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FCS Express 6 IVD Edition
The Future of FCM Analysis
De Novo Software
FCS Express 6 builds on nearly 20 years of
cytometry data analysis excellence bringing
exceptional speed and ease of use to both flow and
image cytometry analysis.

Contents

5

Table of Contents
Chapter 1 Welcome to FCS Express 6

24

1.1 About the Manual

25

1.2 System Requirements

26

1.2.1 Supported File Formats
1.2.1.1
File formats for Flow Cytometry
1.2.1.2
File formats for Imaging Cytometry
1.2.1.3
Other file formats
1.3 Purchasing and Installing FCS Express

27
27
28
30
30

1.4 New Features in FCS Express 6

31

1.4.1 Mac and PC Compatibility
1.4.2 Data Specific Gates
1.4.3 Data Transformations
1.4.4 Integrated Spreadsheets
1.4.5 Scientific Notation
1.4.6 Standard Operating Procedures
1.4.7 Speed Improvements
1.4.8 General Usability Improvements
1.4.9 Marker Linking, Locking, and Visibility options
1.4.10 Authorizations
1.4.11 Data File Compatibility
1.4.12 Plot Types and Enhancements
1.4.13 Custom Grid Options
1.4.14 Index Sorting Compatibility
1.5 Upgrading From Version 5

32
32
33
33
34
35
36
37
37
38
38
38
39
40
41

Chapter 2 Learning How to Use FCS Express

44

2.1 Recorded Webinars and Tutorial Videos

44

2.2 Written Tutorials

45

2.3 Integrated Help System

46

2.4 Comprehensive Manual

46

2.5 Online Discussion Forum

46

2.6 Email Support

47

Chapter 3 A Quick Tour of FCS Express

50

3.1 Getting Started with FCS Express

50

3.2 Startup Screen

54

3.3 A Quick Walk through the Ribbon

55

3.3.1 The File Tab
3.3.2 The Home Tab
3.3.2.1
The Quick Access Toolbar
3.3.2.2
Customizing the Ribbon
3.3.3 The Insert Tab
© 2020 De Novo Software

57
60
65
67
69

6

FCS Express 6 Manual
3.3.4 The Design Tab
3.3.5 The Gating Tab
3.3.6 The Batch Tab
3.3.7 The Format Tab
3.3.8 The Text Tab
3.3.9 The Data Tab
3.3.10 The Tools Tab
3.3.11 The Quality Tab
3.3.12 The View Tab
3.3.13 The Multicycle Tab
3.3.14 The Spreadsheets Tab Group
3.3.14.1
The Layout Tab
3.3.14.2
The Formulas Tab

70
71
72
73
75
76
79
81
82
83
84
84
90

Chapter 4 Working with Layouts

92

4.1 Introduction to the Layout

92

4.1.1 Creating a New Layout
4.1.2 Saving a Layout
4.1.3 Opening a Previously Created Layout
4.1.4 Closing Layouts
4.1.5 Working with Pages
4.1.6 Printing Pages from a Layout
4.1.7 Exporting a Page as a Picture from a Layout
4.1.8 Exporting a Layout as a PowerPoint® Presentation
4.1.9 Exporting a Layout as a PDF File
4.1.10 Navigating through the Layout
4.1.11 Viewing Pages
4.1.12 Zooming the Layout
4.1.13 Auto Recovery Files
4.1.14 Working with Multiple Layouts
4.1.15 Layout and Layout Performance Options
4.1.15.1
Startup Script
4.2 Introduction to Docking

92
93
95
97
98
102
104
105
107
109
109
110
110
110
111
112
113

4.2.1 Opening a Dockable Window
4.2.2 Docking a Window
4.2.3 Pinning a Docked Window
4.2.4 Undocking a Window
4.2.5 Closing a Dockable Window
4.3 Navigators

114
115
121
122
123
123

4.3.1 Layout Navigator
4.3.2 Data Navigator
4.3.3 Gate Navigator
4.4 Layout Page Features

123
126
128
130

4.4.1
4.4.2
4.4.3
4.4.4
4.4.5
4.4.6
4.4.7
4.4.8
4.4.9

Inserting Items onto a Page
Selecting Items on a Page
Overlaying Items on a Page
Grouping Items on a Page
Cutting, Copying, Deleting, Duplicating, and Pasting Items on Pages
Moving Objects
Resizing Objects
Aligning Objects
Ordering Objects

131
131
133
134
135
136
136
136
138

© 2020 De Novo Software

Contents

7

4.4.10 Undoing and Redoing Changes
4.4.11 Page Layout Using Predefined Placeholders
4.5 Using the Master Page

139
139
140

4.5.1 Changing Background Color and Design
4.6 FCS Express Short Cut Keys

141
142

Chapter 5 Working with Pictures

146

5.1 Inserting Pictures

146

5.2 Formatting Inserted Pictures

148

Chapter 6 Working with Text Boxes

152

6.1 Inserting Text Boxes onto a Page

152

6.2 Quadrant Label Text Boxes

152

6.3 Entering and Formatting Text in a Text Box

153

6.3.1 Inserting Tables
6.3.2 Formatting Tables
6.3.2.1
Table Properties
6.3.3 Exporting a Table to Excel
6.4 Resizing Text Boxes

156
157
158
164
164

6.5 Adding a Text Box to a Plot

164

6.6 Formatting Text Box Features

165

6.7 Adding Tokens to Text Boxes

166

6.8 Exporting a Text Box to Excel

166

Chapter 7 Working with Plots

170

7.1 Data Display Plot Types

170

7.2 Inserting Plots

171

7.3 The Current Data File

172

7.4 Changing Data Files

173

Chapter 8 Formatting Objects

178

8.1 Overview

178

8.2 Customizing Default Options

179

8.2.1 General Options
8.2.2 Plot Options
8.2.2.1
Axis Options
8.2.2.2
Background Options
8.2.2.3
Legend Options
8.2.2.4
1D Plot Options
8.2.2.5
2D Plot Options
8.2.2.6
Text Boxes Selection Options
8.2.2.7
DNA Options
8.2.3 Statistic Options
8.2.3.1
1D Plot Statistics
8.2.3.2
2D Plot Statistics
8.2.3.3
DNA Cycle Statistics
© 2020 De Novo Software

180
184
186
188
189
190
191
192
193
196
197
198
200

8

FCS Express 6 Manual
8.2.3.4
DNA Model Statistics
8.2.3.5
DNA Experiment Statistics
8.2.3.6
Proliferation Fit Statistics
8.2.3.7
Proliferation Population Statistics
8.2.4 Startup Options
8.2.5 Gate Options
8.2.6 Files/Directories
8.2.7 Data List
8.2.8 Dialogs Options
8.2.8.1
Keyword Dialog
8.2.8.2
Open Data Dialog

201
202
203
204
206
206
208
209
211
211
212

Accessing the Standard
.........................................................................................................................................
Open Data Dialog
214
Accessing the Advanced
.........................................................................................................................................
Open Data Dialog
215
Advanced Open.........................................................................................................................................
Data Dialog Tabs
216

8.2.8.3
Do Not Show Again
8.2.9 Save Preferences
8.2.10 Security Preferences
8.2.11 Text Box Preferences
8.2.12 User Information
8.2.13 Advanced Publishing Preferences
8.2.14 Data Saving
8.2.15 Data Loading
8.2.15.1
FCS File Options
8.2.15.2
ICE Format Options
8.2.15.3
PerkinElmer Acapella Options
8.2.15.4
Building Blocks Options
8.2.15.5
MDC Store Options
8.2.15.6
Life Technologies Tali Options
8.2.15.7
Nexcelom Options
8.2.15.8
ImageJ Options
8.2.15.9
Amnis DAF Reader Options
8.2.15.10
Perkin Elmer Vectra Options
8.3 Formatting Options Shared by All Objects

220
222
224
224
225
226
227
229
229
232
232
233
233
234
235
235
236
237
238

8.3.1 General
8.3.2 Background
8.3.3 Border
8.3.4 Size
8.3.5 Authorizations
8.4 Formatting Features Shared by All Plots

238
240
242
243
244
245

8.4.1 Specific Options
8.4.2 Title
8.4.3 Legend
8.4.4 Axes
8.4.4.1
Axis Scale and Statistics
8.4.5 3D Display Options
8.4.6 Magnifying a Plot
8.4.7 Changing Plot Type
8.4.8 Plot Names
8.5 Formatting Single Parameter Histograms

246
249
251
253
255
258
260
264
265
266

8.5.1 Overlays
8.5.2 Histogram Markers
8.5.3 Histogram Specific Options
8.6 Formatting 1D Spectrum Plots

267
270
273
276
© 2020 De Novo Software

Contents

9

8.6.1 Overlays
8.6.2 Spectrum Options
8.6.2.1
Plot Specific Options
8.6.2.2
Color Levels
8.6.2.3
Display Gates Options
8.7 Formatting 2D Plots

277
279
280
280
281
283

8.7.1 Overlays
8.7.1.1
Dot and Color Dot Plot Overlays
8.7.1.2
Density and Contour Plot Overlays
8.7.1.3
Scatter and Scatter with Regression Plot Overlays
8.7.2 Quadrants
8.7.3 Color Levels
8.7.4 Gate Display
8.7.5 Specific Options
8.8 Formatting Heat Maps

283
285
286
288
290
294
302
304
307

8.9 Changing the Parameter on Plot Axes Using Keyboard
Shortcuts

308

8.10 Formatting Data Grids and Custom Data Grids
8.10.1
8.10.2
8.10.3
8.10.4

General
Gate Display
Parameters to Display
Image Options

Chapter 9 Analysis of Flow and Image Cytometry Data
Files

308
309
310
311
312

316

9.1 Using Gates

316

9.1.1 Live Updating Gates
9.1.2 Creating Gates
9.1.3 Data Specific Gates
9.1.3.1
Using Data Specific Gates
9.1.3.2
Using Data Specific Gate Groups
9.1.4 Using Boolean Logic to Create Combination Gates
9.1.5 Adding a Combination Gate Matrix
9.1.6 Moving Gates
9.1.7 Resizing Gates
9.1.8 Deleting Gates
9.1.9 Hiding Gates
9.1.10 Using Snapshots with Gates
9.1.11 Gate View Object
9.1.12 Gates and the Clipboard
9.1.13 Linking Gates
9.1.14 Hierarchical Gating
9.1.15 Applying Gates to Plots
9.2 Using Markers

317
318
323
326
330
335
337
339
340
340
342
342
343
345
346
348
350
350

9.2.1 Creating Markers
9.2.2 Moving Markers
9.2.3 Resizing Markers
9.2.3.1
Resizing marker boundaries using the mouse
9.2.3.2
Resizing the marker boundaries via the Formatting
Marker dialog
9.2.3.3
Resizing marker boundaries by dragging and dropping
tokens
© 2020 De Novo Software

351
351
352
353
353
355

10

FCS Express 6 Manual
9.2.3.4

Resizing and linking marker boundaries by dragging
and dropping marker bounds
9.2.3.5
By dragging and dropping a gate
9.2.3.6
By dragging and dropping a plot
9.2.4 Deleting Markers
9.2.5 Using Markers and the Clipboard
9.2.6 Linking Markers to Gates
9.3 Using Quadrants

358
360
361
363
363
364
366

9.3.1 Showing Quadrants
9.3.2 Moving Quadrants
9.3.3 Hiding Quadrants
9.3.4 Linking Quadrants to Quadrants
9.3.5 Creating Gates from Quadrants
9.3.6 Linking Quadrants to Gates
9.3.7 Using Quadrants and the Clipboard
9.4 Snapshots

367
367
368
369
369
369
370
370

9.4.1 Creating and Applying Snapshots
9.4.2 Iteration Snapshots
9.5 Statistics

372
374
379

9.5.1 Histogram Statistics
9.5.2 2D Plot Statistics
9.5.3 Using Statistics and the Clipboard
9.5.4 Formatting Statistics
9.5.5 Percent Gated - Parent and Percent Gated - Grandparent
9.5.6 Spreadsheet Statistics from Data Files
9.6 Axis Scalings

380
383
385
387
389
391
393

9.6.1
9.6.2
9.6.3
9.6.4

Data Display
Gating and Axis Scalings
Quadrants and Axis Scaling
Biexponential Scaling Implementation in FCS Express

395
398
401
402

Chapter 10 Creating and Using Parameter Label Sets

408

Chapter 11 Spreadsheets

412

11.1 Creating a Spreadsheet

413

11.2 Working with Spreadsheets

415

11.2.1 Formatting
11.2.1.1
Formatting Spreadsheet Cells

419
421

Conditional Formatting
......................................................................................................................................... 424

11.2.2 Spreadsheet Cells
11.2.3 Find and Replace
11.2.4 Supported Keystrokes
11.3 Analyzing Files from the Data List with Spreadsheets

425
426
427
431

11.4 Spreadsheet Formula Definitions

438

11.5 Renaming Spreadsheets

532

11.6 Deleting Spreadsheets

533

11.7 Exporting Data in Spreadsheets

534

11.8 Graphing Data with Pie Charts, Bar Plots, and Scatter
with Regression Plots

534
© 2020 De Novo Software

Contents
11.8.1 Pie Charts
11.8.1.1
Inserting Pie Charts

11
535
536

Populating Pie Charts
.........................................................................................................................................
by Drag and Drop
537
Populating Pie Charts
.........................................................................................................................................
from Spreadsheets
539

11.8.1.2
Formatting Pie Charts
11.8.2 Bar Plots
11.8.2.1
Inserting Bar Plots

541
544
545

Populating Bar Plots
.........................................................................................................................................
by Drag-and-Drop
546
Populating Bar Plots
.........................................................................................................................................
from Spreadsheets
550

11.8.2.2
Formatting Bar Plots
11.8.3 Scatter Plots
11.8.3.1
Inserting Scatter Plots

553
556
557

Populating Scatter
.........................................................................................................................................
Plots from Custom Data Grids
557

11.8.3.2
11.8.3.3

Formatting Scatter Plots
Regression Analysis (Manually fitting data)

560
564

Manual Regression
.........................................................................................................................................
Analysis Example
566
Available Equations
......................................................................................................................................... 574

11.8.4 Scatter With Regression
11.8.4.1
Scatter With Regression Plots
11.8.4.2
Formatting Scatter With Regression Plots
11.8.4.3
Scatter with Regression Tokens
11.8.4.4
Interpolating values from Scatter with Regression
Plots

Chapter 12 The Concentration Calculator

575
576
578
581
583

588

12.1 Calculating a Single Concentration

588

12.2 Calculating Concentrations on the Statistics Page

591

Chapter 13 The Histogram Subtraction Tool

594

Chapter 14 Publishing Layout Tools

600

14.1 Publishing a Layout to the De Novo Software
Publishing Site

600

14.2 Advanced Publishing

603

14.3 Default Publishing Options

605

14.4 Managing Your Published Layouts

605

14.5 Sharing Published Layouts with Others

606

14.6 FCS Express Reader

607

14.6.1 Obtaining the FCS Express Reader
14.6.2 FCS Express Reader Limitations
14.6.3 Upgrading from FCS Reader to FCS Express
14.7 Extra Hosting Plans

607
607
608
608

Chapter 15 The Channel Calibration Tool

610

15.1 Creating a New Channel Calibration

610

15.2 Using a Channel Calibration

614

15.3 The Channel Calibration Window

618

© 2020 De Novo Software

12

FCS Express 6 Manual

Chapter 16 The Compensation Tool

622

16.1 Software Compensation Caveats

623

16.2 Setting Up Compensation Definitions

623

16.3 Editing a Compensation Definition

627

16.4 Automatically Calculating Compensation Definitions

630

16.5 Applying Compensation Definitions

638

16.6 Selecting the Default Compensation

641

16.7 Adjusting Compensation Definitions from a 2D Plot

642

16.8 Working with Individual Compensation Files

643

16.9 Saving Compensation Definitions

644

16.10 Loading Compensation Definitions

644

Chapter 17 Working with FCS Data Files

646

17.1 Viewing and Changing FCS File Headers

646

17.2 Extra Keywords

648

17.3 Keyword Anonymizer

654

17.4 Merging / Concatenating Multiple Files

656

17.4.1 Adding Merged Files to the Data List
17.5 Exporting FCS File Data

658
662

17.5.1 Exporting FCS File Data from a Single File
662
17.5.2 Exporting FCS File Data from Multiple Files: Batch Export / Merging/ Concatenation
666
17.5.2.1
Merging / Concatenating FCS Files Via Batch Export Use Case Example
670

Chapter 18 Working with Data Grids

676

18.1 Formatting Data Grids to Display Only Images

677

18.2 Applying Gates to a Data Grid

677

18.3 Backgating on a Data Grid

677

18.4 Creating Cell Number Gates on a Data Grid

679

18.5 Viewing Compensated and Transformed Values in Data
Grids

680

Chapter 19 Using Tokens

688

19.1 Inserting Tokens

688

19.2 Common Token Properties

692

19.2.1 Display Text Token Property
19.2.2 Data Source Token Property
19.3 Token Descriptions and Editing Tokens

692
695
699

19.3.1 Editing Statistic Tokens
19.3.1.1
2D Plot Statistic Token Options
19.3.1.2
Histogram Statistic Token Options
19.3.2 Editing Keyword Tokens
19.3.3 Statistic Classifier Tokens

699
699
702
704
705
© 2020 De Novo Software

Contents

13

19.3.4 Layout Tokens
19.3.4.1
Inserting a Page Layout Token
19.3.5 Gate Tokens
19.3.6 Signature Tokens
19.3.7 Compensation Tokens
19.3.8 Batch Processing Tokens
19.3.9 SOP Tokens
19.3.10 System Tokens
19.3.11 Plot Tokens
19.3.12 Data Parameter Tokens
19.3.13 Spreadsheet Cell Value Tokens
19.4 Custom Tokens

707
708
710
713
713
713
714
715
717
718
721
725

19.4.1 Creating Custom Tokens
19.4.2 Custom Token Example 1: Mathematical Calculation
19.4.3 Custom Token Example 2: Mathematical Calculation with a Token
19.4.4 Custom Token Example 3: Appending Text
19.4.5 Custom Token Example 4: Conditional Statements
19.4.6 Custom Token Example 5: Hiding Signature Tokens
19.4.7 More Complex Custom Token Examples
19.4.8 Inserting Functions into Formulas
19.4.9 Editing Custom Tokens
19.4.10 Custom Token Formatting
19.4.11 Using Boolean Values in Custom Tokens
19.4.12 Using Array Formulas in Custom Tokens
19.4.12.1
Custom Token Example 3: Appending Text 2
19.4.12.2
Custom Token Example 4: Conditional Statements 2
19.4.12.3
Custom Token Example 5: Hiding Signature Tokens 2
19.4.12.4
More Complex Custom Token Examples 2
19.4.12.5
Inserting Functions into Formulas 2
19.4.12.6
Using Boolean Values in Custom Tokens 2
19.4.13 Deleting Custom Tokens
19.4.14 Custom Token Display Types
19.4.14.1
Edit Box Custom Tokens
19.4.14.2
Check Box Custom Tokens
19.4.14.3
Dropdown Custom Tokens
19.5 Custom Token Formula Reference

726
727
729
730
731
732
733
734
741
743
744
745
746
747
748
749
750
757
757
758
759
761
764
766

Chapter 20 Batch Processing

782

20.1 Working with the Data List

783

20.1.1 Data List Actions
20.1.2 Adding Files to the Data List
20.1.3 Sorting in the Data List
20.1.4 Using the Data List to Change the Data Set in a Plot or Token
20.1.4.1
Next/Previous
20.1.4.2
Dragging and Dropping
20.1.4.3
The Change File Button
20.1.4.4
Defer Layout Changes
20.2 Adding Batch Processes

785
786
789
791
791
794
795
796
798

20.2.1 Batch Processing Actions
20.2.1.1
Print
20.2.1.2
Save Layout
20.2.1.3
Save To PowerPoint
© 2020 De Novo Software

801
801
804
808

14

FCS Express 6 Manual
20.2.1.4
Save To PDF
20.2.1.5
Save As Picture
20.2.1.6
Folders (Action Containers)
20.2.2 Batch Processing Reports
20.2.2.1
Working with Reports
20.2.2.2
Creating Templates for Reports
20.2.2.3
Adding Items to Reports

813
818
819
820
823
832
833

Configuring a Report
.........................................................................................................................................
Item's Report Specific Property
835

20.2.2.4
Adding Pictures to a Report
20.2.2.5
Reordering and Copying Items in Reports
20.3 Batch Processing Options

837
839
841

20.4 Running the Batch Process

844

20.5 Rerunning and Reviewing the Batch Process

846

20.5.1 Using Flags
20.5.2 Snapshots and Batch Iteration Navigation

Chapter 21 Using Panels
21.1 Working with Panels

847
850

858
858

Chapter 22 Using Templates

864

Chapter 23 Alerts

866

23.1 Creating Alerts

866

23.2 Running Alerts

868

Chapter 24 Importing External Documents and File Types

872

24.1 BD FACSDiva Files

872

24.1.1 How to Import FACSDiva Experiment Files
24.1.2 Tips for Importing FACSDiva Experiments
24.2 BD Accuri CFlow and C6 Files

873
878
878

24.2.1 How to Import CFlow Experiment Files
24.2.2 Tips for Importing CFlow Experiments
24.3 Comma Separated Value / Delimited (.csv) Files

879
881
882

Chapter 25 DNA Analysis

888

25.1 Multicycle

888

25.2 Inserting a DNA Histogram

889

25.3 Formatting a DNA Histogram

889

25.3.1 General Options
25.3.2 Cycle Options
25.3.3 Background Options
25.3.4 DNA Position Markers
25.4 Setting Default DNA Options

890
891
892
893
896

25.5 The Multicycle Tab

896

25.6 DNA Statistics

899

25.7 DNA-Specific Tokens

901

© 2020 De Novo Software

Contents
25.8 DNA Cycle and Model Summary Reference

Chapter 26 Proliferation Analysis

15
902

906

26.1 Obtaining the Proliferation Add-on

906

26.2 Inserting a Proliferation Histogram

907

26.3 Formatting a Proliferation Histogram

908

26.3.1 The Fit Parameters Option
26.3.2 Proliferation Position Markers
26.4 Proliferation Statistics

908
910
911

26.5 Proliferation-Specific Tokens

915

Chapter 27 Kinetics Analysis

918

27.1 Inserting a Kinetics Plot

918

27.2 Formatting a Kinetics Plot

919

27.3 Kinetics Statistics

921

27.4 Kinetics-Specific Tokens

922

Chapter 28 Spectrum Analysis

926

28.1 Inserting a Spectrum Plot

926

28.2 Formatting a Spectrum Plot

928

28.3 Gating and Backgating on Spectrum Plots

931

28.4 Overlaying Spectrum Plots

932

Chapter 29 Transformations

934

29.1 Parameter Math

935

29.1.1 Defining Parameter Math
29.1.2 Applying Parameter Math
29.2 Principal Component Analysis

935
943
948

29.2.1 Defining a PCA Transformation
29.2.2 Applying a PCA Transformation
29.3 K means (Cluster Analysis)

948
958
960

29.3.1 Defining a k-means cluster analysis
29.3.2 Applying a k-means cluster analysis
29.3.3 Working with k-means parameters
29.4 R Integration

961
970
972
975

29.4.1 Enabling R integration in FCS Express
29.4.2 Installing R packages on the MAC version of FCS Express
29.4.3 Introduction to R integration in FCS Express
29.4.4 R Add Parameters
29.4.5 R Cluster Transformation
29.5 tSNE (viSNE)
29.5.1
29.5.2
29.5.3
29.5.4
29.5.5

tSNE performance in FCS Express
Defining a tSNE transformation
Applying a tSNE transformation
Working with tSNE transformations
Saving tSNE results with an FCS File

© 2020 De Novo Software

976
978
981
984
992
1002
1003
1005
1016
1018
1023

16

FCS Express 6 Manual
29.6 SPADE

1024

29.6.1 Defining a SPADE transformation
29.6.2 Working with SPADE transformations
29.6.3 Saving SPADE results with a DNS file
29.7 Sampling Options

1024
1033
1037
1038

29.7.1 Target Density Downsampling
29.7.2 Weighted Density Sampling

1039
1040

Chapter 30 Working with Amnis .DAF files

1042

Chapter 31 Picture Plots

1046

Chapter 32 Heat Maps

1048

32.1 Working with Heat Maps

1048

32.1.1 Choosing Parameters and Statistics
32.1.2 Choosing a Color Scheme
32.1.3 Heat Map Specific Options
32.1.4 Well Gates
32.1.5 Heat Map Overlays
32.1.6 Formatting Heat Map Overlays
32.2 Working with Index Sort Data in Heat Maps

1052
1055
1058
1059
1061
1064
1066

32.2.1
32.2.2
32.2.3
32.2.4

Influx Index Sorting Data Files
Summit Index Sorting Data Files
Diva Index Sorting Data Files
Chorus Index Sorting Data Files

Chapter 33 Electronic Signatures

1067
1070
1074
1080

1086

33.1 Maintaining Signatures

1087

33.1.1 Adding Signatures
33.1.2 Modifying Signatures
33.1.3 Deleting Signatures
33.2 Signing Layouts

1087
1088
1089
1089

33.3 Unsigning Layouts

1090

33.4 Displaying Signature Information

1091

33.4.1 Signature Status

1096

Chapter 34 Layout History

1098

Chapter 35 Standard Operating Procedures

1102

35.1 Accessing and Docking SOP Navigator

1103

35.2 Creating the SOP

1104

35.3 Changing Order of SOP Steps

1107

35.4 Deleting SOP Step

1107

35.5 SOP Permission Rules and Authorizations

1108

35.6 Running SOP

1108

35.7 Displaying SOP Information and SOP tokens

1111

© 2020 De Novo Software

Contents

Chapter 36 Permission Rules

17

1118

36.1 Creating a Permission Rule

1120

36.2 Organizing Permission Rules in folders

1123

36.3 Save and Load Permission Rules Action List

1123

36.4 Editing a Permission Rule

1124

36.5 Deleting a Permission Rule

1124

36.6 Permission Rules Options

1125

36.7 Available Permission Rules

1125

Chapter 37 Formatting Authorizations

1134

37.1 Accessing and Docking Formatting Authorizations
Navigator

1134

37.2 Working with Authorizations

1136

37.3 Overriding Authorizations

1138

Chapter 38 Security

1140

38.1 User-Based Security

1140

38.2 Layout-Based Security

1141

38.3 Working with User-Based Security

1142

38.3.1 Creating a User
38.3.2 Editing a User
38.3.3 Deleting a User
38.3.4 Editing Security Configurations
38.3.4.1
Managing Password Configurations
38.3.4.2
Mail Notifications
38.3.4.3
SMTP Server
38.3.4.4
Online Registration
38.3.4.5
LDAP and Single Sign On

1144
1150
1151
1152
1153
1154
1156
1157
1164

Creating and Administering
.........................................................................................................................................
LDAP Users
1166

38.4 Working with Security Groups

1171

38.4.1 Creating a User Security Group
38.4.2 Editing a Security Group
38.4.3 Duplicating a Security Group
38.4.4 Deleting a Security Group
38.4.5 Loading and Saving Security Group and Layout Status
38.5 Working with Layout Security Groups

1172
1175
1175
1175
1175
1177

38.6 Managing the Databases

1179

38.7 Available Security Group Permissions

1179

38.8 Security Database Options

1187

38.9 Configuring MS SQL Server to host Security Databases

1188

38.10 Backing up the Databases

1190

38.11 Preparing for Database Updates

1191

38.12 Security Reports

1191

38.12.1 All Events Report
© 2020 De Novo Software

1193

18

FCS Express 6 Manual

38.12.2 Failed Logins Report
38.12.3 Full Sessions Report
38.12.4 All Remote Logouts Report
38.12.5 Report Unique Users
38.12.6 Billing Report
38.12.7 Arranging, Grouping, and Filtering Reports
38.12.7.1
Arranging Columns in Reports
38.12.7.2
Grouping and Filtering Reports
38.12.7.3
Filtering on a Date Range
38.12.8 Exporting Reports
38.13 Layout and Data Security

1194
1195
1195
1196
1197
1198
1198
1199
1202
1203
1204

Chapter 39 Canned Comments

1208

Chapter 40 Tutorials

1212

40.1 Using Objects

1213

40.1.1 Inserting an Object
40.1.2 Selecting and Deselecting Objects
40.1.3 Resizing an Object
40.1.4 Moving an Object
40.1.5 Deleting an Object
40.1.6 Undoing and Redoing Changes
40.1.7 Duplicating Objects
40.1.8 Selecting Multiple Objects
40.1.9 Copying Objects
40.1.10 Pasting Objects
40.1.11 Grouping Objects
40.1.12 Aligning Objects
40.1.13 Ordering Objects
40.2 Inserting Plots

1213
1214
1214
1215
1216
1217
1217
1218
1219
1220
1220
1222
1225
1226

40.2.1 Inserting a 2D Plot
40.2.2 Inserting a Histogram
40.2.3 Inserting from the Data Tab with the Open Command
40.2.4 Always Display Selection Dialog
40.2.5 Inserting Plots from Windows Explorer
40.3 Formatting Plots

1227
1229
1231
1233
1237
1238

40.3.1 Formatting Plots Using the Pop-up Menu
40.3.1.1
Formatting Multiple Plots
40.3.2 Formatting Plot Titles
40.3.3 Formatting Plot Axes
40.3.4 Formatting Plot Background
40.3.5 Formatting the Legend
40.3.6 Changing Histogram Overlays
40.3.7 Formatting 3D Options
40.4 Gating

1239
1244
1250
1256
1258
1260
1263
1266
1268

40.4.1
40.4.2
40.4.3
40.4.4
40.4.5
40.4.6
40.4.7

Creating Gates
Creating a 1D Gate on a 2D Plot
Creating a Gate from a Marker
Creating a Gate from a Quadrant
Creating Combination Gates
Moving Gates
Resizing Gates

1268
1279
1281
1284
1285
1289
1290
© 2020 De Novo Software

Contents

19

40.4.8 Deleting Gates
40.4.9 Applying Gates
40.5 Text Boxes and Tokens

1292
1293
1300

40.5.1 Inserting Text Boxes
40.5.2 Formatting Text in a Text Box
40.5.3 Formatting Text Box Properties
40.5.4 Inserting and Modifying a Table
40.5.5 Inserting and Modifying a Token
40.5.6 Creating a Classifier Token
40.5.7 Creating a Custom Token
40.5.8 Using Custom Token Display Types
40.5.8.1
Creating an Edit Box Custom Token
40.5.8.2
Creating a Check Box Custom Token
40.5.8.3
Creating a Dropdown list Custom Token
40.6 Quadrants

1300
1304
1306
1313
1317
1326
1339
1351
1352
1356
1360
1364

40.6.1 Rectangular and Floating Quadrants
40.6.2 Percentile Quadrants
40.7 Quadrant/Marker to Gate Linking

1364
1372
1377

40.7.1 Quadrant to Gate Linking
40.7.2 Marker to Gate Linking
40.8 Compensation

1377
1384
1391

40.8.1 Manual Compensation
40.8.2 Automatic Compensation
40.8.2.1
Automatic Compensation - Optional Steps 3 and 4
40.8.2.2
Automatic Compensation and Batch Processing
40.8.3 Compensation Digitization Error
40.9 Snapshots

1392
1396
1415
1429
1436
1438

40.9.1 Snapshots Window
40.9.2 Iteration Snapshots
40.9.3 Batch Processing Snapshots
40.10 Batch Processing

1438
1444
1451
1460

40.10.1 Exporting Plots to PowerPoint
40.10.2 Excel Report (Cell Mode)
40.10.3 Excel Report (Column Mode)
40.10.4 Exporting to LabKey
40.10.5 Snapshots
40.11 Creating and Using Panels

1460
1470
1490
1498
1513
1513

40.11.1 Setting Up the Panel
40.11.2 Creating the Layout
40.11.3 Using the Panel
40.11.4 Saving and Loading Panels
40.12 Docking

1513
1523
1540
1550
1552

40.12.1 Features of a Docked Window
40.12.2 Docking Features (Multiple Windows)
40.12.3 Undocking a Window
40.13 Data Navigator

1559
1563
1574
1576

40.13.1 Opening and Docking
40.13.2 Data Navigator Features
40.14 Gate Navigator

1576
1581
1597

40.14.1 Opening and Docking
© 2020 De Novo Software

1597

20

FCS Express 6 Manual

40.14.2 Gate Navigator Features
40.15 Layout Navigator

1603
1612

40.15.1 Opening and Docking
40.15.2 Layout Navigator Features
40.16 HLA Cross Matching - Spreadsheets Use Case 1

1613
1618
1635

40.16.1 Loading a layout for analysis
40.16.2 Creating a Spreadsheet for analysis
40.16.3 Populating a Spreadsheet with data
40.16.4 Working with Custom Tokens and Formula References in spreadsheets
40.16.5 Create Token Classifiers
40.16.6 Using Conditional Formatting to Classify Data
40.17 Antibody Titration - Spreadsheets Use Case 2

1637
1639
1642
1651
1661
1669
1675

40.17.1 Creating an analysis Spreadsheet
40.17.2 Creating a regression curve from a Spreadsheet
40.17.3 Interpolating values from the regression
40.18 Calibration via Regression Analysis - Spreadsheets Use
Case 3

1675
1689
1697

40.18.1 Complete a Spreadsheet and Insert a Scatter with Regression Plot
40.18.2 Working with Regression Tokens and Fit Equations
40.18.3 Apply Regression to an FCS File
40.18.4 Save a Regression
40.19 Working with Pie, Bar, and Scatter Plots Spreadsheets Use Case 4

1702
1711
1717
1721

40.19.1 Creating Bar and Scatter Plots and Pie Charts
40.19.1.1
Creating Bar Plots
40.19.1.2
Creating Pie Charts
40.19.1.3
Creating Scatter Plots
40.19.2 Formatting Bar and Scatter Plots and Pie Charts
40.19.2.1
Adding Error Bars
40.19.2.2
Adding Highlighting or Exploding
40.19.2.3
Displaying Additional Datasets

1701

1725
1726
1727
1733
1740
1746
1746
1752
1756

Overlays on Bar
.........................................................................................................................................
and Scatter Plots
1758
Ring on Pie Chart
......................................................................................................................................... 1760

40.20 DNA Analysis

1761

40.20.1 Autofit Selection (1 Cycle Analysis)
40.20.2 Expanded Analysis with Autofit
40.20.3 Formatting a DNA Histogram
40.20.4 Analysis of 3 Cycle Data
40.21 Proliferation

1762
1775
1784
1793
1798

40.21.1 Inserting Proliferation Plots
40.21.2 Formatting a Proliferation Histogram
40.21.2.1
Fitting Proliferating Cells
40.21.3 Batch Processing Proliferation Data
40.22 Kinetics

1800
1803
1809
1817
1821

40.22.1 Using Parameter Math
40.22.2 Applying Gating and Statistics
40.22.3 Plotting Values
40.22.4 Overlay and Format Kinetics Plots
40.22.5 Format to Change Resolution
40.23 Cell Concentration

1822
1832
1835
1840
1843
1849

40.23.1 Setting up the Bead Gates

1850
© 2020 De Novo Software

Contents

21

40.23.2 Concentration Calculator (Beads)
40.23.3 Concentration Calculator (Time/Flow Rate)
40.23.4 Concentration Calculator ($VOL keyword)
40.23.5 Showing the Concentration in a Statistics Window
40.23.6 Showing the Concentration as a Token
40.24 Channel Calibration

1851
1854
1856
1858
1866
1871

40.24.1 Setting Bead Gates and Markers
40.24.2 Channel Calibration Tool Setup
40.24.3 Channel Calibration Demonstration
40.24.4 Saving/Loading Channel Calibrations
40.24.5 Channel Calibration Defaults
40.25 Immunophenotyping

1871
1875
1879
1882
1883
1885

40.25.1 Building your layout
40.25.2 Adding statistics to your layout
40.25.3 Batch processing your analysis
40.26 Changing Common Preferences

1885
1908
1918
1930

40.26.1 Displaying Filenames Without Path in Data List
40.26.2 Changing Axis Labels
40.26.3 Creating Gates Hierarchically and Adding Statistics to Gate Text Boxes
40.27 Cluster Analysis

1931
1932
1935
1936

40.27.1
40.27.2
40.27.3
40.27.4

Defining a k-means clustering
Applying a k-means clustering
Working with k-means using 1D-2D plots
Working with k-means parameters

Index

© 2020 De Novo Software

1937
1946
1951
1956

1961

Chapter

1

24

1

FCS Express 6 Manual

Welcome to FCS Express 6
FCS Express is an analysis tool for flow cytometry data. FCS Express gives
customers the ability to graphically display data generated by any flow cytometer
that adheres to the FCS standard. These graphical displays consist of many
types of plots, including one-dimensional histograms, and two-dimensional
scatter, contour and density plots, among others.
When loading the data, FCS Express reads numerical values for each parameter
as well as descriptive information about the parameters, and can display either
type of information at any time. In order to display the numerical values, the
values can be binned to display in plots with smaller resolutions, or displayed as
is. Sub-populations (known as gates) can be defined using graphical means, and
used to create further displays.
In addition to the graphical display, FCS Express calculates descriptive statistics
based on the original data, as well as any combinations of statistics and
operations that the customer creates.
These statistics can be displayed alongside the graphs in tables or embedded in
text annotations.
As well as being displayed on the screen, the graphs and statistics can be
exported to many types of formats, including text files, Excel, Word, and many
image formats, and even custom formats for better integration with customers'
existing information storage systems.

This manual applies to FCS Express 6.06.0033.

Each release of FCS Express is validated using a set of tests designed to ensure
quality, that all program requirements are met, and that statistical calculations
are reliable and accurate.
FCS Express 6 Flow IVD Edition has been listed with the FDA as a medical device.
FCS Express IVD Edition is CE marked. De Novo Software has produced FCS
Express IVD under all relevant requirements of 21 CFR §820 “Quality Systems
Regulations”. De Novo Software has not made any specific claim for use of FCS
Express IVD for any specific assay.
If approval or validation is required for a customer’s use of FCS Express IVD in
connection with the customer’s business, obtaining such approval and/or
validation is the sole and complete responsibility of the customer.
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FCS Express is a powerful tool for analyzing Flow Cytometry data. However,
FCS Express does not produce any conclusions or diagnoses based on the data
on its own. Individuals using FCS Express must have prior appropriate training in
the techniques of flow cytometry and flow cytometry analysis and
interpretation.

1.1

About the Manual
The following conventions are used throughout this manual:
In the text, boldface print is used to designate an actual "object" within the
program, either text that you will see on your screen, a user interface
element such as the File tab (note the File tab replaces the Applications
Button from Version 4) or Layout Navigation Toolbar, or an element of
FCS Express (e.g., Display Text token property). If the text is a hyperlink, it
will appear underlined and in blue. Hyperlinked text will not be boldface.
In the Windows operating system, the designation "left mouse button" refers
to the primary mouse button (even if you are left-handed and have switched
the buttons so that the primary mouse button is the one under your index
finger). By convention, to "right-click" always means to press the secondary
mouse button. Throughout the manual, "press the mouse button" refers to
your primary button unless the text specifically states to "right-click."
FCS Express uses the Ribbon interface where most menus and toolbars are
replaced with the File tab as well as Tabs, Groups, and Commands. The
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drop-down list of commands which appear when selecting the File tab or
commands with a down-arrow icon are referred to as "galleries" when using
the Ribbon interface.
To indicate selecting a particular command, the following convention is often
used in this manual "Tab
". For example,
Home
means to select the New Page command from
the Pages Group on the Home Tab.

1.2

System Requirements
The minimum system requirements for FCS Express are as follows:
PC
o Windows 7/Windows 8/Windows 8.1/Windows 10
o Intel Core-equivalent or higher
o 1 GB RAM
o 400 MB Hard drive space
o Recommended system: 4 GB RAM
Mac
o macOS 10.8 (Mountain Lion) or higher.
o 2 GB ram
o Intel Core Duo
o 2 GB Hard drive space
o Recommended system: 8 GB RAM

Notes:
FCS Express takes advantage of many features that are available in higher end
Intel Chips. For optimum performance, use the newest generation processors.
For example, an i7 will significantly outperform an i5 even if the number of
cores and clock speed of the processors are equivalent.
FCS Express can take advantage of all cores in the computer. Thus, while not
required, a multi-core computer will be significantly faster than a single core
computer for many functions.
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FCS Express (32-bit) (PC Only) will use up to 3 GB of RAM on 32-bit Windows
and 4 GB of RAM on 64-bit Windows.
FCS Express (64-bit) (PC and Mac) will use up to 128 GB on 64-bit machines.

1.2.1

Supported File Formats
FCS Express will read .FCS data files from any instrument and supports a broad
range of file formats used for storing flow and imaging cytometry data.
o Supported Flow Cytometry Data Formats

27

o Supported Image Cytometry Data Formats
o Other Supported Data Formats

1.2.1.1

28

30

File formats for Flow Cytometry

FCS Express can read listmode (FCS and LMD) data files from all manufacturers.
FCS Express currently supports FCS Version 1 to FCS version 3.1. Simply
transfer the files to the computer on which you are running FCS Express (either
via the network, flash drive, CD or other method) and FCS Express will be able
to load the data

76

. FCS Express also supports some specialized data formats

native to manufacturers instruments. These specialized formats include Cytek
and Sony Spectral data files, BD Accuri C6 and C6 Plus files, and Miltenyi
MacsQuant .mqd files.
In addition, FCS Express can also import the analysis/acquisition settings (gates,
plots, markers, quadrants etc) from flow cytometers running the BD FACSDiva
872

and the BD Accuri C6

Sample-based files

Plate-based files

Importers
© 2020 De Novo Software
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software.
File description
Listmode files
BD AccuriT M C6 / C6 Plus
files
Sony Spectral Data 926
Cytek Spectral Data 926
Miltenyi MacsQuant files
BD AccuriT M C6 / C6 Plus
Plate files
FCS Plate folders*
BD FACSDivaT M

File format
*.fcs; *.lmd
*.c6; *.cfl; *.ci;
*.sraw and *.fcs
*.fcs
*.mqd
*.c6; *.ci;

FCS Plate Folder (folder
directory - see below*)
Experiment *.xml

28
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files
BD AccuriT M C6 file

* The FCS Plate Folder

1048

*.c6

format allows users to load individual .FCS files derived

from plate based experiments:
o BD instruments with HTS add-on
o Guava
o Coulter Quanta
o Sony
o BD Accuri
o MACSQuant

Plate based data files may be used in conjunction with the High Content Heat
Map
1.2.1.2

1048

add-on.

File formats for Imaging Cytometry

FCS Express Image Cytometry allows access to images, numeric analysis
results, and image segmentation masks from various instruments and image
analysis tools.
In some cases import compatibility with a single image analysis packages enables
compatibility with many image formats (e.g. CellProfiler using Bio-Formats). In
other cases, direct import of analysis results or links to imaging databases have
been developed with specific vendors.
Product

File

Name

format

CellProfiler *.cpout
Samplebased files

Chemomet
ec

*.acs

ImageJ files *.ijout

Images Numeric Data Data Base Link
Y

Y

NA

Y

Y

NA

Y

Y

NA
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*.daf and
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Y

Y

NA

Y

Y

NA

Y

Y - MDC Store

Y

NA

*.tif /*.txt Y

Y

NA

*.ice

Y

Y

NA

YokogawaT *.ice

Y

Y

NA

PerkinElmer Y

Y

Y - ColumbusT M

IDEAS®
Software
Fluxion
Biosciences
- CytoFlux
Phase
Holographic

*.fcs

*.ice

Imaging
Countstar
Molecular
Devices®
instruments *.iso or
utilizing the MDCStore Y
MDC
Tab
TM
Store
Data Base
Nexcelom
*.nxdat or
Y
Cellometer
*.ice
® Vision
Perkin
Elmer
Vectra® /
InForm
Software
Thermo
ScientificT M
HCS
Studio T M
Platebased files

2.0
Software

M

CQ1

Perkin
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Elmer® -

®

Acapella®

Opera®,

Folder or

Operetta®, Building
Acapella®, Blocks Tab.
Harmony®,
ColumbusT
M

InvitrogenT InvitrogenT Y
M

TaliT M

M

Y

NA

Y

Y - MDCStoreT M

TaliT M

Data Folder
Molecular *.iso or
Y
Devices® MDCStore
instruments Tab
utilizing the
MDC
StoreTM
Data Base

1.2.1.3

Other file formats

FCS Express 6 supports loading data stored as Comma Delimited files in the
format of (*.csv). Please refer to the Importing External Documents and File
Types 872 chapter of this manual for further information.

1.3

Purchasing and Installing FCS Express
FCS Express can be purchased from our web site at http://
www.denovosoftware.com. Simply click the Purchase menu on the top of the
homepage. You have the choice of either ordering online or downloading an
order form. If you download the order form, you can fax the completed form to:
+001 (213) 814-1511 or mail it to:
De Novo Software
400 N. Brand Blvd Suite 850
Glendale, CA 91203
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USA
We accept checks, money orders, wire transfers, purchase orders, Visa™,
MasterCard™, and American Express™. In addition to a standalone license, De
Novo Software also sells both a network license and site licenses for FCS
Express. Please contact us at sales@denovosoftware.com for site license
information.
If you purchase the software online, you will be given the option of downloading
FCS Express at the time of purchase so that you can begin using it immediately.
Whether or not you order online, we will send a CD containing FCS Express to
the address you provided. After purchasing the software, the end user will
receive a confirmation email containing your configuration file.
FCS Express 6 is available in multiple versions to suit your needs. To learn about
the different versions, click on the Products menu on the home page.
Information on the different licensing options is available on our web site at
Which License is Right for Me?
Complete installation instructions (including information on obtaining
configuration files, using dongles and countercodes, and site licenses) are
available on the web site at http://www.denovosoftware.com/site/
InstallationInstructions.shtml.

1.4

New Features in FCS Express 6
In addition to the new features described in the other sections of the manual,
FCS Express has major improvements in the categories below:
Mac and PC Compatibility 32
Amnis .DAF file Compatibility
Data Specific Gates 32
Marker to Marker Linking 37
Data Transformations and Cluster Analysis
Integrated Spreadsheets 33
Scientific Notation 34
Standard Operating Procedures 35
Speed 36
General Usability 37
Authorizations 38
Data File Compatibility 38
New Plot Types and Enhancements 38
Custom Grid Options 39
1042

CE Marking
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Mac and PC Compatibility
FCS Express is compatible with Mac or PC. Any purchased license of FCS Express
may be used seamlessly between either platform, and layouts created on a PC
may be opened on a Mac and vice-versa. Users will not have to purchase a
separate Mac or PC version. Please visit http://www.denovosoftware.com/site/
DownloadLanding.shtml to download the appropriate version for your operating
system of choice.
Please see our list of System Requirements
your Mac or PC operating system.

1.4.2

26

for full details on requirements for

Data Specific Gates
Data Specific Gates 323 in FCS Express allow you the ability to assign gates to
specific data files that have been loaded in the data list. Different gating positions
between data files may be stored and automatically used when displaying plots
or making calculations when using the Data Specific Gate feature, Figure below.

The Data Specific Gate button in the Gating tab is used to enable data specific
gates.

When a gate is converted to a Data Specific Gates for a given file, the shape and
position can be modified for the specific file independently from other data files.
Thus, when a Data Specific Gates is created, the original gate (here hence
referred to as "Master gate") continues to be used for all the remaining files.
Jump to:
Creating Data Specific Gates 326
Deleting/Removing Data Specific Gates

327
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Promoting Data Specific Gates to Master Gate
Using Data Specific Gate Groups 330

1.4.3

33

329

Data Transformations
FCS Express has new advanced transformation and cluster analysis 934 features
that will allow you to perform to following transformation in an easy to use
interface.
Parameter Math 935
K-Means cluster analysis 960
Principal Component Analysis (PCA) 948
R Integration 975 for adding new parameters
tSNE
SPADE

984

and cluster transformations

992

1002

1024

Example of tSNE transformed data set with new color based on overlay option
applied below .
1020

1.4.4

Integrated Spreadsheets
A new Spreadsheet 412 tool has been added to FCS Express to allow you to easily
analyze and organize statistics and information from your experiments.
A Spreadsheet may be added to a layout through the Data tab
Spreadsheet command.
Once a spreadsheet is inserted you may click on the Spreadsheet to select it,
which will make the
and
tabs
appear (figures below).
Spreadsheets in FCS Express 6 can be used to perform most of the operations
that Microsoft Excel provides. In addition, values in Spreadsheet cells can be
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derived directly from statistics within the layout, keywords, or from data files in
the data list. Inserting statistics for data files in the data list allows additional
flexibility in analysis of many statistics for many data files that are not currently
open in the layout. Data contained in spreadsheets may be directly exported as
.xlsx, .xls, .csv, .html, .xml and .txt files. When exporting as to Excel compatible
formats equations and formatting from the FCS Express spreadsheet will be
retained.
A number of specialized tutorials are available to guide you through some of the
more advanced spreadsheet features:
HLA Cross matching - Spreadsheet Use Case 1
o Creating a Spreadsheet for analysis
o Populating a Spreadsheet with data
o Working with Custom Tokens and Formula References in spreadsheets
o Using Conditional Formatting to Classify Data
1635

1639

1642

1651

1669

Antibody Titration - Spreadsheets Use Case 2

1675

Calibration via Regression Analysis - Spreadsheets Use Case 3
o Complete a Spreadsheet and Insert a Scatter with Regression Plot
o Working with Regression Tokens and Fit Equations

1702

Working with Pie, Bar, and Scatter Plots - Spreadsheets Use Case 4

1725

1701

1711

The Spreadsheet Layout Tab

The Spreadsheet Formulas tab.

1.4.5

Scientific Notation
Scientific notation is now available for any statistics in FCS Express and may be
accessed via the Number Display Options in any Statistics dialog.
© 2020 De Novo Software
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Statistic for X
Median
displayed as
scientific
notation
(above).

1.4.6

Standard Operating Procedures
Standard Operating Procedures (SOP's)
allow you to create a predetermined
set of steps in your FCS Express layouts in which each step can be conditionally
formatted with tokens so that a requirement must be met before the next step
is performed. For instance, a user may not proceed to the next step unless the
number of events in a gate is above a certain threshold value or text has been
entered in a field.
1102
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The Standard Operating Procedure feature in FCS Express.

1.4.7

Speed Improvements
FCS Express has the following new speed enhancements:
Speed:
Significantly improved speed in the loading of all data files and saving of
layouts.
FCS Express takes advantage of many features that are available in higher
end Intel Chips while using all the cores in your computer to dramatically
speed up your analysis.
o For optimum performance, use the newest generation processors. For
example, an i7 will significantly outperform an i5 even if the number of
cores and clock speed of the processors are equivalent.
FCS Express can take advantage of all cores in the computer. While not
required, a multi-core computer will be significantly faster than a single core
computer for many functions.
FCS Express (32 bit) (PC Only) will use up to 3 GB of RAM on 32 bit
Windows and 4 GB of RAM on 64 bit Windows.
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FCS Express (64 bit) (PC and Mac) will use up to 128 GB on 64 bit
machines.
Heat map loading speed drastically improved.
Picture plot loading speed drastically improved.
.ICE file loading speed drastically improved.

1.4.8

General Usability Improvements
FCS Express has the following new improvements to general usability of the
software:
General Usability
New Microsoft office suite style interface 55
Option to embed or link to images in a layout 146
Compensation and Spillover Matrices are now color coded 627
Gate View 343 and Gate Navigator 128 "unified" so any action available in the
Gate View 343 is possible within the Gate Navigator 128
Ability to drag and drop a single cell image from a data grid onto the layout
to insert a picture of the cell
Table and text box formatting is retained when copy and pasting from FCS
Express to Excel 166
Heat map statistics grids may be displayed in columns or rows as well as
standard tables .
New Custom Token function for more easily interpolating values from
Scatter with Regression Plots 583
Right click on plot to add text box. 164
Batch Processing Run window now dockable 844
1052

1.4.9

Marker Linking, Locking, and Visibility options
FCS Express allows users the ability to link any markers together so that
moving a marker end point will automatically cause an end point on a
different marker to update at the same time. This allows for live updating
bifurcation of markers on histograms. Linking markers is accomplished by
setting the low or high bound for one marker to use a token value for the
high or low bound of a separate marker.
Markers can also be conditionally locked or marked as hidden/visible on any
plots

Markers may be linked together 353
Markers visibility and ability to move may be set manually or via conditional
© 2020 De Novo Software
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token values 272
Marker positions may be locked to a manually entered or token dependent
value 272

1.4.10

Authorizations
All objects in FCS Express may now be assigned Authorizations , or rights,
which allows or prevents layout users from placing objects in Select mode or
Edit mode or both. Authorizations can be set to always allow, never allow, or
always allow/do not allow based on the value of a token. For instance, a token
value can be set to allow selection of a plot if the current FCS Express user
equals a specific person or a plot can remain non-editable unless a particular
statistic value is met, ie the number of events for a particular gate is higher than
X.
1134

Authorizations allow for an additional layer of control at the layout level for any
objects.

The Authorization feature.

1.4.11

Data File Compatibility
FCS Express has the following new data loading and data list features. See our
full list of support file formats 27 for additional details.
Data Loading:
Ability
Ability
Ability
Ability

1.4.12

to
to
to
to

load Amnis® .DAF files.
load new BD Accuri C6 Plus data file (*.ci) format. 878
work with Sony Spectral data files exported in .FCS file format.
load very large data files. 36
1042

Plot Types and Enhancements
FCS Express adds the following new plot types and enhancements:
Heat maps have overlay capabilities

1061
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Heat maps may display any statistic as a radius parameter
Plots and objects may appear visible or hidden and visibility may be based
on token values 238
Quadrant visibility and ability to move may be set manually or via
conditional token values 292
Tokens may be added to plot titles and footers 249
Spectrum plots for Cytek and Sony spectral file analysis 926 .
1055

1.4.13

Custom Grid Options
FCS Express allows for customization of output format when printing, creating
PowerPoint documents, and generating PDF files, from the export and batch
processing 782 features by setting Custom Grid Options (Figure 4.1). These
options allow you to export in a mode where multiple plots or pages are tiled in
your resulting document automatically allowing for many plots or pages to be
presented on one (or many) page(s) in your final report according to the tiling
options you have defined. The Custom Grid Options may also be enabled when
using the Multiple Duplicate and Next and Multiple Duplicate and Prev(ious)
options available from the Home tab Clipboard group Duplicate dropdown
menu. The selected plot(s) will be duplicated in a mode where the new plots will
be added to same page or other pages of the layout based upon tiling options
defined.

Figure 4.1 Custom Grid Options

When selecting Custom Grid Options, the Custom Grid popup window will
appear, which will contain the following five settings:
Number of columns: define the number of layout pages displayed across the
printed page(s) or exported slide(s) or PDF page(s).
Number of rows: define number of layout pages displayed down the printed
page(s) or exported slide(s) or PDF page(s).
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Order: arrange the layout pages across (Horizontal) or down (Vertical) the
printed page(s) or exported slide(s) or PDF page(s).
Gap mode: select how to define horizontal distance (Gap value) between
layout pages.
Gap value: value used for distance of Gap mode in inches; will update
automatically if Gap mode is set to Auto; will be 0.02 inches if Gap mode is
set to Minimal; can enter preferred value if Gap mode is set to Manual.

Example of batching a set of data files from the data list to PowerPoint using the
Custom Grid feature. Notice that one set of plots was defined in FCS Express and a
series of tiled plots have been exported to PowerPoint in one column in three rows.

1.4.14

Index Sorting Compatibility
FCS Express is now offers the ability to work with index sorting data
from the
following instruments to relate individual sorted cells back to the sorted and presort populations.
1066

Influx (BD Biosciences)
Summit Software (Beckman Coulter)
Diva (BD Biosciences)
Chorus (BD Biosciences)
1067

1070

1074

1080

© 2020 De Novo Software

Welcome to FCS Express 6

41

Index Sorting Data with Sorted Events
Emphasized

Heat Map of sorted wells with radius size dependent on
amount of GFP expression.

1.5

Upgrading From Version 5
FCS Express 6 is the result of extensive customer feedback, giving you the
features you need most 31 . FCS Express 6 continues our tradition of innovative,
powerful software, designed to let you work in a modern PowerPointT M style
framework. Speed and general usability have been greatly enhanced in Version 6
as highlighted in the New Features in FCS Express 6 chapter 31 .
In addition, Version 6 continues to expand to bring the full power of flow-style
analysis to the world of image cytometry. All of the standard FCS Express
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features to which you have become accustomed are available, plus new
innovative abilities, such as gating on cells in your images, gating on events in cell
galleries, using heat maps to organize your experiment, and gating on wells.
For more details on upgrading your current FCS Express license to FCS Express
6 please visit our upgrade webpage.
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Learning How to Use FCS Express
In addition to this manual and the integrated help system, there are a number of
other available ways to learn to use FCS Express. These include video 44 and
written 45 tutorials, an online forum 46 , and email support 47 . These resources
may also be found in the new Welcome Screen 54 of FCS Express or on the De
Novo Software website at www.denovosoftware.com
The expert staff at De Novo Software is also happy to set up short training
sessions for free; please write to support@denovosoftware.com to request a
session.
Our staff can also be reached for questions by dialing +001 (213) 814-1240 and
leaving a message. A member of the De Novo Software team will call you back
within 24 hours (usually within the hour).

2.1

Recorded Webinars and Tutorial Videos
A good place to start learning FCS Express is with our online recorded webinars
and short instructional videos. These are accessible via the Recorded Webinars
button on the Start Up Screen 54 and are also available at http://
www.denovosoftware.com/site/recordedWebinars.shtml#ShortOverview and on
the De Novo Software YouTube channel. These videos provide an overview of
software features and a glimpse of the variety of data analysis possibilities in FCS
Express.
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Written Tutorials
De Novo Software also provides comprehensive, step-by-step written tutorials,
which describe how to use the basic functions of FCS Express. The tutorials
are included in this manual, and are also available offline by selecting the File
tab
, or at http://www.denovosoftware.com/site/manual/
index.html?tutorials.htm. The following tutorials are currently available (check
our website for additional tutorials for an updated list).
1212

Sample data is provided so that you can follow along with the examples in the
tutorials. The sample data can be downloaded from the De Novo Software web
site, from the archive:
https://s3.amazonaws.com/fcsexpressdownloads/TutorialSampleDataV6.zip

Using Objects
Inserting Plots
Formatting Plots
Gating
Text Boxes and Tokens
Quadrants
Quadrant/Marker to Gate Linking
Compensation
Snap Shots
Batch Processing
Creating and Using Panels
Docking
Data Navigator
Gate Navigator
Layout Navigator
Spreadsheets Use Case 1 - Working with Custom Tokens, Formula
References, and Conditional Formatting
Spreadsheets Use Case 2 - Creating a regression analysis with an Antibody
Titration Series
Spreadsheets Use Case 3 - Performing Channel Calibration and Regression
Analysis
Spreadsheets Use Case 4 - Creating and working with Pie, Bar and Scatter
Plots
High Content Flow
DNA Analysis
Proliferation
Kinetics
Cell Concentration
Channel Calibration
1213

1226

1238

1268

1300

1364

1377

1391

1438

1460

1513

1552

1576

1597

1612

1635

1675

1701

1725

1761

1798

1821

1850

1871
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Immunophenotyping
Changing Common Preferences
Cluster Analysis
1885

1930

1936

2.3

Integrated Help System
FCS Express comes with a comprehensive integrated help system. The
integrated help is available by selecting File tab
. You can use
this system to search for specific topics (Figure 2.1). It contains the same
information as this manual, in an easy-to-access, cross-referenced manner.

Figure 2.1 The integrated help and manual within FCS Express.

2.4

Comprehensive Manual
The FCS Express manual is a detailed explanation of all of the functions in FCS
Express. The manual is available as a .pdf file by selecting the File
tab
. You can also obtain the latest version of the
manual on the De Novo Software website.

2.5

Online Discussion Forum
In addition to the printed materials described above, an online discussion forum is
available to discuss any issues pertaining to FCS Express. This list is monitored by
the De Novo Software support staff, but has the added advantage of allowing
other FCS Express users to respond and learn from your questions and
comments. We encourage you to post questions, comments, and suggestions
to this forum. You can access the forums by selecting the File
tab
or at https://forums.denovosoftware.com/.
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Email Support
If you have any questions pertaining to FCS Express, please do not hesitate to
contact the De Novo Software team at support@denovosoftware.com. The De
Novo Software team is also available for free live web-based training and support
at your request. Please visit http://www.denovosoftware.com/site/
support.shtml for additional details.
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A Quick Tour of FCS Express
The FCS Express 6 interface utilizes the Ribbon 55 system, similar in design to the
familiar Microsoft Office suite of programs (Office 2007 and later). The Ribbon 55
helps you quickly find commands that you need to complete a task. The
commands are organized into functional groups collected under Tabs. For
example, there is a Gating tab 71 , a Batch tab 72 , an Insert tab 69 , etc.
The Applications button found in Version 4 was replaced with the new File tab in
FCS Express 5 and FCS Express 6, which contains actions previously found in the
Applications button.
The FCS Express User Options 179 can be found within the Options command
in the File tab. Clicking on the File tab Options will launch the FCS Express
User Options window, which contains the adjustable settings found in Edit
Preferences in FCS Express V4.

3.1

Getting Started with FCS Express
When starting FCS Express, the first window to appear is the User Selection
window (Figure 3.1). In this window, you can select the user profile to be used
for the current FCS Express session. To log in with an existing user profile, select
either the Default user, or a user name that you have created, and click the
Select button. When a user is selected, the Options previously saved for that
user are activated. Therefore, multiple users sharing the same computer can
customize their Options independently. To create a new user, click on New
User... and enter a new user name. At the end of the session, the user profile
stores the FCS Express User Options 179 for each user. To delete a user, rightclick on the user name and select Delete User from the pop-up menu. Note:
Once a user is deleted, the default Options for that user cannot be recovered.
The Import... button at the bottom left of the User Selection window is used
for importing FCS Express Version user preference files (.fcg) from the FCS
Express V5 installation folder.
For details on changing default user Options, see the section on Customizing
Default Options 179 . Note: An individual user’s default Options can be restored to
manufacturer default settings, by selecting the File tab
.
If only one user will ever be using this copy of FCS Express, you can choose
Remember Me On This Computer in the User Selection window. FCS Express
will then automatically log in as that user when the program starts. To stop
logging in as the same user, you can log out 59 from the File
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tab System
or from the right side of
the Layout Navigation Toolbar at the bottom of the FCS Express window 56 .

Figure 3.1 User Selection Dialog

Note: If you are running the security system , or are using an Internet Dongle,
FCS Express will start up with a login screen prompting you to enter your user
name and password.
1140

Once you select a user and press OK, FCS Express will start (Figure 3.2) and
the Startup Screen 54 will appear.
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Figure 3.2 Startup Screen

After choosing New Layout, a blank document (layout) will be displayed (Figure
3.3). Layouts (.fey files) are the document format of FCS Express.
The default layout is a single page with a white background.
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Figure 3.3 Blank layout

You can open an existing layout using the File tab Open to bring up a Load
Layout dialog. You can also create a new layout from a blank document or from
a template of an existing layout, discussed in detail in Creating a New Layout 92 .
Layouts can contain plots, pictures, text boxes, statistics windows, and data
windows. Gating definitions, parameter label sets, and other features of the
analysis are also stored directly in the layout file. In addition, .fcs data files can be
embedded directly in the layout and saved as part of the layout file.
Any number of layouts can be open at the same time.
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Startup Screen
The Startup Screen in FCS Express (Figure 3.4) first appears after you choose a
User 50 or will open automatically if you have chosen to remember a user on the
computer.
The Startup Screen is a dashboard for quickly accessing:
New layouts
Saved layouts
Recently accessed layouts
FCS Express news and updates
Video Guides
Recorded webinars
Searchable Manual
Tutorials
Support
Applications Examples
Social media sites for De Novo Software
The Startup Screen will remain open until closed or minimized and can be
dismissed for future instances of FCS Express by unchecking the box for "Show
this screen when FCS Express starts up" in the bottom left of the window.
Once the "Show this screen when FCS Express starts up" box has been
unchecked, the option to show the startup screen upon startup can be reset in
the File tab
Again category by checking the box for "Show startup screen automatically
when FCS Express starts up".
Alternatively, the Startup screen may be opened or closed through the View
tab
button.
Other options for the Startup screen may be changed in the File tab
Startup category, such as Automatically close
the startup screen when opening a new or existing layout and Reopen the
startup screen after closing all layouts.
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Figure 3.4 The Startup Screen

3.3

A Quick Walk through the Ribbon
The Ribbon (Figure 3.5) is at the top of the page. You can find the File tab 57 and
the Quick Access Toolbar at the top, left corner of the Ribbon. The Quick
Access Toolbar is a place to put frequently used functions. You can customize
65 the functions on the Quick Access Toolbar (as well as the entire Ribbon itself
67 ). Under the Quick Access Toolbar are multiple Tabs. Each Tab contains
command buttons organized into logical groups. Some groups contain a Dialog
Box Launcher Button with multiple formatting options.

Figure 3.5 The Ribbon
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On the upper right portion of the ribbon you may also choose the ribbon display
options (Figure 3.6) or to close, minimize, and/or restore the current layout.
Auto-hide Ribbon will hide the ribbon in a single band until the top band is
clicked on to display the ribbon.
Show Tabs will only display tabs until a tab is clicked on, then commands for
each tab will be present.
Show Tabs and Commands will show all tabs and all commands at all times.

Figure 3.6 Ribbon Display Options

At the very bottom left of the application window is the Layout Navigation
Toolbar (Figure 3.7) used for navigating through the layout 109 . Beneath the
Layout Navigation Toolbar is the Zoom Toolbar 110 . To the right of the Zoom
Toolbar is a Status Bar showing the active panel, described in Working with
Panels 858 .

Figure 3.7 Layout Navigation Toolbar with Zoom Toolbar and Status Bar

Individual commands in the groups will be enabled or disabled based upon the
current status of the layout. For instance, if no items are selected, the Cut,
Copy, and Duplicate commands in the Clipboard group of the Home Tab will be
disabled. Brief descriptions of the features of the Ribbon are described in the
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sections below.
Multicycle 83 and Spreadsheet 84 tabs are only available when a multicycle plot
or spreadsheet has been inserted, respectively.

3.3.1

The File Tab
The File tab (Figure 3.8) contains multiple groups of items in a list at the left.
Clicking on any item on the left will open a new item section on the right specific
for that item. The main items and their sub items are as follows:
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Figure 3.8 File tab

Save, Save as..., Open, Close, Close All, Open From, Recent, New (

)

These items allow the user to create, open, save, and close layouts. The
Open From command also allows the user to import BD FACSDiva 872 and BD
Accuri C6 878 files.
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)

The Export item allows you to export your layout to a PowerPoint
presentation 105 or a PDF 107 . In addition, you can save the current page or
selected items as a Picture 104 .
Info (

)

This item allows you to:
o View information about the current layout
o View the log of all changes that were ever made to the layout (if you
have purchased the logging add-on)
o Create and manage the set of electronic signatures for this layout, and
sign or unsign the layout (if you have purchased the security add-on)
Print (

)

This item is used to:
o Select a printer, which pages to print, and other options before printing
o Choose to print Color or Grayscale

Collaborate (

)

This item is for:
o Publishing your layout

600

using the De Novo Software Publishing service

o Managing the layouts you have published

System (

)

With this command, you can:
o Logout the current user.
o Edit information for the current user.
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o Restore Options to default values.
o Reset toolbars to default settings.
o Show background tasks to Manage print jobs, downloads and other
tasks that are running in the background.
o Logout the current user.
o Change your configuration.
Help (

)

With this item, you can:
o Show the help system's table of contents, and search its contents.
o View tutorials about using FCS Express.
o Open the integrated help system and/or the PDF manual.
o Launch the De Novo Software website in your internet browser.
o Open the About screen to view information about the version of FCS
Express that is running.
o Visit the online forum.
Note: If security is activated, there will be an additional item available labeled
"Security".
1140

The Options button ( ) brings up the FCS Express User Options dialog where
you can completely customize the working environment for a selected user by
selecting the defaults (Options) for essentially every object category in FCS
Express.
The Exit button ( ) closes FCS Express. You will be prompted to save your
layout if it has changed during your session.

3.3.2

The Home Tab
The Home tab (Fig. 3.9) contains the following groups:
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Figure 3.9 Home Tab

Clipboard
o The Paste command allows you to paste something from the clipboard.
The label of the Paste command will change depending on the type of
object(s) in the clipboard.
o The precise text beside the Cut and Copy commands will change depending
on which object(s) in the layout are currently selected.
o The Duplicate command duplicates the selected object(s). Under the
Duplicate dropdown menu are five commands: Duplicate, Duplicate and
Next, Duplicate and Prev(ious), Multiple Duplicate and Next, and
Multiple Duplicate and Prev(ious). The Next and Prev functions associated
with these commands duplicate the selected object(s) and changes them to
display the next or previous file(s) in your Data List 783 . The Multiple
commands allow you to make more than one copy of the selected item,
changing successively to the next or previous file(s) in each instance. The
positioning of the duplicated objects can be set in the Duplicate Options
(Fig. 3.10, top)or in the default User Options 180 :
Selecting radio button next to Place the duplicated objects in a grid
will allow Custom Grid settings to be enabled under Grid Options.
The duplicated objects will displayed on the following new page(s) of
the layout.
o Objects are duplicated at the size appropriate for the page
dimensions that allow for the Number of columns, rows, and
Gap mode and value specified under Custom Grid Tiling
Options (Fig. 3.11, top right). Order specifies whether objects
are duplicated across and then down the page ("Horizontal") or
down and then across ("Vertical"). Also note that if Custom
Grid is selected, the file(s) in currently selected object(s) are
duplicated as the first object(s) in the Custom Grid. An
example of selected objects Multiple Duplicated in a Custom
Grid with the options specified below is shown in Fig. 3.12,
bottom.
Selecting the radio button next to Place the duplicated objects
relative to the original will place the duplicated objects on the same
page as the selected object(s) even if pages do not fit on the page. In
order to place all duplicated objects on a page, please be sure to
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check the box next to If duplicated object(s) are off the page, put
them on a new page. Enabling this option will create new page(s) to
accommodate all the duplicated objects that do not fit on the same
page as the original object(s).

Figure 3.10 Multiple Duplicate Options (top), including Custom Grid Tiling
Options (top right), and an example of selected objects Multiple Duplicated with
the pictured options (bottom).

o The items in the Clipboard group will operate on plot windows, text boxes,
statistics windows, and more, depending on which object(s) are currently
selected in the layout page. Items (e.g., Text Boxes) can be copied from
one layout to another. You can switch between open layouts using the
View tab Windows Switch Windows command.
Pages
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o The top half of the New Page command adds a new page to your layout.
The bottom half of the New Page command opens a gallery with numerous
choices for adding a new page with Place Holders for predefined layouts
containing various text boxes, plots, and statistics.
o The Delete Page command deletes the current page.
Font
o Within this group, the Font Name, Font Size, Font Color, and Font
Background Color can be changed for the selected object(s) with Bold,
Italics, and Underline options available. Clicking the expand button will open
the Font Dialog (Fig. 3.13).
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Figure 3.11 - Home Tab Font Group to Font Dialog

Editing
o The Select All command selects all of the object(s) on the current page.
o The Delete command deletes the currently selected object(s).
o The Arrange command expands to allow you to Order Objects and
Group Objects. Order Objects allows you to organize which objects are
visually on top of other objects. This feature is useful when working with
multiple overlapping objects. Group Objects allows you to group several
objects together, so that selecting any one of the objects will automatically
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select all items in the group.
o The Align command expands to allow you to Horizontally or Vertically
align objects and Position Objects. These commands are used in aligning
the sides, tops, bottoms, centers, heights and/or widths of the selected
objects.

3.3.2.1

The Quick Access Toolbar

With the default Quick Access Toolbar, there are icons (Figure 3.14) to Save
the current layout or to Undo and Redo the last user action. FCS Express
remembers every action that you have taken. Therefore, you can undo an
unlimited number of actions, allowing you to revert to any earlier state of your
layout.

Figure 3.12 Quick Access Toolbar Icons

Clicking the Customize command (tooltip "More Buttons") brings up a gallery
(Figure 3.15) which allows you to fully customize the interface.

Figure 3.13 Customize Menu

The Customize Quick Access Toolbar... item brings up a Customize dialog
(Figure 3.16). Commands or individual Tabs can be chosen in the left column to
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be added to or removed from the Quick Access Toolbar in the right column,
where they can be rearranged.

Figure 3.14 Quick Access Toolbar Customization dialog

Under File tab System
drop down, the Reset Toolbars to
Default Settings command will revert your changes to the manufacturer default
(Figure 3.17).
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Figure 3.15 - System Restore Options
3.3.2.2

Customizing the Ribbon

In addition to customizing the interface using the customize command to the
right of the Quick Access Toolbar 65 , right-clicking on an individual command
within a group, or right-clicking on the name of a group, brings up a menu (Figure
3.18) which includes the command to Add to Quick Access Toolbar (or group
of commands) to the Quick Access Toolbar 65 .
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Figure 3.16 Add Command to Quick Access Toolbar

The Customize the Ribbon... item brings up a Ribbon Customization dialog
(Figure 3.19). Commands or the Home, Tools, or Custom tabs can be chosen
in the left column to be added to or removed from the Quick Access Toolbar in
the right column, where they can be rearranged or hidden by unchecking the
checkboxes.

Figure 3.17 - Ribbon Customization dialog
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When the Customize dialog is open, you can perform many customizations to
the Ribbon 55 . To remove items from the Ribbon: click on the item to remove,
hold down the mouse button, drag the item to an area within the Customize
dialog, and release the mouse. If you drag the item to another part of the
Ribbon, it will be moved to the position where you release the mouse. To add
commands to the Ribbon, select the Commands tab. Select a command from
the list and drag it to the position on the Ribbon (or Quick Access Toolbar) where
you wish it to appear.
You can reset an individual group (toolbar) to its default state by selecting the
toolbar in the Toolbars tab and pressing the Reset button in the bottom left
corner of the window.
Under the File tab System
Reset Toolbars to Default
Settings command will restore all toolbars to the default settings.

3.3.3

The Insert Tab
The Insert Tab (Figure 3.20) contains four groups for inserting objects on a
page:

Figure 3.18 Insert Tab

General
o The top half of the New Page command adds a new page to your layout.
The bottom half of the New Page command opens a gallery with numerous
choices for adding a new page with Place Holders for predefined layouts
containing various text boxes, plots, and statistics.
o The Shapes command is for inserting a new shape, such as a Line, Arrow,
Ellipse, or Rectangle.
o The Text Box command inserts a new text box.
o The Gate View command allows the user to insert a Gate View window,
from which the properties of all your gates may be viewed and changed.
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o The Picture command inserts a picture from a file on your computer.
o The Data Grid 676 command 676 allows the user to view data in a table
(spreadsheet) format or work with custom data 412 .
Spreadsheet
o The New Spreadsheet 412 command opens up a dialog window for
creating a new spreadsheet (Figure 3.21), from which data values and
statistical calculations can be plotted in FCS Express. Selecting an
inserted spreadsheet will reveal the Spreadsheet Tab group 84 .

Figure 3.19 - Create New Spreadsheet Dialog

1D Plots
o The six commands in the 1D Plot group 170 insert Histograms 170 , Kinetics
plots 918 , Multicycle DNA histograms 889 , Proliferation histograms 907 ,
Spectrum 926 , Bar Plots 544 , and Pie Charts 535 .
2D Plots
o The eight commands in the 2D Plot group 170 insert two-dimensional Dot
plots, Density plots, Color Dot plots, Contour plots, Surface plots,
Scatter plots 556 and Scatter with Regression 575 .

3.3.4

The Design Tab
The Design Tab (Figure 3.22) contains the Page Layout group, which includes
the following commands:
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Figure 3.20 Design Tab

o The Page Setup command allows you to determine the page Size,
Orientation, Margins with any default or custom values as well as to choose
to Maintain the size of all objects on the layout.
o The Size command allows you to pick a page size from a list of default sizes.
o The Orientation command allows you to choose to view the layout in a
portrait or landscape mode.
o The Margins command allows you to choose from four default margin size.
o The Layout command opens a gallery for adding Place Holders for predefined
text boxes, plots, and statistics to the current page.

3.3.5

The Gating Tab
The Gating Tab (Figure 3.23) contains the following commands for working with
gates:

Figure 3.21 Gating Tab

Create Gates is the group under which all of the following fall:
o commands for creating gates (Ellipse, Rectangle, Polygon,
Freeform), Markers (Create Marker), and Quadrants on a plot. It
also allows you to quickly see which gate is applied to a plot. These
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functions are described in more detail in the section on Using Gates

316

.

o the Data Specific Gate command, which permits the assignment of
unique gating positions to specific data files. Use of this new feature in
FCS Express 6 is described in more detail in the section on Data Specific
Gates 323 .
Note: adjusting gates on a per-datafile basis during Batch Processing is still
possible in FCS Express 6, as in all previous versions of FCS Express.

3.3.6

The Batch Tab
The Batch Tab (Figure 3.24) contains two groups.

Figure 3.22 Batch tab

All of the commands associated with this Tab are described in detail in the
chapter on Batch Processing 782 .
Batch Processing
o Once you have set up and verified all your batch processing options and
actions, the Run command executes all your actions including printing,
saving, and reporting across all samples.
o Within the Batch Processing command you may choose the following
options:
Run - Runs the batch actions with the same gates applied to all
samples.
Rerun - Reruns the previous batch run using any modifications made to
the layout when the batch process was run with pauses.
Review - Runs a series of batch iterations over samples without
exporting any actions.
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841

Set the number of iterations to perform.
Choose whether or not to run alerts before batch processing.
Decide if you want to pause between iterations and which
iterations to pause at if iterations are flagged or certain conditions
are met.
Restore the original files on the layout after batch processing.
The Batch Actions command brings up the Batch Actions 801 window
where you can set various actions associated with printing, reporting,
and saving layouts (to various formats) while batch processing.

Organize Data Sets
o The Panels command brings up the Panel Information dialog for working
with Panels 858 .
o In the Increment Value field, you can set the increment value, which is the
number of files to increment after each iteration in a batch process. An
increment value of 1 means to move to the next file.
o The Data List command brings up the dockable Data List
process the list of current files (or custom data).

3.3.7

783

window to

The Format Tab
The Format Tab (Figure 3.25) contains seven groups. The commands allow
you to change the properties of one or more selected objects.

Figure 3.23 Format Tab

Object Options
properties.

238

: Each command brings up a dialog box to set object

o The General command is for assigning or changing the object name and
the object visibility 238 .
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o With the Size command, you can change or scale the height and width of
objects. An option exists to lock the aspect ratio so that the ratio of the
height to width are kept constant.
o The Fill command is used for setting the objects background characteristics
(color, image), changing the margins of the object, and adjusting the frame.
o The Border/Lines command is used to set the style, color, and width of
lines surrounding the border of the selected object(s).
o The Authorizations
command is used to define what select and edit
actions are accessible for the object(s).
1134

Data Options
o The Gates to Display command is used for choosing which gates to display
in a plot or Data Grid.
o The Parameters to Display command allows you to choose which
parameters are shown in a data grid.
o The Data Image Options command controls image placement in the cells
of a Data Grid.
Plot Options
o The Overlays command is used to choose the characteristics of an overlay
including, x- and y-parameters, gates, compensation, color, and dot size,
among other things.
o The Axes, Title, and Legend commands allow you to format and position
the text used in these areas of the object.
o If you are working with a histogram or surface plot, the 3D command is
used to format the properties of the display, such as zoom, rotation,
elevation, offsets, and perspective.
o The Specific Options command allows you to change specific options that
are related to the particular plot that is selected, e.g., the resolution of a
plot, and to indicate how many cells to plot.
1D Options
If marker(s) have been created, the Markers command is used for
formatting the properties of the markers on single-parameter histograms.
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2D Options
o With the Quadrants command, you can format the quadrants of a dualparameter plot.
o If you are working with a 2D color plot (e.g., color dot plot, density plot,
contour plot) the Color Levels command is used to format the properties
of the colors displayed.
Statistic Options
If statistics are displayed in a default statistics window, the Statistics
command allows you to format the properties of the statistics window.
Change
The Change Plot Type command allows you to change the type of a
selected plot. By clicking on the down arrow associated with the Change
Plot Type command, you expand the item to reveal all of the possible plot
types.
Override
The Override Authorizations command allows you to override any
Authorizations set on objects. See the Overriding Authorizations
topic for
additional details.
1138

3.3.8

The Text Tab
The Text Tab (Figure 3.26) contains four groups.

Figure 3.24 Text Tab

Insert Text
If a text box is selected, the Insert Token command allows you to choose
the type of token to insert. The Insert Table command is used for inserting
a table into a text box and specifying its properties.
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Font and Paragraph
The commands in the Font and Paragraph groups are used to format the
text manually in the current cursor position just as you would in word
processing software. If text is selected, the formatting is applied to the
selected text. You can display standard Font or Paragraph dialogs to format
multiple properties at the same time by clicking on the Dialog Box Launcher
Buttons 55 (little arrow icons at the bottom right) of the Font and Paragraph
groups. While the font and paragraph commands usually apply to text
boxes, some paragraph properties can apply to non-text box options. For
instance, changing the justification of a data or stats window will change the
alignment of the text.
Table
If a table has been inserted in a text box and the table is selected, the
commands in the Table group can be used to:
o Display the table properties.
o Insert rows above or below the current position.
o Insert columns to the left or right of the current position.
o Delete the last row or column of the table.

3.3.9

The Data Tab
The Data Tab (Figure 3.27) contains six groups:

Figure 3.25 - Data Tab

Save/Load
o The Open command brings up the Select a Data File dialog (Figure
3.28) which allows you to select a data file (e.g., an FCS file). The
Select a Data File dialog contains a File Dialog tab for accessing files
anywhere on your computer, a Data List tab which allows you to see
which files/data sets you are working with in the current experiment, an
Active Files tab (i.e., the files currently open in the layout), an MDC
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Store tab (accessing files from the Molecular Devices MDC Store (Image
Cytometry Version)) and a Building Blocks tab (accessing files from
PerkinElmer building blocks (Image Cytometry Version)). Using the Files
of type: drop-down list, you can choose the file extension, e.g., files
from different instrument manufacturers.

Figure 3.26 - Select a Data File Dialog

Once a data file is opened, choose which type of plot(s) to open from
the Select Plot Types ... dialog (Figure 3.29).
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Figure 3.27 - Select Plot Types Dialog

o With the Export command, you export the data from a single open file
662 .
o You can export data from multiple files consecutively using the
Export 666 command.

666

Batch

Data Info
o If a plot is selected, the View Header command brings up a dialog box
which displays the FCS file header information for that file. If no plot
exists on the layout, the Select a Data File dialog is displayed, so you
can choose which header information to display.
o The Keywords Anonymizer 654 command brings up the Select
Keywords to Anonymize window, which allows you to remove any or
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all keywords from a data file.
Organize Data Sets
o The Panels command brings up the Panel Information dialog for working
with panels 858 .
o In the Increment Value field, you can set the number of files to
increment after each iteration in a batch process, or when pressing Next/
Prev on Selection or All Objects (below). An increment value of 1 means
to move to the next file in the Data List.
o The Data List command brings up the dockable Data List window to
process the list of current data 783 files 783 .
Change Data on Selection
o Previous changes the .fcs file to the previous file in the Data List on the
selected plot or plots.
o Next changes the .fcs file to the next file in the Data List on the
selected plot or plots.
o Select brings up the Select a Data File dialog from which you can
choose an .fcs file to display in the selected plot or plots.

Change Data on All Objects
o Previous changes the .fcs file to the previous file in the Data List on all
plots.
o Next changes the .fcs file to the next file in the Data List on all plots.
o Select brings up the Select a Data File dialog from which you can
choose an .fcs file to display in all plots.
o Flag this iteration
marks the selected file or iteration to be flagged
for review in the Batch Process or Data List.
o Iteration allows you to choose an iteration from a drop down menu
that will be displayed in all plots.

3.3.10

The Tools Tab
The Tools tab (Figure 3.30) contains four groups:
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Figure 3.28 - Tools tab

Calculate

o The Histogram Subtraction command opens the Histogram
Subtraction window where you can apply four mathematical methods
of comparing sample and control histograms 594 .
o The Concentration Calculator command opens the Concentration
Calculator window where you can calculate the concentration of events
in a sample 588 .
o The Channel Calibration command opens the Channel Calibration
window where you can change the axis fluorescence intensity scales
from a linear or logarithmic scale to one indication either the absolute
number of antigen molecules or the number of binding sites on the
surface of a cell 610 .

Labels
o The Parameter Labels opens a gallery containing Modify Labels, Load
Labels, and Save Labels commands. These items allow the user to
easily create, change, recall, and save alternate parameter labels 408 .

Snapshots
o The Apply Iteration Snapshot command allows you to move gates
between iterations and have the gates' new positions remembered while
navigating using the Next and Previous commands 374 .
o The Snapshots command opens the Snapshot Navigator window
where you can take custom snapshots of your analysis on data files and
apply that analysis to other files 372 . For example, a snapshot of a gate
position may be taken, the gate position changed, and snapshot applied
to go back to the original gate position.
Transformations
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o The Compensations command opens the Compensations Navigator,
which allows you to display the compensation information on the
selected file, create new compensations, and load or save compensation
information 622 .
o The Transformations command opens the Transformations
Navigator, which allows you access K means (cluster analysis) 960 ,
Principal Component Analysis 948 , Parameter Math 935 (defines a single
or sequence of math functions, save the functions, and apply the
functions to data files 935 ), R integration 975 to add new parameters or
transformations, and tSNE .
1002

3.3.11

The Quality Tab
The Quality tab (Figure 3.31) contains two groups:

Figure 3.29 - Quality tab

SOP
o The Run SOP command begins the step wise process of running
through all of the steps defined in the SOP creation process
1104

o The Standard Operating Procedures command opens the
Standard Operating Procedures
navigator .
1103

1103

1103

o The Permission Rules command opens the Permission Rules
Navigator where you can set available permissions
specific to a
layout.
1125

Alerts
o The Run Alerts command can be run once at least one alert is created.
When clicked, FCS Express will evaluate the formulas written in the
Alerts Navigator.
o The Alerts command opens the Alerts Navigator (only accessible with
FCS Express IVD Version) where you create True or False statements
for evaluation.
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The View Tab
The View Tab (Figure 3.32) contains six groups:

Figure 3.30 View Tab

Tokens
o Once you have created at least one Alert, you can "run" them using the
Run Alerts command. FCS Express evaluates the Alert formulas, one by
one, in the order that they exist in the Alerts window.
o The Alerts command brings up a dockable Alerts window where you
can create new alerts 866 . Alerts allow you to monitor your analysis for
specific analysis conditions.
o The Custom Tokens command brings up a dockable Custom Tokens
window where you can create new custom tokens 726 to generate your
own custom statistics.
o The Canned Comments command brings up a dockable Canned
Comments window to define new canned comments .
1208

Navigators
o The Layout Navigator 123 command brings up a dockable Layout
Navigator window listing each item in the layout.
o The Data Navigator 126 command brings up a dockable Data Navigator
window listing the parameters of each file referenced in the layout.
o The Gate Navigator 128 command brings up a dockable Gate Navigator
window describing the gates which have been defined on plots within the
layout.
Multiple Pages
o In the Multiple Pages group, there are four commands [One Page,
Two Pages (Horizontal), Two Pages (Vertical), and Four Pages]
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.

Windows
If there are multiple layouts open, the Switch Windows command allows
you to choose which layout is active.
Show
o The Master Page command shows the Master Page.
o The Hidden Pages command is used to show pages that the user has
previously chosen to hide in the layout.
Welcome
o The Startup Screen command allows you to view or hide the Startup
Screen.

3.3.13

The Multicycle Tab
The Multicycle Tab 896 allows you to work with the Multicycle AV plugin 888 from
Phoenix Flow Systems. To access this tab, a Multicycle plot must be inserted.
When hovering over a model button, its name will appear (Figure 3.33).

Figure 3.31 Multicycle Tab with Model 1 Name while hovering

It contains two groups:
Fit Parameters
The Autofit command automatically adjusts cycle parameters. In manual
mode, the Fit Parameters command brings up a dialog to format the Fit
Model Properties, and the Background command brings up a dialog to
format background options. The Cycle drop-down list allows you to
choose the number and kinds of populations to model.
Model to Display
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The six Model commands are used to set the currently displayed model.

3.3.14

The Spreadsheets Tab Group
Once you insert a spread sheet from the data tab and put it in selected mode,
the spreadsheets tab group will appear with layout and formulas tab.

3.3.14.1

The Layout Tab

The Spreadsheets

412

Layout tab (Figure 3.34) contains seven groups:

Figure 3.32 - Spreadsheet Layout tab

Font
The Font Name, Font Size, Font Color, and Font Background Color
can be changed for the selected object(s) with Bold, Italics, and
Underline options available.
Alignment
o Alignments and indentations can be applied.
o The Wrap Text command sets text to wrap in a cell.
o The Merge Cells drop down allows you to Merge Cells, Merge
Across, Merge and Center, or Unmerge Cells (Figure 3.35).

Figure 3.33 - Merge
Cells drop down list

Tokens
The Insert Tokens command will open the Insert a Token dialog

688

.
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Formatting and Sorting
o The Conditional Formatting drop down allows you to access the
following:
Color Scales, Data Bars, Icon Sets, Top/Bottom Rules
(Figure 3.36),

Figure 3.34 Conditional
Formatting drop down
list

More Rules..., which opens the Conditional Formatting Rule
window (Figure 3.37),
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Figure 3.35 - Conditional Formatting Rule window

and Manage Rules..., which opens the Conditional Formatting
Rule Manager (Figure 3.38) to create new rules to be applied to
the Current Selection or Sheet.
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Figure 3.36 - Conditional Formatting Rule Manager

o The Sort A to Z command allows you to sort the selected cells in
alphabetical order.
o The Sort Z to A command allows you to sort the selected cells in
reverse alphabetical order.
Cells
o The Insert Row command adds a row above the selected cell(s).
o The Insert Column command adds a column to the left of the selected
cell(s).
o The Delete Row command removes a row below the selected cell(s).
o The Delete Column command removes a column to the right of the
selected cell(s).
o The Formatting drop down list (Figure 3.39) allows you to perform
the following:
AutoFit Row Height
AutoFit Column Width
Access Hide and Unhide list to Hide Rows, Hide Columns,
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Unhide Rows, or Unhide Columns

Figure 3.37 - Cells Formatting drop down
list

Open Format Cells window (Figure 3.40)

Figure 3.38 - Format Cells window

Editing
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o The Clear drop down list allows you to Clear All, Clear Formatting,
and Clear Contents of selected cell(s) (Figure 3.41).

Figure 3.39 - Clear
drop down list

o The Freeze Panes drop down list allows you to Freeze Panes,
Unfreeze Panes, Freeze First Row, and Freeze First Column
(Figure 3.42).

Figure 3.40 - Freeze
Panes drop down list

o The Comments drop down list allows you to add New Comment, Edit
Comment, Delete Comments, move to Next Comment or Previous
Comment, and Show/Hide Comments (Figure 3.43).
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Figure 3.41 Comments drop down
list

Exports
o The Export command allows you to export data contained in the
spreadsheet to various formats: .xlsx Excel workbook, .xls 97-2003
Excel Workbook, .html Web Page, .csv Comma Delimited Value
files, .xml Data and .txt tab delimited files. When exporting as to Excel
compatible formats equations and formatting from the FCS Express
spreadsheet will be retained.

3.3.14.2

The Formulas Tab

The Formulas tab (Figure 3.44) contains the Function Library group with the
following drop down lists: AutoSum, Financial, Logical, Text, Date and Time,
Lookup and Reference, Math and Trig, Statistical, Information, and
Compatibility 438 .

Figure 3.42 - Spreadsheet Formulas tab
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Working with Layouts
Layouts (.fey files) are the file type of FCS Express. They are usually saved with
a link to your .fcs data files, and contain all elements of your analysis including
gates, statistics, batch processes, and more.

4.1

Introduction to the Layout
The layout is the name for an FCS Express document. The layout contains and
organizes plots, regions, quadrants, statistics, text boxes, graphics, printer
settings, and more. There is no limit (other than your computer memory) to the
number of layouts that can be open at one time. It is possible to copy objects
easily from one layout to another. There are many other powerful formatting
and graphics features in FCS Express that allow you to display data exactly as
you wish.
The layout organization in FCS Express is similar to that in a Microsoft
PowerPoint® presentation. Like a presentation containing a series of slides with
text and graphics, each FCS Express layout contains a page or series of pages
with text boxes, plots, statistics, and other objects. Similar to a slide in
PowerPoint, each page in an FCS Express layout can be modified, saved, printed,
or exported. The layout itself can be set up with different background colors or
images on each page. In addition, a saved layout can be used as a template for
batch processing of selected files, or can be linked to specific data files. When a
linked layout file is reopened, the data files and plots used to create it are
displayed. This feature is useful in documenting clinical cases by providing an
archival record of the analysis, or for recreating any kind of repetitive analysis.
Any object inserted into a layout, whether it is a plot, text box, statistics window,
or graphic, can be manipulated in many different ways. Again, it is helpful to think
of objects on a layout page as if they were objects inserted onto a slide in
PowerPoint. Single or multiple objects can be selected, and once selected, the
object(s) can be formatted, moved, resized, or aligned with one another.

4.1.1

Creating a New Layout
A new layout can be created by choosing one of the following options:

Select the New Layout button from the Startup Screen 54 (Figure 4.2).
By selecting the File tab New, you can create a new blank layout, or open
a previously created, saved layout template. A list of your previously
created templates will appear in the Recent Templates area of the gallery.
Recent templates may be pinned to the list by clicking on the pushpin icon.
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Figure 4.2 Recent Templates

o Templates are very useful for setting up standard document settings,
like margins, page orientation, and page size, or analysis-specific
layout elements such as plots and statistics. A template is any
previously saved layout file that you decide to open as a template. To
create a new document from a template, use the File
tab New New From Existing... command. You can also designate
a saved layout file as your default template 208 . When a default
template is present, FCS Express opens that template file instead of a
blank layout when using the File tab New New command.
o When FCS Express opens a new layout from a stored template, a
new layout identical to the stored template is created. However, the
new layout will contain no data files so the plots will be empty.
Therefore, when you save the new layout, you will be prompted for a
new filename to prevent overwriting the original template.

4.1.2

Saving a Layout
Layouts can be saved in any of the following ways:
File tab

Save.

Click the Save Current Layout icon in the Quick Access Toolbar

65

.

Use the Ctrl+S keyboard shortcut.
Using any of these methods will bring up the Save Layout dialog (Figure 4.3)
where you can name the layout file to be saved and choose the location to save
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it.

Figure 4.3 Save Layout Dialog

When saving a layout, you have the option to save with a link, save without a
link, or embed the data files within the saved layout according to the Save as
type drop down option you choose.
• Layout Files (with linked data)(*.fey)
The position and formatting of the objects in the layout will be saved. When
the file is opened, data will appear if the data files are available or have been
copied to the computer where the layout is being opened. However, if the
linked layout file is opened on a computer without access to the linked data
files, no data will appear in the layout plots or statistics. Linked layout files are
smaller than embedded layout files.
• Layout Files (with embedded data)(*.fey)
The position and formatting of the objects will be saved and a copy of the
actual data files is saved within the layout file. This allows anyone who opens
the layout file to see and analyze the data, without having the original data
file. Although a layout file with embedded data files can be fairly large, it is
actually only about two-thirds of the size of the original data file(s). This
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makes layouts with embedded files an ideal way to send data to a
collaborator.
Note: only .fcs files currently showing on the layout will be saved. Files
within the Data List but not currently showing on plots will not be included.

• Layout Files (with unlinked data)(*.fey)
The position and formatting of the objects (plots, statistics boxes, as well as
the Data List options, including sorting) will be saved. No data will appear
when the unlinked layout is opened. The file sizes of unlinked layout files are
smaller than linked or embedded layout files.

4.1.3

Opening a Previously Created Layout
A previously saved layout can be opened by using the File tab Open command,
the File tab Open From Open command. These commands bring up the
Load Layout dialog. Recently used documents will appear in the File
tab Recent category (Figure 4.4). To open a recently used document, simply
select the document. Note that recent Places for file locations may be
accessed. Documents and Places in the Recent category may also be pinned
using the pushpin icons.

Figure 4.4 Recent Documents Appear on the Right

Navigate to the file you wish to open in the Load Layout dialog. Once a layout
file has been highlighted, the Layout Information at the bottom of the dialog
box displays the number of pages, the number of histograms, the number of 2D
plots, the Data Link Style 93 , and Layout Version of the selected layout file
(Figure 4.5).
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Figure 4.5 Load Layout Dialog

If the layout you are opening has linked data and FCS Express cannot find these
.fcs file(s), you will be notified in a Select the Data Directory dialog, and will be
given the opportunity to load the file(s) from a different folder (Figure 4.6).
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Figure 4.6 Missing Linked Data

4.1.4

Closing Layouts
More than one layout can be open in FCS Express at any time. There are two
methods to close the current layout:
Activate the layout that you want to close (you can use
View Windows Switch Windows, if necessary) and select File
tab Close. If the only layout that is open is a blank layout which has not
been changed, this will close (Exit) FCS Express.
If more than one layout file is open, you can click on the "X" icon in the
upper right of the application window (Figure 4.7).
Note: If more than one layout is open only the current layout will be closed.
However, if only one layout is open, clicking on the Close Program "x" will
close (Exit) FCS Express.
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Figure 4.7 Close icons

To close all of the open layout files, select the File tab Close All. A new,
blank layout will be launched after the others are closed.

If any layout has not been saved when you try to close it, you will be prompted
to save it. It is also possible to change your default Save Options 222 so that the
layout will close without being prompted to save. In this case, all changes will be
discarded without altering the original layout.

4.1.5

Working with Pages
There are several ways to add a new page to a layout. The following three
methods will add a new page after the current page:
Select Home
to insert from the ribbon.

Page and choose the kind of page you want

Right-click on the layout and select New Page from the pop-up menu.

Click on the Add Page tab icon
(Figure 4.8) of the Layout
Navigation Toolbar (near the bottom of the FCS Express application
window on the left).

Figure 4.8 Add Page Tab

To insert a page into the middle of an existing layout, right-click on an existing
labeled Page Tab on the Layout Navigation Toolbar (e.g., "Page 1") and
select Insert from the pop-up menu. This will insert a blank page before the
page you selected. To rearrange pages of a layout, select the tab of a page on
the Layout Navigation Toolbar and drag the tab left or right to the new
location.
You can rename pages. To do so:
1. Right-click anywhere on the page (or on the tab associated with the page)
and select Format from the pop-up menu, or double-click on the Page Tab.
2. In the Formatting Page dialog that appears, type the new name into the
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Name field (located in the Name category).
The visibility of a page can be controlled from the formatting dialog.
1. Right-click anywhere on the page and select Format from the pop-up
menu.
2. In the Formatting Page dialog, click on Visibility (Figure 4.9). Using the
radio buttons, visibility can be set to Always visible, Never visible (i.e.,
hidden), or Custom. If you choose Custom, you can insert a token that
evaluates to a Boolean expression 744 (by clicking on the
button), and the
page will only be visible if the token evaluates to True.

Figure 4.9 Formatting Page Visibility

The default background of a page is the background of the master page 141 . Each
page can have a custom background, however. To change the background of an
individual page:
1. Right-click anywhere on the page and select Format from the pop-up
menu.
2. In the Formatting Page dialog, navigate to the Background category
(Figure 4.10).
3. Click on the Custom radio button.
4. Choose the Color/Fill Pattern, Gradient, Image, or Transparent.
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Figure 4.10 Changing an Individual Page Background

The color of a page tab may be controlled from the formatting dialog based on a
series of Color Classifications.
1. In the Formatting Page dialog, click on the Color category(Figure 4.11).
2. Using the Change the color depending on the value of: dialog you can
insert a token that evaluates to a Boolean expression 744 (by clicking on the
button), and the color of the page tab will change if the token evaluates to any
of the classifications in the List of Colors section.
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Figure 4.11 Changing the Page tab Color classifiers

3. List of Colors allows you to create a series of classifications for colors by
clicking the Add button in the List of Colors dialog.
4. The Create Classification dialog will open (Figure 4.12) where you can
choose a Color for the page tab if a value, numeric or token based, falls in a
range you define.
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Figure 4.12 Adding a page tab color classifier with Color Token Bounds.

5. The Edit, Remove, Up, and Down commands in the Formatting Color dialog
allow you to adjust the List of Colors and Color Token Bounds as needed.

There are several ways to delete the current page:
Select Home

Page.

Right-click on the layout page and select Delete Page from the pop-up
menu.
Right-click on a Page Tab (e.g., "Page 2") on the Layout Navigation
Toolbar and select Delete from the pop-up menu.

4.1.6

Printing Pages from a Layout
To print a page (or range of pages) from the layout, select the File tab Print
command (Figure 4.13). A standard Print gallery will appear and allow you to
select what you wish to print. The printed pages will look exactly as they appear
within the page borders on the screen.
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Figure 4.13 Print Setup Dialog

The current Printer and Printer Properties may be accessed or changed in the
Printer section.
The sections under Settings will allow you to:
1. Choose which layout pages to print (Print All Pages, Print Current Page, or
Custom Range).
2. Choose to print layout pages as single or multiples per printed page(s). With
Full Page selected, each layout page will be printed as a single page. Multiple
layout pages may be printed per page using a preset multiple page option (i.e.
3 Pages with Notes or 9 Pages Vertical) or Custom Grid Options 39 .
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a. To print the layout pages on fewer pages, click the down arrow to the right
to expand the dropdown list and select a multiple page option or Custom
Grid Options... to select a preset multiple page option or customize the
tiling, respectively. When selecting Custom Grid Options, the Custom
Grid popup window will appear (Figure 4.14).

Figure 4.14 Custom Grid Options of Print Setup from File tab

b. Frame Page. Check this option to draw a frame around layout pages.
c. Scale To Fit. Will be automatically checked. Only uncheck if it is preferred
the content from the layout page is not scaled for the paper selected for
printing.
3. Choose to print on one side or both sides of the paper.
4. Choose collated or uncollated.
5. Choose to print in color or grayscale.

4.1.7

Exporting a Page as a Picture from a Layout
A page can be exported as a picture by selecting the File tab
Current Page As... command.
The picture can be exported as a Windows Metafile (*.emf), JPEG (*.jpg),
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Bitmap (*.bmp), Windows Extended Metafile (*.emf), Portable Network Graphics
(*.png), GIF (*.gif), or TIFF (*.tif).

4.1.8

Exporting a Layout as a PowerPoint® Presentation
A layout can be directly exported as a Microsoft PowerPoint® presentation. All
plots and text boxes are inserted into the PowerPoint presentation as Windows
Metafiles and can be moved, resized, and manipulated independently within
PowerPoint.

To save as a PowerPoint presentation, select the File tab
PowerPoint Presentation... command.

as

The Save as Microsoft PowerPoint Presentation dialog that appears allows
for the options described below:

PowerPoint Options
o Name the presentation. Use this field to select the output folder and
the name of the output file.
o Include the background (from Master Slide). Check this option to to
include the background from Master Slide. If you choose to export the
background, the objects on the FCS Express Master Page will be placed
on the PowerPoint master slide. These background objects will then
appear on all of the PowerPoint slides.
o Open presentation after saving. When checked, the PowerPoint
presentation will automatically open at the end of the export procedure
by launching PowerPoint.
o Hide objects that are off the page. When checked, objects that are
not located on the white page in the layout will not be exported to
PowerPoint.
o If the presentation already exists, append to it. Check this option to
append slides to an existing PowerPoint presentation.

Export Options
o Quality. Set the PowerPoint quality (High, Medium, Low, On-Screen)
from the dropdown list.
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o Mode. This option enables single or multiple layout pages to be exported
per slide based on selection. When Full Page is selected, each layout
page will be exported as a slide. Multiple layout pages may be exported
per slide using a preset multiple page option (i.e. 3 Pages with Notes or
9 Pages Vertical) or Custom Grid Options 39 . To export the layout
pages on fewer slides, please select a preset multiple page option or
Custom Grid by clicking the down arrow to the right to expand the
dropdown list and selecting a multiple page option or Custom Grid
Options..., respectively. When selecting Custom Grid Options, the
Custom Grid popup window will appear, which will contain following five
settings:
o Frame Page. Check this option to draw a frame around pages.
o Crop To Content. Available when Mode is not set to Full Page. When
selected, empty space of the layout page(s) is cropped during the
export.

Page Range
Choose which layout pages you wish to export.

Comparison of exports to PowerPoint using multiple page preset 4 Pages
Horizontal with or without selecting Frame Page and Crop to Content (Figure
4.15).
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Figure 4.15 Comparison of exports to PowerPoint using preset 4 Pages Horizontal.
Left: Frame Page and Crop To Content unchecked. Right: Frame Page and Crop To
Content checked

Note about ungrouping objects in PowerPoint for PC versus PowerPoint
for Mac
Once exported to PowerPoint, layout objects can be further ungrouped into
single components in the PC version of Microsoft PowerPoint. Ungrouping
objects saved by FCS Express in PowerPoint for Mac is not supported. However,
presentations saved on a Mac may be opened on a PC and ungrouped.

4.1.9

Exporting a Layout as a PDF File
A layout can be directly exported as an Adobe PDF file.
To save as a PDF file, select the File tab
command.

as PDF File...

The Save Layout as PDF File dialog that appears allows for different options:

PDF Filename
o Use this field to select the output folder and the name of the output file.
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o Open presentation after saving. When checked, the PDF file will
automatically open at the end of the export procedure.

PDF Options
Embed fonts (will increase file size). This option ensures that all of the
font information used to make your document look the way it does is
stored in the PDF file.
Export options
o Quality. Set the PDF quality (High, Medium, Low, On-Screen) from
the dropdown list. Higher quality documents will have better graphics, but
larger file sizes. PDF quality primarily affects the look of statistics
windows and gate views.
o Mode. This option enables single or multiple layout pages to be exported
per PDF page based on selection. When Full Page is selected, each
layout page will be exported as a PDF page. Multiple layout pages may
be exported per PDF page using a preset multiple page option (i.e. 3
Pages with Notes or 9 Pages Vertical) or Custom Grid Options 39 .
To export the layout pages on fewer PDF pages, please select a preset
multiple page option or Custom Grid by clicking the down arrow to the
right to expand the dropdown list and selecting a multiple page option or
Custom Grid Options..., respectively. When selecting Custom Grid
Options, the Custom Grid popup window will appear.
o Frame Page. Check this option to draw a frame around pages.
o Crop To Content. Available when Mode is not set to Full Page. When
selected, empty space of the layout page(s) is cropped during the
export.

Page Range
Choose which layout pages you wish to export.

Comparison of exports to PDF using default Custom Grid Options with or
without selecting Frame Page and Crop to Content (Figure 4.16).
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Figure 4.16 Comparison of exports to PDF using default Custom Grid Options (top
row only displayed). Left: Frame Page and Crop To Content checked. Right: Frame
Page and Crop To Content unchecked

4.1.10

Navigating through the Layout
There are many ways to navigate through the layout:
If the layout is larger than your screen, you can use the vertical scroll bar on the
right, or the mouse wheel, to move to different positions on the current page.
Press the Page Down key on your keyboard to move to the next page in
the layout.
Press the Page Up key on your keyboard to go to the previous page in the
layout.
Right-click on the layout and choose Previous Page or Next Page from
the pop-up menu.
Use the Layout Navigation Toolbar 55 (always located at the bottom left
corner of the layout). In the Layout Navigation Toolbar, you can:
o Click on the tab of a named page (e.g., "Page 2").
o Type the desired page number directly into the toolbar edit field.
o Press the arrow buttons located to the left or right of the edit field to go
to the next or previous pages. The buttons with single arrows will move
in single page increments. The buttons with the double arrows will move
to the beginning, or end, of the layout.

4.1.11

Viewing Pages
In the View Multiple Pages group, there are four commands [One Page, Two
Pages (Horizontal), Two Pages (Vertical), and Four Pages] for displaying
the entire layout in different views (Figure 4.17).
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Figure 4.17 Two Pages (Vertical) View

4.1.12

Zooming the Layout
It is possible to change the current zoom factor (in percentages) by using the
Zoom Toolbar 55 located below the Layout Navigation Toolbar 109 . You can enter
the desired zoom percentage directly into the toolbar edit field on the left or
press the Zoom command (with the magnifying glass icon) to access the Zoom
window. This window allows you to choose from several predefined zoom
factors (or type in a percentage in the edit field).

4.1.13

Auto Recovery Files
FCS Express can automatically create a backup of your layout, known as an
Auto Recovery file. By default, an Auto Recovery file will be created every 5
minutes. As a user option, you can turn off this feature, or change the interval
between autosaves, by editing the Save page of the User Options 222 dialog. If
FCS Express is terminated suddenly, and before the layout could be saved, then
the next time you start the program, you will be asked if you want to resume
using the AutoSaved file, which will have been given a unique name so as not to
overwrite the previous user-saved file.

4.1.14

Working with Multiple Layouts
In FCS Express, multiple layouts can be open at the same time. Each layout
opens in its own window. You can drag and drop objects (plots, data files, gates,
etc.) from one layout to another.
Use the View Windows Switch Windows command (and select the
appropriate layout from the drop-down list) to change which layout is active.
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Layout and Layout Performance Options
It is possible to access the Layout Options and Layout Performance Options
by selecting the File tab
.
If you have security enabled , the Layout Group Security Access
category
will also be available.
1140

1177

The Layout Options category (Figure 4.18) displays information about the
layout and allows you to assign a password to open the layout.
In addition, it also allows to customize the layout startup via the Startup Script
112 tool.

Figure 4.18 Layout Options Dialog

Note: Use caution when deciding to password-protect a layout. If you forget the
password, you will not be able to open the layout.
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If you have security enabled
Layout Options dialog.

1140

, additional properties will be available on the

The Layout Performance Options category (Figure 4.19) allows you to
choose if live updating of gates, quadrants, markers, statistics and tokens is
controlled at a global 317 User Options 317 level 317 or at the Layout Level.
Choosing the Specify the value below radio button will allow you to turn the
option to Update Immediately on or off for the current open layout via the
check box.

Figure 4.19 Layout Performance Options Dialog

4.1.15.1

Startup Script

The Startup Script tool allows the user to customize the layout every time it is
launched and is particularly useful to adapt standardized layouts to data acquired
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on different instruments with different settings for storing the data files.
Layout customization is performed via a series of questions which appear to the
user as messages on the screen when a script is defined. The layout or plots will
be customized based on the user's answers to the scripted questions.
Possible scripting customizations are:
Loading a specific file on specific plots and/or on specific overlays
Change parameters on specific plots and/or on specific overlays
Change the parameters used for a specific gate
Replace or Add parameters to an existing transformation
The questions, and the corresponding actions, are defined via an XML script.
If you are interested in using the scripting features in FCS Express, please
contact support@denovosoftware.com for additional information.

4.2

Introduction to Docking
FCS Express 6 has a flexible user interface. Dockable windows give you the
ability to customize your analysis workspace to fit your needs.
The following windows are dockable:
Data List
Layout Navigator
Data Navigator
Gate Navigator
Compensations
Snapshots
Batch Actions
Batch Run
Standard Operating Procedures
Standard Operation Procedures Run
Standard
Permission Rules
Alerts
Custom Tokens
Canned Comments
The remaining sections of this chapter explain how to work with dockable
windows.
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Opening a Dockable Window
Dockable windows are opened by clicking on the appropriate Ribbon
commands from the Batch Tab 72 , the Data Tab 76 , or the View Tab

55
82

.

The commands to open the dockable windows are listed in the table below.
Dockable Window Command
Data List
Data Organize Date Sets Data List or Batch
Sets Data List
Snapshots
Tools
Layout Navigator View Navigators Layout Navigator
Data Navigator
View Navigators
Navigator
Gate Navigator
View Navigators
Navigator
Compensations
Tools Transformations Compensations
Navigator
Transformations Tools Transformations Transformations
Navigator
Batch Actions
Batch
Standard
View
Operating
Procedures
Permission Rules Quality
Alerts
View
s
Custom Tokens
View
s
Canned
View
s
Comments

Organize Date

When opened, the window will first appear as a floating window, undocked, in the
center of the screen (Figure 4.20). You can leave it as a floating window, or
proceed to dock it in the location of your choice 115 .
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Figure 4.20 Data Navigator, Floating (Undocked)

4.2.2

Docking a Window
To dock a floating window:
Move the cursor over the title bar of the window (Figure 4.21).
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Figure 4.21 Title Bar of Floating Window

Press and hold the mouse button over the title bar while beginning to drag
the window. Docking Zone Selectors (a group of rectangles with
arrowheads designating the upper, lower, left, and right docking zones, and
a central square) will appear on the screen (Figure 4.22).

Figure 4.22 Docking Zone Selectors
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While keeping the mouse button down, drag the cursor over the appropriate
zone selector. Not all of the docking zone selectors may be active at all
times. When you position the cursor over an active docking zone selector, a
blue outline appears over the zone location (and a label confirms the
location). In the example (Figure 4.23), the cursor has been positioned over
the right docking zone selector. Notice the blue rectangle over the entire
right half of the screen indicating where the window will be docked (to
better illustrate the label in the lower right corner, it has been slightly
repositioned from where it will appear on your screen).
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Figure 4.23 Cursor Positioned over Right Docking Zone Selector

When you release the button with the cursor positioned over a docking
selector, the window will dock to the location you selected (Figure 4.24).
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Figure 4.24 Data Navigator Window Docked to the Right

If a window is already docked, and you are docking a second window,
docking zone selectors will appear in the middle of the screen and over the
docked window (Figure 4.25). In the example, the Layout Navigator is
being docked inside the already docked Data Navigator. If you dock one
window inside another, the two windows will occupy the same location, but
will be identified by tabs (Figure 4.26). If you dock two windows in the
same location but not inside each other, they will be separated by horizontal
or vertical splitter bars (Figure 4.27).
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Figure 4.25 Docking the Layout Navigator inside the Data Navigator

Figure 4.26 Docked Windows Identified by Tabs
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Figure 4.27 Docked Windows Seperated by a
Horizontal Splitter Bar

Note: Although docked windows are not part of the layout page and will not be
exported to other file formats, their location is saved along with your layout, and
they will be present when you re-open the layout.

4.2.3

Pinning a Docked Window
A docked window has a number of icons in the title bar. The pin icon (Figure
4.28) controls the Auto Hide feature.

Figure 4.28 Auto Hide Pin Icon in a Docked
Window

When the pin is pointing down, it indicates that the docked window is in the
standard configuration (unpinned). If you click on the pin icon, the Auto Hide
property will be activated. The pin will turn to the left and a tab with the window
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name will appear on the edge of the screen (Figure 4.29).

Figure 4.29 Docked Window with Auto
Hide Activated

With Auto Hide activated, the window will remain open whenever the cursor is
over the window. If you move the cursor away (or click on a different part of the
screen) the window will slide towards the edge of the screen and only the tab will
be visible (Figure 4.30). When a window is pinned, you can also hide it by clicking
on the X icon beside the pin. To open a hidden window, hover the cursor over
the tab.

Figure 4.30
Pinned Data
Navigator
Hidden from
View

Note: A window that has been pinned cannot be undocked 122 or closed 123 until it
has been unpinned (i.e., Auto Hide has been turned off). To unpin the window,
make the window visible, and then click on the pin icon.

4.2.4

Undocking a Window
Note: A pinned window cannot be undocked until it is unpinned

121

.

To undock an unpinned window:
Move the cursor over the title bar 115 of the window.
While holding down the mouse button on the title bar, drag the window
away from its docked position.
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Closing a Dockable Window
Note: A pinned window can be hidden on the edge of the screen, but cannot be
closed until it has been unpinned 121 .
To close an unpinned, dockable window, click on the X icon on the right side of
the title bar.

4.3

Navigators
Navigators in FCS Express are dockable windows 113 with drag and drop
functionality to help you find and manipulate the objects in your layout 123 , the
data sources 126 connected to your objects, and the gates 128 on your plots.

4.3.1

Layout Navigator
The Layout Navigator shows a hierarchical view of all of the objects in your
layout by page. Within each page node, plots and other objects are listed with
their data source (Figure 4.31).
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Figure 4.31 Layout Navigator

The first level of the hierarchy in the Layout Navigator is the page number. The
second level is the objects on your page, such as plots, gate views, text boxes,
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and data grids. If the object contains data (e.g., a plot or data grid), the data set
is shown, as well as an indication of whether or not the data is gated.
If you select an object on your layout, the corresponding node in the Data
Navigator will be highlighted. Hovering the mouse cursor over an object in the
docked 113 Data Navigator displays a thumbnail view of the object. In a layout
with more than one page, clicking on a node in the Data Navigator will change
the visible layout page to the page where the corresponding object is located.
Click on a node to expand it. While holding the mouse button down, drag an
object (e.g., a plot title) stemming from the node to your layout and release the
mouse button. The results of drag and drop operations from the Layout
Navigator are described in the table below.

Drag and Drop Operation from Function
Layout Navigator
Drag (or Copy & Paste, or Cut Moves the object to the new location. When Copy is
& Paste) an object to an empty used, a copy of the object is created in the new location.
part of the layout.
Drag an object onto an existing Adds the appropriate data to the existing object. You may
object in the layout.
be prompted to choose special paste format options.
Drag (or Copy & Paste) a data Brings up the Select plot types... 76 dialog to open plot(s)
set to an empty part of the
using this data set.
layout.
Drag (or Copy & Paste) a data Adds data to the plot. You will be prompted whether to
set to an existing plot.
replace the existing data or add it as a new overlay.
Drag a gate to a plot.
Applies the gate to the plot.
Copy a gate and paste it on a If the plot is an Histogram (i.e. 1D plot), the gate will be
plot.
applied to all the overlays on that histogram. If the plto is
a 2D plot, you will be prompted about creating a new gate
on the target plot.
Drag a plot to a text box.
Prompts you to create a keyword or statistics token from
that plot in the text box.
Within the navigator, drag (or Moves the object to the new location without losing
Copy & Paste, or Cut & Paste) token references. If Cut is used, the original object will be
an object onto another Page. removed. Note that token references are lost when using
cut and paste.
Within the navigator, drag and Reorder layout pages.
drop a page into a new
position.
Within the navigator, copy a
A copy of the page will be created into the new position.
page and past it into a new
position.
Delete.
This applies to either gates, pages and objects.
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Data Navigator
The Data Navigator shows a hierarchical view of all of the data currently
showing on your layout. Within each data node, plots and other data grids
displaying the data are shown. (Figure 4.32).

Figure 4.32 Data Navigator

The first level of hierarchy in the Data Navigator represents the data set nodes.
The second level is the plots and/or data grids associated with the data sets.
Hovering the mouse cursor over a plot or data grid in a docked 113 Data
Navigator window displays a thumbnail view of the object.
Click on a node to expand it. While holding the mouse button down, drag and
object stemming from the node to your layout and release the mouse button.
The results of drag and drop operations from the Data Navigator are described in
the table below.
In FCS Express, plots can be renamed directly in the Data Navigator by rightclicking plot title clicking Rename (Figure 4.33). Plot names can still be edited
using
command, via the ribbon bar, or by right clicking on the
plot of interest and updating Name field.
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Figure 4.33 - Renaming Plot in Data Navigator

Drag and Drop Operation from
Data Navigator
Drag a data set to an existing
plot in the layout (or to a plot
within the Data Navigator)

Function
Adds data to the plot. You will be prompted whether to
replace the existing data or add it as a new overlay. If
the target plot does not support overlays, the dragged
data set be loaded in the target plot.

Drag a plot to an existing plot in Adds data to the plot. If the target plot supports
the layout (or to a plot within overlays, the action brings up a Paste Special dialog to
the Data Navigator)
insert data or overlays. If the target plot does not
support overlays, the data loaded in the dragged plot will
be loaded in the target plot.
Drag (or Copy & Paste) a data Brings up the Select plot types... 76 dialog to open
set to an empty part of the
plot(s) using this data set.
layout
Drag (or Copy & Paste, or Cut & Opens a copy of the object the object in the new
Paste) an object to an empty location. When Cut is used, the original object is
part of the layout
removed.
Drag an object onto an existing Adds the appropriate data to the existing object. You will
object in the layout
be prompted to choose special paste format options.
Cut (or Copy) a plot (from the The data set loaded into the cut (copied) plot will be
layout or from the data
loaded into all the objects currently loading the target
navigator) and paste it on a
data set. When Cut is used, the cut plot is removed from
data set within the Data
the Data Navigator.
Navigator
Drag a plot (from the layout or The data set loaded into the dragged plot will replace the
from the data navigator) and
target data set.
drop it on a data set into the
Data Navigator.
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Drag and Drop Operation from Function
Data Navigator
Cut (or Copy) a plot (from the Adds data to the plot. If the target plot supports
layout or from the data
overlays, the action brings up a Paste Special dialog to
navigator) and paste it on a
insert data or overlays. If the target plot does not
plot within the Data Navigator support overlays, the data loaded in the dragged plot will
(or on a plot in Edit mode within be loaded in the target plot. When Cut is used, the cut
the layout)
plot is removed from the Data Navigator.
Copy a data set and paste it on Adds data to the plot. If the target plot supports
a plot within the Data Navigator overlays, the action brings up a Paste Special dialog to
(or on a plot in Edit mode within insert data or overlays. If the target plot does not
the layout)
support overlays, the data loaded in the dragged plot will
be loaded in the target plot.
Copy a data set and paste it on The copied data set will be loaded into all the objects
another data set
currently loading the target data set.

4.3.3

Gate Navigator
The Gate Navigator shows a hierarchical view of the gates that have been
defined in your layout, the plots on which those gates have been applied, and
data files the gates or Data Specific Gates are applied to (Figure 4.34). Any
action that can be completed in the Gate View 343 (i.e. change hierarchies, edit
gate information, and apply gates via drag and drop) can be accomplished with
the Gate Navigator except that the Gate Navigator is a separate dockable
window rather than an insertable object as is the Gate View. Moreover the Gate
Navigator can be used to:
Work with and view Data Specific Gates 323 and Data Specific Gate Groups 330
Change plot names (For plots, the name property is the name of the plot to
238 options 238 ) where the user is required to
display in lists (
select a plot. The name is also used when displaying objects in different
Navigators 123 )
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Figure 4.34 Gate Navigator

The first level of hierarchy in the Gate Navigator represents the gates defined in
your layout. The second level is the plots using those gates. Hovering the mouse
cursor over a plot in the docked 113 Gate Navigator window displays a thumbnail
view of the plot.
Double clicking on a gate node will launch the Edit Gate dialog
information can be changed or updated.

343

where gate

Click on a node to select it. While holding the mouse button down, drag the node
to your layout and release the mouse button. The results of drag and drop
operations are described in the table below.

Drag and Drop Operation
Drag a gate to a plot in the
layout (or to a plot within the
Gate Navigator).
Drag (or Copy & Paste, or Cut
& Paste) a plot (in the layout
or within the Gate navigator)
onto a gate of the Gate
Navigator.
Drag (or Copy & Paste, or Cut
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The target gate will be made Data Specific for the dragged
data. If Cut is used, the cut plot will be removed.

A copy of the plot will be created in the new location. If
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Drag and Drop Operation
& Paste) a plot to an empty
part of the layout.
Drag a plot onto a plot in the
layout (or to a plot within the
Gate Navigator)

Copy and Paste (or Cut and
Paste) a plot from the Gate
Navigator onto a plot in Edit
mode within the layout

Drag and drop a gate to a
different position within the
Gate Navigator

Function
Cut is used, the cut plot is removed.
Adds the appropriate data to the existing object. If the
target plot supports overlays, the action brings up a
Paste Special dialog to insert data or overlays. If the
target plot does not support overlays, the data loaded in
the dragged plot is loaded in the target plot.
Adds data to the plot. If the target plot supports overlays,
the action brings up a Paste Special dialog to insert data
or overlays. If the target plot does not support overlays,
the data loaded in the dragged plot will be loaded in the
target plot. When Cut is used, the cut plot is removed
from the Data Navigator.
The gate is moved into the new position in the hierarchy.

Note: The Gate Navigator is a complementary tool to the Gate View 343 . The gate
view allows similar functionality in terms of dragging and dropping to/from plots,
but allows additional gating functionality.
The Gate navigator window can be formatted in order to display or not display
plots on which those gates have been applied as well as data files the Data
Specific Gates are applied to.
To format the Gate Navigator:
1. Right click on any empty part of the Gate Navigator window.
2. Select Format from the right-click menu. A Formatting Gate Navigator
window with the following options will open:
Create plot navigator items. Flag this item to display plots on which gates
have been applied within the gate navigator window.
Show data specific gates. Flag this item to display data specific gates within
the gate navigator window.

4.4

Layout Page Features
Individual objects in FCS Express can be manipulated almost identically to objects
in Microsoft PowerPoint®. Not only can individual objects be stretched, resized,
and formatted, but any item on the layout can be aligned with respect to any
other item. Multiple items can be selected at once and actions can be performed
on all the selected items. Every item that can be inserted onto a Layout Page in
FCS Express has a formatting menu associated with it. To access the formatting
dialog for any object, hover the cursor over the object and right-click. When the
formatting menu appears, select the desired function.
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Inserting Items onto a Page
Use the Insert Tab 69 to insert objects on the current layout page. The objects
you can insert are located in five groups:
General
Shapes (Line, Arrow, Ellipse, Rectangle), Text Box, Gate View,
Picture, Data Grid
Spreadsheet

412

New spreadsheet
1D Plots
Histogram, Kinetics, Multicycle DNA, Proliferation, Bar, Pie
2D Plots
Dot, Density, Color Dot, Contour, Surface, Scatter

To insert an object on the layout page in the default size:
1. Click on the command within the group.
2. Position your cursor at the point on the layout page where you would like
the upper left corner of the object to be.
3. Click on the layout page and FCS Express will position your object there.
To insert an object on the layout page in a custom size:
1. Click on the command within the group.
2. Drag a sizing rectangle on the layout while holding down the mouse
button.
3. Release the mouse. The object will be inserted into the sizing rectangle.

4.4.2

Selecting Items on a Page
To work effectively with objects/items in FCS Express, you must understand the
difference between edit mode and selected mode.
In order for an object to be manipulated, the object must first be selected. A red
border surrounding the object denotes that it is selected. Only selected items can
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be moved, resized, deleted, etc.
In order to edit items within an object, the object must first be in edit mode. For
example, to modify a gate, the plot containing the gate must be in edit mode.
When an item is in edit mode, it displays a green border.
Figure 4.35 shows one item in selected mode and one item in edit mode.

Figure 4.35 Selected and Edit
Modes

Many items can be selected at the same time, but only one item can be in edit
mode at one time.
To put an object into edit mode, click anywhere within the interior of the object.
A green border will appear around the object signifying that it is in edit mode. If
an object is in edit mode, but does not contain any items that can be selected,
the object will behave as if it is in selected mode. For more information on editing
items contained within a plot, refer to the following sections: Adding a Text Box
to a Plot 164 , Using Gates 316 , and Using Markers 350 .
To put a single item into selected mode, move the cursor over the border of the
item. The cursor will change to a 4-headed arrow
. Click the border once. A
red border will be displayed around the item indicating that the item has been
selected. Alternatively, you can put an item directly into selected mode by
holding down the Shift key while clicking anywhere on the item.
There are two methods for selecting multiple specific items at the same time.
The first method uses a click and drag feature (Figure 4.36). If the items for
selection are located near one another on a page, draw a rectangle around all of
the items to be selected. Press and hold down the mouse button at the top left
of where you want the rectangle to be, then drag the cursor down and to the
right. The point that you release the button will be the bottom right corner of the
rectangle. All items inside this area will now be selected (so that they may be
manipulated together).
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Figure 4.36 Selecting Multiple Objects with Click and Drag

The second method of selecting multiple specific items is useful when the items
are not located in close proximity to one another. Once the first item has been
selected as a single item, place the cursor anywhere over the next item you wish
to select. Press and hold the Shift key while clicking. The second item should
now have a red border. Continue the Shift-Click selection process for each
additional item you wish to select. Once multiple objects have been selected,
they can be copied, cut, resized, moved, and aligned simultaneously as explained
in the sections below.
If you want to select all of the items on the current page, use
Home
. Alternately, press Ctrl+A.
Clicking outside the selected item(s) will deselect them and put them in a neutral
state (no red or green border).

4.4.3

Overlaying Items on a Page
In addition to the edit and selected modes, FCS Express 6 introduces a third
mode called overlay. When an object is in Overlay Mode, it is outlined in blue
(Figure 4.37).
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Figure 4.37 - Histogram in Overlay Mode

Dragging and dropping selected data file(s) from the Data List onto the following
plots, will activate overlay mode and prompt the Select Drag and Drop Action
window upon mouse release:
Histogram, Kinetics, Multicycle DNA, Proliferation, Scatter, Scatter with
Regression, Bar Chart, Pie Chart, Dot, Color Dot, Heat Map
Dragging and dropping selected data file(s) from the Data List onto the following
plots, will activate overlay mode and replace data upon mouse release:
2D Plots - Contour, Density, Surface
Dragging and dropping Gates, Markers, or Quadrants onto plots will activate
overlay mode and be applied upon mouse release.
Dragging and dropping plots onto Text boxes will activate overlay mode and
prompt Paste Special window to select Keyword or Statistic Token.

4.4.4

Grouping Items on a Page
Individual objects on a page can be grouped together. After grouping items, all
objects in the group will be selected if any one item in the group is selected.
This can be useful, for example, if several objects are in a specific relative
location to each other and you want to make sure that you cannot move one
without moving all of the others. Since when objects are grouped, selecting any
one of them will select all of them, the move operation will be applied to all the
selected objects together.
In order to create a group, select the objects you want to group as described
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, then, either:

Select the Group command from the Home

gallery, or

Right-click when the cursor is within one of the selected objects and
choose
from the pop-up menu.

To ungroup objects, use either of the following methods:
Select the UnGroup command from the Home
or

gallery,

Right-click when the cursor is within one of the selected objects and
choose
from the pop-up menu.

4.4.5

Cutting, Copying, Deleting, Duplicating, and Pasting Items on
Pages
After selecting one or more objects as described under Selecting Items on a
Page 131 , use the Home
commands or Ctrl+X (cut) or Ctrl+C
(copy) on your keyboard to perform standard word processing functions (e.g.,
Cut, Copy). Objects that have been copied to the clipboard with these functions
can be pasted onto different pages or even onto a different layout using the
Home
Paste command, or Ctrl+V on your keyboard.
To delete an object, select it and use the Home
(or press the Delete key on your keyboard).

command

The Home
command duplicates the selected item(s). A
copy and paste function will be performed at the same time. By clicking on the
down arrow associated with Duplicate, the command expands to reveal five
items: Duplicate, Duplicate and Next, Duplicate and Prev(ious), Multiple
Duplicate and Next, and Multiple Duplicate and Prev(ious).
The Next and Prev functions associated with these commands duplicate the
selected object(s) and change to the next or previous file in your data list. The
Multiple commands allow you to make more than one copy of the selected
item(s). The default positioning of the duplicated objects can be set in user
options 180 .
Note: In FCS Express 6, objects and text can be copied into another application
simply using the copy and paste functions, without loss of formatting
information. Text boxes, statistics tables, compensations, and other items in
tabular format can be copied from FCS Express and pasted into spreadsheet
software such as Microsoft Excel in the same format.
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Moving Objects
In order to move an object, or group of objects, they must be in selected mode
(as described under Selecting Items on a Page 131 ).
To move selected object(s), position the cursor on the "moving region" of the
selected object, i.e., the red border surrounding the object. Note: With some
objects, such as pictures, the "moving region" is the entire object. Once the
cursor is above the moving region, it changes to a four-headed arrow
. When
the four-headed arrow appears, hold down the mouse button and move the
selected object(s) to the desired location. After the object is in place, release the
mouse button.
You can also move selected objects using the keyboard. When the objects are
selected, pressing the arrow keys will move items up, down, left, or right.
Holding down the Shift key when pressing the arrow keys will move the selected
objects in finer increments.

4.4.7

Resizing Objects
To resize selected object(s), position the cursor over the one of the corners of a
selected object until the cursor becomes a two-headed arrow. When the twoheaded arrow cursor is present, hold down the mouse button while moving the
cursor to resize the object. Release the mouse button once the item has
reached the desired size. If you hold down SHIFT while resizing, the aspect ratio
(height vs. width) of the selected object(s) will be maintained.
The Format tab
command opens a dialog window where the desired size
can be specified by height X width, or scale (percent).
A convenient way to resize several objects to the same size is using the Align
tool 137 .

4.4.8

Aligning Objects
The sides, tops, bottoms, centers, heights and/or widths of objects can be easily
aligned.
To align multiple items, first select the objects you wish to align, and then go to
Home
or Align. This will bring a list of the alignment tools
that can be used to align your selected objects. (Figure 4.38).
Clicking on Align, under the Position Objects section, will open the Alignment
dialog window, as seen in Figure 4.
Note: The Distribute Equally item in the Align dialog ensures that there is an
equal distance, horizontally or vertically, between all the selected objects.
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Figure 4.38 Align Menu

Objects are aligned with respect to the first item selected. For example, if you
select several items, use the Home
command, the
tops of all the items will be placed in the same position as the first selected item.
An example of objects whose horizontal centers were aligned is shown in Figure
4.39.

Figure 4.39 - Before Alignment (left); After Alignment of Tops (right)

To make multiple objects the same size:
1. Select the object(s) you wish to resize.
2. Ctrl + Click on the objects to be resized.
3. Use both Home Editing Align Align Widths and
Home Editing Align Align Heights commands. All objects will be
resized to the dimensions of the first object you selected.
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Ordering Objects
You can also control which object(s) are on top of other objects. This is very
useful when objects overlap each other in the layout and you wish to determine
which is on top. To change the order of selected object(s), choose
Home
and then select a command from the list in the
Order Objects portion of the gallery (or right-click on selected object(s) and
choose a menu item under Order).
The commands function as follows:
• Bring to Front
Brings the selected object(s) to the front of all overlapping objects.
• Send to Back
Sends the selected object(s) all the way to the back of all other
overlapping objects.
• Bring Forward
Brings the selected object(s) one level towards the top of all other
overlapping objects.
• Send Backward
Sends the selected object one level towards the back of all the other
overlapping objects.

Figure 4.40 demonstrates the results when you rearrange the order of the red
circle and the green rectangle.
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Figure 4.40 Ordering Objects

4.4.10

Undoing and Redoing Changes
FCS Express allows up to 30 operations to be undone or redone by default.
Undo
To undo any changes made to a layout, select
(Undo) from the Quick Access
Toolbar 65 . The text of the tooltip associated with the Undo icon will indicate
which operation will be reversed or undone.
You can also use the Ctrl+Z keyboard shortcut to undo the last operation you
performed.
Redo
To redo any changes made to a layout, select the
(Redo) from the Quick
Access Toolbar 65 . The text of the tooltip associated with the Undo icon will
indicate which operation will be reversed or undone.
You can also use the Ctrl+Y keyboard shortcut to redo the last operation you
performed.

4.4.11

Page Layout Using Predefined Placeholders
Using the Design
command or Home
Page command, you can select and apply predefined layouts to the current page
(Figure 4.41).
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Figure 4.41 Layouts Using Predefined Placeholders from Design tab (left) or Home
tab (right)

To most efficiently use this tool, look for a predefined layout containing objects
similar to the layout you would like to create. By selecting a predefined layout,
the current page is populated with placeholders. Now you can easily insert plots,
text boxes, and pictures into the Placeholders with a simple mouse click. The
placeholders behave similarly to any other object and can be moved, resized,
copied to the clipboard, and aligned. An example plot placeholder is shown in
Figure 4.42.

Figure 4.42 An Example Plot Placeholder

4.5

Using the Master Page
The Master Page is always present in a layout and therefore does not need to be
created. Anything inserted onto the Master Page will appear by default as the
background of all pages of a layout. For example, a Text Box containing the
current date, time, and page number inserted onto the Master Page will
automatically appear on all of the pages in the layout. However, you can choose
on an individual page basis 98 , whether or not the master page appears as the
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background of that page.
To view the Master Page, select the View
(Figure 4.43).

command

Figure 4.43 - Master Page
from Ribbon

The default background that will appear on all the pages can be edited on the
Master Page as described in Changing Background Color and Design 141 .

4.5.1

Changing Background Color and Design
To change the background of the Master Page, open the Master Page as
described in Using the Master Page 140 , right-click anywhere on the master page,
and choose Format from the pop-up menu. When the Formatting Master
Page dialog appears, choose Background from the category at left (Figure
4.44).

Figure 4.44 Formatting Master Page Background Screen

The Master Page default setting for background is white as a solid color. You
may choose another solid color, a color gradient, or an image for the
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background. If you select an image, you will be able to stretch it over the entire
page or center it on the page.
A page with a thin black shadow will always appear around the border of the
page, unless you choose the Transparent radio button on the Format Master
Page dialog. Having a transparent page is useful if you simply want to analyze
some data and do not care about the specific layout on the page.

4.6

FCS Express Short Cut Keys
FCS Express 6 contains many shortcut keystroke combinations to make
navigating and working within the software easier. The table below summarizes
the available short cut keys.
Shortcut
Ctrl+C
Ctrl+V
Ctrl+X
Shift+Del
Ctrl+Ins
Shift+Ins
Ctrl+Z
Ctrl+Y
Ctrl+B
Ctrl+I
Ctrl+U
F2
Ctrl+A

Del

Ctrl+D

Command
Copy

Applies To
Objects on layout, tokens, text,
items into navigator views
Paste
Objects on layout, tokens, text,
items into navigator views
Cut
Objects on layout, tokens, text,
items into navigator views
Secondary shortcut Objects on layout, tokens, text,
for Cut
items into navigator views
Secondary shortcut Objects on layout, tokens, text,
for Copy
items into navigator views
Secondary shortcut Objects on layout, tokens, text,
for Paste
items into navigator views
Undo
Any action in the layout
Redo
Any action in the layout
Bold
Text in text boxes and labels in
selected plots
Italic
Text in text boxes and labels in
selected plots
Underline
Text in text boxes and labels in
selected plots
Rename
Items in navigator views and batch
actions and items
Select all
Objects on layout, text, data list,
batch actions, custom tokens,
canned comment, and alerts
navigator
Delete
Selected object on layout, selected
item in navigator views, selected
text, selected user in non secure
login mode
Duplicate
Selected object on layout, selected
gate, custom tokens, canned
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comments and alerts in navigator
views
PgDn
PgUp
Ctrl+N
Ctrl+O
Ctrl+S
Ctrl+Shift+S
Ctrl+P
Ctrl+Shift+P
Ctrl+W
F1
Up
Down
Left
Right
Esc
Space
Ctrl+Alt+D
Shift+Ctrl+D
Alt+Left
Shift+Alt+Left
Alt+Right
Shift+Alt+Right
Ctrl+L
Shift+Alt+L
Ctrl+Alt+E
Shift+Ctrl+E
Ctrl+E
Ctrl+F
1-9
© 2020 De Novo Software

Switch to next page Layouts with multiple pages
in layout
Switch to previous Layouts with multiple pages
page in layout
Open new layout Any layout
Open layout
Any layout
Save current layout Any layout
Save current layout Any layout
As
Print current layout Any layout
Print Setup
Any layout
Close current layout Any layout
Show help
Any layout
Scroll up
Layout or selected object
Scroll down
Layout or selected object
Scroll left
Layout or selected object
Scroll right
Layout or selected object
Cancel adding or Plots, shapes and gates
editing
Finish creating a Creating polygon gates
polygon gate
Duplicate and
Plots and data grid
Previous
Duplicate and Next Plots and data grid
Previous on selected Plots and data grid
objects
Previous on all
Plots and data grid
objects
Next on selected Plots and data grid
objects
Next on all objects Plots and data grid
Change data file for Plots and data grid
selected plot
Change data file for Plots and data grid
all plots
Multiple duplicate Plots and data grid
and previous
Multiple duplicate Plots and data grid
and next
Edit user name User profiles from User Selection
window
Edit format
Objects, Text Boxes, Plots, Data
Grids, and Shapes
Change x parameterPlots
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for selected plot
Change y parameter Plots
for selected plot
Ctrl+M
Maximize/Restore Plots
from the plot's
menu
Double Click on Plot
Opens Format
Plots
Dialog
Double Click on Page
Opens Format
Page tabs
Tab
Dialog
Hold Alt key
Command keys Ribbon
highlight on ribbon pressing highlighted
command keys
activates action
Hold Shift key click
Put object in
Objects, Text Boxes, Plots, Data
on object
selection mode Grids, and Shapes
without allowing
moving
Shift+1-9
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Working with Pictures
In addition to plots and text boxes, FCS Express allows you to insert pictures
into layouts. For working with images from Image Cytometry experiments
please see the topics on Picture Plots
and Image Galleries.
1046

5.1

Inserting Pictures
To insert a picture onto a layout page, use the Insert
command. Click on the layout where you would like to place the picture and the
Insert Picture dialog (Figure 5.1) will appear, allowing you to select the picture
you want to insert. Once the picture has been selected, click on the arrow
located on the Open button (to the right of the file name), and choose either
Yes or No for embedding picture. In both cases, the picture will be placed on the
current page.
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Figure 5.1 - Insert Picture Dialog

The following graphics file types are supported: Windows Bitmaps (*.bmp),
Portable Network Graphics (*.png), JPEG files (*.jpg), GIF (*.gif), Device-
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Independent Bitmaps (*.dib), PCX Images (*.pcx), TIFF (*.tif), Icons (*.ico),
Windows Metafiles (*.wmf), and Windows Extended Metafiles (*.emf).

Once a picture is selected to be inserted, an Embed Picture Message (Figure 5.2)
will appear. If you choose Yes, the picture will be saved as part of the layout file.
If you choose No, the picture will not be saved as part of the layout and the file
will be smaller. However, if the layout file is moved to another computer, or the
picture is moved to another location, the linked picture will no longer be visible
when the layout file is opened.

Figure 5.2 - Embed Picture Message

5.2

Formatting Inserted Pictures
To format a picture, select the picture and choose the appropriate command
from Format
. Alternatively, right-click on the Picture and
select Format from the pop-up menu.
The Formatting Picture dialog (Figure 5.3)will allow you to edit the border and
size 242 of the image as well as general settings and formatting authorizations.
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Figure 5.3 - Formatting Picture Dialog
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Working with Text Boxes
Text Boxes are used to insert text anywhere you want on the layout. Text
Boxes can be used to display text, statistics, tables, page numbers, as well as
entire paragraphs. Text boxes support all the formatting options that are
available in modern desktop publishing applications, including bullets, numbering,
paragraph alignment, and font properties.

6.1

Inserting Text Boxes onto a Page
To insert a Text Box onto a page, use the Insert
command (Figure6.1). Immediately after placing the Text Box on the Page, it will
be in edit mode.

Figure 6.1 - Inserting a Text Box

6.2

Quadrant Label Text Boxes
Plots displaying quadrants have a unique type of text box displayed referred to as
a Label Text Box. A Label Text Box may be formatted much like a normal text
box 153 in FCS Express, but the contents cannot be edited by clicking on and
selecting the text box as you would do with other standard text boxes in FCS
Express.
Label Text Boxes on plots default to display the quadrant statistic defined by
your 2D Plot Option User Options 191 .
To change the contents of a Quadrant Label Text Box please follow the steps
below.
1.Click on the quadrant Label Text Box to select it.
2.Right click in the selected Label Text Box.
3.Choose Format.
4.Choose the Text Box Contents category (Figure 6.2).
5.Change the contents in the Text Box Contents field to your desired text,
symbols, or token 688 .
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The Label Text Box on the plot will now reflect the entry in the Text Box
Contents field.

Figure 6.2 - Label Text Box (for quadrant derived text boxes) Dialog

6.3

Entering and Formatting Text in a Text Box
In order to enter text in a Text Box, place it in edit mode
inside it.

131

by clicking anywhere

The Text Box can be used just like a word processor meaning you can:
Cut/Copy/Paste text within the Text Box.
Format the text (font, alignment, etc.).
Insert numbering and bullets.
Paste text from word processing applications.
Copy text from a Text Box and paste it into a word processor.
In addition, Tokens, may be placed in text boxes. 688
The most common formatting options are available on the Text 75 tab. Detailed
text formatting can be performed using the commands of the Text
and
groups.
If the text box is in edit mode, changing fonts will change the currently selected
text. If the text box is in select mode, changes to the font properties will affect
all the text in the text box. The Text Box automatically grows when the text
being entered reaches the bottom of the Text Box window.
The Font and Paragraph groups contain dialog box launchers on the lower right,
indicated by the
button.
This Font dialog (Figure 6.3) allows you to change all font properties. With the
Layout Tab options, you can change the character spacing and subscript/
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superscript offset.

Figure 6.3 - Font Tab and Dialog

To control the detailed aspects of paragraph formatting, use the Paragraph
dialog box launcher. The Paragraph dialog (Figure 6.4) allows you to change
paragraph indentation and spacing settings, including text alignment, line spacing,
and first-line indentation.
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Figure 6.4 - Paragraph Dialog

In order to modify detailed aspects of the bullet and numbering styles, click on
the Bullets and Numbering button in the paragraph group while a text box is
selected. The Bullets and Numbering dialog allows you to set bullets and
numbering appearance and it provides options for creating new types of bullets
(Figure 6.5).
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Figure 6.5 - Bullets and Numbering Dialog

6.3.1

Inserting Tables
Tables can be inserted into a Text Box by either of the following methods:
If the Text box is in edit mode, select the Text tab
Table command.
Right-click in the Text Box and select Table
menu.

Insert Text

Insert

Insert Table from the pop-up

The Insert Table dialog will appear (Figure 6.6) where you can choose the
number of rows and columns, as well as the size of the table. We recommend
keeping the setting at autosize for the best performance. To save these settings
for creating future tables, click on the Remember dimensions for new tables
checkbox.
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Figure 6.6 - Insert Table Ribbon and Dialog

Tables can also be:
Pasted from Microsoft
then select the Home
keyboard shortcut).
Pasted from Microsoft
then select the Home
keyboard shortcut)

6.3.2

Word. Simply copy the table to the clipboard in Word,
Clipboard Paste command (or use the Ctrl+V
Excel. Simply copy the table to the clipboard in Excel,
Clipboard Paste command (or use the Ctrl+V

Formatting Tables
If you click the cursor in one of the cells of a table (or select a group of cells by
dragging the cursor across the cells you want to highlight), you can choose
formatting options by one of the following methods:
Select one of the commands from the Text

Table group.

Right-click while the cursor is in the table, select Table from the first pop-up
menu, and choose a command from the submenu.

The table below shows the formatting commands that are available.
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Command
Insert Row Above
Insert Row Below
Insert Column to the
Left
Insert Column to the
Right
Delete Rows
Delete Columns
Table Properties 158
Merge Cells
Split Cells

Explanation
Insert a row above the cell where the cursor resides.
Insert a row below the cell where the cursor resides.
Insert a column to the left of the cell where the cursor resides.
Insert a column to the right of the cell where the cursor resides.
Delete the current row or the selected rows.
Delete the current column or the selected columns.
Opens a menu used to set general table properties, as well as set
properties for the selected rows and cells.
The text from all selected cells will be merged into one cell.
The cell(s) will be split into multiple cells.

Note: The Merge Cells and Split Cells commands are only available through the
pop-menu.
6.3.2.1

Table Properties

The Table Properties window is accessed by right clicking on a
table Table Table Properties and is divided into 3 tabs as outlined below.
Table Tab.
These settings apply to the whole table (Figure 6.7):
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Figure 6.7 - Table Properties - Table Tab

o Width
Set the table width in pixels or as a percentage of Text Box width.
(Note: Most users find changing the width of individual columns
works better than using this option to determine table width.)
o Fill Color
Choose the background color of the table.
o Cell padding
Set the amount of space between the text of a cell and its border.
o Cell spacing
Set the amount of space between cells.
o Picture
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Load a picture as the background of the table.
o Table Border
Set the color and width of the table border (the outer frame of the
table).
o Cell Border
Set the color and width of the individual cell borders.
o Printing
Allows you to choose to not to allow columns to break across
pages during printing.
Allows you to choose a number of heading rows depending on your
needs.

Rows Tab
These settings apply to the vertical alignment, printing, and cell colors of
the selected row(s) (Figure 6.8).
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Figure 6.8 - Table Properties - Rows Tab

o Top
Align text to the top of the selected rows.
o Center
Align text to the center of the selected rows.
o Bottom
Align text to the bottom of the selected rows.

Columns Tab
These settings apply to the cell colors and banding of the selected
column(s) (Figure 6.9).
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Figure 6.9 - Table Properties - Columns Tab

Cells Tab
These settings apply to the selected cell(s) (Figure 6.10).
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Figure 6.10 - Table Properties - Cells Tab

o Width
Set the width of the current or selected cells.
o Height
Set the height of the current or selected cells.
o Fill Color
Set the background color of the current or selected cells.
o Picture
Load a picture as the background of the current or selected cells.
o Vertical alignment
Set the vertical alignment of the current or selected cells. (Note: To
align a full Row, use the Table Properties - Rows Tab.)
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o Border
Set the color of the current or selected cell borders.

6.3.3

Exporting a Table to Excel
A table can be exported to Excel without formatting loss. Please refer to the
Exporting a Text Box to Excel 166 to perform this action.

6.4

Resizing Text Boxes
You can change the text box size as described in Formatting Text Box Features
165 . Alternately, you can resize text boxes the same way all items are resized in
FCS Express 136 , with the following exceptions. When a text box contains a token
or table, you will not be able to make the text box narrower than the token or
table. Furthermore, you will not be able to adjust a text box smaller than what is
necessary to display the current text. In either case, attempts to adjust a Text
Box too small will cause the text box to automatically resize to the smallest
acceptable size. In addition, text boxes will automatically become larger when
you add text or insert other items (tables, tokens, etc.) that would not
otherwise fit within the current size.

6.5

Adding a Text Box to a Plot
You can also place a text box directly inside a plot using one of the following
methods:
Putting the plot in Edit Mode by clicking anywhere inside it, followed by
selecting the Insert Text Box command and then clicking inside the plot.
Right-click on a plot and select Add Text Box. A Text Box will be inserted
inside the plot borders.
If you have deleted a marker, quad, or gate text box from your plot, you can
recreate them by right-clicking on the plot and choosing the appropriate
command (Recreate Marker Text Boxes, Recreate Gate Text Boxes, or
Recreate Quad Text Boxes) from the pop-up menu (Figure 6.11).
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Figure 6.11 - Right-click Pop-up Menu
wth Recreate Gate and Quad Text
Boxes Commands

6.6

Formatting Text Box Features
You can change the text box border and size, or set a background by:
Selecting the text box and using commands from the Format Tab.
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Opening the format window. To open the format window, right-click on a
text box and select Format from the pop-up menu. (Note: If the text box
is inside a plot make sure that the text box is in edit mode). The format
window allows you to change the border 242 , size 242 , and background 226 of
the text box. The default background for a text box is transparent.
Text boxes derived from quadrant statistics are referred to as Label Text
Boxes. Please see the section on Quadrant Label Text Boxes for formatting
instructions 152 .

6.7

Adding Tokens to Text Boxes
In addition to plain text, you can also insert statistics and other information inside
a text box using tokens. The statistics or information in the token text will
update as the analysis changes. For more information on tokens, see Using
Tokens 688 .

6.8

Exporting a Text Box to Excel
The content of a text box (tables included) can be completely exported to Excel
without formatting loss via the following steps:
1. Select the entire text box (please see the Selecting Items on a Page

131

topic

for more information on this).
2. Right click on the text box red border and select Copy from the right click
menu. Alternatively, press Ctrl+C on your keyboard.
3. Open Microsoft Excel.
4. Right click on the destination cell and select Paste from the right click menu.
Alternatively, left click on the destination cells to select it and press Ctrl+V on
your keyboard.

A part of the text box can be selectively exported to Excel via the following
steps:
1. Select the text (or the table) of interest.
2. Right click on the selection select Copy from the right click menu.
Alternatively, press Ctrl+C on your keyboard.
3. Open Microsoft Excel.
4. Right click on the destination cell and select Paste from the right click menu.
Alternatively, left click on the destination cells to select it and press Ctrl+V on
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your keyboard.
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Working with Plots
FCS Express supports many different ways of displaying your data. You can view
the raw data in a Data Window 676 , or display the data in many different types of
plots described in this chapter.

7.1

Data Display Plot Types
FCS Express has 16 different types of plots (grouped into 1D Plots, 2D Plots,
and Other Plots on the Insert Tab) to allow you to display your data in many
different ways. The different types of plots are:
1D Plots - (one-dimensional) plots allow you to display one parameter of your
data. You can also display a cumulative probability distribution of your data.
o A Histogram bins all of your data into a discrete number of bins, and sums
all the events that fall into the individual bins. In a Histogram, the data is
typically displayed as the data value on the X-axis and number of events on
the Y-axis.
o In a Kinetics 918 plot, the X-axis is the Time parameter and all of the Y-value
events are averaged for each unit of time.
o Multicycle DNA histograms
DNA cell cycle statistics.

889

are a subset of one-dimensional plots that fit

o Proliferation histograms 907 are a special subset of one dimensional plots that
automatically model proliferation statistics.
o Spectrum plots 926 are a subset of one-dimensional plots to graphically
display spectral data.
o Bar plots 544 can be used to graphically display statistics from plots, default
statistics or text tables, or custom data 412 .
o Pie charts 535 can be used to graphically display statistics from plots, default
statistics or text tables, or custom data 412 .
2D Plots - (two-dimensional) plots allow you to plot one parameter against
another parameter.
o Dot plots represent each cell with an individual dot. Dot plots always display
the dots in the overlay color. Dot plots may also be Shaded Based on
Density 307 .
o Density plots. In a density plot, the color of an area reflect how many
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events are in that position of the plot. Density plots may also be set to base
color on 287 a different parameter and set to shade base on density 307 .
o Color Dot plots. In a color dot plot, the colors can mean one of two
different things. If there is only one overlay on the plot, the colors refer to
which cells fall into which gate. If there is more than one overlay on the plot,
the color refers to which overlay that dot belongs to. If one dot actually
belongs to more than one overly, the color of the dot will be randomly
chosen among the overlays. Color Dot plots may also be Shaded Based on
Density 307
o Contour plots are the same as density plots, with the exception that
contour lines represent different numbers of cells, rather than colors. A
contour plot looks very similar to a topographical map. Contour plots may
also be set to base color on 287 a different parameter
o Surface plots. Together with the two parameters on the X- and Y-axes, the
Z-axis displays the number of events.
o Scatter plots

556

can be used to graphically display custom data

412

.

o Scatter with regression plots 575 can be used to graphically display custom
data 412 with the regression curve 574 automatically overlaid onto the plot
(e.g., in generating a titration curve).
Note: Dot, Density, Contour, and Color Dot plots all bin your data into a
discrete number of bins. Therefore, the dot size of these plots is related to
the number of bins that the data is being divided into. Scatter plots do not bin
your data, but put a symbol at the location of your data value. The symbol
size is controlled by the Formatting preferences. The binned plots are a better
option when viewing data sets containing large numbers of data points (i.e.,
>5000). Scatter plots are more useful when displaying smaller numbers of
data points, where customization of the point shape and style are more
important.

7.2

Inserting Plots
To insert plots on a layout page in the default size, use either of the following
three methods:
Select the command associated with the plot type you desire from the 1D
Plot, 2D Plot groups on the Insert Tab. Then, click on the layout page at
the point where you want the upper left corner of the plot to be (or drag a
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sizing rectangle on the layout). The file that FCS Express will associate with
the plot is explained in the section on The Current Data File 172 .
Drag a file from the Data List 783 and drop it onto an empty spot on your
layout. You will be prompted to select which plot type to insert in the
Select Plot Types... dialog box.
Drag a gate from an existing plot and drop it onto an empty spot on your
layout. A new plot of the same type but with the dragged gate applied will
appear.
To change the default size for a plot, see 1D Plots
To change the file in a plot see Changing Data Files

7.3
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173

or 2D Plots Preferences

191

.

.

The Current Data File
The first time you add a plot to a layout, the Select a Data File dialog (Figure
7.1) will appear. Navigate to the desired file using the File Dialog, File List, or
Active Files tabs and select Open. After choosing the data file, the plot will be
opened and that file will become the current data file. In the future, when you
open another plot, you will not be asked to select the data file. Instead, the plot
will be created using the current data file.
Every time you select an object displaying a data file, or put that object in edit
mode, its data file will become the current data file.
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Figure 7.1 - Select a Data File Dialog

You can also configure FCS Express to prompt you for a data file every time you
open a plot. To do this, go to File tab Options
. In the Do Not Show
again category, check the box for prompt to select plot types to open when
dragging and dropping files. With this configuration, the Select a Data File
dialog will open every time you create or select a plot.
If a data file has been changed during your analysis (e.g.,, you have performed
parameter math to create or modify a parameter), then before that data file is
removed from memory upon closing your FCS Express layout, you will be
prompted whether or not to save the file. If you do not want this prompt to
appear, go to File tab Options Save category, and choose the Don't save
modified data files on close (see Save Options 222 ) radio button at the bottom.

7.4

Changing Data Files
You can change data files on objects such as plots, data windows, and text
boxes in several ways:
Dragging and dropping one plot from the layout (or a plot node from a
Navigator 123 ) onto another plot in the layout. This brings up a Paste Special
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dialog (Figure 7.2).

Figure 7.2 - Paste Special Dialog

After choosing Data in the Paste Special dialog you may see a Select Drag
and Drop Action dialog (Figure 7.3) where you can choose to replace the
existing overlays on the plot or add the files to the plot as new
overlays.
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Figure 7.3 - Select Drag and Drop Action Dialog

Right-click on the plot and select Next, Prev, or Change File from the popup menu.
Use the commands from the
group 79 to change the file on the selected object (or on all objects).
In the right click pop-up menu, Next and Prev will change the data to the next
and previous files in the data list (skipping by the increment value), respectively.
Change File will bring up the Select a Data File dialog.
If you have more than just the base overlay (the base overlay is simply a term
for the first overlay) on the plot that you are trying to change, use the bottom
half of the Select a Data File dialog to choose which overlay to change (Base
overlay, All overlays, Select from the list).
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Formatting Objects
FCS Express provides the user with the ability to customize virtually every aspect
of each analysis object. Whether editing a plot, a text box or a picture, FCS
Express is extremely flexible and offers you many options when it comes to
formatting the objects on your layout.

8.1

Overview
All of the objects in FCS Express have many different formatting properties. You
will frequently change properties to bring out the important features of your
data.
In all cases, you can format the properties on a single object by double clicking
on the object or right-clicking on the object and selecting Format from the popup menu. Properties can also be changed by selecting appropriate commands
from the Format tab 73 .
All formatting windows work in a similar manner. An example is shown in Figure
8.1. The area on the left, denoted by the , displays a list of categories that can
be formatted. Simply click on a category to change it. The properties of the
current category will appear on the right of the form, in the area denoted by the
.
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Figure 8.1 Formatting Dialog

8.2

Customizing Default Options
FCS Express contains many options that allow you to completely customize
your working environment. You can save time by creating a new user name to
save your common options rather than changing the default settings each time
you start the program. The settings for these options are called the FCS Express
User Options. These user options range from default sizes and formatting
options for plots to the way FCS Express copies data to the clipboard.
All FCS Express User Options can be customized and saved under a unique user
name. Any changes to the user options during a session will be saved for that
user only and will not affect any other user. To customize the Preferences for the
current user, select File tab Options. The FCS Express User Options dialog
(Figure 8.2) contains many categories , each of which groups several types of
preferences together . The specific categories are discussed in other sections
of this chapter.
A tutorial
exists with step-by-step instructions for changing commonly edited
FCS Express User Options.
1930
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Figure 8.2 FCS Express user options overview

8.2.1

General Options
The General category of the FCS Express User Options dialog (Figure 8.3) is
used to control the overall functioning of FCS Express.
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Figure 8.3 General options

The specific options are described in the table below.
Option
Show Full Path

Explanation
Under some circumstances, file names are displayed in FCS
Express. This option allows you to choose whether the entire
directory path and file name are displayed or only the file name.
Math Range CheckingWhen performing parameter math, it is possible for the result of a
mathematical operation to exceed the allowed range of the file.
Storing out-of-range values may cause improper results to be
displayed when using data analysis packages other than FCS
Express. If Math Range Checking is on, values greater than the
maximum allowed value will be stored as the maximum allowed
value. If Math Range Checking is off, the real out-of-range value
will be stored.
When dragging a
When dragging a dataset onto a plot, one of three possible
data set onto a plot actions will occur: replace existing overlays with the file being
dragged onto the plot; add overlays to append the FCS file to
the plot; or, prompt me to ask the user what action to take. To
set the action, choose it from the drop-down list.
Default
To set Compensation for new overlays, select one of the options
Compensation to Use below. See Selecting the Default Compensation 641 for additional
details:
None. No compensation will be used.
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Compensation Default. The Compensation Default is
selected in the Compensation Info window 623 .
FCS File. The Compensation used for acquisition will be
taken from the FCS file header.
FCS file, then Compensation Default. FCS Express will
load Compensation from the FCS file. If there is no
Compensation stored in the FCS file, the Compensation
Default from the Compensation Info window will be used.
Compensation Default, then FCS file. FCS Express will load
the compensation default from the compensations navigator
by default. If a default compensation does not exist, the
compensation associated with the FCS file will be used.
Suffix for
When analyzing compensated data, the text typed into this box
Compensated Data will be used as a suffix to describe the compensated data. This
text can be viewed in the Title 249 of a plot when using the
keyword $FCSE_FILENAME or $FCSE_FILENAMENOPATH
In new layouts,
FCS Express can remember the arrangement of parameters in the
remember
plots displaying data by their Parameter Number (Parameter 1,
parameters by
Parameter 2, etc.) or by their Parameter Name (FITC-A, FL2-H,
etc.). The Parameter Name used by this option is the keyword
(or the combination of keywords) specified in the Keyword To Use
as Parameter Name 229 option (i.e. Name, Stain, Name and Stain,
Stain and Name).
This option must be set prior to building the layout.
Show Hints on layout When this checkbox is enabled, a hint will appear showing the plot
ID and names of the files currently displayed when the mouse is
hovering over the plot.
Maintain aspect ratio When this checkbox is enabled, the aspect ratio (height vs. width)
of layout objects
of objects will be maintained.
after Maximize
Measurement Units Choose Inches, Centimeters, or Millimeters from the drop-down
to Use
list.
Appearance Options These options allow you to chose the border colors for selected
objects and objects that are being edited.
Default Zoom
You can customize the default zoom for your layouts. Also, you
can choose to Apply after opening saved layouts by default.
Apply after opening Applies the chosen default zoom level to layouts that were
saved layouts
originally saved with a different zoom level.
Border color for
Choose the color of the border displayed when an object is
selected objects
selected from the drop-down color pallet.
Border color for
Choose the color of the border displayed when an object is being
object being edited edited from the drop-down color pallet.
Print black and white When this option is selected, when displaying plots with black
inverted for plots
backgrounds, those plots will print out white, rather than black.
with black
background
Performance Options These options allow you to define preferences that may increase
the performance speed of FCS Express.
When moving gates, When checked, all gated events, backgating, and statistics
quadrants, and
associated with gates, quadrants, and markers will update
markers, update
immediately ("in real time") when gate, quadrant, or marker
plots statistics and positions are changed.
tokens immediately
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Maximum Number of Sets the maximum number of undo items.
Undo Items
Maximum memory
Determines how many images stay in memory when picture plots
for cell images
are used. A higher value will increase performance until your
computer's memory limit is reached.
Picture output
These options allow you to choose the format, quality, and
options
resolution of images of a plot copied to the clipboard for future
use.
Use the screen
Uses the resolution of the picture on the screen for an exported or
resolution
copied picture.
Use this resolution
Uses a manually inputted value (in pixels) for the resolution of an
exported or copied picture.
JPEG picture quality Determines the quality of an exported or copied JPEG picture (Max
of 100).
Duplicate object
These options control where duplicated objects are placed after
options
they are duplicated.
The position of the
Determines the position of a duplicated object relative to the
duplicated object is original object using the drop-down list to define the position.
Distance between
Defines the space (in inches) between a duplicated object and the
original and
original object after duplication.
duplicated object(s)
If duplicated
If a duplicated object falls off of the page a new page will be
object(s) are off the created containing the duplicated object.
page, put them on a
new page

8.2.2

Plot Options
The Plots FCS Express User Options category (Figure 8.4) lets the user
customize:
1.Plot Generic Options.
2.Plot Parameter Options.
3.Plot Theme.

Figure 8.4 - The Plots category in the FCS Express User Options.
© 2020 De Novo Software

Formatting Objects

185

1.Plot Theme. This option set how plots appear when they are first opened.
Almost any option that can be set on a plot can be set as a default value
including size, color, font, background, etc.
Alternately, you can either:
right-click on a plot and select Set as Default from the pop-up menu. The
plot options selected for that plot will be used as the default options for all
plots opened in the future, or
right-click on a plot and select Save as Plot Theme from the pop-up
menu, enter a Theme Name in the Add Theme Name dialog box, and
click OK (Figure 8.5, top). Those plot options can then be set as the default
via Plot Theme Options (Figure 8.4, bottom) and will take effect on
subsequently inserted plots. The Manage User Themes button enables
renaming and deleting of user-defined Themes.

Figure 8.5 Plot Theme options

In most cases, the general FCS Express User Options settings mirror the specific
plot FCS Express User Options, as described in Formatting Features Shared by All
Plots 245 . The option for Fill overlay area is discussed in Overlays 267 (Formatting
Single Parameter Histograms). Other discrepancies are described below.
2.Plot Generic Options. This option allows to set whether the Plot Formatting
dialog can be accessed by double click.
3.Plot Parameter Options. This options allows to set whether the parameter
list accessible on plot axes will appear as Scrollable list with a search filter
or as a Multi-column list. When scrollable list with a search filter is selected
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you may drop down the parameter list and start typing a parameter name to
quickly access the parameter. Additionally, parameter lists can be sorted based
on the parameter number (default) or in alphabetical order by choosing the
Sort parameters alphabetically option.
8.2.2.1

Axis Options

If you commonly work with data files in both the FCS 2.0 and FCS 3.0
standards, you may find that you want to set different default options for each
of these file types. For example, fluorescent parameters from FCS 2.0 files will
be best viewed in a four-decade log scale, while fluorescent parameters from
your FCS 3.0 files might be best viewed in a biexponential scale.
There is a full set of Axis Options for each type of data file (Figure 8.6).
Therefore, when you open a new plot on your layout, the default settings for
each axis will depend on what type of data file it is.
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Figure 8.6 Edit Preferences - Axis Options

By default, clicking on the axis label of a plot will allow you to change the
parameter for that axis 308 . While this is convenient for users who are designing
layouts, parameters may be accidentally changed on occasion. You can force
the Alt key to be required to change parameters by checking the Alt+Click
Required To Change Axis Parameters checkbox.
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Technical note: Axis Scale and Statistics
In FCS Express 6, all the statistics are calculated on the raw data, irrespective of
the display scaling. However, when Gates and Quadrants are created decisions
must be made in cases where an event falls on the line of the gate or quadrant.
In FCS Express 6, Gates and Quadrants are calculated and drawn in a binned
space with binning dependent on both the Scaling 253 and the Resolution
Minimum/Maximum 246 of the plot. In turn, the inclusion or exclusion of an event
on the border line of a gate or in a quadrant is highly dependent on the scaling of
the plot, and on the Resolution Minimum/Maximum, of the plot the Gate/
Quadrants was drawn on.
When adjustments to the scaling or resolution of a plot are made, an event may
then fall to a different side of the border line of the gate/quadrant, and the user
may notice very slight changes in the statistics of gated events which are usually
quite minimal and make no impact on the interpretation of the results.
Please refer to the Axis Scale and Statistics
8.2.2.2

255

chapter for more details.

Background Options

This category controls the default background appearance of plots. The options
are explained below and pictured in Figure 8.7.
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Figure 8.7 Background Options
Option
Explanation
Background
Controls whether plots will appear with a white, other solid color, or
color and image gradient background. Images on your computer can also be stretched,
centered, or tiled as background.
Frames
Options for adding frames of desired color and thickness appear on the
border of the plotted area.
Margins
Add predefined margins of white space around the plot within each
object.

8.2.2.3

Legend Options

This category controls the default behavior and appearance of plot legends. The
options are explained below and pictured in Figure 8.8.
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Figure 8.8 Legend Options
Option
Explanation
Legend Options If Visible is checked, the legend will appear by default. If unchecked,
it must be added via Formatting options 251 on a per-plot basis.
Position: This defines the position of the legend within the plot.
Options are Left, Right, Top, Bottom.
Margin: This defines how much space is available between the legend
and the plotted data.
Top Position: This defines the distance of the legend from the top of
the plot.
Back Color: This defines that color that is applied to the background
of the legend.
Shadow Size: This defines the degree to which a shadow is applied to
a legend. A larger number applies a more intense shadow. A value of
zero applies no shadow.
Shadow Color: This defines the color of the shadow.
Resize chart to accommodate legend: This defines whether or not
the plotted area will resize itself to accommodate the size of the
legend.
Title Visible: Enabling the check box will display the legend title on
Density and Contour plots. The legend title is text as well as an
interactive drop down menu that allows you to easily change the
parameter to use for the Color based on 287 option.
Legend Font
Defines the default font of legend text.
Style
8.2.2.4

1D Plot Options

The 1D Plot options are shown in Figure 8.9.
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Figure 8.9 1D Plot Options

The options that are specific for 1D plots are described in the table below.
Option
When creating
a marker on a
plot

Explanation
When a marker is created, you can choose whether or not to show the
marker name and/or stat in a text box, and select the default line width
and color. If marker stat is enabled 380 , you can choose which statistic
to display from the drop-down list. If Show detailed marker resizing
information is checked, the marker boundaries will appear above the
marker and lines will drop to the axes to show where the marker
boundaries will be during resizing. If Create a linked gate is checked,
when new markers are created on this plot, a gate linked to the marker
364 will automatically be created.
Create a linked When checked, any new markers created on the histogram will be
gate
automatically converted to linked gates. Any existing markers on the
plot will still need to be manually linked to a gate 364 .
Default Size
The default size of 1D Plots.

8.2.2.5

2D Plot Options

The 2D Plot options category (Figure 8.10) contains items that are specific for
all 2D plots.
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Figure 8.10 2D Plot Options

The 2D plot options are described in the table below.
Option
Quadrant
Options
Font to Use in
Quad Text
Boxes
Default Size
8.2.2.6

Explanation
The default preferences for the quadrants. The Default Quad Stat
option allows you to set which statistic appears in a text box in all four
quadrants when the quadrants are first inserted.
The default font to use for Quad Text Boxes on 2D plots showing
quadrants.
The default size of 2D Plots.

Text Boxes Selection Options

This category (Figure. 8.11) controls whether text boxes derived from markers,
gates, and quads within plots can be selected
for moving, resizing, deleting,
1214
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.

Figure 8.11 Text box selection options
8.2.2.7

DNA Options

The DNA options refer to general 193 , overlay 194 , and position marker options
for performing DNA analysis using Multicycle 888 .

195

General
The General category of DNA Options (Figure 8.12) are miscellaneous
properties dealing with the Multicycle fit model and the parameter to plot on
DNA histograms.
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Figure 8.12 DNA General Options

The properties are described in the table below.

Option
Fit Model to show

Explanation
When Multicycle performs a fit, it calculates six different variations
on that fit. You can choose which variation to display using this
option. The six variations are described in the Multicycle manual.
Parameter Options Select the parameter to display when changing data files. Use
"Prompt when needed" to be prompted for the parameter every time
you change a data file. The "Use parameter below" option always
displays the parameter you set in the spin control.

Overlays
The Overlays category of DNA preferences (Figure 8.13) allows the user to
set up how the calculated overlays look on the DNA histogram.
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Figure 8.13 DNA Overlays Options

Select one or more overlays from the Select DNA Overlay list box on the
left of the Overlays page to change the look and feel of that overlay. The
visual properties that can be changed are similar to those for regular
histogram overlays 267 .

Position Markers
Position markers 893 can be displayed on DNA histograms to mark the position
of cell cycle components such as the G1 mean or the background region. The
Position Markers category for DNA Options allows the user to set the default
properties for these markers.
Select one or more categories from the list box on the left (Figure 8.14) and
choose line options for the markers on the right.
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Figure 8.14 DNA Position Markers Options

8.2.3

Statistic Options
The subcategories of the Statistics FCS Express User Options category allow
the user to select the default format and statistics items to list when statistics
windows are opened. There are different options for different types of statistics
windows, which are described for each in the following pages.
In addition, the When copying stats from a statistics grid to clipboard,
include column headings checkbox (Figure 8.15) controls whether or not the
description of the statistic is also copied by default.
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Figure 8.15 Statistics Options
8.2.3.1

1D Plot Statistics

The 1D Plot Statistics options (Figure 8.16) determine the default visibility and
display for 1D plot statistics.

Figure 8.16 1D Plot Statistics Options
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The options are explained in the table below.
Option
Explanation
Select Statistics The checkbox determines whether or not statistic items are displayed
when a statistics window is first opened. The individual statistics items
are explained in the statistics section of the chapter on analysis of FCS
data 379 .
Number Display Number of decimals indicates the number of decimal places listed to
Options
the right of any decimal point.
Rounding mode indicates the method for rounding the last digit.
Options include Standard, Down, Up, and Truncate.
Show trailing zeroes, if checked, shows the specified number of
decimals even if the terminal digits are zeroes.
Show scientific notation, if checked, shows the number in E
notation: mEn which represents m x 10n, where m and n are any real
number and E represents "exponent"
Font
The default font to use when displaying the statistics.
Default Size
Sets the default size of the statistics window. If Size window
automatically is checked, size will automatically adjust if data is added
that extends beyond the window borders.
8.2.3.2

2D Plot Statistics

The 2D Plot Statistics options (Figure 8.17) determine the default visibility and
display for 2D plot statistics.
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Figure 8.17 2D Plot Statistics Options

The options are explained in the table below.
Option
Explanation
Select Statistics The check box determines whether or not statistic items are displayed
when a statistics window is first opened. The individual statistics items
are explained in the statistics section of the chapter on analysis of FCS
data 379 .
Number Display Number of decimals iindicates the number of decimal places listed to
Options
the right of any decimal point.
Rounding mode indicates the method for rounding the last digit.
Choose between Standard, Down, Up, and Truncate.
Show trailing zeroes, if checked, shows the specified number of
decimals even if the terminal digits are zeroes.
Show scientific notation, if checked, shows the number in standard
form or standard index form: m x 10n, where m is any real number
times ten raised to the n power.
Font
The default font to use when displaying the statistics.
Default Size
Sets the default size of the statistics window. If Size window
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Option

8.2.3.3

Explanation
automatically is checked, size will automatically adjust if data is added
that extends beyond the window borders.

DNA Cycle Statistics

The DNA Cycle Statistics FCS Express User Options (Figure 8.18) control which
statistics are displayed by default when DNA Cycle Statistics windows are
opened.

Figure 8.18 DNA Cycle Statistics Options

The options are explained in the table below.
Option
Explanation
Select Statistics The checkbox determines whether or not statistic items are displayed
when a statistics window is first opened. See the FCS Express
knowledgebase page on DNA Analysis and Modeling with Multicycle AV
for links to information on individual statistics.
Number Display Number of decimals indicates the number of decimal places listed to
Options
the right of any decimal point.
Rounding mode indicates the method for rounding the last digit.
Choose between Standard, Down, Up, and Truncate.
Show trailing zeroes, if checked, shows the specified number of
decimals even if the terminal digits are zeroes.
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Default Size
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Explanation
Show scientific notation, if checked, shows the number in E
notation: mEn which represents m x 10n, where m and n are any real
number and E represents "exponent"
The default font to use when displaying the statistics.
Sets the default size of the statistics window. If Size window
automatically is checked, size will automatically adjust if data is added
that extends beyond the window borders.

DNA Model Statistics

The DNA Model Statistics FCS Express User Options (Figure 8.19) control
which statistics are displayed by default when DNA Model Summary Statistics
windows are opened.

Figure 8.19 DNA Model Statistics Options

The options are explained in the table below.
Option
Explanation
Select Statistics The checkbox determines whether or not statistic items are displayed
when a statistics window is first opened. See the FCS Express
knowledgebase page on DNA Analysis and Modeling with Multicycle AV
for links to information on individual statistics.
Number Display Number of decimals indicates the number of decimal places listed to
Options
the right of any decimal point.
Rounding mode indicates the method for rounding the last digit.
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Option

Font
Default Size

8.2.3.5

Explanation
Choose between Standard, Down, Up, and Truncate.
Show trailing zeroes, if checked, shows the specified number of
decimals even if the terminal digits are zeroes.
Show scientific notation, if checked, shows the number in E
notation: mEn which represents m x 10n, where m and n are any real
number and E represents "exponent".
The default font to use when displaying the statistics.
Sets the default size of the statistics window. If Size window
automatically is checked, size will automatically adjust if data is added
that extends beyond the window borders.

DNA Experiment Statistics

The DNA Experiment Statistics FCS Express User Options (Figure 8.20)
control which statistics are displayed by default when DNA Experiment Statistics
windows are opened.

Figure 8.20 DNA Experiment Statistics options

The options are explained in the table below.
Option
Explanation
Select Statistics The checkbox determines whether or not statistic items are displayed
when a statistics window is first opened. See the FCS Express
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Option

Explanation
knowledgebase page on DNA Analysis and Modeling with Multicycle AV
for links to information on individual statistics.
Number Display Number of decimals indicates the number of decimal places listed to
Options
the right of any decimal point.
Rounding mode indicates the method for rounding the last digit.
Choose between Standard, Down, Up, and Truncate.
Show trailing zeroes, if checked, shows the specified number of
decimals even if the terminal digits are zeroes.
Show scientific notation, if checked, shows the number in E
notation: mEn which represents m x 10n, where m and n are any real
number and E represents "exponent"
Font
The default font to use when displaying the statistics.
Default Size
Sets the default size of the statistics window. If Size window
automatically is checked, size will automatically adjust if data is added
that extends beyond the window borders.
8.2.3.6

Proliferation Fit Statistics

The Proliferation Fit Statistics FCS Express User Options (Figure 8.21) control
which statistics are displayed by default when Proliferation Fit Statistics windows
are opened.
Note: Please refer to the Proliferation Statistics
statistic and for a list of statistical formulas 912 .

911

topic for explanations of each

Figure 8.21 Proliferation Fit Statistics options
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The options are explained in the table below.
Option
Explanation
Select Statistics The checkbox determines whether or not statistic items are displayed
when a statistics window is first opened. Please refer to the
Proliferation Statistics 911 topic for explanations of each statistic and for
a list of statistical formulas 912 .
Number Display Number of decimals indicates the number of decimal places listed to
Options
the right of any decimal point.
Rounding mode indicates the method for rounding the last digit.
Choose between Standard, Down, Up, and Truncate.
Show trailing zeroes, if checked, shows the specified number of
decimals even if the terminal digits are zeroes.
Show scientific notation, if checked, shows the number in E
notation: mEn which represents m x 10n, where m and n are any real
number and E represents "exponent"
Font
The default font to use when displaying the statistics.
Default Size
Sets the default size of the statistics window. If Size window
automatically is checked, size will automatically adjust if data is added
that extends beyond the window borders.

Note: Please refer to the Proliferation Statistics
statistic and for a list of statistical formulas 912 .
8.2.3.7

911

topic for explanations of each

Proliferation Population Statistics

The Proliferation Population Statistics FCS Express User Options (Figure
8.22) control which population statistics 914 are displayed when the proliferation
population statistics window is opened.
Note: Please refer to the Proliferation Statistics
statistic and for a list of statistical formulas 912 .

911

topic for explanations of each
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Figure 8.22 Proliferation Population Statistics options

The options are explained in the table below.
Option
Explanation
Select Statistics The checkbox determines whether or not statistic items are displayed
when a statistics window is first opened. Please refer to the
Proliferation Statistics 911 topic for explanations of each statistic and for
a list of statistical formulas 912 .
Number Display Number of decimals indicates the number of decimal places listed to
Options
the right of any decimal point.
Rounding mode indicates the method for rounding the last digit.
Choose between Standard, Down, Up, and Truncate.
Show trailing zeroes, if checked, shows the specified number of
decimals even if the terminal digits are zeroes.
Show scientific notation, if checked, shows the number in E
notation: mEn which represents m x 10n, where m and n are any real
number and E represents "exponent"
Font
The default font to use when displaying the statistics.
Default Size
Sets the default size of the statistics window. If Size window
automatically is checked, size will automatically adjust if data is added
that extends beyond the window borders.
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8.2.4

Startup Options
The Startup FCS Express User Options (Figure 8.23) allow the user to control
the behavior of FCS Express at startup.

Figure 8.23 Startup screen options

By checking or unchecking the checkbox, you can choose whether or not to:
Automatically close the Startup Screen
layout

54

when opening a new or existing

Reopen the Startup Screen after closing all layouts
Automatically download any new updates
If checked, latest updates to FCS Express will be automatically
downloaded when available. They can also be downloaded manually from
the De Novo Software website.
Start the De Novo Software External Application Bridge on login. The De
Novo Software External Application Bridge is required for the R Integration
features of FCS Express 975 .

8.2.5

Gate Options
The FCS Express User Options Gate category (Figure 8.24) lets the user select
the default FCS Express User Options for gates.
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Figure 8.24 Gate options

These options are described in the table below.
Option
Explanation
Gate options
Set the default gate colors, which apply to gates according to the
order of creation.
Choose to use hierarchical gating 348 as the default logic for new
gates.
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Option

Explanation
Choose to create Data Specific Gates 323 when moving.
Set the width of the line used to draw the outline of the gate on a
plot.
Move the text box associated with a gate/marker when the gate or
marker is moved.
Recreate the gate's text box when selecting Show Gate 342 from the
plot's context menu.
Gate Text
Determine whether or not to insert a gate name in the Gate Text
Box options
Box.
Determine whether to show a gate statistic in the Gate Text Box.
From the dropdown menu, choose from several default gate statistics
379 .
Define the default position of the Gate Text Box.
Determine number of decimal places.
Gate Moving When moving a gate onto a blank part of the page, choose whether to
options
Create a new plot on the gate or to Delete the gate.
Gate Creation Choose prompt window options that appear when creating a gate 1268 ,
Prompt
depending on whether an existing gate is selected or not.
options

8.2.6

Files/Directories
The Files/Directories FCS Express User Options category allows the user to
select default directories and files for various aspects of FCS Express (Figure
8.25). For example, if you routinely open the same template to create new
layouts, the default directory you set here will automatically open your preferred
template.
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Figure 8.25 Files/Directories options

These options are described in the table below.
Option
Default Template File
for creating a new
layout
Default directory for
data files
Default directory for
layouts
Default FCS Express
FACSDiva
configuration file
When creating a new
plot,
always display the
selection dialog

8.2.7

Explanation
If you typically create the same type of layout, this default will
automatically open your preferred Template File when creating
new layouts. See Using Templates 864 for more information.
When an FCS Express layout is first opened and a data file is first
required, FCS Express will look in this directory for the data files.
When you first open a layout 95 , the Open Layout dialog will first
start in this directory.
This is the default FACSDiva configuration file 872 .

If the checkbox is checked, you will always be prompted to
choose the file when creating a new plot. If unchecked, the plot
will be loaded with the current data file 172 .

Data List
The Data List FCS Express User Options category (Figure 8.26) allows the user
to control the default display and behavior of the Data List 783 .
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Figure 8.26 Data List options

The options are described in the table below.
Option
Selected Keywords
Data List Options

Explanation
Add or remove keywords by which to identify or sort 789 files.
Show or hide the Full Path of data files.
Show or hide the Iteration Column.
Show or hide the File Name Column.
Show or hide the Flagged Column.
Action for Drag and
Choose which action to take when dragging and dropping a file
Drop
from windows explorer on top of an existing file in the Data List.
Replace removes the existing file from the data list and
replaces it with the newly dropped file.
Insert before places the newly dropped file before the
existing file in the data list.
Insert after - inserts the newly dropped file after the
existing file in the data list.
Double-click Options Choose which of the following actions to take when doubleclicking on a file in the Data List.
Change all overlays on all objects to selected file.
Change all overlays on selected objects to selected file.
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Explanation
Change base overlay on all objects to selected file.
Change base overlay on selected objects to selected file.
Open new plot with selected file.

Dialogs Options
Some dialog windows appear automatically in FCS Express. Within the Dialogs
category of user options, there are three subcategories for which you can
customize the appearance and behavior of some of these windows: Keyword
Dialog 211 , Open Data Dialog 212 , and Do Not Show Again 220 (Figure 8.27) and
are described on the following pages.

Figure 8.27 - Subcategories for Dialogs outlined in red

8.2.8.1

Keyword Dialog

The Keyword Dialog is used throughout FCS Express whenever you are
required to select a keyword. For instance, keywords can be selected for
insertion in plot titles 249 and in text boxes 152 as keyword tokens 704 .
Since many keywords can be present for a data file, the Dialogs Keyword
Dialog FCS Express User Options allow you to specify which keywords appear in
the keyword dialog (Figure 8.28), providing the user with the opportunity to filter
on the keywords that are used the most.
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Figure 8.28 Keyword Dialog Preferences

You can choose one of the following:
Show all keywords.
Show only keywords in the Keyword Filter List.
Show all keywords except those appearing in the Keyword Filter List.
If you do not choose Show all keywords, you must enter keywords into the
Keyword Filter List list box. Enter one keyword per line. Case/capitalization are
ignored. You can also use the wild card "*" to denote any characters. For
instance, to only display keywords starting with the letter "P", first select the
Show only the keywords listed below option, and then type in "P*" in the
keyword list.
8.2.8.2

Open Data Dialog

The Open Data Dialog can be displayed as the Standard Open Data Dialog
or Advanced Open Data Dialog 215 (Figure 8.29).

214

© 2020 De Novo Software

Formatting Objects

213

Figure 8.29 - Open Data Dialog with Standard Open Data Dialog Overlay Options
Displayed

When the Standard Open Data Dialog is selected, the Select data file dialog
(Figure 8.30) will open when adding files to the Data List or changing overlays.

Figure 8.30 - Select data file dialog

When the Advanced Open Data Dialog is selected, the Open Data File dialog
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with five tabs 216 (Figure 8.31) will open when adding files to the Data List or
changing overlays.

Figure 8.31 - Open Data File dialog
8.2.8.2.1 Accessing the Standard Open Data Dialog

The Standard Open Data Dialog can be accessed when selected in user
preferences for Open Data Dialog through the following actions:
creating statistics
editing statistics
adding files

786

695

791

,

,

to the Data List,

changing overlays on histograms

267

, spectrum plots

277

, or 2D plots

283

,

changing data by using Data tab
Data on Selection or Change
Data on All Objects group Select command (Figure 8.32). Please note
the Select drop down will only appear when the Standard Open Data
Dialog option has been selected for All Overlays in the user preferences.

© 2020 De Novo Software

Formatting Objects

215

Figure 8.32 - Select command outlined in red from Change Data
groups within Data tab on ribbon
8.2.8.2.2 Accessing the Advanced Open Data Dialog

The Advanced Open Data Dialog can be accessed when selected in user
preferences for Open Data Dialog through the following actions:
creating statistics
editing statistics
adding files

786

791

695

,

,

to the Data List, or

changing data by using Data tab
Data on Selection or Change
Data on All Objects group Select drop down list command (Figure 8.33).

Figure 8.33 - Select command outlined in red from Change Data
groups within Data tab on ribbon

and when Standard Open Data Dialog for All Overlays is set as the
preference for Open Data Dialog:
changing data by using Data tab
Data on Selection or Change
Data on All Objects group Select drop down list command (Figure 8.34).
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Figure 8.34 - Select dropdown command outlined in red from Change Data
groups within Data tab on ribbon

8.2.8.2.3 Advanced Open Data Dialog Tabs

The five tabs for the Advanced Open Data Dialog are listed and explained below.
If the checkbox Show full path is checked for Selected Files under any of the
first three tabs, the full pathway will be displayed for each file instead of only the
filename.
File Dialog is the first tab and from the user may click Select data file
button (outlined in red in Figure 8.35 below) to access the Select data file
window to access file(s) on workstation or network.

Figure 8.35 - File tab to Select data file dialog

Data List is the second tab from which the user may select file(s) currently
added to the Data List for the layout (Figure 8.36).
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Figure 8.36 - Advanced Open Data Dialog Data List tab

Active Files is the third tab from which the user may select file(s) currently
used within the layout (Figure 8.37).
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Figure 8.37 - Active Files tab

MDC Store is the fourth tab from which the user may select file(s) if
connected to his/her database (Figure 8.38). The Database Type drop
down list includes SQL Server 2000, SQL Server 2005+, Oracle, and
SQL Server 2000+ OLEDB. If the checkbox Remember me on this
computer is checked, the user's credentials for the server will be
remembered. The MDC Store tab is only available in FCS Express Image or
Plus.
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Figure 8.38 - MDC Store tab

Building Blocks is the fifth tab from which the user may select file(s) to
Load cell images, Load Background Images, and Arrange fields by
physical position (Figure 8.39). Arranging fields by physical position allows
you to use the position of the fields to populate regions of a picture plot.
You can also define the default cell width and height as well as the plane
and timepoint. The Building Blocks tab is only available in FCS Express
Image or Plus.
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Figure 8.39 - Building Blocks tab
8.2.8.3

Do Not Show Again

Some dialog windows appear automatically in FCS Express. With Do Not Show
Again options, you can uncheck those which you wish to not automatically
appear as prompts. The dialog windows are listed and explained below (Figure
8.40). The options may be selected or deselected individually or simultaneously
using Select All or Deselect All.
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Figure 8.40 - Do Not Show Again options

Warning dialog when saving a layout last saved in FCS Express Version
4 or 5.
o Saving a legacy layout in a current version of FCS Express will prevent it from
opening in the earlier version. Leave this option checked to be warned when
saving such a layout.
Warning dialog when opening a layout created with a different version of
FCS Express.
o Leave this option checked to be warned opening a layout created in a
different version of FCS Express.
Selected plot types to open when dragging and dropping files.
o Leave this option checked to have the Select Plot Types... dialog appear
when dragging and dropping files onto the layout.
Action when dropping a file on a data identifier in the Data List.
o Leave this option checked to have Choose Action for Drag and Drop dialog
to appear when dragging and dropping a file from Windows explorer on top of
a file in the data list.
Action when double clicking a data identifier in the Data List.
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o Leave this option checked to have the Select double click action dialog
appear when double clicking on a file in the data list.
Show startup screen automatically when FCS Express starts up.
o Leave this option checked to show the Startup Screen 54 when FCS Express
starts up.
Warning message when turning off iteration snapshots.
o Leave this option checked to show warning message when turning off
iteration snapshots.
Question about embedding/linking when inserting a picture.
o Leave this option checked to show question when inserting a picture.

8.2.9

Save Preferences
The Save category (Figure 8.41) lets the user select how layout files are saved.

Figure 8.41 Save options
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These FCS Express User Options are described in the table below.
Option
Data Files
Autosave Options

Path Options

Explanation
Layout linking and embedding are described in Saving a
Layout 93 .
The layout is automatically saved to the designated
location at the specified interval. You can specify the
number of saved files to keep. Auto recovery files are
described here 110 .
When layout files are saved with the data files linked, FCS
Express has to remember the specific disk location of the
data files (see Saving a Layout 93 ).
When the Save absolute paths radio button is chosen,
the full path of the data files is stored. If the layout is
moved, the data files do not need to be moved as well,
since the layout will remember their original location.
Choosing the Save relative paths radio button will store
the relative path. As long as the data and the layout file
are in the same relative directories on the hard drive or CD,
the files will be loaded into the layout. If you check this
option, when you move the layout, you should move the
data such that the data is in the same relative location to
the layout as it was before.
Example: Assume that your layout and data files were in
C:\data. If you saved the layout with Save Absolute
Paths selected, then the layout will remember to look in C:
\data for the data files. If you saved the layout with Save
Relative Paths selected, the layout will only remember to
look for the data files in the same folder as the layout is in,
since that is the current relative location of the data files
to the layout (remember, they are both in C:\data). If you
move the layout to another location (C:\data1), and leave
the data files in C:\data, the layout saved with Save
Absolute Paths will still be able to find the data files,
since that layout remembers that the data files were in C:
\data. The layout saved with Save Relative Paths will not
find the data in this case, because it will be looking in C:
\data1, since all it remembers is to look for the data in the
same folder as the layout is in.

Save Relative Paths is useful if you are going to be
moving the data onto another computer, or external media
such as flash drive or CD, because as long as you move
the data and the layout together, the layout will be able to
find the data when it is opened.
Prompt to save/Don't save Data file header information can be changed and new
modified data files on close parameters can be created 935 . These actions create a
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Option

History Options

8.2.10

Explanation
modified .fcs data file different from the original. Choosing
the Prompt to save modified data files on close radio
button will prompt you with the choice to save the
modified files when the layout is closed. If you choose
Don’t save modified data files on close, the modified
files will not be saved when the layout is closed and the
modifications will be discarded.
FCS Express can keep a copy of the old versions of FCS
Express layout files as a backup when saving. These files
will be stored in a "History" subfolder within your original
folder. To activate this option, increase the default value
of Number of old copies to keep from "0".

Security Preferences
The Security FCS Express User Options allow the user to set a password to
prohibit others from modifying the Options 179 of the current user (Figure 8.42).
Note: If you forget this password, there will be no way to retrieve the passwordprotected user options.

Figure 8.42 Security options

8.2.11

Text Box Preferences
The Text Box FCS Express User Options category allows the user to configure
the default appearance for text boxes (Figure 8.43).
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Figure 8.43 Text Boxes options

The default background is Transparent. You can choose to fill the background
with a color and/or fill pattern, color gradient, or an image. You can also set the
default size.

8.2.12

User Information
Under user information (Figure 8.44), you can set an e-mail address, author
name, and organization for the user.
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Figure 8.44 User Information options

8.2.13

Advanced Publishing Preferences
There are two subcategories for Advanced Publishing
Permissions and Publishing Options.

603

options: Default

The Default Permissions page allows you to limit what others who view your
published layout will be able to do in terms of modifying and saving your layout.
Checking the box allows the function. The permission to perform almost every
feature available in FCS Express can be customized (Figure 8.45).
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Figure 8.45 Advanced Publishing Default Permissions

The Publishing Options page allows you to control whether or not batch
processing actions are available in your published layout. In addition, you can
decide whether or not to hide objects that are outside of layout pages, and
enable or disable token editing in the published layout (Figure 8.46).

Figure 8.46 Advanced Publishing Options

8.2.14

Data Saving
There are two subcategories of Data Saving FCS Express User Options: Save
as Text Format and FCS Format.
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When saving data as a text file, the Save as Text Format default options allow
you to choose a delimiter ('comma' is the default) and decide whether to Save
Headers (Figure 8.47).

Figure 8.47 Data Saving - Save as Text Format options

You can also set default options for Data Format, Endian Format, and FCS
Version when saving files in FCS Format (Figure 8.48).

Figure 8.48 Data Saving - FCS Format options

© 2020 De Novo Software

Formatting Objects

8.2.15

229

Data Loading
The Data Loading category contains FCS File Options.

8.2.15.1

FCS File Options

This option only appears if you are using FCS Express Flow or FCS Express Plus.
The FCS File Options category (Figure 8.49 and 8.50) allows you to select how
FCS Files will appear in data selection dialogs (e.g., when changing files 173 , adding
files to the Data List 786 , or inserting new plots 172 . The FCS Express User Options
are described in the table below.

Figure 8.49 FCS File Options dialog (Upper panels)
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Figure 8.50 FCS File Options dialog (Lower panels)

Option
Dataset Name Keyword

Allow Multiple Datasets

Default Dataset to use

Explanation
Select the keyword to use as the default
dataset name when selecting from multiple
datasets. Allow Multiple Datasets must be
checked.
Some FCS files contain multiple data sets. If this
option is checked, you can select one of the
embedded datasets. The user option to use
Advanced Open Data Dialog 216 also must be
enabled to be prompted to select which dataset
upon loading the data files.
This option specifies which dataset should be
loaded by default when Allow Multiple Datasets
is not checked. In that case, when you select a
file in the dialog that has multiple datasets, will
load the dataset number corresponding to the
value selected instead of displaying a list of
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datasets. If the dataset does not exist, FCS
Express will load the first dataset in the file.
FCS v3.0 $TIMESTEP units
Choose a unit to use when displaying a Time
parameter in FCS Express from the drop-down
list. The Default time option leaves the time
parameter at the same raw value as is stored in
the FCS file. Choosing a unit from the drop-down
list will use the $TIMESTEP keyword to convert
the raw value to the specified unit from the list.
Keyword To Use as Parameter Name Choose a keyword (or combination of keywords)
to use as parameter names from the drop-down
list.
Allow opening BD FACSDiva data files Check this box to allow opening data files that
that were generated by exporting a were exported from BD FACSDiva together with
FACSDiva Experiment
the experiment. See http://
www.denovosoftware.com/site/kbinvalidfilefromfacsdiva.shtml for a detailed
explanation. Re-exporting the files is a better
option if you have access to FACSDiva and the
experiment data is still available.
Scale Summit/ZE5/S3 log
Check this box to scale log parameters of
parameters
Summit/ZE5/S3 data in the same manner that
they are scaled in Summit/ZE5/S3 software. The
scale is applied to newly loaded files.
Scale Summit/ZE5/S3 lin
Chose a value between None, 64, 128, 256,
parameters
512 and 1024. Linear parameters of Summit/
ZE5/S3 data will be scaled accordingly. The
scale is applied to newly loaded files.
Value to start for log parameters
Choose the starting value for parameters
displayed in the log scale from the drop-down
list.
Sony Spectra Reading Options
This options allows to define which Spectrum
Parameters to Read when a file from Sony
Spectra is loaded.
Plate Folder Import Options
These options allow to automatically create the
Merge FCS File Import Options
File Identifier (i.e. numeric) and/or the
Classification File Identifier (i.e. etxt with file
names) columns when FCS files are loaded as
FCS Plate Folder (see the Working with Heat
Map 1048 chapter of the manual for more details on
the FCS Plate Folder format) or Merge FCS File
(see the Adding Merged Files to the Data List 658
and the Working with Heat Map 1048 chapter of
the manual for more details on the Merge FCS
File format).
An additional Classification column can also be
added using any of the keywords available in the
loaded files. If a keyword is specified and multiple
files share the same value for that keyword,
events from those files will be grouped together
in the same well.
Automatically Set Range Based on
Some flow cytometers save data with a very
Data
large dynamic range (stored in the $PnR
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keywords), but a small actual range, which
results in sparse plots. These cytometers include
the BD Accuri C6 and Beckman Coulter Cytoflex.
These options allow you to automatically adjust
plot axes based on the minimum and maximum of
the data range, rather than the $PnR keyword.
To use them, enter the value of the $CYT
keyword of each instrument whose data files you
want to affect, separated by commas. Note: the
value of the $CYT keyword can be retrieved from
the FCS File Header 646 .
For data from these instruments, the value
chosen by the Automatic option in both the
Specific Options 304 and Axis Options 186 will be
based on the data.

8.2.15.2

ICE Format Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.
When loading .ICE files you can choose whether to Load cell images and Load
Background Images (Figure 8.51).

Figure 8.51 ICE Format options
8.2.15.3

PerkinElmer Acapella Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.
When loading Perkin Elmer Acapella Reader files you can choose whether to
Load cell images, Load Background Images, and Arrange fields by physical
position (Figure 8.52). Arranging fields by physical position allows you to use the
position of the fields to populate regions of a picture plot.
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Figure 8.52 Perkin Elmer options
8.2.15.4

Building Blocks Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.
When loading Building Blocks files you can choose whether to Load cell images,
Load Background Images, and Arrange fields by physical position (Figure
8.53). Arranging fields by physical position allows you to use the position of the
fields to populate regions of a picture plot. You can also define the default cell
width and height.

Figure 8.53 Building Blocks options
8.2.15.5

MDC Store Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.
When loading data from MDC Store you can choose whether to Load cell
images and Load Background Images (Figure 8.54), and whether to load as
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plate.
Security credentials (username and password), ODBC DataSource, and
Database name and type must be specified in under MDC Store Options. The
security credentials can be saved with the layout by checking the appropriate
box.

Figure 8.54 MDC Store options

Please visit the De Novo Software website at http://www.denovosoftware.com/
site/kb-loadingdatafromMDCStore.shtml for more details on configuring the MDC
Store for use with FCS Express.
8.2.15.6

Life Technologies Tali Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.
When loading Life Technologies Tali data files, you can choose whether to Load
cell images and Load Background Images (Figure 8.55). The default length
of the sides of the square around each cell can also be changed.
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Figure 8.55 LifeTechnologies Tali options
8.2.15.7

Nexcelom Options

This option only appears in FCS Express Flow RUO, FCS Express Image
Cytometry and FCS Express Plus.
When loading .nxdat files, you can choose whether the to import the original X
and Y pixels (Figure 8.56).

Figure 8.56 Nexcelom options
8.2.15.8

ImageJ Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.
When loading .ijout files you can choose whether to Load cell images, Load
Background Images, and Load path names from the ImageJ table of
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contents file (Figure 8.57).

Figure 8.57 ImageJ options
8.2.15.9

Amnis DAF Reader Options

This option only appears in FCS Express Image Cytometry and FCS Express
Plus.
When loading Amnis *.daf files
you have the option to load data with or
without images (Figure 8.58). Unchecking the Load images box will load *.daf
files without the associated images from the relevant *.cif file. Resulting plots will
only display number data and data grids will not have columns present for single
cell images.
1042

Figure 8.58 IDEAS options
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Perkin Elmer Vectra Options

This option only appears in FCS Express Image Cytometry and FCS Express Plus.
When loading Vectra files (*.tif, *.txt) you have the option to Load images, Use
Default Image Resolution when loading composite TIFF images, and select
which segmentation image/map from the Segmentation Cell Type options.
(Figure 8.59).
The Load images box will be checked by default, and unchecking this box will
load Vectra files without any associated images. When unchecked, Picture Plots
will not be allowed to be inserted and data grids will not have columns present
for single cells images. However, all numeric data may be plotted in any other
plot type available.
When the Use Default Image Resolution box is checked, the user can set the
Default Image Resolution for composite TIFF images loaded into FCS Express.
Check this box only if you are loading composite TIFF images
(*_composite_image.tif), as these images are exported from the Vectra without
the image resolution data necessary for tiling the different images into a single
field of view. For component TIFF images (*_component_data.tif), you may
leave this box unchecked.

Figure 8.59 Vectra Format options

Please see https://www.denovosoftware.com/site/
PerkinElmerApplicationsandImport.shtml for instructions on exporting data from
the Vectra / InForm software for use in FCS Express.
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Formatting Options Shared by All Objects
This section discusses the background, border, and size options available to
nearly all objects in a layout. Objects can be text boxes, plots, histograms,
statistics, pictures, and more. These features can be customized for individual
objects, but the customization process is common to all objects.
The options in this section can be set in one of two ways:
Selecting the object and then using the appropriate commands from the
Format Object Options group in the ribbon.
Right-click on the object, choose Format from the pop-up menu, and
select the General, Fill, Border, or Size category. With this method, a
Preview button is available to view changes before actually applying them,
as well as a Restore button to easily restore the object to its previous
state. You can also restore any object to its previous state by using the
Undo button in the Quick Access Toolbar 65 .

8.3.1

General
You can edit General properties in one of two ways:
Select the object and use the Format
command.

Object Options

General

Right-click on the object, select Format from the pop-up menu, and
choose the General category.
For most objects, the only general formatting options are:
object's name
object visibility
For all objects, the name property is the label displayed as tool tip while hovering
the mouse cursor over the object. For plots, the name property is the name of
the plot to display in lists where the user is required to select a plot. The name is
also used when displaying objects in different Navigators 123 . The name field
includes an option to insert a token as the name by clicking on the
button to
the right of the edit field.
Please note that Plots' name can be also changed from the Gate Navigator 128
window.
Object visibility can be set to:
Always visible (default) - The object is always visible in the layout.
Never visible - The object is always hidden unless the
Hidden Items 82 button of the ribbon bar is selected.
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Custom - The option allows you define visibility of the object based on a token
or value that evaluates to a conditional expression 744 . Any tokens or values
may be used to set a conditional custom value and may be inserted 688 via right
click in the field, Insert Token or by clicking on the T token icon. The object
will only be visible if the token evaluates to True.

Data Grids have some extra general options (Figure 8.60).

Figure 8.60 Formatting General Dialog for Data Grids

Besides the usual name property (referred to as Data window name), you can
also choose a compensation 622 definition, a transformation 934 , a gate to display
data for, how to display the numbers in the grid, and whether or not to change
the data in the grid during batch processing 782 or in response to a Next/Previous
79 command.
Lastly, the Show the Cell Number column checkbox controls whether the cell
or object number (assigned by the cytometer according to the time of sample
acquisition) is shown as a column in the Data grid.
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Background
The Background options (Figure 8.61) allow you to change the background
appearance of an object. To customize the background, click on the object or
border. When an object is in edit or selected mode, the background is the area
within the red or green outline.
You can format the background in one of two ways:
Select the object(s) and use the Format

Object Options

Fill command.

Right-click on the object, select Format from the pop-up menu, and
choose the Background category.
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Figure 8.61 Formatting Background dialog for a plot

Once the dialog opens, select a background color (solid or a gradient of colors).
Alternatively, an image can be centered, stretched, or tiled in the background.
With some objects (e.g., text boxes, gate views, or shapes) the dialog title is
Formatting Fill/Background. With these items, you can also choose a pattern
as a fill or make the background transparent. Transparency allows any object
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which is behind the item to show through. Plots do not support the Transparent
option.
With the Margins options (seen when formatting plots), you can set the space
around the margin of the plot. This is most useful when the text on the rightmost x-axis label of the plot is being cut off. To correct this, increase the right
margin percentage to increase the space between the right margin and the end
of the x-axis.
The Frames option (for plots) controls whether or not frame lines are visible on
top and to the right of the plot. You can also set the color and thickness of the
frame lines.

8.3.3

Border
The Border/Line options (Figure 8.62) allow you to adjust the border around
an object. By default, objects have no border.
When the object is in edit or selected mode, any border will appear inside and
adjacent to the red or green outline. You can customize the border/line options
in one of two ways:
Use the Format Object Options
in edit or selected mode.

command on object(s)

Right-click on the object, select Format from the pop-up menu, and
choose the Border (or Line) category.
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Figure 8.62 Formatting Border/Line dialog

8.3.4

Size
The Size category (Figure 8.63) is for adjusting the current size of an object. All
sizes are specified in inches.
To change the size of an object, use the Format Object Options
command on an object in edit or selected mode, or right-click on the object,
select Format from the pop-up menu, and choose the Size category. You can
change the absolute size, or scale the object by a certain percentage. By
enabling the Lock Aspect Ratio checkbox, you ensure that the width and the
height change in the same ratio (thereby keeping the object in the same
proportion).
The original size is only meaningful for inserted pictures. For other objects, the
original size will always be the same as the current size.
Note: When the object to be resized is a Text Box containing a token, table, or
text, you will not be able to make the text box smaller than the minimum size to
display the text or the minimum dimensions of the token or table (see Resizing
Text Boxes 164 ).
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Figure 8.63 Formatting Size dialog

8.3.5

Authorizations
The Authorizations category (Figure 8.64) may be adjusted for any object in
FCS Express. Authorizations allow user to control when objects are selected or
edited based on the chosen settings. Please see Formatting Authorizations
for
a detailed explanation of these features.
1134
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Figure 8.64 - The Formatting Authorizations dialog.

8.4

Formatting Features Shared by All Plots
In addition to the formatting options common to all objects 238 , all plots in FCS
Express share certain basic features, e.g., title, axes, legend, and 3D properties
(note that the latter is available only for Histograms and Surface plots) . These
options allow the user to completely customize the look of individual plots. If you
open plots with similar properties often, you may want to change the 184 default
plot options 184 .
You can always format a plot by right-clicking on the plot (or double-clicking on a
plot that is already selected), selecting Format from the pop-up menu, and
choosing a category to format.
After formatting a plot:
Press OK to apply the changes.
Press Cancel to discard the changes, close the dialog, and return to the
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original plot layout.
Press the Preview button to see what the changes would look like without
actually applying the changes. After Preview, press OK to apply the
changes, or simply continue editing.
Press Restore to discard the changes but continue editing the plot.
You can also format many features by selecting a plot and using the commands
on the Format tab of the Ribbon 73 . Preview and restore options are not
available using this method, however.

8.4.1

Specific Options
The following default Options can be specified in the Specific Options category for
indicated FCS Express User Options plot types:
Resolution (explained below 246 for Histograms, Kinetics, Dot, Color Dot,
Density, Contour, and Surface Plots)
Normalization 274 , Control Histogram for Subtraction Statistics 275 , and
Stacked vs. Overlaid display 275 (Histograms)
Cells to Plot 306 (Kinetics, Dot, Color Dot, Density, Contour, and Surface
Plots)
Whether Channel Calibration 610 is applied to axes (Histograms, Kinetics, Dot,
Color Dot, Density, Contour, and Surface Plots)
Dither Color Dot Plots 306 (Dot, Color Dot, and Scatter Plots)
Shade Based on Density (Dot and Color Dot Plots) 307
Orientation
(Heat Maps)
1048

The resolution options are located in the Formatting dialog in the
273 category for histograms 266 , and the
304 category for 2D plots 283 .
The properties you set are slightly different for the two kinds of plots, but the
basic functionality is similar in both.

An important concept to understand is "What is the resolution of a plot?"
The resolution is the number of bins (channels) that parameter data is
subdivided into. Before displaying a plot, FCS Express takes the data and
compresses it into the number of bins selected by the user. This process is
known as binning. The values in these bins are displayed in the plots. When
the resolution is lower, the same data gets compressed into fewer bins,
meaning that the values in the bins will be higher. That is why the peaks in
histograms, contour, and density plots increase when the resolution is
lowered. The way FCS Express puts the data into the bins is determined by
the scale 393 .
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Note: Statistics are always calculated on the full range of data, regardless of
how the resolution is set on a particular plot.

In FCS Express, you can set the value of the resolution, and control the range of
data (minimum and maximum) that is displayed:
Value of the resolution
o For histograms (Figure 8.65), you can choose the range specified in the
data you are using, or set the resolution to a specific number chosen
from the drop-down list.

Figure 8.65 Histogram Resolution Options

o For 2D plots (Figure 8.66), choose from the drop-down list (32 x 32 to
1024 x 1024).
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Figure 8.66 2D Plot Resolution Options

Range of Data (Minimum and Maximum)
FCS Express gives you the option of dividing the full range of data into the
resolution (number of bins) you specify, or to "cut out" either the top end
or the low end of the data. In most cases, it is preferable to leave the
resolution maximums and minimums at the default value, i.e., automatic.
There are two reasons you might want to set the minimum or maximum.
The first is that in certain cases, some instruments may store extreme
values in the data. In general, this will just be noise, not significant data. If
an extreme data point is included when the plot is calculated, information
may be lost in a significant part of the range. In such a case, you can
exclude the extreme data point by setting a minimum or maximum value
to use for significant data points. The second reason you might want to
set the minimum and/or maximum is to provide detailed zooming into a
small range of values. You can also decide whether or not to include out of
range values in gates and quads.
Include Out of Range values in gates and quads
If you have not chosen to use an automatic resolution minimum or
maximum, there could be data that is outside the visible portion of the
plot. You can choose whether or not to include this data in gates or quads
drawn on this plot by selecting include out of range values in gates and
quads. If this option is checked, and the gate touches an extreme edge of
the plot, values outside the range of that edge will be included inside the
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gate. Values outside the edge of the plot will also be included in the
appropriate quad.

Technical note: Axis Resolution and Statistics
In FCS Express 6, all the statistics are calculated on the raw data, irrespective of
the display scaling. However, when Gates and Quadrants are created, decisions
must be made in cases when an event falls on the line of the gate or quadrant.
In FCS Express 6, Gates and Quadrants are calculated and drawn in a binned
space with binning dependent on both the Scaling 253 and the Resolution
Minimum/Maximum 246 of the plot. In turn, the inclusion or exclusion of an event
on the border line of a gate or in a quadrant is highly dependent on the scaling of
the plot, and on the Resolution Minimum/Maximum, of the plot the Gate/
Quadrants was drawn on.
When adjustments to the scaling or resolution of a plot are made, an event may
then fall to a different side of the border line of the gate/quadrant, and the user
may notice very slight changes in the statistics of gated events which are usually
quite minimal and make no impact on the interpretation of the results.
Please refer to the Axis Scale and Statistics

8.4.2
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chapter for more details.

Title
Title formatting options control the text and appearance of the title (header and/
or footer) on each plot.
You can edit the title options in one of two ways:
Select the plot(s) and use the Format

Plot Options

Title command.

Right-click on the plot, select Format from the pop-up menu, and choose
the Titles category (Figure 8.67).
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Figure 8.67 Formatting Titles

Visible headers are the default for plot titles, "centered" with a grey background,
shadow, and a black border. The header text defaults to the file name keyword
code Keyword: $FCSE_FILENAMENOPATH for plot text box ... which
represents the local file name (no drive\folder) with compensation text that is
defined in the General section of the FCS Express User Options 180 .
The text options for titles are explained in the table below.

Option
Header/
Footer
Visible
Font
Text Field

Insert
Keyword

Explanation
Select either a Header or Footer in the upper left corner of the dialog to
determine which title location is currently being edited. Headers and
footers can co-exist.
Check or uncheck the checkbox to turn the Header/Footer on or off.
Customize the header/footer font style, size, and text color.
Enter text to be displayed in the Header/Footer in this field. Keywords
chosen will appear in the text field as codes, but expand to file-specific
values in the title.
A drop-down a list of special keywords that can be used in plot titles. The
following options are available:
Keyword from Data. Opens the FCS keyword list for the current file.
Select keyword(s) from the list (using Ctrl to select multiple
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Explanation
keywords) to insert in the header/footer.
File name with Path. Displays the data file name including the drive
and folder.
File name without path. Displays the data file name without the
drive\folder path.
File name from Data. Displays the $FIL keyword (which is part of
the FCS standard and is placed into the data file header during
sample acquisition).
Current Gate. Displays the name of the gate that is applied to the
base overlay.
Plot number. Displays the Plot Number of the plot (usually visible as
part of the plot name in General options 238 ).
Other Tokens.... Let the user insert any of the tokens available in
the layout. An Inserting Tokens 688 window will open upon selecting
this option.
Align the title text left, center, or right.

The appearance of the Header/Footer can be customized by changing the
background, shadow size, shadow color, and alignment in relation to the plot.
Check the corresponding "visible" checkbox to enable the appearance option. To
remove the shadow, set the Shadow Size to 0. The Rounded Border
checkbox controls whether or not to display the rectangle surrounding the
header/footer title with rounded edges (Figure 8.68).

Figure 8.68 Header Title with Rounded Border

8.4.3

Legend
Legend formatting options control the appearance and position of the legend in
relation to the plot.
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You can edit the Legend options in one of two ways:
Select the plot(s) and use the Format

Plot Options

Legend command.

Right-click on the plot, select Format from the pop-up menu, and choose
the Legend category (Figure 8.69).

Figure 8.69 Formatting Legend Dialog

The options for legends are explained in the table below.
Option
Visible
Position
Margin
Top position %
Back color
Shadow size and
color
Resize chart to
accommodate
legend
Title Visible

Explanation
Check or uncheck the checkbox to turn the legend on or off.
Set the legend to the right, left, top, or bottom of the plot.
Sets how far the legend is from the plot. Margin = 0 calculates the
margin automatically.
Sets where the top of the legend is located.
Sets background color of the legend.
The number sets the size of the shadow; use 0 for no shadow.
Choose the color from the drop-down list.
Enabling the checkbox will resize the plot to accommodate the
legend. The legend and plot events will overlap if the option is
unchecked.
Enabling the check box will display the legend title on Density and
Contour plots. The legend title is text as well as an interactive drop
down menu that allows you to easily change the parameter to use
for the Color based on 287 option.
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Explanation
Customize the Legend font style, size, and text color.

Axes
The Axis options control the appearance and text of the plot axes.
You can edit the Axes options in one of two ways:
Select the plot(s) and use the Format

Plot Options

command.

Right-click on the plot, select Format from the pop-up menu, and choose
the Axis category (Figure 8.70).

© 2020 De Novo Software

254

FCS Express 6 Manual

Figure 8.70 Formatting Axes Dialog

The options are explained in the table below. With the Visible checkbox, where
present, you can determine if the option is displayed or not.
Option
Explanation
Derive
Choose Parameter Name, a Parameter label set 408 (if a label set has been
Axis Titles defined), or the text specified in the Text field (under Title).
From
Select
Select the Y Axis or X Axis to determine which axis is currently being edited.
Axis
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Option
Scale

Explanation
If Automatic scaling is checked, the axis will be shown in the scale chosen
automatically by FCS Express for that parameter (from the $PnE keyword).
You can override automatic scaling, and choose the axis scaling 393 .
Range
For all axes displaying data:
If Automatic Range is checked and the resolution options are set to
automatic 246 , then the range will either start at 0 or the lowest data
value (a negative number) and extend to the highest data value.
If Automatic Range is turned on, but the resolution options are not
automatic, the range will be the minimum to maximum specified in the
resolution options.
For the count axis on a histogram, if Automatic Range is enabled, the
axis range will extend from 0 to the highest event count.
Minimum. The minimum value to display on the axis. This option is only
meaningful if automatic range is turned off.
Maximum. The maximum value to display on the axis. This option is only
meaningful if automatic range is turned off.
# Ticks. The number of ticks to show along the axis.
Title
Set the visibility, specific text, font style, size, color, and angle for the title of
the axis parameter.
Axis Line Set the Axis Line visibility, style, color, and thickness.
Labels
Set the visibility, font style, size, color, and angle for the numbers which label
the scale.
Grid Lines Set the Grid Lines' visibility, style, color, and thickness.
Divide by Divide the nominal axis labels by a given factor, and choose whether or not to
Factor
show the factor in the Axis title.
Ticks
Set the visibility, color, and width for the linear/logarithmic tick markers.
Other
If Display axis at zero is checked, the axis currently being edited will be
displayed at zero rather than at the plot origin.
8.4.4.1

Axis Scale and Statistics

In FCS Express 6, all the statistics are calculated on the raw data, irrespective of
the display scaling. However, when Gates and Quadrants are created decisions
must be made in cases where an event falls on the line of the gate or quadrant.
In FCS Express 6, Gates and Quadrants are calculated and drawn in a binned
space with binning dependent on both the Scaling 253 and the Resolution
Minimum/Maximum 246 of the plot. In turn, the inclusion or exclusion of an event
on the border line of a gate or in a quadrant is highly dependent on the scaling of
the plot, and on the Resolution Minimum/Maximum, of the plot the Gate/
Quadrants was drawn on.
When adjustments to the scaling or resolution of a plot are made, an event may
then fall to a different side of the border line of the gate/quadrant, and the user
may notice very slight changes in the statistics of gated events which are usually
quite minimal and make no impact on the interpretation of the results.
To illustrate the scenario the example below use the exact same Quadrants
which have been drawn on different plots using different Scale and/or different
Resolution Minimum/Maximum values. In row 1, the three plot are using different
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Scales (i.e. Log, Biexponential and Hyperlog respectively) but the same
Resolution Minimum/Maximum. In row 2, the three plots are using the same
scale (i.e. Biexponential) but different Resolution Minimum/Maximum values. In
row 3, plots are using different Scales and different Resolution Minimum/
Maximum values.
Each of the plots below is using a different binning, thus, Quadrants drawn on
each them, will use a slightly different binning as and very slight differences in
percentages may be observed (Figure 8.71).
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Figure 8.71 The same Quadrants have been displayed on plots using different axis
scales and/or different Resolution Minimum/Maximum values. Quadrant
statitìstics are slightly different (yet statistically insignificant) because of the
different binning on the plots and the assignment of events that fall on the borders
of the quadrants.

Although small differences exist for both Quadrants and Gates, they are usually
only visible for quadrants since they are dependent on the scaling of the plot the
quadrant is displayed on. When the axis scale changes, the Quadrant binning on
that plot updates as well.
The behavior of Gates is slightly different, as Gates retain the binning of the plot
they have been drawn on meaning that a gate can be displayed on plots using
different scales but, for consistency, it will always refer to the binning of the plot
it has been drawn on.
In the following three scenarios (Figure 8.72), the same Gate has been drawn on
a plot using a specific scale (i.e. Log scale in the first row, Biexponential scale in
the second row or Hyperlog scale in the third row). The gate has then been
displayed on plots using different scales (i.e. Log scale in the first column,
Biexponential scale in the second column or Hyperlog scale in the third column).
The Resolution Minimum/Maximum on all the plots below is set to Automatic,
thus it will vary between the three columns.
The gate statistics are consistent within each row, because in each row the same
gate is displayed on different plots. However, small differences are visible
between different rows because the gates are using three different binnings.
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Figure 8.72 The same Gate has been drawn on plots using different axis Scales and
different Resolution Minimum/Maximum (Rows 1, 2 and 3) and then displayed on
plots using different axis Scales and different Resolution Minimum/Maximum
(Columns 1, 2 and 3). Gate statitìstics are slightly different (yet statistically
insignificant)change between rows because of the different binning. Gate
statitìstics do not change between columns because Gates retain the binning of the
plot thay have been drawn on.

8.4.5

3D Display Options
Even though only surface plots have typically been displayed in three dimensions
(3D), FCS Express also has the capability of rendering histograms in 3D. The
appearance of histograms with multiple, filled-in overlays may be enhanced in
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The 3D display options control the 3D plot appearance and orientation relative to
the user. You can edit the 3D display options for a surface plot or histogram in
one of two ways:
Select the plot(s) and use the Format tab

Plot Options

3D command.

Right-click on the plot, select Format from the pop-up menu, and choose
the Surface Plot 3D Options or Histogram Plot 3D Options category,
as appropriate (Figure 8.73).
Note: Previewing changes several times without saving is an effective method of
becoming familiar with the 3D controls. Right-clicking on the plot and selecting
the appropriate 3D Options page has the advantage of bringing up a dialog with
Preview and Restore buttons 245 .

Figure 8.73 Formatting 3D Options for a Surface Plot

Check or uncheck View in 3 Dimensions to toggle 3D on or off.
Use the Display wall along Y-axis check box to turn on or off a yellow wall
along the Y-axis.
Depth can be controlled (from 0% to 100%) with the 3D% (for histograms) or
the Depth for surface plots spin buttons. As 3D% increases, the third
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dimension z-axis widens and the single-plane events progress from dots to short
stubble to long lines.
The other options are controlled by sliders:
Zoom resizes the plot within the object border from less than 100%
(smaller than current size) to 500%. As the zoom % increases, axes and
events may extend beyond the object border until the zoom is decreased
again. The zoom is reversible, i.e., no data is lost.
Rotation pivots the plot on the vertical axis from 270 to 360 where 360 is
facing the user straight on and 270 rotates the plot clockwise (turns a 90degree pivot to the left), so the right-hand z-axis is facing the user straight
on.
Elevation turns the plot on the horizontal axis from 270 to 360 where 360
is facing the user straight on and 270 tips the top edge of the plot forward
(turns a 90-degree pivot down), so the top edge z-axis is facing the user
straight on.
Horizontal offset and Vertical offset control the position of the 3D plot on
the page.
Perspective is a value from 0-100 that controls how far the chart appears
to be from the user.
Tilt is a value from 0-360, indicating the number of degrees the plot will be
rotated in its 2D-space about an axis perpendicular to the screen.

8.4.6

Magnifying a Plot
It is possible to Magnify

260

a region of a histogram

260

or 2D plot

262

.

Magnifying Axes is equivalent to setting the minimum and maximum axis range
for the plot 253 . Magnifying Resolution also resets the range of data displayed on
the plot, but also applies your Plot Resolution 246 to the displayed range, rather
than to the entire .fcs file.
To magnify a histogram:
Right-click on the histogram and select either Magnify (Resolution) or
Magnify (Axis) from the pop-up menu.
Press and hold the mouse button down where you want the lower bound of
the magnification to be.
Drag the cursor to where you want the upper bound of the magnification to
be.
Release the mouse button.
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An example histogram for the Magnification operation is shown in Figure 8.74.

Figure 8.74 An Example Histogram
Before Magnification

The result for Magnify (Resolution) for the region from channel 445.8 to 776.8
is shown in Figure 8.75.

Figure 8.75 Magnify Resolution from
Channel 445.8 to 776.8
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The result for Magnify (Axis) for the region from channel 445.8 to 776.8 is
shown in Figure 8.76.

Figure 8.76 Magnify Axis from Channel
445.8 to 776.8

To release the magnification, right-click on the histogram and select UnMagnify
(Resolution) or UnMagnify (Axis) from the pop-up menu.
Magnifying a 2D plot sets the minimum and maximum values on both the X- and
Y-axis scales.
To magnify a 2D plot:
Right-click on the 2D plot and select either Magnify (Resolution) or
Magnify (Axis) from the pop-up menu.
Press and hold the mouse button down where you want one end of the
magnification "box" to be.
Drag the cursor to where you want the other end of the magnification "box"
to be.
Release the mouse button.
An example 2D plot for the Magnification operation is shown in Figure 8.77.
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Figure 8.77 An Example 2D Plot Before
Magnification

The result for Magnify (Resolution) for the region with the majority of cells is
shown in Figure 8.78.

Figure 8.78 Magnify Resolution for a 2D
Plot

The result for Magnify (Axis) for the region with the majority of cells is shown
in Figure 8.79.
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Figure 8.79 Magnify Axis for a 2D Plot

To release the magnification, right-click on the 2D plot and select UnMagnify
(Resolution) or UnMagnify (Axis) from the pop-up menu.

8.4.7

Changing Plot Type
Existing plot(s) on your layout may be reformatted to a different plot type at any
time, by selecting the plot(s)
and using the Change Plot Type button on the
Format tab (Figure 80.)
1218

Figure 8.80 Changing the plot type from color dot to contour.
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Plot Names
Plot names assigned by default include information about the plot type 170 , .fcs
file data, displayed parameters, and order of creation in your layout. Plot names
appear in hovertext over the plot (Figure 8.81) and in navigators 123 , and assist in
selecting the data source 695 when inserting a token on your layout or in setting
up batch processing actions 801 .

Figure 8.81 Default plot name as shown in plot
hovertext.

Plot names can be customized to contain free text, tokens 688 , or a combination
thereof. The same plot's hover text is shown below in Figure 8.82 after being
changed to a combination of freetext and the $DATE keyword token.

Fig. 8.82 Plot name changed to contain freetext
and a keyword token.
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To customize the plot name, either:
Select the plot, use the Format
and edit the Plot Name, or

Object Options

General command,

Right-click on the plot, select Format from the pop-up menu, choose the
General category, and edit the Plot name.
The Data, Layout, or Gate Navigator 123 may also be used to change the
Plot name by right clicking on the plot within the navigator and choosing
Rename.
Alternatively, a Suffix for Compensated Data may be added or removed
from the
Compensated Data Category. 183

8.5

Formatting Single Parameter Histograms
In addition to the formatting options common to all Objects 238 , and those
common to all Plots 245 , single parameter histograms have certain properties,
such as overlays 267 , markers 270 , magnification 260 , and other specific options 273
which can be formatted.
Overlays 267 are defined in FCS Express as a data set that is displayed on a plot. A
data set for a histogram consists of a data file and parameter combination. A
histogram must contain one or more overlays. Overlays can be added or deleted
from a histogram. Furthermore, while any number of data files with parameters
different from the first overlay (also known as the base overlay) can be added to
the same histogram, the axis title and scaling will always be taken from the base
overlay. The histogram legend 251 is valuable for displaying and organizing
multiple overlays.
Markers

270

are regions defined along a single parameter.

Magnification of a histogram 260 allows you to reset the minimum and maximum
axis scale and resolution to restrict your view to a certain region of the
histogram.
The histogram specific options 273 include normalization, plot resolution,
presentation choices for multiple overlays, and the choice of a control histogram
for histogram subtraction statistics.
You can always format a histogram by right-clicking on the plot, selecting
Format from the pop-up menu, and choosing a category. This method will allow
you to use the Preview button to see what the changes would look like without
actually accepting the changes. Alternatively, once the histogram is selected, you
can choose the desired category from the Format tab of the Ribbon 73 .
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Overlays
The Overlays option controls the parameter and appearance of histogram
overlays.
All histograms have at least one overlay representing a file and two parameters
to display. You can add additional overlays by any of the following methods:
Right-click on the plot and select Add overlay from the pop-up menu
(launches a standard browser window called Select Data File 214 ), or
Right-click on the plot and select Add Overlay using Advanced Open
Data Dialog (launches the Open Data File 215 dialog), or
Drag-and-drop file(s) from the Data List
overlay, or

783

onto the plot you wish to

Drag-and-drop a plot from the layout onto the plot you wish to overlay.

You can edit overlays in one of two ways:
Select the histogram(s) and use the Format
command.

Plot Options

Right-click on the histogram, select Format from the pop-up menu, and
choose the Overlays category (Figure 8.83).
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Figure 8.83 Formatting Histogram Overlays Dialog

In the dialog, a list of all the overlays on the histogram will appear in the list box
to the left . You can select one or more overlays using standard Microsoft
Windows keystroke commands, including Shift-Click and Ctrl-Click. The
properties on the right
pertain to the currently selected overlay(s). If multiple
overlays are selected, properties that are not identical in all selected overlays will
appear blank or will display a black square in their check box ( ). If the
properties are not blank, or they are not displaying a black square in their check
box ( ), then they are identical for all selected overlays. Changing an option will
change that property for all selected overlays. For instance, if you select three
overlays and change the Gate, the Gate for all three overlays will be modified.
To remove an overlay from a plot, select the overlay (or multiple overlays) and
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press the Remove button.
To change the order of selected overlay(s) in the legend
down arrows (

251

, use the blue up and

).

For a brief tutorial on how to use overlays, visit us at https://youtu.be/
nVqwvDo1RmA.
Overlay properties are explained in the table below.

Option
X Parameter
Gate

Explanation
Change the parameter displayed on the histogram.
If gates are defined 316 , select the gate that will be used to limit
the data that is displayed on the histogram.
Compensation
If compensation definitions 622 are set, select the definition to use
when compensating the data in the overlay.
Transformation
If transformations 934 are set, select the transformation to use for
each overlay.
Distribution
Select the data to be shown. Standard displays the data in
number of events per channel, and Cumulative displays the
cumulative distribution frequency (often used for statistical
testing). Information about the cumulative distribution frequency
can be found in standard statistics textbooks.
Legend Text
The text that will appear in the legend beside the symbol for the
overlay. Free text can be inserted. If this field is blank the file
name of the overlay will appear.
A dropdown menu with additional pre-customized legend content is
accessible by pressing the ellipsis button next to the legend text.
Possible choices are:
o Keyword. This can be used to insert keywords from the header
of the data file.
o Gate. This can be used to display the current gate applied to
the overlay.
o Tube Number. This can be used to display the Tube Number of
the overlay when a Panel 858 is active.
o Tube Name. This can be used to display the Tube Name of the
overlay when a Panel 858 is active.
The above mentioned Legend options apply only to Dot Plots,
Color Dot Plots, Histograms and Spectrum Plots.
Line Options
Choose the overlay line style, color, and/or width.
Smoothing
Set the degree of smoothing for the overlay.
Show legend
When selected, colored solid boxes will be used in the legend
symbol as solid box instead of lines. Box colors are defined in the Line Options > Color
field (see below).
Fill the histogram
Enable the checkbox to fill in the overlay using the selected Fill
area
Style. Overlays that are filled in may look better on a 3D display 258
(Figure 8.84).
Fill Style
The pattern that will be used to fill the histogram.
Transparency
Transparency of histogram fill, where 0 is opaque and 100 is
completely transparent (invisible).
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Option
Change data file
during Next/Prev/
Batch

Explanation
If this option is checked, the data file for this overlay will change
when doing batch processing 782 , or selecting Previous File or Next
File 72 . This option is usually only disabled for a control histogram,
where you have multiple overlays, and want the control to stay the
same all of the time.
Perform Baseline
If the value of the cell is zero, a random offset will be added so
Offset
that the dot appears off the axis. This will not affect the statistics.
Visible
You can hide overlays on a histogram without removing them.
Select the overlay file from the list and uncheck Visible. Check
Visible to show the overlay again.
Line Options (Width, Graphical options used for each overlay. These options also applies
Style, Color)
to the legend unless the "Show legend symbol as solid box" is
enabled. In that case, the color only will apply to the legend.

Figure 8.84 Histogram Overlays in 3D

8.5.2

Histogram Markers
The Markers option allows the user to control the formatting of histogram
markers.
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Please also see the sections on Using Markers 350 for additional details on
creating, editing, resizing, linking, and locking markers.
You can edit markers in one of two ways:
Select the histogram(s) and use the Format
command.

Options

Right-click on the histogram, select Format from the pop-up menu, and
choose the Markers category (Figure 8.85).

Figure 8.85 Formatting Markers Dialog

In the dialog, a list of all the markers on the histogram will appear in the Marker
list box. You can select one or more markers using standard Microsoft Windows
techniques, including Shift-Click and Ctrl-Click. The properties on the right
pertain to the currently selected marker(s). If multiple markers are selected, the
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information will appear blank for those properties that are not identical in all
selected markers. If the properties are not blank, then they are identical for all
selected markers. Changing an option will change that property for all selected
markers. For instance, if you select three markers and change the Color, the
Color for all three markers will be modified. To remove a marker, select it and
press the Remove button.
Marker properties are explained in the table below.
Option
Applies to
overlay
Name

Explanation
Select which overlay(s) the marker applies to. Statistics will be calculated for
the overlay that the marker applies to.
The name of the marker that appears in text boxes on a plot when the marker
name token is selected.
Low
The low channel boundary of the marker. Tokens may be used to define low
bound by clicking on the T icon 353 . The locked check box locks the low bound
position to a manually entered or token defined value. Additionally, A lock may
be overridden without accessing the formatting dialog by dragging a new
token value onto the marker endpoint.
High
The high channel boundary of the marker.Tokens may be used to define low
bound by clicking on the T icon 353 . The locked check box locks the high
bound position to a manually entered or token defined value. Additionally, A
lock may be overridden without accessing the formatting dialog by dragging a
new token value onto the marker endpoint.
Color
The color that the marker will be drawn in.
Line width The line width of the marker.
Linked
The gate that the marker is linked to 364 . To break the link between the
Gate
marker and a gate select No Link.
Visibility Choose to show the marker "True", hide a marker without removing it "False",
or make it visible based on a conditional value "Custom". The Custom option
allows you define visibility of the marker based on a token or value that
evaluates to a conditional expression 744 . Any tokens or values may be used
to set a conditional custom value and may be inserted 688 via right click in the
field, Insert Token or by clicking on the T token icon. The marker will only be
visible if the token evaluates to True.
Allow
Choose to allow moving the marker "True", disallow a marker move "False", or
Move
make moving the marker based on a conditional value "Custom". The
Custom option allows you define the move status of the marker based on a
token or value that evaluates to a conditional expression 744 . Any tokens or
values may be used to set a conditional custom value and may be inserted 688
via right click in the field, Insert Token or by clicking on the T token icon.
The marker will only be allowed to move if the token evaluates to True.
Default
When a marker is created, you can choose whether or not to show the
marker
marker name and/or stat in a text box, and select the default line width and
values
color. If marker stat is enabled, you can choose which statistic to display
from the drop-down list. If Show detailed marker resizing information is
checked, the marker boundaries will appear above the marker and lines will
drop to the axes to show where the marker boundaries will be during resizing.
If Create a linked gate is checked, when new markers are created on this
plot, a gate linked to the marker 364 will automatically be created.
Show
Enables drop down lines at the end of each marker to show the position on
detailed
the axis as well as displays marker low and high boundary values.
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Explanation

When checked, any new markers created on the histogram will be
automatically converted to linked gates. Any existing markers on the plot will
still need to be manually linked to a gate 364 .

Histogram Specific Options
The Histogram Specific Options category contains a variety of properties that
control how data on the histogram is displayed.
You can edit histogram specific options in one of two ways:
Select the histogram(s) and use the Format
Options command.

Plot Options

Right-click on the histogram, select Format from the pop-up menu, and
choose the Histogram Histogram Specific Options category (Figure
8.86).
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Figure 8.86 Formatting Histogram Specific Options

The options are described in the table below. See Resolution Overview
further description of resolution options.

Option
Normalize to

246

for a

Explanation
If different overlays contain different numbers of events
in a channel, they may not look alike even if the data
comes from an identical population. Overlays can be
normalized based on the number of events or based on
the peak value. The reference, for both the number of
events or the peak value, can be an overlay (select the
Based on Overlay radio button and select an overlay
from the drop-down list. The number of events in other
overlays will be normalized to appear to have the same
number of events as the selected overlay.) or a custom
value (select the Based on Value radio button and type
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Explanation
the custom value in the corresponding field).
Plot resolution
In the first drop-down menu, choose whether to use the
resolution specified in the data or select your own
resolution from the second drop-down menu. Choosing a
resolution lower than the true resolution of the plot is an
effective way of smoothing your data.
Automatic Minimum
If this is checked, then FCS Express will start binning the
data (dividing it into the number of bins specified by the
Plot resolution) at either 0 or the lowest data value (if
the lowest data value is below 0).
Resolution Minimum
Specify where to start binning the data. If Automatic
Minimum is checked, then this value is ignored.
Automatic Maximum
If this is checked, then FCS Express will finish binning the
data (subdividing it into the number of channels specified
by the Plot resolution) at the highest value of the true
data range.
Resolution Maximum
Specify where to finish binning the data. If Automatic
Maximum is checked, then this value is ignored.
Include out of range values If this is checked, data values that are outside the
in gates and quads
resolution options of the plot will be considered to be part
of the lower or upper channels. If a gate or quadrant
touches the lower or upper channels, it will include these
cells, even though the cells are actually outside the
boundary of the gate/quadrant.
Use channel calibration on
FCS Express can establish calibrated values for the axes
610 . If channel calibrations are defined, toggling this
axis
checkbox will determine whether or not to use the
calibrated values in place of the generic channel
numbers.
Control Histogram for
FCS Express can automatically perform histogram
Histogram Subtraction
subtraction 594 to calculate the number of positive cells.
Statistics
Select which overlay is the control.
Display multiple overlay data Display overlay data in a single histogram (Overlaid) or
use a split view (Stacked). See Figure 8.87.
Stacked Y Axis Title Type
If multiple overlay data is displayed Stacked, choose the
Y Axis Title to use.
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Figure 8.87 A Histogram with Two Overlays
in Stacked View

8.6

Formatting 1D Spectrum Plots
In addition to the formatting options common to all Objects 238 , and some of
those common to all Plots 245 , specifically Axis, Titles, and Legends, Spectrum
Plots have certain properties, such as overlays 277 and spectrum options 279 which
can be formatted.
Overlays 267 are defined in FCS Express as a data set that is displayed on a plot. A
data set for a spectrum plot consists the individual spectrum from every event. A
Spectrum Plot must contain one or more overlays. Overlays can be added or
deleted from a Spectrum Plot, but the first overlay, also known as the base
overlay, cannot be removed, only reformatted or changed. Furthermore, spectra
for all events may be displayed individually or as an average.
Spectrum Options 279 share the same options as Display Gates and Color Levels
options. Here, you may automatically match the color of the spectrum line for
each event to the color of the gate to which it belongs. These options allow for
"backgating" of spectral flow cytometry data files. You may alternatively choose
to display the spectral line colors on Density.
You can always format a Spectrum Plot by right-clicking on the plot, selecting
Format from the pop-up menu, and choosing a category. This method will allow
you to use the Preview button to see what the changes would look like without
actually accepting the changes. Alternatively, once the Spectrum Plot is selected,
you can choose the desired category from the Format tab of the Ribbon 73 .
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Overlays
The Overlays option controls the spectrum and appearance of spectrum
overlays. All Spectrum Plots have at least one overlay and a spectrum to
display. Additional overlays from the same or different spectral datafiles can be
added, and different gates can be applied to each, if desired (e.g., Figure 8.88).

Figure 8.88 - Spectral plot with two overlays from different spectral datafiles,
each with a different gate applied.

You can add additional overlays by any of the following methods:
Right-click on the plot and select Add overlay from the pop-up menu
(launches a standard browser window called Select Data File 214 ), or
Right-click on the plot and select Add Overlay using Advanced Open
Data Dialog (launches the Open Data File 215 dialog), or
Drag-and-drop file(s) from the Data List
overlay.

783

onto the plot you wish to

To edit overlays: right-click on the Spectrum Plot, select Format from the popup menu, and choose the Overlays category (Figure 8.89).
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Figure 8.89 - Formatting Spectrum Overlays Dialog

In the dialog, a list of all the overlays on the Spectrum Plot will appear in the list
box to the left . You can select one or more overlays using standard Microsoft
Windows techniques, including Shift-Click and Ctrl-Click. The properties on the
right
pertain to the currently selected overlay(s). If multiple overlays are
selected, the information will appear blank for those properties that are not
identical in all selected overlays. If the properties are not blank, then they are
identical for all selected overlays. Changing an option will change that property
for all selected overlays. For instance, if you select three overlays and change
the Gate, the Gate for all three overlays will be modified.
To remove an overlay from a plot, select the overlay(s) and press the Remove
button.
To change the order of selected overlay(s) in the legend
down arrows (

251

, use the blue up and

).
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For a brief tutorial on how to use overlays, visit us at https://youtu.be/
nVqwvDo1RmA.
Standard Overlay formatting options are explained in the table below; additional
Overlay options specific to Spectrum Plots, which can greatly aid in analysis and
report generation, are explained in detail here 928 .

Option
Spectrum
Gate
Legend Text

Smoothing
Change data file
during Next/Prev/
Batch

Visible

Line Options

8.6.2

Explanation
Change the laser line displayed on the spectrum plot.
If gates are defined 316 , select the gate that will be used to limit
the data that is displayed for each Overlay on the spectrum plot.
The text that will appear in the legend beside the symbol for the
overlay. Free text can be inserted. If this field is blank the file
name of the overlay will appear.
A dropdown menu with additional pre-customized legend content is
accessible by pressing the ellipsis button next to the legend text.
Possible choices are:
o Keyword. This can be used to insert keywords from the header
of the data file.
o Gate. This can be used to display the current gate applied to
the overlay.
o Tube Number. This can be used to display the Tube Number of
the overlay when a Panel 858 is active.
o Tube Name. This can be used to display the Tube Name of the
overlay when a Panel 858 is active.
The above mentioned Legend options apply only to Dot Plots,
Color Dot Plots, Histograms and Spectrum Plots.
Set the degree of smoothing for the overlay.
If this option is checked, the data file for this overlay will change
when doing batch processing 782 , or selecting Previous File or Next
File 72 . This option is usually only disabled for a control spectrum,
where you have multiple overlays, and want the control to stay the
same all of the time.
You can hide overlays on a spectrum plot without removing them.
Select the overlay file from the list and uncheck Visible. Check
Visible to show the overlay again.
Choose the overlay line width, style, and/or color.

Spectrum Options
The Spectrum Options category contains the Spectrum Plot Specific Options
280 , Color Levels 280 , and Display Gates Options 281 (Figure 8.90).
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Figure 8.90 - Spectrum Options category

8.6.2.1

Plot Specific Options

Spectrum Plot Specific Options include Y Plot Resolution, Display Mode (Color on
Gated/Overlays vs. Color on Density), Shade Based on Density, and Interpolate
Values. For details on these options, please see the table in the Formatting a
Spectrum Plot 928 topic.
8.6.2.2

Color Levels

Color Level options for Spectrum Plots are enabled in Color on Density
Display Mode 929 only.

929

Color Levels for Spectrum Plots can be formatted in the same manner as for 2DDensity Plot Color Levels 294 . Below is an example of a plot with customized color
levels (Figure 8.91). Please also see the Formatting a Spectrum Plot chapter 930
for additional details and examples.
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Figure 8.91 - The two
Spectrum Plots in the center
of the picture have
customized Color Levels.
8.6.2.3

Display Gates Options

To edit Display Gates options, either
Select the Spectrum Plot(s) and use the Format tab
Options
command, or
Right-click on the Spectrum Plot, select Format from the pop-up menu, and
choose the Spectrum Options Display Gates Options category (Figure
8.92).
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Figure 8.92 - Spectral plot with two overlays from different spectral datafiles, each
with a different gate applied.

If you have Average set as the Overlay to display, the lines are shown as the
Line options color. If you have All spectrums set as the Overlay to display,
the colors of each line will reflect the color of the gate in which the event falls. If
an event falls in more than one of the selected gates, then the line will be drawn
in the highest priority gate.
By default, the All Gates option is selected. However, you can select Only the
gates checked below and then select the gates whose colors you wish to
display. Alternatively, select All gates except those checked below and then
choose the gates whose colors you do not wish to display.
You can also choose how to display the gate color when a new gate is created
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on the layout. By choosing either the second or third radio buttons in the When
a new gate is created on the layout category, you can have FCS Express
display the gate color on a back-gated plot if the new gate was created on a
plot showing the same data file, or only on a plot showing the same
parameters (as the plot where the new gate was created).

8.7

Formatting 2D Plots
In addition to the formatting options common to all objects 238 , and those
common to all plots 245 , 2D plots have certain properties, such as overlays 283 ,
quadrants 290 , gates to display 302 , color levels 294 for density and contour plots,
and other specific options 304 which can be formatted.
You can always format a 2D plot by right-clicking on the plot, selecting Format
from the pop-up menu, and choosing a category. This method will allow you to
use the Preview button to see what the changes would look like without
actually accepting the changes. Alternatively, once the 2D plot is selected, you
can choose the desired category from the Format tab of the Ribbon 73 .

8.7.1

Overlays
All 2D plots have at least one overlay representing a file and two parameters to
display. With certain 2D plots (e.g., Dot, Color Dot, and Scatter), you can add
additional overlays, by any of the following methods:
Right-click on the plot and select Add overlay from the pop-up menu
(launches a standard browser window called Select Data File 214 ), or
Right-click on the plot and select Add Overlay using Advanced Open
Data Dialog (launches the Open Data File 215 dialog), or
Drag-and-drop file(s) from the Data List
overlay, or

783

onto the plot you wish to

Drag-and-drop a plot from the layout onto the plot you wish to overlay.

The Overlays option controls the parameters and appearance of 2D overlays.
You can edit overlays in one of two ways:
Select the 2D plot and use the Format
command (Figure 8.93).

Plot Options

Right-click on the 2D plot, select Format from the pop-up menu, and
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choose the Overlays category.
Different and specific overlay options are available for the following 2D
Plot types:
Dot Plots and Color Dot plots 285
Density plots and Contour Plots
Scatter Plots 288

286

Figure 8.93 Formatting Overlays Dialog for 2D Dot Plots

In the dialog, a list of all the overlays on the plot will appear in the list box to the
left. If the plot type permits multiple overlays, you can select one or more
overlays using standard Microsoft Windows techniques, including Shift-Click and
Ctrl-Click. The properties on the right pertain to the currently selected
overlay(s). If multiple overlays are selected, the information will appear blank for
those properties that are not identical in all selected overlays. If the properties
are not blank, then they are identical for all selected overlays. Changing an option
will change that property for all selected overlays. For instance, if you select
three overlays and change the Gate, the Gate for all three overlays will be
modified.
To remove an overlay from a plot, select the overlay (or multiple overlays) and
© 2020 De Novo Software

Formatting Objects

285

press the Remove button.
To change the order of selected overlay(s) in the legend
down arrows (

251

, use the blue up and

).

For a brief tutorial on how to use overlays, visit us at https://youtu.be/
nVqwvDo1RmA.

8.7.1.1

Dot and Color Dot Plot Overlays

For Dot plots and Color dot plots the following overlay options are available
(Figure 8.94).
Option
X Parameter
Y Parameter
Gate
Compensation
Transformation
Color

Dot Size

Emphasize Low
Frequency
Populations
Legend Text
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Explanation
Change the parameter displayed on the X axis.
Change the parameter displayed on the Y axis.
If gates are defined 316 , select the gate that will be used to limit
the data that is displayed on the 2D plot.
If compensation definitions 622 are set, select the definition to use
when compensating the data in the overlay.
If transformations are defined 934 , select the transformation to use
when displaying the data in the overlay.
The color that the overlay will be drawn in (used for dot plots and
color dot plots). The default overlay colors can be set on the 2D
plot preferences page of the FCS express User Options Dialog 191 .
FCS Express automatically calculates the dot size based upon the
height and width of your plot. By changing this setting, you can
force the dot size to be larger or smaller than what FCS Express
calculates by the factor chosen in the spin box. Note: If you are
using several overlays on color dot plots, and you want the
overlays to have different dot sizes, then the plot must be set
with Dither turned off 304 .
If the % gated 383 for a given gate is < 2%, the dot size for those
gated events will increase. Only available for Dot 170 plots
displaying gate colors and Color Dot plots 170 .
The text that will appear in the legend beside the symbol for the
overlay. Free text can be inserted. If this field is blank the file
name of the overlay will appear.
A dropdown menu with additional pre-customized legend content is
accessible by pressing the ellipsis button next to the legend text.
Possible choices are:
o Keyword. This can be used to insert keywords from the header
of the data file.
o Gate. This can be used to display the current gate applied to
the overlay.
o Tube Number. This can be used to display the Tube Number of
the overlay when a Panel 858 is active.
o Tube Name. This can be used to display the Tube Name of the
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Option

Smoothing
Change data file
during Next/Prev/
Batch

Visible
Perform Baseline
Offset

Explanation
overlay when a Panel 858 is active.
The above mentioned Legend options apply only to Dot Plots,
Color Dot Plots, Histograms and Spectrum Plots.
Set the degree of smoothing for the presentation of your data.
If this option is checked, the data file for this overlay will change
when doing batch processing 782 , or selecting Previous File or Next
File 72 . This option is usually only disabled for control histograms,
where you have multiple overlays, and want the control to stay the
same all of the time.
Controls whether or not to display this overlay on the 2D plot.
If the value of the cell is zero, a random offset will be added so
that the dot appears off the axis. This will not affect the statistics.
This option is typically used when analyzing LMD files from
Beckman Coulter.

Figure 8.94 Formatting Overlays Dialog for 2D Dot Plots

8.7.1.2

Density and Contour Plot Overlays

For Contour and Density plots, the following overlay options are available (Figure
8.95).
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Option
X Parameter
Y Parameter
Color based on

Gate
Compensation
Transformation
Legend Text

Smoothing

Outlier Display
Mode

Outlier Dot Color
Outlier Dot size
Change data file
during Next/Prev/
Batch

Visible
Perform Baseline
Offset
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Explanation
Change the parameter displayed on the X axis.
Change the parameter displayed on the Y axis.
Choose from Count or available parameters to base the density
display color palette on. For instance if FSC and SSC are displayed
on the X and Y and FL1 is chosen for Color Based on then the
density display will represent the distribution of FL1 fluorescence on
the FSC vs SSC plot. Using Color Based on is a common and useful
display type for working with tSNE transformed data sets 1002 where
it is useful to view tSNE X vs tSNE Y parameters on separate plots
for each measured parameter with the Color based on for each
plot representing a different parameter. The parameter used by this
option, can also be selected via the the legend title 251 .
If gates are defined 316 , select the gate that will be used to limit
the data that is displayed on the 2D plot.
If compensation definitions 622 are set, select the definition to use
when compensating the data in the overlay.
If transformations are defined 934 , select the transformation to use
when displaying the data in the overlay.
The text that will appear in the legend beside the symbol for the
overlay. If this field is blank the file name of the overlay will appear.
Insert keywords from the header of the FCS file by pressing the
ellipsis next to the legend text. You can also display the current
gate applied to the overlay by inserting "<$FCSE_GATEFORMULA>"
into the legend text.
Set the degree of smoothing for the presentation of your data.
Smoothing is performed with a box-filter algorithm. The Smoothing
parameter controls how many iterations of smoothing are
performed.
Choose from Do not show, Use color below, Use lowest color
level. Do not show will not display any outliers; Use color below
will use the Outlier Dot Color chosen in the drop down below for
the outlier color; Use lowest color level will set the color of the
outliers to the lowest color level displayed in the density plot.
If Use color below is chosen then the Outlier Dot Color selected
in the color palette will be used to display outliers.
Choose the size of the dots used to display outliers.
If this option is checked, the data file for this overlay will change
when doing batch processing 782 , or selecting Previous File or Next
File 72 . This option is usually only disabled for control histograms,
where you have multiple overlays, and want the control to stay the
same all of the time.
Controls whether or not to display this overlay on the 2D plot.
If the value of the cell is zero, a random offset will be added so
that the dot appears off the axis. This will not affect the statistics.
This option is typically used when analyzing LMD files from
Beckman Coulter.
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Figure 8.95 Formatting Contour or Density Plots

8.7.1.3

Scatter and Scatter with Regression Plot Overlays

For a full description of working with Scatter Plot specific features such as Error
Bars and Highlight parameters please see the Formatting Scatter Plots topic 562
and Scatter Plots Overview topic 556 .
Special overlay formatting options for Scatter and Scatter with Regression Plots
are indicated by number and referenced in the table and image below (Figure
8.96).
Point Color ( )
Point size ( )
Point shape ( )
Highlight Param(

)
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Highlight Color( )
Error Bar Param ( )
The formatting options are described in the table below.
Option
X Parameter
Y Parameter
Error Bar Param.

Highlight Param.

Highlight Color
Gate
Point Color
Legend Text

Point size

Explanation
The parameter (column) from the Spreadsheet 558 displayed on the
X axis.
The parameter (column) from the Spreadsheet 558 displayed on the
Y axis.
The parameter (column) from the Spreadsheet displayed as error
bars. See below 562 for more information on how to define the error
bars.
The parameter (column) from the Spreadsheet from which the
highlighting rule derives. Points will be highlighted (e.g., the orange
point in the plot below 563 ) in the color defined in
if their value
meets the criterion defined by the Highlighting rule. See below 562
for more information on how to define a highlighting rule.
The display color for highlighted points.
The gate that is applied to the Scatter Plot.
The display color for points.
The text that will appear in the legend beside the symbol for the
overlay. Free text can be inserted. If this field is blank the file
name of the overlay will appear.
The size of the points.

The shape of the points. Choose between rectangle (default),
triangle, circle, cross, star, hexagon, and diamond options.
Connect the points Whether the points are connected by a line.
Change data file
Whether the Scatter Plot changes during batch processing 782 or in
during Next/Prev/ response to a Next/Previous 79 command. It is generally
Batch
recommended to leave this unchecked (default), as the Scatter
Plot will update automatically as the data to which it refers is
changed.
Visible
Hides overlays without removing them. Select the overlay file from
the 2D Unbinned Overlays list and uncheck Visible. Check
Visible to show the overlay again.
Show marks
Displays the value of the points as text directly above the points.
Toggle between Error Bar Pen, Shape Border, and Connecting Lines
Line Options for
editing mode.
Error Bar Pen/
Width, Style (solid, dotted, and dashed options), and Color of the
Shape Border/
Error Bar Pen, Shape Border, or Connecting Lines.
Connecting Lines
Properties
Point shape
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Figure 8.96 Special formatting options for Scatter and Scatter with Regression Plots

8.7.2

Quadrants
The Quadrants category allows you to manipulate the quadrants on a 2D plot.
Quadrants can also be created and their positions adjusted directly from the plot
366 .
You can edit quadrants in one of two ways:
Select the 2D plot(s) and use the Format
command.

Options

Right-click on the 2D plot, select Format from the pop-up menu, and
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choose the Quads category (Figure 8.97).

Figure 8.97 Formatting Quadrants dialog

The options on the left side of the dialog are explained in the table below.
Option
Type

© 2020 De Novo Software

Explanation
The type can be one of the following:
Standard: All four quadrants are rectangular.
Floating: Quadrants can be any shape
X Percentile: The quadrants are rectangular, and the X position
of the quadrant is determined automatically based on the value in
the X Percentile edit field. Please refer to the note at the bottom
of this chapter 293 for details about how out of range events are
handled by percentile quadrants.
Y Percentile: The quadrants are rectangular, and the Y position
of the quadrant is determined automatically based on the value in
the Y Percentile edit field.Please refer to the note at the bottom
of this chapter 293 for details about how out of range events are
handled by percentile quadrants.
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Option

Explanation
Both Percentile: The quadrants are rectangular, and the X and Y
positions of the quadrant are determined automatically based on
the value in the X Percentile and Y Percentile edit fields,
respectively. Please refer to the note at the bottom of this
chapter 293 for details about how out of range events are handled
by percentile quadrants.

Line color and
thickness
Visibility

The color and thickness that the quadrant lines will be drawn in.

Choose to show the quad "True", hide a quad without removing it
"False", or make it visible based on a conditional value "Custom". The
Custom option allows you define visibility of the quad based on a token
or value that evaluates to a conditional expression 744 . Any tokens or
values may be used to set a conditional custom value and may be
inserted 688 via right click in the field, Insert Token or by clicking on
the T token icon. The quad will only be visible if the token evaluates to
True.
Allow Move
Choose to allow moving the quad "True", disallow a quad move "False",
or make moving the quad based on a conditional value "Custom". The
Custom option allows you define the move status of the quad based on
a token or value that evaluates to a conditional expression 744 . Any
tokens or values may be used to set a conditional custom value and
may be inserted 688 via right click in the field, Insert Token or by
clicking on the T token icon. The quad will only be allowed to move if
the token evaluates to True.
Quadrant
The precise coordinates of the quadrant vertices. These can be entered
vertices
manually for precise control over quadrant positioning. Note: Quadrants
are stored in 256x256 resolution; therefore, not all possible values for
quad vertices will be available.
Overlay to use Which overlay to use when calculating the percentiles for the X
Percentile and Y Percentile quadrant types.
X Percentile
Which percentile to use for the X Percentile and Both Percentile
quadrant types.
Y Percentile
Which percentile to use for the Y Percentile and Both Percentile
quadrant types.

Quadrant Linking Options
Quadrants can either be linked to other quadrants 369 or to gates 369 . You can
change the current links from the Linking Options area of the dialog.
To change the quadrant to quadrant link, select Quad to Quad and choose the
plot you want to link to the current plot. The quadrants on the current plot will
become a "slave" to the quadrants on the linked plot, i.e., when the properties of
the quadrants on the linked plot change, the quadrants on the current plot will
also change. For example, by linking plots to an isotype control plot, the
quadrants in the linked plots will automatically adjust if the isotype control
quadrants are adjusted.
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If quadrants on the plots have been converted and linked to gates 369 , these links
can be changed or broken in the Quad to Gate dialog. The dialog will appear
similar to Figure 8.98.

Figure 8.98 Linking Quad to Gate

In order to change or break the link, select the down arrow to the right of the
drop-down list. Select No Link to break the link between the quadrant and the
region. Below the No Link item will be a list of gates previously linked to other
quadrants on this plot, and now available for linkage to the selected quadrant. A
gate can only be linked to one quadrant in a layout. If the desired gate does not
appear in the drop-down list, it is already linked to another quad on the current
plot or is not derived from these quadrants at all.

Notes regarding percentile quadrants and out of range events
Sometimes a considerable number of events are out of range for a given
parameter and thus are assigned to have the maximum value for that
parameter. If the top X% of events all equal the maximum value on the plot then
the vertex of the last X percentiles will all be set at the maximum value. For an
example in which the top 30% of events are all set to the maximum value for a
given parameter the vertex of all the percentiles quadrants above the 70th
percentile will all be set at the maximum value (Figure 8.99 below. Note the
middle two and far right plots.).
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Figure 8.99 In this FCS file more than 30% of the events are set at the maximum
value for the SSC parameter. Percentile quadrants have been set at different
percentiles of the SSC parameter. Note that the vertex of percentiles from the 70th
percentile and above are all at the maximum values for the SSC parameter.

8.7.3

Color Levels
The Color Levels options are used to control how Density and Contour plot
are colored. The significance of each color level can be displayed in the plot
legend 251 . In FCS Express 4, 25 discrete color levels were used to generate
gradients in Density and Contour Plots. Since FCS Express 5, Density plots are
rendered in 256 discrete color levels, resulting in a smoother color gradient.

You can edit the Color Levels for Density or Contour plots in one of two
ways:
Select Density or Contour plot(s) and select Format
Levels from the ribbon bar (Figure 8.100).

2D Options

Right-click on a Density or Contour plot, select Format from the pop-up
menu, and choose Density Options Color Levels or Contour
Options Color Levels.
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Figure 8.100 Contour Level Options

For Density and Contour plots, each bin is colored based on the value that bin
has for a specific parameter. By default, both Density and Contour plot are
colored based on density, thus based on the number of events included in each
bin. However, since FCS Express 6, any parameters can also be used to
represent a density color shading. The parameter the color is based on is the one
shown in the legend 251 and can be changed both through the legend itself and
through the Overlay 286 dialog (see the Color based on 287 option).
Note: Colors are calculated taking into consideration both Plot Resolution 304 and
Smoothing 286 . The plot legend reports the actual values used to calculate the
color.
Three options can be selected to customize the way bins are colored:

1. Color level
Color level options define the color palette (see figures below).
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Color Level choices for density plots

Color Level choices for contour plots
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The choices in the list differ for each type of plot:
Possible choices for Density plots are: Absolute or Percentile (the
number of levels is the number of colors shown in the list), Rainbow (240
color levels), Green-black-red (250 color levels), Flame (252 color level),
Greyscale and Inverse greyscale (255 color levels), B&W stripes (240
color levels).
Possible choices for Contour plots are: Absolute or Percentile (the
number of levels is the number of colors shown in the list), Rainbow (24
color levels), Green-black-red (8 color levels), Flame (24 color level). For
the remaining choices the number of levels is specified in the drop down
menu.
When you select a color level category, the colors in the chosen palette will be
displayed in the bottom half of the dialog. In addition, the Preview and Restore
buttons 238 in the Format dialog provide a convenient means for evaluating each
color scheme with your data. Note that the Preview and Restore buttons 238 are
available only when the Format dialog is accessed by right clicking on the plot.
They are not available when the Format dialog is accessed via the Ribbon bar.
Most of the Color Level schemes are simply defined by their names, ie, GreenBlack-Red uses those colors in the scheme, but two may require further
explanation:
Absolute. Color levels may be defined by the user based on absolute
values (see below, Color Level Properties). If Calculate Levels based
on data is checked, color levels are instead defined by the software.
Percentile. Color levels may be defined by the user based on percentiles
(see below, Color Level Properties). If Calculate Levels based on
data is checked, color levels are instead defined by the software.
The color for an individual level can be changed by selecting the color and
clicking the ellipsis inside the color box. A level can be added or removed by
selecting the appropriate level and pressing the
(Add) or
(Remove)
buttons. To access these settings for plots displaying Color Levels other than
Absolute and Percentile, uncheck Calculate all levels based on data 298 .
When selecting grayscale, the shades of gray are automatically displayed for
you. You will not be able to edit the shades for an existing level.
You can return to the Rainbow style (or your current default option for 2D
Contour or Density plots 191 ) by clicking on the Restore selected level to
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default values button. Clicking the Default button will also update any plots
created in a Version 4 layout to the newest default color palette for the current
version.

2. Style
Style options defines how color levels are used to color the data.
Fixed range. The range of the data in the parameter that was selected
for the coloring is divided into evenly spaced color levels. Settings may
also be manually defined rather than based on data. 298
Percentile. The range of the data in the parameter that was selected for
the coloring is divided into color levels, so that each color level contains
the same number of data causing the colors to be centered around the
median. Settings may also be manually defined rather than based on data.
298

Mean +- SD. The range of the data in the parameter that was selected
for the coloring is divided into color levels, so that the central level is
centered around the mean of the data and the color shapes are normally
distributed based on the standard deviation specified by the user.
Threshold. The range of the data in the parameter that was selected for
the coloring is divided into only two levels regardless of the Color Level
selected. The two colors can be customized by the user. The color of
each bin will be decided based on the threshold specified by the user.

3. Color Scaling
When Logarithmic is selected, the data (i.e. bin values) are logtransformed before dividing the range of the data into color levels.
4. Unchecking Calculate all levels based on data - Manual Settings
For Fixed range and Percentile styles you may uncheck the Calculate
all levels based on data check box to manually define your color level settings
or fix the low and high levels with two settings.
Specify the low and high level; the rest will be calculated
automatically, Figure 8.101: User may enter any value within limits for
the low and high bounds of the color levels. Intermediate increments for
the color levels will be calculated automatically using the current Color
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Level choice. This option is particularly useful when comparing plots with
tSNE transformations applied and visualizing different color based on
parameters in order to visualize color mappings within the same range/
scale.

Figure 8.101 - Choosing Specify the low and high levels; the rest will be
calculated automatically allows users to set a fixed low and high bound for
color scaling.

Specify all levels: The user may specify any levels manually by clicking
on the green + button to add a value or the red - button to remove a
color level. Alternatively, you may click on the yellow gear icon to launch
the Increment Information dialog, Figure 8.102, to more automatically
set increment levels based on user input of the lowest and highest color
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level, and how many increments to add in between. The Increment
Information dialog will allow you to adjust the following settings in the
table below.

Figure 8.102 - The Select an increment value dialog allows you to
automatically set increments for color levels based on the
desired low value, high value, and increment value between
discreet color levels to use.

Setting
Definition
Current value of lowest the value of the lowest color level currently showing
level
on the plot.
The value of the lowest the new value of the lowest color level you would like
level will be
to set.
Set the levels to
the incrementation value between discreet color
increments of
levels that you would like to set.
Current value of highest the value of the highest color level currently showing
level
on the plot.
The value of the highest the new value of the highest color level you would like
level will be
to set
The color gradient created will be based on the colors of the first and
last color in the list, figure 8.103. For instance, if the first color level is
purple and the last color level is black you will arrive at a purple to black
color gradient. Clicking on ellipsis button (...) on the individual color
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levels will reveal the color palette to choose which colors to use for the
first and last color level.

Figure 8.103 - The first and last color levels in the list will determine the beginning
and ending colors for the gradient. Clicking on the ... button within the color will
allow you to pick a new color for the color palette.

Examples
Figure 8.104 below depicts some examples of plots colored with different
combinations of Color Levels, Styles and Color Scaling:
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Figure 8.104. Example of different color combinations. The text below each plot
reports the Color Levels, the Styles and the Color Scaling used. Additional setting
(e.g. "Calculate Levels based on data" and "Standard Deviation") are also
reported.

8.7.4

Gate Display
The Gates to Display formatting options are for setting which gates to use to
color events. Gate display functions are available for dot plots, color dot plots,
and scatter plots. You can also choose which gates to display in a data grid 676 .
You can edit the Gates to Display in one of two ways:
Select the plot(s) and use the Format
command (Figure 8.105).

Options

Right-click on the plot, select Format from the pop-up menu, and choose
the Display Gates Options category (located under the Plot Options
category for each specific type of plot).
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Figure 8.105 Formatting Gates to Display dialog

If you have one overlay on a dot plot, the dots are shown in the gate color. If
you have more than one overlay, the colors will reflect the different overlays,
which are specified in the Overlays 267 section of the Format window.
By default, the All Gates option is selected. However, you can select Only the
gates checked below and then select the gates whose colors you wish to
display. Alternatively, select All gates except those checked below and then
choose the gates whose colors you do not wish to display.
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You can also choose how to display the gate color when a new gate is created
on the layout. By choosing either the second or third radio buttons in the When
a new gate is created on the layout category, you can have FCS Express
display the gate color on a back-gated plot if the new gate was created on a
plot showing the same data file, or only on a plot showing the same
parameters (as the plot where the new gate was created).

8.7.5

Specific Options
The Specific Options category contains properties to control the way data is
displayed on 2D plots.
You can edit 2D plot specific options in one of two ways:
Select the 2D plot(s) and use the Format Plot Options
Options command. This will bring up the Formatting Binned Dot Specific
Options dialog for Dot and Color Dot plots (Figure 8.106), or the
Formatting Binned Plot Specific Options dialog.
Right-click on the 2D plot, select Format from the pop-up menu, click on
the triangle next to the specific plot type, and choose the appropriate
Binned [Dot or Plot] Specific Options category.
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Figure 8.106 Formatting Binned Dot Specific Options Dialog

The options are described in the table below. See Resolution Overview
further description of resolution options.
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Option
Cells to Plot Options

Use channel calibration on
axes

Resolution options

Resolution overlays

Automatic Minimum

Resolution Minimum
Automatic Maximum

Resolution Maximum
Include out of range values
in gates and quads

Dither Color Dot Plots (Dot
Plots only)

Shade Based on Density
(Dot, Color Dot, and Density
Plots only)(Figure 8.107)

Explanation
Control how many cells are plotted. If fewer cells are
plotted, the plot can draw itself faster. Typically, most of
the structure of a plot can be seen if 5000 cells are
plotted. With the radio buttons, choose the cell number
range or number of cells plotted option. Then, select a
value from the drop-down list or enter in freetext into the
from and to boxes, as appropriate. Statistics are always
calculated based upon all of the cells in the data set,
irrespective of how many are plotted.
FCS Express can establish calibrated values for the axes
610 . If channel calibrations are defined, toggling this
checkbox will determine whether or not to use the
calibrated values in place of the generic channel numbers.
Choose a resolution to display the data from the dropdown list. Lowering the resolution effectively smoothes
the data.
The resolution options can be changed for the X Axis/Y
Axis, or together. To edit the options for one of the axes,
select that axis in the list, and change the options. The
edit the options for both axes simultaneously, select both
axes in the list (Shift-Click).
If this is checked, then FCS Express will start binning the
data (dividing it into the number of bins specified by the
Plot resolution) at either 0 or the lowest data value (if
the lowest data value is below 0).
Specify where to start binning the data. If Automatic
Minimum is checked, then this value is ignored.
If this is checked, then FCS Express will finish binning the
data (subdividing it into the number of channels specified
by the Plot resolution) at the highest value of the true
data range.
Specify where to finish binning the data. If Automatic
Maximum is checked, then this value is ignored.
If this is checked, data values that are outside the
resolution options of the plot will be considered to be part
of the lower or upper channels. If a gate or quadrant
touches the lower or upper channels, it will include these
cells, even though the cells are actually outside the
boundary of the gate/quadrant.
Determine which color to use when two dots of different
colors overlap each other (if you have more than one
overlay or an event is located in an area where two gates
overlap). If dither is on, the color will be chosen randomly
from one of the two colors. If dither is off, only the most
recent color will be used (i.e., if you have two gates
defined, the color for gate 2 will always have priority over
the color for gate 1, unless gate 1 is dragged below gate
2 in the Gate View 343 .)
Creates a greyscale shading pattern based on the density
of plotted data. When gates are displayed or when
checked on a color dot plot the shading pattern will be
pseudo colored to match the color of the gate displayed.
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Explanation
A lighter shade represents a higher density. When using
Shade Based on Density with Density plots, the option will
further highlight the densest portions of the data set.
Note that this option will not apply if multiple overlays are
displayed on the plot.

Figure 8.107 An example of color dot and dot plots shaded based on density.

8.8

Formatting Heat Maps
In addition to the formatting options common to all objects 238 , and to some of
those common to all plots 245 , Heat Maps have certain properties, such as Heat
Map Overlays , Color Levels
and other specific options
which can be
formatted.
1064

1055

1058

You can format an heat Map by right-clicking on it, selecting Format from the
pop-up menu, and choosing a category. This method will allow you to use the
Preview button to see what the changes would look like without accepting the
changes and allowing you to revert. Alternatively, once the Heat Map is selected,
you can choose the desired category from the Format tab of the Ribbon 73 .
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Changing the Parameter on Plot Axes Using
Keyboard Shortcuts
The axis parameters can be changed in the formatting dialogs for each plot, as
described for histogram overlays 267 and 2D plot overlays 283 . You can also change
the parameters of the base overlay on each plot using the keyboard or the
mouse.
Note: For any of these methods to work, you must make sure that the plot is in
edit mode 131 .

Keyboard
To change the parameter displayed on the x-axis with the keyboard, press
the number corresponding to the parameter you want to display (e.g., press
3 to view parameter 3). To change the parameter displayed on the y-axis of
a 2D plot, simultaneously press the Ctrl key and the number corresponding
to the parameter to display.

Mouse
To change the parameter of an axis with the mouse (the x-axis on a
histogram, either axis on a 2D plot), move the mouse cursor over the axis
label and click on the axis label. A pop-up menu will appear containing the
available parameters (if you have set the Alt+Click Required To Change
Parameters option 186 , you will also have to press the Alt key while clicking).
From this pop-up menu, you may type in the empty field at the top or scroll
through the list using the mouse scroll wheel or arrows in the pop-up menu (if
more than 10 parameters are available). If you do not wish to change the
parameter after the list has appeared, hit ESC on the keyboard or move the
cursor anywhere outside the list and click.

8.10

Formatting Data Grids and Custom Data Grids
Data Grids 676 have unique formatting properties that can be accessed by rightclicking on the data grid, selecting Format from the pop-up menu, and choosing
a category. This method will allow you to use the Preview button to see what
the changes would look like without actually accepting the changes. Alternatively,
once the Data Grid is selected, you can choose the desired category from the
Format tab of the Ribbon 73 .
Custom Data grids have been deprecated from FCS Express 6 as the
functionality has been improved upon with the addition of Spreadsheets

412

. Any
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existing Custom Data grids saved in FCS Express 4 or FCS Express 5 layouts will
still be available and formattable in FCS Express 6 via the methods in this
chapter. Please contact support@denovosoftware.com if you are having any
problems working with data grids saved in a previous version of FCS Express in
FCS Express 6.

8.10.1

General
In addition to the usual name property (referred to as Data window name),
Data Grids have some additional General options (Figure 8.108).

Figure 8.108 Formatting general options for Data Grids and Custom Data Grids

Additional formatting options are described below.
Option
Use compensation
Transformation
Gate

Change data file during
© 2020 De Novo Software

Explanation
Choose which compensation 622 matrix is applied to the
data in the grid.
Choose which transformation 948 is applied to the data in
the grid.
The gate 350 applied to the data in the grid. Note that a
range gate 679 can be created on and applied to Data
Grids and Custom Data Grids.
Whether the data grid changes during batch processing 782
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Option
Next/Prev/Batch

Show the cell number
column
Number of decimals
Rounding mode
Show trailing zeroes
Show scientific notation

8.10.2

Explanation
or in response to a Next/Previous 79 command. It is
generally recommended to leave this unchecked (default),
as the data within the grid normally refers to plots and will
update automatically as the data in the plots are
changed.
Whether the cell or object number (assigned by the
cytometer according to the time of sample acquisition) is
shown as a column in the Data Grid.
The number of decimal places listed to the right of the
decimal point.
The method for rounding the last digit. Choose between
Standard, Down, Up, and Truncate.
If checked, shows the specified number of decimals even
if the terminal digits are zeroes.
If checked, shows the number in E notation: mEn which
represents m x 10n, where m and n are any real number
and E represents "exponent"

Gate Display
The Gates to Display formatting option for Data Grids determines for which
gates backgating information is displayed 677 . This formatting option does not
apply to Custom Data Grids.
You can edit the Gates to Display in one of two ways:
Select the Data Grid(s) and use the Format
Display command.

Options

Right-click on the Data Grid, select Format from the pop-up menu, and
choose the Gates to Display category (Figure 8.109).
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Figure 8.109 Formatting gates to display in a Data Grid

By default, the No Gates (hide the Gates column) option is selected.
However, you can select All gates or Only the gates checked below and then
select the gates whose colors you wish to display. Alternatively, select All gates
except those checked below and then choose the gates whose colors you do
not wish to display.
You can also choose how to display the gate color when a new gate is created
on the layout. By choosing either the second or third radio buttons in the When
a new gate is created on the layout category, you can have FCS Express
display the gate color on a back-gated plot if the new gate was created on a
plot showing the same data file, or only on a plot showing the same
parameters (as the plot where the new gate was created).

8.10.3

Parameters to Display
Each column in a Data Grid or Custom Data Grid is a parameter which can be
shown or hidden, by accessing the Parameters to Display formatting options.
You can edit the Parameters to Display in one of two ways:
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Select the Data Grid(s) and use the Format
to Display command.

Options

Parameters

Right-click on the Data Grid, select Format from the pop-up menu, and
choose the Gates to Display category (Figure 8.110).

Figure 8.110 Formatting parameters to display in a Data Grid

8.10.4

Image Options
Image Options formatting is available for Data Grids in FCS Express Image or
FCS Express Plus only.
If a Data Grid has been formatted to display images for at least one parameter
311 , these images will be viewable as an Image Gallery within the Data Grid.
These images can fill the grid cell or be centered within it.
You can edit these Image Options in one of two ways:
Select the Data Grid(s) and use the Format
Options command.

Options

Right-click on the Data Grid, select Format from the pop-up menu, and
choose the Image Options category (Figure 8.111).

© 2020 De Novo Software

Formatting Objects

Figure 8.111 Formatting image options in a Data Grid
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Analysis of Flow and Image Cytometry Data Files
FCS Express provides many tools for flow cytometry analysis, such as gates,
markers, quadrants, and statistics. In this chapter, we describe these tools so
that you can apply them to your own data.

9.1

Using Gates
Some flow cytometry software packages make a distinction between regions
and gates. This distinction does not apply in FCS Express. In FCS Express, you
create gates and apply them directly to your data. The term "gate" will be used
exclusively throughout this manual.

You can create an unlimited number of individual gates. FCS Express supports
seven types of gates.
Elliptical gates: Gates that are oval, oblong, or circular.
Rectangular gates: Gates that are square or rectangular.
Polygonal gates: Gates that are drawn with three or more vertices
connected by straight lines.
Freeform gates: Gates that are drawn with various straight and/or curved
sections in an irregular shape.
1D gates: Gates that exist only in one dimension, i.e., a one parameter
histogram gate or an x-axis plot gate.
Combination gates: Gates that are Boolean combinations of one or more of
the other six types of gates.
Examples of different gate types are shown in Figure 9.1.
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Figure 9.1 Examples of Different Gate Types

9.1.1

Live Updating Gates
FCS Express has the ability to have all gate, quadrant, and marker related
changes such as backgating, statistics, and gated events update in real time as
the gate is moved.
The option to update immediately, "in real time", is controlled via the FCS
Express User Options located in the File tab Options General
category Performance Options
markers, update plots, statistics and tokens immediately. (Figure 9.2).
The option to enable live updating gating may also be defined at the layout based
level via the Layout Performance Options 111 .
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Figure 9.2 The option to enable or disable "real time gating" is controlled by the
When moving gates, quadrants and markers, update plots, statistics and tokens
immediately check box.

9.1.2

Creating Gates
Gates can be created in several ways. To create a gate efficiently, first select the
plot that you would like to create the gate on, and then do one of the following:
Select a command (e.g., Ellipse, Rectangle, Polygon, Freeform) from
Home Create Gates.
Select your desired gate shape from the commands in Gating
Gates.
Right-click on the plot and then choose Create Gate and a gate type from
the pop-up menu.
To cancel the creation of a gate while you are drawing the gate, press the Esc
key on your keyboard before completing the operation.

Elliptical or Rectangular Gates
If you choose the Ellipse or Rectangle commands, position the cursor on
the plot where you want the top left corner of the gate to be. Then, press
and hold the mouse button while dragging the cursor down and to the right
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until the gate is the size you want. Release the mouse button to complete the
gate. Note: You can easily adjust the size later.
Polygonal Gates
If you choose the Polygon command, position the cursor where you want
the first vertex to be. Then, click (and release) the mouse button. Continue
repositioning the cursor and clicking at the vertex locations. Straight lines will
connect the vertices to create the polygon. To close and complete the
polygon gate, click on the square that appeared at the first polygon vertex.
Alternatively, you can complete the polygon gate by pressing the space bar.
Pressing the space bar will cause the gate to close with a straight line
between the first vertex and the last vertex you created. When completed, in
addition to the vertices being marked, the polygon will show four outer circles
which can be used for proportional resizing.
Freeform Gates
If you select the Freeform command, position the cursor on the plot where
you want to begin drawing the gate. Click and hold the mouse button. While
continuing to hold the mouse button down, drag the mouse to draw the
shape of the gate. The gate will be drawn along the path of the cursor. To
close and complete a Freeform gate, release the mouse button. The gate will
automatically close with a straight line connecting the first cursor position to
the cursor position when the mouse button was released. When completed,
the freeform shape will show four outer circles which can be used for
proportional resizing.
1D Gates
Create a Marker on a histogram as described in Creating Markers 351 . Then,
right-click on the plot that contains the marker and choose Convert Marker
to Gate, the Marker number, and either Convert or Convert and Link. If
you choose Convert and Link, changing the original marker changes the
corresponding 1D gate. Otherwise, moving or deleting the original marker will
have no effect on the 1D gate.
To create a 1D Gate on a 2D-plot:
o Select the Gating (or Home)
command.

Create Gates

Create Marker

o Right-click on the plot and select Create marker from the pop-up
menu.
Then, position the cursor where you want the left marker boundary to be,
and press and hold the mouse button down. While holding the mouse button
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down, move the cursor parallel to the X- or Y-axis. Position the cursor where
you want the right marker boundary to be, and release the mouse button.

Once you have finished creating a gate, a dialog will appear (Figure 9.3) asking
you to name the gate, choose a color, and decide if a gate should include or
exclude the events contained within it.

Figure 9.3 Create New Gate Dialog

To replace an existing gate with the newly created gate, select the Replace an
existing gate radio button and choose the gate you wish to replace from the
drop-down list. The new gate will replace the old gate without affecting your
gating hierarchy 348 at all.
To create the new gate as a child of a specific gate in the hierarchy, choose the
parental gate in the hierarchy from the Parent Gate drop down. The hierarchy
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as well.

Gates can be copied and pasted from any plot to any other plot. If the recipient
plot has different parameters from the original plot you will be prompted to
create a new gate that will use the original gating coordinates with the existing
parameters of the new plot.
When the Emphasize on Plots feature is checked FCS Express will display any
events within the gate on a Color Dot plot, or dot plots with the gate chosen to
display 302 , as larger and bolder dots for emphasis (Figure 9.4). Emphasize on
plots may also be accessed for specific low frequency populations in overlays on
2D plots through the Formatting 2D Plots dialog 285 .

Figure 9.4 - Gate 2 has been created with the Emphasize
on Plots feature selected. Notice how dots within Gate 2
appear larger and bolder than Gate 1 which was created
without the feature selected.

The Allow Gate Edit section within the Edit Gate dialog (Figure 9.5) allows you
to choose if the gate may be put into edit mode which allows users to move,
replace, and delete the gate. Selecting the radio button for True allows full
editing, False prevents the gate from being edited, and Custom allows the gate
to be edited based on the conditions that are set and will only allow editing if the
value evaluates to true. You may use the "=" followed by an input of a manual
number, token or custom token. "<" or ">" may also be used to specify the
condition to be less than or greater than, respectively.
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Figure 9.5 Allow gate edit dialog based on radio buttons next
to "true", "false", or "custom". The custom setting is based
on if the conditions are met.

The Edit Gate dialog may be accessed from the Gate View:
o Click on Insert tab
.
or from the Gate Navigator:
o Click on View tab
In either dialog double click on the gate to edit to access the Gate Edit dialog.
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When the radio button for "custom" is selected, the gate may be edited based
on whether or not the conditions below are met. You may use the "=" followed
by an input of a manual number, token or custom token. "<" or ">" may also be
used to specify the condition to be less than or greater than, respectively.
For example, see Figure 9.6 below where a conditional statement was defined in
the Custom field. The custom field is defined as true since 18.90 is greater than
2 and will allow gate editing if the lymphs gate.

Figure 9.6 Allow Edit Dialog-Defining the Conditions to be met
in order to Custom Allow Gate Edit

9.1.3

Data Specific Gates
Data Specific Gates in FCS Express allow you the ability to assign gates to
specific data files that have been loaded in the data list. Different gating positions
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between data files may be stored and automatically used when displaying plots
or making calculations when using the Data Specific Gate feature, Figure 9.7.

Figure 9.7 The Data Specific Gate button in the Gating tab is used to enable data
specific gates.

When a gate is converted to a Data Specific Gates for a given file, the shape and
position can be modified for the specific file independently from other data files.
Thus, when a Data Specific Gates is created, the original gate (here hence
referred to as "Master gate") continues to be used for all the remaining files.
Jump to:
Creating Data Specific Gates 326
Deleting/Removing Data Specific Gates 327
Promoting Data Specific Gates to Master Gate
Using Data Specific Gate Groups 330

329

An example of Data Specific Gates is given in Figure 9.8, where Gate 1 has been
converted to be a Data Specific Gates for File 4. Files 1 through 3 continue to
use the original position for Gate 1 (i.e. the Master Gate).

Figure 9.8- Example of Data Specific Gate where Gate 1 has been changed and
made specific for File 4.

Data Specific Gates can be easily tracked using the Gate Navigator
9.9.

128

Figure
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Figure 9.9 - Using the gate navigator to view which data files are assigned data file
specific gates.

Although Data Specific Gates may appear to share some similarities with
Iteration Snapshots 374 and Manual Snapshots 372 the features are quite
different in term of their applicability:
Data Specific Gates are specific for a data file in the data list, while Snapshot
are specific for a given iteration number in the data list. Data Specific Gates
are suitable for analyzing multiple FCS files simultaneously open in the layout,
as well as multiple FCS file using batch process while Snapshots are suitable
for analyzing multiple FCS files using the batch process.
Data Specific Gates only account for gates and gating positions while
Snapshots are used to record marker and quadrant positions along with
gating positions.

Gates
Record the shape and
Markers
the position of
Quadrants
Data Files in Data List
Specific for
Iteration Numbers in Data List
Multiple FCS files simultaneously
Suitable for analyzing open in the layout
Multiple FCS file using batch
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process

9.1.3.1

Using Data Specific Gates

Creating Data Specific Gates
Assigning a gate to be Data Specific is accomplished from the Gating tab through
the steps below:
1. Click on the gate to convert to a data specific gate (Figure 9.10 - Number 1)
on a plot.
2. Click on the Gating tab of the Ribbon.
3. Select Create Gates

(Figure below - Number 2).

Figure 9.10- Data File Specific gates are created using the Data Specific Gate
button from the Gating tab > Create Gates section.

The Gate Navigator will now reflect the presence of a Data Specific Gate for File
4 (ApoMono.004 compensated) (Figure 9.11).
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Figure 9.11 - The gate navigator before and after creating a data file specific gate
on File 4 (ApoMono.004).

The shape and position of Gate 1 on File 4 can now be modified independently
from the master gate (File 1 through File 3) Figure 9.12.

Figure 9.12 - An example of a data file specific gate for Gate 1 that has been made
Data File Specific for File 4.

Deleting Data Specific Gates
A Data Specific Gate can be reverted back to resemble the Master gate (i.e. to
loose its data specificity) in one of three ways:
Option 1:
1. Click on the gate that need to be reverted to Master gate (Figure 9.13 Number 1).
2. Click on the Gating tab of the Ribbon.
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3. Select Create Gates

(Figure below - Number 2).

Figure 13 - DSG can be deleted using the Data Specific Gate button from the Gating
> Create Gates ribbon bar.

Option 2:
1. Select the Data Specific Gate for the File in the Gate Navigator.
2. Press Delete.

Option 3:
4. Right click on the Data Specific Gate in the Gate Navigator.
5. Select Delete Data Specific Gate(s)(Figure 9.14).
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Figure 9.14- A Data File Specific Gate can be removed using the right click menu in
the Gate Navigator.

When a Data Specific Gate is deleted the Master Gate will be used on any files
that had used the Data File Specific gate.

Promoting a Data Specific Gate to the Master Gate
A Data Specific Gate can be promoted to be the Master gate within the Gate
Navigator:
1. Right click on the Data Specific Gate in the Gate Navigator.
2. Select Promote Data Specific Gate to Master from the right click menu
(Figure 9.15).

(Figure 9.15) - Selecting promote data specific gate to master gate in the gate
navigator.
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When promoting a Data Specific Gate to Master Gate:
All of the files that used the original Master Gate will use the Data Specific Gate.
The original Data Specific Gate is removed from the Gate Navigator (Figure
9.16) - left).

Figure 9.16 - A data specifc gate was promoted to a new master gate. Note the
original data specific gate is no longer present.
9.1.3.2

Using Data Specific Gate Groups

Data Specific Gates may be used as gate groups to specify a gating position for
multiple data files by creating a Data Specific Gate Group.
Data Specific Gate Groups may be create in three ways:
Multiple Selecting Data Specific Gates

330

Dragging and Dropping within the Gate Navigator
Dragging and Dropping from the Data List

331

331

Data specific gate groups may also be removed via deletion.

334

Multiple Selecting Data Specific Gates to Create a New Group (Figure 9.17)
1. Multiple select the Data Specific Gates that will constitute the Data Specific
Gate Group in the Gate Navigator.
NOTE: The first Data Specific Gate selected will be used as reference gate for
the Data Specific Gate Group.
2. Right click on any of the selected Data Specific Gate.
3. Select Create Data Specific Gate Group from the right click menu.

The first Data Specific Gate selected in step 1 will now be used for all other data
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files specified in the group.

Figure 9.17 - Using multiple select to create a data specific gate group for multiple
files.

Dragging and Dropping to Create a Group within the Gate Navigator
(Figure 9.18)
1. Select one or more Data Specific Gates in the gate navigator.
2. Drag the selected Data Specific Gates and release them on top of the Data
Specific Gate file name that is intended to be used for the gate group master
position.

Figure 9.18 - Creating a data specific gate group by dragging and dropping files
from in the gate navigator to the data specific gate intended as the new group
master gate.

Dragging and Dropping to Create a Group from the Data List (Figure 9.19)
1. Select one or more data files in the Data List.
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2. Drag the selected data file(s) and release them on top of the Data Specific
Gate in the Gate Navigator that is intended to be used for the gate group
master position.

Figure 9.19 - Creating a data specific gate group by dragging and dropping files
from the data list to the data specific gate intended as the new group master gate
within the gate navigator.

The result for the three above methods for creating a Data Specific Gate Group
is that all files within the newly created group will be unified to the Data Specific
Gate used for reference. A new Group child will appear under the Data Specific
Gates for the gate of choice (Figure 9.20).

Figure 9.20 - A new data file specific group is created via the multiple select or
drag and drop methods for creating groups.

Note: If the Data Specific Gate Group of interest already exists, file(s) can be
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dragged and dropped on either the Data Specific Gate Group entry or on any
of the Data Specific Gates which are part of it (Figure 9.21).
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Figure 9.21 - When a DSG group is already present, file(s) can be added to the
group by dragging them from either the Data List (upper panel) or the Gate
Navigator (lower panel), and realeasing them on top of either the DSG group entry
or on top of any DSG already listed in the DSG group of interest.

Removing and Deleting a Data Specific Gate Group
An entire Data Specific Gate group can be deleted by:
1.Selecting the Data Specific Gate Group or multiple selecting the Data Specific
Gates composing it in the gate navigator.
2.Press Delete on your keyboard.
a. Alternatively, Right click on the selected Data Specific Gate.
b. Select "Delete Data Specific gate(s)"

One Data Specific Gate can be removed from a Data Specific Gate group by:
1. Selecting the gate within a plot displaying it (Figure 9.22) - Number 1)
2. Click the Data Specific Gate button in the Gating tab

on the
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(Figure below - Number 2)

Figure 9.22 - Removing a data specific gate from a group by clicking the Data
Specific Gate button twice.

9.1.4

Using Boolean Logic to Create Combination Gates
Creating Combination Gates
Combination gates consist of combinations of other gates. To combine gates,
you create a gating formula consisting of Boolean combinations of preexisting gates. Gating formulas are defined by either a single gate or several
gates joined by Boolean operators. The operators describe how the gating
regions should be combined and follow the rules of Boolean algebra. FCS
Express supports the following operators:
AND
AND is represented by typing 'a', 'A', or 'and' into the gating formula. If
you enter the gating formula "1 a 2" (read as, 1 and 2), only events
that fall into both gate 1 and gate 2 are selected.
OR
OR is represented by typing 'o', 'O', or 'or' into the gating formula. If
you enter the gating formula "1 o 2" (read as, 1 or 2), all events that
fall into either gate 1 or gate 2 are selected.
NOT
NOT is represented by typing 'n', 'N', or 'not' into the gating formula. If
you enter the gating formula "n1" (read as, not 1), all events except
the events in gate 1 are selected.
XOR
XOR is represented by typing 'x' or 'X' or 'xor' into the gating formula.
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If you enter the gating formula "1 x 2" (read as, 1 xor 2), only events
that fall into gate 1 or gate 2, but not both, are selected. Note: XOR
stands for exclusive Or. The difference between 'or' and 'xor' is that
with 'or' an event that falls into both regions is selected, while with 'xor'
an event that falls into both regions is excluded from selection.

Together with the four Boolean operators, Combination Gates can be created
using parentheses. The contents of the innermost parentheses are evaluated
first, and the remainder of the equation is evaluated from left to right. This
allows you to build complex gating formulas quite easily. The following are
examples of some valid gating formulas. Note: Spaces are not required when
inputting the formula into FCS Express some people prefer to use then to
make complex formulas more readable.
"not lymphocytes or monocytes"
Events that are not in lymphocytes or are in monocytes are
selected. The NOT is only applied to the lymphocytes if you do not
use parentheses.
"n (lymphocytes or monocytes)"
First the "(lymphocytes or monocytes)" is evaluated, then a NOT is
applied. Now all events that are not in the lymphocytes gate and
not in the monocytes gate are selected. The formula "Not
lymphocytes And Not monocytes" would have the same result.
"(lymphocytes and monocytes) or (granulocytes and blasts)"
Events that are in both the lymphocytes and monocytes gates, or
both the granulocytes and blasts gates are selected. Because 'and'
means events must be in both gates to be selected, the only events
that will be selected will be those that fall in the overlap between the
lymphocytes and monocytes gate OR the overlap between the
granulocytes and blasts gates.

Combination gates are created in the following way:
After inserting a Gate View object 343 onto the layout
(Insert General Gate View), right-click on the Gate View and select
Add Combination Gate from the pop-up menu.
A dialog box (Figure 9.23) will appear. Select the Formula field and enter
Boolean operators and the names of preexisting gates. As you type, FCS
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Express will determine which gate or Boolean operator you are trying to type
and will attempt to complete the word for you via autofill. If more than one gate
or operator matches the letters you’ve typed, you can scroll through the
available matches by using the arrow keys. Press the space bar to accept the
choice.

Figure 9.23 Creating a Combination Gate

9.1.5

Adding a Combination Gate Matrix
Adding a Combination Gate Matrix
A combination gate matrix is a set of combination gates, created from one or
more previously existing gates. This set of gates contains every possible positive
and negative value for the previously existing gates. For example, if we start with
a gate labeled "CD4", and another gate labeled "CD25", select both gates, and
create a combination gate matrix from them, four new gates will be created
(Figure 9.24):
•
•
•
•

CD4+/CD25+
CD4-/CD25+
CD4+/CD25CD4-/CD25-
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Figure 9.24 Combination Gate Matrix Example. Left: Gates applied to select all
CD4+ or CD25+ cells. Right: Combination Gate Matrix applied to create gates for all
four combinations.

Once the new gates are created, they are treated as normal gates. Any changes
to the original gates (such as renaming) will not cause the new gates to be
renamed. The new gates can also be deleted or edited like any other
combination gate.
To add the combination gate matrix:
After inserting a Gate View object 343 onto the layout
(Insert General Gate View), select the gates that you want to use via
SHIFT-click or Ctrl-click, right-click on the Gate View, and select Add
Combination Gate Matrix from the pop-up menu (Figure 9.25).
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Figure 9.25 Adding a Combination Gate Matrix

If you selected three gates to create the matrix then, after the new matrix
has been added, eight new gates will have been created. The gate will now
look like Figure 9.26.

Figure 9.26 After Adding a Combination Gate Matrix

9.1.6

Moving Gates
To move a gate, click the mouse cursor once in the gate that you wish to move.
This will activate the gate. The cursor will change to the drag cursor and resizing
handles will appear on the vertices of the gate. To move the gate, click and hold
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the mouse button down anywhere inside the gate. Move the cursor while the
mouse button is pressed, and the gate will move with the cursor. Release the
mouse to drop the gate into the new position.
If one gate falls within the boundaries of a second gate you may right click on the
plot Activate gate select the underlying gate. The position of the underlying
gate may now be changed.
To cancel a gate move once you have begun, press and hold the Esc key and
release the mouse button before you release the Esc key.
If you move a gate onto a blank part of a page, you will either:
Create a new plot gated on the gate, or
Delete the gate,
according to the options you set in the Gate moving options section on the Gate
page of the Options dialog 206 .

9.1.7

Resizing Gates
To resize a gate, click the left mouse button when the cursor is in the gate that
you wish to resize. This will activate the gate. The cursor will also change to the
drag cursor and resizing handles will appear. Move the cursor over one of the
resizing handles. You will know you are in the correct position when the cursor
changes to the resize cursor, which is a two-headed arrow. With the resize
cursor, click and hold down the left mouse button. Move the mouse to move the
cursor and the vertex will move with the cursor. Release the mouse button to
drop the vertex into the new position.
To cancel a gate resize once you have begun, press the Esc key before you
release the mouse button.

9.1.8

Deleting Gates
A gate can be deleted in one of two ways:
Select the gate from a Gate View object 343 or the Gate Navigator 128 and
either: Right-click and choose Delete from the pop-up menu, as seen in
Figure 9.27 or press the Delete key on the keyboard.
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Figure 9.27 - Removing a Gate from the Gate View

A gate can also be deleted directly from the plot. To delete a gate, click the
mouse button when the cursor is in the gate you wish to delete. This will
activate the gate. The cursor will then change to the drag cursor and
resizing handles will appear on the vertices of the gate. Press the Delete
key. A dialog box will appear asking whether you want to delete the gate
completely, or just hide the gate 342 on that plot, as seen in Figure 9.28.
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Figure 9.28 - Delete or Hide a Gate

9.1.9

Hiding Gates
To determine whether a gate is visible on a 2D plot or to show or hide a gate,
right-click on the plot and select Show Gates from the pop-up menu. A
submenu will appear listing all currently defined gates. Clicking on the desired gate
in the list will toggle between showing or hiding the gate.
You can also hide a visible gate directly from a 2D plot:
1. Activate the gate that you wish to hide, by clicking inside it.
2. Press the Delete key.
3. Select the Hide button in the dialog box that appears.
Note: A 2D gate can only be displayed if the axes on the plot match the axes
that were used when the gate was first created. However, color dot plots can
display backgated populations 302 for any gate in your layout.

9.1.10

Using Snapshots with Gates
Snapshots 370 provide a way to save multiple gate, quadrant, or marker
positions for quick access in your analysis. An unlimited number of snapshots
may be created and saved in a layout. When a snapshot is added to the
Snapshot navigator using the green + (
) button, FCS Express will remember
the position of a any gates, quadrants, or markers present on open plots. When
gates, quadrants, or markers are changed on open plots the saved snapshot
may be applied to the layout by dragging and dropping the snapshot from the
Snapshots navigator to any blank space on the layout. The position of the
gates, quadrants, and markers saved in the snapshot will be applied.
In the example below (Figure 9.29) note that the snapshot for Gate Position
Number 1 is applied to Sample 1 on the left. When data was changed to Sample
2 on the right, the position of the CD4 and CD25 gates was updated by applying
the snapshot for Gate Position Number 2. In this way many positions for gates,
quadrants, or markers may be saved and easily accessed to be used as needed.
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Figure 9.29 - The snapshot for Gate Position Number 1 is applied to Sample 1 on the
left. When data was changed to Sample 2 the gate positions were updated by
applying the snapshot fo Gate Position Number 2 to the layout.

Please see the Snapshots
Snapshots.

1513

chapter

1513

for more details on creating

Please see the Snapshots 850 and Batch Iteration Navigation chapter 850 for more
details on using Snapshots with a batch process and the Next / Previous
commands.
Also see the Snapshots
and using Snapshots.

9.1.11

1438

Tutorial

1438

for step by step instructions on creating

Gate View Object
The Gate View object is an interactive legend of all the gates in your layout. As
an object, the Gate View will be printed and displayed like any other object. For
additional object properties, see Formatting Options Shared by All Objects 238 .
The Gate Navigator 128 may also be used to edit gate information but the Gate
Navigator will not be treated as an object and cannot be printed or exported.
To insert a Gate View, select the Insert tab

General Gate View command.

Many of the actions can be performed directly from the Gate View as follows:
To delete a gate from the entire layout, select the gate in the Gate View
and press the Delete key.
To rename a gate, double click the gate in the Gate View and type in the
new gate name in the Name field and press Enter.
To edit all of the gate properties, double-click on the gate in the Gate View
to bring up the Edit Gate dialog (Figure 9.30). From the dialog you can
change the gate Name, add a Comment, change the Description, change
the Color* 345 , Emphasize the gated events on plots 321 , Include or
Exclude the events inside the gates shape, and, if applicable, break the link
to a quadrant or gate. If you check Alt+Click required to select this
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gate, then clicking on the gate will not select the gate unless the Alt key is
being held. This will prevent accidental changing of the gate vertices.
Additionally, the ability to edit the gate is controlled through the Allow
Gate Edit section.
Selecting the True radio button allows edits to the gate.
Selecting the False radio button prevents edits to the gate.
Selecting the Custom radio button allows the user to define a value
or condition based on a token 688 or custom token 725 that must be
met in order to edit the gate.
To rearrange the hierarchy of the gates 348 , drag and drop the gates within
the Gate View. For example, to make a gate a child gate of another gate,
drag the child gate onto the parent gate. Also note that a gate may be
placed in a specific position in the hierarchy at the time of creation using the
Parent Gate drop down 320 .
To gate a plot on a gate, drag the gate from the Gate View onto that plot.
The actions above may also be completed through the Gate Navigator

128

.
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Figure 9.30 Edit Gate Dialog

* Note: If Gate Color has been changed, text color within the Gate Text Box will
no longer match. To recreate this text with the current Gate Color, right-click on
the plot and select Recreate Gate Text Boxes from the pop-up menu.

9.1.12

Gates and the Clipboard
Gates can be copied to and pasted from the clipboard for use within FCS
Express. This will create an identical gate with a new name that can be moved
independently of the original gate. You can also copy all gates to another layout
346 to reuse your entire gating strategy.
To show a previously created gate on another plot or on a plot on which it is
currently hidden, use the Show Gates command 342 instead.
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Copying a Gate to the Clipboard
Click the mouse button when the cursor is in the gate that you wish to copy.
This will activate the gate. Select the Home Clipboard Copy Gate
command or press Ctrl+C from the keyboard. Similarly, you can select the
gate in the Gate View 343 or Gate Navigator 128 and select
Home Clipboard Copy Gate or press Ctrl+C from the keyboard. You
can also right click on the Gate and select Copy Gate from the right click
menu.
Cutting a Gate to the Clipboard
Click the mouse button when the cursor is in the gate that you wish to cut.
This will activate the gate. Select the Home Clipboard Cut Gate
command or press Ctrl+X from the keyboard. Similarly, you can select the
gate in the Gate View 343 or Gate Navigator 128 and select the
Home Clipboard Cut Gate command or pressCtrl+X from the keyboard.
If you try to cut a gate from a plot, a dialog will appear asking if you want to
delete the gate completely or hide it in that particular plot. You can also right
click on the Gate and select Cut Gate from the right click menu.
Pasting a Gate from the Clipboard
Right-click on a plot, the Gate View 343 object, or Gate Navigator 128 , and
press Ctrl+V on the keyboard, or select the Home Clipboard
Gate
command. Note that in order to paste a gate as a child of another gate, the
prospective parent gate should be selected in the Gate View or Gate
Navigator first. Alternatively, you may drag the gate into the prospective
parent Gate (see Hierarchical Gating 348 for details) to define it as a child gate.
Copying All Gates to Another Layout
From the Gate View 343 object, or Gate Navigator 128 , press Ctrl+A on the
keyboard to select all, and Ctrl+C to copy. Then, in the new or second
layout, open the Gate View or Gate Navigator, and press Ctrl+V to paste.

9.1.13

Linking Gates
In FCS Express, you can link two or more gates of the same type together. This
will make the gates duplicates of each other. Then, moving or resizing one gate
will move all linked gates.
To link two gates:
1. Insert a Gate View using the Insert General Gate View command on
a layout with plot(s) containing two or more gates of the same type. Note:
You can only link gates of the same type, e.g., two rectangular gates, or
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two elliptical gates. You cannot link a rectangular gate to an elliptical gate.
2. Select both gates in the Gate View (using Shift-Click).
3. Right-click on one of the selected gates and choose Link Selected Gates
from the pop-up menu (Figure 9.31).

Figure 9.31 Linking Gates

In the Gate View, when one of the gates is selected, the icon for the gates
will change from a square to a chain to indicate that the gates are linked
(Figure 9.32).
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Figure 9.32 Linked
Gates with Chain
Icon

To break a link:
1. In the Gate View, right-click on one of the linked gates and select Break
Link from the pop-up menu.

You can also clone/duplicate a single gate to create linked gates:
1. In the Gate View, right-click on the gate you want to clone and select
Create Linked Gate from the pop-up menu.
2. In the Create Linked Gate window that appears, enter a suffix that you
want to use to recognize the linked gate (Figure 9.33).
3. Click OK.
4. You will see a new cloned gate added to the Gate View, with the suffix
tagged on the end.

Figure 9.33 - Creating a Linked Gate

9.1.14

Hierarchical Gating
In examining flow cytometry data, a common theme is the analysis and
comparison of cellular subsets. In practice, this results in the widespread use of
combination gates with the Boolean operator AND. For example, you may first
specify a live cell subset with the intention of examining lymphocytes,
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monocytes, and granulocytes within the live cells subset. To do so, you first
define four gates: Live cells, Lymphocytes, Monocytes, and Granulocytes.
However, the subsets you wish to examine are combination gates of the type:
Live cells and Lymphocytes, Live cells and Monocytes, and finally, Live cells and
Granulocytes. Using this Boolean combination gating method, there are now
seven gates in the gate list. Adding additional subsets, e.g., T- and Blymphocytes, increases the gate number further.
Hierarchical gating facilitates this type of analysis by introducing the concept of
"parent" and "child" gates, thus obviating Boolean operators in a typical gating
strategy. A parent gate can contain one or more child gates and the gating
criteria of a parent gate are passed on to the child gate. In the example we are
discussing, the use of hierarchical gating reduces the number of gates present
from seven to four and eliminates the need to manually define combination gate
formulas.
The current gating hierarchy for a layout is listed in the Gate View
Gate Navigator 128 .

343

or in the

In Figure 9.34, the hierarchical gating strategy for the gates in our example are
displayed in the Gate View.

Figure 9.34 Gate View Showing
Hierarchy

Note that the Lymphocytes, Granulocytes, and Monocytes gates are children
of the parent Live cells gate. This means that if you use the Lymphocytes gate
on a plot, the plot is actually gated on Live cells AND Lymphocytes. The same will
hold true for the other two child gates.
It is possible to change the gating hierarchy at any time, simply by clicking on the
gates in the Gate View and dragging the gate to a new hierarchical position.
When creating a new gate you may also choose a specific gate in the hierarchy
as the parental gate by selecting the Parent Gate drop down 320 .
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If you create a new gate on a plot that is already gated, and the when a new
gate is created, create it hierarchically option is turned on in the gate options
206 , the new gate will become a child of the plot’s current gate. Note that this
option is turned on by default in FCS Express 6.

9.1.15

Applying Gates to Plots
There are several different ways to apply a gate to a plot such that only the
events in the applied gate will appear in the plot:
Create a Gate View 343 from the Insert General group. Press and hold the
mouse button on the gate that you want to apply. While holding the mouse
button down, drag and drop the gate from the Gate View list onto a plot.
Open the Gate Navigator from the View tab
Navigator. Press and hold the mouse button on the gate that you want to
apply. While holding the mouse button down, drag and drop the gate from
the Gate Navigator onto a plot.
Select a gate on a plot. While holding the mouse button down, drag and
drop the gate to another plot. If dragged to an empty spot on the layout, a
new plot gated on that gate will be created.
Select a plot or multiple plots
and go to the Gating Create Gates
group. Select the gate from the Current Gates drop-down list.
1218

Right-click on a plot and select Format from the pop-up menu. Go to the
Overlays category (see Formatting Single Parameter Histograms 266 or
Formatting 2D plots 283 ) and choose the gate you want to apply from the
drop-down list. This is a convenient for applying different gates to overlays
on the same plot.
Note: Different overlays on a plot need not have the same gate applied.

9.2

Using Markers
Markers are areas (sometimes known as "regions" in other data analysis
software) that you set on a 1D plot (histogram). Markers are accessed by
selecting the Gating (or Home) tab Create Gates Create Marker
command and subsequently drawing a marker on a histogram of interest.
Markers may be:
Created on any histogram 351
Adjusted and moved manually 351
Resized manually 353
Linked to other marker endpoints from the same or different plots
Linked to any token value 355

358
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9.2.1

351

353

Creating Markers
To create a marker on a plot, either:
Select the Gating (or Home) tab
command, or

Create Gates

Create Marker

Right-click on the plot and select Create marker from the pop-up menu.
Then, position the cursor where you want the left marker boundary to be, and
press and hold the mouse button down. While holding the mouse button down,
move the cursor to the right until the desired right marker boundary, and release
the mouse button.
Markers can be updated in real time if desired by choosing the FCS Express User
Option to update Gates, Markers, and Quadrants immediately. 317
High and Low bounds of markers within one plot or in different plots may be
linked so they move together 353 when either marker is adjusted.

9.2.2

Moving Markers
Markers can be moved by clicking and holding on the center point of the marker
using the mouse and adjusting the position of the marker.
When the marker is selected by clicking on it, three points will appear: a resizing
handle at the left- and right-boundaries, and a point in the center for moving the
marker (Figure 9.35). Position the mouse cursor over the central point so it
turns into a four-headed arrow. While keeping the mouse button pressed, move
the marker to a new position. Release the mouse when the marker is in the new
position. To cancel moving the marker mid-way through a move, press the Esc
key before releasing the mouse button and the marker will return to its original
position before a move was attempted.
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Figure 9.35 - Histogram showing a marker. Red boxes indicate the marker resizing
handles and green box indicates the marker center point.

Please refer to the next chapter to learn how to resize a marker with handles or
move a marker by defining its boundaries 352 .

9.2.3

Resizing Markers
Markers can be resized by either of the following ways:
1. Using the mouse

353

.

2. Via the Formatting Marker dialog

353

.

3. By dragging and dropping tokens on marker bounds

355

.

4. By dragging and dropping a different marker bound to link them
5. By dragging and dropping a gate to choose a statistic to link.
6. By dragging and dropping a plot to choose a statistic to link.

358

.

360

361
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Resizing marker boundaries using the mouse

Markers can be resized using the mouse in the following way:
Click anywhere on the marker to select it.
When the marker is selected, three points will appear: a resizing handle at the
left- and right-boundaries, and a point in the center for moving the marker 351
(Figure 9.36).
Position the mouse cursor over one of the resizing handles so it turns into a
two-headed arrow.
While holding the mouse button down, move that marker boundary to a new
position.
Release the mouse when the marker is the desired size.
To cancel adjustment of the marker before you have released the mouse
button, press the Esc key and the marker will return to the original position.

Figure 9.36 - Histogram showing a marker. Red boxes indicate the marker resizing
handles and green box indicates the marker center point.
9.2.3.2

Resizing the marker boundaries via the Formatting Marker dialog

Markers end points may be set and/or locked to any number or numeric token
via the Formatting Markers dialog 270 in the following way:
With the plot containing the marker you want to resize in selected or edit
mode, use the Format 1D Options Markers command from the
ribbon bar (alternatively, right click on the plot, choose Format and select
the Markers category) to launch the Formatting Markers dialog 270 .
In the list of Marker's highlight the marker you would like to resize by
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clicking on it.
In the Marker Options section, Low and High represent the channel
numbers of the left and right marker boundaries, respectively.
Change the Low and/or the High value by either typing in numbers
(decimal values may also be used) or by clicking on the T icon at the right
of the bound to select a numeric token. If the T icon is selected, then
choose Statistic from the Select a Token Type dialog and select the
numeric token of interest.
Optionally, check the Locked check box to lock the marker bound to the
specified value. When the marker bound is locked to a token, the marker
bound will automatically resize when the token value changes. When a
marker bound is locked, the marker bound will not be resizable when
attempting to move the marker endpoint with the mouse.
Clicking OK in the Formatting dialog will apply the changes.
Please note
When a marker bound is not locked to the specified value, the marker bound
will still remain resizable by moving it using the mouse. When this happens,
the manually inserted value (or the token value, if a token is used to set the
marker bound) will be replaced with the position defined using the mouse. To
avoid this, marker bounds can be locked to the given value via the
Formatting Markers dialog 270 .
Although marker end points can be set and locked to any numeric token, a useful
application of this feature is setting and locking marker end points together so
that moving a marker end point will automatically cause an end point on a
different marker to update accordingly while preventing additional independent
adjustments of the markers. Markers may be linked within the same plot or
between different plots using these features.
Below is a use case examples of linking and locking markers together via the
Formatting Markers dialog 270 .

To link and lock two or more marker end points together:
Linking marker end points is accomplished by setting the Low or High bound for
one marker to use a token value for the Low or High bound of a separate
marker. In the following example, both markers have been created on the same
plot and we will link the High bound of Marker 1 to the Low bound of Marker 2
to create a set of markers that will define positive and negative population.
1. Begin with a layout in which two markers have already been created 351 on
one plot.
2. Double click on the plot on which the markers were created to launch the
Formatting dialog.
3. Choose the Markers category (Figure 9.37 below- Number 1).
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4. Select the first marker (Marker 1) from the Marker list (Figure below Number 2).
5. Delete the contents of the field for High in the Marker Options section
(Figure below - Number 3).
6. Click on the T icon to choose a token (Figure below - Number 4).
7. Choose Statistic from the Select a Token Type dialog.
8. Click Insert. The Create Statistic dialog opens.
9. Choose the Statistic category on the left.
10.Select M2 from the Select a marker drop down.
11. Choose Low bound from the Statistic list.
12. Click OK.
13. Check the Locked box of the High bound of Marker 1 in the Marker
Options.
14. Click OK in the Formatting dialog.
Since the Locked option has been set, when the low bound of Marker 2 is
adjusted, the high bound of Marker 1 will now adjust automatically to match.
For the same reason, the high bound of Marker 1 cannot be adjusted
independently. Please note that dragging a new token value onto the marker
will update the value without having to unlock it first.

Figure 9.37 - Formatting a marker bound to use the high or low bound of
another marker.
9.2.3.3

Resizing marker boundaries by dragging and dropping tokens

A marker endpoint may be set and locked to a token value by dragging and
dropping a numeric token onto it. The marker endpoint will be set to the token
value and will be automatically resized as soon as the token value will change.
Please note: The marker bound will automatically be locked to the token, thus
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the marker bound will not be resizable by using the mouse. The lock can be
removed via the Formatting Markers dialog 270 and unchecking the Locked
check box of the boundary of interest. Additionally, dragging a new token value
to the marker end point will override the original lock and lock the newly dragged
value to the end point.
Below are two use case examples of setting and locking marker end point to
token using drag and drop:
Using a token in a statistics table to link two markers together.
In this use case the high bound of a marker (M1) is set and locked to the low
bound of another marker (M2). The action will be performed via dragging and
dropping the token referring to the low bound of marker M2 from a statistics
table to the high bound of marker M1 (Figure 9.38). Please note that in this
example, the two markers are within the same plot, but the same procedure
may be used for markers which reside on different plots as well.
1. Left click the cell of the stat table containing the token of interest to select it
(Figure below - Number 1).
2. While pressing the left mouse button drag the cell on top of the right end point
of marker M1. Note that the cursor will appear as
(Figure below - Number
2).
3. Release the mouse button on top of the right end point of Marker M1. The
position of the right end point of Marker 1 now matches the value of the token
(Figure below - Number 3).
4. When token value will changes by moving the low bound of marker M2, the
right end point of marker M1 will change accordingly (Figure below - Number
4). Please note that the opposite is not true. Since the right end point of
marker M1 is automatically locked to the left end point of marker M2, the
right end point of marker M1 will not be resizable by using the mouse (Figure
below - Number 5, note the absence of the resizing handle at the rightbound). The lock can be removed via the Formatting Markers dialog 270 by
unchecking the Locked check box of the boundary of interest.
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Figure 9.38. The figure shows how to set and lock two marker end points together
by dragging and droppging a token contained in a statistics table.

Using a token in a text box to link a marker to it.
In this use case example a statistic token in a text box will be dragged and
dropped to the end point of a marker (i.e. Marker M1) to set that end point to
be equal to the value of the token (Figure 9.39). Please not that any type of
statistical tokens, included custom tokens, can be used when they exist in a text
box.
1. Highlight the token of interest (Figure below - Number 1).
2. Left click on the highlighted token and drag it on top of the right end point of
Marker 1. Note that the cursor will appear as
(Figure below - Number 2).
3. Release the mouse button on top of the right end point of Marker M1. The
position of the right end point of Marker 1 now matches the value of the token
(Figure below - Number 3).
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4. When the token value changes, the right end point of marker M1 will change
accordingly. Please note that the opposite is not true. In addition, since the
right end point of marker M1 is automatically locked to the token, the right end
point of marker M1 will not be resizable by graphically acting on it using the
mouse (Figure below - Number 4, note the absence of the resizing handle at
the right-bound). The lock can be removed via the Formatting Markers
dialog 270 by unchecking the Locked check box of the boundary of interest.

Figure 9.39. The figure shows how to set and lock a marker end point to a token by
dragging and dropping the token from a text box.

9.2.3.4

Resizing and linking marker boundaries by dragging and dropping marker
bounds

A marker endpoint may be set and locked to an end point of another marker by
dragging and dropping one marker endpoint onto another marker endpoint. The
dependent marker endpoint will be automatically repositioned as soon as the
independent marker endpoint changes.
Please note: The dependent marker bound will automatically be locked to the
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independent one, thus the dependent marker bound will not be resizable by using
the mouse. The lock can be removed via the Formatting Markers dialog 270 by
unchecking the Locked check box of the boundary of interest.
Below is a use case example of linking two marker end points together using
drag and drop:
To set and lock two marker end points together using drag and drop.
In this use case the high bound of a marker (M1) is linked to the low bound of
another marker (M2). The action will be performed via dragging and dropping the
low bound of marker M2 onto the high bound of marker M1 (Figure 9.40).
Please note that in this example, the two markers are within the same plot, but
the same procedure may be used for markers which reside on different plots as
well.
1. Click anywhere on Marker 2 to select it. When the marker is selected, three
points will appear: a resizing handle at the left- and right-boundaries, and a
point in the center for moving the marker 351 .
2. Position the mouse cursor over the left resizing handles so it turns into a twoheaded arrow.
3. Left click to select the left resizing handles.
4.While holding the mouse button down, drag that marker boundary on top of
the right end point of marker M1(Figure below - Number 1). Note that the
cursor will appear as
(Figure below - Number 2).
5. Release the mouse button on top of the right end point of Marker M1. The
position of the right end point of Marker 1 now matches the position of the left
end point of Marker 2 (Figure below - Number 3).
6. When the left end point of Marker 2 will change, the right end point of marker
M1 will change accordingly (Figure below - Number 4). Please note that the
opposite is not true. Since the right end point of marker M1 is automatically
locked to the left end point of marker M2, the right end point of marker M1 will
not be resizable by graphically acting on it using the mouse (Figure below Number 5, note the absence of the resizing handle at the right-bound). The
lock can be removed via the Formatting Markers dialog 270 by uncheking the
Locked check box of the boundary of interest. Additionally, dragging a new
token value onto the marker will update the value without having to unlock it
first.

© 2020 De Novo Software

360

FCS Express 6 Manual

Figure 9.40 The figure shows how to set and lock two marker end points together
by dragging and dropping one on top of the other.

9.2.3.5

By dragging and dropping a gate

A marker endpoint may be set and locked to a token value by dragging and
dropping a gate onto it. The marker endpoint will be set to the chosen token
value and will be automatically resized as when the token value changes.
Please note: The marker bound will automatically be locked to the token, thus
the marker bound will not be resizable by using the mouse. The lock can be
removed via the Formatting Markers dialog 270 and unchecking the Locked
check box of the marker bound of interest.

To Link and lock a marker bound to a gate statistic.
In the example below the low bound of a marker (M1) is linked and locked to the
X Median of a gate (Gate 1). The action is be performed by dragging and
dropping Gate 1 onto the low bound of marker M1 (Figure 9.41) and selecting
the X Median from the statistic list.
1. Left click and hold anywhere on Gate 1 (Figure below - Number 1) and drag
Gate 1 on top of the left end point of marker M1. Note that the cursor will
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appear as
(Figure below - Number 2).
2. Release the mouse button on top of the left end point of Marker M1. An Edit
Statistic dialog will open.
3. Select X Median from the Statistic list within the Edit Statistic window.
4. Click OK.
The position of the lower boundary of marker M1 will now link to the X Median of
Gate 1 (Figure below - Number 3).
When Gate 1 is adjusted, the lower boundary of marker M1 will change
accordingly (Figure below - Number 4). Please note that the marker endpoint is
now locked to the gate based token and cannot be updated by adjusting the
marker itself (Figure below - Number 5, note the absence of the resizing handle
at the left-bound). The lock can be removed via the Formatting Markers
dialog 270 by unchecking the Locked check box of the boundary of interest.

Figure 9.41 Setting and locking a marker end point by dragging and dropping a gate
on to the marker boundary.
9.2.3.6

By dragging and dropping a plot

A marker endpoint may be set and locked to a token value by dragging and
dropping a plot onto it. The marker endpoint will be set to the chosen token
value and will be automatically resized as when the token value changes.
Please note: The marker bound will automatically be locked to the token, thus
the marker bound will not be resizable by using the mouse. The lock can be
removed via the Formatting Markers dialog 270 and unchecking the Locked
check box of the marker bound of interest.
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To Link and lock a marker bound to a plot statistic.
In the example below the low bound of a marker (M1) is linked and locked to the
X Median of a quadrant on another plot. The action is be performed by dragging
and dropping the plot where the quadrant is displayed onto the low bound of
marker M1 (Figure 9.42) and by then selecting the X Median of the quadrant of
interest from the statistic list.
1. Select the plot where quadrant is displayed by left clicking on the plot border
(Figure below - Number 1).
2. While holding the mouse button down, drag the plot on top of the left end
point of marker M1. Note that the cursor will appear as
(Figure below Number 2).
3. Release the mouse button on top of the left end point of Marker M1. A Paste
Special dialog will open.
4. Select Statistic token from the Paste Format list.
5. Click OK. An Edit Statistic dialog will open.
6. Select the Lower Right quadrant from the Select a quadrant drop down
menu in the Plot Information section of the Edit Statistic dialog.
7. Select X Median from the Statistic list within the Edit Statistic window.
8. Click OK.
The position of the low bound of marker M1 will now link to the X Median of the
lower right quadrant (Figure below - Number 3).
When the quadrant is adjusted, the low bound of marker M1 will change
accordingly (Figure below - Number 4). Please note that the marker endpoint is
now locked to the quadrant/plot based token and cannot be updated by
adjusting the marker itself (Figure below - Number 5, note the absence of the
resizing handle at the left-bound). The lock can be removed via the Formatting
Markers dialog 270 by unchecking the Locked check box of the boundary of
interest.
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Figure 9.42 Setting and locking a marker end point by dragging and dropping a plot
on to the marker boundary.

9.2.4

Deleting Markers
Markers can be deleted in one of the following ways:
To delete a marker directly from a plot, click anywhere on the marker to
select it. When the marker is selected, three points will appear: a resizing
handle at the left- and right-boundaries, and a point in the center for moving
the marker. Press the Delete key on the keyboard or select the
Home Editing Delete command.
With the plot containing the marker you want to delete in selected or edit
mode, use the Format 1D Options Markers command. This brings up
a Formatting Markers dialog. In the Marker list box, highlight the
marker(s) you want to delete. Click on the Remove button. Click OK.
Right-click on the plot containing the marker and select Format from the
pop-up menu. Choose the Markers category in the formatting dialog.
Highlight the marker(s) you want to delete in the list box. Click on the
Remove button. Click OK.

9.2.5

Using Markers and the Clipboard
Copying/Cutting a marker to the clipboard
Click anywhere on the marker to select it (three points will appear along the
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length of the marker). Use the Home Clipboard Cut Marker (or Copy
Marker) command, or standard Windows Cut or Copy keyboard shortcuts
(Ctrl+X or Ctrl+C).
Pasting a marker
Select the plot where you want the marker to be pasted. Use the
Home Clipboard Paste Marker command, or standard Windows Paste
keyboard shortcut (Ctrl+V).
Markers that have been copy and pasted between different plots can also be
linked together 353 to move in union.

9.2.6

Linking Markers to Gates
When a marker is linked to a gate, the gate is automatically resized as the
marker is resized or moved. A marker can be linked to any existing 1D gate
using the Marker list in the Formatting Markers dialog 270 .
You can also create a new gate from a marker and link it automatically. To do
so:
Right-click on the histogram, select the appropriate marker, and then select
Convert Marker to Gate Convert and Link from the pop-up menu;
note, if you choose Convert only, the gate will not update if you move or
resize the original marker. If the Show prompt window radio button is set in
Gate creation prompt options 206 (Gate category of Options dialog), you will
be prompted to enter a name for the new gate.
To break a linked gate, either:
1. Use the Format 1D Options Markers command to bring up the
Formatting Markers dialog (or right-click on the histogram, select
Format from the pop-up menu, and choose the Markers category).
2. Select the Marker from the list on the left.
3. In the Linked Gate drop-down list, change the selection to No Link.
or,
1. Access the Edit Gate dialog 343 from the Gate View object.
2. Uncheck the Linked to... box (Figure 9.43)
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Figure 9.43 Unlinking a gate from a marker in the Edit Gate
dialog

A 1D gate can be automatically created every time a marker is created. This
option cab be activated:
On one or more existing histograms by checking the Create a Linked Gate
check box in the Histogram Markers 273 dialog of the histograms of
interest.
By default on every new histogram by by checking the Create a Linked
Gate check box in the 1D Plot Preferences 190 user options.
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Using Quadrants
FCS Express supports three different kinds of Quadrants 290 : Standard, Floating,
and Percentile. The four quadrants are defined as follows: Upper Left (UL), Upper
Right (UR), Lower Left (LL), and Lower Right (LR).
Standard quadrants are the quadrants found in most flow cytometry software
packages. All four quadrants are square or rectangular and are defined by the
central vertex. Moving the central vertex of the quadrants will redefine all four
quadrants.
Floating quadrants allow the four quadrants to be non-rectangular. When the
quadrants are floating, each quadrant can have a different shape. The outer
vertices are no longer linked to the central vertex, and each vertex can be
manipulated individually (see Floating Quads example, below). Floating quadrants
allow the user to quickly and easily get statistics on populations that cannot be
demarcated by standard quadrants. This can eliminate the need for
compensation when only percentages are needed.
Examples of Standard Quadrants and Floating Quadrants are shown in Figure
9.44.

Figure 9.44 Standard vs Floating Quads

Percentile Quadrants are similar to standard quadrants except that the vertex of
the quadrant is automatically calculated based on the percentile entered in the
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Quads page of the Format dialog 290 . The vertices of the quadrants will
automatically update as the data on the plot changes. For instance, if you set the
percentile to be 99%, the quads will automatically update so the center quadrant
vertex is at the channel where 99% of the events are below it. It can be useful
to set Percentile Quadrants on your controls and then link those quadrants to the
plots with your sample. Quad linking is described in the section on Linking
Quadrants to Quadrants 369 .

9.3.1

Showing Quadrants
Only one set of quadrants can exist for a plot. You can control whether
quadrants are automatically displayed by checking the Show quadrants box in
the 2D Plots page of the Options 191 dialog. The default behavior is for the
quadrants to be hidden when the plot is created.
You can show the quadrants on a per-plot basis using one of the following
methods:
Right-click on the plot and select Show Quadrants from the pop-up menu.
Select the Gating Create Gates Quadrants command and click on the
plot at the position where you want the central vertex to be located.
Right-click on the plot and select the Format menu item. Choose the
Quads category. Enable the Show quadrants checkbox.

9.3.2

Moving Quadrants
Quadrant vertices can be adjusted either by using the mouse to click and drag
the vertex on the plot, or by entering the vertex coordinates on the Quadrants
page of a Format window. Quadrants can be updated in real time if desired by
choosing the FCS Express User Option to update Gates, Markers, and Quadrants
immediately. 317
Selecting Quadrants
To select the quadrants in order to edit their position, click on the central
vertex, where all the lines meet. If a Standard Quadrant is selected, a resizing
handle will appear at the central vertex. If Floating Quadrants are selected,
resizing handles will appear over all five vertices. Percentile Quadrants cannot
be selected, as their position is dictated by the Formatting Quadrants 290
dialog.

Moving Standard Quadrants
Click on the central vertex of the quadrant you want to move. You will know
that you clicked on the correct position when the cursor turns into a fourheaded arrow
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four-headed arrow. While holding the mouse button down, move the cursor
to the new central vertex position. Release the mouse to move the quadrants
to the new position.
Moving Floating Quadrants
Click on the central vertex of the quadrant you want to move. You will know
that you clicked on the correct position when the cursor turns into a fourheaded arrow. Press and hold the mouse button while the four-headed cursor
is over any of the five vertices. While holding the mouse button down, move
the cursor to the new vertex position. Release the mouse to move the vertex
to the new position. Note: Much like the Standard Quadrants, the central
vertex can move anywhere within the plot. Outer vertices will only be able to
move along their original plot edge.
To enter the vertex coordinates directly on a Format window, see the Quadrants
section under Formatting 2D Plots 290 . Note: Format windows where you can
enter vertex coordinates can be reached in one of two ways, either: Right-click a
plot and choose Format from the pop-up menu; or, select a plot and use the
Format 2D Options Quadrants command.
To cancel moving quadrant vertices once you have started, press the Esc key at
any time. Or, to undo a move, hit Undo on the Quick Access Toolbar 65 or Ctrl
+Z on the keyboard.
Notes:
If quadrants are linked to the quadrants on another plot 369 , the quadrants on
the dependent plot will move automatically.
Percentile quadrants (see the Quadrants section under Formatting 2D Plots 290 )
cannot be moved manually. Instead, the percentile(s) must be redefined 290 .

9.3.3

Hiding Quadrants
Quadrants always exist with a plot. They can never be deleted, but they can be
hidden.
There are several ways to hide quadrants:
Right-click on the plot and deselect the Show Quadrants item on the popup menu.
Right-click on the plot and select Format from the pop-up menu. Go to the
Quads page of the format dialog and uncheck the Show quadrants box.
Select the plot and use the Format tab 2D Options
command. Uncheck the Show quadrants box.

Quadrants
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Select the quadrants by clicking on the central vertex. Press the Delete key
on the keyboard, or select the Home tab Editing Delete command.

9.3.4

Linking Quadrants to Quadrants
FCS Express allows you to link quads from one plot to another. This means that
when the quads on one plot are moved, the quads on the linked plot will be
updated automatically. This is useful in circumstances when you want to create a
reference quadrant on your control, from which the quads on your sample data
update automatically as the reference control quad is adjusted. To set up linked
quadrants, see Quadrant Linking Options 292 .

9.3.5

Creating Gates from Quadrants
You can create a gate from a Quadrant. The gate will be created as a polygon
gate with the same coordinates as the quadrant. You can create a gate from
the Upper Left, Upper Right, Lower Left, Lower Right, Upper (Upper Left
plus Upper Right), Lower (Lower Left plus Lower Right), Left (Upper Left plus
Lower Left), or Right (Upper Right plus Lower Right) quadrants.
To create a Gate from a Quadrant:
Right-click on the plot and select the Convert Quads To Gates item in the
pop-up menu. Select the quad you wish to convert to a gate from the
submenu. Select either Convert or Convert and Link 369 . If you choose
Convert only, the gate will not update if you move or resize the quad,
while Convert and Link will allow the gate to be updated as the quad is
moved.
The links may be broken at any time, from either the Quadrant Formatting dialog
292 or the Edit Gate dialog 343 from the Gate View object.

9.3.6

Linking Quadrants to Gates
It is also possible to link a quadrant to a gate so that whenever the quadrant is
moved, the gate will automatically adjust to the new quadrant coordinates. This
allows you to effectively use a quadrant as a gate.
To create a linked gate from a quadrant, either:
Right-click on a plot, select Convert Quads to Gates from the pop-up
menu choose the quadrant from the submenu Convert and Link, or
Right-click on the plot and select Format from the pop-up menu. Select
the Quads category. Choose Quad to Gate from the Linking Options
box. Select a quadrant and an existing polygon or freeform gate from the
drop-down list. Further information is available in the Quadrants section
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under Formatting 2D Plot 290 . Alternatively, you can reach the format
window by selecting a plot and using the Format 2D
Options Quadrants command.
The links may be broken at any time, from either the Quadrant Formatting dialog
292 or the Edit Gate dialog 343 from the Gate View object.

9.3.7

Using Quadrants and the Clipboard
It is possible to copy and paste quadrants to and from the clipboard.
Copying/Cutting a quadrant to the clipboard
Select the quadrant by clicking on the central vertex. Select the
Home Clipboard Copy Quad (or Cut Quad) command, or standard
Windows Cut or Copy keyboard shortcuts (Ctrl+X or Ctrl+C). Note: Cutting
does not delete the quadrants, it merely hides them.
Pasting a quadrant
Select the plot where you want the quadrant to be pasted. Select the
Home Clipboard Paste Quad command, or right-click on the plot and
use the standard Windows Paste keyboard shortcut (Ctrl+V).

9.4

Snapshots
Snapshots in FCS Express 6 provide a way to easily save multiple gate,
quadrant, or marker positions for quick access across samples in your analysis.
Snapshots can be manually defined by working with the Snapshots 372 Navigator
372 or automatically each time a gate is moved while advancing through the Data
List using the Data tab Next/Prev commands, or during Batch Processing 850 .
Automatically created Snapshots do not appear in the Snapshots navigator.
The Snapshots navigator can be opened from the Tools tab
category
(Figure 9.45).

Figure 9.45 Snapshots Icon from
Ribbon
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The Snapshots navigator (Figure 9.46) includes the following options:
Create a new Snapshot - Creates a new Snapshot of the current gate,
marker, and quadrant positions.
Create a new Folder - Creates a new folder in the Snapshot navigator to
organize Snapshots from the analysis.
Delete - Deletes the selected Snapshot in the navigator.
Rename the selected Snapshot - Renames the selected Snapshot in the
navigator.
Apply Snapshot - Applies the selected Snapshot to the layout.
Snapshot Date and Time - Records the Date and Time that a Snapshot of
the layout was created.
Description - Allows user to describe selected snapshot

Figure 9.46 The commands available in the Snapshots navigator.
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Creating and Applying Snapshots
Snapshots provide an easy method for remembering multiple gate, marker, and
quadrant positions across different samples or analysis runs. Snapshots may be
created manual via the steps below or automatically by using Iteration
Snapshots 374 .
To create a Snapshot on a layout containing plots and data:
1. Open the Snapshots navigator from the Tool tab
category
.
2. Position any gates, markers, or quadrants as you would like the Snapshot to
save.
3. Click on the green plus

button to create a new Snapshot.

4. Enter a name for the Snapshot in the Snapshots navigator.
The position of the gates, markers, and quadrants on the layout are now saved
within the Snapshot you have created (Snapshot 1 in Figure 9.47 below).
To create multiple Snapshots:
5. Repeat steps 1-4 above and give the new Snapshot(s) a name (Snapshot 1,
Snapshot 2, and Snapshot 3 in Figures below).
To apply a Snapshot after the above steps 1-4 have been completed,
6. Move gates, markers, or quadrants to a new position.
7. Highlight the Snapshot in the Snapshots navigator that you intend to apply.
8. Click the camera icon within the navigator (tooltip: "Apply Snapshot")
a. Alternatively, drag the Snapshot name from the Snapshot navigator to a
blank space on the layout and drop it.
b. Note in Figure 9.48 that "Snapshot 2" has been applied automatically
changing the shape of Gate 1, position of Gate 2, the Marker position, and
the position and type of Quadrant.

An unlimited number of Snapshots may be created and / or organized using the
folder icon (tooltip: "Create a new folder"). Once a folder is created you may
drag and drop any existing Snapshots into and out of the folder.
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9.47 Snapshot 1 from the Snapshot navigator is applied to the layout. Note the
position of Gate 4, the position of M1, and the position and style of the Quadrants.

9.48 Snapshot 2 from the Snapshot navigator has now been applied to the layout.
Note the changes from Snapshot 1 to the position of Gate 4, the position of M1, and
the position and style of the Quadrants.
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Iteration Snapshots
While analyzing your data, FCS Express automatically takes Snapshots
of your
gate, marker, and quadrant positions. Snapshots are recorded automatically
when changing between iterations. For instance, by using the Next/Previous
buttons 79 to change data on all plots, or by clicking on an Iteration number in
the Data List 783 to change between iterations, or automatically while using the
Batch Processing 782 functionality. These automatic snapshots are referred to as
Iteration Snapshots, and do not appear in the Snapshots window 370 .
1513

Iteration Snapshots are always recorded but they are only applied in the
specific conditions below:
Never applied: when Batch Processing using the Run 844 command.
Always applied: when Batch Processing using the Rerun or Review mode 846 .
Applied, or not: depending on whether the Apply Iteration Snapshot button
is depressed or not, when loading iterations by using the Next/Previous buttons
79 to change data on all plots, or by clicking on an Iteration number in the Data
List 783 .
Note: Turning off the Apply Iteration Snapshot button will continue to record
new Iteration Snapshots but will stop applying them when changing between
iterations by using the Next/Previous buttons 79 to change data on all plots, or
by clicking on an Iteration number in the Data List 783 . Importantly, this means
that, when changing between iterations, the previously recorded Iteration
Snapshots will be overwritten, and thus lost, with the current one (i.e with the
current gate, marker, and quadrant positions).

The Apply Iteration Snapshot button (Figure 9.49) is found under the Tools
tab
category
button.

Figure 9.49 - Apply
Iteration Snapshot
button.
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If the Iteration Snapshot is enabled, FCS Express will take a Snapshot of each
iteration when the Previous/Next tools are used to manipulate the data in All
elements simultaneously. The Snapshot will record all the properties of the
gating strategy.
The Figures below show how the Previous/Next buttons will advance to the
next iteration in All objects and record a Snapshot for each iteration. Notice how
the Iteration Snapshot button is depressed in figure 9.50 before clicking the Next
command. When data is changed to the next iteration in figure Figure 9.51, new
gate, quadrant, and marker positions may be created and their positions will be
stored within that iteration. Clicking the previous button will revert the layout to
the previous file/iteration in the data list along with all of the gate, marker, and
quadrant positions remembered for that iteration.
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Figure 9.50 Depressing the Snapshot iteration button before clicking the Next
button will cause FCS Express to remember the position of any gates, quadrants,
or markers before moving to the next file/iteration in the data list.
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Figure 9.51 Taking Iteration Snapshots Using the Previous/Next Tools

In addition to using the Previous/Next button to simultaneously advance
through your data and take Snapshots, it is also possible to navigate through
your iterations by selecting the iteration number from the dropdown menu that is
located in Data tab
(Figure 9.52).
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Figure 9.52 Navigating through Data Using the Iteration Number Dropdown Menu

Flagging Iterations
As you analyze your data using the Previous/Next tools, it's possible that you
might see something about your data that you would like to earmark for further
review.
In FCS Express, you can Flag an iteration by selecting the Flag this iteration
tool. This tool can be found under Data tab
(Figure
9.53).
You can also flag iterations during Batch Processing

847

.
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Figure 9.53 Flag This Iteration Tool

Once an iteration is flagged, you can see which iterations are flagged in the Data
List 783 . Also, you will be able to review this data during Batch Processing by
adjusting the Batch Processing Options to 841 Pause on Flagged Items 841 .

9.5

Statistics
FCS Express can generate any statistic that one would need for analysis of flow
cytometry data. Statistics can be calculated either from a 1D or 2D plot.
Statistics calculated base on a plot are only calculated for cells currently showing
on the plot according to the current gate .
1293

Statistics may be accessed in default statistics windows or tables or represented
anywhere within FCS Express as tokens 688 . Custom statistics may also be
derived from any plot or user based input by accessing custom tokens 692 .
FCS Express calculates statistics to be accurate to the IEEE single precision
floating point standard, as described in http://ieeexplore.ieee.org/xpl/
articleDetails.jsp?arnumber=4610935&contentType=Standards and http://
en.wikipedia.org/wiki/Single-precision_floating-point_format. Intermediate
calculations may be performed with more precision, if available.
More information on the default statistics available for 1D- and 2D-plots, as well
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as using and formatting statistics are in the sections below:
Histogram statistics 380
2D plot statistics 383
Custom tokens 725 (user defined statistics and more)
Using statistics and the clipboard 385
Formatting statistics 387

FCS Express 5 and above includes the following new statistics which are
described further in subsequent pages:
Default Statistics introduced in FCS Express 5 and available in later versions:
o Percent of Gated - Parent 389
o Percent of Gated - Grandparent 389
o BD Robust Standard Deviation (rSD in BD FACSDiva)
o BD Robust coefficient of variation (rCV in BD FACSDiva)

9.5.1

Histogram Statistics
Statistics will be calculated for every overlay on the histogram. If there are
markers, statistics will be calculated for every overlay that the marker applies to
(see Creating Markers 351 and Histogram Markers 270 ).
To view the histogram statistics, right-click on the plot and select Histogram
Statistics from the pop-up menu (Figure 9.54 below, ). Individual statistics
may be toggled on and off by right-clicking on the default statistics table (Figure
below, ), or from the Formatting Statistics 387 menu.
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Figure 9.54 Adding a default statistics table from a histogram

The available statistics are shown in the table below.
Statistic
Histogram #

Filename
Parameter

Overlay Gate
Marker

Low bound
High bound
# of Events
% of all cells
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Explanation
If there are multiple overlays visible on a plot, then the statistics will be
calculated for every overlay. Histogram # displays the overlay number
for that row of statistics. The overlay number corresponds to the
position in the overlay list on the Overlays 267 page of the Format
window.
The file name of the overlay.
The parameter name for the parameter that is being displayed on the
overlay. The field that the parameter name is taken from can be set in
the FCS Express User Options Dialog under Data Loading - FCS File
Options 229 .
The name of the gate that is currently being applied to the overlay.
If there are several markers visible on a plot, then the statistics will be
calculated for each overlay that the marker applies to. Marker displays
the marker number for that row of statistics. The marker number
corresponds to the position in the marker list on the Markers page of
the Format window (see Histogram Markers 270 ).
The channel number of the low boundary of the marker.
The channel number of the high boundary of the marker.
The number of events that are accepted by the gating formula.
The number of events that are accepted by the gating formula and are
located within the specified marker divided by the total number of
events in the FCS file.
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% of gated
cells

The number of events that are accepted by the gating formula and are
inside the specified marker divided by the total number of events
displayed on the plot.
Median
The median channel value of the events that are accepted by the
gating formula that fall within the specified marker.
Geometric
The geometric mean channel number of the events that are accepted
Mean
by the gating formula that fall within the specified marker. Similar to
arithmetic mean except that the numbers are multiplied and the Nth root
of the resulting product is taken.
Arithmetic
The arithmetic mean channel number of the events that are accepted
Mean
by the gating formula that fall within the specified marker.
CV (Coefficient The coefficient of variation of events that are accepted by the gating
of Variation)
formula that fall within the specified marker. The CV is a measure of the
distribution of your data and is equal to the standard deviation divided
by the mean.
RCV (Robust CV) The Robust Coefficient of Variation of events that are accepted by the
gating formula. The RCV may be more applicable than the CV for
populations that do not follow a normal Gaussian distribution. The RCV is
equal to 0.75 multiplied by the interquartile range divided by the median.
The interquartile range is the 75th percentile channel minus the 25th
percentile channel.
5%-ile(5th
The channel corresponding to the 5th percentile of the cells that have
percentile)
been accepted by the gating formula.
th
95%-ile (95
The channel corresponding to the 95th percentile of the cells that have
percentile)
been accepted by the gating formula.
25%-ile (25th
The channel corresponding to the 25th percentile of the cells that have
percentile)
been accepted by the gating formula.
75%-ile (75th
The channel corresponding to the 75th percentile of the cells that have
percentile)
been accepted by the gating formula.
Concentration The concentration of the cells that are accepted by the gating formula.
The parameters for the concentration calculation can be set up in the
Concentration Calculator 588 .
Percent
The percentage of the cells accepted by the gating formula that are
Positive
positive with respect to the control overlay. The control overlay is set
in Histogram Specific Options 273 . The Overton Subtraction method
statistic will be displayed. 594
Standard
A measure of the variation from the average for the events. The square
Deviation
root of the variance.
% of gated The number of events that are accepted by the gating formula and are
parent
inside the specified marker divided by the total number of events in the
parent gate.
% of gated The number of events that are accepted by the gating formula and are
grandparent
inside the specified marker divided by the total number of events in the
grandparent gate.
BD-rSD
The BD Biosciences robust standard deviation. See the full description
by BD Biosciences.
BD-rCV
The BD Biosciences robust coefficient of variation of events that are
accepted by the gating formula that fall within the specified marker. See
the full description by BD Biosciences.

The right-click Format pop-up menu Markers If there are markers on
plot, also show statistics for the base overlay without the marker
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checkbox is for displaying statistics for the entire overlay with no marker applied.

9.5.2

2D Plot Statistics
There are two kinds of statistics that can be displayed for a 2D plot (Gate
Statistics and Quadrant Statistics). The same statistics are available in either
case.
Gate Statistics
The statistics are calculated for every gate designated in the Gates to
Display data option for the statistics window, even if the gate is not being
displayed on the plot. The Gates to Display can be chosen from a dialog
accessible from the Format Data Options Gates To Display command,
or in the Formatting Statistics 387 dialog shown by right-clicking on the
statistics window and choosing Format from the pop-up menu.
Quadrant Statistics
The statistics are calculated for every quadrant. There will be four rows of
statistics for each overlay with each row corresponding to a different
quadrant. Quadrant statistics displayed on the plot may be changed by
formatting the Label Text Box containing the statistic 152 .

In order to open a statistics window, right-click on a 2D Plot and choose Gate
Statistics (Figure 9.55 below) or Quadrant Statistics (if quadrants are not
currently shown on the plot, this option is not enabled) from the pop-up menu.
Individual statistics may be toggled on and off by right-clicking on the default
statistics table (Figure below), or from the Formatting Statistics 387 menu.
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Figure 9.55 Adding a default statistics table from a 2D plot

The available statistics are shown in the table below. A region can refer to a gate
or quadrant.
Statistic
Overlay #

Explanation
If there are multiple overlays visible on a plot, the statistics will be
calculated for every overlay on the plot. Overlay # displays the overlay
number for that row of statistics. The overlay number corresponds to the
position in the overlay list on the Overlays 283 page of the Format window.
FCS Filename The file name corresponding to the overlay number.
Overlay Gate The name of the gate that is currently being applied to the overlay.
Gate
The region for which the statistics apply. This region can be either a gate
or quadrant designation.
# of Events
The total number of events in this region accepted by the gating formula.
X Geometric The geometric mean channel number of the events on the X-axis that are
Mean
accepted by the gating formula. Similar to arithmetic mean except that
the numbers are multiplied and the Nth root of the resulting product is
taken.
Y Geometric The geometric mean channel number of the events on the Y-axis that are
Mean
accepted by the gating formula. Similar to arithmetic mean except that
the numbers are multiplied and the Nth root of the resulting product is
taken.
X Arithmetic The mean X-axis channel value of cells in this region that are accepted
Mean
by the gating formula.
Y Arithmetic The mean Y-axis channel value of cells in this region that are accepted
Mean
by the gating formula.
X Median
The median X-axis channel value of cells in this region that are accepted
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Statistic

Explanation
by the gating formula.
Y Median
The median Y-axis channel value of cells in this region that are accepted
by the gating formula.
X CV
The coefficient of variation of X-axis events that are accepted by the
(Coefficient of gating formula that fall within the specified marker. The CV is a measure
Variation)
of the distribution of your data and is equal to the standard deviation
divided by the mean.
Y CV
The coefficient of variation of Y-axis events that are accepted by the
gating formula that fall within the specified marker.
X RCV (Robust The Robust Coefficient of Variation of X-axis events that are accepted by
CV)
the gating formula. The RCV may be more applicable than the CV for
populations that do not follow a normal Gaussian distribution. The RCV is
equal to 0.75 multiplied by the interquartile range divided by the median.
The interquartile range is the 75th percentile channel minus the 25th
percentile channel.
Y RCV
The Robust Coefficient of Variation of Y-axis events that are accepted by
the gating formula.
% of Gated
The total events in the specified region divided by the total number of
Cells
events on the whole plot accepted by the gating formula.
% of All Cells The total events in the specified region divided by the total number of
events in the FCS file.
Concentration The concentration of the cells that are accepted by the gating formula.
The parameters for the concentration calculation can be set up in the
Concentration Calculator 588 .
X Standard
A measure of the variation from the average for the events on the XDeviation
axis. The square root of the variance.
Y Standard
A measure of the variation from the average for the events on the YDeviation
axis. The square root of the variance.
X BD-rSD
The BD Biosciences robust standard deviation for X axis events. See the
full description by BD Biosciences.
Y BD-rSD
The BD Biosciences robust standard deviation for Y axis events. See the
full description by BD Biosciences.
X BD-rCV
The BD Biosciences robust coefficient of variation of X-axis events that
are accepted by the gating formula that fall within the specified marker.
See the full description by BD Biosciences.
Y BD-rCV
The BD Biosciences robust coefficient of variation of Y-axis events that
are accepted by the gating formula that fall within the specified marker.
See the full description by BD Biosciences.
% of gated - The number of events that are accepted by the gating formula and are
Parent
inside the specified gate divided by the total number of events of the
parent of the gate applied to a plot.
% of gated - The number of events that are accepted by the gating formula and are
Grandparent inside the specified gate divided by the total number of events of the
grandparent of the gate applied to a plot.

9.5.3

Using Statistics and the Clipboard
It is possible to copy any single statistic, or a group of contiguous statistics, from
the statistics window to the clipboard. First, you must select the cells you wish to
copy by clicking. You can then paste the statistics into a text box
that will be
automatically inserted on your layout, or outside of FCS Express* (e.g, to a text
file, or a spreadsheet). Cutting cells from the statistics window is not allowed;
1300

© 2020 De Novo Software

FCS Express 6 Manual

386

instead, toggle
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the desired statistic off.

To select statistics from a default statistics table:
Click in a cell to select it. The background of the cell will be highlighted in
blue.
To select a group of contiguous cells, select the first cell of the group to
highlight it. Then, while holding the Shift key, select the last cell of the
group. All of the selected cells will have a blue background.
After you have selected the cells you wish to copy, either:
use the Home Clipboard Copy Text command (or Ctrl+C) to copy the
statistics [i.e., statistic name(s) and selected cell(s)] to the clipboard (Figure
9.56).
drag the statistic(s) out to an empty spot on your layout to insert them
into their own text box.

Figure 9.56 Clipboard
from Home
tab

* Note: If a large number of statistics from various plots, tables, or from multiple
.fcs data files are to be exported, Batch Processing
is a more efficient method.
1470

Copying Histogram Data:
The Bin and Count numbers of histogram data may be copied from any
histogram and pasted within FCS Express or any software, such as Excel, for
further review. To Copy Histogram Data (Figure. 9.57):
1.
2.
3.
4.

Right click on a histogram.
Choose Copy Histogram Data.
Choose the Overlay to copy data from.
Paste the data in FCS Express or any other software with control+V or any
other paste command.
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Figure. 9.57 Using the copy histogram data feature. Notice the red highlighted
table in which the first 5 bins of data from the histogram are displayed upon a
paste command.

9.5.4

Formatting Statistics
There are several options to control which statistics get displayed in any
individual statistics window.
You can change the displayed statistics in either of the following ways:
Right-click on the statistics window. In the pop-up menu, there will be a list
of available statistics. You can individually toggle any statistic from this
menu. If the statistic is selected, a check mark will appear next to the name
(Figure 9.58).
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Figure 9.58 Toggling individual statistics on and off via the right-click menu

Access the Formatting options for the Statistics window by either of these
two methods:
o right-click on the Statistics window and select Format from the
pop-up menu and the Stats category at left, or
o select the Statistics window and use the Format tab Statistics
Options Statistics command.
Then, individually select/deselect each statistic you want to display by
checking/unchecking the appropriate checkbox in the Select Statistics list
box on the Stats page. You may also Select or Deselect All by right
clicking in the Select Statistics list (Figure 9.59).
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Figure 9.59 Select/Deselect All statistics

To format the statistics window, right-click on it and select Format from the
pop-up menu. Several categories will be available to set various options, such as
the size of the statistics window, border, which statistics are available, and which
gate(s) you would like to see statistics for 302 .
To set the default statistics that appear when you first open a statistics window,
use the 1D Plot Statistics 197 or the 2D Plot Statistics 198 category of the Options
dialog. This feature is convenient if you routinely prefer to see the same set of
statistics during data analysis.
Details on statistic options and number display options may be found in the
description for 1D Plot Statistics 197 or the 2D Plot Statistics 198 as they related to
FCS Express user options.

9.5.5

Percent Gated - Parent and Percent Gated - Grandparent
The statistics % Gated - Parent and % Gated - Grandparent are available in
FCS Express.
These are defined as follows:
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% Gated Parent

The number of gated events divided by the number of events of
the parent of the gate that is applied to a plot, multiplied by
100.
% Gated - The number of gated events divided by the number of events of
Grandparent the grandparent of the gate that is applied to a plot, multiplied
by 100.
We will examine these statistics in terms of real data. Figure 9.60 represents an
analysis with sequential gating.

Figure 9.60 - Analysis with Sequential Gating

When observing Gate 5... In Plot #10 (the lower right 1D histogram), there is a
Marker that was converted to Gate 5. Gate 5 contains 40 events.
The gate that is applied to Plot #10 is Gate 4. Therefore, the statistic for Gate 5
% Gated is defined as the number of Gate 5 events (40) divided by the number
of Gate 4 events (2203) multiplied by 100. In this case, the numerical formula is
(40/2203)x100, which equals 1.8157.
The statistic for Gate 5 % Total is defined as the number of Gate 5 events (40)
divided by the Total Number of events collected (20,000). The numerical
formula is (40/20000)x100, which equals 0.2.
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The statistic for Gate 5 % of Gated - Parent is defined as the number of gated
events (40) divided by the number of events for the parent of the gate applied
to Plot #10. As can be seen in Figure 9.61, Gate 4 has been applied to Plot #10.
The parent of Gate 4 is Gate 3. So, the statistic for Gate 5 % of Gated Parent is defined as the number of Gate 5 events divided by the number of Gate
3 events multiplied by 100. The numerical formula is (40/2407)x100, which
equals 1.6618.

Figure 9.61 - Showing the Parent and Grandparent of Gate 4

The statistic for Gate 5 % of Gated - Grandparent is defined as the number of
gated events (40) divided by the number of events for the grandparent of the
gate applied to Plot #10. As can be seen in Figure 2, Gate 4 has been applied to
Plot #10. The parent of Gate 4 is Gate 3. The parent of Gate 3 is Gate 2. So,
the statistic for Gate 5 % of Gated - Grandparent is defined as the number of
Gate 5 events divided by the number of Gate 2 events multiplied by 100. The
numerical formula is (40/2830)x100, which equals 1.4134.

9.5.6

Spreadsheet Statistics from Data Files
Spreadsheets may be populated by statistics from the data files available in the
Data List 431 using the drag-and-drop feature. The available statistics are shown
in the table below.
Statistic
Filename
Parameter
Gate name
Min value

Max value
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Explanation
The file name of the file.
The name of the parameter selected from the Parameter dropdown
menu under Data File Information within the Edit Statistic window.
The name of the gate that is currently being applied to the file.
The number of the minimum value for the selected parameter from the
Parameter dropdown menu under Data File Information within the
Edit Statistic window for the events in the data file that are accepted
by the gating formula.
The number of the maximum value for the selected parameter from the
Parameter dropdown menu under Data File Information within the
Edit Statistic window for the events in the data file that are accepted
by the gating formula.
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# of Events
% of parent

The number of events that are accepted by the gating formula.
The number of gated events that are accepted by the gating formula
and in the specified gate divided by the total number of events in the
parent gate of the specified gate.
% of
The number of gated events that are accepted by the gating formula
grandparent
and are in the specified child gate divided by the total number of events
in the grandparent gate of the specified gate.
% of great
The number of gated events that are accepted by the gating formula
grandparent
and are in the specified gate divided by the total number of events in
the great grandparent gate of the specified gate.
% of all cells
The number of gated events that are accepted by the gating formula
and are located within the specified gate divided by the total number of
events in the FCS file.
Median
The median channel value of the events that are accepted by the
gating formula.
Geometric
The geometric mean channel number of the events that are accepted
Mean
by the gating formula that fall within the specified gate. Similar to
arithmetic mean except that the numbers are multiplied and the Nth root
of the resulting product is taken.
Arithmetic
The arithmetic mean channel number of the events that are accepted
Mean
by the gating formula that fall within the specified gate.
CV (Coefficient The coefficient of variation of events that are accepted by the gating
of Variation)
formula that fall within the specified gate. The CV is a measure of the
distribution of your data and is equal to the standard deviation divided
by the mean.
RCV (Robust CV) The Robust Coefficient of Variation of events that are accepted by the
gating formula. The RCV may be more applicable than the CV for
populations that do not follow a normal Gaussian distribution. The RCV is
equal to 0.75 multiplied by the interquartile range divided by the median.
The interquartile range is the 75th percentile channel minus the 25th
percentile channel.
5%-ile(5th
The value corresponding to the 5th percentile of the cells that have
percentile)
been accepted by the gating formula.
th
95%-ile (95
The value corresponding to the 95th percentile of the cells that have
percentile)
been accepted by the gating formula.
25%-ile (25th
The value corresponding to the 25th percentile of the cells that have
percentile)
been accepted by the gating formula.
75%-ile (75th
The value corresponding to the 75th percentile of the cells that have
percentile)
been accepted by the gating formula.
Concentration The concentration of the cells that are accepted by the gating formula.
The parameters for the concentration calculation can be set up in the
Concentration Calculator 588 .
Standard
A measure of the variation from the average for the events. The square
Deviation
root of the variance.
BD-rSD
The BD Biosciences robust standard deviation. See the full description
by BD Biosciences.
BD-rCV
The BD Biosciences robust coefficient of variation of events that are
accepted by the gating formula that fall within the specified marker. See
the full description by BD Biosciences.
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Axis Scalings
FCS data has traditionally been acquired on either a linear or logarithmic scale,
and the appropriate scaling is stored in the header of the FCS data file. Although
FCS Express has supported displaying linear data on a logarithmic scale, the data
has traditionally been displayed on the same scale as it was acquired.
The logarithmic scale has the disadvantage that it cannot display values below
zero. This is considered a limitation when performing software compensation
where it is common for a significant proportion of compensated data to appear
in a "negative" channel. When displayed on a log scale, the negative values are
placed on the axis, where they can be easily missed, leading you to
overcompensate your data.
To overcome this limitation, several additional axis scalings have been developed.
These scalings share the general characteristic that they behave linearly close to
zero, and behave logarithmically farther away from zero. These scalings also are
defined to be able to graph data below zero. Scalings that are a combination of
linear and log scalings are called hybrid scalings. More details can be found in the
following publications:
Herzenberg LA, Tung J, Moore WA, Herzenberg LA, Parks DR. Interpreting
flow cytometry data: a guide for the perplexed. Nat Immunol 2006;7:681685.
Parks DR, Roederer M, Moore WA. A New "Logicle" Display Method Avoids
Deceptive Effects of Logarithmic Scaling for Low Signals and Compensated
Data. Cytometry A 2006;69A:541-545.
Bagwell CB. Hyperlog – A Flexible Log-like Transform for Negative, Zero,
and Positive Valued Data. Cytometry A 2005;64A:34-42.
Battye FL. A Mathematically Simple Alternative to the Logarithmic Transform
for Flow Cytometric Fluorescence Data Displays. Cytometry A
2006;69A:413-414.
FCS Express supports the following axis scalings:
Linear – Standard linear scaling
Log – Standard log scaling
Log with Negative – This is a modified log scaling.
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In the normal log function the zero and negative values are undefined, and
if they are obtained during compensation they are commonly represented
as events stacked on the axis, as is commonly seen in compensated data.
In the log with negative function, if negative values are encountered, the
log of its absolute value is calculated and displayed on the negative side of
the scale, effectively creating a "negative logarithm" display which is a
mirror image of its positive counterpart. Zero values are still kept on axis.
Biexponential
The biexponential display was popularized by the BD FACSDiva software.
As a result of our close collaboration with BD, FCS Express now supports
all of the options that FACSDiva does in terms of displaying biexponential
data. In fact, we have implemented FACSDiva's proprietary algorithm for
calculating the reflection point, so the results from FCS Express will look
identical to the results from the FACSDiva software.
Hyperlog™ 2 – Described in the Bagwell paper, above.
Lin/Log – Described in the Battye paper, above.

This transform is purely linear below a transition point and purely log above
the transition point. The a and c coefficients are matched so that the
function is continuous at the transition point.
ArcSinh
ArcSinh is an inverse hyperbolic function most widely used with .fcs files
generated by CyTOF Mass Cytometry. ArcSinh values are calculated by
applying the ArcSinh equation to the raw intensity value and dividing by a
cofactor. The "cofactor" defines the size of the linear region around 0, with
smaller cofactors corresponding to a longer linear region.
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Data Display
The axis scale for a given plot can be adjusted using the axis formatting options.
All data files, regardless of the scale that they were acquired with, can be
displayed in any of the scalings supported by FCS Express. The scaling only
affects the display of the data, not the statistics 255 .
Lin/Log and Hyperlog scalings:
The Lin/Log and Hyperlog scalings both a have coefficient that can be adjusted.
The coefficient can be changed in the Scale section of the Axis page in the
formatting dialog (right-click on the plot, select Format from the pop-up menu).
The coefficient is called the Transition Point because it describes the transition
from the predominantly linear to predominantly log portion of the transform. The
transition parameter for the Hyperlog scaling is identical to the b parameter in
the Bagwell paper 393 .
An example of setting the Lin/Log scaling with a Transition Point of 200 is shown
in Figure 9.62. Transition values are entered in channel units, and do not have to
be scaled as described in the Bagwell paper.

Figure 9.62 Setting the Transition Point for the Y-axis in Lin/Log Scaling

For any of these transforms, smaller transitions values result in plots which more
closely resemble the standard log plots. The precise transition value to use will
depend for the most part on your data, and generally a value of at least 30 is
required.
Biexponential Scaling:
The biexponential display was popularized by the BD FACSDiva software. As a
result of our close collaboration with BD, FCS Express now supports all of the
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options that FACSDiva does in terms of displaying biexponential data. In fact, we
have implemented FACSDiva's proprietary algorithm for calculating the transition
(Below-zero) value, so the results from FCS Express will look identical to the
results from the FACSDiva software.
When an FCS file that was acquired with BD FACSDiva is opened in FCS Express
you will notice that the automatic scaling in FCS Express applies the Biexponential
scaling and chooses the Below Zero Parameter (transition point) automatically
(Figure 9.63).

Figure 9.63 Automatic biexponential scaling in FCS Express of a file acquired in BD
FACSDiva.

The Below Zero Parameter can also be manually adjusted by unchecking the
Automatic box and selecting the Use the value radio button. You may also
choose to Automatically set the plot's minimum value by checking/
unchecking the associated box. When the Automatically set the plot's
minimum value is checked the axis minimum is set to optimize the display by
not displaying outliers. When unchecked the entire range of data, including
outliers, will be displayed (Figure 9.64).
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Figure 9.64 Manually entering a Below Zero Parameter value with
Biexponential scaling.

The Calculate automatically radio button may also be checked if you would like
to change the gate for calculating the display (Figure 9.65) or if you would like to
change the method for calculation to 5th percentile (Figure 9.66). The Fifth
percentile method sets the plots minimum such that the bottom 5% of the data
within the selected gate is not visible.

Figure 9.65 Choosing a gate for calculating the biexponential
display.

Figure 9.66 Choosing the BD FACSDiva Method or the Fifth
Percentile method for display.

Archsinh Scaling:
ArcSinh is an inverse hyperbolic function most widely used with .fcs files
generated by CyTOF Mass Cytometry. Unlike standard light based flow
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cytometry, mass cytometry can produce many true zero signal ("intensity")
values. An ArcSinh transformation helps display and visualize values at or near
zero with a "spread" as we are accustomed to visualizing with standard flow
cytometry data. ArcSinh values are calculated by applying the ArcSinh equation
to the raw intensity value and dividing by a cofactor. The "cofactor" defines the
size of the linear region around 0, with larger cofactors corresponding to a longer
linear region. (Figure 9.67).

Figure 9.67 - The formula for converting to
Archsinh scaling.

Figure 9.68 - Arcsinh is choosen from the Scale drop down menu. The cofactor
value determines the size of the linear region around 0.

9.6.2

Gating and Axis Scalings
When gates are drawn on a plot, the axis scaling of that plot will become the
scaling of the gate. This means that if a gate is drawn on a plot using a particular
scaling, and then the gate is displayed on a plot with a different scaling, the gate
may appear distorted. The gate may also appear distorted if it is displayed on a
plot with the same scaling, but a different transition point (e.g., a different "Below
zero" parameter for Biexponential scaling). The original scaling that was used
when then gate was drawn will be called the native scaling and the alternative
scale that it is being displayed will be called the non-native scaling.
Figure 9.68 shows an example of how the gate perimeter can appear distorted
when the gate is displayed on a non-native scale. The gate was drawn in linear
scale (shown on the left panel) and then displayed on a log scale (shown on the
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right panel). Notice that the straight lines of the gate borders appear curved in
the log space. This is correct and is caused by the relative distortion introduced
by the log scaling.

Figure 9.69 Warped Gates in Different Scalings

If you move a gate 339 on a plot displaying a non-native space, the shape of the
perimeter of the gate may change as you move the gate, to reflect the mapping
of the scales in the different regions of the plot. There are several considerations
to take into account when moving a gate on a non-native scale. Since the gate
scale is in the native space, the gate may not be able to move to certain
positions on the non-native plot. For instance, assume you created a gate on a
log scale, which has no negative values, and you are now displaying the gate on
a "log with negative" scale, that does have negative values. You will not be able
to move the gate to the area of the plot containing negative values, since the
native scaling (log) does not support negative values.
A more subtle distortion is depicted in the next figure. The gate shown in the right
panel of the figure above (Warped Gates in Different Scalings) was moved to the
position shown in Figure 9.69. It is obvious that the gate no longer appears as a
four-sided polygon.
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Figure 9.70 Distorted Gate in Non-native
Space

The explanation for this can be appreciated by examining the gate in the native
space, seen in Figure 9.70. It is evident that the vertices of the gate (located
near the origins) comprise a very small area of the data space in the native
space. Thus, there is not enough resolution in the native space to accurately
draw and calculate a perimeter, and the perimeter appears distorted in the nonnative space.
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Figure 9.71 Not Enough Resolution in
Native Space

If you are displaying a gate on a non-native scale and wish to change it so that
scale becomes the native scale, simply draw a new gate on the plot with the
non-native scale and replace the existing gate (see Creating Gates 320 ).

9.6.3

Quadrants and Axis Scaling
Linked quadrants 369 will also appear distorted if they are displayed on plots with
different scalings, as shown in Figure 9.71.
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Figure 9.72 Linked Quads Displayed in Non-native Space

9.6.4

Biexponential Scaling Implementation in FCS Express
Biexponential Scale Formula
The biexponential scale formula is defined by the equation1 :

Where x is the value in scaled space, while f(x) is the value in linear space.
In order to generate a formula which is valid for all possible real numbers, we
reflect the scale formula about w when x < w (Equation 2).

By definition,

, so we can simplify Equation 2.

For this equation,
T represents the range of the data in linear space.
m represents the approximate number of decades of scaled space. For
FCS Express, we use the following relation to determine a reasonable
value for m:
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w is the approximate width of the linear data range in scaled space.
o

The limits of values for w are described in the second paper on the
scale formula2 .

At w = 0, the linear region of the scale formula is 0, while at w =
m/2, the linear region extends for the majority of the data range.
p is defined by its relationship to w:

In order to control the width parameter, w, the original paper1 introduced a
separate parameter, the “Below zero value”. This value should be equal to the
most negative values in the data set.

In the original paper, the below zero value, R, is always negative. However, in
FCS Express, we will display the below zero value as a positive value equal to the
absolute value of the paper’s below zero value.
In the second paper describing the biexponential scale formula2 , we should pick a
value of w which is non-negative. Based on this reasoning, we can limit the
values used as the below zero value.

In a standard 18-bit data file, we have T = 262144 and m = 10.3616. In order
to have a non-negative w value,
8.2897.

Invalid below zero values:
The graph of the equation that relates w and p is shown below.
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We can see from the graph that if we require w to be positive, then the value of
p will be greater than 1. In this graph, we can also see that if we relax the
constraint that w is non-negative we can extend the values for w down to a
global minimum at w = -0.5569290855... = wmin
Based on the relationship between R and w, we can define the minimum value of
the below zero value using the following expression.

For example, in a standard 18-bit data file, T = 262144, m = 10.3616, and the
minimum below zero value will be approximately 2.7214.
A graph of the relation between T and Rmin is shown below.
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References:
1. Parks, David R.; Roederer, Mario; Moore, Wayne A. A New ‘‘Logicle’’
Display Method Avoids Deceptive Effects of Logarithmic Scaling for Low
Signals and Compensated Data. Cytometry Part A 2006, 69A, 541–551.
2. Moore, Wayne; Parks, David. Update for the Logicle Data Scale Including
Operational Code Implementations. Cytometry A 2012, 81(4), 273-277.
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Creating and Using Parameter Label Sets
FCS Express allows complete flexibility in labeling the plot axes with whatever
information the user desires. Typically, the plot axis labels are taken from the
FCS file header or are modified during an analysis session. However, sometimes
when acquiring data, the wrong parameter description is entered, or the default
parameter description is not modified, and you need to change the axes labels.
FCS Express allows you to create sets of alternate parameter labels associated
with the FCS file header parameters. When the new parameter label set is
selected during analysis, the alternate parameter label will display on the plot
instead of the parameter label listed in the FCS file header. FCS Express allows
multiple parameter label sets to be defined, each of which is distinguished by a
unique name.
The advantage of a parameter label set is that it allows you to display different
axis information without changing the header of the FCS File. By changing the
plot axis options to use a parameter label set 253 instead of modifying the data in
the FCS File, you can customize the layout the way you want without affecting
your data.
To create a new parameter label set:
1. Select the Tools
Parameter Labels Modify Labels
command.
2. Click ... (ellipsis) button to select or change Template File used.
3. Click the Add Set button.
4. Enter a unique name for the new parameter set and click OK.
5. Click the Add button.
6. Select the parameter to modify.
7. Enter the alternate text in the Label field.
8. Click OK.
9. Continue clicking the Add button to modify additional parameters for this
parameter label set. You can click on a label and modify it (or use the
Remove button to delete it).
10. Click OK to save the set

Figure 10.1 shows a parameter label set named Lymphs that has been created
with eight alternate labels.
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Figure 10.1 Parameter Label Sets

If the axes are set to derive the axis labels from the Lymphs set, whenever
parameter 3 is shown on the plot, the axis label will be CD3 instead of the label
stored in the header of the FCS file. Selecting a set as the default set means that
it will appear by default in the Derive Axis Titles From Parameter label set radio
selection drop-down list of the Format Axes dialog 253 .
Parameter Label Set Lists can be saved to and loaded from a file by selecting the
Tools
Parameter Labels Save Labels or
Tools
Parameter Labels Load Labels commands, respectively.
Parameter labels are automatically saved with the layout file 93 .
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Spreadsheets
Spreadsheets in FCS Express 6 can be used to perform most of the operations
that Microsoft Excel provides. In addition, values in Spreadsheet cells can be
derived directly from statistics within the layout, keywords, or from data files in
the data list. Inserting statistics for data files in the data list allows additional
flexibility in analysis of many statistics for many data files that are not currently
open in the layout.

A Spreadsheet may be added to a layout through the Insert
tab
command.
Once a spread sheet is inserted you may click on the Spreadsheet to select it
84 and
90
which will make the
tabs appear (figures below).
Once data is tabulated, you can display it graphically, using Pie Charts, Bar Charts
and Scatter Plots 534 . For example, Spreadsheets can be used to automate the
process of generating titration curves.
Spreadsheets created within FCS Express may also be exported 534 to various
external file formats such as .xls, .xls, .csv, .html, .xml and .txt.
Formulas, formatting, and references will be preserved when selecting to save in
the .xls or .xlsx file format.
Note: Spreadsheets replace Custom Data tables from previous versions of FCS
Express but have the same capabilities. If you have Custom Data tables saved
from previous versions FCS Express in your layout then FCS Express 6 will allow
you to open them for use. New tables can only be create via the Spreadsheets
feature.
Jump to:
Creating a Spreadsheet 413
Working with Spreadsheets 415
Formatting Spreadsheet Cells 421
Using Spreadsheets to access statistics from files in the Data List 431
Spreadsheet Formula Definitions 438
Using Find and Replace 426
Supported Spreadsheet Keystroke Commands 427
List of and description Spreadsheet Statistics available via drag and drop from the
data list 391
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The Spreadsheet Layout Tab

The Spreadsheet Formulas tab.

Additional Resources:
Tutorials:
HLA Cross matching - Spreadsheet Use Case 1
o Creating a Spreadsheet for analysis
o Populating a Spreadsheet with data
o Working with Custom Tokens and Formula References in spreadsheets
o Using Conditional Formatting to Classify Data
1635

1639

1642

1651

1669

Antibody Titration - Spreadsheets Use Case 2

1675

Calibration via Regression Analysis - Spreadsheets Use Case 3
o Complete a Spreadsheet and Insert a Scatter with Regression Plot
o Working with Regression Tokens and Fit Equations

1702

Working with Pie, Bar, and Scatter Plots - Spreadsheets Use Case 4

1725

1701

1711

11.1

Creating a Spreadsheet
To create a Spreadsheet, use the Insert tab
to bring up the Create new spreadsheet dialog (Figure 11.1).

command

Alternatively, if a Data Navigator 126 is open, you can right-click on the Data
Navigator and choose Create new spreadsheet from the pop-up menu.
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Creating a Spreadsheet from the Insert tab.

Figure 11.1 Create new spreadsheet Dialog

The option for Open Data Grid is selected by default. You can additionally
choose to open the Data Navigator. If the Data Navigator is already open
then the option will be inaccessible.
When you are finished, click OK. The Create new spreadsheet dialog will
disappear. A new spreadsheet will appear on your screen, similar to the image
below.
The cells of spreadsheet may be filled with text, numbers or tokens

415

.

Cells of the spreadsheet may reference each other much like Microsoft Excel
following the same conventions of Excel.
Formulas may be created

438

in the cells much like Microsoft Excel.
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New, Empty Spreadsheet

11.2

Working with Spreadsheets
If you have added a Spreadsheet 413 , the Spreadsheet will appear on the layout
and a node will appear in the Data Navigator with the name you assigned to the
spreadsheet (Figure 11.2). Spreadsheets in FCS Express share much of the
functionality included in Excel with the added benefit of live updating as statistics
or data in your layout changes. A list of some of the common features in Excel
that FCS Express will support are:
Array Formulas
Appearance Customization and Conditional Formatting
Built in Operators and Functions 438
Formula Creation 417 and AutoSum 417
Formatting Cells 421
Find and Replace 426
Comments 422
Sorting 422

Jump to:
Entering text or numeric data in the spreadsheet 417
Creating a formula in a spreadsheet 417
Using AutoSum 417
Referencing cells in a spreadsheet 418
Inserting a Token or Custom Token in a cell 418
Inserting Token Tables 419
Formatting Spreadsheet cells 421
Spreadsheet Cell Value Tokens 721
Analyzing Files from the Data List with Spreadsheets
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o Spreadsheet Statistics Available from Data Files

391

Figure 11.2 An empty spreadsheet open and Data Navigator with New spreadsheet
node.

The spreadsheet may be selected, de-selected, moved, re-sized, copied, and
pasted just like any object in FCS Express 130 .
A spreadsheet that has been copied and pasted will create a duplicate of itself.
Any information that is entered in one of the copies will be updated in the
additional copies. The copies will be visible in the Data Navigator as separate Data
Grids/Spreadsheets under the same node (Figure 11.3) Multiple spreadsheets
may exist in the same layout and will appear as separate nodes in the Data
Navigator (figure below).
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Figure 11.3 - Working with multiple spreadsheets and
copies of spreadsheets in the Data Navigator.

Spreadsheets in FCS Express behave very similarly to Microsoft Excel. Just as in
Excel there are countless features and options that can be performed. We will
cover a few of the basic operations and important points for working with
spreadsheets in FCS Express below.
To enter text or numeric data in the spreadsheet:
1. Click on the cell in the spreadsheet.
2. Begin typing in the cell.
To create a formula in a spreadsheet:
1.
2.
3.
4.

Click on a cell in spreadsheet.
Enter an equals sign "=".
Enter a formula, function, or operator 438 to evaluate.
The cell will return the value of the information entered.

You may select a cell in the spreadsheet and click on the Spreadsheet
tab Formulas. Click on the formula or function 438 to use from the menu and it
will populate the chosen cell as a blank formula.
AutoSum:
Alternatively, you may select a range of cells and choose a command from the
AutoSum drop down (Figure 11.4). The AutoSum command you have chosen
will be calculated across the selected range of data and appear below the final cell
in the data range.
Available AutoSum functions are:
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Sum
Average
Count
Numbers
Min
Max

Sums all values within a given range.
Calculates the average for the values within a given range.
Counts the number of cells containing numbers within a given range.
Excludes counting cells that contains text.
Finds the minimum value in a given range.
Find the maximum value in a given range.

Figure 11.4 - The AutoSum feature is
a convenient tool for quickly
calculating statistics for a range of
values in a spreadsheet.

To reference cells in a spreadsheet:
1.
2.
3.
4.

Click on a cell in a spreadsheet.
Enter an equals sign "=".
Click on a different cell in the spreadsheet that contains data.
The original cell will display the data referenced from the second cell.

To insert a Token or Custom Token in a cell:
1. Right click in the cell.
2. Choose Insert Token.
3. Select a token to insert in the same manner as inserting a token into a text
box 688 .
Alternative 1: Drag and drop a statistic, plot, gate, or other FCS Express item
from which tokens can be derived into a cell (see more about dragging and
dropping tokens and token types 688 )
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The token value, or multiple token values, will appear in one or many cells.
Alternative 2:
1. Click on cell in the spreadsheet.
2. Click on the Spreadsheet tab
3. Choose the token of your choice to insert in the cell.

Token.

Tokens that are present in cells will update in real time as data updates in plots.
Cells that reference other cells or formulas containing token values with also
calculate and update in real time. Please note that tokens can also be used
elsewhere in FCS Express to reference spreadsheet cells 721 .
To insert Token Tables:
Tables in FCS Express from Compensations 622 , Signatures , SOPs , Canned
Comments , and Heat Maps
may be inserted into a spreadsheet by (Figure
11.5):
1086

1208

1102

1048

1. Right clicking in a cell.
2. Choose Insert.
3. Select a token table to insert in the same manner as inserting a token into a
text box 688 .

Figure 11.5 - The available options for inserting tables in a spreadsheet.

11.2.1

Formatting
Spreadsheets may be formatted just like any other object in FCS Express 178 and
contain many of the same formatting options as other objects. When right
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clicking on a Spreadsheet you will be presented with the option to Format or
Format Cells (Figure 11.6). The Format command will allow you to access
formatting commands for the Spreadsheet object itself for items like Name,
Visibility, Border, Size, Authorizations.
The Format Cells command allows you to adjust formatting options specific to
a cell or multiple cells / cell ranges. Please see the next section on Formatting
Spreadsheet cells for additional information 421 .

Figure 11.6 - The right click menu available with spreadsheets.

In addition to standard object formatting options 238 spreadsheets have the
additional formatting option to Use values in a first row as labels (Figure
11.7).
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Figure 11.7 - Choosing to Use values in a first row as labels option.

When the option is turned on by checking the box then the first row in the
spreadsheet will be used as labels in any additional graph types as in figure 11.8
below.

Figure 11.8 - Choosing the Use values in a first row as label option enables bar
plots, pie charts, scatter plots, and scatter with regression plots to use the first
row in the spreadsheet as a data label.
11.2.1.1

Formatting Spreadsheet Cells

Formatting Spreadsheet cells:
Cells or cell ranges within a spreadsheet in FCS Express may be formatted much
as spreadsheets in Microsoft Excel (Figure 11.9).
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Figure 11.9 - The spreadsheet layout tab provides access to a number of
formatting and specialized features for spreadsheets in FCS Express.

The available formatting categories and options from the Layout tab are:
Font
Adjust fonts, font sizes, font styles, font color, and cell borders
Alignment Adjust text alignment for horizontal and vertical placement. Indent
text. Wrap text within cells. Merge and unmerge selected cells.
Tokens
Insert any token from FCS Express. 688
Formattin A range of values may be conditionally formatted 424 or sorted.
g and
Sorting
Cells
Insert or delete rows or columns in the data set. Format cells to
autofit contents, hide or unhide contents, and launch the Format
Cells dialog.
Editing
Clear the contents formatting or contents of cells. Add or remove
freeze panes to the spreadsheet. Create a comment to be
associated with the selected cell or cell range.
Additionally, Number, Alignment, Font, Border, Fill and Protection from cells
or a range of cells may all be adjusted (Figure 11.10). Cells or cell ranges may
be formatted via a right click on the select or via the Spreadsheet tab
tab commands. To format a cell or range of cells:
1.
2.
3.
4.

Select a cell or range of cells to format
Right click within the range.
Choose Format Cells.
Choose the formatting feature you would like to adjust from the available
tabs just as you would do in Excel.
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Figure 11.10 - The Format Cell dialog for spreadsheets in FCS Express. The
formatting contains all of the familiar features and functionality of Microsoft Excel.

Alternatively:
1. Select a cell or range of cells to format
2. Click on the Spreadsheet tab
tab.
3. Choose the formatting item you wish to apply to the cells.
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11.2.1.1.1 Conditional Formatting

Conditional formatting is a tool that allows you to apply different displays in the
form of Color Scales, Data Bars, and Icon sets to a range of cell values.
Conditional formatting may be applied by:
1. Select a range of cells in a Spreadsheet.
2. Click on the Spreadsheet tab
tab
dropdown (Figure 11.11).

Figure 11.11 - Choosing conditional
formatting from the Spreadsheets-->
Layout tab.

3. Choose the type of display from Color Scales, Data Bars, and Icon Sets.
4. Choose the sub-type of conditional formatting you wish to apply.
The conditional formatting you choose will be applied to the range of cells. Below
is an example of some conditional formatting options applied to a range of data
Figure 11.12.
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Figure 11.12 - A variety of conditional formatting options applied to a series of
data.

The conditional formatting is based on a series of rules which may be managed
by clicking on the Spreadsheet tab
tab
dropdown
command. From
within the Conditional Formatting Rules Manager you may select Edit Rule
to adjust how color scales, bars, and icon sets values are determined.

11.2.2

Spreadsheet Cells
Cells in a spreadsheet allow you to manually enter values, text, formulas or
information derived from tokens 415 . Individual cells or cell ranges may be
formatted and also contain properties unique to FCS Express in that tokens may
exist and be referenced within a cell 418 . Conversely, Spreadsheet Cell Values 721
may be inserted and used as tokens within text boxes and batch processing 721 .

Values that currently exist in a cell can be easily moved to a different cell by:
1. Click and hold on the blue square in the lower right portion of the cell to
be referenced (Figure 11.13 below).

Figure 11.13- Clicking and holding on the blue square on the bottom right of the cell
allows you to drag the cell to a new location in the spreadsheet.

2. Drag the cell to the new cell position in the spreadsheet where you
would like it to appear.
3. Release the mouse button to place the cell.
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Cell values can be copied down much as you would in Excel to quickly populate a
range of cells. To copy a cell down:
1.
2.
3.
4.

Select the originating cell by clicking on it.
Press Cntrl+C to copy.
Select the range of cells to copy down including the originating cell.
Press Cntrl+D to copy down over the range of selected cells.

Right clicking in a Spreadsheet cell reveals options to insert tokens 699 , format
cells 421 , and format tokens. If you have already inserted a token in a
spreadsheet cell you may format that token by:
1. Right click in the cell that contains the token.
2. Choose Format Token.
The token type
desired.

11.2.3

699

that is included in the cell may now be edited and changed as

Find and Replace
Spreadsheets in FCS Express support Find and Find and Replace functionality. To
access Find and Find and Replace:
1. Click on a spreadsheet or select a range of cells.
2. Press Control+F.
The Find and Replace dialog will appear.
In the Find tab:
1. Enter a value or text to find within the spreadsheet or selected range.
2. Click Find All or Find Next.
If matching values or text is found the spreadsheet will highlight the cell in which
the information has been found.
The Options button allows you to further designate search terms and locations.
In the Replace tab:
1. Enter a value or text to find within the spreadsheet or selected range in the
Find what area.
2. Enter a value or text to replace the found item in the Replace with area.
a. Click Find All or Find Next to jump to the next found values.
b. Click Replace All or Replace to replace the found values with the values
indicated in the Replace with area.

The Options button allows you to further designate search terms and locations.
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Supported Keystrokes
Supported Keystrokes
The Spreadsheets tool in FCS Express provides a familiar Excel-like environment,
including multiple corresponding keyboard support. The Spreadsheets tool
supports over 70 keys and key combinations available in Microsoft Excel. All
currently supported keyboard controls are listed in the following table:
Key/Key Description
Combinati
on
Pressing an arrow key produces different effects depending on what
object is selected and/or focused (highlighted) in the Spreadsheet
control:
If a cell is focused, pressing the Left, Up, Right, or Down key
moves focus to the left, top, right, or bottom adjacent cell;
Arrow
If a cell range is selected, pressing the Left, Up, Right, or Down
Keys
arrow key clears the selection and shifts focus by one cell in
the respective direction;
If the focused cell is located at the left, top, right, or bottom
edge of the worksheet area, pressing the Left, Up, Right, or
Down key does not move focus;
Del
Pressing the Del key destroys all cell objects within all selected areas.
End
Moves focus to a cell following the rightmost cell object within the
same row. If there are no cell objects in this row, the focus is
moved to its first (i.e., the leftmost) cell.
Enter /
Pressing the Enter key or the Shift+Enter key combination produces
Shift
different effects depending on what object is selected and/or
+Enter
focused in the Spreadsheet control:
If a cell is focused within a worksheet, pressing the Enter key
moves focus to the next (i.e., underlying) cell within the same
column. If the last cell in a column is focused, the Enter key
moves focus to the topmost cell in the next (i.e., the right
adjoining) column. If the last cell in the last (i.e., the
rightmost) column is focused, pressing the Enter key sets the
focus to the top cell in the worksheet's leftmost column.
If a cell range is selected, pressing the Enter key moves cell
focus within the range's boundaries in the same manner as
described above. In the case of multiple selected cell ranges,
the Enter key consecutively moves cell focus through all
selected areas in the ascending order of their indexes within
the worksheet's collection of selections.
Both the Enter key and the Shift+Enter key combination close an inplace cell editor accepting its current contents as a new cell value.
The cell focus shifts identically to the cases described above. The
Shift+Enter key combination moves focus identically to the Enter
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key but in the opposite direction.
If an in-place editor is open, pressing the Esc key closes it and
discards its current value.
F2
Opens an in-place editor for the focused cell.
F9
Recalculates all formula expressions within the current spreadsheet
document.
Home
Moves cell focus to the leftmost (i.e., the first) cell in the current
row.
Page
Moves cell focus to the next cell containing data in the column below
Down
the current focus. If no data is present, moves cell focus to last row
in the spreadsheet.
Page Up Moves cell focus to the next cell containing data in the column above
the current focus. If no data is present, moves cell focus to first row
in the spreadsheet.
Tab / Shift Pressing the Tab key or the Shift+Tab key combination produces
+Tab
different effects depending on what object is selected and/or
focused in the Spreadsheet control:
If a cell is focused within a worksheet, pressing the Tab key
moves focus to the next (i.e., the right adjoining) cell within
the same row. If the last cell in a row is focused, the Tab key
moves focus to the first cell on the next (i.e., the lower
adjacent) row. If the last cell in the last row is focused,
pressing the Tab key sets the focus to the first cell in the
worksheet's topmost row.
If a cell range is selected, pressing the Tab key moves the cell
focus within the range's boundaries in the same manner as
described above. In the case of multiple selected cell ranges,
the Tab key consecutively moves the cell focus through all
selected areas in the ascending order of their indexes within
the active Table View worksheet's collection of selections.
Both the Tab key and the Shift+Tab key combination close an
in-place cell editor, accepting its current contents as a new cell
value. The cell focus shifts identically to the cases described
above.
The Shift+Tab key combination moves focus identically to the Tab
key but in the opposite direction.
Alt+Enter When editing the contents of a cell, starts a new line within the open
in-place cell editor.
Ctrl+;
Enters the current date into the focused cell.
Ctrl+`
With a cell in edit mode, switches between displaying formula
expressions and their calculated results in the active worksheet.
Ctrl+'
Copies the formula expression to the focused cell from the adjacent
cell above.
Ctrl+1
Displays the Format Cells dialog for the current cell selection.
Ctrl+2 / Adds/removes the bold attribute to/from the font used to display
Ctrl+B
the contents of the current cell selections.
Ctrl+3 / Adds/removes the italic attribute to/from the font used to display
Esc
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the contents of the current cell selections.
Adds/removes the underline attribute to/from the font used to
display the contents of the current cell selections.
Adds/removes the strikeout attribute to/from the font used to
display the contents of the current cell selections.
Ctrl+9
Hides all rows that intersect the current cell selection area.
Ctrl+0
Hides all columns that intersect the current cell selection area.
Ctrl+A
Selects all cells within the active worksheet.
Ctrl
Moves focus to the nearest cell object within the current row or
+Arrow
column (i.e., the Ctrl+Left, Ctrl+Up, Ctrl+Right, or Ctrl+Down key
Keys
combination moves focus to the nearest cell object located to the
left, above, to the right, and below the currently focused cell). If
there are no cell objects on the supposed path of the cell focus, it is
moved to the last cell on the respective worksheet's edge (i.e., left,
top, right, or bottom, depending on a specific arrow key pressed).
Ctrl+C / Copies the current cell selection to the clipboard. If there are multiple
Ctrl
selections then the full area between the top left cell of those
+Insert
selections and the bottom right cell of the selections will be copied to
the clipboard.
Ctrl+D
Populates the currently selected cell range with both the contents
and style of its topmost cell (if the range's width does not exceed a
single cell) or row.
Ctrl+End Cancels the current cell selection and moves cell focus to the
bottom-right corner of the Dimensions area. Previous cell focus
position is irrelevant. If there are no cell objects within the active
worksheet, pressing this key combination moves cell focus to the
topmost cell in the worksheet's first column.
Ctrl+F
Invokes the Find and Replace dialog with the activated Find tab.
Ctrl+H
Invokes the Find and Replace dialog with the activated Replace tab.
Ctrl
Cancels the current cell selection and moves the cell focus to the
+Home
upper-left (origin) cell of the active worksheet.
Ctrl+K
Displays the Insert Hyperlink dialog for new hyperlinks or the Edit
Hyperlink dialog for a previously created hyperlink. You can add
hyperlinks to both the cells and floating containers, including
comments.
Ctrl+Page Switches between the currently visible worksheets, consecutively
Down
activating their respective tabs from left to right in the caption bar. If
the rightmost worksheet tab is already active, pressing this key
combination has no effect. The Ctrl+Page Up key combination
consecutively activates the currently visible worksheets in reverse.
Ctrl+Page Switches between the currently visible worksheets, consecutively
Up
activating their respective tabs from right to left in the caption bar. If
the leftmost worksheet tab is already active, pressing this key
combination has no effect. The Ctrl+Page Down key combination
consecutively activates the currently visible worksheets in reverse.
Ctrl+R
Populates the currently selected cell range with both the contents
and style of its leftmost cell (if the range's height does not exceed a
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single cell) or column.
Ctrl+Shift Applies the outline border to the currently focused cell or selected
+7
cell range(s). This key combination is a direct counterpart of the Ctrl
+Shift+_ key combination.
Ctrl+Shift Returns the outline border of the currently focused cell or a selected
+_
cell range to its original state. This key combination is a direct
counterpart of the Ctrl+Shift+& key combination.
Ctrl+Shift Applies the General number format to data within the currently
+~
focused cell or selected cell range(s).
Ctrl+Shift Applies the Currency number format to data within the currently
+4
focused cell or selected cell range(s).
Ctrl+Shift Applies the Percentage number format to data within the currently
+5
focused cell or selected cell range(s).
Ctrl+Shift Applies the Scientific number format to data within the currently
+6
focused cell or selected cell range(s).
Ctrl+Shift Applies the Date number format to data within the currently focused
+3
cell or selected cell range(s).
Ctrl+Shift Applies the Time number format to data within the currently focused
+2
cell or selected cell range(s).
Ctrl+Shift Applies the Number format (that has two decimal places, thousands
+1
separator, and minus sign (-) for negative values) to the data within
the currently focused cell or selected cell range(s).
Ctrl+Shift Selects the current region around the focused cell (the area enclosed
+8
by blank rows and columns containing uninitialized cells).
Ctrl+Shift Enters the current time into the focused cell.
+:
Ctrl+Shift Copies the value to the currently focused cell from the adjacent cell
+“
above.
Ctrl+Shift Extends the selected cell range to the bottom-right corner of the
+End
Dimensions area, i.e., to the cell object with the largest row and
column index values.
Ctrl+Shift Accepts the changes made in an in-place cell editor and closes it,
+Enter
leaving the current cell focused. If an in-place editor was used to
enter a formula expression, this key combination chooses the array
formula variant of the function, if applicable.
Ctrl+Shift Extends the selected cell range to the active worksheet's upper-left
+Home
cell.
Ctrl
Displays the Delete dialog for deleting cells, rows, and columns at the
+Minus(–) currently focused cell or selected cell range.
Ctrl+Shift Selects all cell objects that have an associated comment container in
+O
the currently active worksheet.
Ctrl
Displays the Insert dialog for inserting cells, rows, and columns at
+Plus(+) the currently focused cell or selected cell range.
Ctrl
Selects an entire column whose cell object is currently focused. This
+Spacebar key combination works even if there are no cell or column objects
created within the active worksheet.
Ctrl+V / Pastes the current clipboard content into the active worksheet.
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Shift
+Insert
Ctrl+X / Pressing this key combination results in moving (cutting) to the
Shift+Del clipboard both the cell data and associated styles from the currently
focused cell or a selected cell range.
Shift
This key combination expands the currently selected cell range by
+Arrow
one cell, row, or column depending on the area's shape and the
Keys
actual arrow key pressed. If there are several selected cell ranges
within the active worksheet, this key combination expands only the
last selected cell or cell range.
Shift
Selects the entire row that intersects the cell selection in which the
+Spacebar cell focus is currently located.

11.3

Analyzing Files from the Data List with
Spreadsheets
Spreadsheets may be used to quickly analyze and compare statistics for many
data files from the data list without opening additional plots or creating a batch
process.
After data files have been loaded into the data list 783 , the data files may
individually or multiple selected in the data list, dragged and dropped onto a
spreadsheet, and the information or statistics to display will be inserted into the
spreadsheet cells. If plots exist on the layout you may choose to derive statistics
from gates and as gates are adjusted the values in the spreadsheet will update in
real time.
Watch the short video below or review the written steps to learn how to use this
feature.

© 2020 De Novo Software

432

FCS Express 6 Manual

In FCS Express 6 the Spreadsheet feature may be used to quickly
analyze and compare statistics for many data files from the data list
without opening additional plots or creating a batch process. Watch
this short overview to learn about the new feature.

To analyze files from the data list in a spreadsheet:
1. Create a spreadsheet 413 in the layout.
2. Open the data list 783 . (Figure 11.14)
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Figure 11.14 - A layout with spreadsheet created and data list opened.

3. Multiple select data files from the data list.
4. Drag and drop data files from the data list into the first cell in the spreadsheet
that you would like statistics to appear (Figure 11.15).
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Figure 11.15 - Dragging and dropping data files from the data list into a cell in the
spreadsheet.

5. Select Statistic Token or Keyword Token in the Paste Special dialog. In
this example, Statistic Token has been selected.
6. Select the appropriate parameter for the statistic from the Parameter drop
down in the Edit Statistic dialog (Figure 11.16).
Note - a parameter must be selected regardless of the statistic you choose to
insert
7. Select a compensation or choose Default or None from the Compensation
drop down.
Note: by setting Default from the Compensation drop down, the default option
for compensation 641 specified in the User Options will be used.
8. Select a gate from the Select Gate drop down if needed.
9. Select one or multiple statistics from the Statistic list (Figure below).
NOTE: The values present in a Spreadsheet for data derived from the data
list will reflect the values associated with the data file/iteration and will update
in real time.
However, in some situations a "fixed" or static value from a
particular data file(s)/iteration(s) may be useful to insert in a Spreadsheet.
For instance, if you would like
to derive the mean from an Isotype
control or any other statistic when batch processing. When the having a static
or fixed value from a data file or iteration is
necessary, the
statistics added to the spreadsheet can be made independent from the
iteration selected. In other words, the statistics will not change while batch
processing or changing through different iterations.
To "fix" a value in the spreadsheet to prevent allowing the value
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associated with the data file/iteration to change click on the Data Source
category on the left of
the the Create Statistic window after dragging and
dropping a data file from the data list into the spreadsheet and uncheck the
Allow the Data file of this token
to change when running Next/Prev/Batch Processing option as seen
in the image below. This option is always available for statistics added by
dragging and
dropping files from the Data List to the spreadsheet, and can be accessed
by right clicking on a spreadsheet cell and by selecting Format Token (the Edit
Keyword
or the Edit Statistic dialog will open and the Data Source category will be
available on the left). However, by unchecking the option during the initial drag
and drop
action (i.e. before Step 10 below), the option will apply to all of the
data files/iterations at once.

Statistics within the spreadsheet can be made independent from the currently
loaded iteration by unchecking the "Allow the Data file of this token to change
when running Next/Prev/Batch Processing" option.

10.Click OK.

© 2020 De Novo Software

436

FCS Express 6 Manual

Figure 11.16 - Selecting the parameter, compensation, and statistics to insert in
the spreadsheet cells.

The statistics 391 for all of the data files you selected from the data list will appear
in the spreadsheet and will update in real-time as gates are adjusted (Figure
11.17).
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Figure 11.17 - Statistics for all of the data files selected will appear in the
spreadsheet.

If additional statistics or statistics from different parameters are needed repeat
the steps above. In the example below additional columns were added for gated
statistics (Gate 1) and statistics from different parameters (Median CD8) (Figure
11.18).
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Figure 11.18 - Spreadsheet displaying statistics from 9 data files from different
gated populations and parameters. Statistics will update in real time as gates are
adjusted.

11.4

Spreadsheet Formula Definitions
Spreadsheets in FCS Express use many of the formulas, functions, and operators
with which you are familiar in Excel. Please reference the list of functions and
operators below for use in FCS Express. Please also note when implementing a
formula below, the delimiter used in list separation may not be a comma based
on the computer's regional settings (i.e. replacing the comma with a semi-colon
may be necessary to execute the function).
The built-in operators and functions for Spreadsheets can be divided into these
groups:
Compatibility Functions 439
Arithmetic Operators 451
Logical Operators 451
Logical Functions 452
Lookup and Reference Functions
Arithmetic Functions 465
Financial Functions 515
Statistical Functions 476
Date and Time Functions 521
Text Functions 526

454
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Compatibility Functions
Compatibility functions have been replaced with new functions that may provide
improved accuracy and whose names better reflect their usage. These functions
are still available for compatibility reasons. However, if backward compatibility is
not mandatory, you should consider using the new functions from now on,
because they offer more accuracy and better functionality.

Mnemonic Accepted
s
Parameters
(Operand
Types)

Example

Explanation

BETADIST Accepts three
=BETADIST(X, Returns the beta cumulative
obligatory
Alpha, Beta, [A], distribution function.
parameters:
[B])
If any specified parameter is not
The value at
numeric, the BETADIST function
which the
returns the #VALUE! error value. If
BETADIST
either the Alpha or Beta parameter
function
is not positive, BETADIST returns
performs
the #NUM! error value. If X < A, X
evaluation (X)
> B, or A = B, BETADIST returns
and two
the #NUM! error value. If you omit
parameters of
the A and B parameter values,
the calculated
BETADIST uses the standard
distribution
cumulative beta distribution, so
(Alpha and
that A = 0 and B = 1.
Beta).
BETADIST is a deprecated
Optionally, you
function. For information about its
can pass the
new version, refer to the
lower and upper
BETA.DIST function description.
bounds of the
interval as the A
and B
parameters,
respectively.
BETAINV
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obligatory
parameters:
The value at
which the
BETAINV

=BETAINV(Prob Returns the inverse of the
ability, Alpha,
cumulative distribution function for
Beta, [A],[B])
a specified beta distribution.
If any parameter is non numeric,
the BETAINV function returns the
#VALUE! error code. If alpha or
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function
performs
evaluation; and
two parameters
of the calculated
distribution
(Alpha and
Beta).
As with the
BETADIST
function, you
can also pass
the lower and
upper bounds of
the interval as
the A and B
parameters,
respectively.
BINOMDI Accepts four
ST
obligatory
parameters:
The number of
successes in
trials
(NumberS), the
number of
independent
trials (Trials),
the probability
of success on
each trial
(ProbabilityS),
and a logical
value that
determines the
form of the
function
(Cumulative).
CHIDIST

beta are not positive, BETAINV
returns the #NUM! error code. If
Probability < 0 or Probability > 1,
BETAINV returns the #NUM! error
code. If you omit the A and B
parameter values, BETAINV uses
the standard cumulative beta
distribution, so that A = 0 and B =
1.
BETAINV is a deprecated function.
For information about its new
version, refer to the BETA.INV
function description.

=BINOMDIST(Nu Returns the individual term
mberS, Trials,
binominal distribution probability.
ProbabilityS,
The NumberS and Trials
Cumulative)
parameter values are truncated to
integers. If the NumberS, Trials, or
ProbabilityS parameter value is not
numeric, the BINOMDIST function
returns the #VALUE! error code. If
NumberS < 0 or NumberS > trials,
BINOMDIST returns the #NUM!
error code. If ProbabilityS < 0 or
ProbabilityS > 1, BINOMDIST
returns the #NUM! error code.
BINOMDIST is a deprecated
function. For information about its
new version, refer to the
BINOM.DIST function description.

Accepts two
=CHIDIST(X,
obligatory
DegFreedom)
parameters: the
value at which
you want to
evaluate the
distribution (X)
and the number

Returns the one-tailed probability
of the chi-squared distribution.
If either parameter is not numeric,
the CHIDIST function returns the
#VALUE! error code. If X is
negative, CHIDIST returns the
#NUM! error code. If the
DegFreedom parameter is not an
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freedom
(DegFreedom).

CHIINV

COVAR
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integer, it is truncated.
CHIDIST is a deprecated function.
For information about its new
versions, refer to the CHISQ.DIST
and CHISQ.DIST.RT function
descriptions.
Accepts two
=CHIINV(Probab Returns the inverse of the oneobligatory
ility,
tailed probability of the chi-squared
parameters: a DegFreedom)
distribution.
probability
If either parameter is not numeric,
associated with
the CHIINV function returns the
the chi-squared
#VALUE! error code. If Probability
distribution
< 0 or Probability > 1, CHIINV
(Probability)
returns the #NUM! error code. If
and the number
the DegFreedom is not an integer,
of degrees of
it is truncated. If DegFreedom < 1,
freedom
CHIINV returns the #NUM! error
(DegFreedom).
value.
CHIINV is a deprecated function.
For information about its new
versions, refer to the CHISQ.INV
and CHISQ.INV.RT function
descriptions.
Accepts two
=COVAR(Array1 Returns covariance, the average of
obligatory
,Array2)
the products of deviations for each
parameters: the
data point pair in two data sets.
first and second
The parameters must either be
cell ranges of
numbers or be names, arrays, or
integers (Array1
references that contain numbers.
and Array2).
If the array or reference
parameter contains text, logical
values, or empty cells, those
values are ignored; however, cells
with zero values are taken into
account.
If Array1 and Array2 have different
numbers of data points, COVAR
returns the #N/A error value.
If either Array1 or Array2 is
empty, the COVAR function
returns the #DIV/0! error code.
COVAR is a deprecated function.
For information about its new
versions, refer to the
COVARIANCE.P and
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COVARIANCE.S function
descriptions.
EXPONDIS Accepts three
=EXPONDIST(X, Returns the exponential
T
obligatory
Lambda,
distribution.
parameters: the Cumulative)
If cumulative is TRUE,
value of the
EXPONDIST returns the
function (X),
cumulative distribution function;
the Lambda
otherwise – returns the probability
parameter, and
density function.
the logical value
that specifies
If the X or Lambda parameter is
which form of
not numeric, the EXPONDIST
the exponential
function returns the #VALUE!
function to
error code.
provide
If the X parameter is negative,
(Cumulative).
EXPONDIST returns the #NUM!
error code.
If the Lambda parameter is not
positive, EXPONDIST also
returns the #NUM! error value.
EXPONDIST is a deprecated
function. For information about
its new version, refer to the
EXPON.DIST function
description.
GAMMADI Accepts four
=GAMMADIST(X Returns the gamma distribution.
ST
obligatory
, Alpha, Beta,
You can use this function to study
parameters: the Cumulative)
variables that may have a skewed
value at which
distribution. The gamma
you want to
distribution is commonly used in
evaluate the
queuing analysis.
distribution (X),
If the Beta parameter is 1, the
two parameters
GAMMADIST function returns the
of the
standard gamma distribution.
distribution
If the X, Alpha, or Beta parameter
(Alpha and
is not numeric, GAMMADIST
Beta), and the
returns the #VALUE! error code.
cumulative
If the X parameter is negative,
logical value
GAMMADIST returns the #NUM!
(Cumulative).
error code.
If either the Alpha or Beta
parameter is not positive, the
GAMMADIST function returns the
#NUM! error code.
GAMMADIST is a deprecated
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GAMMAIN Accepts three
=GAMMAINV(Pr
V
obligatory
obability, Alpha,
parameters: the Beta)
probability
associated with
the gamma
distribution
(Probability),
and two
parameters of
the distribution
(Alpha and
Beta).

HYPGEOM Accepts four
=HYPGEOMDIST
DIST
obligatory
(SampleS,
parameters: the SampleSize,
number of
PopulationS,
successes in the PopulationSize)
sample
(SampleS), the
size of the
sample
(SampleSize),
the number of
successes in the
population
(PopulationS),
and the
population size
(PopulationSize)
.
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function. For information about its
new version, refer to the
GAMMA.DIST function description.
Returns the inverse of the gamma
cumulative distribution. You can
use this function to study a
variable whose distribution may be
skewed.
If the Beta parameter is 1, the
GAMMAINV function returns the
standard gamma distribution.
If text is passed as any of the
parameters, GAMMAINV returns
the #VALUE! error code.
If Probability < 0 or Probability >
1, the GAMMAINV function returns
the #NUM! error code.
If either the Alpha or Beta
parameter is not positive, the
GAMMAINV function returns the
#NUM! error code.
GAMMAINV is a deprecated
function. For information about its
new version, refer to the
GAMMA.INV function description.
Returns hypergeometric
distribution. The HYPGEOMDIST
function returns the probability of a
given number of sample
successes, given the sample size,
population successes, and
population size.
All parameters are truncated to
integers.
If any parameter is non-numeric,
the HYPGEOMDIST function returns
the #VALUE! error value.
If the SampleS parameter is
negative or SampleS is greater
than the lesser of SampleSize or
PopulationSize, the HYPGEOMDIST
function returns the #NUM! error
value.
If SampleS is less than the larger
of 0 or (SampleSize –
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PopulationSize + PopulationS), the
HYPGEOMDIST function returns the
#NUM! error value.
If the SampleSize parameter is not
positive or SampleSize >
PopulationSize, the HYPGEOMDIST
function returns the #NUM! error
value.
If PopulationS is not positive or
PopulationS > PopulationSize,
HYPGEOMDIST returns the #NUM!
error value.
If the PopulationSize parameter is
not positive, HYPGEOMDIST
returns the #NUM! error value.
NORMDIS Four obligatory =NORMDIST(X, Returns the normal cumulative
T
parameters: the Mean,
distribution. This function has a
value for which StandardDev,
very wide range of applications in
you want the
Cumulative)
statistics, including hypothesis
distribution, the
testing.
arithmetic mean
If mean or standard_dev is nonof the
numeric, NORMDIST returns the
distribution, the
#VALUE! error value.
standard
If standard_dev is not positive,
deviation of the
NORMDIST returns the #NUM!
distribution, and
error value.
the logical value
If mean = 0, standard_dev = 1,
that specifies
and cumulative = True,
the form of the
NORMDIST returns the standard
function.
normal distribution, NORMSDIST.
If cumulative =
True,
NORMDIST
returns the
cumulative
distribution
function.
Otherwise,
NORMDIST
returns the
standard normal
distribution,
NORMSDIST.
NORMSDI The value for
=NORMSDIST(z Returns the inverse of the normal
ST
which you want )
cumulative distribution. The
distribution has a mean of 0 (zero)
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the distribution
is passed as the
z parameter.

NORMSIN The probability
V
value
corresponding
to the normal
distribution is
passed as the
probability
parameter.
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and a standard deviation of one.
Use this function in place of
standard normal curve areas.
If z is non-numeric, NORMSDIST
returns the #VALUE! error value.
=NORMSINV(pr Returns the inverse of the
obability)
standard normal cumulative
distribution. The distribution has a
mean of zero and a standard
deviation of one.
Given a value for probability,
NORMSINV seeks that value z that
NORMSDIST(z) = probability.
Thus, precision of NORMSINV
depends on precision of
NORMSDIST. NORMSINV uses an
iterative search algorithm. If the
search is not converged after 100
iterations, the function returns the
#N/A error value.
If probability is non-numeric,
NORMSINV returns the #VALUE!
error value.
If probability is not positive or
exceeds 1, NORMSINV returns the
#NUM! error value.

PERCENTI Two obligatory =PERCENTILE(ar Returns the k-th percentile of
LE
parameters: the ray, k)
values in a range. You can use this
array or range
function to establish a threshold of
of data that
acceptance. For instance, you can
defines relative
decide to examine candidates who
standing and the
score above the 90th percentile.
percentile value
If k is non-numeric, PERCENTILE
in the range
returns the #VALUE! error value.
0..1, inclusive.
If k < 0 or k > 1, PERCENTILE
returns the #NUM! error value.
If k is not a multiple of 1/(n – 1),
PERCENTILE interpolates to
determine the value at the k-th
percentile.
POISSON Three obligatory =POISSON(x,
parameters: the mean,
number of
cumulative)
events, the
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Returns the Poisson distribution. A
common application of the Poisson
distribution is predicting the
number of events over a specific
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expected
numeric value,
and the logical
value that
specifies the
form of the
probability
distribution
returned.
If cumulative is
True, POISSON
returns the
cumulative
Poisson
probability that
the number of
random events
occurring will be
between zero
and x inclusive.
Otherwise, the
POISSON
function returns
Poisson mass
function that the
number of
events occurring
will be exactly x.

time, such as the number of cars
arriving at a toll plaza in 1 minute.
If x is not an integer, it is
truncated.
If x or mean is non-numeric,
POISSON returns the #VALUE!
error value.
If x is negative, POISSON returns
the #NUM! error value.
If mean is negative, POISSON
returns the #NUM! error value.

QUARTILE Two obligatory =QUARTILE(arra Returns the quartile of a data set.
parameters: the y, quart)
Quartiles are often used in sales
array of cell
and survey data to divide
range of
populations into groups. For
numeric values
instance, you can use QUARTILE to
for which you
find the top 25 percent of incomes
want the
in a population.
quartile value,
If array is empty, QUARTILE
and the quart
returns the #NUM! error value.
value that
If quart is not an integer, it is
indicates which
truncated.
value to return.
If quart is negative or if quart > 4,
quart = 0
QUARTILE returns the #NUM! error
corresponds to
value.`
the minimum
MIN, MEDIAN, and MAX return the
value;
same value as QUARTILE when
quart = 1
quart is equal to 0 (zero), 2, and
corresponds to
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the first quartile
(25th
percentile);
quart = 2
corresponds to
the median
value (50th
percentile);
quart = 3
corresponds to
the third quartile
(75th
percentile);
quart = 4
corresponds to
the maximum
value.

4, respectively.

RANK

Three
=RANK(number,
parameters: the ref, [order])
number whose
rank you want
to find, an array
of, or a
reference to, a
list of numbers.
Non-numeric
values in ref are
ignored. As an
option, you can
specify the
sorting order as
the order
parameter.

Returns the rank of a number in a
list of numbers. The rank of a
number is its size relative to other
values in a list (i.e. if you were to
sort the list, the rank of the
number would be its position).
If order is 0 (zero) or omitted,
the ExpressSpreadSheet ranks
number as if ref were a list sorted
in descending order.
If order is any nonzero value, the
ExpressSpreadSheet ranks
number as if ref were a list sorted
in ascending order.

STDEV

The one
=STDEV(number Estimates standard deviation
obligatory
1, [number2], based on a sample. The standard
parameter: the …)
deviation is a measure of how
first number
widely values are dispersed from
corresponding
the average value (the mean).
to a sample of a
STDEV assumes that its
population. As
parameters are a sample of the
an option, you
population. If your data represents
can specify from
the entire population, then
2 to 255
compute the standard deviation
parameters
using STDEVP.
corresponding
STDEV calculates the standard
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to a sample of a
population. It is
also possible to
use a single
array or a
reference to an
array instead of
parameters
separated by
commas.

deviation by using the "n – 1"
method.
Parameters can either be numbers
or names, arrays, or references
that contain numbers.

STDEVP

The one
=STDEVP(numb
obligatory
er1, [number2],
parameter: the …)
first number
corresponding
to a sample of a
population. As
an option, you
can specify from
2 to 255
parameters
corresponding
to a sample of a
population. It is
also possible to
use a single
array or a
reference to an
array instead of
parameters
separated by
commas.

Calculates standard deviation
based on the entire population.
The standard deviation is a
measure of how widely values are
dispersed from the average value
(the mean).
STDEVP assumes that its
parameters are the entire
population. If your data represents
a sample of the population, then
compute the standard deviation
using STDEV.
STDEVP calculates the standard
deviation by using the "n" method.
Parameters can either be numbers
or names, arrays, or references
that contain numbers

TDIST

Three obligatory =TDIST(x,
parameters: the deg_freedom,
numeric value at tails)
which to
evaluate the
distribution, the
number of
degrees of
freedom, and
the number of
distribution tails
to return. If Tails
= 1, TDIST
returns the one-

Returns the Percentage Points
(probability) for the Student tdistribution where a numeric value
(x) is calculated value of t for
which the Percentage Points are to
be calculated. The t-distribution is
used in the hypothesis testing of
small sample data sets. Use this
function in place of a table of
critical values for the t-distribution.
If any parameter is non-numeric,
TDIST returns the #VALUE! error
value.
If Deg_freedom < 1, TDIST returns
© 2020 De Novo Software
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tailed
distribution. If
Tails = 2, TDIST
returns twotailed
distribution.

the #NUM! error value.
The Deg_freedom and Tails
parameters are truncated to
integers.
If Tails is any value other than 1 or
2, TDIST returns the #NUM! error
value.
If x < 0, then TDIST returns the
#NUM! error value.
If Tails = 1, TDIST is calculated as
TDIST = P(X > x), where X is a
random variable that follows the tdistribution. If Tails = 2, TDIST is
calculated as TDIST = P(|X| > x) =
P(X > x or X < -x).
Since the negative x values are not
allowed, to use the TDIST function
with x < 0, note that TDIST(x,df,1) = 1 – TDIST(x,df,1) = P(X
> -x) and TDIST(-x,df,2) =
TDIST(x,df,2)=P(|X| > x).

TINV

Two obligatory =TINV(probabilit
parameters: the y,
probability
deg_freedom)
associated with
the two-tailed
Student’s tdistribution and
the number of
degrees of
freedom with
which to
characterize the
distribution.

Returns the inverse of the
Student’s t-distribution.
If either parameter is non-numeric,
TINV returns the #VALUE! error
value.
If probability <= 0 or if probability
> 1, TINV returns the #NUM! error
value.
If deg_freedom < 1, TINV returns
the #NUM! error value.
TINV returns that value t, such
that P(|X| > 1) = probability
where X is a random variable that
follows the t-distribution and P(|X|
> t) = P(X < -t or X > t).

VAR

The first number =VAR(number1,
parameter
[number2],…)
corresponding
to a sample of a
population is
obligatory.
Optionally, you
can specify from

Estimates variance based on a
sample.
VAR assumes that its parameters
are a sample of the population. If
your data represents the entire
population, then calculate the
variance by using VARP instead.
Parameters can either be numbers
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to 2 to 255
number
parameters
corresponding
to a sample of a
population.

VARP

or names, arrays, or references
that contain numbers.
Logical values, and text
representations of numbers that
you type directly into the list of
parameters are counted.
If an parameter is an array or
reference, only numbers in that
array or reference are counted.
Empty cells, logical values, text, or
error values in the array or
reference are ignored.
Parameters that are error values
or text cannot be translated into
numbers cause errors.

The first number =VARP(number1 Calculates variance based on the
parameter
, [number2],…) entire population.
corresponding
VARP assumes that its parameters
to a sample of a
are the entire population. If your
population is
data represents a sample of the
obligatory.
population, then compute the
Optionally, you
variance by using VAR instead.
can specify from
Parameters can either be numbers
to 2 to 255
or names, arrays, or references
number
that contain numbers.
parameters
Logical values, and text
corresponding
representations of numbers that
to a population.
you type directly into the list of
parameters are counted.
If an parameter is an array or
reference, only numbers in that
array or reference are counted.
Empty cells, logical values, text, or
error values in the array or
reference are ignored.
Parameters that are error values
or text that cannot be translated
into numbers cause errors.

WEIBULL Four obligatory =WEIBULL(x,
parameters: the alpha, beta,
value at which cumulative)
to evaluate the
function, the
alpha and beta
parameters to

Returns the Weibull distribution.
Use this distribution in reliability
analysis, such as calculating a
device’s mean time to failure.
If x, alpha, or beta is non-numeric,
WEIBULL returns the #VALUE!
error value.
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the distribution,
and the
cumulative
logical value
that determines
the form of the
function.

451

If x is negative, WEIBULL returns
the #NUM! error value.
If alpha or beta is not positive,
WEIBULL returns the #NUM! error
value.

Arithmetic Operators

Arithmetic operators allow you to perform basic arithmetic operations (i.e.,
addition, subtraction, multiplication, division, and exponential functions).

Mnemonic Operand Type Example
s

Explanation

+

Two parameters = 5 + B1

Adds the first parameter’s value to
the value of the second parameter.

-

Two parameters = A5 - B1

Subtracts the second parameter’s
value from the value of the first one.

*

Two parameters = A2 * A3

Multiplies the first parameter’s value
by the value of the second
parameter.

/

Two parameters = A1 / PI()

Divides the first parameter’s value
by the value of the second
parameter.

^

Two parameters = B1 ^ A2

Raises the first parameter’s value to
the power determined by the
second parameter’s value.

Logical operators

Logical operators perform comparison operations and return a logical value
(TRUE or FALSE) as a result.

Mnemonic Operand Type Example
s
© 2020 De Novo Software
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=

Two parameters = A1=A2
of logical types

The equality operation. Returns
TRUE if the first parameter is equal
to the second one. Otherwise,
returns FALSE.

<>

Two parameters = A1<>B2
of logical types

The inequality operation. Returns
TRUE if values within the list are not
equal. Otherwise, returns FALSE.

<

Two parameters = A1<B1
of logical types

The "Less than" operation. Returns
TRUE if the first parameter is less
than the second one. Otherwise,
returns FALSE.

>

Two parameters = A1>100
of logical types

The "Greater than" operation.
Returns TRUE if the first parameter
is greater than the second one.
Otherwise, returns FALSE.

<=

Two parameters = A2<=C4
of logical types

The "Less than or equal to"
operation. Returns TRUE if the first
parameter is less than or equal to
the second one. Otherwise, returns
FALSE.

>=

Two parameters = A2>=1.57 The "Greater than or equal to"
of logical types
operation. Returns TRUE if the first
parameter is greater than or equal
to the second one. Otherwise,
returns FALSE.

Logical functions
Logical functions include Boolean operators, conditional tests and functions.

Mnemo Operand Type
nics

Example

AND

=AND(1<B4, Logical AND operation.
B4<100)
Returns TRUE if all values within the
list are TRUE; returns FALSE if one
or more values within the list
evaluates to FALSE.
One common use for the AND
function is to expand the usefulness

A list of logical
parameters

Explanation
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of other functions that perform
logical tests. For example, the IF
function performs a logical test and
then returns one value if the test
evaluates to TRUE and another
value if the test evaluates to FALSE.
FALSE No parameters
required

=FALSE()

IF

=IF(A10<=10 Returns the second parameter if the
0, "Within
logical expression evaluates to TRUE
budget",
and the third parameter otherwise.
"Over
budget")

Three parameters:
the logical
expression, the
value to return if
the expression
succeeds, the value
to return if the
expression fails.

Returns the logical value FALSE.
You can also type the word FALSE
directly into a worksheet cell or as a
part of a formula expression.

IFERRO Two parameters: =IFERROR(val Returns the value you specify if a
R
the parameter that ue,
formula evaluates to an error.
is checked for an
value_if_error Otherwise, returns the formula
error, and the value )
calculation result. The IFERROR
displayed in an error
function is particularly useful for
occurs.
spreadsheet error handling.
The formula evaluates the following
error types: #N/A, #VALUE, #REF!,
#DIV/0!, #NUM!, #NAME?, and
#NULL!.
IFNA
Two parameters: =IFNA(value, Returns the value you specify if the
the parameter that value_if_na) formula returns the #N/A error
is checked for the
value. Otherwise, returns the result
#N/A error value,
of the formula.
and the value
returned if the error
occurs.
NOT

One parameter of
logical type

=NOT(1>D4)

OR

A list of logical
parameters

=OR(A1>=10 Logical OR operation.
, A1<=–10) Returns TRUE if any parameter is
TRUE; returns FALSE if all values
within the list evaluate to FALSE.

TRUE

No parameters
required.

=TRUE()
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XOR

The first parameter =XOR(logical1 Returns a logical exclusive OR of all
is mandatory,
, logical2, …) specified parameters. The XOR
subsequent logical
function allows you to test from 1
values are optional.
to 254 conditions.
If the specified
The result of XOR is TRUE when the
range contains no
number of TRUE inputs is odd and
logical values, the
FALSE when the number of TRUE
XOR function
inputs is even.
returns the
#VALUE! error
code.

Lookup and Reference Functions
A set of reference and lookup functions.

Mnemoni Operand Type
cs

Example

ADDRES Three parameters: =ADDRESS(ro
S
the numeric value w_num,
that specifies the column_num,
row number to
[abs_num],
use in the cell
[a1],
reference, the
[sheet_text])
numeric value that
specifies the
column number to
use in the cell
reference.
Optionally, you
can add a numeric
value that
specifies the type
of reference to
return.
AREAS

Explanation

Returns a reference as text to a
single cell in a worksheet.
You can use the ADDRESS function
to obtain the address of a cell in a
worksheet, given specified row and
column numbers. For instance,
ADDRESS(2, 3) returns $C$2. As
another example, ADDRESS(77,
300) returns $KN$77. You can use
other functions, such as the ROW
and COLUMN functions, to provide
the row and column number
parameters to the ADDRESS
function.

The reference
=AREAS(refer Returns the number of areas in a
parameter is
ence)
reference. An area is a range of
mandatory. It is a
continuous cells or a single cell.
reference to a cell
For instance, the AREAS(B2:D4)
or cell range and
expression returns 1. As another
can refer to
example, AREAS((B2:D4,E5,F6:I9))
multiple areas. If
returns 3.
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you want to
specify several
references as a
single parameter,
include extra sets
of parentheses so
the
ExpressSpreadS
heet formula
engine will not
interpret the
comma as a field
separator.
CHOOSE Two mandatory
=CHOOSE(ind
parameters. The ex_num,
index_num
value1,
parameter
[value2], …)
specifies which
value parameter is
selected. The
index_num value
must be within the
range of 1 to 254,
or a formula
expression or cell
reference
returning a value
within the same
range.
The value1
parameter is also
mandatory while
subsequent
parameters are
optional. You can
specify up to 254
value parameters
from which the
CHOOSE function
selects a value or
an action to
perform based on
the index_num
parameter value.
The actual
parameters can be
© 2020 De Novo Software

Returns a value from the list of
value parameters. You can use the
CHOOSE function to select one of
the specified values based on the
index number.
If index_num is 1, CHOOSE returns
value1. If the index value is 2, the
CHOOSE function returns value 2,
and so on.
If the index_num value is less than 1
or greater than the number of the
last provided value, the CHOOSE
function returns the #VALUE! error
value.
If the index_num parameter value is
a fraction, it is truncated to the
lowest integer before evaluation.
The value parameters can be cell
range references as well as single
values.
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numbers, cell
references,
defined names,
formulas,
functions, or text.
COLUMN The reference
=COLUMN([re Returns the column number of a
parameter is
ference])
reference. For instance, the formula
optional. If it is
=COLUMN(D10) returns 4 since
omitted or refers
column D is the fourth column.
to a range of cells,
If the reference parameter is a
and if the COLUMN
range of cells, and if the COLUMN
function is entered
function is not entered as a
as a horizontal
horizontal array formula, the
array formula, the
COLUMN function returns the
COLUMN function
number of the leftmost column.
returns the
If the reference parameter is
column numbers
omitted, it is assumed to be the
of reference as a
reference of the cell in which the
horizontal array.
COLUMN function appears.
The reference parameter cannot
refer to multiple areas.
COLUMN The array
=COLUMNS(a Returns the number of columns in a
S
parameter is
rray)
reference.
mandatory. It
specifies an array
or array formula,
or a reference to a
range of cells for
which you want
the number of
columns.
FORMUL The reference
=FORMULATE Returns the formula at the given
ATEXT
parameter is
XT(reference) reference as text.
mandatory; it
The reference parameter can be to
specifies a
another worksheet or workbook.
reference to a cell
If the reference parameter is to
or range of cells.
another workbook that is not open,
FORMULATEXT returns the #N/A
error value.
If the reference parameter is to an
entire row or column, or to a range
or defined name containing more
than one cell, FORMULATEXT returns
the value in the upper leftmost cell
or the row, column, or range.
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In the following cases,
FORMULATEXT returns the #N/A
error value:
The cell used as the reference
parameter does not contain a
formula;
The formula in the cell is longer than
8192 characters;
The formula cannot be displayed in
the worksheet; for example, due to
worksheet protection;
An external workbook that contains
the formula is not currently open.
Invalid data types used as inputs will
produce a #VALUE error value.
HLOOKU Three mandatory =HLOOKUP(lo Looks in the top row of an array
P
parameters: the okup_value, and returns the value of the initiated
value to be found table_array, cell. Use HLOOKUP when your
in the first row of row_index_nu comparison values are located in a
the table, the table m,
row across the top of a table of
of information in [range_looku data, and you want to look down a
which data is
p])
specified number of rows. Use
looked up, and the
VLOOKUP when your comparison
row number in
values are located in a column to
table_array which
the left of the data you want to find.
the matching
If HLOOKUP can’t find lookup_value,
value will be
the range_lookup is TRUE, it uses
returned.
the largest value that is less than
You can optionally
lookup_value.
add a logical value
If lookup_value is smaller than the
that specifies
smallest value in the first row of
whether you want
table_array, HLOOKUP returns the
HLOOKUP to find
#N/A error value.
an exact match or
If range_lookup is FALSE and
an approximate
lookup_value is text, you can use
match.
the wildcard characters, question
mark (?) and asterisk (*), in
lookup_value. A question mark
matches any single character; an
asterisk matches any sequence of
characters. If you want to find an
actual question mark or asterisk,
type a tilde (~) before the
character.
Array
form:
Array
form:
INDEX
Returns a value or the reference to
© 2020 De Novo Software
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Two mandatory
=INDEX(array
parameters.
, row_num,
[column_num
The array
])
parameter
specifies a cell
range or an array Reference form:
constant. If the
=INDEX(refer
specified array
ence,
contains only one row_num,
row or column,
[column_num
the corresponding ],
row_num or
[area_num])
column_num
parameter is
optional. If the
array has more
than one row and
more than one
column, and only
the row_num or
column_num
parameter is
provided, the
INDEX function
returns an array of
the entire row or
column in array.
The mandatory
row_num
parameter
specifies the row
in the array from
which the INDEX
function should
return a value. If
the row_num
parameter is
omitted, the
column_num
parameter is
required instead.
The optional
column_num
parameter
specifies the
column in the

a value from within a table or cell
range. There are two forms of the
INDEX function: the array form and
the reference form.
Array form:

Returns the value of an element in a
table or an array, selected by the
row and column number indexes.
Use the array from if the first
parameter of the INDEX function is
an array constant.
If both the row_num and
column_num parameters are used,
the INDEX function returns the value
in the cell at the intersection of
row_num and column_num.
If you set row_num or column_num
to 0 (zero), the INDEX function
returns the array of values for the
entire column or row, respectively.
To use values returned as an array,
enter the INDEX function as an array
formula in a horizontal range of cells
for a row, and in a vertical range of
cells for a column. In order to enter
the INDEX function as an array
formula, press the Ctrl+Shift
+Enter key combination.
The row_num and column_num
parameter values must point to a
cell within the array. Otherwise, the
INDEX function returns the #REF!
error value.
Reference form:

Returns the reference of the cell at
the intersection of a particular row
and column. If the reference
consists of nonadjacent cell ranges,
you can pick a particular range.
After the reference and area_num
values have been used to select a
particular range, the row_num and
© 2020 De Novo Software
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array from which
the INDEX function
should return a
value. If the
column_num
parameter is
omitted, the
row_num
parameter is
required instead.
Reference form:

Two mandatory
parameters.
The reference
parameter
specifies a
reference to one
or more cell
ranges. If you are
entering a
nonadjacent cell
range for the
reference, enclose
the reference in
parentheses. If
each area in the
reference
parameter
contains only one
row or column,
the row_num or
column_num
parameter
becomes optional,
respectively.
The mandatory
row_num
parameter
specifies the
number of the row
in the reference
from which the
INDEX function
returns a
reference.
© 2020 De Novo Software

459

column_num values are used to
select a particular cell. The row_num
value set to 1 corresponds to the
first row in the range, the
column_num value set to 1
corresponds to the first column, and
so on. The reference returned by
the INDEX function is the
intersection of the row and column
whose numbers are specified as the
row_num and column_num
parameters.
If you set the row_num or
column_num parameter to 0
(zero), the INDEX function returns
the reference for the entire column
or row, respectively.
The row_num, column_num, and
area_num parameter values must
point to a cell within the reference.
Otherwise, the INDEX function
returns the #REF! error value. If the
row_num and column_num
parameters are omitted, the INDEX
function returns the area in the
reference specified by the area_num
parameter.
The result of the INDEX function is a
reference and can be used as a
reference in other formula
expressions.
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The optional
column_num
parameter
specifies the
number of the
column in the
reference from
which the INDEX
function returns a
reference.
The optional
area_num
parameter
specifies a range in
the reference from
which the INDEX
function returns
the intersection of
row_num and
column_num. The
first selected area
is numbered 1, the
second is 2, and
so on. If the
area_num
parameter is
omitted, the
INDEX function
uses 1 as the area
value.
INDIREC One mandatory
=INDIRECT(re Returns the reference specified by a
T
parameter: the
f_text, a1)
text string. References are
reference to a cell
immediately evaluated to display
that contains an
their contents.
A1-style
Use the INDIRECT function when
reference, an
you need to change the reference to
R1C1-style
a cell within a formula without
reference, a name
changing the formula itself.
defined as a
If the ref_text parameter contains
reference, or a
no valid cell reference, the INDIRECT
reference to a cell
function returns the #REF! error
as a text string.
value.
If the a1
parameter is set
to TRUE or
omitted, the
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ref_text value is
interpreted as an
A1-style
reference.
If the a1
parameter is set
to FALSE, the
ref_text value is
interpreted as an
R1C1-style
reference.
LOOKUP Vector form:
Two obligatory
parameters: the
value that
LOOKUP searches
for in the first
vector, and the
range that
contains only one
row or one
column.
Additionally, you
can specify a
range that
contains only one
row or column
(result_vector).

Looks up values in a vector or
=LOOKUP(loo array. The LOOKUP function returns
a value either form a one-row or
kup_value,
lookup_vector one-column range or form an array.
The LOOKUP function has two
,
[result_vector syntax forms: the vector form and
the array form.
])
Vector form:

Vector form:

A vector is a range of only one row
=LOOKUP(loo or one column. LOOKUP looks in a
one-row or one-column range
kup_value,
(known as a vector) for a value and
array)
returns a value from the same
position in a second one-row or
one-column range. Use the LOOKUP
function when you want to specify
the range that contains the values
that you want to match.
Array form:
If lookup_value is smaller than the
Two obligatory
smallest value in lookup_vector,
parameters: the
LOOKUP returns the #N/A error
value that
value.
LOOKUP searches
for in the array
Array form:
and the range of
The array form of LOOKUP looks in
cells that contains
the first row or column of an array
text, numbers, or
for the specified value and returns a
logical values that
value from the same position in the
you want to
last row or column of the array. Use
compare with
this form of LOOKUP when the
lookup_value.
values that you want to match are
in the first row or column of the
array. Use the other form of
LOOKUP when you want to specify
the location of the column or row.
Press the Ctrl+Shift+Enter key
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combination to execute the formula.
In general, it is best to use the
HLOOKUP or VLOOKUP function
instead of the array form of
LOOKUP. This form of LOOKUP is
provided for compatibility with other
spreadsheet programs.
MATCH

Two obligatory
=MATCH(look
parameters: the up_value,
value that you
lookup_array,
want to match in [match_type]
lookup_array, and )
the range of cells
being searched.
Additionally, you
can specify the
match_type which
can be the number
–1, 0, or 1. The
match_type
specifies how the
ExpressSpreadS
heet matches
lookup_value with
values in
lookup_array. The
default value for
this parameter is
1.
If match_type is 1
or omitted,
MATCH finds the
largest value that
is less than or
equal to
lookup_value.
If match_type is
0, MATCH finds
the first value that
is exactly equal to
lookup_value.
If match_type is –
1, MATCH finds
the smallest value
that is greater

Looks up values in a reference or
array. The MATCH function searches
for a specified item in a range of
cells, and then returns the relative
position of that item in the range.
Use MATCH instead of one of the
LOOKUP functions when you need
the position of an item in a range
instead of the item itself.
MATCH returns the position of the
matched value within lookup_array,
not the value itself. For instance,
MATCH("b",{"a","b","c"},0) returns
2 which is the relative position of "b"
within the array {"a","b","c"}.
MATCH does not distinguish
between uppercase and lowercase
letters when matching text values.
If MATCH is unsuccessful in finding a
match, it returns the #N/A error
value.
If match_type is 0, and
lookup_value is a text string, you
can use the wildcard characters –
the question mark (?) and asterisk
(*) – in the lookup_value
parameter. A question mark
matches any single character; an
asterisk matches any sequence of
characters. If you want to find an
actual question mark or asterisk,
type a tilde (~) before the
character.
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than or equal to
lookup_value.
OFFSET Accepts three
=OFFSET(refe Returns a reference to a range that
obligatory
rence, rows, is the specified number of rows and
parameters: the cols, [height], columns from a cell or cell range.
reference from
[width])
The returned reference can be a
which you want to
single cell or cell range. You can
base the offset,
specify the number of returned rows
the number of
and/or columns.
rows, up or down
If the offset reference is outside the
that you want the
worksheet’s boundaries, the
upper-left cell to
OFFSET function returns the #REF!
refer to, and the
error value.
number of
If the height or width parameter is
columns to the left
omitted, the returned cell range has
or right that you
the same height or width as the
want the upperspecified reference.
left cell of the
The OFFSET function does not
result to refer to.
actually move any cell or change the
Additionally, you
selection while returning a reference.
can specify the
You can use OFFSET with any
height and width
function expecting a reference
of the returned
parameter. For example, the
reference. Both
formula expression
the height and
SUM(OFFSET(C2,1,2,3,1))
width must be
calculates the total value of a range
positive.
that is three rows in height and one

ROW

The reference
parameter is
optional.
If reference is
omitted, it is
assumed to be the
reference of the
cell in which the
ROW function
appears.
If reference is a
range of cells, and
if ROW is entered
as a vertical array,
ROW returns the
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column width that is 1 row below
and 2 columns to the right of the C2
cell.
=ROW([refere Returns the row number of a
nce])
reference.
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row numbers of
reference as a
vertical array.
Reference cannot
refer to multiple
areas.
ROWS

The array
parameter is
mandatory. An
array, an array
formula, or a
reference to a
range of cells for
which you want
the number of
rows.

=ROWS(array Returns the number of rows in a
)
reference or array.

TRANSP One obligatory
=TRANSPOSE
OSE
parameter: an
(array)
array or range of
cells within a
worksheet that
you want to
transpose. The
transposition of an
array is created by
using the first
column of the new
array, the second
row of the array
as the second
column of the new
array, and so on.

Returns a vertical range of cells as a
horizontal range, and vice versa.
You must enter the TRANSPOSE
function as an array formula in a
range that has the same number of
rows and columns, respectively, as
the source range has columns and
rows. Use TRANSPOSE to swap the
vertical and horizontal orientation of
an array or range within a
worksheet. The steps are as
follows:
1.Highlight the new area for the
transposed cells.
2.Select TRANSPOSE and
highlight the source cells so
they appear within the
parentheses of the formula.
3.Press Ctrl+Shift+Enter key
combination to execute the
formula; the new area will
now contain the transposed
data.

VLOOKU Three obligatory
P
parameters: the
value to search in
the first column of

=VLOOKUP(lo
okup_value,
table_array,
col_index_nu

Looks in the first column of an array
and moves across the row to return
the value of a cell. You can use the
VLOOKUP function to search the first
© 2020 De Novo Software
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the table or range, m,
the range of cells [range_looku
that contains the p])
data, and the
column number in
the table_array
parameter from
which the
matching value
must be returned.
Additionally, you
can specify the
range_lookup that
switches the
VLOOKUP finding
between an exact
match and an
approximate
match.
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column of a range of cells, and then
return a value from any cell on the
same row of the range. The V in
VLOOKUP stands for vertical. Use
VLOOKUP instead of HLOOKUP when
your comparison values are located
in columns to the left of the data
that you want to find.
When searching number or date
values, ensure that the data in the
first column of table_array is not
stored as text values. In this case,
VLOOKUP might return an incorrect
or unexpected value.
If range_lookup is FALSE and
lookup_value is text, you can use
the wildcard characters – the
question mark (?) and asterisk (*) –
in lookup_value. A question mark
matches any single character; an
asterisk matches any sequence of
characters. If you want to find an
actual question mark or asterisk,
type a tilde (~) preceding the
character.

Arithmetic functions
A set of mathematic and trigonometric functions, including basic arithmetic, conditional sums and
products, and trigonometric ratios. Mathematicians may also find the Statistical Functions 476 useful.

Mnemonic Operand Type Example
s

Explanation

ABS

One parameter
of double type.

=ABS(B6)

Returns the absolute value.

ACOS

One parameter
of double type.

=ACOS(B16) Returns the arccosine.

ACOSH

One parameter
of double type.

=ACOSH(A1) Returns the inverse hyperbolic
cosine.

ACOT

One parameter
of double type.

=ACOT(A1)
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of a number. The returned angle is
given in radians in the range 0
(zero) to pi.
ACOTH

One parameter =ACOTH(A1) Returns the inverse hyperbolic
of double type.
cotangent of a number. If the
The absolute
absolute value of the parameter is
value of the
less than 1, the ACOT function
parameter must
returns the #VALUE! error value.
be greater than
1.

ASIN

One parameter
of double type.

=ASIN(B6)

Returns the arcsine.

ASINH

One parameter
of double type.

=ASINH(C2)

Returns the inverse hyperbolic sine
of the parameter.

ATAN

One parameter
of double type.

=ATAN(C5)

Returns the arctangent.

ATAN2

Two parameters =ATAN2(A1,
of double type. A2)

ATANH

One parameter
of double type.

BASE

Two parameters =BASE(A1,
of integer type: Radix[Min_len
the first is
gth])
greater than 0
and less than
2^53; the
second (radix)
must be greater
than or equal to
2 and less than
or equal to 36.
Third parameter
is optional, which
must be greater
or equal to 0.

CEILING

Returns the arctangent using x- and
y- coordinates.

=ATANH(D4) Returns the inverse hyperbolic
tangent.

Converts a number into a text
representation with the given radix
(base).
If A1, Radix, or Min_length are
outside the minimum or maximum
constraints, BASE returns the
#NUM! error value.
If A1 is a non-numeric value, BASE
returns the #VALUE! error value.
Any non-integer number used as an
parameter is truncated to an
integer.
If the Min_length parameter is
included, leading zeros are added to
the result if the result would
otherwise be shorter than the
minimum length specified. For
example, BASE(16,2) returns
10000 but BASE(16,2,8) returns
00010000.
Two parameter =CEILING(2.5 Rounds the first parameter up to the
of double type , 1)
nearest multiple based on the
significance specified by the second
© 2020 De Novo Software
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parameter.
CEILING. Three
=CEILING.MA
MATH
parameters. The TH(A1,
first parameter [significance],
must be less
[mode])
than 9.99E+307
and greater than
–2.229E-308;
the second
parameter is the
multiple to which
the number is
rounded; the
optional Mode
parameter.

Rounds a number up to the nearest
integer or to the nearest multitude
of significance.
By default, significance is +1 for
positive numbers and –1 for
negative numbers.
By default, both positive and
negative numbers with decimal
portions are rounded up to the
nearest integer. If you specify the
Significance and Mode parameters,
you can change the direction of
rounding for negative numbers. For
example, rounding –6.3 to a
significance of 1 with a mode of 1
rounds away from 0, to –7. There
are many combinations of
Significance and Mode values that
affect rounding of negative numbers
in different ways.
The Mode parameter does not
affect positive numbers.

CEILING.P Two
=CEILING.PRE Returns a number that is rounded up
RECISE
parameters. The CISE(A1,
to the nearest integer or to the
first parameter is [significance]) nearest multiple of significance.
a number of
Regardless of the sign of the
double type. The
number, the number is rounded up.
Significance
However, if the number or the
parameter is
significance is zero,
optional.
CEILING.PRECISE returns zero. If
the Significance parameter is
omitted, its default value is 1.
CONCATE At least one text =CONCATENA Joins several text items into a single
NATE
item is
TE(text1,
text item. The CONCATENATE
mandatory; you [text2], …)
function joins up to 255 text strings
can add more
into one text string. The joined
text items, up to
items can be text, numbers, cell
a maximum of
references, or a combination of
255 items.
those items.
Commas must
Note that you can also use the
separate the
ampersand (&) calculation operator
specified items.
instead of the CONCATENATE
function to join text items. For
instance, =A1 & B1 returns the
© 2020 De Novo Software
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same value as =CONCATENATE(A1,
B1).
COS

One parameter
of double type

=COS(A1)

Returns the cosine.

COSH

One parameter
of double type

=COSH(D7)

Returns the hyperbolic cosine.

COMBIN

Two parameters
of integer type.
Non-integer
numeric
parameters are
truncated to
integers.

=COMBIN(nu
mber,
number_chos
en)

Returns the number of combinations
for a given number of items. Use
COMBIN to determine the total
possible number of groups for a
given number of items.
If either parameter is non-numeric,
COMBIN returns the #VALUE! error
value.
If either parameter is negative,
COMBIN returns the #NUM! error
value.
COMBINA Two parameters =COMBINA(n Returns the number of combinations
of integer type. umber,
(with repetitions) for a given
Non-integer
number_chos number of items.
numeric
en)
If the value of either parameter is
parameters are
outside of its constraints, COMBINA
truncated to
returns the #NUM! error.
integers.
If either parameter is a non-numeric
value, COMBINA returns the
#VALUE! error value.
COT
One parameter =COT(number Returns the cotangent of an angle
of double type, )
specified in radians.
which should be
If the specified parameter is outside
more than 0 and
its constraints, the COT function
less than 2^27.
returns the #NUM! error value.
If the specified parameter is not a
numeric value, the COT function
returns the #VALUE! error value.
The COT(0) expression returns the
#DIV/0! error value.
COTH
One parameter =COTH(numb Returns the hyperbolic cotangent of
of double type, er)
a hyperbolic angle.
which should be
If the specified parameter is outside
less than 2^27.
its constraints, the COTH function
returns the #NUM! error value.
If the specified parameter is a nonnumeric value, the COTH function
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returns the #VALUE! error value.
CSC
One parameter =CSC(number Returns the cosecant of an angle
of double type, )
specified in radians.
which should be
If the specified parameter is outside
less than 2^27.
its constraints, the CSC function
returns the #NUM!
If the specified parameter is a nonnumeric value, the CSC function
returns the #VALUE! error value.
CSC(n) equals 1/SIN(n).
CSCH
One parameter =CSCH(numb Returns the hyperbolic cosecant of
of double type, er)
an angle specified in radians.
which should be
If the specified parameter is outside
less than 2^27.
its constraints, the CSCH function
returns the #NUM! error value.
If the specified parameter is a nonnumeric value, the CSCH function
returns the #VALUE! error value.
DECIMAL One parameter =DECIMAL(te Converts a text representation of a
is a text string
xt, radix)
number in a given base into a
that must be
decimal number.
less or equal to
A radix greater than 10 uses the
255 characters,
numeric values 0 – 9 and the letters
other parameter
A-Z as needed. For example, base
is an integer that
16 (hexadecimal) uses 0 – 9 and A
must be greater
– F, and base 36 uses 0 – 9 and A –
or equal to 2
Z.
and less than or
If either parameter is outside its
equal to 36.
constraints, DECIMAL may return
the #NUM! or #VALUE! error value.
DEGREES One parameter =DEGREES(PI Converts radians to degrees.
of double type ()/2)
that specifies
angle in radians
EVEN

One parameter
of double type

=EVEN(-1)

Rounds the parameter up to the
nearest even integer.

EXP

One parameter
of double type

=EXP(C1)

Returns the exponent value of the
parameter.

FACT

One non=FACT(2)
negative
parameter. If a
number is not an
integer, it is
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truncated.
FACTDOU One non=FACTDOUBL
BLE
negative
E(number)
parameter. If a
number is not an
integer, it is
truncated.

FLOOR

Returns the double factorial of a
number.
If the number is non-numeric, the
FACTDOUBLE function returns the
#VALUE! error value.
If the number is negative, the
FACTDOUBLE function returns the
#NUM! error value.
Two parameters =FLOOR(-2.5, Rounds the first parameter down,
of double type -2)
towards zero, to the nearest
multiple of the significance specified
by the second parameter.

FLOOR.MA Three
=FLOOR.MAT
TH
parameters: first H(number,
is the number to significance,
be rounded
mode)
down, second is
the multiple to
which you want
to round, and
third is the
direction (either
towards or away
from 0) to round
negative
numbers.

By default, both positive and
negative numbers are rounded
down to the nearest integer. By
using 0 or a negative number as the
Mode parameter, you can change
the direction of the rounding for
negative numbers.
The Significance parameter rounds
the number down to the nearest
integer that is a multiple of the
significance specified. The exception
is where the number to be rounded
is an integer. For example, for a
Significance of 3, the number is
rounded down to the next integer
that is a multiple of 3. If Number is
divided by a Significance of 2 or
greater results in a remainder, the
result is rounded.

FLOOR.PR Two
=FLOOR.PREC Returns a number that is rounded
ECISE
parameters.
ISE(number, down to the nearest integer or to
First is the
[significance]) the nearest multiple of significance.
number to be
Regardless of the sign of the
rounded down,
number, the number is rounded
second is the
down. However, if the number of
multiple to which
the significance is zero, zero is
the number is to
returned.
be rounded. The
If the significance is omitted, its
Significance
default value is 1.
parameter is
The absolute value of the multiple is
optional.
used, so that the FLOOR.PRECISE
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function returns the mathematical
floor irrespective of the signs of the
number and significance.
INT

Parameter of
type double

=INT(E4)

Rounds the parameter down to the
nearest integer.

ISO.CEILI Two
=ISO.CEILING Returns a number that is rounded up
NG
parameters.
(number,
to the nearest integer or to the
First is the value [significance]) nearest multiple of significance.
to be rounded;
Regardless of the sign of the
second is the
number, the number is rounded up.
optional multiple
However, if the number or the
to which the
significance is zero, zero is returned.
number is to be
If the significance is omitted, its
rounded.
default value is 1.
LN

One parameter
of double type

LOG

Two
=LOG(100,
parameters: the 10)
number and the
base

LOG10

One parameter
of double type

MMULT

Two obligatory =MMULT(arra Returns the matrix product of two
parameters: the y1, array2)
arrays. The result is an array with
arrays you want
the same number of rows as array1
to multiply. The
and the same number of columns as
number of
array2. You must enter formulas
columns in
that return arrays only as array
array1 must be
formulas.
the same as the
The MMULT function returns
number of rows
#VALUE! error when any of the
in array2, and
specified cells are empty or contain
both arrays
non-numeric values. If the number
must contain
of columns in array1 is different
only numeric
from the number of rows in array2,
values. Both
MMULT also returns the #VALUE!
arrays can be
error.
specified as cell
ranges, array
constants, or
references.

MOD

Two
parameters: a
number and
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=LN(C1)

Returns the natural logarithm.
Returns the logarithm of a number
to the specified base.

=LOG10(100 Returns the base-10 logarithm of
0)
the parameter.

=MOD(4,3)

Returns the remainder after the
number is divided by the divisor.
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divisor
MROUND

Two
=MROUND(nu
parameters: the mber,
value to be
multiple)
rounded, and the
multiple to which
you want to
round the value.

Returns a number rounded to the
desired multiple.
MROUND rounds up, away from
zero, if the remainder of dividing the
number by the multiple is greater
than or equal to half the value of the
multiple.

ODD

One parameter
of double type

=ODD(3.5)

Rounds the parameter up to the
nearest odd integer.

PI

No parameters
required

=PI()

Returns the value of Pi.

POWER

Two parameters =POWER(A1, Raises the number to the base.
of double type: 4)
the number and
the power

PRODUCT The first
=PRODUCT(n
parameter is the umber1,
number or range [number2],
that you want to …)
multiply.
Additional
optional
parameters that
specify additional
numbers or
ranges that you
want to multiply,
up to a
maximum of
255 parameters.

The PRODUCT multiplies all the
numbers given as parameters and
returns the product. For example, if
cells A1 and A2 contain numbers,
you can use the formula
=PRODUCT(A1, A2) to multiply
those two numbers together. You
can also perform the same
operation by using the multiply (*)
mathematical operator; for
example, =A1 * A2.
The PRODUCT function is useful
when you need to multiply multiple
cells or cell ranges together. For
example, the formula
=PRODUCT(A1:A3, C1:C3) is
equivalent to = A1 * A2 * A3 * C1
* C2 * C3.

QUOTIENT Two
=QUOTIENT(n Returns the integer portion of a
parameters: the umerator,
division. Use this function when you
dividend and the denominator) want to discard the remainder of a
divisor.
division.
RADIANS One parameter =RADIANS(18 Converts degrees to radians.
of type double 0)
that specifies
angle in degrees.
RAND

No parameters

=RAND()

Returns a random number between
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0 and 1.

RANDBET Two parameters =RANDBETWE Returns a random integer between
WEEN
of integer type: EN(bottom, the numbers you specify. A new
bottom that
top)
random integer is returned every
specifies the
time the worksheet is calculated.
smallest
returned value,
and top that
specifies the
largest returned
value.
ROUND

Two
=ROUND(20. Rounds the first parameter to the
parameters: the 57, 1)
specified number of digits.
number of
double type and
the number of
digits

ROUNDDO Two parameters =ROUNDDOW Rounds the parameter toward zero.
WN
of double type N(2.75,0)
The first parameter specifies a
number to round up. The second
parameter defines the number of
digits to which you want to round
the first parameter.
ROUNDUP Two parameters =ROUNDUP(of double type 3.42,1)

SEC

One parameter =SEC(number)
of double type.
Number is the
angle in radians
for which you
want to calculate
the secant.

SECH

One parameter
of double type.
Number is the
angle in radians
for which you
want to calculate
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Rounds the parameter toward
infinity. The first parameter specifies
a number to round up. The second
parameter defines the number of
digits to which you want to round
the first parameter.

Returns the secant of an angle.
The absolute value of the parameter
must be less than 2^27.
If the parameter is outside of its
constraints, SEC returns the #NUM!
error value.
If the parameter is a non-numeric
value, SEC returns the #VALUE!
error value.
=SECH(number) Returns the hyperbolic secant of an
angle.
The absolute value of the parameter
must be less than 2^27.
If the parameter is outside of its
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the hyperbolic
secant.

constraints, SECH returns the
#NUM! error value.
If the parameter is a non-numeric
value, SECH returns the #VALUE!
error value.

SIGN

One parameter
of double type

=SIGN(A2)

Returns the sign.

SIN

One parameter
of double type

=SIN(A1)

Returns the sine.

SINH

One parameter
of double type

=SINH(1)

Returns the hyperbolic sine.

SQRT

One parameter
of double type

=SQRT(B5)

Returns the square root.

SQRTPI

One parameter
of double type.

=SQRTPI(num Returns the square root of (number
ber)
* pi).
If the parameter is negative, SQRTPI
returns the #NUM! error value.

SUBTOTAL The first
=SUBTOTAL(f
parameter is a unction_num,
number from 1 ref1, [ref2],
to 11 (includes …)
hidden values)
or from 101 to
111 (ignores
hidden values)
that specifies
which function to
use in calculating
subtotals within
a list.
The second
parameter is the
first named
range or
reference for
which you want
the subtotal.
Subsequent
parameters are
optional and
specify named
ranges or
references 2 to

Returns a subtotal in a list or
database.
If there are other subtotals within
ref1, ref2, … (or nested subtotals),
these nested subtotals are ignored
to avoid double counting.
The SUBTOTAL function ignores any
rows that are not included in the
result of a filter, no matter which
function_num value you use.
The SUBTOTAL function is designed
for columns of data, or vertical
ranges. It is not designed for rows
of data, or horizontal ranges. For
example, when you subtotal a
horizontal range using a
function_num of 101 or greater,
such as SUBTOTAL(109,B2:G2),
hiding a column does not affect the
subtotal. However, hiding a row in a
subtotal of a vertical range does
affect the subtotal.
If any of the references are 3-D
references, SUBTOTAL returns the
#VALUE! error value.
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254 for which
you want the
subtotal.
SUM

A list of
parameters

SUMIF

Three
=SUMIF(rang
parameters. The e, criteria,
range of cells
[sum_range])
that you want to
evaluate by
criteria. Blank
and text values
are ignored. The
criteria in the
form of a
number,
expression, a cell
reference, text,
or a function
that defines
which cells will
be added. The
optional
sum_range
parameter that
allows you to
add more cells
to those
specified ion the
range
parameter.

SUMSQ

A list of
parameters
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=SUM(A1:C1 Sums all the values in the list.
2)
=SUM(A1,
3.14, 1.57)
The SUMIF function is designed to
sum the values in a range that meet
a criteria you specify. For example,
suppose that in a column that
contains numbers, you want to sum
only the values that are larger than
5. You can use the following
formula:
=SUMIF(B2:B25, ">5")
In this example, the criteria is
applied the same values that are
being summed. If you want, you can
apply the criteria to one range and
sum the corresponding values in a
different range. For example, the
formula =SUMIF(B2:B5, "John",
C2:C5) sums only the values in the
range C2:C5, where the
corresponding cells in the range
B2:B5 equal "John".
Any text criteria or any criteria that
includes logical or mathematical
symbols must be enclosed in double
quotation marks ("). If the criteria is
numeric, double quotation marks
are not necessary.
You can use both the question mark
(?) and asterisk (*) – as the criteria
parameter. A question mark
matches any single character; an
asterisk matches any sequence of
characters. If you need to find an
actual question mark or asterisk,
type a tilde (~) preceding the
character.

=SUMSQ(B1: Sums the square of values in the list
D1)
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=SUM(1, 2, 3,
4)
TAN

One parameter
of double type

=TAN(C3)

Returns the tangent.

TANH

One parameter
of double type

=TANH(0)

Returns the hyperbolic tangent.

TRUNC

One parameter
of double type

=TRUNC(PI()) Returns the integer part. Compare
this with the INT function, which
returns a double

Statistical functions
The ExpressSpreadSheet control provides a large selection of statistical functions, performing most of
the common statistical calculations, from basic mean, median and mode calculations to more complex
statistical distribution and probability tests.

Mnemonics Operand Type Example

Explanation

AVEDEV

Number1 is
=AVEDEV(nu
required,
mber1,
subsequent
[number2],
parameters are …)
optional. You
can specify
from 1 to 255
numbers for
which you want
the average of
the absolute
deviations.
Alternatively,
you can use a
single array or
a reference to
an array
instead of
parameters
separated by
commas.

Returns the average of the absolute
deviations of data points from their
mean. AVEDEV is a measure of the
variability in a data set.
AVEDEV is influenced by the unit of
measurement in the input data.
Parameters must either be numbers
or be names, arrays, or references
that contain numbers.
Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.
If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.

AVERAGE

A list of
parameters

=AVERAGE(A Calculates the average value of
1:A5)
values within the list.
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=AVERAGE(1
0.3, 9.1)
AVERAGEA A list of
parameters

=AVERAGEA( Calculates the average value of the
A1:A5)
non-empty cells referenced.
AVERAGEA(range) equals
SUM(range)/COUNTA(range).

AVERAGEIF Two mandatory =AVERAGEIF( Returns the average (arithmetic
parameters:
range, criteria, mean) of all the cells in a range that
the range which [average_ran meet a given criteria.
specifies one or ge])
Cells that contain TRUE or FALSE
more cells to
are ignored.
average,
If a cell in average_range is an
including
empty cell, AVERAGEIF ignores it.
numbers or
If range is a blank or text value,
names, arrays
AVERAGEIF returns the #DIV/0!
or references
error value.
that contain
If a cell in criteria is empty,
numbers; the
AVERAGEIF treats it as a 0 value.
criteria in the
If no cells in the range meet the
form of a
criteria, AVERAGEIF returns the
number,
#DIV/0! error value.
expression, cell
reference, or
You can use the wildcard
text that
characters, question mark (?) and
defines which
asterisk (*), in criteria. A question
cells are
mark matches any single character;
averaged.
an asterisk matches any sequence
of characters. If you want to find an
Additionally,
actual question mark or asterisk,
you can specify
type a tilde (~) before the
the actual set
character.
of cells to
average. If
The average_range parameter does
omitted, the
not have to be the same size and
range
shape as range. The actual cells that
parameter is
are averaged are determined by
used.
using the top, left cell in
average_range as the beginning cell,
and then including cells that
correspond in size and shape to
range.
BETA.DIST Six parameters, =BETA.DIST(x Returns the beta distribution. The
the first four of , alpha, beta, beta distribution is commonly used
which are
cumulative,
to study variation in the percentage
mandatory: X [A], [B])
of something across samples, such
is the value
as fraction of the day people spend
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BETA.INV

between A and
B at which the
function should
be evaluated;
Alpha and Beta
are parameters
of the
distribution;
Cumulative is a
logical value
that determines
the form of the
function; A and
B are lower and
higher bounds
to the interval
of X,
respectively.

watching television.
If any parameter is non-numeric,
BETA.DIST returns the #VALUE!
error value.
If either alpha or beta is not
positive, BETA.DIST returns the
#NUM! error value.
If x < A, x > B, or A = B, BETA.DIST
returns the #NUM! error value.
If you omit values for A and B,
BETA.DIST uses the standard
cumulative beta distribution, so that
A = 0 and B = 1.
If cumulative is TRUE, BETA.DIST
returns the cumulative distribution
function; if FALSE, it returns the
probability density function.
If you omit values for A and B,
BETA.DIST uses the standard
cumulative beta distribution, so that
A = 0, and B = 1.

Five
=BETA.INV(pr
parameters,
obability,
the first three alpha, beta,
of which are
[A], [B])
mandatory:
Probability is
the probability
associated with
the beta
distribution;
Alpha and Beta
are parameters
of the
distribution; A
and B are lower
and higher
bounds to the
interval of X,
respectively.

Returns the inverse of the beta
cumulative probability density
function (BETA.DIST).
If probability = BETA.DIST(x, …
TRUE), then BETA.INV(probability,
…) = x. The beta distribution can be
used in project planning to model
probable completion times given an
expected completion time and
variability.
If any parameter is non-numeric,
BETA.INV returns the #VALUE! error
value.
If either alpha or beta is not
positive, BETA.INV returns the
#NUM! error value.
If probability is either below zero or
higher than 1, BETA.INV returns the
#NUM! error value.
If you omit values for A and B,
BETA.INV uses the standard
cumulative beta distribution, so that
A = 0 and B = 1.
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Given a value for probability,
BETA.INV seeks that value x such
that BETA.DIST(x, alpha, beta,
TRUE, A, B) = probability. Thus, the
precision of BETA.INV depends on
the precision of BETA.DIST.
BINOM.DIS Four obligatory =BINOM.DIST
T
parameters:
(number_s,
the number of trials,
successes in
probability_s,
trials, the
cumulative)
number of
independent
trials, the
probability of
success on
each trial, and
the logical value
that determines
the form of the
function.
If cumulative is
TRUE, then
BINOM.DIST
returns the
cumulative
distribution
function, which
is the
probability that
there are at
most number_s
successes; if
FALSE, it
returns the
probability
mass function,
which is the
probability that
there are
number_s
successes.

Returns the individual term
binominal distribution probability.
Use BINOM.DIST in problems with a
fixed number of tests or trials, when
the outcome of any trial are only
success or failure, when trials are
independent, and when the
probability of success is constant
throughout the experiment. For
example, BINOM.DIST can calculate
the probability that two of the next
three babies born are male.
The number_s and trials parameters
are truncated to integers.
If number_s, trials, or probability_s
is non-numeric, BINOM.DIST returns
the #VALUE! error value.
If number_s < 0 or number_s >
trials, BINOM.DIST returns the
#NUM! error value.
If probability_s < 0 or probability_s
> 1, BINOM.DIST returns the
#NUM! error value.

BINOM.DIS Three
T.RANGE
obligatory
parameters:
the number of

Returns the probability of a trial
result using a binomial distribution.
If any parameters are outside of
their constraints,
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independent
[number_s2]) BINOM.DIST.RANGE returns the
trials, the
#NUM! error value:
probability of
The trials parameter must be
success in each
greater than or equal to zero.
trial, and the
The probability_s parameter must
number of
be greater than or equal to zero
successes in
and less than or equal to 1.
trials.
The number_s parameter must be
Additionally,
greater than or equal to zero and
you can provide
less than or equal to trials.
an additional
The number_s2 parameter, if
range bound for
provided, must be greater or
the number of
equal to number_s, and less than
successes in
or equal to trials.
trials.
If any parameters are non-numeric
values, BINOM.DIST.RANGE returns
the #VALUE! error value.
Numeric parameters are truncated
to integers.
CHISQ.DIST Three
=CHISQ.DIST Returns the cumulative beta
obligatory
(x,
probability density functions. The
parameters:
deg_freedom, chi-squared distribution is
the value at
cumulative) commonly used to study variation
which you want
in the percentage of something
to evaluate the
across samples, such as the
distribution, the
fraction of the day people spend
number of
watching television.
degrees of
If any parameter is non-numeric,
freedom, and
CHISQ.DIST returns the #VALUE!
the logical value
error value.
that determines
If x is negative, CHISQ.DIST returns
the form of the
the #NUM! error value.
function.
If deg_freedom is not an integer, it
If cumulative is
is truncated.
TRUE,
If deg_freedom < 1 or
CHISQ.DIST
deg_freedom > 10^10,
returns the
CHISQ.DIST returns the #NUM!
cumulative
error value.
distribution
function;
otherwise, it
returns the
probability
density
function.
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CHISQ.DIST Two obligatory =CHISQ.DIST. Returns the one-tailed probability of
.RT
parameters:
RT(x,
the chi-squared distribution. The chithe value at
deg_freedom) squared distribution is associated
which you want
with a chi-squared test. Use the chito evaluate the
squared test to compare observed
distribution and
and expected values. For instance,
the number of
a genetic experiment might
degrees of
hypothesize that the next
freedom.
generation of plants will exhibit a
certain set of colors. By comparing
the observed results with the
expected ones, you can decide
whether your original hypothesis is
valid.
If either parameter is non-numeric,
CHISQ.DIST.RT function returns the
#VALUE! error value.
If deg_freedom is not an integer, it
is truncated.
If deg_freedom < 1 or
deg_freedom > 10^10,
CHISQ.DIST.RT returns the #NUM!
error value.
CHISQ.INV Two obligatory =CHISQ.INV( Returns the inverse of the left-tailed
parameters:
probability,
probability of the chi-squared
the probability deg_freedom) distribution. The chi-squared
associated with
distribution is commonly used to
the chi-squared
study variation in the percentage of
distribution and
something across samples, such as
the number of
the fraction of the day people spend
degrees of
watching television.
freedom.
If parameter is non-numeric,
CHISQ.INV returns the #VALUE!
error value.
If probability < 0 or probability > 1,
CHISQ.INV returns the #NUM! error
value.
If deg_freedom is not an integer, it
is truncated.
If deg_freedom < 1 or
deg_freedom > 10^10, CHISQ.INV
returns the #NUM! error value.
CHISQ.INV. Two obligatory =CHISQ.INV.R Returns the inverse of the rightRT
parameters:
T(probability, tailed probability of the chi-squared
the probability deg_freedom) distribution. If probability =
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associated with
the chi-squared
distribution and
the number of
degrees of
freedom.

CHISQ.DIST.RT(x,…), then
CHISQ.INV.RT(probability,…) = x.
Use this function to compare
observed results with expected
ones in order to decide whether
your original hypothesis is valid.
If either parameter is non-numeric,
CHISQ.INV.RT returns the #VALUE!
error value.
If probability < 0 or probability > 1,
CHISQ.INV.RT returns the #NUM!
error value.
If deg_freedom is not an integer, it
is truncated.
If deg_freedom < 1, CHISQ.INV.RT
returns the #NUM! error value.
Given a value for probability,
CHISQ.INV.RT seeks that value x
such that CHISQ.DIST.RT(x,
deg_freedom) = probability. Thus,
precision of CHISQ.INV.RT depends
on precision of CHISQ.DIST.RT.
CHISQ.INV.RT uses an iterative
search technique. If the search has
not converged after 64 iterations,
the function returns the #N/A error
value.

CHISQ.Test Two obligatory =CHISQ.Test( Returns the test for independence.
parameters:
array1,
CHISQ.TEST returns the value from
array1 specifies array2)
the chi-squared (χ2 ) distribution for
a cell range of
the statistic and the appropriate
values and
degrees of freedom. The first
array2 specifies
parameter is an array of observed
a second range
frequencies, the second parameter
of values.
is an array of estimated
(theoretical) frequencies.
CORREL
Two obligatory =CORREL(arr Returns the correlation coefficient of
parameters:
ay1, array2) the array1 and array2 cell ranges.
array1 specifies
Use the correlation coefficient to
a cell range of
determine the relationship between
values and
two properties. For example, you
array2 specifies
can examine the relationship
a second range
between a location’s average
of values.
temperature and the use of air
conditioners.
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If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however cells with the
zero value are included.
If array1 and array2 have a
different number of data points,
CORREL returns the #N/A error
value.
If either array1 or array2 is empty,
or if s (the standard deviation) of
their values equals zero, CORREL
returns the #DIV/0! error value.
COUNT

A list of
parameters

=COUNT(A1: Returns the number of cells in a
A4)
given range.
=COUNT(1,
5, 8)

COUNTA

A list of
parameters

=COUNTA(A1 Counts the number of non-empty
:A4)
cells in a given range.

COUNTBLA A list of
NK
parameters

=COUNTBLAN Counts the number of empty cells.
K(A1:E1)

COUNTIF

=COUNTIF(A1 Counts the number of nonblank
:A7,">2")
cells within a range, which meet a
given condition.

Two
parameters:
the range of
cells and the
condition of
type string.

COVARIAN Two obligatory =COVARIANC Returns population covariance, the
CE.P
parameters:
E.P(array1,
average of the products of
array1 specifies array2)
deviations for each data point pair in
the first cell
two data sets. Use covariance to
range of
determine the relationship between
integers and
two data sets. For example, you
array2 specifies
can examine whether greater
the second
income accompanies greater levels
range of
of education.
integers.
The parameters must either be
numbers or be names, arrays, or
references that contain numbers.
If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.
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If array1 and array2 have different
numbers of data points,
COVARIANCE.P returns the #N/A
error value.
If either array1 or array2 is empty,
COVARIANCE.P returns the #DIV/0!
error value.
COVARIAN Two obligatory =COVARIANC Returns the sample covariance, the
CE.S
parameters:
E.S(array1,
average of the products of
array1 specifies array2)
deviations for each data point pair in
the first cell
two data sets.
range of
The parameters must either be
integers and
numbers or be names, arrays, or
array2 specifies
references that contain numbers.
the second
If an array or reference parameter
range of
contains text, logical values, or
integers.
empty cells, those values are
ignored; however, cells with the
zero value are included.
If array1 and array2 have different
numbers of data points,
COVARIANCE.S returns the #N/A
error value.
If either array1 or array2 is empty
or contains only 1 data point each,
COVARIANCE.S returns the #DIV/0!
error value.
DEVSQ

The first
=DEVSQ(num
parameter is
ber1,
required,
[number2],
subsequent
…)
numbers are
optional. You
can specify
from 1 to 255
parameters for
which you want
to calculate the
sum of squared
deviations. You
can also use a
single array or
a reference to
an array
instead of

Returns the sum of squares of
deviations of data points from their
sample mean.
Parameters can either be numbers
or names, arrays, or references
that contain numbers.
Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.
If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.
Parameters that are error values or
text that cannot be translated into
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separated by
commas.
EXPON.DIS Three
=EXPON.DIST
T
obligatory
(x, lambda,
parameters:
cumulative)
the value of the
function, the
parameter
value, and the
logical value
that indicates
which form of
the exponential
function to
provide.
If cumulative is
TRUE,
EXPON.DIST
returns the
cumulative
distribution
function;
otherwise, it
returns the
probability
density
function.

485

numbers cause errors.

Returns the exponential distribution.
Use EXPON.DIST to model the time
between events, such as how long
an automated bank teller takes to
deliver cash. For example, you can
use EXPON.DIST to determine the
probability that the process takes at
most 1 minute.
If x or lambda is non-numeric,
EXPON.DIST returns the #VALUE!
error value.
If x < 0, EXPON.DIST returns the
#NUM! error value.
If lambda is not positive,
EXPON.DIST returns the #NUM!
error value.

FORECAST Three
=FORECAST( Calculates, or predicts, a future
obligatory
x, known_y’s, value by using existing values. The
parameters:
known_x’s) predicted value is a y-value for a
the data point
given x-value. The known values
for which you
are existing x-values and y-values,
want to predict
and the new value is predicted by
a value, the
using linear regression. You can use
dependent
this function to predict future sales,
array or range
inventory requirements, or
of data, and the
consumer trends.
independent
If x is non-numeric, FORECAST
array or range
returns the #VALUE! error value.
of data.
If known_y’s and known_x’s are
empty or contain different number
of data points, FORECAST returns
the #N/A error value.
If the variance of known_x’s equals
© 2020 De Novo Software
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zero, then FORECAST returns the
#DIV/0! error value.
F.Test

Two obligatory =F.Test(array Returns the result of F-Test, the
parameters:
1,array2)
two-tailed probability that the
array1 specifies
variances in array 1 and array2 are
a cell range of
not significantly different. The
values and
parameters are the first and second
array2 specifies
datasets.
a second range
of values.

GAMMA

The number
parameter is
mandatory.

=GAMMA(nu Returns the gamma function value.
mber)
If number is not positive, GAMMA
returns the #NUM! error value.
If number contains characters that
are not valid, GAMMA returns the
#VALUE! error value.

GAMMA.DIS Four
=GAMMA.DIS
T
mandatory
T(x, alpha,
parameters: X beta,
– the value at cumulative)
which you want
to evaluate the
distribution;
Alpha and Beta
are parameters
to the
distribution;
Cumulative is a
logical value
that determines
the form of the
function.

Returns the gamma distribution.
You can use this function to study
variables that may have a skewed
distribution. The gamma distribution
is commonly used in queuing
analysis.
If x, alpha, or beta is non-numeric,
GAMMA.DIST returns the #VALUE!
error value.
If x is negative, GAMMA.DIST
returns the #NUM! error value.
If either alpha or beta is not
positive, GAMMA.DIST returns the
#NUM! error value.
If beta = 1, GAMMA.DIST returns
the standard gamma distribution.
If cumulative is TRUE, GAMMA.DIST
returns the cumulative distribution
function; if FALSE, it returns the
probability density function.

GAMMA.INV Three
=GAMMA.INV Returns the inverse of the gamma
mandatory
(probability, cumulative distribution. If p =
parameters:
alpha, beta) GAMMA.DIST(x, …), then
Probability is
GAMMA.INV(p, …) = x. You can use
the probability
this function to study a variable
associated with
whose distribution may be skewed.
the gamma
If beta = 1, GAMMA.INV returns the
distribution;
standard gamma distribution.
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If any parameter is a text string,
GAMMA.INV returns the #VALUE!
error value.
If the probability is either negative
or higher than 1, GAMMA.INV
returns the #NUM! error value.
If either alpha or beta is not
positive, GAMMA.INV returns the
#NUM! error value.
Given a value for the probability,
GAMMA.INV seeks that value x such
that GAMMA.DIST(x, alpha, beta,
TRUE) = probability. Thus, the
precision of GAMMA.INV depends on
precision of GAMMA.DIST.

A single
=GAMMALN(X Returns the natural logarithm of the
mandatory
)
gamma function, (x).
parameter of
If x is non-numeric, GAMMALN
double type,
returns the #VALUE! error value.
which is the
If x is not positive, GAMMALN
value for which
returns the #NUM! error value.
you want to
The number e raised to the
calculate
GAMMALN(i) power, where i is an
GAMMALN.
integer, returns the same result as
(I – 1)!.

GAMMALN. A single
=GAMMALN.P
PRECISE
mandatory
RECISE(x)
parameter of
double type,
which is the
value for which
you want to
calculate the
natural
logarithm of the
gamma
function.

Returns the natural logarithm of the
gamma function, (x).
If x is non-numeric,
GAMMALN.PRECISE returns the
#VALUE! error value.
If x is not positive,
GAMMALN.PRECISE returns the
#NUM! error value.
The number e raised to the
GAMMALN.PRECISE(i) power, where
i is an integer, returns the same
result as (I – 1)!.

GAUSS

Calculates the probability that a
member of a standard normal
population will fall between the
mean and z standard deviations
from the mean.
If z is not a valid number, GAUSS
returns the #NUM! error value.
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If z is not a valid data type, GAUSS
returns the #VALUE! error value.
Because NORM.S.DIST(0, True)
always returns 0.5, GAUSS(z) will
always be 0.5 less than
NORM.S.DIST(z, True).
GEOMEAN

Up to 255
=GEOMEAN(n
parameters, for umber1,
which you
[number2],
calculate the
…)
mean. Only the
first parameter
is mandatory.
You can also
use a single
array instead of
number of
parameters.

Returns the geometric mean of an
array or range of positive data. For
example, you can use GEOMEAN to
calculate average growth rate given
compound interest with variable
rates.
Parameters can either be numbers
or names, arrays, or references
that contain numbers.
Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.
If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.
Error values or text strings that
cannot be translated into numbers
cause errors, if you use them as
parameters.
If any data point is not positive,
GEOMEAN returns the #NUM! error
value.

Grubbs.Test One obligatory =GRUBBS.TE Performs the Grubbs' test for
parameter:
ST(array1)
outliers. Test is used to detect
array1 specifies
outliers in a univariate dataset. It is
a cell range of
based on the assumption of
data.
normality. That is, you should first
verify your data can be reasonably
approximated by a normal
distribution before applying the
Grubbs' test. The parameter is the
dataset.
HYPGEOM.D Five obligatory =HYPGEOM.D Returns the hypergeometric
IST
parameters:
IST(sample_s, distribution. HYPGEOM.DIST returns
the number of number_sam the probability of a given number of
successes in
ple,
sample successes, given the sample
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the sample, the population_s,
size of the
number_pop,
sample, the
cumulative)
number of
successes in
the population,
the population
size, and the
logical value
that determines
the form of the
function.
If cumulative is
TRUE, then
HYPGEOM.DIST
returns the
cumulative
distribution
function;
otherwise, it
returns the
probability
mass function.

size, population successes, and
population size. Use HYPGEOM.DIST
for problems with a finite
population, where each observation
is either a success or a failure, and
where each subset of a given size is
chosen with equal likelihood.
All parameters are truncated to
integers.
If any parameter is non-numeric,
HYPGEOM.DIST returns the
#VALUE! error value.
If sample_s < 0 or sample_s is
greater than the lesser of
number_sample or population_s,
HYPGEOM.DIST returns the #NUM!
error value.
If number_sample is not positive or
number_sample >
number_population, HYPGEOM.DIST
returns the #NUM! error value.
If population_s is not positive or
population_s > number_population,
HYPGEOM.DIST returns the #NUM!
error value.
If number_pop is not positive,
HYPGEOM.DIST returns the #NUM!
error value.

INTERCEPT Two obligatory =INTERCEPT(
parameters:
known_y’s,
the dependent known_x’s)
and
independent
sets of
observations or
data.

Calculates the point at which a line
will intersect the y-axis by using
existing x-values and y-values. The
intercept point is based on a best-fit
regression line plotted through the
known x-values and known yvalues. Use the INTERCEPT function
when you want to determine the
value of the dependent variable
when the independent variable is 0
(zero). For example, you can use
the INTERCEPT function to predict a
metal’s electrical resistance at a
certain temperature when your data
points were taken at room
temperature and higher.
The parameters should be either
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numbers or names, arrays, or
references that contain numbers.
If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.
If known_y’s and known_x’s
contain a different number of data
points or contain no data points,
INTERCEPT returns the #N/A error
value.
KS.Test

Two obligatory
parameters:
array1 specifies
a cell or cell
range of values
and array2
specifies a
second cell or
cell range of
values. Two
optional
parameters:
Tailing and
alpha
(significance).
For tailing, a
value of 0=two
tailed, 1=right
tailed, 2=left
tailed. Alpha
may be an
significance
level.

=KS.TEST(arr Performs two-sample Kolmogorovay1, array2) Smirnov goodness of fit test on
independent random samples Data1
and Data2. Test determines if Data1
or
and Data2 samples are drawn from
=KS.TEST(arr the same continuous population.
ay1, array2, The mandatory parameters are the
0|1|2, Alpha) first and second datasets. The
optional parameters are tailing and
alpha (significance)

LARGE

Two
parameters:
the array or
range of data
for which you
want to
determine the
k-th largest
value. K is the
position (from
the largest) in

=LARGE(array Returns the k-th largest value in a
, k)
data set. You can use this function
to select a value based on its
relative standing. For example, you
can use LARGE to return the
highest, runner-up, or third-place
score.
If array is empty, LARGE returns the
#NUM! error value.
If k is not positive or if k is greater
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than the number of data points,
LARGE returns the #NUM! error
value.
If n is the number of data points in a
range, then LARGE(array, 1) returns
the largest value, and LARGE(array,
n) returns the smallest value.

Lilliefors.Te One obligatory =LILLIEFORS. Performs the Lilliefors goodness of
st
parameter:
TEST(array1) fit test to a normal distribution with
array1 specifies
unknown parameters mu and
a cell range of
sigma. The parameter is the
vales.
dataset. A minimum of 4 values
must be present to calculate.
MannWhitne Five obligatory =MANNWHIT Performs the non-parametric test
y.Test
parameters:
NEY.TEST(arr of the null hypothesis, that two
array1 specifies ay1,
samples come from populations of
a cell or range array2,hypoth equal means, against an alternative
of cells for
esis type,
hypothesis, especially that a
dataset 1,
alpha,approxi particular population has a larger
array2 specifies mation)
mean than the other one. It
a cell or range
operates under the assumption that
of cells for
all the observations from both
dataset 2, the
groups are independent of each
hypothesis
other. Will evaluate to TRUE when
type, the
failing to reject the null hypothesis
significance
or FALSE when rejecting the null
level, and the
hypothesis.
approximation.
(Credit: Wikipedia)

MAX
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The variables for the function are as
follows:
[Array1...] - cell range of values
for first dataset
[Array2...] - cell range of values
for second dataset
Hypothesis Type - 0 for twotailed, 1 for right-tailed, or 2 for
left-tailed
Alpha - the significance level for
which to test (i.e. 0.05)
Use Normal Approximation True (or 1)/False (or 0)
=MAX(A1:D1) Returns the largest parameter
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parameters

=MAX(A1,
100, C2)

value.

MAXA

From 1 to 255 =MAXA(value
parameters.
1, [value2],
Value1 is the
…)
mandatory
parameter for
which you want
to find the
largest value;
the following
values from 2
to 255 are
optional
parameters for
which you want
to find the
largest value.

Returns the largest value in a list of
parameters. Parameters can be the
following: numbers; names, arrays,
or references that contain numbers;
text representations of numbers;
logical values, such as TRUE and
FALSE, in a reference.
Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.
If an parameter is an array or
reference, only values in that array
or reference are used. Empty cells
and text values in the array or
reference are ignored.
If the parameters contain no values,
MAXA returns 0 (zero).
If you do not want to include logical
values and text representations of
numbers in a reference s part of the
calculation, use the MAX function
instead.

MEDIAN

From 1 to 255
parameters.
Only the
number1 is
required,
subsequent
numbers are
optional.

=MEDIAN(nu
mber1,
[number2],
…)

Returns the median of the given
numbers. The median is the number
in the middle of a set of numbers.
Note that the MEDIAN function
measures central tendency, which is
the location of the center of a group
of numbers in a statistical
distribution.

MIN

A list of
parameters

=MIN(A1:D1) Returns the smallest parameter
=MIN(0, C2) value.

MINA

From 1 to 255
parameters.
Only the value1
is required,
subsequent
values are
optional.

=MINA(numb
er1,
[number2],
…)

Returns the smallest value in a list
of parameters, including members,
text, and logical values. Parameters
can be the following: numbers;
names, arrays, or references that
contain numbers; text
representations of numbers; logical
values, such as TRUE and FALSE, in
a reference.
© 2020 De Novo Software
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Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.
If an parameter is an array or
reference, only values in that array
or reference are used. Empty cells
and text values in the array or
reference are ignored.
If the parameters contain no values,
MINA returns 0 (zero).
If you do not want to include logical
values and text representations of
numbers in a reference s part of the
calculation, use the MIN function
instead.
NORM.DIST Four obligatory =NORM.DIST( Returns the normal distribution for
parameters:
x, mean,
the specified mean and standard
the value for
standard_dev, deviation. This function has a very
which you want cumulative) wide range of applications in
the distribution,
statistics, including hypothesis
the arithmetic
testing.
mean of the
If mean or standard_dev is nondistribution, the
numeric, NORM.DIST returns the
standard
#VALUE! error value.
deviation of the
If standard_dev is not positive,
distribution, and
NORM.DIST returns the #NUM!
the logical value
error value.
that determines
If mean = 0, standard_dev = 1, and
the form of the
cumulative = TRUE, NORM.DIST
function.
returns the standard normal
If cumulative is
distribution, NORM.S.DIST.
TRUE,
NORM.DIST
returns the
cumulative
distribution
function;
otherwise, it
returns the
probability
mass function.
NORM.INV

© 2020 De Novo Software

Three
mandatory
parameters:

=NORM.INV(p Returns the inverse of the normal
robability,
cumulative distribution for the
mean,
specified mean and standard
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the probability standard_dev
corresponding )
to the normal
distribution, the
arithmetic
mean of the
distribution, and
the standard
deviation of the
distribution.

NORM.S.DI Two mandatory =NORM.S.DIS
ST
parameters:
T(z,
the value for
cumulative)
which you want
the distribution,
and the
cumulative
logical value
that determines
the form of the
function.
If cumulative is
TRUE,
NORM.S.DIST
returns the
cumulative
distribution
function;
otherwise, it
returns the
probability
mass function.

deviation.
If any parameter is non-numeric,
NORM.INV returns the #VALUE!
error value.
If probability is not positive or if
probability > 1, NORM.INV returns
the #NUM! error value.
If standard_dev is not positive,
NORM.INV returns the #NUM! error
value.
If mean = 0 and standard_dev = 1,
NORM.INV uses the standard
normal distribution.
Given a value for probability,
NORM.INV seeks that value x such
that NORM.DIST(x, mean,
standard_dev, TRUE) = probability.
Thus, precision of NORM.INV
depends on precision of
NORM.DIST.
Returns the standard normal
distribution (has a mean of zero
and a standard deviation of one).
Use this function in place of a table
of standard normal curve areas.
If z is non-numeric, NORM.S.DIST
returns the #VALUE! error value.

NORM.S.IN The probability =NORM.S.INV Returns the inverse of the standard
V
parameter is
(probability) normal cumulative distribution. The
mandatory.
distribution has a mean of zero and
© 2020 De Novo Software
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a standard deviation of one.
If probability is non-numeric,
NORM.S.INV returns the #VALUE!
error value.
If probability is not positive or if
probability >= 1, NORM.S.INV
returns the #NUM! error value.
Given a value for probability,
NORM.S.INV seeks that value z that
NORM.S.DIST(z, TRUE) =
probability. Thus, precision of
NORM.S.INV depends on precision
of NORM.S.DIST. NORM.S.INV uses
an iterative search technique.
PEARSON

Two mandatory =PEARSON(ar Returns the Pearson product
parameters:
ray1, array2) moment correlation coefficient, r, a
array1 and
dimensionless index that ranges
array2 which
from –1.0 to 1.0 inclusive and
represent two
reflects the extent of a linear
sets of
relationship between two data sets.
independent
The parameters must be either
and dependent
numbers or names, array
values,
constants, or references that
respectively.
contain numbers.
If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.
If array1 and array2 are empty or
have a different number of data
points, PEARSON returns the #N/A
error value.

PERCENTIL Two mandatory =PERCENTILE. Returns the k-th percentile of values
E.INC
parameters:
INC(array, k) in a range. You can use this function
the array or
to establish a threshold of
range of data
acceptance. For example, you can
that defines
decide to examine candidates who
relative
score above 90th percentile.
standing, and
If array is empty, PERCENTILE.INC
the percentile
returns the #NUM! error value.
value in the
If k is non-numeric,
range 0..1,
PERCENTILE.INC returns the
inclusive.
#VALUE! error value.
If k is < 0 or if k > 1,
© 2020 De Novo Software
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PERCENTILE.INC returns the #NUM!
error value.
If k is not a multiple of 1/(n – 1),
PERCENTILE.INC interpolates to
determine the value at the k-th
percentile.
PERCENTIL Two mandatory =PERCENTILE. Returns the k-th percentile of values
E.EXC
parameters:
EXC(array, k) in a range, where k is in the range
the array or
0..1, exclusive.
range of data
If array is empty, PERCENTILE.EXC
that defines
returns the #NUM! error value.
relative
If k is non-numeric,
standing, and
PERCENTILE.EXC returns the
the percentile
#VALUE! error value.
value in the
If k is not positive or if k is equal to
range 0..1,
or exceeds 1, PERCENTILE.EXC
exclusive.
returns the #NUM! error value.
If k is not a multiple of 1/(n – 1),
PERCENTILE.EXC interpolates to
determine the value at the k-th
percentile.
PERCENTILE.EXC will interpolate
when the value for the specified
percentile lies between two values
in the array. If it cannot interpolate
for the percentile, specified by the k
parameter, the
ExpressSpreadSheet returns
#NUM! error.
PERMUT

Two mandatory =PERMUT(nu
parameters:
mber,
integer values number_chos
that describe
en)
the number of
objects and the
number of
objects in each
permutation.

Returns the number of
permutations for a given number of
objects that can be selected from
number objects. A permutation is
any set or subset of objects or
events where internal order is
significant. Permutations are
different from combinations, for
which the internal order is not
significant. Use this function for
lottery-style probability calculations.
Both of the accepted parameters
are truncated to integers.
If number or number_chosen is
non-numeric, PERMUT returns the
#VALUE! error value.
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If number is not positive or if
number_chosen is negative,
PERMUT returns the #NUM! error
value.
If number < number_chosen,
PERMUT returns the #NUM! error
value.
POISSON.D Three
=POISSON.DI
IST
mandatory
ST(x, mean,
parameters:
cumulative)
the number of
events, the
expected
numeric value,
and the
cumulative
logical value
that determines
the form of the
probability
distribution
returned.
If cumulative is
TRUE,
POISSON.DIST
returns the
cumulative
Poisson
probability that
the number of
random events
occurring will
fall between
zero and x
inclusive;
otherwise, it
returns the
Poisson
probability
mass function
that the
number of
events
occurring will be
exactly x.

© 2020 De Novo Software

Returns the Poisson distribution. A
common application of the Poisson
distribution is predicting the number
of events over a specific time, such
as the number of cars arriving at a
toll plaza in 1 minute.
If x is not an integer, it is truncated.
If x or mean is non-numeric,
POISSON.DIST returns the #VALUE!
error value.
If x < 0, POISSON.DIST returns the
#NUM! error value.
If mean < 0, POISSON.DIST returns
the #NUM! error value.
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QUARTILE.I Two mandatory =QUARTILE.IN Returns the quartile of a data set,
NC
parameters:
C(array,
based on percentile values from
the array or cell quart)
0..1, inclusive. Quartiles often are
range of
used in sales and survey data to
numeric values
divide populations into groups. For
for which you
example, you can use
want the
QUARTILE.INC to find the top 25
quartile value,
percent of incomes in a population.
and the quart
If array is empty, QUARTILE.INC
that indicates
returns the #NUM! error value.
which value to
If quart is not an integer, it is
return.
truncated.
If quart = 0,
If quart < 0 or if quart > 4,
QUARTILE.INC
QUARTILE.INC returns the #NUM!
returns the
error value.
minimum value.
MIN, MEDIAN, and MAX return the
If quart = 1,
same value as QUARTILE.INC when
QUARTILE.INC
quart is equal to 0 (zero), 2, and 4,
returns the first
respectively.
quartile (25th
percentile).
If quart = 2,
QUARTILE.INC
returns the
median value
(50th
percentile).
If quart = 3,
QUARTILE.INC
returns the
third quartile
(75th
percentile).
If quart = 4,
QUARTILE.INC
returns the
maximum
value.
QUARTILE. Two mandatory =QUARTILE.E
EXC
parameters:
XC(array,
the array or cell quart)
range of
numeric values
for which you
want the

Returns the quartile of the data set,
based on percentile values from
0..1, exclusive.
If array is empty, QUARTILE.EXC
returns the #NUM! error value.
If quart is not an integer, it is
truncated.
© 2020 De Novo Software
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quartile value,
and the quart
that indicates
which value to
return.
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If quart is not positive or if quart
equals to or exceeds 4,
QUARTILE.EXC returns the #NUM!
error value.
MIN, MEDIAN, and MAX return the
same value as QUARTILE.EXC when
quart is equal to 0 (zero), 2, and 4,
respectively.

RANK.AVG Two mandatory =RANK.AVG(n Returns the rank of a number in a
parameters:
umber, ref,
list of numbers: its size relative to
the number
[order])
other values in the list. If more than
whose rank
one value has the same rank, the
you want to
average rank is returned.
find, and the ref
If order is 0 (zero) or omitted, the
parameter
ExpressSpreadSheet ranks
specifies an
number as if ref were a list sorted in
array of, or a
descending order.
reference to, a
If order is any non-zero value, the
list of numbers.
ExpressSpreadSheet ranks
Additionally,
number as if ref were a list sorted in
you can set the
ascending order.
way of ranking
the number as
the order
parameter.
RANK.EQ
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Two mandatory =RANK.EQ(nu
parameters:
mber, ref,
the number
[order])
whose rank
you want to
find, and the ref
parameter
specifies an
array of, or a
reference to, a
list of numbers.
Additionally,
you can set the
way of ranking
the number as
the order
parameter.

Returns the rank of a number in a
list of numbers. Its size is relative to
other values in the list; if more than
one value has the same rank, the
top rank of that set of values is
returned. If you were to sort the
list, the rank of the number would
be its position.
If order is 0 (zero) or omitted, the
ExpressSpreadSheet ranks
number as if ref were a list sorted in
descending order.
If order is any non-zero value, the
ExpressSpreadSheet ranks
number as if ref were a list sorted in
ascending order.
RANK.EQ gives duplicate numbers
the same rank. However, the
presence of duplicate numbers
affects the ranks of subsequent
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numbers. For example, in a list of
integers sorted in ascending order, if
the number 10 appears twice and
has a rank of 5, then 11 would
have a rank of 7 (no number would
have a rank of 6).
For some purposes one might want
to use a definition of rank that
takes ties into account. In previous
example, you would want a revised
rank of 5.5 for the number 10. This
can be done by adding the following
correction factor to the value
returned by RANK.EQ. This
correction factor is appropriate oth
for the case where rank is
calculated in descending order
(order = 0 or omitted) or ascending
order (order = non-zero value).
Correction factor for tied
ranks=[COUNT(ref) + 1 –
RANK.EQ(number, ref, 1)]/2.
REGRESSIO Three
=REGRESSIO Returns the Y value of the
NPLOTXTOY mandatory
NPLOTXTOY(p regression function given the X input
parameters:
lot_number, value. Only a single X value is
the Plot number overlay_numb allowed as input.
of a regression er,x_known_
plot (numeric), value)
the overlay
number of a
regression fit
(numeric) and
the X known
value
(numeric).
REGRESSIO Three
=REGRESSIO Returns the X value of the
NPLOTYTOX mandatory
NPLOTYTOX(p regression function given the Y input
parameters:
lot_number, value. Only a single Y value is
the Plot number overlay_numb allowed as input.
of a regression er,y_known_
plot (numeric), value)
the overlay
number of a
regression fit
(numeric) and
the Y known
© 2020 De Novo Software
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value
(numeric).
Two mandatory =RSQ(known
parameters are _y’s,
two arrays or known_x’s)
ranges of data
points.
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Returns the square of the Pearson
product moment correlation
coefficient through data points in
known_y’s and known_x’s. For
more information, refer to the
description of the PEARSON
function. The r-squared value can
be interpreted as the proportion of
the variance in y attributable to the
variance in x.
Parameters can either be numbers
or names, arrays, or references
that contain numbers.
Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.
If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.
Parameters that are error values or
text that cannot be translated into
numbers cause errors.
If known_y’s and known_x’s are
empty or have a different number
of data points, RSQ returns the #N/
A error value.
If known_y’s and known_x’s
contain only 1 data point, RSQ
returns the #DIV/0! error value.

The SKEW
=SKEW(numb Returns the skewness of a
function
er1,
distribution. Skewness characterizes
accepts from
[number2], ... the degree of asymmetry of a
one to 255
)
distribution around its mean.
parameters for
Positive skewness indicates a
which you want
distribution with an asymmetric tail
to calculate
extending toward more positive
skewness. You
values. Negative skewness indicates
can also use a
a distribution with an asymmetric
single array or
tail extending towards more
a reference to
negative values.

502

FCS Express 6 Manual

SKEW.P

an array
instead of
parameters
separated by
commas.
Note that you
must specify at
least one
parameter.

Parameters can either be numbers
or names, arrays, or references
that contain numbers.
Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.
If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.
Parameters that are error values or
text that cannot be translated into
numbers cause errors.
If there are fewer than three data
points, or the sample standard
deviation is zero, SKEW returns the
#DIV/0! error value.

The SKEW
=SKEW.P(nu
function
mber1,
accepts from
[number2],
one to 255
…)
parameters for
which you want
to calculate
skewness. You
can also use a
single array or
a reference to
an array
instead of
parameters
separated by
commas.
Note that you
must specify at
least one
parameter.

Returns the skewness of a
distribution based on a population:
a characterization of the degree of
asymmetry of a distribution around
its mean.
Parameters can either be numbers
or names, arrays, or references
that contain numbers.
Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.
If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.
SKEW.P uses the standard deviation
of an entire population, not a
sample.
If parameters are values that are
not valid, SKEW.P returns the
#NUM! error value.
If parameters use data types that
are not valid, SKEW.P returns the
#VALUE! error value.
© 2020 De Novo Software
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If there are fewer than three data
points, or the sample standard
deviation is zero, SKEW.P returns
the #DIV/0! error value.
SLOPE

Two mandatory =SLOPE(kno
parameters: an wn_y’s,
array or cell
known_x’s)
range of
numeric
dependent data
points and the
set of
independent
data points.

SMALL

Two mandatory =SMALL(array Returns the k-th smallest value in a
parameters: an , k)
data set. Use this function to return
array or range
values with a particular relative
of numerical
standing in a data set.
data for which
If array is empty, SMALL returns the
you want to
#NUM! error value.
determine the
If k is not positive or if k exceeds
k-th smallest
the number of data points, SMALL
value and the
returns the #NUM! error value.
position (from
If n is the number of data points in
the smallest) in
array, SMALL(array, 1) equals the
the array or
smallest value, and SMALL(array, n)
range of data
equals the largest value.
to return.

SSMD

Six mandatory
parameters:
the mean of
the positive
control, the
mean of the
negative

© 2020 De Novo Software

Returns the slope of the linear
regression line through data points
in known_y’s and known_x’s. The
slope is the vertical distance divided
by the horizontal distance between
any two points on the line, which is
the rate of change along the
regression line.
The parameters must be either
numbers or names, arrays, or
references that contain numbers.
If an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.
If known_y’s and known_x’s are
empty or have a different number
of data points, SLOPE returns the
#N/A value.

=SSMD(mean Short for Strictly Standardized Mean
max,mean
Difference. Has been used as a
min,n max,n ranking metric for hit selection in
min,SDmax,S high throughput screening assays.
Dmin)
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control, the
sample size of
the positive
control, the
sample size of
the negative
control, the
standard
deviation of the
positive control,
and the
standard
deviation of the
negative
control.
StainIndex Three
mandatory
parameters:
mean or
median of
positive
population,
mean or
median of
negative
population, and
standard
deviation of
negative
population
STDEV.S

=STAININDEX Performs a stain index calculation
(mean or
using the means/medians or
median of
positive and negative populations
positive
and the negative population's
population,me standard deviation based on the
an or median Stain Index formula of (Median of
of negative
Positive - Median of Negative) / (SD
population,sta of Negative *2).
ndard
deviation of
negative
population)

This function
=STDEV.S(nu
accepts from 1 mber1,
to 255
[number2],
parameters.
…)
Only the
number1 is
required,
subsequent
values are
optional.
You can also
use a single
array or a
reference to an
array instead of
parameters

Estimates the standard deviation
based on a sample. The standard
deviation is a measure of how
widely values are dispersed from
the average value (the mean).
STDEV.S assumes that its
parameters are a sample of the
population. If your data represents
the entire population, then calculate
the standard deviation using the
STDEV.P function instead.
The standard deviation is calculated
using the "n-1" method.
Parameters can either be numbers
or names, arrays, or references
that contain numbers.
© 2020 De Novo Software
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separated by
commas.

Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.
If an parameter is an array or
reference, only numbers in that
array or reference are counted.
Empty cells, logical values, text, or
error values in the array or
reference are ignored.
Parameters that are error values or
text that cannot be converted into
numbers cause errors.
If you want to include logical values
and text representations of
numbers in a reference as part of
the calculation, use the STDEVA
function instead.

From 1 to 255 =STDEV.P(nu
parameters.
mber1,
Only the
[number2],
number1 is
…)
required,
subsequent
values are
optional.
You can also
use a single
array or a
reference to an
array instead of
parameters
separated by
commas.

Estimates the standard deviation
based on the entire population. The
standard deviation is a measure of
how widely values are dispersed
from the average value (the mean).
STDEV.P assumes that its
parameters are the entire
population. If you data represents a
sample of the population, then
calculate the standard deviation
using STDEV.
For large sample sizes, STDEV.S
and STDEV.P return approximately
equal values.
The standard deviation is calculated
using the "n" method.
Parameters can either be numbers
or names, arrays, or references
that contain numbers.
Logical values, and text
representations of numbers that
you type directly into the list of
parameters are counted.
If an parameter is an array or
reference, only numbers in that
array or reference are counted.
Empty cells, logical values, text, or
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error values in the array or
reference are ignored.
Parameters that are error values or
text that cannot be converted into
numbers cause errors.
If you want to include logical values
and text representations of
numbers in a reference part of the
calculation, use the STDEVPA
function instead.
STDEVA

From 1 to 255 =STDEVA(val Estimates the standard deviation
parameters.
ue1, [value2], based on a sample. The standard
Only the value1 …)
deviation is a measure of how
is required,
widely values are dispersed from
subsequent
the average value (the mean).
values are
STDEVA assumes that its
optional.
parameters are a sample of the
You can also
population. If your data represents
use a single
the entire population, you must
array or a
calculate the standard deviation
reference to an
using STDEVPA instead.
array instead of
The standard deviation is calculated
parameters
using the "n–1" method.
separated by
Parameters can be the following:
commas.
numbers, names, arrays, or
references that contain numbers;
text representations of numbers, or
logical values, such as TRUE and
FALSE, in a reference.
Parameters that contain TRUE
evaluate as 1; parameters that
contain text or FALSE evaluate as 0
(zero).
If an parameter is an array or
reference, only values in that array
or reference are used. Empty cells
and text values in that array or
reference are ignored.
Parameters that are error values or
text that cannot be translated into
numbers cause errors.
If you do not want to include logical
values and text representations of
numbers in a reference as part of
the calculation, use the STDEV
© 2020 De Novo Software
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function instead.
STDEVPA

From 1 to 255 =STDEVPA(va Calculates the standard deviation
parameters.
lue1,
based on the entire population,
Only the value1 [value2], …) including numbers, text, and logical
is required,
values. The standard deviation is a
subsequent
measure of how widely values are
values are
dispersed from the average value
optional.
(the mean).
You can also
STDEVPA assumes that its
use a single
parameters are the entire
array or a
population. If your data represents
reference to an
a sample of the population, you
array instead of
must calculate the standard
parameters
deviation by using the STDEVA
separated by
function.
commas.
The standard deviation is calculated
using the "n" method.
Parameters can be the following:
numbers, names, arrays, or
references that contain numbers;
text representations of numbers, or
logical values, such as TRUE and
FALSE, in a reference.
Text representations of numbers
that you type directly into the list of
parameters are counted.
Parameters that contain TRUE
evaluate as 1; parameters that
contain text or FALSE evaluate as 0
(zero).
If an parameter is an array or
reference, only values in that array
or reference are used. Empty cells
and text values in the array or
reference are ignored.
Parameters that are error values or
text that cannot be converted into
numbers cause errors.
If you do not want to include logical
values and text representations of
numbers in a reference as part of
the calculation, use the STDEVP
function instead.

STEYX

Two mandatory =STEYX(know Returns the standard error of the
parameters:
n_y’s,
predicted y-value for each x in the
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the two arrays known_x’s)
or ranges of
dependent and
independent
data points,
respectively.

regression. The standard error is a
measure of the amount of error in
the prediction of y for an individual
x.
Parameters can either be numbers
or names, arrays, or references
that contain numbers.
Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.
In an array or reference parameter
contains text, logical values, or
empty cells, those values are
ignored; however, cells with the
zero value are included.
Parameters that are error values or
text that cannot be converted into
numbers cause errors.
If known_y’s and known_x’s have a
different number of data points,
STEYX returns the #N/A error value.
If known_y’s and known_x’s are
empty or have less than three data
points, STEYX returns the #DIV/0!
error value.

SUM

A list of
parameters

=SUM(A1:C1 Sums values within the list.
2)
=SUM(A1,
3.14, 1.57)

SUMSQ

A list of
parameters

=SUMSQ(B1: Sums squares of values within the
D1)
list.
=SUMSQ(1,
2, 3, 4)

T.DIST

Three
=T.DIST(x,
Returns the Student’s left-tailed tobligatory
deg_freedom, distribution. The t-distribution is
parameters:
cumulative) used in the hypothesis testing of
the numeric
small sample data sets. Use this
value at which
function in place of a table of critical
to evaluate the
values for the t-distribution.
distribution, the
If any parameter is non-numeric,
integer value
T.DIST returns the #VALUE! error
indicating the
value.
number of
If deg_freedom < 1, T.DIST returns
© 2020 De Novo Software
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degrees of
freedom, and
the cumulative
logical value
that determines
the form of the
function.
If cumulative is
TRUE, T.DIST
returns the
cumulative
distribution
function;
otherwise, it
returns the
probability
density
function.
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an error value. The deg_freedom
parameter should be at no less than
1.

T.DIST.2T

Two obligatory =T.DIST.2T(x, Returns the two-tailed Student’s tparameters:
deg_freedom) distribution. The Student’s tthe numeric
distribution is used in the hypothesis
value at which
testing of small sample data sets.
to evaluate the
Use this function in place of a table
distribution, and
of critical values for the tthe integer
distribution.
value that
If any parameter is non-numeric,
indicates the
T.DIST.2T returns the #VALUE!
number of
error value.
degrees of
If deg_freedom < 1, T.DIST.2T
freedom.
returns the #NUM! error value.
If x < 0, then T.DIST.2T returns the
#NUM! error value.

T.DIST.RT

Two obligatory =T.DIST.RT(x, Returns the right-tailed Student’s tparameters:
deg_freedom) distribution. The t-distribution is
the numeric
used in the hypothesis testing of
value at which
small data sets. Use this function in
to evaluate the
place of a table of critical values for
distribution, and
the t-distribution.
the integer
If any parameter is non-numeric,
value that
T.DIST.RT returns the #VALUE!
indicates the
error value.
number of
If deg_freedom < 1, T.DIST.RT
degrees of
returns the #NUM! error value.
freedom.

T.INV

Two obligatory =T.INV(proba Returns the left-tailed inverse of the
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parameters:
bility,
student’s t-distribution.
the probability deg_freedom) If either parameter is non-numeric,
associated with
T.INV returns the #VALUE! error
the Student’s tvalue.
distribution and
If probability <= 0 or if probability >
the number of
1, T.INV returns the #NUM! error
degrees of
value.
freedom with
If deg_freedom is not an integer, it
which to
is truncated.
characterize
If deg_freedom < 1, T.INV returns
the distribution.
the #NUM! error value.
T.INV.2T

T.Test

Two obligatory =T.INV.2T(pr Returns the two-tailed inverse of
parameters:
obability,
the Student’s t-distribution.
the probability deg_freedom) If either parameter is non-numeric,
associated with
T.INV.2T returns the #VALUE! error
the Student’s tvalue.
distribution and
If probability <= 0 or if probability >
the number of
1, T.INV.2T returns the #NUM!
degrees of
error value.
freedom with
If deg_freedom < 1, T.INV.2T
which to
returns the #NUM! error value.
characterize
T.INV.2T returns that value t, such
the distribution.
that P(|X| > t) = probability where
X is a random variable that follows
the t-distribution and P(|X| > t) =
P(X < -t or X > t).
A one-tailed t-value can be returned
by replacing probability with
2*probability. For a probability of
0.05 and degrees of freedom of 10,
the two-tailed value is calculated
with T.INV.2T(0.05, 10), which
returns 2.28139. The one-tailed
value of the same probability and
degrees of freedom can be
calculated with T.INV.2T(2 * 0.05,
10), which returns 1.812462.
Given a value for probability,
T.INV.2T seeks that value x such
that T.DIST.2T(x, deg_freedom, 2)
= probability. Thus, precision of
T.INV.2T depends on precision of
T.DIST.2T.
Four
=T.TEST(arra It compares Array1 mean value
with Array2 mean value. The
© 2020 De Novo Software
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assumption is Number1 and
y1,
array2,hypoth Number2 variances are equal but
esis type or unknown.
tails,type)
The variables for the function are as
follows:
[Array1...] - cell range of values
for first dataset
[Array2...] - cell range of values
for second dataset
Hypothesis Type - 1 for one-tailed
(left-tailed) or 2 for two-tailed
Type - 1 for paired data with equal
variance (homoscedastic) (data set
size should be equal), 2 for
unpaired data with equal variance
(homoscedastic) (data set size do
not have to be equal).
From 1 to 255 =VAR.P(numb Calculates variance based on the
parameters.
er1,
entire population (ignores logical
Only the
[number2],
values and text in the population).
number1 is
…)
VAR.P assumes that its parameters
required,
are the entire population. If your
subsequent
data represents a sample of the
values are
population, than calculate the
optional.
variance by using the VAR.S
function instead.
Parameters can either be numbers
or names, arrays, or references
that contain numbers.
Logical values, and text
representations of numbers that
you type directly into the list of
parameters are counted.
If an parameter is an array or
reference, only numbers in that
array or reference are counted.
Empty cells, logical values, text or
error values in the array or
reference are ignored.
Parameters that are error values or
text that cannot be translated into
numbers cause errors.
If you want to include logical values
and text representations of
mandatory
parameters:
array1 specifies
a cell or range
of cells for
dataset 1,
array2 specifies
a cell or range
of cells for
dataset2, the
hypothesis
type, and the
last to define
paired or
unpaired

VAR.P
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numbers in a reference as part of
the calculation, use the VARPA
function instead.
VAR.S

From 1 to 255
parameters.
Only the
number1 is
required,
subsequent
values are
optional.

=VAR.S(numb Estimates variance based on a
er1,
sample (ignores logical values and
[number2],
text in the sample).
…)
VAR.S assumes that its parameters
are a sample of the population. If
your data represents the entire
population, then calculate the
variance by using the VAR.P function
instead.
Parameters can either be numbers
or names, arrays, or references
that contain numbers.
Logical values, and text
representations of numbers that
you type directly into the list of
parameters are counted.
If an parameter is an array or
reference, only numbers in that
array or reference are counted.
Empty cells, logical values, text, or
error values in the array or
reference are ignored.
Parameters that are error values or
text that cannot be translated into
numbers cause errors.
If you want to include logical values
or text representations of numbers
in a reference as part of the
calculation, use the VARA function
instead.

VARA

From 1 to 255 =VARA(value Estimates variance based on a
parameters.
1, [value2], sample.
Only the value1 …)
VARA assumes that its parameters
is required,
are a sample of the population. If
subsequent
your data represents the entire
values are
population, you must calculate the
optional.
variance by using the VARPA
function instead.
Parameters can be the following:
numbers, names, arrays, or
references that contain numbers;
text representations of numbers, or
© 2020 De Novo Software
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logical values, such as TRUE and
FALSE, in a reference.
Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.
Parameters that contain TRUE
evaluate as 1; parameters that
contain text or FALSE evaluate as 0
(zero).
If an parameter is an array or
reference, only values in that array
or reference are used. Empty cells
and text values in the array or
reference are ignored.
Parameters that are error values or
text that cannot be translated into
numbers cause errors.
If you do not want to include logical
values and text representations of
numbers in a reference as part of
the calculation, use the VAR function
instead.
VARPA

© 2020 De Novo Software

From 1 to 255 =VARPA(value Calculates variance based on the
parameters.
1, [value2], entire population.
Only the value1 …)
VARPA assumes that its parameters
is required,
are the entire population. If your
subsequent
data represents a sample of the
values are
population, you must calculate the
optional.
variance by using the VARA function
instead.
Parameters can be the following:
numbers, names, arrays, or
references that contain numbers;
text representations of numbers, or
logical values, such as TRUE and
FALSE, in a reference.
Logical values and text
representations of numbers that
you type directly into the list of
parameters are counted.
Parameters that contain TRUE
evaluate as 1; parameters that
contain text or FALSE, evaluate as
0 (zero).

514

FCS Express 6 Manual

If an parameter is an array or
reference, only values are used in
that array or reference. Empty cells
and text values in the array or
reference are ignored.
Parameters that are error values or
text that cannot be translated into
numbers cause errors.
If you do not want to include logical
values or text representations of
numbers in a reference as part of
the calculation, use the VARP
function instead.
WEIBULL.D Four obligatory
IST
parameters:
the value at
which to
evaluate the
function, the
alpha and beta
parameters to
the distribution,
and the
cumulative
parameter that
determines the
form of the
function.

=WEIBULL.DI
ST(x, alpha,
beta,
cumulative)

Wilcoxon

=Wilcoxon(ar Performs a non-parametric test
ray1,
that compares two paired groups.
array2,hypoth The test calculates the difference
esis
between each set of pairs and
type,alpha)
analyzes these differences. The
Wilcoxon Rank Sum test can be
used to test the null hypothesis that
two populations have the same
continuous distribution. Will evaluate
to TRUE when failing to reject the
null hypothesis or FALSE when
rejecting the null hypothesis.

Four
mandatory
parameters:
array1 specifies
a cell or range
of cells for
dataset 1,
array2 specifies
a cell or range
of cells for
dataset 2,
hypothesis
type, and the
significance
level

Returns the Weibull distribution. Use
this distribution in reliability analysis,
such as calculating a device’s mean
time to failure.
If x, alpha, or beta is non-numeric,
WEIBULL.DIST returns the #VALUE!
error value.
If x is negative, the WEIBULL.DIST
function returns the #NUM! error
value.
If either alpha or beta is not
positive, WEIBULL.DIST returns the
#NUM! error value.

(Credit: Investopedia)
The variables for the function are as
follows:
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[Array1...] - cell range of values
for first dataset
[Array2...] - cell range of values
for second dataset
Hypothesis Type - 0 for twotailed, 1 for right-tailed, or 2 for
left-tailed
Alpha - the significance level for
which to test (i.e. 0.05)
Four
=ZPRIME(me Calculates the Z Factor, which is an
mandatory
an
attempt to quantify the suitability of
parameters:
negative,SD a particular assay for use in a fullthe mean of
negative,mea scale, high-throughput screen by
the negative
n positive,SD comparing the Mean and Standard
control, the
positive)
Deviation of a negative control to
standard
the Mean and Standard Deviation of
deviation of the
a positive control within the
negative
experiment.
control, the
mean of the
positive control,
and the
standard
deviation of the
positive control
Three
=Z.TEST(arra Compares the normally distributed
mandatory
y1,X,sigma) data elements, mean value with
parameters:
known standard deviation,
array1 specifies
expected SD, to a mean value
a cell or range
expected mean. array1 is the
of cell values, X
dataset.
specifies the
expected
mean, and
sigma specifies
the expected
standard
deviation

Financial functions
Financial functions are designed for financial calculations and analysis. Use them to perform many of the
commonly used financial calculations, such as the calculation of yield, interest rates, investment
valuations, internal rate of return, payments and asset depreciation.
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Mnemonic Operand Type Example
s

Explanation

FV

Returns the future value of an
investment.
Make sure that you are consistent
about the units you use for
specifying rate and nper. If you
make monthly payments on a fouryear loan at 12 percent annual
interest, use 12%/12 for rate and
4*12 for nper. If you make annual
payments on the same loan, use
12% for rate and 4 for nper.
For all parameters, cash you pay
out, such as deposits to savings, is
represented by negative numbers;
cash you receive, such as dividend
checks, is represented by positive
numbers.

Three
=FV(rate,
mandatory
nper, pmt,
parameters: the [pv], [type])
interest rate per
period, the total
number of
payment periods
in an annuity,
and the payment
made each
period; it cannot
change over the
life of the
annuity.
Typically, pmt
contains principal
and interest but
no other fees or
taxes. If pmt is
omitted, you
must specify the
pv parameter
instead.
Additionally, you
can specify the
lump-sum
amount that a
series of future
payments is
worth right now.
If pv is omitted,
it is assumed to
be 0 (zero), and
you must include
the pmt
parameter.
The second
optional
parameter is
type that

© 2020 De Novo Software

Spreadsheets

517

indicates when
payments are
due. If type is
omitted, it is
assumed to be
0.
IPMT

Four mandatory =IPMT(rate,
parameters
per, nper, pv,
include: the
[fv], [type])
interest rate per
period, the
period for which
you want to find
the interest and
must be in the
range 1 to nper,
the total number
of payment
periods in an
annuity, and the
lump-sum that a
series of future
payments is
worth right now.
Additionally, you
can specify two
more
parameters that
include: the
future value, or
a cash balance
you want to
attain after the
last payment is
made (if this
parameter is
omitted, it is
assumed to be
0), and the type
that indicates
when payments
are due (if type
is omitted, it is
assumed to be
0).

Returns the interest payment for an
investment for a given period.
Make sure that you are consistent
about the units you use for
specifying rate and nper. If you
make monthly payments on a fouryear loan at 12 percent annual
interest, use 12%/12 for rate and
4*12 for nper. If you make annual
payments on the same loan, use
12% for rate and 4 for nper.
For all parameters, cash you pay
out, such as deposits to savings, is
represented by negative numbers;
cash you receive, such as dividend
checks, is represented by positive
numbers.

NPER

Three

Returns the number of periods for
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mandatory
pmt, pv, [fv], an investment based on periodic,
parameters
[type])
constant payments and a constant
include: the
interest rate.
interest rate per
period, the
payment made
each period
which cannot
change over the
life of annuity,
and the lumpsum amount
that a series of
future payments
is worth right
now.
Additionally, you
can specify the
cash balance
you want to
attain after the
last payment is
made (if this
parameter is
omitted, it is
assumed to be
0), and the type
that indicates
when payments
are due.
NPV

Two mandatory =NPV(rate,
parameters
value1,
include the rate [value2], …)
of discount over
the length of one
period and the
value1
parameter
specifies the
payments and
income. You can
specify up to
254 value
parameters.

Calculates the net present value of
an investment by using a discount
rate and a series of future payments
(negative values) and income
(positive values).
The NPV investment begins one
period before the date of the value1
cash flow and ends with the last
cash flow in the list. The NPV
calculation is based on future cash
flows. If your first cash flow occurs
at the beginning of the first period,
the first value must be added to the
NPV result, not included in the value
parameters.
NPV is similar to the PV function
© 2020 De Novo Software
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(present value). The primary
difference between PV and NPV is
that PV allows cash flows to begin
either at the end or at the beginning
of the period. Unlike the variable
NPV cash flow values, PV cash flows
must be constant throughout the
investment. For information about
annuities and financial functions,
refer to the description of the PV
function.
PMT

Three
=PMT(rate,
mandatory
nper, pv, [fv],
parameters
[type])
include: the
interest rate per
period, the
payment made
each period
which cannot
change over the
life of annuity,
and the lumpsum amount
that a series of
future payments
is worth right
now.
Additionally, you
can specify the
cash balance
you want to
attain after the
last payment is
made (if this
parameter is
omitted, it is
assumed to be
0), and the type
that indicates
when payments
are due.

Calculates the payment for a loan
based on constant payments and a
constant interest rate.
The payment returned by PMT
includes principal and interest but no
taxes, reserve payments, or fees
sometimes associated with loans.
Make sure that you are consistent
about the units you use for
specifying rate and nper. If you
make monthly payments on a fouryear loan at an annual interest rate
of 12 percent, use 12%/12 for rate
and 4 * 12 for nper. If you make
annual payments on the same loan,
use 12 percent for rate and 4 for
nper.

PPMT

Four mandatory =PPMT(rate,
parameters
per, nper, pv,
include: the
[fv], [type])
interest rate per

Returns the payment on the
principal for a given period for an
investment based on periodic,
constant payments and a constant
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PV

period, the
period for which
you want to find
the interest and
must be in the
range 1 to nper,
the total number
of payment
periods in an
annuity, and the
lump-sum that a
series of future
payments is
worth right now.
Additionally, you
can specify two
more
parameters that
include: the
future value, or
a cash balance
you want to
attain after the
last payment is
made (if this
parameter is
omitted, it is
assumed to be
0), and the type
that indicates
when payments
are due (if type
is omitted, it is
assumed to be
0).

interest rate.
Make sure that you are consistent
about the units you use for
specifying rate and nper. If you
make monthly payments on a fouryear loan at 12 percent annual
interest, use 12%/12 for rate and
4*12 for nper. If you make annual
payments on the same loan, use
12% for rate and 4 for nper.

Three
=PV(rate,
mandatory
nper, pmt,
parameters: the [fv], [type])
interest rate per
period, the total
number of
payment periods
in an annuity,
and the payment
made each
period; it cannot

Returns the present value of an
investment. The present value is the
total amount that a series of future
payments is worth now. For
example, when you borrow money,
the loan amount is the present value
to the lender.
Make sure that you are consistent
about the units you use for
specifying rate and nper. If you
make monthly payments on a four© 2020 De Novo Software
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change over the
life of the
annuity.
Typically, pmt
contains principal
and interest but
no other fees or
taxes. If pmt is
omitted, you
must specify the
pv parameter
instead.
Additionally, you
can specify the
lump-sum
amount that a
series of future
payments is
worth right now.
If pv is omitted,
it is assumed to
be 0 (zero), and
you must include
the pmt
parameter.
The second
optional
parameter is
type that
indicates when
payments are
due. If type is
omitted, it is
assumed to be
0.
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year loan at 12 percent annual
interest, use 12%/12 for rate and
4*12 for nper. If you make annual
payments on the same loan, use
12% for rate and 4 for nper.
An annuity is a series of constant
cash payments made over a
continuous period. For example, a
car loan or a mortgage is an
annuity. For more information, refer
to the description of each annuity
function.
In annuity functions, cash you pay
out, such as a deposit to savings, is
represented by a negative number;
cash you receive, such as a dividend
check, is represented by a positive
number. For example, a $1000
deposit to the bank would be
represented by the parameter –
1000 if you are the depositor and
by the parameter 1000 if you are
the bank.

Date and Time functions
Use this set of functions to identify the current date, extract a part of the date, convert the DateTime
values to other data types, and perform calculations with the dates.

Mnemo Operand Type
nics
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DATE

Three operands
defining the year,
month and day.

=DATE(1900,1, Calculates the serial number that
1)
represents a specified date.

DATEVAL The date_text
=DATEVALUE(da The DATEVALUE function converts
UE
parameter specifies te_text)
a date that is stored as text to a
a date in the Excel
serial number that the
date format, or a
ExpressSpreadSheet recognizes
reference to a cell
as a date.
that contains text
Like Excel, the
that represents a
ExpressSpreadSheet stores
date in the Excel
dates as sequential serial numbers
date format. For
so that they can be used in
example,
calculations. By default, January 1,
"1/30/2008" or
1900 is a serial number 1, and
"30-Jan-2008" are
January 1, 2008 is serial number
text strings within
39448 because it is 39447 days
quotation marks
after January 1, 1900.
that specify dates.
Most functions automatically
convert date values to serial
numbers.
The DATEVALUE function returns
the #VALUE! error value if the
value of the date_text parameter
falls outside the range of dates
between January 1, 1900 and
December 31, 9999.
DAY

One parameter
defining the serial
number of the
required date.

=DAY(TODAY()) Returns the day portion of a given
date.

DAYS

Two mandatory
=DAYS(end_dat Returns the number of days
parameters:
e, start_date) between two dates.
start_date and
If both date parameters are
end_date are two
numbers, DAYS uses EndDatedates between
StartDate to calculate the number
which you want to
of days in between both dates.
know the number
If either one of the date
of days.
parameters is text, that parameter
is treated as
DATEVALUE(date_text) and
returns an integer value instead of
a time component.
If date parameters are numeric
values that fall outside the range
of valid dates, DAYS returns the
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#NUM! error value.
If date parameters are strings that
cannot be parsed as valid dates,
DAYS returns the #VALUE! error
value.
DAYS36 Two mandatory
=DAYS360(start The DAYS360 function returns the
0
parameters:
_date,
number of days between two
start_date and
end_date,
dates based on a 360-day year
end_date are two [method])
(twelve 30-day months), which is
dates between
used in some accounting
which you want to
calculations. Use this function to
know the number
help calculate payments if your
of days. If
accounting system is based on
start_date occurs
twelve 30-day months.
after end_date, the
Like Excel, the
DAYS360 returns a
ExpressSpreadSheet stores
negative number.
dates as sequential serial numbers
Additionally, you
so that they can be used in
can specify if the
calculations. By default, January 1,
ExpressSpreadSh
1900 is a serial number 1, and
eet should use the
January 1, 2008 is serial number
European method
39448 because it is 39447 days
instead of the U.S.
after January 1, 1900.
method in the
calculation.
EDATE

Two mandatory
=EDATE(start_d
parameters:
ate, months)
start_date specifies
the start date, and
months specifies
the number of
months before or
after start_date. A
positive value for
months yields a
future date; a
negative value
yields a past date.

EOMONT Two mandatory
H
parameters:
start_date
© 2020 De Novo Software

Returns the serial number of the
date that is the indicated number
of months before or after a
specified date (the start_date).
Use EDATE to calculate maturity
dates or due dates that fall on the
same day of the month as the
date of issue.
Like Excel, the
ExpressSpreadSheet stores
dates as sequential serial numbers
so that they can be used in
calculations. By default, January 1,
1900 is a serial number 1, and
January 1, 2008 is serial number
39448 because it is 39447 days
after January 1, 1900.

=EOMONTH(sta Returns the serial number of the
rt_date,
last day of the month that is the
months)
indicated number of months
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(specifies the start
date), and months
(specifies the
number of months
before or after
start_date). A
positive value for
months yields a
future date; a
negative value
yields a past date.
HOUR

before or after start_date. Use
EOMONTH to calculate maturity
dates or due dates that fall on the
last day of the month.

One parameter
=HOUR(NOW()) Returns the hour portion of a given
defining the serial
date/time value.
number of the
required date/time
value.

ISOWEE The date
=ISOWEEKNUM( Returns the number of ISO week
KNUM
parameter is the
date)
number of the year for a given
date-time code
date.
used by the
ExpressSpreadSh
eet for date and
time calculations.
MONTH One parameter
defining the serial
number of the
required date.

=MONTH(TODA Returns the month portion of a
Y())
given date.

MINUTE One parameter
=MINUTE(NOW( Returns the minutes portion of a
defining the serial ))
given date/time value.
number of the
required date/time
value.
NOW

No parameters
required.

=NOW()

Returns the current time in general
format. You can apply further
formatting to the result of the
function.

SECOND One parameter
=SECOND(NOW Returns the seconds portion of a
defining the serial ())
given date/time value.
number of the
required date/time
value.
TIME

Three parameters =TIME(16, 48,
defining hour,
10)
minute and second

Returns a decimal number for a
specified time.
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parts of a time
value.
TIMEVAL The time_text
=TIMEVALUE(ti
UE
parameter is a text me_text)
string specifies a
time in any one of
the Microsoft
Excel® time
formats; for
example, "6:45
PM" and "18:45"
text strings within
quotation marks
that specify time.

Returns the decimal number of the
time represented by a text string.
The decimal number is a value
ranging from 0 (zero) to
0.99988426, representing the
times from 0:00:00 (12:00:00
AM) to 23:59:59 (11:59:59 PM).
Date information in time_text is
ignored.
Time values are a portion of a date
value and represented by a
decimal number (for example,
12:00 PM is represented as 0.5
because it is half of a day).

TODAY

Returns the serial number of the
current date.

No parameters
required.

WEEKDA Two parameters:
Y
the serial number
of the required
date, weekday
base.

=TODAY()

=WEEKDAY(TOD Returns the day of the week
AY())
corresponding to the specified
date.
=WEEKDAY(DAT The weekday base identifies the
first day of the week and
E( 2002, 12,
determines the return value type:
1),1) returns
1(Sunday)
1 or omitted: the first day of the
week is Sunday. The function
returns 1 for Sunday, 2 for
Monday, etc.
2: the first day of the week is
Monday. The function returns 1 for
Monday, 2 for Tuesday, etc.
3: the first day of the week is
Monday. The function returns 0 for
Monday, 1 for Tuesday, etc.

WEEKNU The serial_number =WEEKNUM(seri Returns the week number of a
M
parameter specifies al_number,
specific date. For example, the
a date within the
[return_type]) week containing January 1 is the
week. Dates
first week of the year, and is
should be entered
numbered week 1.
by using the DATE
function, or as
results of other
formulas or
functions.
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Additionally, you
can specify the
return_type
parameter that
determines on
which day the
week begins (the
default value is 1).
YEAR

One parameter
defining the serial
number of the
required date.

YEARFRA Two mandatory
C
parameters include
start_date and
end_date that
represent start
date and end date,
respectively.
Additionally, you
can specify which
type of the day
count basis to use.

=YEAR(TODAY() Returns the year portion of a given
)
date.

=YEARFRAC(sta
rt_date,
end_date,
[basis])

Calculates the fraction of the year
represented by the number of
whole days between two dates
(the start_date and end_date
parameters). Use the YEARFRAC
worksheet function to identify the
proportion of a whole year’s
benefits or obligations to assign to
a specific term.

Text functions
The text functions allow you to work with text strings.

Mnemon Operand Type
ics

Example

Explanation

&
Two parameters of = "Yellow
(ampersa type string
"&"river"
nd)

Concatenates specified strings.

CHAR

Returns the character specified y a
number. Use CHAR to translate
code page numbers you might get
from files on other types of
computers into characters.

The number
=CHAR(numb
parameter allows er)
you to specify a
number between 1
and 255
representing the
required character.
The character is
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from the character
set used by your
computer.
CLEAN

The text
=CLEAN(text) Removes all non-printable
parameter
characters from text. Use CLEAN on
specifies any
text imported from other
worksheet
applications that contains characters
information from
that may not print with your
which you want to
operating system. For example, you
remove noncan use CLEAN to remove some
printable
low-level computer code that is
characters.
frequently at the beginning and end
of data files and cannot be printed.
The CLEAN function was designed to
remove the first 32 nonprinting
characters in the 7-bit ASCII code
(values 0 through 31) from text. In
the Unicode character set, there are
additional nonprinting characters
(values 127, 129, 141, 143, 144,
and 157). By itself, the CLEAN
function does not remove these
additional nonprinting characters.

CODE

The text
=CODE(text)
parameter
specifies the text
for which you want
the code of the
first character.

CONCATE A list of strings
NATE

Returns a numeric code for the first
character in a text string. The
returned code corresponds to the
character set used by your
computer.

=CONCATENA Joins several text strings in one text
TE("Developer string. An alternative to "&".
", " Express")

DOLLAR

Two parameters =DOLLAR(957 Converts the number to text using
defining the value .344, 2)
currency format $#,##0.00_);
and the number of
($#,##0.00), with the decimals
digits to the right
rounded to the specified number of
of the decimal
places.
point in the output
string.

EXACT

The text1 and
=EXACT(text1 Compares two text strings and
text2 parameters , text2)
returns TRUE if they are exactly the
specify the first
same, FALSE otherwise. EXACT is
and second text
case-sensitive but ignores
strings.
formatting differences. Use EXACT
to test text being entered into a
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document.
FIND

The find_text
parameter
specifies the text
you want to find,
the within_text
parameter
specifies the
source text for the
text fragment you
want to find.
Additionally, you
can specify the
character at which
to start the search
as the start_num
parameter. The
first character in
within_text is
character number
1. If you omit
start_num, it is
assumed to be 1.

=FIND(find_te FIND locates one text string within a
xt,
second text string, and returns the
within_text, number of the starting position of
[start_num]) the first text string from the first
character of the second text string.
FIND always counts each character,
whether single-byte or double-byte,
as 1, no matter what the default
language setting is.

FIXED

The first parameter =FIXED(1234. Rounds the first parameter to the
of type double is 567, 1)
number of decimals determined by
required. The
the second parameter and returns it
second parameter
as a string. The third parameter
of type integer is
specifies whether to omit commas
optional (the
in the output string.
default value is 2).
The third
parameter of type
Boolean is
optional.

LEFT

The first parameter =LEFT(A1)
of type string is
=LEFT(A1, 3)
required. The
second parameter
of type integer is
optional.

LEN

One parameter of =LEN("ABC") Returns the length of a given string.
type string.

LOWER

One parameter of =LOWER(A1) Converts a string to lowercase.
type string.

Returns the first character or
characters in a text string. The
second parameter defines the
number of characters to extract.
The default value is 1.
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MID

The first parameter =MID("ABC",3 Returns the substring of a given text
is of type string,
,1)
string. The position of the substring
the second and the
is defined by the second parameter.
third parameters
The third parameter specifies the
are of type integer.
number of characters to extract.

PROPER

The text
=PROPER(text Capitalizes the first letter in a text
parameter of the )
string and any other letters in text
string type is
that follow any character other than
mandatory. Text
a letter. Converts all other letters to
enclosed in
lowercase letters.
quotation marks, a
formula that
returns text, or a
reference to a cell
containing the text
you want to
partially capitalize.

REPLACE Four mandatory
=REPLACE(old Replaces part of a text string, based
parameters: the
_text,
on the number of characters you
text in which you start_num,
specify, with a different text string.
want to replace
num_chars, REPLACE always counts each
some characters, new_text)
character, whether single-byte or
the position of the
double-byte, as 1, no matter what
character in
the default language setting is.
old_text that you
want to replace
with new_text, the
number of
characters in
old_text that you
want REPLACE to
replace with
new_text, and the
text that will
replace a specified
number of
characters in
old_text.
REPT

Two obligatory
=REPT(text, Repeats text a given number of
parameters: the
number_times times. Use REPT to fill a cell with a
text you want to )
number of instances of a text string.
repeat, and the
If number_times is 0 (zero), REPT
positive number of
returns "" (empty string).
times to repeat
If number_times is not an integer, it
text.
is truncated.
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The result of the REPT function
cannot be longer than 32767
characters, otherwise REPT returns
the #VALUE! error value.
RIGHT

The first parameter =RIGHT(B2,
of type string is
3)
required. The
second parameter
of type integer is
optional.

Returns the last character or
characters in a text string. The
second parameter defines the
number of characters to extract.
The default value is 1.

SEARCH Two obligatory
parameters of
string type.

=SEARCH("n", The SEARCH function locates one
"printer")
text string with a second text string,
and returns the number of the
starting position of the first text
string from the first character of the
second text string. For example, to
find the position of the letter "n" in
the word "printer", you can use this
function as =SEARCH("n", "printer").

SUBSTIT Three obligatory
UTE
parameters of
string type plus an
optional
instance_num
parameter that
allows you to
specify what
instance of the old
text should be
replaced.

=SUBSTITUTE
(text,
old_text,
new_text,
[instance_nu
m])

Substitutes new_text for old_text in
a text string. Use SUBSTITUTE when
you want to replace specific text in a
text string; use REPLACE when you
want to replace any text that occurs
in a specific location in a text string.

T

One obligatory
parameter of any
type.

=T(value)

Returns the text referred by value.

TEXT

Two obligatory
=TEXT(A1,
parameters: first is "$0.00")
a numeric value or
a reference to a
cell containing a
numeric value;
second is a
numeric format as
a text string
enclosed in
quotation marks,
for example "m/d/

The TEXT function converts a
numeric value to text and allows
you to specify the display formatting
by using special format strings. This
function is useful in situations where
you want to display numbers in a
more readable format, or you want
to combine numbers with text or
symbols. For example, suppose cell
A1 contains the number 23.5. To
format the number as a dollar
amount, you can use the following
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formula: =TEXT(A1, "$0.00")

TRIM

One parameter of =TRIM("
Removes all spaces from text
string type
Express
except for single spaces between
Spread Sheet words.
")

TRUNC

Two parameters: =TRUNC(num Truncates a number to an integer by
the number that is ber,
removing the fractional part of the
truncated, and the [num_digits]) number.
optional
num_digits
parameter that
specifies the
precision of the
trunctaion. The
default value for
num_digits is 0
(zero).

UPPER

One parameter of =UPPER(A1&A Converts a string to uppercase.
type string.
2)

VALUE

One obligatory
parameter of
string type.

=VALUE(text) Converts a text string that
represents a number to a member.
Text can be in any of the constant
number, date, or time formats
recognized by the
ExpressSpreadSheet. If text is not
in one of these formats, VALUE
returns the #VALUE! error value.
You do not generally need to use
the VALUE function in a formula
because the ExpressSpreadSheet
automatically converts text to
numbers as necessary. This function
is provided for compatibility with
other spreadsheet applications.

Information functions

Functions which test the type of a value and return a Boolean result.

MnemonOperand Type
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11.5

ISBLANK A value of any
type.

=ISBLANK(A1 Returns TRUE if cell is empty.
)

ISERR

A value of any
type.

=ISERR(H1)

ISEVEN

A value of any
type.

=ISEVEN(B1) Returns TRUE if the number is even

Returns TRUE if the cell contains any
error value except #N/A.

ISERROR A value of any
type.

=ISERROR(A7 Returns TRUE if the cell contains any
)
error value (#N/A, #VALUE!, #REF!,
#DIV/0!, #NUM!, #NAME?, or
#NULL!).

ISLOGIC A value of any
AL
type.

=ISLOGICAL( Returns TRUE if the specified value
C3)
refers to a logical value.

ISNA

=ISNA(E5)

A value of any
type.

Returns TRUE if the cell contains #N/
A (value not available) error value.

ISNONTE A value of any
XT
type.

=ISNONTEXT( Returns TRUE if the cell does not
D4)
contain text. Returns TRUE for blank
cells.

ISNUMBE A value of any
R
type.

=ISNUMBER(A Returns TRUE if the cell contains a
2)
number.

ISTEXT

A value of any
type.

=ISTEXT(D1) Returns TRUE if the specified cell
contains text.

ISODD

A value of any
type.

=ISODD(A2)

ISTEXT

A value of any
type.

=ISTEXT(A1) Returns TRUE if the value is a text.

N

A value of any
type.

=N(F7)

Returns a value converted to a
number.

NA

A value of any
type.

=NA(B2)

Returns the error value #N/A.

Returns TRUE if the number is odd.

Renaming Spreadsheets
To rename your Spreadsheet:
1.
2.
3.
4.

Open the Data Navigator 126 .
Right click on the spreadsheet to rename.
Select Rename from the list.(Figure 11.19)
Enter the new name in the edit field and press Enter.
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Figure 11.19 Rename a spreadsheet.

11.6

Deleting Spreadsheets
To delete a Spreadsheet
1. Select the spreadsheet in the layout.
2. Press Delete. If you want to immediately restore a spreadsheet that was
deleted by mistake, use the Undo command in the Quick Access Toolbar 65 .
Please note that the steps above will only delete the spreadsheet object from
the page but it will still remain associated with the layout in the Data
Navigator 126 . To completely remove a spreadsheet from the layout right-click
on the spreadsheet in the Data Navigator and choose Delete from the popup menu.
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Exporting Data in Spreadsheets
Spreadsheets created within FCS Express may be exported to various external
file formats such as .xls, .xls, .csv, .html, .xml and .txt.
Formulas, formatting, and references will be preserved when selecting to save in
the .xls or .xlsx file format.
To export a spreadsheet created within FCS Express:
1. Left click within the desired spreadsheet to select it. The spreadsheet will enter
into Edit mode (green borders) and the Spreadsheet category will appear in
the Ribbon bar (Figure 11.20, Step 1).
2. Select Spreadsheet Layout Export Export (Figure below, Step 2) in
the Ribbon.
3.Navigate to the desired file path location in the Export Spreadsheet To dialog
(Figure below, Step 3).
4.Enter the file name to be used.
5. Select the desired file format (Figure below, Step 4).
6.Click Save.

Figure 11.20 How to Export a Spreadsheet created whitin FCS Express.

11.8

Graphing Data with Pie Charts, Bar Plots, and
Scatter with Regression Plots
Data in a spreadsheet can be graphed in FCS Express as Pie Charts 535 , Bar Plots
544 , Scatter Plots 556 , and Scatter with Regression Plots 575 . Graphing data from
spreadsheets in FCS Express allows you to easily visualize trends in your data as
plots update in real time in response to gate, marker, and quadrant adjustments
or as data files update via Next/Previous 79 or Batch Processing 782 . Data may
also be graphed from data files values inserted in a spreadsheet from the data
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535

.

Graphing Bar Plots 544
Graphing Pie Charts 535
Graphing Scatter Plots 556
Scatter with Regression Plots

575

.

Please note that in all graph types the first row of a corresponding spreadsheet
may be enable for use as the data label source. Please see the Formatting
Spreadsheet section for additional details 420 .

11.8.1

Pie Charts
Pie charts are a convenient means for visualizing how several statistics relate to
one another and combine to form a conceptual whole (e.g., Figure 11.21).
Pie Charts can be inserted anywhere on your layout 536 , and can be populated via
drag-and-drop 537 or from Spreadsheets 539 containing statistical tokens or
freetext. They are also fully formattable 541 .
The appearance of Pie Charts in FCS Express is customizable via special
formatting options 541 .

Figure 11.21 Pie Chart in FCS Express
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11.8.1.1

Inserting Pie Charts

Pie Charts are inserted like any other plot in FCS Express (see below). In FCS
Express, Pie Charts may be created easily by drag and drop 537 , or from an
existing spreadsheet 539 .
To insert a blank Pie Chart to populate by drag and drop

537

:

1. Click the Insert tab
D Plots
command.
2. Click on a blank space of the layout to insert the Pie Chart.
An empty Pie Chart will appear, to which you can drag and drop any statistic in
FCS Express to populate the pie 537 . Note: if a spreadsheet exists in your
layout, the inserted Pie Chart will be populated with its data. Simply insert
another Pie Chart to create an empty Pie Chart for receiving the dragged and
dropped items. The first Pie Chart may be deleted, if desired.
To insert a Pie Chart from a spreadsheet:
1. Select a spreadsheet in the Layout 413 .
2. Click the Insert tab
D Plots
command (Figure 11.22).
3. Click on a blank space of the layout to insert the Pie Chart.
Note: The spreadsheet should be formatted so the first column (A) contains
the name of the series and the second column (B) contains the values to be
plotted. If the data exists in different rows the Pie Chart may be formatted to
select the appropriate columns of data. 541

In both cases, a new Pie Chart will appear on the layout that is populated with
the data from the spreadsheet. The Pie Chart may now be populated with the
desired parameters 539 and formatted as you wish 541 .

Figure 11.22 Inserting a Pie Chart
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11.8.1.1.1 Populating Pie Charts by Drag and Drop

Pie Charts are easy to populate through the drag-and-drop functionality in FCS
Express. You can drag plots or gates 538 , statistical tokens 538 , or free text to
create or replace sectors (slices) 539 on a blank Pie Chart that has already been
inserted on your layout 536 .
When populating a previously blank Pie Chart by drag-and-drop, the following
actions are available:
Insert a new statistic or value to be plotted as a slice in the pie chart.
Replace the value of an existing slice in pie chart with a new value. 539

538

See the figures and steps below to learn how to populate Pie Charts by dragand-drop.
After inserting a blank Pie Chart 536 , dragging and dropping gates onto it will cause
the Edit Statistic dialog to appear. The specific statistic relating to the gate can
be chosen for plotting (e.g., "% of Gated Cells" in Fig. 11.23).

Figure 11.23 Edit Statistic dialog appearing after dragging a gate to a Pie Chart
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The result of dragging and dropping a gate to a Pie Chart and choosing the
desired statistic in the Edit Statistic 537 dialog is shown in Fig. 11.24 below.

Figure 11.24 Dragging a gate to a Pie Chart to add a sector (slice)

Statistical tokens or freetext from default statistics windows or text boxes on
your layout can also be dragged directly to Pie Chart. The data value must be
dropped on the plot outside of the existing pie area (if dropped on the pie area
the current value representing the slice will be replaced with the dropped value 539
). In this case, the Edit Statistic dialog will not appear. In the example below,
the selected "Gate 1, % of gated cells" statistic is dragged to an empty space on
the Pie Chart, in order to add a new sector (slice) (Fig. 11.25).

Figure 11.25 Dragging and dropping a statistic token to the Pie Chart

Dragging a plot, gate, or statistic onto an existing sector (slice) will replace it with
the desired statistic, as shown below (Fig. 11.26).

© 2020 De Novo Software

Spreadsheets

539

Figure 11.26 Dragging and dropping a gate to replace an existing sector (slice) on
a Pie Chart

11.8.1.1.2 Populating Pie Charts from Spreadsheets

An alternative to populating Pie Charts by dragging and dropping values is to
populate a pie chart from an existing Spreadsheet 412 .
If a Spreadsheet exists on the layout, an inserted Pie Chart 536 will be
automatically populated with the data from Columns A and Column B within the
Pie. Column A will be the series name and column B the value used in the Pie
Chart. If more than one spreadsheet exists, select
that which is intended as
the data source prior to inserting the Pie Chart 536 .
1214

By default, the first two columns of the Custom Data Grid for the Name- and
Value-parameters of each sector (slice) will be plotted on the Pie Chart,
respectively.
To populate the Pie Chart with parameters other than these first two columns of
the Custom Data Grid,
1.Select the Format tab
11.27)
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Figure 11.27 Choosing parameters for Pie Chart

2.Choose the Spreadsheet column intended for the value of the sector
(slice), from the Value Parameter drop-down menu ( )
3.Choose the Spreadsheet column intended for the name of the sector
(slice), from the Name Parameter drop-down menu ( )
See Formatting Pie Charts
rings, and more.

541

for details on how to customize colors, legends,
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Formatting Pie Charts

Pie Charts in FCS Express are fully formattable. In addition to many of the
formatting options shared by all plots 245 (border, size, background, titles, and
legend), special formatting options are accessible from the Overlays category.
To access these special options:
Select the Pie Chart and use the Format tab
command (Figure 11.28), or

Plot Options

Right-click on the Pie Chart, select Format from the pop-up menu, and
choose the Overlays category.
Special formatting options for Pie Charts are pictured below and include:
Plotting additional data as a Ring Parameter ( )
Explode Parameter for exploding individual sectors (slices) for emphasis (
)
Color Parameter for sector (slice) colors ( , )
Shadow ( )
Displaying of Pie Chart as filled pie (default) or "donut" ( )
Caption Style ( )
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Figure 11.28 Special formatting options for Pie Charts

The formatting options are described in the table below.
Option
Value Parameter

Explanation
The parameter (column) from the Spreadsheet 539 displayed as
value of the sector (slice).
Name Parameter
The parameter (column) from the Spreadsheet 539 displayed as
name of the sector (slice).
The parameter (column) from the Spreadsheet displayed as sector
Ring Parameter
values of the Ring. See below 543 for more information on displaying
additional data as a Ring on Pie Charts.
Explode Parameter The parameter (column) from the Spreadsheet from which the
Explode rule derives. A sector (slice) will explode away from the
pie for emphasis (e.g., the yellow sector shown below 544 ) if its
value meets the criterion defined by the Explode rule. See below
543 for more information on how to define am Explode rule.
The parameter (column) from the Spreadsheet defining the display
Color Parameter
color the sector (slice). See the Pie Charts tutorial 1740 for details.
Whether a shadow behind the Pie Chart is shown.
Show Shadow
Any of twenty preset coloring schemes which can be applied to the
Color Scheme
Pie Chart.
© 2020 De Novo Software
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Option
Show as "donut"
chart
Hole size
Caption Style
Legend Title
Change data file
during Next/Prev/
Batch
Visible

543

Explanation
Whether the Pie Chart is shown with a hole in the center.
If the Pie Chart is shown as "donut" ( ), the size of the donut
hole.
The Name, Value, percentage of the pie (note: "percentage of the
pie" differs from "percent gated") or any combination thereof can
be shown as text directly beside each sector of the pie or ring.
Text title for the Name parameters listed in the Legend.
Whether the Pie Chart changes during batch processing 782 or in
response to a Next/Previous 79 command. It is generally
recommended to leave this unchecked (default), as the Pie Chart
will update automatically as the data to which it refers is changed.
Whether the Pie Chart is visible within the object.

To add Ring values as additional data at the periphery of the pie 543 or Exploding
for emphasis 543 to a Pie Chart, these values must be entered into designated
columns in the Spreadsheet.
To define values for the Ring:
1. Go to an empty column of the Spreadsheet 412 .
2. Enter the value 417 of the Ring for each row (each row corresponds to an
individual slice, or sector, of the pie). This value may be freetext or a
custom token 725 .
3. Choose the appropriate Spreadsheet column for the Ring Parameter
(Figure 11 above, )
An example of a Pie Chart with additional Ring values (plotted at the periphery
of the Pie) and its associated Spreadsheet is shown in Figure 11.29 below.
To define an Explode rule:
1. Go to an empty column of the Spreadsheet 412
2.Enter the value 417 of the rule for each row (each row corresponds to an
individual slice, or sector, of the pie). The rule must be a formula evaluating
to "TRUE" or "FALSE"; if "TRUE," the sector (slice) will explode away from
the pie. An example of an Explode rule referring to a cell within the
Spreadsheet is shown in Figure 11 below.
3. Choose the appropriate Spreadsheet column for the Explode Parameter
(Figure 11 above, )
An example of a Pie Chart with the Explode option and its associated
Spreadsheet is shown in Figure 11 below.
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Figure 11.29 Pie Chart and associated Spreadsheet with Ring and Explode
formatting options

11.8.2

Bar Plots
Bar Plots are a convenient visualization tool for comparing several statistics at a
glance, whether these derive from different gates, plots, data files, ratios, or
complex statistical formulae. Bar plots are unitless along the X-axis, being
labeled with user-defined, nominal categories instead (e.g., Figure 11.30). Thus
bar plots are not truly bivariate, unlike scatter plots.
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Figure 11.30. Bar Plot in FCS Express

Bar Plots can be inserted anywhere on your layout 545 , and can be populated
from Spreadsheets 550 or by dragging and dropping gates, plots, or statistical
tokens 546 . They are also fully formattable 553 .

11.8.2.1

Inserting Bar Plots

Bar Plots are inserted like any other plot in FCS Express (see below). In FCS
Express 6, Bar Plots may be created easily by drag and drop 545 , or from a
Spreadsheet 545 .
To insert a blank Bar Plot to populate by drag and drop

546

:

1. Click the Insert tab
D Plots
command (Figure 11.31).
2. Click on a blank space of the layout to insert the Bar Chart.
An empty Bar Plot will appear, to which you can drag and drop any statistic in
FCS Express to populate the bars 546 . Note: if a Custom Data Grid exists in
your layout, the inserted Bar Plot will be populated with its data. Simply insert
another Bar Plot to create an empty Bar Plot for receiving the dragged and
dropped items. The first Bar Plot may be deleted, if desired.
To insert a Bar Plot from an existing Spreadsheet:
1. Select a Spreadsheet in the Layout 412 .
2. Click the Insert tab
D Plots
command.
3. Click on a blank space of the layout to insert the Bar Plot.

© 2020 De Novo Software

546

FCS Express 6 Manual

Alternatively:
1. Drag a Spreadsheet from the Data Navigator 126 to an empty part of the
page.
2. Release the mouse button.
3. Select Bar from the Select Plot Types… dialog.

Figure 11.31 Inserting a Bar Plot

See the following sections to learn how to add data to Bar Plots:
Populating Bar Plots by Drag-and-Drop 546
Populating Bar Plots from Spreadsheets 550
11.8.2.1.1 Populating Bar Plots by Drag-and-Drop

Bar Plots are easy to populate through the drag-and-drop functionality in FCS
Express 6. You can drag gates 547 , statistical tokens 548 , or freetext to create
bars on a Bar Plot that has been inserted on your layout 545 .
When populating a Bar Plot by drag-and-drop, the following attributes can be
controlled:
The
The
The
The

specific statistic 546 relating to the gate to be plotted.
position of the new bar 548 relative to existing bars.
addition of new overlays 549 to the Bar Plot.
X-axis label 550 for each bar.

See the figures and steps below to learn how to populate Bar Plots by drag-anddrop.
After inserting a Bar Plot 545 , dragging and dropping gates onto it will cause the
Edit Statistic dialog to appear. The specific statistic relating to the gate can be
chosen for plotting (e.g., "% of Gated Cells" in Fig. 11.32).
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Figure 11.32 Edit Statistic dialog appearing after dragging a gate to a Bar Plot

The result of dragging and dropping a gate to a bar plot and choosing the desired
statistic in the Edit Statistic 546 dialog is shown in Fig. 11.33.

Figure 11.33 Dragging and dropping a gate onto a Bar Plot

A second gate can be dragged to the Bar Plot to open the Edit Statistic
from which a statistic for the second bar is chosen (Fig. 11.34).
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Figure 11.34 Dragging and dropping a second gate onto a Bar Plot

Statistical tokens or freetext from default statistics windows or text boxes on
your layout can also be dragged directly to Bar Plots. In this case, the Edit
Statistic dialog will not appear. In the example below, the selected "CD8, % of
gated cells" statistic is dragged to the second position, to form a new bar
between the existing two (Fig. 11.35).

Figure 11.35 Dragging and dropping a statistic token to the middle position in a Bar
Plot

To add an overlay, drag the data source toward the Bar Plot and drop it below
the axis (Fig. 11.36, ); the overlay will be overlaid onto the first bar.
To add subsequent bars, drag the data source toward the Bar Plot and drop it to
the right of the intended bar of the first overlay (Fig. 11 (below) ).
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Figure 11.36 Dragging and dropping an overlay to a Bar Plot

To add a descriptive X-axis label for each bar:
1.Click on the label
2.Enter freetext or tokens 688 (using the
button) into the label editor bar.
Fig. 11.37.
3.Click the green check mark in the label editor bar or hit Enter on the
keyboard to accept the change. In the example below, the label for the
second bar has been edited to "population 2".
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Figure 11.37 Clicking on a Bar Plot axis label to edit it

See the Formatting Bar Plots section
bar style, error bars, and more.

553

for details on how to customize colors,

11.8.2.1.2 Populating Bar Plots from Spreadsheets

It is generally more convenient to populate Bar Plots via drag-and-drop
the following situations require use of a Spreadsheet 412 :

546

, but

Bars derived from:
o Custom Tokens 725 that cannot serve as a drag source during drag-anddrop (e.g., those not visible within a text box 688 )
o The results of Parameter Math or array formulas 745 calculated within a
Spreadsheet 415 , and
Error bars or highlighting parameters 553 .
Note: Bar Plots requiring these formatting elements can still be populated
with bars via drag-and-drop 546 , but accessing the Spreadsheet is required
to add them.
If a Spreadsheet exists on the layout, an inserted Bar Plot 545 will be automatically
populated with the data within the Spreadsheet. If more than one Spreadsheet
exists, select
that which is intended as the data source prior to inserting the
Bar Plot 545 .
1214

By default, the Bar Plot will plot the first two columns of the Spreadsheet for the
X- and Y-parameters, respectively.
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To populate the Bar Plot with parameters other than the first two columns of the
Spreadsheet,
1.Select the Format tab
11.38).

Plot Options

command (Figure

Fig. 11.38 Populating a Bar Plot from Spreadsheet parameters

2.Choose the parameter (i.e., Spreadsheet column) intended for the X-axis,
from the Bar Labels drop-down menu ( ).
3.Choose the parameter (i.e., Spreadsheet column) intended for the Y-axis,
from the Bar Values drop-down menu ( ).

To add an overlay to an existing Bar Plot, either
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Drag and drop a Spreadsheet onto the Bar Plot, or
Drag and drop another Bar Plot onto the recipient Bar Plot, or
Right-click on the Bar Plot
1.Select Add Overlay using Advanced Open Data Dialog from the popup menu.
2.Select the data source in the Active Files tab of the Open Data File
dialog (Figure 11.39).
3.Click OK.

Figure 11.39 Selecting a Spreadsheet to overlay onto an existing Bar Plot

4.Select the parameters for the new Overlay in the Add overlays dialog.
5.Click OK (Figure 11.40).
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Figure 11.40 Selecting parameters to overlay onto an existing Bar Plot

See the Formatting Bar Plots section
bar style, error bars, and more.
11.8.2.2

553

for details on how to customize colors,

Formatting Bar Plots

Bar Plots in FCS Express are fully formattable. In addition to the formatting
options shared by all plots 245 (e.g., border, size, background, axis 556 , titles, and
legend), special formatting options are accessible from the Overlays category.
To access these special options, either
Select the Bar Plot and use the Format tab
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command, or
Right-click on the Bar Plot, select Format from the pop-up menu, and
choose the Overlays category.
Special formatting options for Bar Plots are indicated by number below (Figure
11.41) and include:
Bar color ( ), shape (
Highlighting ( , ).
Error bars ( , ).

), fill (

,

), and border (

).

Figure 11.41 Special formatting options for Bar Plots

The formatting options are described in the table below.
Option
Bar Labels
Bar Values
Error Bar
Parameter
Highlight Param.

Highlight Color
Gate

Explanation
The parameter (column) from Spreadsheets 551 displayed on the X
axis.
The parameter (column) from Spreadsheets 551 displayed on the Y
axis.
The parameter (column) from the Spreadsheet displayed as error
bars. See below 555 for more information on how to define the error
bars.
The parameter (column) from the Spreadsheet from which the
highlighting rule derives. Bars will be highlighted (e.g., the yellow
bar shown in this example 544 ) in the color defined in
if their
value meets the criterion defined by the Highlighting rule. See
below 555 for more information on how to define a highlighting rule.
The display color for highlighted bars.
The gate that is applied to the Bar Plot.
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Option
Bar Color
Bar Shape
Legend Text
Bar Fill Color
Bar Fill Pattern
Change data file
during Next/Prev/
Batch
Visible

Show marks
Line Options for
Bar Border/Error
Bar Properties
/

555

Explanation
The display color for bars.
The shape of the bar. Choose between rectangle (default),
pyramid, cylinder, ellipse, arrow, cone, bevel, cube, and diamond
options.
The text that will appear in the plot legend beside the symbol for
the overlay.
The stripe fill color for bars with fill patterns.
The fill pattern of the bar. Choose between none (default), cross,
diagonal, horizontal, and vertical stripe options.
Whether the Bar Plot changes during batch processing 782 or in
response to a Next/Previous 79 command. It is generally
recommended to leave this unchecked (default), as the Bar Plot will
update automatically as the data to which it refers is changed.
Hides overlays without removing them. Select the overlay file from
the 2D bar Overlays list and uncheck Visible. Check Visible to
show the overlay again.
Displays the value of the bars as text directly above the bars.
Toggle between Bar Border and Error Bar Pen editing mode.
Width, Style (solid, dotted, and dashed options), and Color of the
Bar Border or Error Bars.

To add error bars 555 or highlighting 555 to a Bar Plot, these values must be
entered into designated columns in the Spreadsheet.
To define values for the Error Bars,
1.Go to an empty column of the Spreadsheet 412
2.Enter the value 417 of the error for each row (each row corresponds to an
individual bar). This value may be freetext or a custom token 725 .
3.Choose the appropriate Spreadsheet column for the Error Bar Parameter
(Figure 11 (above), ).
An example of a Bar Plot with Error Bars and its associated Spreadsheet is
shown in Figure 11.42 below.
To define a Highlighting rule,
1.Go to an empty column of the Spreadsheet 412
2.Enter the value 417 of the rule for each row (each row corresponds to an
individual bar). The rule must be a formula evaluating to "TRUE" or
"FALSE"; if "TRUE," the bar will be highlighted with the color defined in the
Formatting Overlays window, , in the chart shown above. An example
of a Highlighting rule referring to a cell within the Spreadsheet is shown
below in Figure 11 below.
3.Choose the appropriate Spreadsheet column for the Highlight Param. (as
shown in the Formatting Overlays window, , in the Special formatting
options figure above the chart).
An example of a Bar Plot with Highlighting and its associated Spreadsheet is
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shown below.

Figure 11.42 Bar Plot and Spreadsheet with Error Bars and
Highlighting.

Note: Bar Plot Axis titles may be defined in the Axes
options.

11.8.3

253

category of Formatting

Scatter Plots
Scatter plots facilitate the observation of relationships between two variables*.
These variables may be native to the experiment (e.g., time and fluorescence
.fcs file parameters), simple statistical tokens 688 derived from different plots or
populations, or complex statistical formulae defined in Custom Tokens 725 . Unlike
bar plots and pie charts, scatter plots are true 2D plots.
Scatter Plots (e.g., Figure 11.43)can be inserted anywhere on your layout 557 ,
and are populated from Spreadsheets 557 containing statistical tokens or freetext.
They are also fully formattable 560 .
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Figure 11.43. Scatter Plot in FCS
Express

* Note: If you plan on performing a regression analysis (best-fit curve) of your
data, it is strongly recommended to insert a Scatter with Regression Plot 575
instead. Scatter with Regression Plots facilitate automatic overlay of the
regression curve onto your raw data.

11.8.3.1

Inserting Scatter Plots

To insert a Scatter Plot:
Use the Insert tab 1D Plots
on a blank space of the layout

Scatter command (Figure 11.44) and click

Learn more about Populating Scatter Plots from Spreadsheets

557

Figure 11.44 Inserting a Scatter Plot

11.8.3.1.1 Populating Scatter Plots from Custom Data Grids

Scatter Plots are populated from Spreadsheets

412

.

If a Spreadsheet exists on the layout, an inserted Scatter Plot
automatically populated with the data from the Spreadsheet.
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If more than one Spreadsheet exists on the layout, select the Spreadsheet
that which is intended as the data source prior to inserting the Scatter Plot 557 .
1214

By default, the Scatter Plot will plot the first two columns of the Spreadsheet for
the X- and Y-parameters, respectively.
To populate the Scatter Plot with parameters other than the first two columns of
the Spreadsheet,
1.Select the Format tab
11.45)

Plot Options

command (Figure

Fig. 11.45 Populating a Scatter Plot from Spreadsheet parameters

2.Choose the parameter (i.e., Spreadsheet column) intended for the X-axis,
from the X Parameter drop-down menu ( )
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3.Choose the parameter (i.e., Spreadsheet column) intended for the Y-axis,
from the Y Parameter drop-down menu ( )
Note: Alternatively, click and hold on the axis parameter name and select the
intended parameter from the list of available parameters.
To add an overlay to an existing Scatter Plot, either
Drag and drop a Spreadsheet onto the Scatter Plot.
Drag and drop another Scatter Plot onto the recipient Scatter Plot.
Right-click on the Scatter Plot.
1.Select Add Overlay using Advanced Open Data Dialog from the popup menu.
2.Select the data source in the Active Files tab of the Open Data File
dialog (Figure 11.46).

Figure 11.46 Selecting a Spreadsheet to overlay onto an existing Scatter Plot

3.Click OK.
4.Select the parameters for the new Overlay in the Add overlays dialog.
5.Click OK (Figure 11.47).
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Figure 11.47 Selecting parameters to overlay onto an existing
Scatter Plot
11.8.3.2

Formatting Scatter Plots

Scatter Plots in FCS Express are fully formattable. In addition to the formatting
options shared by all plots 245 (e.g., border, size, background, axis 564 , titles, and
legend), special formatting options are accessible from the Overlays category.
To access these special options, either
Select the Scatter Plot and use the Format tab
command, or

Plot Options

Right-click on the Scatter Plot, select Format from the pop-up menu, and
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choose the Overlays category.
Special formatting options for Scatter Plots are indicated by number below
(Figure 11.48) and include:
Point Color ( )
Point size ( )
Point shape ( )
Highlight Param( )
Highlight Color( )
Error Bar Param ( )

Figure 11.48 Special formatting options for Scatter Plots
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The formatting options are described in the table below.
Option
X Parameter
Y Parameter
Error Bar Param.

Highlight Param.

Highlight Color
Gate
Point Color
Legend Text
Point Fill Color
Point Fill Style
Point size

Explanation
The parameter (column) from the Spreadsheet 558 displayed on the
X axis.
The parameter (column) from the Spreadsheet 558 displayed on the
Y axis.
The parameter (column) from the Spreadsheet displayed as error
bars. See below 562 for more information on how to define the error
bars.
The parameter (column) from the Spreadsheet from which the
highlighting rule derives. Points will be highlighted (e.g., the orange
point in the plot below 563 ) in the color defined in
if their value
meets the criterion defined by the Highlighting rule. See below 562
for more information on how to define a highlighting rule.
The display color for highlighted points.
The gate that is applied to the Scatter Plot.
The display color for points.
The text that will appear in the plot legend beside the symbol for
the overlay.
The color used to fill points.
The style used to fill points.
The size of the points.

The shape of the points. Choose between rectangle (default),
triangle, circle, cross, star, hexagon, and diamond options.
Connect the points Whether the points are connected by a line.
Change data file
Whether the Scatter Plot changes during batch processing 782 or in
during Next/Prev/ response to a Next/Previous 79 command. It is generally
Batch
recommended to leave this unchecked (default), as the Scatter
Plot will update automatically as the data to which it refers is
changed.
Visible
Hides overlays without removing them. Select the overlay file from
the 2D Unbinned Overlays list and uncheck Visible. Check
Visible to show the overlay again.
Show marks
Displays the value of the points as text directly above the points.
Toggle between Error Bar Pen, Shape Border, and Connecting Lines
Line Options for
editing mode.
Error Bar Pen/
Width, Style (solid, dotted, and dashed options), and Color of the
Shape Border/
Error Bar Pen, Shape Border, or Connecting Lines.
Connecting Lines
Properties
Point shape

To add error bars 562 or highlighting 563 to a Scatter Plot, these values must be
entered into columns in the Spreadsheet.
To define values for the Error Bars,
1.Go to an empty column of the Spreadsheet 412
2.Enter the value 417 of the error for each row (each row corresponds to an
individual bar). This value may be freetext or a custom token 725 .
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3.Choose the appropriate Spreadsheet column for the Error Bar Parameter
(Figure 11 above, ).
An example of a Scatter Plot with Error Bars and its associated Spreadsheet is
shown in the figure below.
To define a Highlighting rule,
1.Go to an empty column of the Spreadsheet 412
2.Enter the value 417 of the rule for each row (each row corresponds to an
individual point). The rule must be a formula evaluating to "TRUE" or
"FALSE"; if "TRUE," the point will be highlighted with the color defined in
Figure 11 above, . An example of a Highlighting rule referring to a cell
within the Spreadsheet is shown below in Figure 11.49.
3.Choose the appropriate Spreadsheet column for the Highlight Param.
(Figure 11 above, ).
An example of a Scatter Plot with Highlighting and its associated Spreadsheet
is shown in Figure 11 below.

Figure 11.49 Scatter Plot and associated Spreadsheet with
Error Bars and Highlighting
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Note: Scatter Plot Axis titles may be defined:
directly in the Spreadsheet by using the column header (this require to
check the Use values in a first row as labels 420 option in the Spreadsheet
Formatting dialog 419 ).
in the Axes 253 category of Formatting options.
11.8.3.3

Regression Analysis (Manually fitting data)

FCS Express has the ability to perform regression analysis on your data through
manual formulas and custom data grids or at a click through Scatter with
Regression plots 575 .

FCS Express provides the user with many mathematical functions to create
custom tokens 725 and custom data 412 sets. These functions operate similar to
functions within Microsoft Excel™. When it comes to regression analysis there
are four basic functions that apply to all of the available equations that a
regression can be performed on. In the table below the functions are listed with
the red italic, xxx, representing the FCS Express Function name for a particular
equation 574 (The FCS Express Function names can be found in the Available
Equations 574 .). A description of the function argument is given in the right side of
the table.
Regr Descriptio Arguments
Result
essio n
n
Funct
ion
Type
Perfor Performs a ([X Values],[Y Values],[SD],[Fixed Parameters]) Comma
mxxx fit of the
Where X Values is a comma delimited list of X
delimited
Fit
specified X- values, generally specified by a series of tokens 688 . list of all of
Y values to Where Y Values is a comma delimited list of Y
the fit
a particular values, generally specified by a series of tokens 688 . variables
equation. Fixed Parameters allows you to specify variables and their fit
that should not be fit, but will be forced to use the values
value that you specify. The format of the Fixed
parameters is a comma delimited list of var=value
where var is one of the available variables for that
equation 574 and value is the value to fix it to.
SD, or Standard Deviation, allows you to specify a
standard deviation for each list of the Y values,
generally specified by a series of tokens 688 . The SD
value assigns a "weight" to each associated X and
Y value with a lower SD value resulting in a higher
weight and a higher SD value resulting in a lower
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weight. If the SD is not specified, an SD of zero is
assumed for each Y value.
Extra Extracts a
ctxxx particular
Result variable
s
from the
result of a
Performxx
xFit
custom
token.

ExtractxxxResults([modelParameters], "Variable The value
1" | "Variable 2" | "Variable 3")
of the
Where xxx represents an equation 574 (ie. Linear, specified
Sigmoidal, Exponential, etc...).
variable.
Where modelParameters represents a comma
delimited list of all of the fit variables and their
values, generally specified by a token 688 result of
the PerformxxxFit function.
Where Variable represents a variable defined by
the PerformxxxFit function and "|" represents "or"
.
Each PerformxxxFit function will define a unique
set of variables that will replace the example of
"Variable 1, Variable 2, Variable 3" when the
function is used: ie... "m" | "b" | "r2" or "A" | "B" |
"C"| "r2" for Linear and Sigmoidal equations
respectively. Unwanted variables must be deleted
to return a result. For example:
ExtractLinearResults([modelParameters], "m") will
return the fit value result of the "m" variable
associated with the equation.
xxxXt Uses the X xxxXToY(X, [modelParameters])
Comma
oY
values of a Where xxx represents an equation 574 (ie. Linear,
delimited
given data Sigmoidal, Exponential, etc...).
list of all of
set and the Where X is a comma delimited list of X values,
the Y
688
"Model
generally specified by a token .
values
Parameters Where modelParameters represents a comma calculated
" or "Fit" of delimited list of all of the fit variables and their fit from the
a
values. Generally specified by a token 688 result of associated
regression the PerformxxxFit function.
equation, X
to return
value, and
an
fit
unknown Y
variables.
Value.
xxxYt Uses the Y xxxYToX(Y, [modelParameters])
Comma
oX
values of a Where xxx represents an equation 574 (ie. Linear, delimited
given data Sigmoidal, Exponential, etc...)
list of all of
set and the Where Y is a comma delimited list of Y values,
the X
"Model
generally specified by a token 688 .
values
Parameters Where modelParameters represents a comma calculated
" or "Fit" of delimited list of all of the fit variables and their fit from the
a
values. Generally specified by a token 688 result of associated
regression the PerformxxxFit function.
equation, Y
to return
value, and
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an
unknown X
Value.

fit
variables.

To view a list of all possible equations please see the topic of Available Equations
574 . To see an example of using these equations please see the topic of
Regression Analysis Example 566 or visit the Linear Regression Analysis
tutorial.
1701

11.8.3.3.1 Manual Regression Analysis Example

In order to perform a manual regression analysis, you will use a custom data set.
To demonstrate the use of this feature, we will fill a new data set with fixed
values. Normally, you would use Tokens 688 , representing some statistic from
your analysis. Defining regressions manually is easy in FCS Express 6 with
Scatter with Regression plots 575 . We highly recommend you visit the Scatter with
Regression plots 575 chapter before proceeding with a manual fit.
In Figure 11.50, we have a Spreadsheet 413 , with values typed into the cells.
Please note that these are freetext values, but in practice many of these will be
tokens 688 derived from plots on your layout.

Figure 11.50 Spreadsheet Data for
Regression Analysis

With this data, a linear regression should yield a slope of approximately 10 and a
Y-intercept of approximately 1.
Regression analysis is performed using Custom Tokens

725

.

1. First, create a new custom token and name it Linear Regression.
If you right-click in the formula area of the Custom Token window and choose
Insert Function, you will find a list of available regressions, each beginning with
the word Perform (Figure 11.51).
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Figure 11.51 Regression Functions

2. Start a formula with an equals sign (=), right-click to bring up the pop-up
menu, and choose Insert Function PerformLinearFit([xValues,
[yValues], [SDvalues], [fixedParameters]) (Figure 11.52).
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Figure 11.52 Linear Regression Formula

3. In the formula, highlight xValues, right-click to bring up the pop-up menu,
and choose Insert Token (Figure 11.53).

Figure 11.53 Inserting a Token into a Linear Regression Formula

An Insert a Token dialog will appear that contains a Data Parameter token
(Figure 11.54).
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Figure 11.54 Data Parameter Token

4. Select the Data Parameter token and click Insert.
5. In the Create Data Parameter dialog which appears, choose the
Spreadsheet radio button as a Data Source, and select New
Spreadsheet (Figure 11.55).
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Figure 11.55 Create Data Parameter -- Data Source

6. Then, go to the Parameter category and from the Parameter dropdown list, choose the data in column A (Figure 11.56). Leave Macro for
the Output As drop-down selection. Choosing Data Values converts all
of the data to string values which is not efficient when there is a large
amount of data.
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Figure 11.56 Create Data Parameter -- Parameter Page

7. Repeat steps 3-6 using yValues in the formula and choosing Parameter B.
8. Highlight SDvalues and press the Del key (leaving the area between the
brackets blank. Do the same for fixedParameters (Figure 11.57).

Figure 11.57 Completed Linear Regression Formula

If the measurement in your B column was made from multiple data points and
you know the standard deviation of each of the data points, you can enter a list
of comma-delimited values in the SDvalues parameter of the linear regression
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formula. The model will weigh the points with the lower standard deviation more
strongly than the points with higher SD values.
The fixed Parameters for a linear regression are m (slope) and b (Y-intercept).
By leaving the parameter blank, the model will fit both of them. If you wanted to
force a Y-intercept of 0, for example, you could enter b=0 in fixedParameters,
and the model will fix that parameter, rather than letting it float.

9. Convert both Data Parameter values in the formula to display a numeric
result type 743 (they will be highlighted in blue instead of pink, as shown
below in Figure 11.58).

Figure 11.58 Completed Linear Regression Formula with result type
converted to Numeric

10. Insert a Text Box

152

onto your layout.

11. Drag the custom token Linear Regression into the text box. The m, b,
and r2 (r-squared) values will be displayed (Figure 11.59).
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Figure 11.59 Linear Regression Token inserted into a Text Box

The result is a comma-delimited list of every parameter that the linear regression
fit.
If you want to display just the slope of the linear regression in a text box, you
create a new custom token, and:
12. Use the function ExtractLinearResults([modelParameters], "m" |
"b" | "r2") (Figure 11.60) as in step 2.
13. Then, select modelParameters and insert the Linear Regression
token, as in step 4.
14. Delete the "b" and "r2" parameters.
15. Create a text box and insert the text: "The slope is: ".
16. Drag the Slope token into the text box (Figure 11 below).

Figure 11.60 Slope Parameter of Linear Regression Analysis Inserted into a Text
Box as a Token
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In summary, it is a two-step process. You make one custom token for the fit,
and a second custom token for the parameter that you want to use from that
fit.
11.8.3.3.2 Available Equations

FCS Express has the ability to fit your data to many different types of equations.
Below you will find a table indicating the equation, the formula associated with it,
and the parameters defined in FCS Express when a fit is performed.
Equation
Name
Michaelis
Menten

FCS Express
Function Name
MichMenten

Equation

Variables
Vmax, Km

TwoSiteBinding TwoSiteBinding

Vmax, KM,
Vmax2, KM2

Four Parameter FourParmLogisti
Logistic (4PL) c

Imax, Imin,
IC50, Hill

Five Parameter FiveParmLogistic
Logistic (5PL)

Imax, Imin,
IC50, Hill,
Asym
Bottom, Top,
V50, Slope

Boltzmann

Boltzmann

Exponential

Exponential

A, M, C

Two Phase
Exponential

TwoPhaseExpon
ential

A, M, A2, M2,
C

Exponential
Association

ExpAssociation

Ymax1, K1

Two Phase
Exponential
Association
Exponential
Grow

TwoPhaseExpAs
sociation

Ymax1, K1,
Ymax2, K2

ExponentialGro
w

A, M, C

Power

Power

A1, B1, K
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Power Series

PowerSeries

A1, B1, A2,
B2, K

Linear

Linear

m, b

Parabolic

Parabolic

m, b, A2

Cubic

Cubic

m, B, A2, A3

Sine Wave

SineWave

Gaussian

Gaussian

Baseline,
Amplitude,
Frequency,
Offset
A, SD, xMed, K

Sigmoidal

Sigmoidal

A, B, C

Decreasing
Sigmoidal

SigmoidalDec

A, B, C

Scatter With Regression
FCS Express can display data from a Spreadsheet 412 or any file as a Scatter with
Regression Plot 576 which automatically overlays one or multiple best-fit
regression curves of your choice 574 onto your data. The resulting regression
parameters 564 can be extracted and added as statistical tokens 581 anywhere on
your layout. The regression curve will update as you adjust your gates or
advance through your dataset, as shown in Figure 11.61 below:
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Figure 11.61 Scatter with Regression Plot updating as gate is moved.
11.8.4.1

Scatter With Regression Plots

To insert a Scatter with Regression plot,
1. Select the Insert
(Figure 11.62).

Plots

Scatter with Regression command

Fig. 11.62 Inserting a scatter with regression plot.

2. Click (or click-drag) on your layout where you want the plot to appear.
Note: The plot will appear showing data from the top Spreadsheet 412 , i.e.,
the Spreadsheet which was most recently selected or edited. The top
Spreadsheet is the one most recently accessed.
3. Change the X- and Y-axes

253

to the desired parameters.

To Format a Scatter with Regression Plot:
1. Right click on the plot.
2. Choose Format to access plot formatting options
3. Choose the Regression fit category.

283

.
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In the regression fit category you may choose the Regression Type (Figure
11.63) from the dropdown list of available regression curve equations 574 to
best fit your data.

Fig. 11.63 Formatting a scatter with regression plot.

Note that multiple fits may be added or removed by using the Add and
Remove buttons under the Regression Model List. The Regression Model
Options also allow you to see the model parameters and enter a fixed
parameter where applicable (Figure 11.64). The model parameters may later
be added to a layout as live-updating tokens via Scatter with Regression
Tokens 581 .
You may also increase the Number of regression dots to give the curve a
smoother appearance, though the default of "30" is sufficient in most cases.
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Fig. 11.64 Regression Model Options with a Linear and Sigmoidal fit
added to the Regression Model List for comparison. Parameters for the
regression model are displayed on the right and a fixed parameter may
be typed in the Fixed column. Note in the example that the line was
forced through zero by adding a fixed value of "0" to the column.
11.8.4.2

Formatting Scatter With Regression Plots

Scatter with Regression plots in FCS Express are fully formattable. In addition to
the formatting options shared by all plots 245 (e.g., border, size, background, axis
581 , titles, and legend), special formatting options are accessible from the
Overlays category. To access these special options, either
Select the Scatter Plot with Regression and use the Format tab
Options
command, or

Plot

Right-click on the Scatter Plot with Regression, select Format from the
pop-up menu, and choose the Overlays category.
Special formatting options for Scatter with Regression plots allow to customize
the appearance of both the data (i.e., Overlay 1,
in Figure 11.65) and the
regression (i.e., Overlay 2,
in the figure below).
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Figure 11.65 Special formatting options for Scatter with Regression Plots

The formatting options are described in the table below.
Option
X Parameter
Y Parameter
Error/Weights Bar
Param.

Highlight Param.

Highlight Color
Gate
Point Color
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Explanation
The parameter (column) from the Spreadsheet 558 displayed on the
X axis.
The parameter (column) from the Spreadsheet 558 displayed on the
Y axis.
The parameter (column) from the Spreadsheet displayed as error
bars and used by the regression to calculate the weights. Note, if
an Error/Weights parameter is selected, a weighted regression will
be performed. Weights will be calculated as the inverse of the
Error/Weights Bar Parameter. For the sake of simplicity, if the Error/
Weights Bar Parameter contains the following values "a, b, c, d,..."
the weights that will be used to perform the weighted regression
will be "1/a, 1/b, 1/c, 1/d,...".
See below 580 for more information on how to define the error bars.
The parameter (column) from the Spreadsheet from which the
highlighting rule derives. Points will be highlighted (e.g., the orange
point in the plot below 581 ) in the color defined in the Highlight
Color drop down menu if their value meets the criterion defined by
the Highlighting rule. See below 580 for more information on how to
define a highlighting rule.
The display color for highlighted points.
The gate that is applied to the Scatter with Regression Plot.
The display color for points.

580
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Option
Legend Text

Explanation
The text that will appear in the plot legend beside the symbol for
the overlay.
Point Fill Color
The color used to fill points.
Point Fill Style
The style used to fill points.
Point size
The size of the points.
Point shape
The shape of the points. Choose between rectangle (default),
triangle, circle, cross, star, hexagon, and diamond options.
Connect the points Whether the points are connected by a line.
Change data file
Whether the Scatter with Regression Plot changes during batch
during Next/Prev/ processing 782 or in response to a Next/Previous 79 command. It is
Batch
generally recommended to leave this unchecked (default), as the
Scatter with Regression Plot will update automatically as the data
to which it refers is changed.
Visible
Hides overlays without removing them. Select the overlay file from
the 2D Unbinned Overlays list and uncheck Visible. Check
Visible to show the overlay again.
Show marks
Displays the value of the points as text directly above the points.
Line Options for
Toggle between Error Bar Pen, Shape Border, and Connecting Lines
editing mode.
Error Bar Pen/
Width, Style (solid, dotted, and dashed options), and Color of the
Shape Border/
Error Bar Pen, Shape Border, or Connecting Lines.
Connecting Lines
Properties

To add error bars 562 or highlighting 563 to a Scatter Plot, these values must be
entered into columns in the Spreadsheet.
To define values for the Error Bars,
1.Go to an empty column of the Spreadsheet 412
2.Enter the value 417 of the error for each row (each row corresponds to an
individual bar). This value may be freetext or a custom token 725 .
3.Choose the appropriate Spreadsheet column for the Error Bar Parameter
(Figure 11 above, ).
An example of a Scatter Plot with Error Bars and its associated Spreadsheet is
shown in the figure below.
To define a Highlighting rule,
1.Go to an empty column of the Spreadsheet 412
2.Enter the value 417 of the rule for each row (each row corresponds to an
individual point). The rule must be a formula evaluating to "TRUE" or
"FALSE"; if "TRUE," the point will be highlighted with the color defined in
Figure 11 above, . An example of a Highlighting rule referring to a cell
within the Spreadsheet is shown below in Figure 11.66.
3.Choose the appropriate Spreadsheet column for the Highlight Param.
(Figure 11 above, ).
An example of a Scatter with Regression Plot with Highlighting and its
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associated Spreadsheet is shown in Figure 11 below.

Figure 11.66 Scatter with Regression Plot and associated Spreadsheet with Error
Bars and Highlighting

Note: Scatter with Regression Plot Axis titles may be defined:
directly in the Spreadsheet by using the column header (this require to check
the Use values in a first row as labels 420 option in the Spreadsheet
Formatting dialog 419 ).
in the Axes 253 category of Formatting options.
11.8.4.3

Scatter with Regression Tokens

Scatter with Regression parameters (Regression Param Statistics) can be
extracted and used as tokens 688 or displayed in a default Regression Parameter
Statistics window 582 . These tokens can be inserted into text boxes 688 , used in
Custom Token 725 or any formulas, and exported to reports during batch
processing 833 . Regression Parameter Statistics will update in real time as
regression curves change just like any other token in FCS Express.
To insert a Regression Parameter Statistics token into a text box:
1. Insert a text box using the Insert tab General Text Box command.
2. Right-click on the text box and select Insert Token.
3. Choose Statistic and click on the Insert button to bring up the Create
Statistic dialog.
4. Choose a Scatter with Regression 576 plot as a Data Source from the
Select a Plot box.
5. Open the Statistic category.
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6. Choose Regression Parameter Statistics from the Select a Statistic
dropdown list (Figure 11.67).
7. Choose a statistic from the Statistic list box.
8. Click OK.
The statistic or Model name will now be displayed in the text box and will update
in real time as the regression overlay updates.

Fig. 11.67 Choosing Regression Parameter Statistics

Scatter with Regression parameters can also be displayed in a Regression
Parameter Statistics window, by right-clicking on the plot, and choosing
Statistics> Regression Parameter Statistics from the pop-up menu (Figure
11.68). The tokens therein may also be dragged and dropped elsewhere in your
layout, which will result in a copy-paste operation.
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Fig. 11.68 Displaying the default Regresion Parameter Statistics window from the
Scatter with Regression Plot
11.8.4.4

Interpolating values from Scatter with Regression Plots

X- or Y-values can be interpolated from Scatter with Regression Plots using the
"RegressionPlotYToX" and "RegressionPlotXtoY" functions, via the Custom
Tokens 726 window (Figure 11.69) or via a formula in the Spreadsheet 584 . See
below or this Use Case Tutorial section
for details.
1697

Fig. 11.69 Regression Plot Interpolation Custom Token Functions

The components of the Custom Token are Plot ID (i.e., the Plot Number token 717
), Overlay Number for the Regression Overlay (note: the overlays are 1-based,
so the raw data is Overlay #1, and the first regression is Overlay #2), and the Xor Y-value from which the interpolated value will be derived. An example of an
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unfilled and filled Custom Token formula is shown below in Figure 11.70, top and
bottom, respectively.

Fig. 11.70 Interpolation Custom Token formula components unfilled (top) and filled
(bottom)

Interpolation formulas can also be entered into a Spreadsheet 412 from the
Spreadsheet tab
Statistical group of functions, as shown in
Figure 11.71.
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Fig. 11.71 Regression Plot Interpolation Formula (left) inserted in Spreadsheet
(center) and with components filled (right).
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The Concentration Calculator
Sometimes, you need to know the absolute concentration of the cells in your
sample. For example, you may be determining absolute lymphocyte counts or
counting bacterial populations. While most instruments allow for the accurate
determination of counts, they often do not report the volume of the sample that
was measured to obtain those counts.
FCS Express can calculate the sample volume from the flow rate and the sample
acquisition time, or from counts of beads added to a sample at a known
concentration. It can also read the $VOL in FCS 3.1 files or the equivalent value
from Amnis DAF files.
FCS Express allows you to:
Calculate individual concentrations.
Have the concentration calculated automatically and appear directly on the
statistics window.

12.1

Calculating a Single Concentration
To set up the proper parameters for the concentration calculator, select the
Tools tab Calculate Concentration Calculator command.
To calculate a single concentration:
Go to the Individual tab of the Concentration Calculator dialog (Figure
12.1).

© 2020 De Novo Software

The Concentration Calculator

589

Figure 12.1 Concentration Calculator - Individual Tab

Use the File to analyze drop-down list box to select the FCS file on which
you want to calculate the concentration. You can choose to calculate the
concentration for only a subset of cells by selecting a gate in the Gate to
analyze list box.
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Select a method to calculate volume using Reference beads, acquisition
Time or Volume keyword in the data (see below).
Press Calculate to calculate the actual concentration. The sample volume
will be displayed in the Volume Analyzed field and the concentration will be
displayed in the Sample Concentration field.

Calculating Volume from Reference Beads
A common way to calculate the volume of a sample is to add a known
concentration of beads to your sample. By counting how many beads were
acquired in the time it took to acquire the sample, it is possible to calculate
the volume of the sample.
o Before opening the Concentration Calculator dialog, draw a gate
around your population of beads on a 2D Plot.
o Select the Reference Beads radio button.
o Select the gate created around beads from the Bead Gate drop-down
menu.
o Enter the concentration of the beads in the Bead Concentration field.
The concentration must be entered in units of beads/ml. You can enter
the concentration in scientific notation (e.g., 5 x 10 6 /ml is entered as
5e6).
Calculating Volume by Time
Some instrument sheath fluid flows at a well-defined rate. If you know the
flow rate, and the acquisition time, you can calculate the volume acquired.
o Enter the flow rate in the Flow Rate field in ml/min.
o The Start Time and End Time fields are automatically filled in from data
in the topmost FCS file header. If those times are not correct, you can
enter the start time and end time directly. The Total Time is calculated
as the difference between the start time and end time. You can also
enter data into the total time field directly.
Calculating Volume by Keyword
A standardized keyword for sample volume run during acquisition ($VOL) was
introduced with the FCS 3.1 file format. The keyword value is a floating point
number, which represents sample volume in nanoliters. FCS Express can
read the keyword from FCS files and the equivalent from Amnis .daf files to
be used for calculating concentrations.
o Before opening the Concentration Calculator dialog, insert a plot. If
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preferred, draw a gate around your population of interest.
o Select the Volume keyword in the data radio button.

12.2

Calculating Concentrations on the Statistics Page
You can also have the concentration calculated automatically on the statistics
window of a plot. In that case, you must tell FCS Express how the volume is to
be analyzed for that data file. The concentration will be calculated as the number
of cells in that statistics row divided by the volume. To set up statistics
concentration calculations, go to the Stats Window Setup tab of the
Concentration Calculator dialog (Figure 12.2) and enter the volume
parameters (by Reference Beads, Time, or Volume keyword in the data) in
a similar manner as for a single concentration 588 .
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Figure 12.2 Concentration Calculator Dialog - Stats
Window Setup
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The Histogram Subtraction Tool
Histogram subtraction allows you to determine the percent positive on a
histogram by subtracting a negative control histogram from a sample histogram.
Histogram subtraction can be
1. Set up to be automatically calculated and appear on the Histogram Statistic
table. In this case, the Overton Subtraction method is used.
2. Performed on an individual basis using the Histogram Subtraction tool. In
this case, the subtraction can be performed using different method.

380

To have the histogram subtraction automatically performed and displayed in a
histogram statistics window:
Make sure the percent positive column is visible for the statistics window

387

.

Use the Format Plot Options Specific Options command (or right-click
on the histogram, choose Format, and select the Histogram Histogram
Specific Options category). Set the Control Histogram for Histogram
Subtraction Statistics field to the appropriate negative control (Figure
13.1). Statistics histogram subtraction always uses the Overton Subtraction
method, described below.
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Figure 13.1 Setting the Control Histogram in the Formatting Histogram Specific
Options Dialog

To perform an individual histogram subtraction, select the Tools tab Calculate
category click Histogram Subtraction command on the ribbon (Figure 13.2).

Figure 13. 2 - Histogram Subtraction command on ribbon

The Histogram Subtraction window (Figure 13.3).
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Figure 13.3 Histogram Subtraction Window

A histogram subtraction can be performed for any FCS file that is currently open.
Select the File, Parameter, and Control or Sample Gate for the Control
Histogram and Sample Histogram in the appropriate places. Press the
Calculate button to perform the histogram subtraction. The percent positive is
calculated in four different ways, of which the Overton Subtraction and Positive
Difference methods are usually the most accurate.
The methods used to calculate % Positive are:
Channel by channel
The control histogram is subtracted from the sample histogram on a
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channel by channel basis. In other words, the number of cells in channel N
of the control is subtracted from the number of events in channel N of the
sample. All of the positive results (i.e., where there are more cells in the
sample channel N than in the control channel N) are summed and are then
divided by the total number of cells to yield a positive result.
X Percent
In this method, you set a cutoff channel value at the top of the control
population and consider all cells above this channel to be positive. To
determine the cutoff value, enter a value in the edit field to the left of the
Percent label. If you enter the value 2, the cutoff channel will be below
the highest two percent of the control cells or the 98th percentile. Any
cells in the sample histogram that are above this channel are considered
positive.
Overton Subtraction
This technique is similar to the channel by channel subtraction method
except that negative differences (where the number of cells in control
channel N is greater than the number of cells in sample channel N) are
added to the positive differences in lower channels. After all channels have
been analyzed, residual negative results are set to zero, and the sum of
the positive results is divided by the total number of cells to yield a percent
positive.
Positive Difference
The percent of cells between channel N and channel N-1 are calculated for
the sample and control histogram and the difference between these
percentages is determined. This difference is determined as N moves from
channel 1 to the last channel. The largest difference found becomes the
percent positive.
The Overton Subtraction results in a histogram overlay that contains all the
positive cells. This overlay can be placed on a histogram by choosing an existing
histogram in the Put Overton Output Histogram On field. Statistics can be
calculated on this overlay as if it were a regular overlay on the histogram.
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Publishing Layout Tools
FCS Express has the unique capability to share your data and analysis with other
scientists and researchers. You can share your layouts by publishing them. Once
a layout is published, it can be placed on a web site and can be read by anyone in
the world using the FCS Express Reader 607 , which is available free at http://
www.denovosoftware.com/site/reader.shtml.
A published layout is a specialized FCS Express layout with embedded data and
certain restrictions about what can be changed. FCS Express Reader will allow
users to perform a complete analysis using your data (including moving gates
and creating new plots) subject to certain limitations 607 .
De Novo Software also provides a free service to publish your layouts 600 . These
layouts will be hosted on our web site and can be accessed by anyone on the
internet. You do not have to worry about uploading your published files to a web
site and exposing it. That is all handled behind the scenes by FCS Express.
Every FCS Express customer has 10 free megabytes on our web site that they
can use to publish their layouts. If more space is required, you can purchase
additional hosting space 608 . In addition, you can publish the layout to your own
web site 603 .

14.1

Publishing a Layout to the De Novo Software
Publishing Site
To publish a layout to the De Novo Software web site, use the File
tab Collaborate Publish Layout... command. The Publishing Wizard will
appear to guide you through the publishing process.
You enter demographic information about your layout (Title, Author,
Organization) in the first page after the welcome screen (Figure 14.1).
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Figure 14.1 Publishing Information

This information is optional and is only used for descriptive purposes. Press Next
when you are done entering the demographic information.
The next page (Figure 14.2) allows you to choose the location to publish your
layout. Everyone can publish on the De Novo Software web site. To publish to
your local hard drive, please see the section on Advanced Publishing 603 . Press
Next to publish your layout on the De Novo Software web site.
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Figure 14.2 Publishing Location

When using the Advanced Publisher you will be presented with two additional
dialogs that are discussed in the Advanced Publishing section 603 .
The Publishing Wizard will ask you to log in using your email address and
password (Figure 14.3). This must be the same email address and password
that you used when registering for an account on the De Novo Software web
site.
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Figure 14.3 Logging in to the De Novo Software Server

You can also provide a filename that will be used when publishing. This will be the
name of the layout that will appear in the maintenance list 605 .
Press Next after entering the required information. The final page of the wizard
shows you the URL that you distribute to have other people view your published
layout. Press Copy to copy the URL to the clipboard to paste it into an e-mail.
Pasting the URL into a browser will allow users with the FCS Express Reader 607 to
view your data files.

14.2

Advanced Publishing
The advanced publishing module allows you to publish your layout to any
location, as well as giving you several more options for controlling how your
published layouts are used by others. Publishing permissions may be saved just
like regular permissions and loaded from a previously saved permissions file .
1123

If you are using the advanced publisher, the on my local computer option will
be available on the Location page of the Publishing Wizard 600 . If you select this
radio button and press Next, the Set permissions for the published layout
page (Figure 14.4) will appear.
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Figure 14.4 Publishing Security Permissions

On this page, you can select which actions viewers of your layout will be allowed
to perform. For example, if you wish to prevent users from printing your layout,
you could disable the Print permission (located under Layout operations).
Almost every action in FCS Express has an associated permission code that you
can choose to allow or not to allow. These permissions will be respected if the
published layout is loaded both in FCS Express and FCS Express Reader. Press
Next after you have selected your permissions.
The next page (Advanced publishing options) allows you to control additional
features, including whether to include batch processing actions and/or disable
token editing in the published document.
The next page (Information for keywords anonymizing) allows you to use
the features associated with the Keyword Anonymizer 654 to remove any or all
keywords from the data in the published layout.
When publishing to your local computer, the next page requires you to select the
file name. Your published file will have the same extension as a standard FCS
Express layout (.fey) and the data will automatically be embedded.
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When publishing to the De Novo Software website, the next page requires you to
enter the email address and password associated with you De Novo Software
account as well as a file name for the layout on the server.
Any published layout can be opened in the FCS Express Reader.

14.3

Default Publishing Options
The Default Permissions and Publishing Options can be set in the Advanced
Publishing category of the FCS Express User Options dialog 226 .

14.4

Managing Your Published Layouts
FCS Express allows you to delete and rename the layouts that you currently
have published on the De Novo Software web site.
Select the File tab Collaborate Publishing Maintenance command to open
the Manage your Published Layouts dialog (Figure 14.5).
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Figure 14.5 Managing Published Layouts

Enter your Email Address and Password and press the Log In button. You
must use the same email address and password that you used when registering
for an account on the De Novo Software web site. When you log in, a summary
of all your published layouts on the De Novo Software web site will appear in the
bottom portion of the window. You can Delete or Rename files, as well as
obtain the URL for any of your published layouts. If you need more than 10 MB
of space for your layouts, you can purchase a larger hosting plan 608 .

14.5

Sharing Published Layouts with Others
To share your published layouts with others, they must have either FCS Express
or FCS Express Reader installed on their computer.
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Simply distribute the URL that was generated by FCS Express 600 (or that you
chose when publishing to your own site). Paste the URL into any web browser
(Figure 14.6) and press Enter.

Figure 14.6 Pasting the URL of a Published Layout into a Web Browser

14.6

FCS Express Reader
With FCS Express Reader, you can:
See published analysis from the web.
Perform all actions that the publisher of the layout has given you access to.
Re-analyze the data. All analysis capabilities of the FCS Express Professional
version are available.
Find templates and demos on the web from reagent suppliers to help get
started with using their products.
Upgrade to the full demo, or the purchased version, at any time.

14.6.1

Obtaining the FCS Express Reader
FCS Express Reader is available free at http://www.denovosoftware.com/site/
reader.shtml.

14.6.2

FCS Express Reader Limitations
FCS Express Reader allows you to perform almost all of the analysis tasks of the
regular version of FCS Express. For example, you can add new plots, manipulate
gates, get statistics, and print. However, FCS Express Reader does have the
following limitations:
You can only use the data files that are embedded in the published layout.
You cannot change data files, load new data files, or run batch processing
on the layout.
There is restricted saving capability. A published layout that was saved from
FCS Express Reader can only be opened on the same computer on which it
was saved, or the computer from which it was originally published. This
allows teachers to create layouts which students can manipulate and save.
The changed layouts can then be returned to the teacher for subsequent
grading (as long as the grading occurs on the same computer which created
the published layouts).
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Upgrading from FCS Reader to FCS Express
To upgrade from the FCS Express Reader to FCS Express, purchase the
appropriate version from http://www.denovosoftware.com. Once you have
made your purchase, you can upgrade your FCS Express Reader by selecting
the File tab System Change your configuration. (Figure 14.7) and follow
the steps in the configuration wizard.

Figure 14.7 Upgrade FCS Express Reader

14.7

Extra Hosting Plans
If you want to publish more than 10 MB worth of layouts on the De Novo
Software publishing site, you can purchase extra hosting plans. These allow you
additional space on our servers. Several different hosting plans are available.
Details can be found at http://www.denovosoftware.com.
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The Channel Calibration Tool
Quantitative flow cytometry is used to determine the actual number of
fluorescent ligands (fluorochromes or fluorochrome-protein conjugate
molecules) labeling each particle. The technique requires calibration of the
fluorescence channel number with standards of known fluorochrome content.
The standards define the relationship between the observed fluorescence level
and the number of bound fluorochrome molecules.
Several companies have specially designed beads of different intensities where
the precise number of dye molecules per bead is known. By establishing a
standard curve correlating the channel number to the number of dye molecules
per bead, it is possible to determine the absolute number of molecules per cell of
antigen, antibody, and other useful markers.
This type of calibration has traditionally been a very labor intensive process,
requiring you to use your flow cytometry software to obtain a set of statistics
from the beads and the sample, then entering the statistics into a spreadsheet,
creating a calibration curve, determining the standard channel values, and finally
performing more calculations using the spreadsheet to convert the statistics to
the number of binding sites per cell.
FCS Express automates the entire process for you. Once you have set up a
channel calibration, all plots will automatically display the calibrated axes, and the
statistics will be displayed as calibrated values. Tokens may be used to monitor if
a calibration has been applied to an axis 616 or what the last channel calibration
loaded in the layout 617 was. To set up a channel calibration 610 , you must have a
set of beads for which the number of fluorochrome molecules is precisely known.
In addition, you must know the effective fluorescence-protein ratio to determine
the number of dye molecules attached to each marker on the cells.

15.1

Creating a New Channel Calibration
To create a new channel calibration:
Display the bead data in a histogram and create a marker
bead as shown in Figure 15.1.

351

bounding each
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Figure 15.1 Setting Up Markers for Channel
Calibration

Ensure that the plot being used as the raw data source for the calibration
does not itself have calibration applied by following Steps 11-15 of the
Channel Calibration tutorial .
1873

Select the Tools tab

click Channel Calibration command (Figure 15.2).

Figure 15.2 - Channel Calibration Ribbon

The Channel Calibration window
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Figure 15.3 Channel Calibration Window

Click Add to create a new calibration. The New Calibration dialog will
appear (Figure 15.4).
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Figure 15.4 New Calibration Dialog

Select the parameter you wish to create the calibration for in the Create
calibration for drop-down list.
Choose the histogram which will serve as a data source for the calibration
from the Calculate regression from dropdown list.
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Select the correct overlay from the histogram in the Overlay drop-down
list. When the histogram is selected, the marker box will automatically
create an entry for every marker that exists on that histogram. You can
choose to use fewer markers by changing the value in the Number of
peaks to use for regression field. You must use a minimum of three
markers to calculate the regression.
Enter the number of molecules per bead next to the marker for that peak.
This information is supplied by the manufacturer of the beads.
Click Calculate to calculate the new channel calibration. The equation for
the new calibration (Slope, Y Intercept, Correlation coefficient) will
appear in the Results box.
The Dye molecules:Antibodies (also known as the F:P) ratio is typically
1:1, but you can change it to another value. The F:P ratio is supplied by the
manufacturer of the antibodies you are using in your experiment.
Click OK to accept the new calibration.
The channel calibration may now be saved, edited, or reloaded from the
Channel Calibration dialog 614 .

15.2

Using a Channel Calibration
FCS Express offers two levels of control in determining whether a parameter will
have a calibration applied to it: A global control, and an individual plot-by-plot
control.
If you do not want the calibration to be used at all, you can select the Tools
tab click Channel Calibration command and uncheck the Active checkbox
beside that calibration (Figure 15.5).
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Figure15.5 - Channel Calibration Window with Active Checkbox

You can also choose which individual plots use the calibrations. The Specific
Options page of the Format window for both histograms 273 and 2D Plots 304
contains a Use channel calibrated on axis checkbox. If this checkbox is set,
calibrations will be used for any parameter that has a calibration defined. If the
Use channel calibrated on axis checkbox is not set, the calibration will not be
used, irrespective of whether or not that calibration is active (Figure 15.6).
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Figure 15.6 - Channel Calibration on Axes in Formatting Dialog

Tokens 688 in FCS Express also allow you to monitor if channel calibrations are
applied to any axis on your plots 616 and to monitor the last loaded calibration file
in the layout 617 .
To monitor channel calibrations on either axis of a plot using the "Is channel
Calibration applied on the axis?" token type:
1.
2.
3.
4.

Right click on a text box.
Choose Insert Token.
Choose Plot
.
Choose "Is channel Calibration applied on the X/Y axis?" in the Plot
Elements category.
5. Click OK.
6. Click Insert.
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A new token will now be displayed in the text box indicating the calibration status
of the axis you chose for the indicated plot (Figure 15.7).

Figure 15.7 Using the "Is channel Calibration applied on the axis?" token type. The
token can be access through Plot Information>Plot Elements (red arrow). When
the token is inserted it will indicate if a channel calibration is applied on the X or Y
axis of a plot (green arrow).

To monitor the Last Loaded Channel Calibration File token type:
1.
2.
3.
4.

Right click on a text box.
Choose Insert Token.
Choose Layout
Click Insert.

A new token will now be displayed in the text box indicating the last calibration
file that was loaded into the layout (Figure 15.8).
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Figure 15.8 - Last Loaded Channel Calibration File
Token Type

15.3

The Channel Calibration Window
The Channel Calibration window (Figure 15.9) shows all the current calibrations.
It is possible to have different calibrations defined for different parameters. FCS
Express will automatically use the appropriate calibration depending on which
parameters are displayed on a plot.
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Figure 15.9 Channel Calibration Window

In the Channel Calibration window:
Parameter # indicates which parameter the calibration applies to.
Equation is the linear regression formula that will be used to calibrate the
channels.
F:P refers to the dye molecules:antibody ratio that you selected.
R tells you how closely your equation fit the actual data, with a value of 1
being a perfect fit.
Min is the minimum number of fluorochromes you are able to resolve.
# Decades represents the number of decades of dynamic range your
instrument is capable of measuring.
Active indicates whether this calibration will be applied for the selected
parameter.

To edit an existing calibration, click on a row (e.g., Parameter #2 above) to
highlight/select it and press Edit. This will bring up the New Calibration dialog for
that data, where you can change the values.
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The Compensation Tool
Ideally, when one uses a dye in an experiment, its emission spectrum will be
narrow enough that fluorescence from that dye is only detected by a single
detector in the instrument. In practice, however, because of the broad emission
spectra of available fluorochromes, the dye you are using will likely emit
significant amounts of fluorescence in several different detectors. In other words,
the light reaching a given detector consists of the signals from multiple
fluorochromes.
Compensation is the process of transforming the data such that the values from
a single detector come from an individual dye. In order to do this, a percentage
of the overlapping emission is subtracted from the target emission. Traditionally,
this compensation was performed by the instrument during acquisition. However,
modern instruments are capable of storing the data in uncompensated form and
compensation can be applied by the analysis software.

Example of the calculation: Compensated Parameter 2 Fluorescence = Observed
Parameter 2 Fluorescence minus 5% of Observed Parameter 1 Fluorescence.

Compensation involves creating two matrices. The spillover matrix represents
the percentage of the signal from a given channel that spills into adjacent
channels. The compensation matrix, used to correct for the spillover, is the
inverse of the spillover matrix.
FCS Express uses the following terminology when dealing with compensation.
The target parameter is the parameter that is detecting signal (potentially from
multiple sources). The source parameter is the primary parameter that you want
the signal to be in, but that dye is also bleeding (potentially) into multiple targets.
In other words, we are subtracting the percentage of the source that is
“bleeding” into the target.
In the example given above, Parameter 2 is the target and Parameter 1 is the
source. A family of sources and targets is called a compensation definition. A
compensation definition describes all the ways that fluorescence from different
channels affect each other under a given set of conditions and is equivalent to a
single compensation matrix. Typically, the instrument user will set the gains for all
the channels at the beginning of the experiment and use these settings for the
duration of the experiment. Thus, the compensation definition would apply for
the entire experiment.
FCS Express can store multiple compensation definitions in a single layout. This is
useful when one wants to analyze data acquired on different days in the same
layout. It is likely that the gains will be different on different days and will require
a different compensation definition for each day. Each overlay on a plot can use
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a different compensation definition.
In addition, the compensation definition can be assigned to a data file. This
means that when the .fcs file is loaded into a plot, it will automatically use the
proper compensation. In this way, you do not have to remember the
appropriate compensation definition for each of your data files.

16.1

Software Compensation Caveats
Software compensation is not a panacea for all compensation problems.
Software compensation works best on high-resolution (> 1024 channel) linear
data. Compensation must be performed on linear data. Therefore, data that is
stored in logarithmic format (as is sometimes the case with FCS 2.0 data files)
must be converted to linear prior to compensation. This conversion from
logarithmic to linear can induce rounding errors. In addition, data that is stored as
less than 1024 channels is rarely compensated accurately with software.
However, the majority of data stored as 1024 channels or greater can be
software compensated.
Additionally, certain file formats supported by FCS Express do not support storing
compensation matrices separately from the data file and the these data sets will
only display and utilize the raw data values. Examples include .csv files 30 and
.MQD (MacsQuant) files 27 .
For a detailed description of how software compensation is implemented in FCS
Express, please see our Frequently Asked Questions at http://
www.denovosoftware.com/site/compensationdetails.shtml.

16.2

Setting Up Compensation Definitions
In order to view all the current compensation definitions in the layout, select the
Tools tab Transformations Compensations command. A dockable window
titled Compensations will open. The Compensations window will list all of the
compensation definitions that are available in the layout within the Loaded
automatically with data files or the Created manually folders. (Figure 16.1).
The Loaded automatically with data files folder shows compensation
definitions that were automatically loaded with a data file presently showing on
the layout (e.g., one defined during acquisition and saved as metadata with a
modern FCS 3.0 or greater format .fcs data file) and the Created manually
folder shows compensation definitions that have been created manually within
FCS Express.
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Figure 16.1 Compensations Navigator showing compensations available in the
layout.

The Compensations window (Figure 16.2) is dockable and pinnable 113 like many
other windows in FCS Express. There are many actions you can perform from
the Compensations window tool bar. You can perform the action either by
pressing the appropriate button (hover the mouse over the button for tooltip) or
by right-clicking on a compensation folder or sub-item. The actions are
summarized in the table below:
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Figure 16.2 Compensations Navigator showing available commands and actions.

Action
Command
Explanation
Create a new
Add a new compensation definition.
or right-click on
compensation
Folder or Compensation
Import a
Import a previously saved compensation
compensation
(*.compensation) file.
from a file
Export the
Export a compensation (*.compensation) file for
selected
use in other layouts.
compensation
Assign this
Assign 643 a compensation definition to a file or
or right-click on
compensation
series of files.
Folder or
to a data file
Compensation
to file
Rename the
Renames the selected compensation definition.
or right-click on
selected
Folder or
compensation
Compensation
Rename
Delete
Deletes a compensation definition from the
or right-click on compensation window and the plots to which it
Folder or
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Cut Object

Copy Object

Compensation
Right-click on
compensation
Object
Right-click on
compensation
Object

Set as Default Right-click on
compensation
Default

was applied.
Performs a cut command on the compensation
definition. If performed on the Compensation or
Spillover Matrix, the Matrix can be pasted into a
Text Box or other document.
Performs a copy command on the compensation
definition. If performed on the Compensation or
Spillover Matrix, the Matrix can be pasted into a
Text Box or other document.
Sets the selected compensation definition as the
default compensation. The default compensation
is the one that will be used when adding new
plots. Only Created manually compensation
definitions may be Set as Default; however,
compensation definitions Loaded automatically
with data files may be copied into the Created
manually category for this purpose.

The Compensations window also has tabs devoted to the Compensation
Matrix, Spillover Matrix, and Automatic Compensation Setup 630 (Figure 16.3).
The Compensation Matrix and Spillover Matrix tabs allow you to view and
Edit a Compensation Definition 627 by utilizing the compensation or spillover
matrix. You can choose to view the Matrix Editor or List Editor from the
Editor drop-down (Figure 18 below) to view a matrix of Source vs. Target
(Figure 16 below and left) or to view a list of Target - % Source (Figure 16
below and right). Please see the Automatic Compensation Setup 630 section
for details on this tab.

Figure 16.3 Compensations Navigator showing available tabs. Matrix Editor View
(left) and List Editor View (right).

Once a Compensation or Spillover Matrix is defined, you can drag and drop
either matrix directly onto a layout, into a text box, or even directly into
Microsoft Excel to display the raw matrix data (Figure 16.4).
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Figure 16.4- Drag and drop a compensation matrix from the Compensations
navigator onto a layout, into a text box, or directly into Microsoft Excel to display
the values.

16.3

Editing a Compensation Definition
Selecting a file within the Compensations navigator displays the compensation
definition in the tabs below. Expanding the compensation file node will reveal the
Compensation Matrix, Spillover Matrix, and Automatic Compensation
Setup 630 items. Clicking on items in the expanded view is just like choosing the
different tabs in the lower pane of the window (Figure 16.5).
FCS Express has color-coding for values in compensation and spillover matrices.
The color heat map allows users quick identification of same parameter pairings
(green) and potentially high (shades of yellow to red) or low (shades of purple to
blue) values.
You can choose to view the Matrix Editor or List Editor from the Editor dropdown to view a matrix of Source vs. Target or to view a list of Target - %
Source, respectively.
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Figure 16.5 The Compensations Navigator displaying the
Compensation Matrix in Matrix Editor View.

Compensations can be edited directly from the Compensation Matrix tab and
Spillover Matrix tab by clicking on the Target (Matrix Editor) (Figure 16.6,
left) or Value (List Editor) (Figure 16 below and right) and using the up and
down arrows (outlined in red below) or entering a value to adjust the
compensation.
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Figure 16.6 Adjusting compensation values using the compensation Matrix (left)
and List (right) Editors. Use the up and down arrows or manually enter a value to
adjust the compensation.

Every compensation must be given a unique name. The name of your
compensation may be changed at any time by selecting the compensation and
clicking the Rename selected compensation button
or by right-clicking on
a compensation and choosing Rename. You may find it helpful to enter the date
or experiment number as the compensation name.
The Parameter field allows you to add or remove parameters to/from the
matrix by clicking the

or

buttons (Figure 16.7).

Figure 16.7 The Parameter field allows you to add or
remove parameters to your compensation matrix.

Compensation must be performed on linear data. If you have stored data on a
logarithmic scale in your FCS file (common with FCS 2.0 data files), this data has
to be converted to a linear scale before compensation is applied. It is then
converted back to log for display. Depending on the resolution of your original
file, this can result in digitization errors , which can cause large numbers of
events to group in a single channel. The conversion to linear and reconversion
back to log occurs automatically during the software compensation process.
However, if you notice digitization errors, you can enter a value to spread the
grouped population out using the Range of random value to add when
converting log data field (Figure 16.8). Typically, this value should be less than
one. This will add a small random value to the linear value prior to it being
1436
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reconverted back to log. It is recommended to leave this value at zero unless
these digitization errors become apparent.

Figure 16.8 The Range of random value to add when converting
log data field allows you to easily correct for digitization errors.

16.4

Automatically Calculating Compensation Definitions
Instead of manually entering a value to subtract for every target-source pair, or
guessing the compensation by eye using old-fashioned sliders 643 , you can have
FCS Express calculate the entire compensation definition for you. For step-bystep instructions on using the Automatic Compensation Setup please see our
Automatic Compensation Tutorial . To get started, use the Tools
tab Transformations Compensations command, open the Compensations
navigator, and add a new compensation with the Add a new compensation
1396

button
or you can then click on the Automatic Compensation Setup
command (outlines in red below) tab to access the automatic settings (Figure
16.9).
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Figure 16.9 The Automatic Compensation Setup tab.

The Automatic Compensation Setup tab contains 5 steps to calculate your
compensation. Step 3 and step 4 are optional and do not have to be completed.
Step 1 - Select single-stained controls (Figure 16.10)
In order to automatically calculate the compensation definition, you will need an
.fcs file with a single stain control for each parameter you wish to compensate
and an unstained control. The unstained control can be a universal negative, a
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negative population defined by a gate, or the negative population with the tube
of the positive control. You will also have the option of using an unstained control
for each parameter you wish to compensate or to use populations defined in
user-created gates in Step 3: Adjust parameters.
1.Click the Add data for auto compensation button,
, to add files that
will serve as compensation controls.
2.Choose the parameter that was stained for each control sample and the
universal negative using the Parameter dropdown menu.

Figure 16.10 Step 1 - Select single-stained controls. Add compensation control
data files and choose their respective channels from the Parameter drop down list.

Step 2: Build Histograms (Figure 16.11)
1.Click the Build Histograms button. If there was something wrong with the
files or parameters you selected in the previous step, an error message will
appear here to let you know what the problem was, and the Build Histogram
button will be disabled until the error is corrected.
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Figure 16.11 Step 2: Build Histograms

If there were no errors, the Ready to build histograms for autocompensation message appears in the Build histograms dialog. The Build
histograms step will automatically create the following items (Figure 16.12):
Scatter Plot Layout Page: A page will be created with a plot displaying SSC
vs FSC and a Scatter Gate. The Scatter Gate is automatically created
and used to define the "live" cells or cells of interest in your compensation
controls. All of the fluorescence gates are children of the Scatter Gate,
which means adjusting the Scatter Gate will cause all other gates to
update in real time. If the Scatter Gate does not appear on the right
parameters (e.g., SSC-H vs FSC-H), change the gate using the replace
gate feature 320 . To replace the Scatter Gate with a new gate:
.
.
.

Change the X and Y axes to the correct parameters.
Draw a gate around the population of interest.
Choose the Replace an existing gate radio button in the
Create New Gate dialog.
. Select Scatter Gate from the drop down menu.
. Click OK.
(Note: These steps are also described in the Automatic
Compensation Setup
tutorial.)
1396

Single Stained Control Layout Pages: A new page will be created for every
parameter you are compensating (e.g., "FITC-A control", "PE-A control" in
the image below). The page will display one histogram with the stained
population marked and one histogram with the unstained population
marked. Markers will be placed based on FCS Express auto recognition of
peaks, but can be adjusted 352 .
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Note: the unstained population histogram will only appear if a
universal negative is chosen. If it was not, only a single plot with two
markers (for positive and negative populations) will appear.
Gates: New gates will be created for the Scatter Gate and each stained
and unstained set up markers will be converted and linked to gates. After
the initial "auto-gating" all the gates and markers created in the Build
histograms can be manually adjusted 352 . (Note: A Gate View 343 will not
automatically be inserted.)

Figure 16.12 Layout after Step 2 of Autocompensation setup. Note the Scatter Plot,
FITC control, and PE control pages. Also notice that a plot for SSC vs FSC has been
created with a Scatter Gate automatically applied. Histograms with markers for the
stained and unstained populations have also been automatically created.

Step 3: Adjust Parameters (optional) (Figure 16.13)
This step is rarely used, but can be helpful with certain kinds of data (e.g., where
the Stained or Unstained population must be defined on a different plot). Once
you have determined your initial compensation parameters via Step 1 and Step 2
(or completed your compensation matrix in step 5) you can add Adjust
parameters in Step 3.
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Step 3 - Adjust parameters (optional) is useful when you would like to refine
the populations that are used for calculating compensation. Dragging and
dropping new plots, files, or gates in this section will allow you to override the
automatic setup and use gates and plots of your choice. For instance, if the
Automatic Compensation Setup does not make a good estimate of the
population or if you would like to use a population from another file, gate, or
plot, Step 3 would be useful. Parameters may be adjusted or changed
altogether by dragging and dropping a plot or gate onto the parameter for the
Stained and Unstained columns. If a gate is dropped, the compensation
definition will be based on that gate, including its hierarchical position 348 visible in
the Gate View object. If a plot is dropped, the compensation definition will be
based on the entire population on the plot. If you have adjusted a parameter
after the matrix has been calculated you must click on the Calculate matrices
button in Step 5 again to apply the change.

Figure 16.13 The Adjust parameters dialog displaying the currently defined
parameters, plots, and gates.

Instructions for adjusting parameters (Figure 16.14):
1.Click and hold on a gate or plot.
2.Drag the gate or plot to appropriate cell in the Autocompensation
controls table (red arrow).
3.Release the mouse button.
The new gate and or plot will appear by name in the appropriate cell in the
Autocompensation controls table of the Adjust parameters pane (Figure 16
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below, green arrow).

Figure 16.14 To change a parameter plot or gate drag the gate or plot onto the plot
you wish to change. The plot information will then update to the newly choosen
gate or plot.

Step 4: Add extra spillover targets (optional) (Figure 16.15)
Adding extra spillover targets allows you to have other targets defined without
defining a source. This is useful if you would like to have an idea of what spillover
would look like if an extra parameter was added in future experiments. To add an
extra spillover target simply check the box for the extra target you would like to
add. Note: extra spillover targets will only appear for parameters that were
acquired with the data.
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Figure 16.15 The Add extra spillover targets (optional) dialog.
Checking a box will calculate the spillover for targets that have
no source.

Step 5: Calculate matrices (Figure 16.16)
In this final step you can choose to Calculate Matrices based on the Mean or
Median depending on your preference for your data and experiment. Click on
the radio button for either choice to apply your preference.

Figure 16.16 Step 5: Calculate Matrices button and choosing
Mean or Median.
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Your Spillover Matrix will then appear in the Compensations navigator (Figure
16.17)and you may edit any of the source-target pairs 627 through the
Compensation Matrix, Spillover Matrix, or make new adjustments in the
Automatic Compensation Setup.

Figure 16.17 The Compensation Matrix after the Automatic
Compensation Setup is complete.

The automatic compensation setup settings are saved with the layout 644 . To
create another compensation matrix from a different set of data, simply add a
new compensation with the Create a new compensation button
begin the Autocompensation setup process again.

and

We also suggest that you use the compensation determined in the Automatic
Compensation Setup and apply it to different layouts and files 638 rather than
re-creating the same compensation definition many times.
A step-by-step description of the Automatic Compensation Setup feature is
provided in our tutorials at Compensation Tutorial .
1391

16.5

Applying Compensation Definitions
Every plot, overlay on a plot, and every file loaded as a plate, can have a
different compensation definition. To change the compensation for an overlay,
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right-click on the plot and select Format from the pop-up menu. Go to the
Overlays category, select the overlay(s) of interest, and select the
compensation definition you want to use. Alternatively, you can use the Format
tab Plot Options Overlays command to edit individual or multiple plots.
There are also many drag and drop commands for compensations 623 . You can
drag and drop compensations from the Compensations navigator to any plot,
any layout, and from one matrix to another to apply and edit compensations
(Figure 16.18).
To apply a compensation definition by dragging and dropping from the
Compensations navigator, follow the steps below.
1. Left click and hold on a compensation.
2. Drag the compensation to the intended plot (red arrow).
3. Drop the compensation by releasing the left mouse button.
The compensation will then be applied to the plot (green arrow).

Figure 16.18 Dragging and dropping a compensation from the Compensations
navigator onto a plot to apply the compensation.
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Compensations may be dragged and dropped between different layouts by
dragging the compensation definition from the Compensations navigator in one
layout to the Compensations navigator or on a plot in another layout much like
Steps 1 - 3 above. This will allow you to easily apply compensations between
different layouts and experiments.
A compensation definition may also be dragged and dropped onto another
compensation definition. This allows you to easily copy matrices from one
compensation definition to another.
You can set a compensation as default for the layout, so it will automatically
apply to all experimental files in your Data List as you click Next/Prev or perform
a Batch Process. See the Automatic Compensation and Batch Processing
section
of the relevant tutorial.
1429

You can save compensation definitions to folders
automatically apply to the FCS files in the folder.
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, and have them

Compensations may be applied to individual or multiple plots by performing either
option in the Compensations navigator below. Note if user option Default
Compensation to Use is set to any option other than None, the compensation
applied will revert to the preference (i.e. Compensation Default or FCS file)
when changing the data displayed on the plot or during batch processing.
Left-click to select compensation name from Loaded automatically with
data files folder or Created manually folder and click Apply to selected
plots or Apply to all plots button in top menu bar (Figure 16.19)

Figure 16.19 -Compensation
navigator menu to access options
to apply selected compensation
to selected or all plots (outlined in
red)

Right-click compensation and click Apply to selected plot or Apply to all
plots button in popup menu (Figure 16.20)
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Figure 16.20 - Right-click popup menu to access
options to apply selected compensation to selected
or all plots (outlined in red)

Additionally, standard copy and paste commands 142 may be used to move
matrices from one compensation definition to another within the
Compensations navigator.
Note that various other functions in FCS Express allow you to apply a
compensation definition. For instance, when performing Parameter Math you can
choose whether a compensation definition is applied prior to performing the
math.

16.6

Selecting the Default Compensation
FCS Express has many default options for compensation definitions when
opening files or adding overlays to a plot. These options are found on the
General page of the Options dialog (File tab Options) in the Default
Compensation to Use drop-down list. The options are described in the table
below.
Option
None

Explanation
When adding a new plot, no compensation will be used. When changing
a file on an existing plot, the compensation that was applied to the plot
638 before the change will continue to be used.
Compensation The compensation definition that was manually Set as Default will be
Default
used. To set the definition, see Setting Up Compensation Definitions 626 .
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Option
FCS File

Explanation
The compensation definition stored with the file is automatically used
when the data file is displayed on a plot. This is commonly the matrix
defined at the time of acquisition (for FCS 3.0 or later format files), or it
may be a compensation that was Assigned to an .fcs file by FCS Express
626 .
FCS File, then See FCS File, above. However, if there is no definition, the default
Compensation compensation definition will be applied (see Setting Up Compensation
Default
Definitions 626 ).
Compensation See compensation default above. However, if there is no Compensation
Default, then
Default, the compensation stored with the file will be automatically
FCS File
loaded as described in FCS File above.

16.7

Adjusting Compensation Definitions from a 2D Plot
It is also possible to adjust the compensation definition from a 2D plot itself.
Right-click on the plot and select Compensation from the pop-up menu. The
compensation item contains one submenu for every compensation definition that
is used on the plot (maximum one per overlay). For step-by-step instructions on
using the this feature please see our Manual Compensation Tutorial .
1392

The first item in the Compensation submenu is Create New, which allows you
to create a new compensation definition. If you select Create New, a dialog will
appear asking you to enter a name for the new compensation as well as some
additional information (Figure 16.21). To edit an existing compensation definition,
select the appropriate submenu item.

Figure 16.21 Creating a New Compensation from a 2D Plot
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After naming a new compensation and clicking OK, or selecting a compensation
definition to edit, the Edit Compensation dialog will appear (Figure 16.22). Use
this dialog to compensate the two parameters against each other on the plot.
Move the slider to either increase or decrease the amount of compensation. If
you check Automatic Preview, the plot will update with the new compensation
settings as you edit the compensation in real-time. If the Compensations
window is open and displaying the compensation currently being edited, the
Compensation Matrix and Spillover Matrix 627 values will update in real time, as will
plots to which the compensation has been applied.
Click Cancel to reject the compensation changes and exit the dialog, or Restore
to discard the changes but continue editing the plot. Once you press OK, the
compensation settings for any plot on your layout to which this compensation
was applied will be changed to the new values.

Figure 16.22 Edit Compensation Dialog

16.8

Working with Individual Compensation Files
The extension for an individual compensation matrix in FCS Express is
.compensation. This is the extension that is applied in an Assign this
compensation to a data file or Export the selected compensation
command from the Compensations 626 command.
If FCS File or FCS File, then Compensation Default is specified as the default
Option for loading compensations 641 , when loading a list mode file, FCS express
will look in the folder where the file is being loaded for a file with the same name,
but ending in .compensation. For instance, if you are loading sample1.fcs then
FCS Express will look for sample1.fcs.compensation. If it finds this file, it will load
that matrix as if it was specified in the .fcs file itself.
If it does not find the specific compensation file, it will look for a file of the type
*.allcompensation in the same folder as the data file. The individual matrix in the
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*.allcompensation file will be applied to all of the files in that folder.
Note: If there are two or more *.allcompensation files in the same folder, e.g.,
type1.allcompensation and type2.allcompensation, the results cannot be
predicted. In such a case, FCS Express will pick one randomly.

16.9

Saving Compensation Definitions
All compensation definitions are automatically saved with the layout file when the
layout is saved. The Automatic Compensation Setup 630 is also saved with each
compensation.
Save an individual compensation definition (*.compensation) by selecting the
Data tab Data Info Compensations command, select a compensation
definition by clicking on it, and click the Export the selected compensation icon
.

16.10

Loading Compensation Definitions

The compensation definitions that were saved with the layout are automatically
loaded when the layout is loaded. You may also choose to open a saved
compensation file (*.compensation) by choosing the Import a compensation
from a file
command, then navigating to the compensation file, and
selecting it to be opened.
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Working with FCS Data Files
FCS Express gives you the power to modify .fcs data files directly. You will be
able to edit existing 646 or add new keywords 648 , and export the raw data 662 as
modified .fcs files or other generic formats. You may also choose to merge
several FCS files into one file "on the fly" or export the merged data as a new
file.

17.1

Viewing and Changing FCS File Headers
To view the header details of the current FCS file 172 , use the Data tab Data
Info View Header command. The View Header window will appear (Figure
17.1). If you do not have any open .fcs files, you will be presented with a dialog
to select the desired file.
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Figure 17.1 View Header window

Some of the more common keywords associated with each parameter are
displayed in the Parameter Information field. You can view the entire list of
keywords by pressing the All Keywords… button. A dialog listing all the
keywords in the file will appear (Figure 17.2).
To copy all of the keywords to the clipboard in the $Keyword=Value format (for
pasting into a text document or a text box in FCS Express), press the Copy to
Clipboard button.
© 2020 De Novo Software

648

FCS Express 6 Manual

To print the keywords in the $Keyword=Value format, press the Print... button.
You can modify keywords by clicking the All Keywords... button near the
bottom of the window and entering in the new Value in the designated column
(Figure 17.2); note that not all values can be modified. You can also modify
any of the values in the editable freetext fields in the middle of the window.
To add keywords, click the Add Keyword button and a dialog will appear asking
you to fill in the new keyword label and value. When you press OK, your new
keyword will be added to the bottom of the list. To efficiently add multiple
keywords to a data file or keywords to multiple files 648 , please see instructions
on the following page 648 .
To remove a keyword, press the Remove Keyword button. If the keyword is
required, there will be another dialog informing you that the keyword cannot be
removed. If the keyword is not required, you will see a confirmation dialog after
the change has been made.
When you have finished making your changes in the View keywords - edit
mode dialog, press OK and the changes will be saved in the FCS file header.

Figure 17.2 View Keywords - Edit Mode

17.2

Extra Keywords
FCS Express allows you to add keywords contained in a text file (with the form
Keyword=Value) to an existing data file. This is useful for adding descriptors to
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your data files that were not saved as metadata at the time of sample
acquisition, or for loading data as multiwell plate Heat Maps 654 in FCS Express.
To add extra descriptive keywords to your .fcs files, use any of the following
methods:
Add a keyword text file with the name <filename>.extrakeywords.txt to
the same folder as a data file with the name <filename>. FCS Express
will display the extra keyword(s) 688 with the data file.
Add a keyword text file with the name
<descriptor>.allextrakeywords.txt to the same folder containing your
data files. FCS Express will display the extra keyword(s) 688 with all data files
in the folder.
Add a .csv file with the name ExtraKeywordsTable.csv containing columns
for filename and extra keyword(s) to the same folder containing your data
files. FCS Express will display the extra keyword(s) 650 with the appropriate
data file on a per-row basis.
The format of the .csv file should be as follows and as seen in Figure 17.3
below:
Column A contains a header named "filename"
Additional rows contain the file name of the file to add the
keyword value to within the folder. Make sure to include the file
extension as part of the name of the file.
Additional columns contain headers named with the name of the
keyword you would like to add.
Additional rows contain under each header contain the
information for the keyword associated with each file in text or
numeric form.
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Figure 17.3 Extra keywords .csv file
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Special Extra Keywords:
Plate Based Data:
When loading data as a multiwell plate Heat Map , the size of the plate must be
specified in an extra keywords file residing in the same directory folder as your
data file(s). The keywords file must contain the keywords $PlateRows and
$PlateColumns. In a typical 96 well plate, that file would contain the following
text:
1048

$PlateRows=8
$PlateColumns=12
Extra keyword .txt files for 6-, 12-, 24-, 48-, 96, and 384-well plates can be
downloaded on the De Novo Software website.

17.3

Keyword Anonymizer
The Keywords Anonymizer allows you to remove sensitive keyword information
from your data files.
Keywords are written into the file header of data files. Many of these keywords
contain the identification of the sample or patient from which these files came.
To maintain the privacy of these files, you can use the Keywords Anonymizer to
strip any keyword information that contains an identifiable feature.
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Anonymizer.
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Data Info

In the open Select Keywords to Anonymize window, you can:
Select the Files to anonymize :
o All active files, which will anonymize all the files currently active and
displayed within the layout, or
o Only the ones selected below, which allow selection of the files to be
anonymized .
Remove keywords :
o From this list, you can choose to remove:
all keywords
only the keywords listed below
all keywords except the ones listed below
To add specific keywords to the list, click on the Get keywords
button to open the Please select one or more keywords dialog, or
you can type the keyword into the list .
You can select multiple keywords using the Ctrl or Shift key.
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Figure 16 - The Keywords Anonymizer

Options to use the Keyword Anonymizer are also available when publishing your
layout using the advanced publisher add-on 603 .

17.4

Merging / Concatenating Multiple Files
FCS Express allows users to merge / concatenate multiple data files. This is
particularly useful every-time it is necessary to combined the data points across
multiple samples (e.g. different experimental conditions, different experimental
groups, different replicates,...).
Some examples for using file merging are as follows:

To visualize changes across multiple files in one plot (see Example A in Figure
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16.23 below, depicting a titration experiment);
To easily display multiple samples not acquired in plate format using Heat Map
plot (i.e. to present them in a multiwell "virtual" plate) (see Example B in the
figure below where 8 files are depicted in a multiwell plate format);
To perform data transformations on multiple files simultaneously without
ending up with different transformation results for each file (see the Example C
below where tSNE is calculated on 9 samples).

Data file merging can be accomplished in two ways in FCS Express.
1. Virtually Merging Files "on the fly" via the Merge FCS Files
loading data files in the Data List ().

658

2. Merging and exporting data files as a new .FCS or file type.

option when

666

Note that the above mentioned strategies are not super-imposable. The Virtual
Merge is faster but less flexible. For example, since the compensation matrix of
the first file is applied to all the subsequent files, the Virtual merge it is not
recommended if you want to use different compensation matrix for different
files.

Figure 16.23 - Use cases examples of file merging.
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Adding Merged Files to the Data List
Usually, Flow and Image cytometry files are added as separate data files in the
data list. However, multiple files may be merged together and loaded as a new
file using the Merge FCS Files file format from the file of type drop down. Once
a merged data file is added to the data list it may be used in any of the plots and
analysis your perform in FCS Express.
Merging data files using the Merge FCS Files file of type is a convenient way to
load and visualize multiple files on one plot, for instance, with an antibody
titration or drug treatment series, and may prove particularly useful when
performing transformations 934 where an algorithm must be run on a file that is
representative of all samples in the experiment. Merged files may also be
represented in a heat map even if they were not acquired on a plate . When
using the Merge FCS Files option there is no need to export as a new data file
as the files that are selected will be "virtually" merge on the fly. Virtually merged
files can be used as any other .FCS File would be used. They can be displayed in
any plot types 171 and statistics 379 can be derived from them as well.
1048

Please also see the chapter on Exporting FCS File Data from Multiple Files 666 if
you would like to merge multiple data files and save the resulting merged data
file as a new .FCS file.

To begin merging data files using the Merge FCS Files option:
1. Open the Data list
2. Click on the

783

.

button.

The Standard Open Data Dialog will appear as in Figure 16.24 below.
Note: based on your User Options 212 , the Advanced Open Data Dialog 216 may
appear. If the Advanced Open Data dialog appears, please select the
button to access the Standard Open Data Dialog.
3. Select Merge FCS Files (*.fcs; *.lmd; *.*) from the files of type drop-down
menu (Step 1 figure below).
4. Select multiple files from your computer (Step 2 in figure picture below).
5. Click Open File.
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Figure 16.24 - The Standard Open Data dialog

The selected files will be virtually merged / concatenated in alphabetical order and
a single file will be listed for them in the Data List (Figure 16.25 below).
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Figure 16.25 below. The Data List with the virtually merged file loaded.

The virtually merged file is concatenated as follow:
Files are concatenated in alphabetical order.
The compensation matrix of the first file is applied to all the following files (the
compensation matrices of the following files are not used).
A File Identifier 667 and a Classification File Identifier 668 are added. The first one
can be used to discriminate the merged files using 1D and 2D plots afterwards.
The second one can be used to discriminate merged files using an Heat Map
plot afterwards.
1048

An example of virtually merged file is depicted below. The File Identifier
parameter can be displayed on 1D and 2D plots. Single files can be selected by
Converting and Linking Markers 364 on 1D plots, or by using 1D or regular gates 316
on 2D plots (Figure 16.26, upper panes). The Classification File Identifier
parameter can be displayed in Heat Map
plots. With Heat Maps, single files can
be selected by by using Well Gates
(Figure below, lower pane).
1048

1059
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Figure 16.26. The virtually merged file is loaded into different plots displayin either
the File Identifier or the Classificiation File Identifier paranmeter. Single files are
also selected by Markers (Converted and Linked to gates), 1D Gates or Well Gates.

Heat Map plots displaying the virtually merged files can be customized in term of
both Color Scheme
and well layout . The example below shows the same
Heat Map plot above, with both the color scheme and the well layouts
customized (Figure 16.27).
1055
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Figure 16.27 The same Heat Map plot of the figure
above, customized both in term of color scheme and
well layouts.

Note: the virtually merged file can be exported as a merged file by using the
Single File Export tool 662 and by selecting the DNS data stream file (*.dns) file
type.

17.5

Exporting FCS File Data
FCS Express gives you two ways to export (i.e., save) the data from an FCS file
in different formats. You can export data from a single file 662 or you can "batch
export" data from several files 666 at one time. Files may also be Merged/
Concatenated 666 to create one new file that can display and compare
parameters in a single plot for multiple data files.

17.5.1

Exporting FCS File Data from a Single File
To export the data from an open FCS file:
Select a plot displaying the file to be exported.
Note: the compensation applied to the selected plot will also be applied to the
exported data.
Use the Data tab Save/Load
Data dialog (Figure 17.4).

Export command to bring up the Export
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Figure 17.4 Export Data dialog

You must assign a name and file type for the data you are exporting. It is
recommended to click the folder icon to the right of the Export file name field.
This will bring up a Save As dialog (Figure 17.5) where you can choose the
folder to save the data in, enter a file name, and choose the file type from a drop
down menu.
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Figure 17.5 - The file export Save As dialog. Note the files of type dropdown
list and Options button.

The Options button in the Save As dialog will allow you to set the specific
options for the selected data format. Figure 17.6 depicts the Saving Options
when FCS files (*.fcs) is selected as file type.
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Figure 17.6 - The Save Data dialog allows you to choose the format of the data file
saved.

The following table lists the options available when exporting data as FCS files.
Option
Data Format

Endian Format

FCS Version

Save the FCS v3.0 time units in

Explanation
Select the data format to use: Integer or Single
Precision Floating Point. The default option is to
export the data with Single Precision Floating
Point.
Select the endian format to use: PC format
(little-endian) or Mac Format (big-endian). The
default option is to export the data in PC format.
Select the Flow Cytometry Standard (FCS)
format version: 2.0 or 3.0. The default option is
to export the data as FCS 3.0.
Select the units to use for the Time Parameter
(it only applies if 3.0 is selected in the FCS
Version in the option above). Possible choices:
Don’t modify the FCS time parameter,
milliseconds, seconds, minutes or hours. The
default option is Don’t modify the FCS time
parameter.

In addition to the FCS file (*.fcs) format, you can export the data as a text file
(*.txt), comma separated values file (*.csv), tab separated values file
(*.tab), space separated values file (*.prn), ICE file (*.ice), or a DNS data
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stream file (*.dns). After assigning the file name and type, click Save.
The Export Data dialog allows to select also additional options:
Select keywords to export. Keywords can be selectively exported using the
Keywords to export button.
Parameters to Export. Select which parameters to export in the
Parameters to Export list box.
Export Cell Range. Choose which cells to export, by cell number in the
Export Cell Range field. The format is [first cell number-last cell number]. By
default, the numbers represent the first and last cells in the file.
Export cells in Gate. Use the Export cells in Gate drop-down list, to export
cells only within the specified gate.
When you are ready to export, press OK.

17.5.2

Exporting FCS File Data from Multiple Files: Batch Export /
Merging/ Concatenation
You can export data from multiple files consecutively, or merged multiple files
into a single file, using batch export. The process is also sometimes referred to
as concatenation.
1. Select the Data tab Save/Load
Export command to launch
the Batch Export dialog (Figure 17.7).
2. Click Add to select the files to export. You can remove files from the
export list by clicking the Remove button (or clear all files with the Clear
button).
3. Use the Export as Individual Files radio button to export all files
separately and Export as Merged File to export all files merged into a
single file. When Export as Merged File is selected, you may check the
Create File Identifier column 667 box and/or the Create Classification
File Identifier Column 668 box, which both allow each event in the merged
file to be traced back to the original file (see details below 667 ).
The options, with respect to file types, and the choices for data to export, are
similar to those when exporting data from a single file 662 .
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Figure 17.7 Batch Export Dialog

Create File Identifier column adds a new column (parameter) to the merged
output file. The values for the File Identifier parameter are incremented for each
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file so that events in the merged file may be traced back to and gated on the
original files. In the example below (Figure 17.8), a merged output file has been
created from a dataset containing four original files. Three separate gates have
been drawn on events originating from files 1, 2, and 3 to allow for separate
analysis of these populations.
Note: In order for the File Identifier parameter scaling to display correctly, please
ensure that the default FCS Saving Option for Data Format 227 is set to Single
(default).

Figure 17.8 Merged file with File Identifier Column, with separate gates drawn on
events from original files

Create Classification File Identifier Column adds a new column (parameter)
to the merged output file. The values for the Classification File Identifier
parameter are text labels matching the file name to which each event belongs to
allowing each event in the merged file to be traced back to and gated per file.
The difference between the File Identifier parameter and Classification File
Identifier is that the Classification File Identifier parameter is compatible
with Heat Map plots . Thus, each original file may be represented as a well of
an Heat Map plot. Moreover, the Classification File Identifier parameter
reports the actual file name instead of a number as is the case with the File
Identifier parameter.
1048

Please note that to create the Classification File Identifier parameter, the DNS
data Stream files (*.dns) format must be selected as the file of type for the
output merged file (see the Merging / Concatenating FCS Files - Use Case
Example 670 chapter for more information on how to use this feature).
In the example below (Figure 17.9), a merged output file has been created from
a dataset containing four files. Three separate well gates have been drawn on the
wells of the Heat Map plot representing files 1, 2, and 3, to allow for separate
analysis of these populations.
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Figure 17.9 Merged file with Classification File Identifier Column, with separate
well gates drawn on the Heat Map plot to specifically select events from original
files

See an example of the Multiple File Merging feature in the Merging /
Concatenating FCS Files - Use Case Example 670 .

The Batch Export dialog also allows you to set the following options:
Export with compensation allows you to select the compensation that will be
applied to the data before exporting (default is None).
Possible choice are:
None (non-compensated data will be exported)
Default (the default option for compensation 641 specified in the
User Options will be used)
Any of the compensation definitions that are currently loaded into
the layout.
If more than one compensation has been applied to the files for export, a
single compensation must be selected from the Export with Compensation
option or no compensation will be applied to the merged output file.
When merging multiple data files, if a Data Specific Gate was used to select
the Cells to Export, the compensation applied to the merged output file
must be the same compensation applied to the Data Specific Gate. In this
case, it is recommend to select Default in the Export with Compensation
option and set the compensation used to create the Data Specific Gate as the
Default for the layout (see Applying Compensation Definitions 638 for more
information on how to set a compensation as Default for a layout).
Export with transformation allows to select the Transformation
be applied to the data before exporting. Default is None.

934

Select keywords to export allows to select which keywords will be
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maintained or removed after the export. Default is to export all keywords.
Parameters to Export allows to select the parameters to export. Default is all
parameters.
Cells to Export allows to select a subset of events to export.
Possible choices are:
Export Cell Range. Only the events in the specified range will be
exported. Default is all cells.
Export cells in gate. Only the events belonging to the selected gate
will be exported. Default is No gate.
17.5.2.1

Merging / Concatenating FCS Files Via Batch Export - Use Case Example

Here we will present a use case example for Merging/Concatenating Data
Files

666

. In the example, files from a titration experiment will be concatenated.

Briefly, each sample has been stained with a different dilution of the antibody of
interest (e.g. CD3 FITC). The file resulting from file merging will then be loaded
into FCS Express for further analysis. Both the File Identifier Column and the
Classification File Identifier Column will be created in this example. Of course,
the user can decide to create either one or both the above-mentioned Identifier
Columns.
1. Select Data tab

Export from the Ribbon. The Batch

Export dialog will open.
2. Click on Add from the Select Data File to Export section of the dialog
Add using Standard Open Data Dialog or Add using Advanced Open
Data Dialog (Figure 17.10). Note: The Advanced Data Dialog allows to select
files from the Data List.
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Figure 17.10 The Batch Export Dialog displaying the different Add options.

3. Browse and multiple select the files to merge.
4. Check the Export as Merged File radio button.
5. Browse to a location in the Export Filename field for the output file
an output file name (

and

select

in Figure 17.11).

a. Select DNS data Stream files as File of type (

in the figure below). Note

that this file extension is required to create the Classification File Identifier
Column. If only the File Identifier Column has to be created, FCS files (*.fcs)
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can be selected as File of type.
b. Note: When the File Identifier Column is created, in order for the File
Identifier parameter scaling to display correctly, please ensure that the default
FCS Saving Option for Data Format

227

is set to Single (default). Note that this

option is only available when FCS files (*.fcs) is selected as File of type. When
working with DNS files, the plot axis displaying the File Identifier parameter may
be manually customized with regards to the Resolution Options via the 1D plot
Specific Options

273

or the 2D plot Specific Options

304

.

Figure 17.11 The Save As dialog allows to specify the location, the name and the
type of the oputput file.

6. Check the Create File Identifier Column and the Create classification File
Identifier Column check boxes (

in the Figure above).

7. Click OK. The selected file will be merged/concatenated and the corresponding
merged file will be saved in the location specified in Step 5. Note that files are
merged/concatenated in the same order in which they are listed in the Select
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data files to export field (Step 2).
The merged file can be now loaded into the layout using 1D plots, 2D plots, Heat
Maps and Data grids.

Below is an example of a Density plot, Contour plot and Heat Map with the newly
merged file loaded. Note that the File Identifier Column and Classification File
Identifier Column created in Step 6 above can now be used to create gates
and well gates and thus to virtually separate the different merged files (Figure
17.12).

Figure 17.12 An example of Density (left) and Contour (right) plots of the file
resulting from the merge.

Plots displaying the File Identifier Column and file-specific gates can be both
integrated in any of your layout as they are compatible will all functionality of FCS
Express (Figure 17.13).
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Figure 17.13 An example of file-specific gates drawn on the file resulting from the
merge.

Please see also the Antibody Titration Spreadsheet use Cases 2

1675

to see how to

use spreadsheet for this type of assay.
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Working with Data Grids
FCS Express allows you to view the raw data acquired for every event or "cell" in
a data set, including cell images if applicable.
Select the Insert General Data Grid command to insert a Data Grid in the
layout to show the data from the top data set (Figure 18.1). If no data set is
open, you will be prompted to select a file.

Figure 18.1 Data Grid

To copy the raw data to the clipboard, select the cells to copy, and then use the
Home Clipboard Copy Text command. To select an entire column, click on
the column header for the parameter. To select an entire row, click in the small
grey box to the left of the cell number.
To export multiple parameters to a text file, see Exporting FCS File Data

662

.
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Formatting Data Grids to Display Only Images
In order to format a Data Grid to only display images, right-click on the Data
Grid and select Format from the pop-up menu. Choose the parameters to
show as columns in the grid by using the Parameters to Display category
(Figure 18.2). To show selected columns, choose Only the items checked
below or All items except those checked below, and then check the
appropriate items.
For all other formatting options please see Formatting Data Grids and Custom
Data Grids 308 .

Figure 18.2 Showing and Hiding Columns in a Data Grid to only display images.

18.2

Applying Gates to a Data Grid
Gates can be applied to data grids to show just the data within the gate. To do
so, use the Gating Create Gates group and choose a gate from the Current
Gate drop-down list.
Gates may also be applied to a Data Grid by dragging the gate and dropping it on
top of the Data Grid. Please see the section on Using Gates 316 for additional
details and options.

18.3

Backgating on a Data Grid
A Data Grid can also be backgated
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1. Right-click on the grid and select Format from the pop-up menu.
2. Choose the Gates to Display category.
3. Select a gating scheme using the radio buttons and check the gates
appropriate to your scheme (Figure 18.3).

Figure 18.3 Formatting a Data Grid - Gates to Display

When gates are displayed in a Data Grid, a Gates column is present. If an
event falls in one or more gates, colored bars (according to the gate colors)
will be shown in the Gates column (Figure 18.4).
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Figure 18.4 Backgated Data Grid. Bars in the Gates column of some events show in
which gate(s) the cells fall.

18.4

Creating Cell Number Gates on a Data Grid
To create a gate on a Data Grid, right-click on the grid and select Create Gate
from the pop-up menu. A new column will appear in the grid (Figure 18.5).
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Figure 18.5 Creating a Gate on a Data Grid

Check the events in the New Gate column that you want to include in your gate
(so-called "Cell Number gates") and click OK to bring up a Create New Gate
dialog where you can assign a name to the gate and choose the color 318 .
You can also create a gate containing a Selection or Range using the
appropriate drop-menu items.

18.5

Viewing Compensated and Transformed Values in
Data Grids
Data grids may be formatted to display compensated and transformed values.
Please note only one compensation and one transformation may be applied at a
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time for each plot or data grid selected. Also, the transformation will have its
own column(s) displayed in the data grid, the number of which are dependent
upon the transformation selected.
Compensations may be applied to data grids by any of the following commands:
Drag and drop compensation from Compensations navigator (Figure 18.6).

Figure 18.6 - Drag compensation from Compensations navigator and drop onto
data grid (red arrow).

Right-click data grid
listed options (Figure 18.7).
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Figure 18.7 - Right-click data grid to Show Compensated Values menu.

Access Formatting dialog for general options 309
compensation to use from Use Compensation drop down list
18.8).

select
(Figure
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Figure 18.8 - Using Formatting dialog to select from Use Compensation drop
down list under Data Options.

Transformations may be applied to data grids by any of the following methods:
Drag and drop from the Transformations navigator to the intended data grid
(Figure 18.9).
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Figure 18.9 - Applying parameter math transformation to a plot by dragging from
the Transformations navigator to the data grid (red arrow).

Right-click data grid Show Transformed Values
transformation from menu.(Figure 18.10).

select appropriate

Figure 18.10 - Accessing parameter math transformation by right-clicking data grid
and navigating to Show Transformed Values menu.

Access Formatting dialog for general options 309
parameter math to use from Transformation drop down list
18.11).

select
. (Figure
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Figure 18.11 - Applying parameter math transformation to a data grid by selecting
the parameter math in the Transformation drop down from the Formatting
Overlays dialog.
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Using Tokens
FCS Express allows you to insert special items, called Tokens, into a Text Box.
Tokens appear as text, but are dynamically evaluated and can display
information such as plot statistics, FCS file keywords, layout properties, and
system information. For example, tokens can be used to display the number of
pages in a layout, the percentage of events in a quadrant, and the instrument
used to acquire data.
Once a token is placed in a Text Box, the displayed information acts like any
other text and can be formatted like normal text 153 . Simply select the token text
and format it using the appropriate commands in the Text Tab, or, right-click on
the selected token text and choose the Format Token option from the pop-up
menu.
Tokens are evaluated automatically, which means that whenever the underlying
information changes, the text that the token displays will change accordingly.

19.1

Inserting Tokens
To insert a Token in a Text Box (or any other edit field that accepts tokens), use
either of the following methods:
Right-click in the body of the text box and select Insert Token from the
pop-up menu (or use the Text Insert Text Insert Token command).
The Insert a Token dialog will appear (Fig. 19.1):

Figure 19.1 - Insert a Token dialog
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Drag and drop a plot into the text box. The Paste Special dialog will
appear. Choose Statistic token or Keyword token (Fig. 19.2). The Edit
Statistic or Edit Keyword dialog box will appear, from which token(s) can
be selected for insertion. Multiple statistics may be chosen and inserted at
the same time by multiple selecting statistics from the Statistic category.
Multiple plots may also be selected and dropped into a text box. You
will be prompted by the Paste Special dialog separately for each plot
you have selected.

Figure 19.2 - Paste Special dialog

Drag and drop a gate into the text box. The Edit Statistic dialog box will
appear, from which token(s) can be selected for insertion. To select
multiple items, press Ctrl or SHIFT on the keyboard.
Drag and drop a default statistics into the text box. With a default gate or
histogram statistics window open you can drag and drop individual statistics
or hold down shift while clicking on different statistics to multiple select
them. One or many statistics may be inserted into a new text box in this
way.
When inserting a token into a text box embedded within a plot, you
may select the plot on which the token is on or from a different plot
listed for the Data Source category (Figure 19.3 below).
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Figure 19.3 - Create Statistic dialog displaying options outline in red for selecting
plot as source for token to be inserted.

There are many kinds of tokens that can be inserted:
Statistic

699

Displays plot, quadrant, and gate statistics. The value of a statistic token
updates automatically, whenever a change pertaining to that statistic is
made.
Keyword

704

Displays the information which is stored in the FCS file header. Each
keyword contains a different piece of information, i.e., acquisition date,
number of events, etc.
Statistic Classifier

705

Allows you to classify a statistic in terms of text, i.e., positive or negative
cells (see Statistic Classifier Tokens 705 ).
Layout

707
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Displays information related to the layout, including the number of pages,
the layout creation date, compensation settings, batch processing, and
gate information.
Gate

710

Displays information related to gate information, such as the gate name,
comments, link description, gate points, gate wells, combination formula or
gate color.
Signature

713

Displays information related to signatures such as Name, Description,
Status, Data, Time, Signer, and Stamping Notes
Compensation

713

Displays information for the Spill Over or Compensation Matrices.
Batch Processing

713

Displays information related to batch processing including the Current
Iteration, Number of Iterations, and Start time of the current batch
process.
SOP (Standard Operating Procedure)

714

Displays information related to SOP steps.
System

715

Displays information related to the current user and other system-related
data.
Plot

717

Displays text related to the Plot Information, such as:
1. Title
2. Footer
3. X axis label
4. Y axis label
5. Plot Number
6. Plot Description
7. Whether the plot is using channel calibration?
8. Is channel calibration applied on the X and/or Y axis?
This token can also display information as it relates to the Center, Top,
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Right, Bottom, or Left Quad Vertices in the plot.
Data Parameter

718

Provides a shortcut to a column of data in a data set. Normally used for
evaluating numeric data from a parameter in a custom token.
Spreadsheet Cell Value

721

Displays information from the specified cell address in the user-selected
spreadsheet on the layout.
Custom Tokens

725

These are tokens, which can contain user-defined formulas, that are
created from the Custom Token window 726 . A custom token formula can
contain arithmetic operations, such as division and multiplication, and
conditional operations, such as IF … THEN … ELSE. See Custom Tokens 725
for a more detailed explanation. Note: Since a custom token must be
created before it can be inserted into a text box, the Custom node will not
appear in the Insert a Token dialog until one or more custom tokens have
been created.
To insert a token, select the kind of token you want and then click Insert.
Alternatively, you can double-click on the token you want to insert. After you
Insert, a dialog box may appear asking you to set the properties for that
particular token. The token properties are described under Common Token
Properties 692 .

19.2

Common Token Properties
The Display Text token property is shared by all Tokens, whereas the Data
Source token property is only common to Statistic and Keyword tokens.
These two properties will be described in the following sections.

19.2.1

Display Text Token Property
When you insert or edit a Token in a text box, you have the option to select
what text will be displayed by changing the Display Text property. All tokens can
display one of the following three items:
Token Value
The token value is the default setting when a token is inserted into a text box.
The token will display the current evaluated information for the selected
statistic, keyword, etc. For example:
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o The "number of pages on the layout" token would display the number
"2" if the layout consisted of 2 pages. If a page was added, the number
displayed would change to "3".
o The token value representing the number of events on a particular plot
would display "3043" in the text box if there were 3043 events in that
plot.
o The token value for the data collection date (e.g., for an .fcs file on the
layout) would display "January 1, 2005" if the data was collected on the
first day of 2005.
Token Description
Displays the description of the token rather than the value. This is the default
setting when a token is used as part of a formula, for instance when creating
custom token 725 . For example:
o The "number of pages on the layout" token would display the description
"Number of Pages".
o The "number of events" token for the first overlay on the second plot
would display the description "Statistic: # of Events for Plot #2, overlay
#1".
Text
Displays user-defined text for the token. For example:
o If you enter the text "apple" then the token will display "apple" in the
text box.
o If you enter the text "My first draft" then the token will display "My first
draft" in the text box.

The following example will demonstrate how to change the Display Text
property:
1. Follow steps 1 – 5 from the example given in Inserting a Page Layout
Token 708 .
2. Double-click on the highlighted "1", which is the token value for the number
of pages token you inserted. The Edit Number of Pages dialog will appear
(Figure 19.4). Note that the three options are listed with the Token Value
selected by default.
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Figure 19.4 Edit Number of Pages Dialog

3. Choose the Token Description radio button and then click OK. The token
now displays the token description, "Number of Pages" as shown in Figure
19.5 rather than the token value "1".

Figure 19.5 Display Text - Token Description

4. Double-click on the highlighted "Number of Pages" token to return to the
Edit Number of Pages dialog.
5. Click on the Text radio button, and then enter "# of Pages on my Layout"
in the edit field.
6. Click OK.
The token now displays the text just entered on the previous screen (Figure
19.6).

Figure 19.6 Display Text - User Defined Text
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The Display Text option can also be changed by right-clicking on the text box
token and changing the Display Text option from the pop-up menu (Figure 19.7).
The user-defined Text option is primarily useful when creating custom tokens 725 .

Figure 19.7 Display Text Pop-up Menu

19.2.2

Data Source Token Property
The Data Source token property is available only for Statistic and Keyword
tokens. Many of these tokens are used to obtain information from an .fcs data
file or from a plot on the layout. As the data changes in a layout, the token
information will update as well.
Keyword tokens display .fcs file keyword information and Statistic tokens
display statistics calculated from the data. Each .fcs file contains multiple
keywords which can also be viewed from the View Header window 646 .
The Data Source token property is used to define where a token gets its
information. A token can obtain information directly from an .fcs file or from the
data that is being displayed on a plot. If the data source is a plot, then the token
will update whenever the data on that plot changes.
To configure a Data Source token property for a Statistic token using an .fcs
data file:
1. Create a new layout 92 .
2. Insert a Text Box 152 on the page and type in "The number of events in my
data file are: " (with a <space> after colon). Make sure that the flashing
cursor is located after the <space>.
3. Right-click near the flashing cursor in the text box, and select Insert
Token from the pop-up menu.
4. Choose the Statistic token and then click the Insert button. The Create
Statistic dialog will appear. If there are no plots on the layout (as in this
example), choose the Data File from Disk radio button (Figure 19.8).
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Figure 19.8 Create Statistic Dialog - Data Source - Data File from Disk

5. Click on the Select Data File button to locate an .fcs file, which will cause
the Select Data File 214 dialog to appear if Standard Open Data Dialog is
chosen under user options or Open Data File 215 dialog to appear if
Advanced Open Data Dialog is chosen under user options. When you
have chosen an .fcs file, the filename will appear in the Select a Data File
field (outlined in red in above figure.)
6. Leave the default option: Change data file during Next/Prev/Batch
enabled, so that the token information will update when the Data Source
changes.
Note: Instead of performing Steps 3 to 6, you can also drag a file from the
Data List 783 and drop it near the flashing cursor in the text box then directly
select Statistics from the Paste Special dialog. By clicking OK you will be
directly prompted with Step 7 below. You may still go to the Data Source
section to change any options if you choose.
7. Click on Statistic from the list of token properties on the top-left of the
Create Statistic dialog.
8. Select a Parameter from the drop down for the statistic.
9. Select a compensation or choose Default or None from the
Compensation drop down.
Note: by setting Default from the Compensation drop down, the default
option for compensation 641 specified in the User Options will be used.
10. Choose a gate from the drop-down list if any gates exist on the plot. The
default is No Gate which will use all events on the plot.
11.Select one, or multiple select, a Statistic option, such as # of Events
(Figure 19.9).
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Figure 19.9 Create Statistic Dialog - Statistic Page

9. Click OK. The text box will display the text entered in step 2 followed by
the statistical data from step 7 for the .fcs file selected in step 5.

To configure a Data Source token property for a Statistic token using a plot:
1.Open an existing layout 95 , or create a new one 92 .
2.Insert a 2D Dot Plot 171 on the page if there are none.
3.Insert a Text Box 152 on the page.
4.Right-click on the text box, and select Insert Token from the pop-up
menu.
5.Select Statistic, and then click the Insert button. The Data Source page
of the Create Statistic dialog will appear with Plot selected as the default
Data Source type (Figure 19.10).
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Figure 19.10 Create Statistic Dialog - Data Source Page

6.Select a plot from the Select a plot field, which lists the plots on the
layout.
Note: If multiple overlays exist on the selected plot, the desired overlay
must be selected from the Select an Overlay field appearing below the
Select a plot field.
7.Click on the Statistic category on the left.
8.Select a Statistic from the Statistic list, such as # of Events.
9.Click OK.
The Create Statistic dialog closes, and you will see that the text box now
displays the number of events in the plot.

Keyword tokens work in the same way as Statistics tokens, with the following
exceptions:
To insert a keyword token, select Keyword after selecting Insert Token in
Step 4 above.
In the Create Keyword dialog, there will be a Keyword category on the
left side of the window. After you select that category, you will be able to
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type in a keyword, or select one from the list of default keywords (see
Editing Keyword Tokens 704 ).

19.3

Token Descriptions and Editing Tokens
Each of the different categories of tokens contains a number of properties which
can be edited.
Jump to:
Editing Statistic Tokens 699
2D Plot Statistic Token Options 699
Histogram Statistic Token Options
Editing Keyword Tokens 704
Statistic Classifier Tokens 705
Layout Tokens 707
Inserting a Page Layout Token 708
Gate Tokens 710
Signature Tokens 713
Compensation Tokens 713
Batch Processing Tokens 713
SOP Tokens 714
System Tokens 715
Plot Tokens 717
Data Parameter Tokens 718
Spreadsheet Cell Value Tokens 721

19.3.1

702

Editing Statistic Tokens
To insert or edit a Statistic token, the following properties need to be set:
Display Text
Data Source
token.

692

695

to select the token value, description, or user-defined text.
to select the plot or FCS file as a source of data for the

Note: The Statistic page of the Create Statistic dialog is used to choose the
statistic to display in a statistic token. Because the Statistic property options
differ depending on the Data Source, you must select the Data Source first.
The Data Source page is the default page shown when you select Statistic
from the Insert a Token dialog.
19.3.1.1

2D Plot Statistic Token Options

If a 2D Plot is the Plot type chosen as a Data Source, the following properties
can be set (Figure 19.11).
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Figure 19.11 Statistic Options - 2D Plot as Data Source

Plot Information
Select a quadrant from the drop-down list to use as a basis for your
statistic. The default selection is None which will use all events on the plot.
Gate
Choose a gate from the drop-down list if any gates exist on the plot. The
default is No Gate which will use all events on the plot.
Statistic
Select the statistic to display. Multiple statistics may be selected to inserted
together. See 2D Plot Statistics 383 for descriptions of each.
Number Display Options
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Select the number of decimals to be displayed for this statistic and the
rounding mode for this statistic. Rounding mode options include Standard,
Down, Up, and Truncate. The default value is 2 decimal places. You can also
choose whether or not to display trailing zeroes.
Show scientific notation allows you to display the statistic in the form of
X.XXE+Y

It is also possible to insert or edit a Statistic token with an .fcs file as a Data
Source, though if the desired file is showing on your layout, it is preferable to use
a Plot as the Data Source as described above. The following properties need to
be set when an .fcs file is the Data Source (Figure 19.12):

Figure 19.12 Statistic Options - FCS File as a Data Source

Data File information
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o Parameter
Select the parameter data to use from the drop-down list.
o Compensation
Select a compensation definition 623 for the data or choose Default or
None from the Compensation drop down.
Note: By setting Default from the Compensation drop down, the default
option for compensation 641 specified in the User Options will be used.
o Derive Axis Titles From
Choose from the Data File axis titles, or axis titles from a predefined
Parameter Label Set 408 .
Gate
Choose a gate from the drop-down list for calculating the statistics on gated
events.
Statistic
Select the statistic to evaluate from the list box.
Number Display Options
Select the number of decimals to be displayed for this statistic, the Rounding
Mode and whether or not to show trailing zeroes. The options for the
Rounding Mode include Standard, Down, Up, and Truncate. The default is 2
decimal places.
Show scientific notation allows you to display the statistic in the form of
X.XXE+Y
19.3.1.2

Histogram Statistic Token Options

If a histogram is the Plot type chosen for a Data Source of a Statistic Token, the
following properties can be set (Figure 19.13).
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Figure 19.13 Statistic Options - Histogram as Data Source

Plot Information
Select a marker from the drop-down list to use as a basis for your statistic.
The default selection is None which will use all events on the plot.
Gate
Choose a gate from the drop-down list (if the histogram data is based on a
gate from a 2D plot). The default is No Gate.
Statistic
Select the statistic to display. See Histogram Statistics
each.

380

for descriptions of

Number Display Options
Select the number of decimals to be displayed for this statistic and the
rounding mode to be used for this statistic. The options include Standard,
Down, Up, and Truncate. The default value is 2 decimal places. You can also
choose whether or not to display trailing zeroes.
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Show scientific notation allows you to display the statistic in the form of
X.XXE+Y

19.3.2

Editing Keyword Tokens
When you insert or edit a Keyword token, the following properties need to be
set:
Use the Display Text 692 category of the Create Keyword dialog to choose
a token value (default), description, or user-defined text to display in the
token.
Use the Data Source 695 category of the Create Keyword dialog to select
the plot or FCS file as a source of data for the token.
Use the Keyword page of the Create Keyword dialog to edit the keyword
that will be displayed (Figure 19.14). Note: Because the Keyword options
differ depending on the Data Source, you must select the Data Source
before you can navigate to the Keyword page.

Figure 19.14 Keyword Properties

Select a keyword. Click on the ellipsis to display the scrollable Please select
a keyword dialog (Figure 19.<%19F++++%>). Click on the Keyword
you want to display, and then click OK to return to the Create Keyword
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dialog. Click OK to complete the Keyword edit or insert procedure.

Figure 19.<%19C++++%> Select a Keyword

For more information regarding Keywords, please watch our YouTube video that
goes into greater detail about what Keywords are and how to use them within
your analysis layout.

19.3.3

Statistic Classifier Tokens
Statistic Classifier tokens allow you to classify a statistic in terms of text. For
example, you would use a statistic classifier token to characterize a population
as "Positive" or "Negative" depending on the number of cells in a gate or
quadrant.
To insert a Statistic Classifier token:
1. Right-click on a Text Box.
2. Select Insert Token from the pop-up menu.
3. Choose the Statistic Classifier category and click on the Insert button.
A Create Statistic Classifier dialog will appear.

To define the statistic classifier, you enter the value you wish to classify in the
Enter a value to classify field. It is possible to enter a formula in this field,
similar to a formula you would use for a custom token 725 . Typically, however,
you insert a token in this field by clicking on the
button to the right of the field
and inserting a Statistic token. FCS Express evaluates the statistic classifier
token in terms of the classification that you set in the List of classifications. To
Add, Edit, Remove, or reorder classifications, click on the appropriate button to
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the right of the list.
In the example shown in Figure 19.15, a statistic classifier has been based on the
percentage of cells in the upper left quadrant of a dot plot. If the percentage of
cells in the upper left quadrant is greater than or equal to 30, the fluorochrome
marker on the Y-axis of the dot plot is considered to be positive. If the number is
less than 30, the population will be considered to be negative for the marker.

Figure 19.15 Statistic Classifier Example

Whenever there is overlap in the classification definitions, FCS Express performs
the classification in the order of the entries in the List of classifications. In this
example, if the percentage of cells in the upper left quadrant is exactly 30, the
population will be considered to be positive because: Positive: 30-100 comes
before (i.e., is placed higher than) Negative: 0-30 in the list.
You can also enter a default value for the token if none of the classifications
evaluates to true.
Figure 19.16 shows a text box with the statistic classifier from the example.
CD19 was displayed on the Y-axis and the percentage of cells in the upper left
quadrant was 81.59%.
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Figure 19.16
Text Box with
Statistic
Classifier

19.3.4

Layout Tokens
Layout tokens display information related to the layout, e.g., the number of
pages on the layout or the date the layout was created.
To insert Layout tokens directly into a Text Box
1.
2.
3.
4.

1300

:

Right-click on the Text Box.
Select Insert Token from the pop-up menu.
Select the desired Layout token.
Click the Insert button.

To edit the text format or display properties, right-click on the Layout token and
select Format Token or one of the Display Text options from the pop-up menu.
Or, double-click the Layout token to access the Edit dialog.
Layout Token
Number of Pages
Current Page
Number
Last Saved Time
Last Saved Date
Created Time
Created Date
Number of Files
in the File List
Current Print ID
Print Date and
Time
File Name
File Path
Current FCS File
Path
Current User
Current Page
Name
Current User
Security Groups
Last Saved
© 2020 De Novo Software

Definition
The overall number of pages in the current layout.
The page number of the layout page currently in use for the
token.
The time at which the layout was last saved.
The date on which the layout was last saved.
The time at which the layout was created.
The date on which the layout was created.
The total current number of data files in the Data List.
Identification number used for the print job.
The date and time when the layout was last printed.
The file name of the current layout.
The file path specific for the current layout.
The file pathway for the file which was last used in the layout.
The user name of who is currently logged into FCS Express.
The name of the page that is currently being viewed.
For users of the Security option, this token displays the name
of the security group to which the user belongs.
The last version number of FCS Express used when saving the
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Program Version
Last Saved
Layout Version
Last Loaded
Channel
Calibration File

layout.
The last layout version number used when saving the layout.
The last file that was used when performing Channel
Calibration 617 .

Also see the Inserting a Page Layout Token example
19.3.4.1

708

.

Inserting a Page Layout Token

The following is an example on inserting a Page Layout Token:
1. Create a new layout 92 , or open an existing one.
2. Insert a Text Box 152 on the page and type in "The number of pages on this
layout is " (with the <space> after the word "is").
3. Right-click near the flashing cursor in the text box, and select Insert Token
from the pop-up menu. The Insert a Token dialog will appear (Figure 19.17).
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Figure 19.17 Insert a Token Dialog

4. Select the Number of Pages token (located under Layout) and then click
the Insert button.
5. The text box will then look like Figure 19.18. Note how the background of the
number 1 is gray. When the Text Box is in edit mode, this signifies that the text
is actually a token rather than freetext.

Figure 19.18 Number of Pages Token in a Text Box

6. Insert a new page on the layout by using the Insert tab
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Page Blank command.
7. The FCS Express window will display the new, empty page. Return to the page
with the Text Box and Token by clicking on the Page 1 tab, located at the
bottom left of the layout screen. Since the text displayed in the token changes
as the information it is displaying changes, the token text now displays "2"
indicating the new number of pages (Figure 19.19).

Figure 19.19 Token Automatically Updates

19.3.5

Gate Tokens
Gate tokens display information related to the gates on the Layout. To see the
list of available gate tokens:
1. Right-click on a Text Box .
2. Select Insert Token from the pop-up menu.
3. Click on the triangle next to Gate on the Insert a Token dialog (Figure
19.20).
1300
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Figure 19.20 - Choose a Gate Token

4. Select a Gate token and click the Insert button. Or, double-click the
Gate token.

When you insert or edit a Gate token, the Create Gate Token dialog appears.
Use the Display Text 692 page of the Create Gate Token dialog to choose a
token value (default), description, or user-defined text to display in the token.
Use the Gate information page (Figure 19.21) to:
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Figure 19.21 Gate Token Options

Select the Gate Name (on which to base the token data) from the dropdown list.
Choose one of the following options for which Information to Display:
Gate Token
Gate Name

Comment
Link Description
Points

Combination
Formula
Gate Wells

Definition
This is the name that you specified when the gate was
created. This name that is used to reference the gate
throughout FCS Express.
This is text that you can specify when you are editing the gate
from the Gate View 343 .
If the gate is linked to a quadrant or a marker, this is the
information that describes that link.
If the gate is one of the basic shapes (elliptical, rectangular,
polygonal, or freeform) and not a combination gate, then this
is the set of points that define it on the plot.
If the gate is a combination gate, this is the formula that you
used to create it.
If the Gate is a Well Gate, this information tells you which well,
or wells, makes up the Gate.
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This token will describe the color used for the Gate.

Signature Tokens
Signature tokens are described in detail in the Displaying Signature Information
chapter.

19.3.7

1091

Compensation Tokens
Compensation tokens allow you to insert information pertaining to the current
compensation 622 settings. You can choose different source and target
parameters and display either the crossover or spillover matrix values (Figure
19.22).

Figure 19.22 - Compensation Tokens

19.3.8

Batch Processing Tokens
Batch processing tokens allow you to insert information relating to the current
state of the batch process 782 (Figure 19.23. These tokens are used to create
dynamic file names that change as a batch process proceeds thru a collection of
files (see Batch Processing - Save Layout 804 ).
The options include:
Gate Token
Current Iteration
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This is the iteration number of the current iteration that is
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Number of
Iterations
Start Time of the
Current Batch
Process

being displayed within your plots during batch processing, as
defined within the Data List.
This is the total number of iteration numbers, as defined
within the Data List.
This will list the time at which batch processing commences.
It will be listed in a hh:mm:ss AM/PM format.

Figure 19.23 - Batch Processing Tokens

19.3.9

SOP Tokens
Standard Operating Procedure tokens are described in detail in the Displaying SOP
Information
chapter. See token list below (Figure 19.24).
1111
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Figure 19.24 - SOP Token List

19.3.10

System Tokens

System tokens allow you to insert information pertaining to the current
computer session. The current system tokens are listed in the table below.
To insert a System token:
1. Right-click on a Text Box.
2. Select Insert Token from the pop-up menu. Scroll the list box until you
see the System category, if necessary.
3. Click on the triangle next to System (Figure 19.25).
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Figure 19.25 - System Tokens

4. Choose one of the System tokens and click the Insert button.

System Token
Current FCS Express
User
Current Date

Definition
The name of the user currently logged into FCS Express.
The current date as shown on the workstation.
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Current Time
The current time as shown on the workstation.
Current Windows User The user name for whoever is currently logged into
Windows.
Temp Folder
The destination pathway for the Temporary folder.
Desktop Folder
The destination pathway for desktop folder of the user
currently logged into FCS Express.
My Documents Folder The destination pathway for the user's Documents
folder.
Common Documents The destination pathway for the Public Documents
Folder
folder.
Configuration
Identifier associated with license configuration file.
Company ID

19.3.11

Plot Tokens

Plot Tokens allow you to insert information pertaining to a plot selected as Data
Source 695 . To insert a Plot token:
1. Right-click on a Text Box.
2. Select Insert Token from the pop-up menu.
3. Click on the triangle next to Plot (Figure 19.26).

Figure 19.26 - Selecting Plot Token from the Select
Token Type dialog

4.Double-click on Plot Information or Quad Vertices.
© 2020 De Novo Software

FCS Express 6 Manual

718

5.Choose the desired plot from the Select a Plot list from the Data Source
category of the Edit Plot Information Token dialog
6.Choose the desired token from the list in the Plot Elements 718 or Quad
Vertices 718 category, and click OK.

Plot Elements
The available Plot Elements tokens are described below.
Plot Element
Title
Footer
X Axis Label
Y Axis Label
Plot Number

Definition
The text within the plot title 249 .
The text contained with the plot footer.
The label used for the X axis within the plot.
The label used for the Y axis within the plot.
The number given to the plot by FCS Express as it is
created.
Plot Description
An overall description of the plot, showing the Plot Number,
Plot Type, the data file name being displayed within the plot,
and the X and Y axis parameters for the selected plot.
Use Channel
Has the Use Channel Calibration on Axes option been
Calibration?
selected for that plot? The output is Off or On 616 .
Is Channel
A description of whether or not channel calibration has been
Calibration Applied applied to the X axis.
on X axis?
Is Channel
A description of whether or not channel calibration has been
Calibration Applied applied to the Y axis.
on Y axis?
Quad Vertices
This token will display the X- and Y- coordinates for a selected vertex of a
Quadrant 290 .
The options are Center, Top, Right, Bottom, Left.

19.3.12

Data Parameter Tokens

Data Parameter tokens provide a shortcut to a column of data in a data set.
Data Parameter tokens are normally used for evaluating numeric data from a
parameter in a custom token, for instance, the mean value of a particular
parameter (Figure 19.27).

© 2020 De Novo Software

Using Tokens

719

Figure 19.27 A Data Parameter token for Parameter 3 of plot 1
being used in a custom token formula to calculate the Mean of
Parameter 3.

To insert a Data Parameter token:
1. Right-click on a Text Box.
2. Select Insert Token from the pop-up menu. Scroll the list box until you
see the Data Parameter token type, if necessary (Figure 19.28).
3. Choose the Data Parameter token and click the Insert button.
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Figure 19.28 - Data Parameter Tokens

Upon choosing to insert a Data Parameter token, the Create Data
Parameter dialog will open (Figure 19.29). After selecting the Data Source 695 ,
choose which Gate and Parameter to derive the column of data from in the
Parameter category.
Choosing Macro from the Output As dropdown will retrieve all values and
input them in the function without using any text derived values.
Choosing Data Values from the Output As dropdown will retrieve all
values and input them in the function as text derived value (Not
recommended for large data sets)
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Figure 19.29 Create Data Parameter token dialog.

19.3.13

Spreadsheet Cell Value Tokens

Spreadsheet Cell Value tokens provide a shortcut to data within a cell of a
spreadsheet 412 . The data may be derived directly from statistics within the
layout, keywords, or from data files in the data list. Inserting statistics for data
files in the data list allows additional flexibility in analysis of many statistics for
many data files that are not currently open in the layout. Spreadsheet Cell Value
tokens may be used in text boxes or in the batch actions.
To insert a Spreadsheet Cell Value token in a text box or layout:
Drag and Drop method:
1. Click and hold on the blue square in the lower right portion of the cell
to be referenced (Figure 19.30 below).
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Figure 19.30- Clicking and holding on the blue square on the bottom right of the cell
allows you to drag the cell value out of the spreadsheet to insert it as a Cell Value
Token in a text box or batch action.

2. Drag the cursor onto a blank section of the layout. A new text box will
be created that contains the Spreadsheet Cell Value token.
3. Alternatively, Drag the cursor into an existing text box. The
Spreadsheet Cell Value token will be inserted in the text box.
The drag and drop method may also be used to quickly populate Batch Actions
as in Figure 19.31 below.

Figure 19.31 - Dragging and dropping a Spreadsheet Cell Value token to an Excel
(Column Mode) action.

Right click method:
1. Right-click on a Text Box.
2. Select Insert Token from the pop-up menu. Scroll the list box until you
see the Spreadsheet Cell Value token type, if necessary Figure 19.32.
3. Choose the Spreadsheet Cell Value token and click the Insert button.
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Figure 19.32 - Insert Spreadsheet Cell Value Token

Upon choosing to insert a Spreadsheet Cell Value token, the Create
Spreadsheet Cell Value dialog will open (Figure 19.33). After selecting a
spreadsheet as the Data Source 695 , choose which Cell Address to derive the
value inserted.
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Figure 19.33 - Create Spreadsheet Cell Value dialog

If a spreadsheet is not selected first as the Data Source before proceeding to
Cell Address, a warning message will appear (Figure 19.34) prompting you
Continue or Correct.

Figure 19.34 - Spreadsheet Cell Value without dataset Message
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If OK is clicked before selecting Cell Address, a warning message will appear
(Figure 19.35) prompting you Continue or Correct.

Figure 19.35 - Spreadsheet Cell Value without Cell Address Message

19.4

Custom Tokens
Custom Tokens contain user-defined combinations of tokens and text to create
custom statistics. The custom combinations are created using mathematical
calculations and/or functional operators to define the custom token formula.
These formulas can contain any token including Statistic tokens, Keyword
tokens, or even other Custom tokens.
Once defined, custom tokens are inserted into text boxes the same way other
tokens are inserted 708 . During data analysis, the custom token formula is
evaluated by FCS Express and the result is displayed in the text box containing
the custom token. With custom token formulas you can:
Create mathematical expressions to combine tokens and/or text
Create conditional statements using IF..THEN..ELSE qualifiers
Convert a string of numeric values into a text result such as Positive or
Negative
The following sections will help you understand the power of Custom Tokens. A
comprehensive list of all Custom Token formula operators and functions 766 is
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also provided.
Note: FCS Express 6 uses Excel-style formula evaluation. Therefore, formulas
must start with "=".

19.4.1

Creating Custom Tokens
To create a Custom Token:
1. Click on the View tab Tokens
command to bring up
the dockable Custom Tokens window.
2. As with many of the functional windows in FCS Express, the Custom
Tokens window can be docked 115 to the sides of the screen. This helps
keep the window within reach, while not getting in the way. Once docked,
the window can be pinned to enable the Auto Hide feature.
3.The two areas of the Custom Tokens window, the Custom Token List
(upper pane) and the Custom Token Formula Editor (lower pane), are
separated by a splitter which can be moved to re-size the areas. (Figure
19.36)

Figure 19.36 Docked Custom Tokens Window

3.
4.
5.
6.

Click on the
(Add) icon.
Give the New Custom Token a unique name.
Click on the Token name in the list so that it is highlighted.
Enter or edit the formula:
Right-click in the lower pane of the Custom Tokens window, select
Insert Token from the pop-up menu, and choose a token from the
Insert a Token dialog; alternatively, drag and drop a gate or plot from
your layout which serves as Data Source 695 into the lower pane of the
Custom Tokens window to access the Edit Statistic dialog.
Modify the formula. You can use any of the operators and functions that
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727

.

The icon buttons in the Custom Tokens window are explained in the table
below.
Icon Button Explanation
Add a new Custom Token.
Create (and name) a new folder to manage Custom Tokens. Drag & Drop
Custom Tokens into the folder once it has been created.
Delete the selected item. Note: You can undo a delete by immediately
clicking Undo in the Quick Access Toolbar 65 .
Rename the currently selected item.

To understand how Custom Token formulas operate, and how to use them, a
number of examples are shown in the next sections of this chapter.

19.4.2

Custom Token Example 1: Mathematical Calculation
In the first example, you will create a Custom Token with a simple formula, and
then insert it into a Text Box.
1.
2.
3.
4.

Click on
(Add) in a docked Custom Token window 726 .
Edit New Custom Token to read Mathematical Calculation.
In the Formula area below the splitter 726 , enter the following: =100 * 30.
Click on Mathematical Calculation to highlight/select it. Your Custom Token
window should look like Figure 19.37.

Figure 19.37 Custom Token Example 1
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5. Create a Text Box
on a layout page.
6. In the Text Box, enter the phrase: The number of stars in the sky is:
<space>
7. Right-click at the end of the text, and select Insert Token from the pop-up
menu.
8. At the bottom of the Insert a Token dialog (Figure 19.38), make sure that
the Custom category is open (click on the triangle next to Custom, if
necessary), and select Mathematical Calculation.
1300

Figure 19.38 Insert a Token Dialog

9. With Mathematical Calculation highlighted, Click the Insert button. The Text
Box should now read: "The number of stars in the sky is: 3000.00". (The
default numeric output for a numeric result is two decimal places. This can be
changed by right-clicking on the token in the text box, selecting Format
Token from the pop-up menu, and changing the value on the Output Format
page with the spin control). Once the Text Box is no longer in edit mode, the
Mathematical Calculation token will display its result without a gray
background.
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This example demonstrates that when a Custom Token is inserted into a Text
Box, its formula is calculated and the result is displayed.

19.4.3

Custom Token Example 2: Mathematical Calculation with a
Token
The second example demonstrates how to insert tokens in your formulas to
create more complex custom tokens.
1. Insert a plot 171 and a text box
window 726 and dock 115 it.

152

on a layout page. Open the Custom Token

2. Click on
(Add) in the docked Custom Token window.
3. Edit New Custom Token to read "Math Calc with Token".
4. Enter = in the Formula area below the splitter 726 . Note: FCS Express 6 uses
Excel-style formula evaluation. Therefore, formulas must start with "=".
5. Choose the Data Source 695 of the token by either of the following methods:
right-click in the Formula area (lower pane of Custom Tokens window) and
choose Insert Token from the pop-up menu. Select Statistic and click on
the Insert button, and choose a plot from the Data Source category
drag and drop the desired gate or plot from your layout into the lower pane
of the Custom Tokens window, and double-click Statistic token.
6. From the Statistic category, highlight # of Events as the statistic. Click OK.
7. In the Formula area, enter "/2" to the right of the token.
8. Click on Mathematical Calculation with a Token to highlight/select it. Your
Custom Token formula should look similar to Figure 19.39.

Figure 19.39 Custom Token Example 2

9. Insert the Custom Token you have just created into the Text Box by either of
the following methods:
right-click on the Text Box , choose Insert Token from the pop-up
menu, select Math Calc with Token from Custom (clicking on the triangle
next to Custom to expand the list, necessary), and click the Insert button,
or
drag and drop Math Calc with Token from the Custom Token List (upper
pane of the Custom Tokens window) to an empty spot on your layout or to
an existing Text Box.
1300

The Text Box should now display the number of events in your dataset divided
by 2.
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Custom Token Example 3: Appending Text
Up until now, you have seen how formulas calculate and return numeric results.
However, formulas can also be used to display text. The following example
demonstrates how to create a formula that appends text with Keyword tokens
to return information:

1. Insert a plot 171 and a text box
window 726 and dock 115 it.

152

on a layout page. Open the Custom Token

2. Click on
(Add) in the docked Custom Token window.
3. Edit New Custom Token to read "Appending Text".
4. Choose the Data Source 695 of the token by either of the following methods:
right-click in the Formula area (lower pane of Custom Tokens window),
choose Insert Token from the pop-up menu, double-click Keyword, and
choose a plot from the Data Source category
drag and drop the desired plot from your layout into the lower pane of the
Custom Tokens window, and double-click Keyword token
5. Select the Keyword category of the Create Keyword dialog, and click the
ellipsis to bring up the Please select a keyword dialog.
6. Select $FIL and click OK to exit the Please select a keyword dialog and
then OK again to exit the Create Keyword dialog.
7. Enter the following after the keyword token: <space> was created on
<space>
8. Add the $DATE keyword (similar to steps 4–6). The Formula field should
resemble Figure 19.40.

Figure 19.40 Custom Token Example 3 Formula

9. Insert the Custom Token you have just created into the Text Box by either of
the following methods:
right-click on the Text Box , choose Insert Token from the pop-up
menu, select Appending Text from Custom (clicking on the triangle next
to Custom to expand the list, necessary), and click the Insert button, or
drag and drop Appending Text from the Custom Token List (upper pane of
the Custom Tokens window) to an empty spot on your layout or to an
existing Text Box.
1300

The Text Box should now resemble Figure 19.41.
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Figure 19.41 Custom Token Example 3

19.4.5

Custom Token Example 4: Conditional Statements
This example demonstrates using conditional IF..THEN..ELSE statements in a
Custom Token formula.
1. Insert a plot 171 and a text box 152 on a layout page. Create a gate
your cells of interest.
2. Open the Custom Token window 726 and dock 115 it.

318

around

3.
4.
5.
6.

Click on
(Add) in the docked Custom Token window.
Edit New Custom Token to read "Conditional Statement".
In the Formula field enter: =IF <space>
Choose the Data Source 695 of the token by either of the following methods:
right-click in the Formula area (lower pane of Custom Tokens window) and
choose Insert Token from the pop-up menu, and double-click Statistic.
Choose the plot from Step 1 from the Data Source category
drag and drop the plot from Step 1 from your layout page into the lower
pane of the Custom Tokens window, and double-click Statistic token.
7. From the Statistic category, select the gate that you created in Step 1 from
the drop-down list in the Select Gate field. Highlight # of Events as the
statistic. Click OK.
8. Type the following in the formula area: >2000 THEN "There are a lot of cells."
ELSE "There are very few cells". The Formula field should resemble Figure
19.42.

Figure 19.42 Custom Token Example 4 Formula

9. Insert the Custom Token you have just created into the Text Box by either of
the following methods:
right-click on the Text Box , choose Insert Token from the pop-up
menu, select Conditional Statement from Custom (clicking on the triangle
next to Custom to expand the list, necessary), and click the Insert button,
or
drag and drop Conditional Statement from the Custom Token List (upper
pane of the Custom Tokens window) to an empty spot on your layout or to
an existing Text Box.
1300

The token will display There are a lot of cells. if the number of events in the
Plot #2 is greater than 2000 and There are very few cells. if the number of
events is less than or equal to 2000. If you move the gate, the Custom Token
© 2020 De Novo Software

732

FCS Express 6 Manual

formula is recalculated. Therefore, the token will display a different result if the
number of events within the gate changes from less than 2000 to greater than
2000 (or vice versa).

19.4.6

Custom Token Example 5: Hiding Signature Tokens
Once you have created and set up your signatures
in FCS Express, you may
only want to display their signing status on your layout pages if the layout is
signed and forgo signatures labeled as "unsigned" or "never signed".
1087

Creating a new custom token based on your signature token
the hiding effect.

688

will accomplish

The custom token will take the form of a conditional statement 731 (IF, THEN,
ELSE statement) as follows where <signature XXXXX status> represents your
signature status
token. Use the following custom token equation to create the
token:
1096

=if ("<signature XXXXX status>" = "Never Signed" or "<signature XXXXX
status>" = "Unsigned") then "" else "Signed"
Please note that:
1. The custom token is case-sensitive so that Never Signed, Unsigned, and
Signed strings must be entered with capital letter when the match with the
Signature Token is evaluated (see example above).
2. If the Signature Status token is compared to a text string as in this
example, the Signature Status token must be formatted to be a text string
by adding quotes around it (as in the example above and the screenshot
below).
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Once the new custom token has been defined you may drag and drop or insert it
anywhere in the layout and the token will only be displayed when the signing
status is "Signed".

19.4.7

More Complex Custom Token Examples
The following two examples demonstrate more complex custom token
formulas:
Custom Token Example 5 demonstrates the use of parentheses to control
the order in which mathematical operations are applied. The part of the
formula inside the parentheses is performed first. The Custom Token
formula in Figure 19.43 calculates the average number of events across
three plots.

Figure 19.43 Custom Token Example 5
Formula

Custom Token Example 6 demonstrates the use of nested IF..THEN..ELSE
statements. The custom token formula shown in Figure 19.44 categorizes
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the fluorescence of a histogram based on the percentage of events within
marker regions (Figure 19.45). If 80% of the events exist in the right
marker region (M1), then the formula returns Bright. If the middle marker
region (M2) contains 80% of the events, then Medium is returned. If 80%
of the events exist in the left marker region (M3), then Dim is returned. If
none of the markers contain more than 80% of the events, then Unknown
is returned.

Figure 19.44 Custom Token Example 6 Formula

Figure 19.45 Fluorescence Intensity Marker
Example

Additional conditions could be applied in Example 6. For example, if the sum of
two markers contains more than 80% of the events, then Bimodal could be
returned.

19.4.8

Inserting Functions into Formulas
A number of mathematical functions 766 can be inserted into custom token
formulas. To insert a function, right-click in the formula area at the point you
want the function to appear, choose Insert Function from the pop-up menu,
and select the appropriate function (Figure 19.46).
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Figure 19.46 Inserting a Function into a Formula

The available functions in each group are pictured below.
Math
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Type-Conversion

Logic

Text Manipulation
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Date Time
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Regression
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SOP

For in-depth definitions for each non-Regression Function, please visit our
Custom Token Formula Reference 766 .
For in-depth definitions for each Regression Function, please visit our Regression
Analysis section 564 .
For a table indicating the equation, the formula associated with it, and the
parameters defined in FCS Express when a fit is performed, please visit our
section on the Available Equations 574 .

19.4.9

Editing Custom Tokens
You can edit the formula of a Custom Token directly in the Custom Tokens
window 726 by simply clicking on an available Custom Token from the list.
If you have already inserted a Custom Token into a text box, you can open an
Edit dialog (Figure 19.47) by either of the following methods:
right-click on the Custom Token in the Text Box and choose Format Token
from the pop-up menu, or
double-click on the token in the text box.
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Figure 19.47 Editing a Custom Token -- Font Page

By default, Custom Tokens will contain 2 decimal places. You can edit the
number of decimal places under the Number Format page of the dialog. On this
page of dialog, you can also edit the Rounding Mode (from either Standard,
Down, Up, or Truncate) and whether or not the value shows trailing zeroes.
On the Font page of the dialog, you can modify which font to use for the token
depending on the value of the token or a custom value. Click Add to bring up a
Create Classification dialog (Figure 19.48). To change the font style or color
for a range of values, select the Custom Font radio button and click the Edit
button. Then set the range and click OK. Repeat for other ranges.
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Figure 19.48 Create Classification Dialog

If you edit the formula of a Custom Token in a text box (as opposed to editing it
in the Custom Token window), you will be prompted whether you want to
modify the existing token (throughout the layout), or create a new token that
only applies to that text box. If you choose Create New, a new token with a
default name will be created. To modify the default name, right-click on the new
token in the Custom Token window, select Rename from the pop-up menu,
and edit the name.

19.4.10

Custom Token Formatting

FCS Express custom token formulas must follow standard rules for
mathematical expressions in order to generate the desired token output. In
addition to standard mathematical operations, FCS Express can also perform
text manipulation, i.e., joining two text phrases together. The following table
shows examples of correct and incorrect formulas for generating text results.

Desired Output
There are 5000 cells
4
22

Correct Formula
"There are" + "5000 cells"
2+2
"2"+"2"

Incorrect Formula
"There are" + 5000 cells
"2"+"2"
2+2

When tokens are inserted into formulas, they are considered to be one of two
types: numeric result tokens or text result tokens. Numeric tokens have a blue
background and text tokens have a peach background when a formula is being
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edited. It is possible to change the result type of a token by right-clicking on the
token and selecting the alternate result type from the drop-down menu (Figure
19.49).

Figure 19.49 Changing the Result Type in a Custom Token
Formula

When a new token is inserted into a formula, FCS Express will try to determine
the correct result type. However, some tokens can make sense either as a
number or text, depending on the context. It is up to you to ensure that the
correct type is selected. The result type is important when FCS Express is trying
to evaluate the result of a formula. Consider the case shown in the next table
where there are 5000 cells on plot 2.

Desired Output
Correct Formula
There are 5000 cells "There are " +
on plot 2
+ " cells on plot 2"
10000
* 2

Incorrect Formula
"There are " +
+ " cells on plot 2"
* 2

In the first example, the incorrect formula tried to link a numeric result token
(blue) to text phrases. The correct formula contains a text result token (peach).
In the second example, the incorrect formula tried to apply a mathematical
operation to a text result token (peach). The correct formula contains a numeric
result token (blue).
An incorrect formula will display ##ERROR## if the token is placed in a text
box.

19.4.11

Using Boolean Values in Custom Tokens

It is possible to create a custom token that returns a Boolean value. For
example, the statistic chosen in the custom token, Condition1, shown in Figure
19.50, was set on a gate drawn around the lymphocyte population. Condition1
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will evaluate to TRUE or FALSE, depending on the number of cells in the
lymphocyte gate.

Figure 19.50 Token that Evaluates to TRUE or FALSE

You can use the My Condition token inside another token. To do so, set the
result type of the token to Numeric and use the IsTrue or IsFalse function 766 , as
shown in Figure 19.51.

Figure 19.51 Using a Boolean token

19.4.12

Using Array Formulas in Custom Tokens

Several mathematical functions described in the Custom Token Formula
Reference 766 , such as Mean, StdDev, Minimum, Maximum, and Range, work on
arrays. The arrays can contain an unlimited number of elements enclosed in
square brackets and separated by commas. These elements can be constants or
tokens.
For example:
Using the formula =Minimum([54,36,75,89,39]) returns 36 when the
custom token is inserted in a text box.
The formula in Figure 19.52 will return the mean of the Y Median values of
the Upper Left quadrant across four dot plots.

Figure 19.52 Using Tokens in an Array Formula
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19.4.12.
1

Custom Token Example 3: Appending Text 2

Up until now, you have seen how formulas calculate and return numeric results.
However, formulas can also be used to display text. The following example
demonstrates how to create a formula that appends text with Keyword tokens
to return information:

1. Insert a plot 171 and a text box
window 726 and dock 115 it.

152

on a layout page. Open the Custom Token

2. Click on
(Add) in the docked Custom Token window.
3. Edit New Custom Token to read "Appending Text".
4. Choose the Data Source 695 of the token by either of the following methods:
right-click in the Formula area (lower pane of Custom Tokens window),
choose Insert Token from the pop-up menu, double-click Keyword, and
choose a plot from the Data Source category
drag and drop the desired plot from your layout into the lower pane of the
Custom Tokens window, and double-click Keyword token
5. Select the Keyword category of the Create Keyword dialog, and click the
ellipsis to bring up the Please select a keyword dialog.
6. Select $FIL and click OK to exit the Please select a keyword dialog and
then OK again to exit the Create Keyword dialog.
7. Enter the following after the keyword token: <space> was created on
<space>
8. Add the $DATE keyword (similar to steps 4–6). The Formula field should
resemble Figure 19.53.

Figure 19.53 Custom Token Example 3 Formula

9. Insert the Custom Token you have just created into the Text Box by either of
the following methods:
right-click on the Text Box , choose Insert Token from the pop-up
menu, select Appending Text from Custom (clicking on the triangle next
to Custom to expand the list, necessary), and click the Insert button, or
drag and drop Appending Text from the Custom Token List (upper pane of
the Custom Tokens window) to an empty spot on your layout or to an
existing Text Box.
1300

The Text Box should now resemble Figure 19.54.
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Figure 19.54 Custom Token Example 3
19.4.12.
2

Custom Token Example 4: Conditional Statements 2

This example demonstrates using conditional IF..THEN..ELSE statements in a
Custom Token formula.
1. Insert a plot 171 and a text box 152 on a layout page. Create a gate
your cells of interest.
2. Open the Custom Token window 726 and dock 115 it.

318

around

3.
4.
5.
6.

Click on
(Add) in the docked Custom Token window.
Edit New Custom Token to read "Conditional Statement".
In the Formula field enter: =IF <space>
Choose the Data Source 695 of the token by either of the following methods:
right-click in the Formula area (lower pane of Custom Tokens window) and
choose Insert Token from the pop-up menu, and double-click Statistic.
Choose the plot from Step 1 from the Data Source category
drag and drop the plot from Step 1 from your layout page into the lower
pane of the Custom Tokens window, and double-click Statistic token.
7. From the Statistic category, select the gate that you created in Step 1 from
the drop-down list in the Select Gate field. Highlight # of Events as the
statistic. Click OK.
8. Type the following in the formula area: >2000 THEN "There are a lot of cells."
ELSE "There are very few cells". The Formula field should resemble Figure
19.55.

Figure 19.55 Custom Token Example 4 Formula

9. Insert the Custom Token you have just created into the Text Box by either of
the following methods:
right-click on the Text Box , choose Insert Token from the pop-up
menu, select Conditional Statement from Custom (clicking on the triangle
next to Custom to expand the list, necessary), and click the Insert button,
or
drag and drop Conditional Statement from the Custom Token List (upper
pane of the Custom Tokens window) to an empty spot on your layout or to
an existing Text Box.
1300

The token will display There are a lot of cells. if the number of events in the
Plot #2 is greater than 2000 and There are very few cells. if the number of
© 2020 De Novo Software

FCS Express 6 Manual

748

events is less than or equal to 2000. If you move the gate, the Custom Token
formula is recalculated. Therefore, the token will display a different result if the
number of events within the gate changes from less than 2000 to greater than
2000 (or vice versa).
19.4.12.
3

Custom Token Example 5: Hiding Signature Tokens 2

Once you have created and set up your signatures
in FCS Express, you may
only want to display their signing status on your layout pages if the layout is
signed and forgo signatures labeled as "unsigned" or "never signed".
1087

Creating a new custom token based on your signature token
the hiding effect.

688

will accomplish

The custom token will take the form of a conditional statement 731 (IF, THEN,
ELSE statement) as follows where <signature XXXXX status> represents your
signature status
token. Use the following custom token equation to create the
token:
1096

=if <signature XXXXX status> = "Never Signed" or <signature XXXXX status> =
"Unsigned" then "" else "signed"

Please note that the custom token is case-sensitive so that Never Signed,
Unsigned, and signed must be entered exactly as above.
Once the new custom token has been defined you may drag and drop or insert it
anywhere in the layout and the token will only be displayed when the signing
status is "Signed".
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More Complex Custom Token Examples 2

The following two examples demonstrate more complex custom token
formulas:
Custom Token Example 5 demonstrates the use of parentheses to control
the order in which mathematical operations are applied. The part of the
formula inside the parentheses is performed first. The Custom Token
formula in Figure 19.56 calculates the average number of events across
three plots.

Figure 19.56 Custom Token Example 5
Formula

Custom Token Example 6 demonstrates the use of nested IF..THEN..ELSE
statements. The custom token formula shown in Figure 19.57 categorizes
the fluorescence of a histogram based on the percentage of events within
marker regions (Figure 19.58). If 80% of the events exist in the right
marker region (M1), then the formula returns Bright. If the middle marker
region (M2) contains 80% of the events, then Medium is returned. If 80%
of the events exist in the left marker region (M3), then Dim is returned. If
none of the markers contain more than 80% of the events, then Unknown
is returned.

Figure 19.57 Custom Ton Example 6 Formula
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Figure 19.58 Fluorescence Intensity Marker
Example

Additional conditions could be applied in Example 6. For example, if the sum of
two markers contains more than 80% of the events, then Bimodal could be
returned.
19.4.12.
5

Inserting Functions into Formulas 2

A number of mathematical functions 766 can be inserted into custom token
formulas. To insert a function, right-click in the formula area at the point you
want the function to appear, choose Insert Function from the pop-up menu,
and select the appropriate function (Figure 19.59).
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The available functions in each group are pictured below.
Math
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Date Time
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For in-depth definitions for each non-Regression Function, please visit our
Custom Token Formula Reference 766 .
For in-depth definitions for each Regression Function, please visit our Regression
Analysis section 564 .
For a table indicating the equation, the formula associated with it, and the
parameters defined in FCS Express when a fit is performed, please visit our
section on the Available Equations 574 .
19.4.12.
6

Using Boolean Values in Custom Tokens 2

It is possible to create a custom token that returns a Boolean value. For
example, the statistic chosen in the custom token, Condition1, shown in Figure
19.60, was set on a gate drawn around the lymphocyte population. Condition1
will evaluate to TRUE or FALSE, depending on the number of cells in the
lymphocyte gate.

Figure 19.60 Token that Evaluates to TRUE or FALSE

You can use the My Condition token inside another token. To do so, set the
result type of the token to Numeric and use the IsTrue or IsFalse function 766 , as
shown in Figure 19.61.

Figure 19.61 Using a Boolean token

19.4.13

Deleting Custom Tokens

To delete a custom token, right-click on the token in the Custom Token window
list 726 and select Delete from the pop-up menu. If the deleted token is used in
the formula of another Custom Token, the remaining token will display
##ERROR## if it is used in a text box.
Also, a custom token can be deleted by selecting the token in the Custom Token
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window List, and by clicking the Delete button
toolbar.

19.4.14

in the Custom Token window

Custom Token Display Types

FCS Express 6 has new custom token Display types which allow you to insert
an interactive Edit box, Check box, or Dropdown list directly in a layout (Figure
19.62). The new Display type feature can be accessed by right-clicking on any
custom token displayed on the layout and choosing Format Token
(alternatively, double click on the custom token to open the Edit custom token
dialog). Within the Edit custom token dialog click on the Display type dropdown
and choose:
Edit box 759 - creates an editable box directly in the layout where you can
change custom token values which will update the original custom token
and subsequently any other instance of the custom token
Check box 761 - creates a check box directly in the layout that displays the
name of the custom token. Checking the box returns a "TrueValue" entry
for the custom token while unchecking the box returns a "FalseValue"
entry for the custom token.
Dropdown list 764 - creates a dropdown list of comma separated choices
entered in the Choices section of the Edit custom token dialog Display
category.
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Figure 19.62 The Display type feature in FCS Express allows you to create editable
text fields, check boxes, and dropdown lists directly in your layout.
19.4.14.
1

Edit Box Custom Tokens

The Edit box Display type allows you to create an editable box directly in the
layout where you can change Custom Token values which will update the original
Custom Token and subsequently any other instance of the Custom Token. To
create an Edit Box Custom Token:
1. Create a new Custom Token
with or without text.
2. Drag and drop the Custom Token from the Custom Token window onto the
layout to insert it.
3. Double-click the Custom Token in the layout to open the Edit custom token
dialog.
4. Change the Display type to Edit box (Figure 19.63).
1651
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Figure 19.63 The custom token display type is set to edit box.

5. Click OK.
An Edit box will appear within the text box in the layout where the token was
inserted (Figure 19.64).

Figure 19.64 When the
Custom Token Display type is
set to Edit box, an editable
box will appear in the layout.
This one appears empty as
the original Custom Token
formula was not defined (i.e.,
left empty)

6. Enter or change any text in the Edit box.
Once a value has been entered, the custom token value in the Custom Tokens
navigator will reflect the value entered in the Edit box. The Custom Token may
then be dragged and dropped from the Custom Tokens window to any other
location in the layout. When dragging and dropping the token from the Custom
Tokens window, the default display type of "label" will be used thus displaying
only the value entered in the Edit box. When the value is updated in the Edit
box, the Custom Token will update wherever displayed. (Figure 19.65)
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Figure 19.65 The text of "John Smith" was entered in the Edit box. The
value was updated in the Custom Token window and also in the
secondary text box containing the token.
19.4.14.
2

Check Box Custom Tokens

The Check box Display type allows you to create a check box directly in the
layout that displays the name of the Custom Token. Checking the box returns a
"TrueValue" entry for the Custom Token while unchecking the box returns a
"FalseValue" entry for the custom token. To create a Check box Custom
Token:

1. Create a new Custom Token
with or without text.
2. Drag and drop the Custom Token from the Custom Token window onto the
layout to insert it.
3. Double-click the Custom Token in the layout to open the Edit custom token
dialog.
4. Change the Display type to Check box (Figure 19.66).
1651

© 2020 De Novo Software

762

FCS Express 6 Manual

Figure 19.66 The custom token display type is set to Check box.

5. Click OK.
A Check box will appear within the text box in the layout where the token was
inserted (Figure 19.67).

Figure 19.67 When the custom token
display type is set to Check box, a
check box will appear in the layout
displaying the name of the custom
token.

6. Check or uncheck the box next to the Custom Token name in the layout.

Once the box has been checked, the Custom Token returns a "TrueValue" entry
for the Custom Token. Unchecking the box returns a "FalseValue" entry for the
Custom Token (Figure 19.68). The token value, "TrueValue" or "FalseValue"
may then be used in any location within FCS Express where a True or False
evaluation is made via tokens such as displaying pages or IF, THEN, ELSE
statements.
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Figure 19.68) Once the box has been checked, the Custom Token
returns a "TrueValue" entry for the Custom Token. Unchecking the
box returns a "FalseValue" entry for the Custom Token.
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19.4.14.
3

Dropdown Custom Tokens

The Dropdown list Display type allows you to create a list of comma-separated
values to appear in a dropdown list within the layout. To create a Dropdown
list:

1. Create a new custom token
with or without text.
2. Drag and drop the custom token from the Custom Token window onto the
layout to insert it.
3. Double-click the custom token in the layout to open the Edit custom token
dialog.
4. Change the Display type to Dropdown list.
5. Enter a list of comma-separated choices for the list in the text field
1651

(alternatively, choose to use any token values by clicking on the
(Figure 19.69).

button)

Figure 19.69 Enter a list of choices separated by a comma to be displayed in the
dropdown list.

6. Click OK.
An empty box will appear within the text box in the layout where the token was
inserted (Figure 19.70).

Figure 19.70 An empty
dropdown list box appears in
the layout where the token was
originally inserted.
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7. Click on the dropdown arrow to reveal the contents of the Dropdown list
(Figure 19.71).

Figure 19.71 Once the
dropdown arrow is pressed a
list of the comma separated
choice that were entered will
appear.

8. Click on any of the choices in the Dropdown list to fill the box (Figure 19.72).

Figure 19.72 The dropdown
list after the "De Novo
Software" choice was
selected.

Once a choice has been selected, the Custom Token value in the Custom
Tokens window will reflect the choice made in the Dropdown list. The Custom
Token may then be dragged and dropped from the Custom Tokens window to
any other location in the layout. When dragging and dropping the token from the
Custom Tokens window, the default display type of "label" will be used, thus
displaying only the value chosen in the Dropdown list. When the value is updated
via the Dropdown list the custom token will update wherever displayed. (Figure
19.73)
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Figure 19.73 The value of "De Novo Software" was chosen from the
dropdown list. The value was updated in the Custom Token navigator
and also in the secondary text box containing the token.

19.5

Custom Token Formula Reference
The following tables are a reference of all operators and functions available for
creating custom tokens in the Custom Token Editor 726 and with Parameter Math
935 .
Arithmetic Operators
Operator
x+y
x-y
x*y
x/y
x^y

Description
Add x and y
Subtract y from x
Multiply x and y
Divide x by y
x to the y power

Conditional/Comparison Operators. Use these with IF..THEN..ELSE
statements.
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Operator
x>y
x<y
x=y
x>=y
x<=y
x<>y
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Description
x is greater than y
x is less than y
x is equal to y
x is greater than or equal to y
x is less than or equal to y
x is not equal to y

Logical Operators. These are used in IF..THEN..ELSE statements or to combine
two equations.
Operator
Description
x OR y
x OR y
x AND y
x AND y
NOT (x AND y)
Inverse of the value of (x AND y)
Example: if (x>20 and y>20) then......else
If combining multiple logical operators, parenthesis must surround each operator.
Example: if ((x>20 and y>20) and (a<1 or b>10)) then......else

Mathematical Functions
Function
Abs(x)
ArcCos(x)
ArcCosh(x)
ArcSin(x)
ArcSinh(x)
ArcTan(x)
ArcTanh(x)
ConvertLinToLog(I,J,
K,L)

Description
Absolute value of x
Arc Cosine of x
Hyperbolic Arc Cosine of x
Arcsine of x
Hyperbolic Arcsine of x
Arctangent of x
Hyperbolic Arctangent of x
Converts a linearly scaled value into a logarithmically scaled value,
using the following parameters:
I = Lin value, J = # of decades, K = output range (with values of 0,
256, 512, or 1024), L = offset

This will convert a value from 1-10,000 to 0-1024.
ConvertLogToLin(I,J, Converts a Logarithmically scaled value into a Linearly scaled value,
K,L)
using the following parameters:
I = Log value, J = # of decades, K = input range, L = offset

Cos(x)
Cosh(x)
CoTan(x)
Ln(x)
Log(x,y)
Max(x,y)
Maximum([x,y,z...])
Mean([x,y,z...])
Min(x,y)
© 2020 De Novo Software

This will convert a value from 0-1024 to 1-10,000.
Cosine of x
Hyperbolic Cosine of x
Cotangent of x
Natural logarithm of x
Logarithm of y in base x
Returns the higher value of x and y.
Returns the maximum value in the array ([x,y,z,…]). The array can
hold an unlimited number of elements.
Returns the mean of the values in the array [x,y,z,…]. The array can
hold an unlimited number of elements.
Returns the lower value of x and y.

768

FCS Express 6 Manual

Function
Minimum([x,y,z...])
Range([x,y,z...])
Sin(x)
Sinh(x)
Sqr(x)
Sqrt(x)
StdDev([x,y,z...])
Tan(x)

Description
Returns the minimum value in the array ([x,y,z,…]). The array can
hold an unlimited number of elements.
Returns the result of (Maximum([x,y,z,…]) – Minimum([x,y,z,…])).
Sine of x
Hyperbolic Sine of x
x squared
Square root of x
Returns the standard deviation of the values in the array [x,y,z,…].
The array can hold an unlimited number of elements.
Tangent of x

Type Conversion Functions. These are used in more advanced formulas, to
convert a number to text and vice versa. They are used when the value returned
by a particular token is not the type that you need, and you want to convert it to
a type that you can include in your formula. You could also change the result
type as described in Custom Token Formatting 743 .
Function
Description
NumericToString(x) Converts the number x to text (also known as a string).
StringToNumeric(x) Converts the string x to a number.

Logic (True/False) Functions. These functions return the truth values of
applying an operation to the incoming parameters. Some of the functions return
a numerical representation of True (-1) or of False (0).
Function
Between(x,y,z)

Description
Returns True if x is between y and z (including being equal to y or z),
False otherwise.
FalseValue
Returns 0.
IsFalse(x)
Returns True if x has a value of 0.
IsSameText([Text1, Returns True if Text1 and Text2 are the same. If CaseSensitive is
Text2],CaseSensitiv true, the words must match in case, in addition to its content.
e)
IsTrue(x)
Returns True if x has a value of -1.
TrueValue
Returns -1.

Text Manipulation Functions. These functions can be used to manipulate or get
information out of existing text values.
Function
AreValuesInRange([x,
y,z...],tolerance,
[xName,yName,zName
...])
Copy(x,y,z)

Description
If the values in the array [x,y,z...] are all within tolerance % of
each other, it returns True. If a pair of values in the array are not
within tolerance % of each other, it returns text indicating which
ones are not.
X is the full text. Y is the position to start copying text. Z is the
number of letters (also known as characters) to copy from the full
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Function

Description
text. Returns a subset of the text x, starting at position y, copying
z characters in total.
ExtractFilename("file_ Accepts a file name and will return the text of the data file name.
path")
For example, if a file path is C:\Data Files\Today
\FlowData1.fcs, ExtractFilename("file_path")will return
FlowData1.fcs.
Keyword tokens using the keywords $FIL, $FCSE_FILENAME or
$FCSE_FILENAMENOPATH can be used for this function.
ExtractFolderFromFile Accepts a file name and will return the text of the file path of the
name("file_path")
folder in which the data is contained.
For example, if a file path is C:\Data Files\Today
\FlowData1.fcs, ExtractFolderFromFilename("file_path") will
return C:\Data Files\Today.
Keyword tokens using the keyword $FCSE_FILENAME can be used
for this function.
FormatFloat("format FormatFloat formats the floating-point value given by Number
string",number)
using the format string given by Format String. The following
format specifiers are supported in the format string:
Specifie
r

0

#

.

,

E+
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Represents
Digit placeholder. If the value being formatted has a digit
in the position where '0' appears in the format string, then
that digit is copied to the output string. Otherwise, a '0' is
stored in that position in the output string.
Digit placeholder. If the value being formatted has a digit
in the position where '#' appears in the format string,
then that digit is copied to the output string. Otherwise,
nothing is stored in that position in the output string.
Decimal point. The first '.' character in the format string
determines the location of the decimal separator in the
formatted value; any additional '.' characters are ignored.
The actual character used as a decimal separator in the
output string is determined by the DecimalSeparator
global variable or its equivalent.
Thousand separator. If the format string contains one or
more ',' characters, the output will have thousand
separators inserted between each group of three digits to
the left of the decimal point. The placement and number
of ',' characters in the format string does not affect the
output, except to indicate that thousand separators are
wanted. The actual character used as a thousand
separator in the output is determined by the
ThousandSeparator global variable or its equivalent.
Scientific notation. If any of the strings 'E+', 'E-', 'e+', or
'e-' are contained in the format string, the number is
formatted using scientific notation. A group of up to four
'0' characters can immediately follow the 'E+', 'E-', 'e+', or
'e-' to determine the minimum number of digits in the
exponent. The 'E+' and 'e+' formats cause a plus sign to
be output for positive exponents and a minus sign to be
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Function

Description
output for negative exponents. The 'E-' and 'e-' formats
output a sign character only for negative exponents.
Learn more about working with Scientific Notation.
'xx'/"xx" Characters enclosed in single or double quotation marks
are output as such and do not affect formatting.
Separates sections for positive, negative, and zero
;
numbers in the format string.

The locations of the leftmost '0' before the decimal point in the
format string and the rightmost '0' after the decimal point in the
format string determine the range of digits that are always present
in the output string.
The number being formatted is always rounded to as many decimal
places as there are digit placeholders ('0' or '#') to the right of the
decimal point. If the format string contains no decimal point, the
value being formatted is rounded to the nearest whole number.
If the number being formatted has more digits to the left of the
decimal separator than there are digit placeholders to the left of
the '.' character in the format string, the extra digits are output
before the first digit placeholder.
To allow different formats for positive, negative, and zero values,
the format string can contain between one and three sections
separated by semicolons, as follows:
* One section: The format string applies to all values.
* Two sections: The first section applies to positive values
and zeros, and the second section applies to negative
values.
* Three sections: The first section applies to positive values,
the second applies to negative values, and the third applies
to zeros.
If the section for negative values or the section for zero values is
empty, that is if there is nothing between the semicolons that
delimit the section, the section for positive values is used instead.
If the section for positive values is empty or if the entire format
string is empty, the value is formatted using general floating-point
formatting with 15 significant digits. General floating-point
formatting is also used if the value has more than 18 digits to the
left of the decimal point and the format string does not specify
scientific notation.
FragmentCount("text1 Returns the number of string fragments in text2 separated by
",'text2")
text1.
Text1 will equal a delimiter, such as "\", for example. Text 2 will be
a pathway.
For example, FragmentCount("\","C:\Documents\Data
\Sample.fcs") will return 4, since there are 4 fragments that are
delimited by "\".
Keywords that return a pathway can be used for Text2.
GetContainingFolder("f Returns the name of the folder containing the file named in
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ile_path")

GetFragment(n,
"text1", "text2")
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Description
file_path.
Example, if file Sample.fcs was located in the directory C:
\Program Files\De Novo Software\FCS Express 6 Plus Research
Edition/Data, the output for this function would be Data.
Returns the Nth string fragment in Text2, delimited by Text1.
N = the nth occurrence, Text1 = a delimiter, such as "\", Text2 =
a string that uses Text1 as a delimiter.
Some examples of Text2 could be:
a pathway that uses "\" as a delimiter, such as C:
\Documents\Data\Sample.fcs.
a name of a file where several identifiers have been
concatenated together and delimited by "_", such as
FirstnameLastname_ID1_ID2_ID3_Date.
For example, GetFragment(1, "\", "C:\Documents\Data
\Sample.fcs") will return C:.
GetFragment(2, "\", "C:\Documents\Data\Sample.fcs") will
return Documents.
If n is a negative number, the function will start evaluating the
text string backwards.

For example, GetFragment(2,"_","SheldonCooper_ABC_DEF_GHI") will return DEF.
IncludeTrailingPathDeli Accepts the value of "File_path", while including the delimiter (\, for
miter("file_path")
example) at the end of the string.
Pos(x,y)
X is the text that you are looking for. Y is the text that you are
searching in. Returns the position of x inside y. If x cannot be
found in y, the return value is 0.
PositionInText("text1" PositionInText returns the position of a string within another
,"text2",StartingPositi string.
on,N)
Text1 = the text for which you are searching
Text2 = the text in which you are searching
StartingPoint = the position at which to start searching
(1,2,3...etc.)
N = the Nth occurrence for the string for which you are searching
(1 for 1st occurrence, 2 for 2nd occurrence, etc.)
For example =PositionInText("d","abcdefgabcdefg",1,1) would
return 4 because the first occurrence (N=1) of "d" occurs at
position 4.
=PositionInText("d","abcdefgabcdefg",1,2) would
return 11 because the second occurrence (N=2) of "d" occurs at
position 11.
This function would return a "0" if no occurrence can be found.
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Function
RemoveSpaces(x)

Description
Removes the spaces from the text x, and returns the resulting
text.
RemoveText(x,y,Remo This function will remove the string x from y. RemoveAll will equal
veAll)
True or False depending on whether only the first occurrence is to
be removed.
For example, =RemoveText("def","abcdefg",True) will return
abcg.
ReplaceText(x,y,z,Re This function will replace the string x with the string y located
moveAll)
within the string z. RemoveAll will equal True or False depending
on whether only the first occurrence is to be removed.
For example, =ReplaceText("def","xyz","abcdefg",True) will
return abcxyzg.
x+y
If x and y are both text (i.e., strings), returns the concatenation of
x with y.
Trim
Removes spaces before and after a string of text.
For example, =Trim(" abcd efgh
") will return abcd efgh

Statistical Functions
Operator
ChiSquareTest([number1,...],
[number2,...])

FTest([number1,...],[number2,...])

GrubbsTest([number1,...])

KSTest([number1,...],[number2,...])

KSTest2([number1,...],[number1,...],
tails, significance)

LillieforsTest([number1,...])

Description
Performs the Chi-squared goodness of fit test to
test if data is coming from specific distribution.
The first parameter is an array of observed
frequencies, the second parameter is an array of
estimated (theoretical) frequencies.
Performs F-Test by comparing number1 and
number2 standard deviations. The parameters
are the first and the second dataset.
Performs the Grubbs test for outliers. Test is
used to detect outliers in a univariate data set.
It is based on the assumption of normality. That
is, you should first verify that your data can be
reasonably approximated by a normal distribution
before applying the Grubbs' test. The parameter
is the dataset.
Performs two-sample Kolmogorov-Smirnov
goodness of fit test of independent random
samples Data1 and Data2. Test determines if
Data1 and Data2 samples are drawn from the
same continuous population. The parameters are
the first and the second dataset.
Performs two-sample Kolmogorov-Smirnov
goodness of fit test of independent random
samples Data1 and Data2. Test determines if
Data1 and Data2 samples are drawn from the
same continuous population. The parameters are
the first and the second dataset, the hypothesis
type (TWO_TAILED, LEFT_TAILED or RIGHT_TAILED
(not case sensitive)) , and significant level for
which to test. For example, 0.05.
Performs the Lilliefors goodness of fit test to a
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MannWhitney([number1,...],
[number1,...],hypothesis type,alpha, use
normal approximation)
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Description
normal distribution with unknown parameters mu
and sigma. The parameter is the dataset.
The Mann Whitney test is is a nonparametric
test of the null hypothesis that two samples
come from populations of equal means, against
an alternative hypothesis, especially that a
particular population has a larger mean than the
other one. It operates under the assumption
that all the observations from both groups are
independent of each other. (Credit: Wikipedia)
The variables for the functions are as follows:
[Number1.....] - Comma separated values from
the 1st dataset.
[Number2.....] - comma separated values from
the 2nd dataset.
Hypothesis Type - TWO_TAILED, LEFT_TAILED or

RIGHT_TAILED (not case sensitive)
Alpha - the significance level for which to test. For
example, 0.05.
Use Normal Approximation - True/False
SSMD(mean max,mean min,n max,n
min,SDmax,SDmin)

Short for Strictly Standardized Mean Difference.
Has been used as a ranking metric for hit
selection in high throughput screening assays.
StainIndex(positive population mean/
Performs a stain index calculation using the
median, negative population mean/
means/medians of positive and negative
median, negative population standard
populations and the negative population standard
deviation).
deviation based on the Stain Index formula of
(Median of Positive - Median of Negative) / (SD
of Negative * 2).
TTest1S([number1,...],expected mean) Performs the one sample T-test. It compares
Data mean value with the expected mean. The
first parameter is the dataset.
TTest2S([number1,...],
It compares Number1 mean value with Number2
[number2,...],tails,paired)
mean value. The assumption is Number1 and
Number2 variances are equal, but unknown. The
first 2 parameters are the first and the second
datasets. Tails parameter can be 1 or 2. It is
used to define the type of null hypothesis, a
value of 1 means left tailed, a value of 2 means
two tailed. Paired can be True or False. If
True, it will perform Two-Sample Paired t-Test.
If False, it will perform Two-Sample Pooled
(unpaired) t-Test.
Wilcoxon([number1,...],
The Wilcoxon test is a nonparametric test that
[number1,...],hypothesis type,alpha)
compares two paired groups. The test calculates
the difference between each set of pairs and
analyzes these differences. The Wilcoxon Rank
Sum test can be used to test the null hypothesis
that two populations have the same continuous
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Operator

Description
distribution. (credit: Investopedia)
The variables for the functions are as follows:
[Number1.....] - Comma separated values from
the 1st dataset.
[Number2.....] - comma separated values from
the 2nd dataset.
Hypothesis Type - TWO_TAILED, LEFT_TAILED or

RIGHT_TAILED (not case sensitive)
Alpha - the significance level for which to test, for
example, 0.05.
ZPrime(mean negative,SD
negative,mean positive,SD positive)

ZTest([number1,...],expected
mean,expected SD)

The ZPrime function is used to calculate the Z
Factor. The Z-factor is an attempt to quantify
the suitability of a particular assay for use in a
full-scale, high-throughput screen by comparing
the Mean and Standard Deviation of a negative
control to the Mean and Standard Deviation of a
positive control within the experiment.
Compares the normally distributed Data elements
mean value with known standard deviation
expected SD, to a mean value expected
mean. ([Number1,...]) is the dataset.

Date and Time Manipulation Functions
Function
DateKWToDate($DATE
keyword,n)

Description
Takes the standardized format of the $DATE keyword, which
is in either dd-mmm-yy or dd-mmm-yyyy format, and returns
mm/dd/yyyy. If $DATE has the year listed as yy, n will be
placed in front of yy to produce yyyy. A keyword token will
be used to insert the value of $DATE.
For example if the $DATE keyword equals 03-Nov-05,
DateKWToDate($DATE,20) will return 11/03/2005.
If the year is already formatted as yyyy, the function will still
return mm/dd/yyyy. If the year is already formatted as
yyyy, n must still be accounted for in the function.

For example, if $DATE keyword equals 04-Jul-2008,
DateKWToDate($DATE,20) will return 07/04/2008. Also,
DateKWToDate($DATE,0) will return 07/04/2008.
DaysBetween(StartDate,En Returns the number of days between the values entered for
dDate)
the Start Date and End Date. Dates in anything other than a
mm/dd/yyyy format will need to be run through
DateKWToDate and/or FormatDateTime prior to being used
within this function.
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Function
Description
FormatDateTime("format","D FormatDateTime formats the Time or Date value given by
ate or Time")
using the format given.
Example: =FormatDateTime("yyyy-mm-dd",(<Current Date
token>)) will return the Current Date in a format showing
Year-Month-Day,
with 2 digits for the month
and day, and 4 digits for the year.
=FormatDateTime("hh:mm:ss",(<Current Time
token>)) will return the Current Time in a format showing
Hour:Minute:Second,
with 2 digits for Hour,
Minute and Second.
*Please note that if using the <Current Date> token, no
quotation marks are needed, as the Result Type for this
token is Text.
Formats can be as follows below:
Specifier Displays :
c
Displays the date using the format given by the
ShortDateFormat global variable, followed by the time using
the format given by the LongTimeFormat global variable. The
time is not displayed if the date-time value indicates midnight
precisely.
d
Displays the day as a number without a leading zero (1-31).
dd
Displays the day as a number with a leading zero (01-31).
ddd
Displays the day as an abbreviation (Sun-Sat) using the
strings given by the ShortDayNames global variable.
dddd
Displays the day as a full name (Sunday-Saturday) using the
strings given by the LongDayNames global variable.
ddddd
Displays the date using the format given by the
ShortDateFormat global variable.
dddddd
Displays the date using the format given by the
LongDateFormat global variable.
e
(Windows only) Displays the year in the current period/era as
a number without a leading zero (Japanese, Korean, and
Taiwanese locales only).
ee
(Windows only) Displays the year in the current period/era as
a number with a leading zero (Japanese, Korean, and
Taiwanese locales only).
g
(Windows only) Displays the period/era as an abbreviation
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Description
(Japanese and Taiwanese locales only).
gg
(Windows only) Displays the period/era as a full name
(Japanese and Taiwanese locales only).
m
Displays the month as a number without a leading zero (112). If the m specifier immediately follows an h or hh
specifier, the minute rather than the month is displayed.
mm
Displays the month as a number with a leading zero (01-12).
If the mm specifier immediately follows an h or hh specifier,
the minute rather than the month is displayed.
mmm
Displays the month as an abbreviation (Jan-Dec) using the
strings given by the ShortMonthNames global variable.
mmmm
Displays the month as a full name (January-December) using
the strings given by the LongMonthNames global variable.
yy
Displays the year as a two-digit number (00-99).
yyyy
Displays the year as a four-digit number (0000-9999).
h
Displays the hour without a leading zero (0-23).
hh
Displays the hour with a leading zero (00-23).
n
Displays the minute without a leading zero (0-59).
nn
Displays the minute with a leading zero (00-59).
s
Displays the second without a leading zero (0-59).
ss
Displays the second with a leading zero (00-59).
z
Displays the millisecond without a leading zero (0-999).
zzz
Displays the millisecond with a leading zero (000-999).
t
Displays the time using the format given by the
ShortTimeFormat global variable.
tt
Displays the time using the format given by the
LongTimeFormat global variable.
am/pm
Uses the 12-hour clock for the preceding h or hh specifier,
and displays 'am' for any hour before noon, and 'pm' for any
hour after noon. The am/pm specifier can use lower, upper,
or mixed case, and the result is displayed accordingly.
a/p
Uses the 12-hour clock for the preceding h or hh specifier,
and displays 'a' for any hour before noon, and 'p' for any hour
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HoursBetween(start
time,end time)

MillisecondsBetween(start
time,end time)

MinutesBetween(start
time,end time)

SecondsBetween(start
time,end time)

StrToDateFMT(text,
"format", "delimiter")

StrToTimeFMT(text, "time
delimiter", "millisecond
delimiter")
YearsBetween(Start
Date,End Date)

Description
after noon. The a/p specifier can use lower, upper, or mixed
case, and the result is displayed accordingly.
ampm
Uses the 12-hour clock for the preceding h or hh specifier,
and displays the contents of the TimeAMString global variable
for any hour before noon, and the contents of the
TimePMString global variable for any hour after noon.
/
Displays the date separator character given by the
DateSeparator global variable.
:
Displays the time separator character given by the
TimeSeparator global variable.
'xx'/"xx"
Characters enclosed in single or double quotation marks are
displayed as such, and do not affect formatting.
Counts the number of hours between the start time and the
end time. The keywords $BTIM or $ETIM can be used for the
start and end times. However, user-defined times would
need to be fed through the StrToTimeFMT function prior to
use in this function to establish the proper formatting.
Counts the number of milliseconds between the start time
and the end time. The keywords $BTIM or $ETIM can be
used for the start and end times. However, user-defined
times would need to be fed through the StrToTimeFMT
function prior to use in this function to establish the proper
formatting.
Counts the number of minutes between the start time and
the end time. The keywords $BTIM or $ETIM can be used for
the start and end times. However, user-defined times would
need to be fed through the StrToTimeFMT function prior to
use in this function to establish the proper formatting.
Counts the number of seconds between the start time and
the end time. The keywords $BTIM or $ETIM can be used for
the start and end times. However, user-defined times would
need to be fed through the StrToTimeFMT function prior to
use in this function to establish the proper formatting.
Returns a date string in the format as defined by the user,
using the specifier displays as seen in
FormatDateTime("format","Date or Time") of ddmmyyyy using
the delimiter designated, such as "/".
Returns a time string using a time delimiter and a millisecond
delimiter.
Returns the number of years between the values entered for
the Start Date and End Date. Dates in anything other than a
mm/dd/yyyy format will need to be run through
DateKWToDate and/or FormatDateTime prior to being used
within this function.

Regression. These function allow to fit several regression functions and to
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calculate the corresponding results. Two of those functions allow to retrieve the
X (or the Y) value for a given Y (or a given X) from a Scatter with Regression
plot 576 fit.
Function
Description
RegressionPlotXToY(Plot ID, The three mandatory parameters are the Plot number of a
Overlay Number, X Value) regression plot (numeric), the overlay number of a regression
fit (numeric) and the X known value (numeric). The function
returns the Y value of the regression function given the X
input value. Only a single input X value is allowed.
RegressionPlotYToX(Plot ID, The three mandatory parameters are the Plot number of a
Overlay Number, Y Value) regression plot (numeric), the overlay number of a regression
fit (numeric) and the Y known value (numeric). The function
returns the X value of the regression function given the Y
input value. Only a single input Y value is allowed.

SOP (Standard Operating Procedure) Functions. These functions can be
used to derive information from SOP's .
1102

Function
HasSOPBeenRun

Description
Returns true or false in the form of -1 (True) or 0 (False) to
determine if any SOP has been previously run in the layout.
IsSOPAfterStep(Ste Returns true or false in the form of -1 (True) or 0 (False) to
pID)
determine the the current SOP step is after a specific SOP Internal
Step ID.
IsSOPBeforeStep(St Returns true or false in the form of -1 (True) or 0 (False) to
epID)
determine the the current SOP step is before a specific SOP Internal
Step ID.
IsSOPFinished
Returns true or false in the form of -1 (True) or 0 (False) to
determine if the SOP has finished running in the layout.
IsSOPOnStep(StepI Returns true or false in the form of -1 (True) or 0 (False) to
D)
determine if the running SOP is currently on a specific SOP Internal
Step ID.
IsSOPRunning
Returns true or false in the form of -1 (True) or 0 (False) to
determine if an SOP is currently running.

Parameter Math Variables. These functions can be used to manipulate or get
information out of existing parameter values.
Function
Row

Description
The variable 'row' describes the current value in a particular row, or
cell number, of the data file. ‘Row’ may be used to perform sequential
calculations on a series of values in a file. For example, 'row' may be
used to create a time parameter. By using the 'row' variable, you use
the cell number as a parameter and can plot fluorescence against
cell number to check for uniform flow over time. Or, if the acquisition
took 5 minutes and you have 5000 cells you could use the following
formula to get the actual time (in minutes) where that cell was
acquired. Formula: =(row-1)*(5/5000)
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Function
Description
ConvertLinToLog(I,J, Same as above, except that variable I will
K,L)
that is being converted, for example P4 or
ConvertLogToLin(I,J, Same as above, except that variable I will
K,L)
that is being converted, for example P4 or
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use the Parameter number
P14.
use the Parameter number
P14.
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Batch Processing
Batch Processing allows you to analyze many data files consecutively in a
single layout without having to set up new plots for each file. Batch processing
also gives you the ability to print, save, or export your layout and statistics in
many different formats, including a PowerPoint presentation, a Word document,
an Excel spreadsheet, a PDF file, or a text file.
Batch processing applies the analysis on the layout to every item in the Data
List. During batch processing, FCS Express automatically performs a
791 to systematically
increment all the data files in your layout. The items will be incremented in their
order in the Data List by the increment value specified in the batch processing
options 841 , or the currently active panel 858 .
Changing the files during a batch process is called iteration. During iteration, the
FCS files on every plot will be incremented and tokens will be evaluated.
You can choose not to increment a particular overlay by disabling the Change
data file during Next/Prev/Batch option for histograms 267 , spectrum plots 277
, or 2D plots 283 . For example, you may choose not to increment a control file in
one overlay, while allowing iteration in the other overlays. In addition, you can
choose not to increment a particular token function by disabling the Change data
file during Next/Prev/Batch function for token Data Sources 695 .
FCS Express allows you to define batch processes that can be performed during
iteration. These processes are divided into Action or Report processes:
Action Processes

801

These processes allow you to print and/or save the layout in various
formats. The following lists all print/save processes:
o Print
o Save
o Save
o Save
o Save

Layout
to PowerPoint
as PDF
as Picture

Report Processes

820

These processes allow you to export information from your layout to:
o Microsoft Excel
o Microsoft Word
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o A PDF file
o A text file
o De Novo Software Data Services (DDS)
The information you can export includes plots (as pictures), statistics (as
columns, cells, or text), and tokens (i.e., the token information displayed in the
text box). Once you have chosen where to export the data by adding a Report,
you assign items to transfer to that Report.
There are four distinct steps to using Batch Processing properly after you have
set up your analysis layout:
1. Add the data sets you wish to analyze, in the correct order, to the Data
List 786 .
2. Add Batch Action and Report processes to the Batch Processing Action
Screen 798 .
3. Specify the Batch Processing Options 841 .
4. Run the Batch Process 844 .

20.1

Working with the Data List
Once you have created a layout to analyze your initial data, you can begin to
review data or build a Batch Process to sequentially analyze the remainder of
your items. The first step in setting up batch processing is to add items to the
Data List. The order in which items appear in the Data List is an important
consideration. Items are batch processed in the order that they appear in the list,
and the Next and Prev commands change items in the order that they appear in
the list, as well.
To access the Data List, use the Batch (or Data) Organize Data
Sets
List command to bring up the Data List window (Figure 20.1).
The Data List is a dockable window 113 .
The Data List window will show the File Name, the Tube number and the Iteration
number.
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Figure 20.1 Data List Window

The icon buttons in the Data List window are explained in the table below.
Icon Button Explanation
Add File. Brings up the Select a Data File Dialog 214 or Advanced Open Data
Dialog 215
Format. Brings up the Format Data List dialog where you can add keywords
to be used for sorting, show or hide file paths, or show the Iteration Column.
You can also hide file paths by default by adjusting your FCS Express User
Options 1931 .
Move selected file(s) up.
Move selected file(s) down.
Change file drop down list to access Change Data on Selected Plots
command or Change Data on All Plots command.
Search for files using Find Data Files 786 dialog.
Delete the selected file(s).
Sort on All Keywords. The sort is performed based on the priority order of
the keywords in the "Selected Keywords" dialog, or on the order of the extra
keywords columns (the default order of the columns is the same order as the
selected keywords). You can change the order by dragging the columns
around.
Note, if you drag the keyword columns around, or if you click on another
column header, it turns OFF the "sort by multiple keywords" option and you
have to click it again.
Defer layout changes 796 . When this button is selected and used in
conjunction with Panels 858 , FCS Express will not refresh the data within the
layout until all changes have been made and the button has been de© 2020 De Novo Software
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Icon Button Explanation
selected.

20.1.1

Data List Actions
In FCS Express, you can use the Data List to manipulate your data within the
layout.
For example, if you wanted to change the base overlay in all of the plots in your
layout, you can double-click on the data file within the Data List, and choose the
appropriate action.
By double-clicking on a data file in the Data List, you will be prompted with the
Select double click action window, as seen below (Figure 20.2).

Figure 20.2 Select double click action dialog window

Once a selection has been made, FCS Express can remember your selection and
not prompt you for an action.
As your data update, any tokens that are included in the layout will automatically
update to reflect the new data.
Also, the user can navigate to an iteration within the Data List by clicking on the
iteration number within the Iteration Column (Figure 20.3).
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Figure 20.3 Click on the Iteration
Number to view that Iteration

20.1.2

Adding Files to the Data List
Two methods can be used to add data sets to the Data List:
Add files directly without searching.
1.
783

.

2. Click on the
button to bring up the Select Data File 214 dialog if
Standard Open Data Dialog is chosen under user options or Open
Data File 215 dialog if Advanced Open Data Dialog is chosen under
user options.
3. Select the appropriate files and click on the Open button to add the files
to the Data List. This dialog allows you to add multiple files at once
using standard Windows techniques (e.g., Shift-Click or Ctrl-Click to
select multiple files at the same time).
Alternatively, you may drag and drop data files into the Data List from
any folder on your computer.
Note: If you have set an active Panel 858 , you can simply choose the first
file/tube in your Panel, and FCS Express will ask if you want to
automatically load the rest of the files/tubes in the Panel.
Search for files or conditionally select files.
If you do not know where your data files are located, or if you wish to
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select files based on one or more conditions, you can perform a search.
Note: Since FCS Express Version 4, FCS Express is no longer limited to
opening only FCS files. Therefore, to properly utilize functions which are
related to Keywords, you must highlight the appropriate data set/file (so
that FCS Express knows which type of Keywords to display) before doing a
keyword search.
1.
783

2. Click on the Search button
(Figure 20.4).

.

783

to bring up the Find Data Files dialog

Figure 20.4 Find Data Files Dialog

Select one or more of the three tabs at the top of the Find Data Files dialog
to set search criteria for finding the files you want to add to the Data List. All
the search criteria work together, so you can select any combination before
clicking the Find button.
On the Name & Location tab, click the Browse button, navigate to the
directory to search, then press the Find button. Note: Setting an
appropriate directory on the Name & Location tab first will make
searches faster even if you are using the date or keyword conditions
below.
To search for files based on their date, click on the Date tab and enter
the search criteria.
To search for files based on the value of a keyword, select the
Conditions tab. (Recall that you must highlight/select a data set/file in
the Data List for Keyword searches to work properly.) By default, there
are no conditions set, so click the Add Condition button. A new line
appears in the table, and the first column will be unavailable. Click on the
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button in the Keyword column and select a keyword (e.g., $TOT for
total number of events) from the Please select a keyword dialog. You
can also type in the keyword within the field. In the Relation and Value
columns, select the keyword range to search. For example, to search
for files with more than 20000 events, select > (for less than) in the
Relation column, then enter 20000 in the Value column.
To search for files based on more than one keyword, click on the Add
Condition button again. This time, select the Operator from the first
column. The Operator default is AND to specify both keyword conditions
must be met. Otherwise, select the operator OR to specify either
keyword condition may be met. After selecting the operator, enter the
Keyword, Relation and Value options as before.
When you are ready to run the search, click on the Find button. Remember
that all of the conditions work together, so you can select a starting folder,
date criteria, and keyword conditions before starting the search.
While FCS Express is finding the files that match your search requirements,
the window will expand to include the Search Results field. As files are found,
they will be added to that field. To halt the search before it is complete, click
on the Stop button. Figure 20.5 shows a search for all files within a specified
directory with greater than 20,000 cells acquired.
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Figure 20.5 Search Files by Keyword

Once all the files have been found, add the files you want to use in the Data
List. To add files individually, click on a file name to select it. To select more
files, press Ctrl (or Shift) while you click on a file name, then press OK. Once
the appropriate files have been highlighted, press the Down Arrow button. To
remove files from entry into the Data List, select the files to be removed and
click the Up Arrow button. When you have finished choosing files for the
Data List, press OK.
If you wish to perform a second search, first add the files from the current
search, then perform subsequent searches. When files are added to the Data
List and an active Panel 858 is set, each group of files (representing the tubes
of the Panel) will appear in alternating colors. This makes it easier to
distinguish between the different files of a Panel.

20.1.3

Sorting in the Data List
The Data List window allows you to look at the values of certain keywords, and
to sort the list based on these keywords.
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To select keywords to view:
1.
List command 783 .
2. Click on an appropriate entry in the Data List to let FCS Express know
which keywords to display.
3. Click on the
(Format) button to bring up the Format File List dialog.
4. Click on Add. The Please select one or more keywords dialog will
appear.
5. Click on a keyword to select it. To select more keywords, press Ctrl while
you are clicking the mouse button.
6. Once you have selected all the keywords you would like to view, press
OK.
The Data List will have a new column for each of the keywords that you
selected (Figure 20.6).

Figure 20.6 Data List with Keyword Columns

By default, the Data List is sorted in alphabetical order based on data set name.
To sort the data sets by other criteria, click on any column title. The list will be
sorted based on the values in that column. Clicking on the title once will sort in
ascending order; clicking on the title a second time will sort in descending order;
clicking on the title a third time will return the list to the previous sort criteria.
You can also sort individual files (or groups of files) without clicking on the
column titles. Click on a row in the list to select it, then press the

(Up) button

to move that file up in the list, or the
(Down) button to move it down in the
list. You can move several file rows at the same time by selecting them together
using standard Windows techniques for selecting multiple objects (Shift-Click,
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20.1.4

or
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buttons.

Using the Data List to Change the Data Set in a Plot or Token
Batch Processing is an effective tool to use for processing multiple sets of data
with a common layout and exporting your data into various formats.
Once a Data List has been created, you can also use the list to manipulate the
data set in plots 785 .
Also, when editing Tokens, you can edit the Data Source to include data files that
are included in the Data List by selecting the option for Data File From Disk, and
then choosing data from the Select Data File 214 or Open Data File 215 dialog
(Figure 20.7).

Figure 20.7 - Editing the Data Source of a Token through the Data List to Select
Data File (lower left) or Open Data File (lower right) dialog options.
20.1.4.1

Next/Previous

The Next and Previous functions will change the dataset on the following objects:
Plots
Data Windows
Tokens in Text Boxes
Custom Tokens
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Alerts
Batch Processing Actions
In order to use the Next/Previous functions to change datasets, each of the
following conditions must be met:
A Data List has been defined;
The object(s) to change (e.g., a plot) are selected or in edit mode, if
datasets are to be changed on only certain objects;
The selected object(s) display or are linked to a dataset in the list, and
finally;
The selected object(s), e.g., a histogram 267 , 2D plot 283 , and/or Token 695 ,
must have the Change data file during Next/Prev/Batch option enabled
(Figure 20.8).
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Figure 20.8 - Example of Formatting dialog for 2D plots in which the Change
data file during Next/Prev/Batch option is selected. The same option is
available for histograms and Tokens.

To change the dataset on one or more selected objects to the next or previous
dataset:
1. Select the plots you wish to change. If you wish to change all plots, you
need not select them and the current selection is irrelevant.
2. Use one of the three following methods:
Use the Data Change Data on Selection/Change Data on All
Objects Next (or Previous) command.
Use the keyboard shortcuts Alt+Right arrow for Next or Alt+Left
arrow for Previous.
Right-click on the selected object and choose Next or Prev from the pop© 2020 De Novo Software
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up menu.
In the Data List, click on the file to which you would like to change and
select the appropriate choice from the Data List Actions 785 window.
Use the Data Change Data on Selection/Change Data on All
Objects
This command will open the Select a Data File window,
which will allow you to select another data file, either in the Data List or
from another location.
3. Please note that new Snapshots will not be recorded while changing the
data on Selected object(s), and previous Iteration (automatic) Snapshots
will be discarded.
4. The user can also change the data within all objects by selecting an
iteration number from the Iteration drop down menu.
20.1.4.2

Dragging and Dropping

Like other dockable windows 113 in FCS Express 6, the Data List has drag and
drop functionality. You can drag a data set directly from the Data List to your
layout to either change the data in an existing plot, to add the data as an overlay
in an existing plot, or to create a new plot.
The When dragging a data set onto a plot drop-down list in the General
category of the FCS Express User Options dialog 180 controls the functionality
when you drag a data set onto an existing plot. The drag and drop operation will
either:
Replace the current FCS file on the plot;
Create a new overlay with the dragged file, or;
Open a dialog to select one of the first two options.
If you drag a file from the Data List directly onto a blank area of the layout, a
Select Plot Types... dialog will appear asking which object(s) you wish to open
(Figure 20.9).
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Figure 20.9 Select Plot Types... Dialog

One or more objects can be chosen by checking the appropriate box(es). Once
you have chosen the object type(s), the new object(s) will open showing the
data from the data set that you dragged from the Data List.
20.1.4.3

The Change File Button

To use the Data List to change the files/data sets on your plots (Figure 20.10):
1. Click on a dataset in the Data List to highlight it.
2. Click on the
icon to Change Data On Selected Plots or Change
Data on All Plots from the drop down list.
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Figure 20. 10 - Available commands from Change File drop down list
20.1.4.4

Defer Layout Changes

When using the Panels feature in FCS Express, a user needs to load data into the
Data List as it pertains to the panel.
FCS Express will automatically load the data into the plots to which the files were
assigned. If a panel set of data files were placed in the wrong order, you can
easily re-arrange the order of the tubes by selecting the file, then, clicking the
button or the

button to place the files in the correct sequence.

However, if the data files are large in size and they needed to be moved Up or
Down in sequence, the amount of time needed for FCS Express to correctly
display the data in their proper plots and to recalculate statistics and tokens can
be significant.
Users can make changes to the sequence of tubes within their panel and have
FCS Express defer those changes until all the changes have been made rather
than recalculate each time a file is moved in the Data List.
In the example illustrated below, we can see how this tool is utilized by using a
3-tube panel dataset.
1. Open the Data List.
2. Load the data specific for the panel.
3. Select the Defer Layout Changes
icon.
4. Once the icon is selected, a grey play button icon and a red "X" will appear
next to the Defer Layout Changes icon

.
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5. Move a tube within the sequence Up or Down using the arrows within the
Data List toolbar (Figure 20.11).

Figure 20.11 - Panel Data Before Deferring Layout Changes

6. Once the tube is moved to the correct sequence, click the blue play button
icon to accept the changes
.
7. FCS Express will now display the data in the appropriate plots (Figure 20.12).
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Figure 20.12 - Panel Data After Deferring Layout Changes

20.2

Adding Batch Processes
After creating the Data List, the second step in Batch Processing is to define
which processes to perform. FCS Express allows you to perform actions and
reports during the batch process 782 .
To add actions to the batch process, use the Batch Batch Processing Batch
Actions command to bring up the dockable Batch Actions window (Figure
20.13).
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Figure 20.13 Batch Actions Window

To add a new process to the Batch Process Actions list, click on the process
from the list of available items on the left of the Batch Actions window. An
appropriate dialog box will appear to further specify the action for each process.
For example, to add a Print 801 action, you must specify the printer, the number
of pages, and the number of copies to print.
Once a process has been added to the Batch Process Actions list, it is
automatically set as active and will execute when running the Batch (the box to
the left of the process in the Batch Process Actions list will be checked). To
deactivate a process so that it will not execute in the Batch, uncheck the
checkbox to the left of the process name.
Multiple actions of the same type can be added to the Batch Process Actions
list. For example, two print processes can be active at once. The first print
process could print pages 1-5 on printer #1 and the second print process could
print pages 6-10 on printer #2.
Because both of the actions in the previous example will be listed as "Print" in the
list, it could be helpful to change the process names in a complex batch list. To
rename an action in the list:
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1. Select the process name and press F2 (or right-click on the action and
choose Rename from the pop-up menu).
2. Type in the new process name.
3. Press Enter.
Figure 20.14 shows an example of a Batch Process with several actions defined.
The two active print actions have been renamed with descriptive text. The Save
Picture of Plot action has been deactivated, indicating that it will not be used the
next time the Batch Process is run.

Figure 20.14 Batch Process Actions List with Actions
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Right-clicking on a process in the Batch Process Actions list brings up a pop-up
menu with the following options:
Cut/Copy/Paste: Allows copying and pasting processes. This facilitates
moving tokens from one report to another.
Delete: Delete the selected action.
Rename: Enter a meaningful name for the selected action.
Add Items: For Reports, you can add Items that can be found in the Add
Item To Report section.
Properties: Display the dialog box for the selected action to allow changes
to the action properties.

20.2.1

Batch Processing Actions
The Batch Processing Actions include printing a layout 801 , saving a layout 804 ,
saving to PowerPoint 808 , saving to PDF 813 , and saving as a picture 818 . You can
also group your actions using a folder (action container) 819 .

20.2.1.1

Print

A Print action will allow you to automatically print a range of pages during a batch
process.
To create a Print Action, click on Print (in the Add Action section of the Batch
Actions window). The Create Print Action dialog (Figure 20.15) is used to set
up how the layout will be printed with each iteration of the batch process.
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Figure 20.15 Create Print Action Dialog

The properties in the Create Print Action dialog are divided into five sections:

Printer
Select which printer to use to print the layout.
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Print Options
o Quality. Will be set to On-screen.
o Mode. Choose to print layout pages as single or multiples per printed
page(s). With Full Page selected, the layout page(s) for each iteration
783 will be printed as individual page(s). Multiple layout pages may be
printed per page using a preset multiple page option (i.e. 3 Pages with
Notes or 9 Pages Vertical) or Custom Grid Options 39 . To print the
layout pages on fewer pages, please select a preset multiple page option
or Custom Grid. To select a preset multiple page option or customize
the tiling, click the down arrow to the right to expand the dropdown list
and select a multiple page option or Custom Grid Options...,
respectively. When selecting Custom Grid Options, the Custom Grid
popup window will appear.
o Frame Page. Flag this option to draw a frame around layout page(s).
o Crop To Content. Available for selection when Mode is not set to Full
Page. When selected, empty space of the layout page(s) is cropped
during the export.

Extra Print Options
o Print Side. Choose to print One Sided, Two Sided Horizontal, or Two
Sided Vertical.
Select One Sided for single-sided printing.
Select Two Sided Horizontal for long-edge page turning.
Select Two Sided Vertical for short-edge page turning.
o Collate. May be set to Collated for which all pages are printed in
ordered sets or Uncollated for which all copies of the first page followed
by copies of subsequent page(s).
o Color Mode. May be set to Color or Grey Scale.

Page Range
Choose which page(s) of the layout to print.

Iteration options
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Choose whether to save the output of each iteration to a separate
document or combine all the iterations into a single document. Combine
the output of all iterations into a single print task, without page
break must be selected when Mode is not set to Full Page.
o Print the output of each iteration separately.
Each iteration will be printed separately.
o Combine all the output from all iterations into a single print task.
All iterations will be combined into one print task for printing.
o Combine the output of all iterations into a single print task,
without page break
All iterations will be combined into one print task. Depending on your
Export Options Mode settings many iterations may be combined
into one page for printing.

Copies
Designate how many copies of the layout to print.

Click OK when you have finished. At this point, the Printer action will be added to
the list of batch actions.
20.2.1.2

Save Layout

To create a Save action, click on Save Layout (in the Add Action section of
the Batch Actions window).
The Create Save Layout Action dialog (Figure 20.16) is used to set up how
the layout will be saved after each iteration.
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Figure 20.16 Create Save Layout Action Dialog

The properties are divided into three sections:
Output File
The Output file field determines the name and location of each saved
layout. Since you will need different names for each file that is saved in
each iteration, the filename you enter must contain dynamic information
that changes for every iteration. In order to create a dynamic filename,
you have to insert a token 688 as part of the name. The most common
token used in conjunction with a dynamic filename in Batch Processing is
the Current iteration token.
Before you insert the token into the Output file field, make sure you have
entered a filename in the field, and then position the cursor where you
want the token text to appear. To insert a Current Iteration token:
1.
2.
3.
4.
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Click on the
button to bring up the Insert a Token dialog.
Click on the triangle next to Batch Processing.
Select Current iteration (Figure 20.17).
Click Insert.
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Figure 20.17 Insert a Current Iteration Token

Figure 20.18 shows an example of Output file, which will create a dynamic
filename using the Current iteration token.
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Figure 20.18 Example Output File with Current Iteration Token

Running the Batch with this output file would generate files such as C:
\Temp\Layout-1.fey, C:\Temp\Layout-2.fey, etc. If Ask for confirmation
before overwriting an existing file is checked, you will be prompted to
approve overwriting already existing filenames when the batch process is
run.
You do not have to use the Current iteration token. You can use any
token whose information changes with every increment. For example,
Patient ID, Sample ID, or some calculated value could all be used to
generate unique dynamic file names.
Data Link
The options are the same as in the Save Layout dialog

93

.

Save Options
By checking this box, you can tell FCS Express to hold the process of
saving the layouts until the end of the batch process.

Click OK to finish editing the Save Layout properties. At this point, FCS Express
verifies that the Output file has been filled in properly. If you have left the Output
file field empty, or if the path name contains characters that are not allowed in a
filename, then a Messages with descriptions of the errors will appear (Figure
20.19).

© 2020 De Novo Software

FCS Express 6 Manual

808

Figure 20.19 Batch Processing Error Messages

This dialog allows you to Save the action with the error, or to Correct it. If you
choose to save the action without correcting the error, this action will not be
executed in the Batch.
20.2.1.3

Save To PowerPoint

To create a Save To PowerPoint action, click on Save To PowerPoint (in the
Add Action section of the Batch Actions window).
The Create Export to Powerpoint Action dialog (Figure 20.20) is used to set
up how each iteration of the layout will be saved as a PowerPoint presentation
file.
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The properties are divided into six sections:
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Powerpoint Options
o Include background (from Master Slide). Flag this option to to
include the background from Master Slide. If you choose to export the
background, the objects on the FCS Express Master Page will be placed
on the PowerPoint master slide. These background objects will then
appear on all of the PowerPoint slides.
o Open presentation after saving. When checked, the PowerPoint
presentation will be opened after the batch process has ended.
o Hide Objects that are off the page. When checked, objects that are
not located on the white page in the layout will not be exported to
PowerPoint.

Page Range
Choose which layout pages to export.

Export Options
o Quality. Set the PowerPoint quality (High, Medium, Low, On-Screen)
from the dropdown list.
o Mode. This option enables single or multiple layout pages per slide based
on selection. With Full Page selected, the layout page(s) for each
iteration 783 will be exported as individual slide(s). Multiple layout pages
may be printed per slide using a preset multiple page option (i.e. 3
Pages with Notes or 9 Pages Vertical) or Custom Grid Options 39 .
To export the layout pages on fewer slides, please select a preset
multiple page option or Custom Grid by clicking the down arrow to the
right to expand the dropdown list and selecting a multiple page option or
Custom Grid Options..., respectively. When selecting Custom Grid
Options, the Custom Grid popup window will appear. See an example
of the output below in (Figure 20.21).
o Frame Page. Flag this option to draw a frame around layout page(s).
o Crop To Content. Available for selection when Mode is not set to Full
Page. When selected, empty space of the layout page(s) is cropped
during the export.
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Iteration options
o Save the output of each iteration to a separate presentation.
Each iteration will be saved as a new PowerPoint presentation.
o Combine all the output from all iterations into the same
presentation.
All iterations will be combined into one new PowerPoint presentation.
o Combine the output of all iterations into a single file, without page
break.
All iterations will be combined into one new PowerPoint presentation.
Depending on your Export Options Mode settings many iterations
may be combined into one PowerPoint slide as seen in the figure
below.

Append Options
Choose whether to export to a new file or append the output to an
existing PowerPoint presentation.

Output file options
Click on the folder icon to choose a location on the computer or server
and create the filename for the exported PowerPoint file(s). See Save
Layout - File Options for a description of batch generated filenames 804 .

Click OK when you are finished editing the properties.
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Figure 20.21 Custom Grid Options enabled for batch processing 9 data files for two
layout pages exported to a single PowerPoint slide.

Note about ungrouping objects in PowerPoint for PC versus PowerPoint
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for Mac
Once exported to PowerPoint, layout objects can be further ungrouped into
single components in the PC version of Microsoft PowerPoint. Ungrouping
objects saved by FCS Express in PowerPoint for Mac is not supported. However,
presentations saved on a Mac may be opened on a PC and ungrouped.
20.2.1.4

Save To PDF

To create a Save To PDF action, click on Save To PDF (in the Add Action
section of the Batch Actions window).
The Create Export to PDF Action dialog (Figure 20.22) is used to set up how
each iteration of the layout will be saved as a PDF file.
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Figure 20.22 Create Export to PDF Action Dialog

You can choose to Open the PDF file after saving. The properties are divided into
the sections below:
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PDF Options
Embed fonts (will increase file size). This option ensures that all of the
font information used to make your document look the way it does is
stored in the PDF file.
Export options
o Quality. Set the PDF quality (High, Medium, Low, On-Screen) from
the dropdown list.
o Mode. This option enables single or multiple layout pages per page based
on selection. With Full Page selected, the layout page(s) for each
iteration 783 will be exported as individual slide(s). Multiple layout pages
may be printed per slide using a preset multiple page option (i.e. 3
Pages with Notes or 9 Pages Vertical) or Custom Grid Options 39 .
To export the layout pages on fewer pages, please select a preset
multiple page option or Custom Grid by clicking the down arrow to the
right to expand the dropdown list and selecting a multiple page option or
Custom Grid Options..., respectively. When selecting Custom Grid
Options, the Custom Grid popup window will appear, which will contain
following five settings:
o Frame Page. Check this option to draw a frame around layout page(s).
o Crop To Content. Available for selection when Mode is not set to Full
Page. When selected, empty space of the layout page(s) is cropped
during the export.
See an example of the output in Figure 20.23 below.
Page Range
Choose which layout pages to export.

Iteration options
o Save the output of each iteration separately.
Each iteration will be saved as a new file.
o Combine all the output from all iterations into a single file.
All iterations will be combined into one new file.
o Combine the output of all iterations into a single file, without page
break.
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All iterations will be combined into one new file. Depending on your
Export Options Mode settings many iterations may be combined
into one page in the file as seen in the figure below.
Append Options
Choose whether to start with a new file or append the output to an
existing PDF file.

Output file options
o Append to the file being combined with (specified above). This
option is only available when both the Combine the output from all
iterations into a single file and the Append to an existing PDF file
are selected.
o Save to a new file. Use this option to generate a new PDF file and enter
the filename for the generated PDF file. See Save Layout - File Options
for a description of batch generated filenames 804 .
o Ask for confirmation before overwriting an existing file. Chose this
option to be prompted about the existence of a file with the same name
before overwriting it.
o Create output folder if it does not exist. Chose this option to
automatically create the output folder if it does not exist.
o Open the PDF file after saving. When checked, the PDF file will open at
the end of each iteration.

Click OK when you are finished editing the properties.
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Figure 20.23 Custom Grid Options enabled for batch processing 9 data files fortwo
layout pages exported to a single PDF page.
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20.2.1.5

Save As Picture

To create a Save As Picture action, click on Save As Picture (in the Add Action
section of the Batch Actions window).
The Create Save Picture of Plot Action dialog (Figure 20.24) is used to set up
how, in each iteration, plots or layout pages will be saved as picture files.

Figure 20.24 Create Save Picture of Plot Action Dialog

The properties are divided into three sections:
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File Options
Enter the filename for the exported file. See Save Layout - File Options for
a description of batch generated filenames 804 .
Picture output options
Choose the file type (JPEG, Bitmap, Metafile, GIF, PNG, TIF) from the
drop-down list. For JPEG files, choose a picture quality using the spin
control. Set the resolution using the radio buttons. For Metafiles, choose
whether or not to embed the plot data as a bitmap.
Get a picture from
Choose to save a particular plot/text box or a full page in the layout using
the radio buttons. Select the plot or layout page from the list box.

Click OK when you are finished editing the properties.
20.2.1.6

Folders (Action Containers)

Folders (Action Containers) are used for organizational purposes. They do not
generate output by themselves. Think of them simply as a container for a group
of related actions.
The advantage of folders is that by unselecting the folder, the actions within the
folder will not be executed during the batch.
In Figure 20.25, two folders are defined. The actions in the Main Actions folder
will all be run, since the Main Actions folder is checked. However, the actions in
the Supplemental Actions folder will not be executed (even though the individual
actions are checked), because the Supplemental Actions folder is not checked.
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Figure 20.25 Folders (Action Containers)

If a folder is deleted, all its contained actions will be deleted. You can drag and
drop a folder like any other action, and all the contained actions will move with it.
If you copy a folder to the clipboard, all the contained actions will be copied.

20.2.2

Batch Processing Reports
Reports are used to export items (e.g., tokens, pictures) into Excel, Word, as
Text/PDF files, or to LabKey Server . All reports can contain tokens, and Word/
Excel reports can also contain images. Exporting items using Reports is a twostep process:
1498

1. Add the Report type to the Batch Actions list by selecting it from the Add
Report section of the Batch Actions window.
2. Add the item(s) to be exported to the appropriate Report process.
There are seven types of reports:
Excel - Column Mode

823

(text)
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Excel - Cell Mode 826 (text and images)
Word Report 828 (text and images)
PDF Form 830 (text)
Text Report 831 (text)
LabKey Server 831 (tokens, images, PDF files, FCS files, FCS Express
Layouts)
The items which can be exported to a report are determined by the report type.
Depending on the report type, the following items may be available:
Regular Token 688 (all available tokens, including Custom tokens 725 )
Statistic Token 699
Keyword Token 704
Picture 837 (a plot in the layout, or an entire page of the layout, only used in
Word, Excel-Cell Mode, and DDS reports)
Text Box 152 (text in a text box (e.g., canned comments) can be exported
to a column in an Excel worksheet or other location)
PDF 107
Layout 92
PowerPoint
FCS File
1460

An example of the Batch Process Actions for an Excel (Cell Mode) report is
shown in Figure 20.26.
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Figure 20.26 Batch Process Actions for Excel Report

This report will export two statistics and a picture of a specified plot for each
iteration of the batch process. Only items that are checked will be exported.
Using the check boxes for each of the Batch Process Actions, an item can be
enabled or disabled to run with the Batch Process. If you double click on the
Batch Process Action (or right-click and choose Properties from the pop-up
menu), you can navigate to the Running Options page of the Options dialog to
control the activation state of an action (Figure 20.27). If you choose the Set
the checkbox from the value of the expression below radio button, you can
input a formula (using standard or custom tokens) to control the action.
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Figure 20.27 Running Options

20.2.2.1

Working with Reports

To create a new report:
1. Use the Batch Batch Processing Batch Actions command.
2. Select the report type from the Add Report section of the Batch Actions
window. A properties dialog for that report type will appear. Once the
properties are set, the report will be added to the list of Batch Process
Actions.

There are seven different types of reports:
Excel (Column Mode)
Excel (Cell Mode) 826
Word 828
PDF form 830
Text 831
LabKey Server 831

823

Excel (Column Mode)
All tokens contained in this report will be written to a Microsoft Excel file.
Pictures cannot be added to this report. Each token will be reported in its
own column. The values for each iteration are written in the same column,
but in new rows. An example of the output of an Excel (Column Mode)
report is shown in Figure 20.28.
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Figure 20.28 Excel (Column Mode) Sample Report

The File Options page of the Excel (Column Mode) Options dialog
(Figure 20.29) has two sections:
o Append Options
With the radio buttons, you can choose to Start with an empty
file or Combine the output with the data in an existing file. If
you combine data from an existing file, FCS Express will join the
Batch Processing output with the data that exists in the Excel file
(.xls) entered in the text box. The final output (new iterations plus
existing data) will be written to another worksheet.
o Output file options
When combining data with an existing file, the destination file can be
a new file (.xls) or the existing Excel worksheet.
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Figure 20.29 Excel (Column Mode) File Options

The Worksheet Options (Figure 20.30) page of the Excel (Column Mode)
Options dialog allows you to assign the name of the worksheet (optionally
using a token). You can use either a new worksheet or an existing
worksheet. If you use an existing worksheet, you can designate Row
Options and Column Options (e.g., start at the first available row or column
or start at a particular row or column).
The Row/Column Arrangement radio button controls whether iterations
are exported as new columns or new rows within a document.
The Header Options allow FCS Express to automatically write the Field Label
835 to the result Excel document. By default, this option is enabled.
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Figure 20.30 Worksheet Options

Excel (Cell Mode)
The Excel (Cell Mode) report allows you to merge you data with a
preexisting spreadsheet. You select a Template Document (spreadsheet)
containing headings, fonts, and colors, and then specify the exact cell
destination for each output item, including pictures. An example is shown
in Figure 20.31.
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Figure 20.31 An Example Excel (Cell Mode) Report

The File Options page of the Excel (Cell Mode) Options dialog (Figure
20.32) has four sections:
o Template Document
Enter the filename (and path) to your preformatted Excel
workbook. The first worksheet in the workbook will be used as the
template.
o Iteration options
Output each Batch iteration to a separate file (the default), or
combine the output from all Batch iterations to a single file. In the
latter case, each iteration is written to a separate worksheet within
a single Excel workbook.
o The Append Options and Output file options are identical to those
for the Column Mode described above.
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Figure 20.32 Excel (Cell Mode) File Options

Word Report
With this report type you can create Word files resembling Figure 20.33. A
Word Template Document contains all the headings and text formatting.
When combined with the output of the values from Batch Processing, you
can create professional quality reports. All tokens contained in a Word
Report, including pictures, will be written to a Microsoft Word file during
each iteration using the mail merge features of Word. Once each token
has been configured with a Field Name 835 , the token value will be merged
with the Word Merge Field. Details on setting up the Word report with mail
merge fields are described under Creating Templates for Reports 832 .
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The File Options page of the Word Report Options dialog has four
sections similar to those described for Excel (Cell Mode) reports:
o Template Document
Enter the filename (and path) to your preformatted Word
document.
o Iteration options
Output each Batch iteration to a separate file (the default), or
combine the output from all Batch iterations to a single file.
o The Append Options and Output file options are identical to those
for the Column Mode described above.

PDF Form Report
In addition to exporting your layout directly as a standard PDF file 107 , FCS
Express can merge your statistics with PDF Form files. PDF forms are
special PDF files that allow you to enter information in specific fields. FCS
Express will export all tokens contained in the report to the specific fields in
the PDF file. Once each token has been configured with a Field Name 835 ,
the token values will be placed into the report fields designated in a
preformatted PDF file.
The File Options page of the Export to PDF Options dialog has four
sections similar to those described for Excel (Cell Mode) reports:
o Template Document
Enter the filename (and path) of the preformatted PDF template
document.
o Iteration options
Output each Batch iteration to a separate file (the default), or
combine the output from all Batch iterations to a single file. In the
latter case, each iteration is written to a new page in the PDF
document.
o The Append Options and Output file options are identical to those
for the Column Mode described above.
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Text Report
All tokens in a Text Report will be written to a text file, with custom
separator (see below the Encoding Options). The first row of the text file
will contain the column header of each exported item (see below the
Header Options). A new row of outputted values will be created for each
iteration. Note: Pictures cannot be exported to this type of report.
The File Options page of the Text File Report Options dialog is similar
to the Excel (Column Mode) format (described above) with two sections:
o Append Options
With the radio buttons, you can choose to Start with an empty
file or Combine the output with the data in an existing file. If
you combine data from an existing file, FCS Express will join the
Batch Processing output with the data that exists in the text file
entered in the text box. The final output (new iterations plus existing
data) will be written to another text file.
o Output file options
This option goes along with the previous one.
When Start with an empty file is selected in the Append Options,
a file name must be specified. Available file extensions are .tab, .prn
and .csv. To generate a Txt file, the .txt extension needs to be
manually specified in the file name. When combining data with an
existing file, the destination file can be a new file or the existing text
file.
Two additional sections are also present:
o Encoding Options
Two drop-down menus allow to select the desired Separator (Tab,
Space or Comma) and the Encoding (ANSI or Unicode (UTF8)).
o Header Options
This check box defines whether the first exported raw will contain
the column header of each exported item.

LabKey Server Report
LabKey Server is free, open source software that supports automated
quality control, centralized data management, and web-based data
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sharing. You may use the batch processing function of FCS Express to
export your data to LabKey Server.
After registering with LabKey Server, downloading their free server, and
preparing LabKey Server to receive your exported data, simply click on
the Export to LabKey icon under "Add Report" from the Batch Actions
window. The Export to LabKey Options dialog window appears (Figure
20.34). Select Web Service in the left pane of the window, and enter in
your LabKey Server URL, Protocol ID (must be an integer), Name of
the report, and, if desired, a Comment, into the fillable fields. Note that
tokens may be entered into the Name and Comments fields. Enter in
the Username and Password you used to register with LabKey Server, and
click OK.

Figure 20.34 Export to LabKey Options

20.2.2.2

Creating Templates for Reports

You can create templates for Excel (Cell Mode) reports, as well as PDF and Word
reports.
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Creating Excel Templates
Excel templates are simply Excel spreadsheets. You can use any Excel
functionality in the spreadsheets that are used as templates. Simply leave
blank cells where you want FCS Express to put the data or pictures. Enter
those cells as the Cell Address on the Field page of the options dialog
corresponding to the exported item.
Creating PDF Form Templates
When creating a PDF template, the PDF file must contain text fields (which
must be uniquely named) where FCS Express will place the data from your
layouts. PDF files containing text fields can be created with numerous PDF
creation programs, such as Adobe Acrobat®. Please refer to your PDF
creation program for instructions on how to create PDF files with text fields.
Creating Word Templates
In order to create a report using Word, you must use the Word mail merge
functions. A brief overview of how to create mail merge templates is given
below. For more details, please consult the documentation for your version of
Microsoft Word®.
When creating a Word report template, you must enter fields into your Word
document where FCS Express will place the exported data from the layout
during batch processing. Enter those fields as the Mail Merge field name on
the Field page of the options dialog corresponding to the exported item.
Please refer to the help files in your version of Word for detailed instructions
on how to create Word documents with mail merge fields.
20.2.2.3

Adding Items to Reports

An item is something that is exported from FCS Express to a particular report.
Reports usually contain multiple items. Whenever you add an item to a report, it
is added to the bottom of the list of existing items in the report. To see all the
items contained in a report, expand the report by clicking on the + to the left of
the report name. You can reorder the items in the report 839 by selecting item(s)
and dragging them to a new order position. You can also drag item(s) from one
report to another.
Items can only be added to the Batch Process Actions list after a Report has
been added because the item must be added directly to a report. There are four
methods to add items to reports:
Adding items from a Text Box or a Statistics window.
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If you have a layout with an open statistics window or with tokens in a
text box, you can add some or all of these items to an existing report.
Perform the steps as follows:
1. Open the Batch Actions window by using the Batch Batch
Processing Batch Actions command.
2. Make sure you have a report in the Batch Process Actions list.
3. Dock the Batch Actions window (or position it such that you can
view the statistics window or Text Box in the layout).
4. To add statistics, highlight the cell(s) in the statistics grid and drag
them onto the report in the Batch Process Actions area. When the
report is highlighted, release the mouse button.
5. To add token(s) from a Text Box, highlight one or more tokens and
drag them onto the report in the Batch Process Actions area. Once
the report is highlighted, release the mouse button.
Adding items from a plot or gate.
Perform the steps as follows:
1. Open the Batch Actions window by using the Batch Batch
Processing Batch Actions command.
2. Make sure you have a report in the Batch Process Actions list.
3. Click on the page of the layout containing the plot(s) from which the
items will be added.
4. Drag and drop the plot or gate onto the report in the Batch
Process Actions area. When the report is highlighted, release the
mouse button.
5. Double-click Statistic token or Keyword token from the Paste
Special dialog.
6. Select the item(s) from the Statistic list box or the Please select
one or more keywords dialog.
Note: Multiple items may be selected and added while holding
down Ctrl on the keyboard.

Adding items from the Add Item to Report list.
When you first open the Batch Actions window, the items in the Add
Item to Report section will be disabled. After adding a report to the Batch
Process Actions list, items appropriate to that report type will be enabled.
To add an item to a report:
1. Open the Batch Actions window by using the Batch Batch
Processing Batch Actions command.
2. Click on the report that will contain the item.
3. Click on an enabled item in the Add Item to Report section.
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4. Once an item has been added to a report, you will need to configure
the item’s "report-specific" property 835 . This property tells FCS
Express where to insert the item in the final report.

Adding items by right clicking on the Action (Figure 20.35).
1. Open the Batch Actions window by using the Batch Batch
Processing Batch Actions command.
2. Right click on the report that will contain the item.
3. Mouse over Add Item.
4. Choose an item from the list of available items in the dropdown.

Figure 20.35) A dding items to a batch action by right clicking on the action.

20.2.2.3.1 Configuring a Report Item's Report Specific Property

When adding items to reports, there is a report-specific property that needs to
be set to tell FCS Express where to insert the item in the final report. This
property differs depending on report type. It is usually found on the Field page of
the report item options dialog. For example, when you add a Regular Token
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from the Add Item to Report section of the Batch Actions window for either
of these two report types, after the specific token has been chosen a dialog box
will open to the Field page and the appropriate property can be entered in the
corresponding edit field. You can also reach the Field page by right-clicking on
the item in the Batch Process Actions list and selecting Properties from the
pop-up menu.
Excel (Column Mode) and Text Reports
The Column Name specifies the text that will appear in the report at the top
of each column of data. For example, if the token you are exporting displays
the number of events for a plot, a useful Column Name could be Number of
Events. In FCS Express V5 and later versions, the report-specific property of
Excel (Column Mode) and Text Reports defaults to the name of the item in
your layout (e.g., the token description in Fig. 20.36). To change this default
behavior so that the field is left blank, see the Header Options 825 .

Figure 20.36 Token description automatically exported to Excel as Column
Name in FCS Express V5

If you wish to manually define the report-specific property in lieu of the
default, enter it in Column Name field of the Field category (Figure 20.37).
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Figure 20.37 Manually entering the Column Name property

Excel (Cell Mode)
The report-specific property for Excel (Cell Mode) reports is set in the Cell
Address field. The Cell Address specifies the Excel cell to write the data.
Word
The specific property for Word reports is set in the Mail Merge field name
which specifies the mail merge field in your Word template 832 where the
layout item will be placed. The field name must exactly match the name in the
Word document.
PDF Form
For PDF reports, the specific property is set by editing the Field Name. This
specifies the text field in your PDF template 832 where the layout item will be
placed. The field name must match the corresponding field in the PDF.
LabKey Server
For LabKey Server reports, the specific property is set by editing the XML
Node. This specifies the Data Field in LabKey Server to which the layout item
will be sent. The XML Node must match the corresponding Data Field name
in LabKey Server.
20.2.2.4

Adding Pictures to a Report

A picture of a Text Box, plot, or an entire page of the Layout can be exported to
Excel (Cell Mode), Word, and LabKey Server reports. To add a picture to a
report:
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1. Click on the appropriate report type in the Add Report section of the Batch
Actions window 820 .
2. Highlight the appropriate report type and click on Picture in the Add Item
to Report section of the Batch Actions window.
Excel (Cell Mode)
The Picture page of the Excel (Cell Mode) field "Picture" options dialog
will appear (Figure 20.38). This page has two sections:
o Picture output options
Choose the file format and resolution 818 . Note: JPEG picture quality
is directly related to the size of the image; a higher quality image will
be less compressed and larger in size.
o Get the picture from
Choose whether to export an object from the layout (a plot or text
box) or to export an entire page from the layout.

Figure 20.38 Excell (Cell Mode) Picture Options
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Word
The Picture page of the Word Report field "Picture" options dialog is
similar to the Excel (Cell Mode) dialog described above.
The Mail Merge field Name edit field on the Field page of the Word Report
field "Picture" options dialog is where you identify the field in the Word
template file where the picture will be inserted. The specified field name
must exactly match the corresponding field in the Word template file. See
the section on report-specific properties 835 for a description of the Field
Name property.

LabKey Server
The Picture page of the Export to LabKey field "Picture" options
dialog is similar to the Excel (Cell Mode) dialog described above. See the
LabKey Server Export Tutorial
to learn how to prepare pictures and
other items for export to LabKey Server.
1498

20.2.2.5

Reordering and Copying Items in Reports

In Excel (Column Mode) and Text File reports, the token order in the Batch
Actions list is significant since the values will be written to columns in the order
that they are listed within the report.
To reposition an item (e.g., a token) within a report, click on the item and drag it
to the new location in the list. As you drag the item over other items in the list,
you will see a blue line appear above the other items (Figure 20.39). Release the
mouse button to place the item in the position designated by the line. If you
want to reposition the item at the end of the list, drag it onto the report name at
the top of the list. You can also select multiple items and drag them all at once.
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Figure 20.39 Repositioning a Token in a Report

To move an item to a new report, drag the item from its current report to the
title of another report. This removes the item from the current report and adds it
to the end of the destination report. Alternately, right-click on the item and
select Cut BP Actions from the pop-up menu. Click on the destination report,
right-click, and select Paste BP Actions from the pop-up menu.
To copy an item to a new report, click on an item to select it, then right-click and
choose Copy BP Actions from the pop-up menu. Click on the destination
report, right-click, and select Paste BP Actions from the pop-up menu.
Alternatively, you can copy items by dragging them from one report to another
while holding down the Ctrl key.
Note: After you have moved or copied an item from one report to another, it is
important to ensure that the report-specific properties 835 in the destination
report are configured correctly. FCS Express attempts to set the new properties,
but it is impossible to set them correctly in all cases programmatically. For
example, FCS Express has no way of tracking which new report cell to use for a
new token.
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Batch Processing Options
To set batch processing options, use the Batch Batch Processing Options
command to bring up the Batch Processing Options dialog (Figure 20.40).
With the Batch Processing Options, you can control how many iterations are to
be performed during batch processing, whether or not to Pause during batch
processing (either conditionally or unconditionally), and how FCS Express is to
prepare the layout for the analysis of the next iteration.

Figure 20.40 Batch Processing Options Dialog
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The properties which can be set are as follows:
How many iterations should be performed during batch processing?
Specify the number of iterations that the Batch will perform. Normally, you
will want to have as many iterations as can be accommodated by the
number of data sets in the Data List. If you choose Automatically
perform the maximum possible, FCS Express will determine the number
of iterations to perform based on the number of data sets in the Data List,
the position of files in the layout, and the increment value. You can
override this by selecting Always perform this many iterations, and
entering a value in the text field.
Increment value
The increment value is the number of data sets to increment after each
iteration of the batch process. An increment value of 1 means to move to
the next data set. An increment value of 2 means to skip over the next
data set and use the third data set. For example, if the increment value is
1 and an open plot contains the first FCS file in the Data List, the open plot
will contain the second FCS file in the list after the first iteration. If the
increment value is 2, then the plot will contain the third FCS file after the
first iteration, and the fifth file after the second iteration. If a panel 858 is
applied, the Batch increment value will be ignored and the iteration value
from the panel will be used to move through the data sets.
Iteration start count
The iteration start count is the starting value for the number in the Current
Iteration token (commonly used in dynamic filenames). See Save Layout File Options for a description of batch generated filenames 804 for more
information about the Current Iteration token. The default value is 1. All
filenames generated in subsequent iterations will be incremented by 1.
Run alerts before batch processing
If this property is checked, any alerts that you have set will be run before
each iteration is processed. If an alert does not pass the defined criteria
the user will be notified and will have the ability to continue or abort the
batch process.

Pause between iterations
There are several options available in which FCS Express can pause during
batch processing to give the user an opportunity to finalize the analysis for
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each iteration. These settings allow the user to adjust gates and
quadrants as needed before the next iteration. If any of these options are
selected, a window will appear during the batching process, prompting the
user to click Continue, Run to end, or Cancel 844 . The options to Pause
the batch process are:

Unconditionally If this option is enabled, you will be prompted to click
pause between the Continue button in the Batch Run progress window
iterations
at the beginning of each iteration unconditionally. In
other words, FCS Express will pause between
iterations, whether or not the iteration has been
manually flagged or conditionally flagged, as
determined by the conditions set up by the user. The
Batch will run uninterrupted if this property is
unchecked. Using the radio buttons, you can choose
to Keep the changes that were made between
iterations or Restore the state of the layout for the
next iteration. Also, if the iteration was not flagged
previously, you can flag the iteration during the
process.
Pause if the
With the option, the user can create conditions through
condition below the use of tokens. If the condition is True, FCS
is met
Express will pause during batch processing at the
iteration which fulfills the condition.
Pause on
If any iterations were Flagged, FCS Express will list the
flagged
iteration numbers which were flagged. FCS Express will
iterations (the also pause batch processing when the data from the
list is below)
flagged iterations is currently being viewed.
Pause on specificWith this option, the user can designate at which
iterations (the iterations FCS Express will pause during batch
range is below) processing. The user can enter the iteration number,
an iteration range ( for example, 1-9) or specific
iterations (for example, 1,3,5).
Keep the changes that were made between iterations or Restore the
original FCS files on the layout after completing batch processing
When one of these options are selected, all objects on the layout will
display their original data sets at the end of the Batch Process. If
unchecked, then at the end of the batch process, the Data List and
corresponding objects will point to the last data set.
After batch processing is complete - After FCS Express has completed
batch processing, how would you like FCS Express to treat the layout? The
options are:
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Do nothing

Restore the original data files in
the layout

Clear the data files

FCS Express will do nothing and
leave the layout, as is, after the
completion of batch processing.
After the completion of batch
processing, FCS Express will reload
the original data files that were being
viewed within the layout.
After the completion of batch
processing, FCS Express will clear
the Data List of all the data files were
present within it.

Click OK to save your settings.

20.4

Running the Batch Process
Once you have set up all your actions, the Batch Processing options, and verified
that all files you want included in the Batch are listed in the Data List, then you
are ready to run the Batch. Running the Batch executes all actions, including the
Print, Save, and Report actions.
To run the Batch, use the Batch Batch Processing Run command. The
Batch Processing Run, Rerun, and Review windows are now dockable 115 , so that
you may perform other actions while the Batch Process runs or modify Batch
Actions, as well as keep the window open at all times if you wish.
While the Batch Process is running, a progress window will appear showing how
many iterations have passed and how many are left. If you chose to pause
between iterations, then the progress window will have 2 options from which
you can select:
1.Keep the changes - this option will keep the changes that were made to
the layout during the analysis and keep the changes for the next iteration.
2.Restore the state of the layout before the next iteration - this option
will restore the layout to its original state, ignoring any changes that were
made to the layout during the previous batch processing iteration.
Once a selection has been made, the user can choose to Continue running the
batch process, while pausing for each iteration, or by choosing Run to end,
where the batch process will continue to its end, without pausing (Figure 20.41).

If the Batch Process aborts for any reason, FCS Express will now save all of the
reports up until the abort (Figure 20.42).
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Figure 20.41 Batch Processing Progress Window
showing the options that are available between
iterations.

Figure 20.42 If the Batch Process is cancelled you will be prompted to save the
data that was already processed.
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Rerunning and Reviewing the Batch Process
After the Batch Process has been Run

844

, the user now has the option to:

Rerun - Reruns the previous batch process including all changes to gates,
markers, and quadrants applied during a pause of the batch by using
Iteration Snapshots 850 .
Review - Reruns the previous batch process including all changes to gates,
markers, and quadrants applied during a pause of the batch by using
Iteration Snapshots 850 without completing the batch actions.
To rerun the Batch, use the Batch Batch Processing Rerun command
(Figure 20.43). To review the Batch, use the Batch Batch
Processing Review command (Figure below).

Figure 20.43 Rerun or Review Batch
Processing

Rerun and Review will be dependent on the pause options that available in the
Batch Processing Options 850 and Flags 847 . If there are no pause options selected
when running in Review mode, FCS Express will display a message, prompting
the user whether they would like to choose a pause option (Figure 20.44).
Clicking Yes will open the Batch Processing Options window.

Figure 20.44 No pause options were set for Batch Review prompting the message
to open the options dialog.
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Using Flags
During analysis, you will most likely encounter data that needs to be reviewed or
re-analyzed. In FCS Express, you can designate iterations for review by Flagging
them.
You can find the Flag This Iteration button at Data tab
Objects (Figure 20.45).

Figure 20.45 The Flag Iteration Tool Showing a Flagged Iteration.

If any iterations are flagged, as seen in the above image, it is possible to review
those items during Batch Processing.
During Batch Processing, it will be possible to flag iterations from the Batch
Processing progress window (Figure 20.46).

Figure 20.46 An Iteration during Batch Processing that is Unflagged (Left) and
Flagged (Right).

By adjusting the Batch Processing Options 841 to Pause on flagged iterations,
Batch Processing can be Run, Rerun or Reviewed for those selected items
(Figure 20.47).
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Figure 20.47 Batch Processing Paused on Flagged Iteration for further review.

Flagged iterations will be visible within the Data List if the option for Show
Iteration Column is checked within the Data List options. The Data List can be
formatted to show this column by clicking on the Format

button.

After clicking on the Format button, select Show Iteration Column (Figure
20.48).
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Figure 20.48 Choosing to Show the Iteration Column within the Data List.

After selecting the Show Iteration Column option, a Flag will appear in front of
the iteration that was flagged, either during Batch Processing, or from the Data
tab (Figure 20.49).
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Figure 20.49 The Data List displaying
Flagged Iterations

20.5.2

Snapshots and Batch Iteration Navigation
FCS Express now has the ability to automatically take Iteration Snapshots
your analysis for each iteration during Batch Processing.

374

of

During Batch Processing 782 , as gates, markers and quadrants are adjusted, an
Iteration Snapshot 374 is automatically captured for each iteration to store:
o all gates and their coordinates.
o all markers and their coordinates.
o all quadrants and their coordinates.

When a Pause 841 is enabled in the Batch Processing Options (Figure 20.50) the
user can make adjustments of all gates, markers and quadrants and record
those elements for each iteration as part of Batch Processing, through the use of
automatic Iteration Snapshots 374 .
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Figure 20.50 Enabling Batch Processing Pause Options.

As the analysis progresses through batch processing and pauses between
iterations, gates can be adjusted manually or by applying Snapshots
that were
taken with the Snapshots list. If any iteration needs to be reviewed, a flag 847 can
be applied to that iteration.
1513
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If the Batch Processing Options for Pause if the condition below is met is
selected, a condition, in the form of a Token, can entered into the field. If the
condition is True for an iteration, batch processing will pause and the user will
have the opportunity to alter the gating or flag the iteration for further review.
If the Batch Processing Options for Pause on flagged iterations 847 is
selected (Figure 20.51), batch processing will only stop at those iterations that
are flagged. The iterations that have been flagged will be listed in the field below
the option.
If the Batch Processing Option for Pause on specific iterations is selected, the
user can manually list the iteration or iterations during at which batch processing
should pause.
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Figure 20.51 Batch Processing Options Showing Pause for Flagged
Iterations.

Once the gates have been adjusted to their correct positions for an iteration,
click on Continue or Run to end (Figure 20.52). FCS Express will automatically
store a Snapshot of that iteration, move to the next iteration, or to complete
the sequence of iterations.
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Figure 20.52 Choosing Continue, Run to End or Cancel.

If Cancel is selected, FCS Express will prompt you whether you want to save the
data that has already been processed (Figure 20.53).
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Figure 20.53 Cancelling a batch process will prompt you with "Do You Want To Save
the Data That Has Already Been Processed?"

Once Batch Processing is complete, you can review the gating changes that were
made to an iteration during the batch by navigating to the iteration in the Data
List. You may also use the Batch Rerun or Review options 846 from the Batch
tab Batch Processing Run dropdown to run the batch and review your
previous changes. The gating changes that were made will be recorded and
shown with the data (Figure 20.54 and Figure 20.55).
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Figure 20.54 Snapshot showing gating changes made during the batch process for
Iteration #2.

Figure 20.55 Snapshot showing gating changes made during the batch process for
Iteration #3.
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Using Panels
In a typical experiment, you can repeat the same set of staining protocols many
different times, with different samples, but using the same number and sequence
of tubes for your experiment. This type of staining protocol is often referred to
as a Panel. You can specify the number of tubes in the panel, as well as the
name of each tube. Once you have designated an active panel, and added files to
the Data List 783 , FCS Express will automatically determine which data file
corresponds to which tube in your panel. You can change this association from
the Data List. With an active panel, when you create plots with files from the
Data List, FCS Express will know which plots will display the proper file. When
you change the Data List, the plots will automatically update with the correct file
for that tube.
Panels can be added, deleted, edited, saved, and loaded from the Panel
Information dialog which can be opened by using the Batch Organize Data
Sets Panels command, or by clicking on the Panel status bar button (with the
test tubes icon) at the bottom of the layout.

21.1

Working with Panels
The primary benefit of a panel is that it allows you to change the data on your
layout simply by changing the Data List. For example, on Day 1 you analyze
your tubes using FCS Express, creating a plot for each tube. On Day 2, you need
to load new data into the same plots that you used on Day 1. Once you set up
the Panel and the Data List correctly, the layout from Day 1 can be modified to
show the data from Day 2, simply by loading the Day 2 data into the Data List.
The following example will guide you through creating a Panel and taking
advantage of it using the Data List.
1. Select the Data Organize Data Sets Panels command. The Panel
Information dialog, shown in Figure 21.1, will appear.
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Figure 21.1 Panel Information Dialog

2. Click on the Add button to create a blank Panel. This will bring up the Add
Panel dialog (Figure 21.2).
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Figure 21.2 Add Panel Window

3. Enter a name in the Panel Name field, and then select the number of
tubes in the panel by clicking on the arrows to the right of Number of
Tubes. For each tube added, a blank line appears in the table.
4. Give each tube a name (optional), by typing the name into the name
column.
5. Click OK when you have finished setting up the panel. You will be returned
to the Panel Information dialog, where you will see the newly created
panel. Panel information is saved with the layout. However, you can save
your panel for use in other layouts. The Panel Information dialog allows
you to Edit, Delete, Save, and Load panels.
6. Since each layout can have only one active panel, verify that the panel that
you want to use is marked active (the box to the left will be checked).
7. Click OK to continue. Now create plots on your layout and populate them
with data. The Data List will automatically be populated with the data files
in the current directory.
8. Use the Data Organize Data Sets
List command to bring up
the Data List window (Figure 21.3). The first column shows the tubes
from the Panel and the second column shows each tube's associated data
file. Notice how the data files are grouped into the panel automatically. If a
tube is associated with the wrong data file, you can reorder the files using
the Up and Down buttons.
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Figure 21.3 Data List with 2-tube Example Panel

To use the Data List in conjunction with the panel to control the data files in the
plots in your layout, do the following:
1. Remove the data files from the Data List by selecting all the files and
clicking Remove.
2. Click OK. The plots which previously displayed data are now empty.
3. Return to the Data List, and add a new set of data files. To do this, click
on Add and select the data files to be added.
4. Click OK. The previously empty plots are now displaying data from their
associated data files.

If you have a Panel applied, and are adding files to the file list, you do not have to
select all the files that you want to add. You can select the first file that you wish
to add, and FCS Express will attempt to determine how many additional files to
include (Figure 21.4).
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Figure 21.4 Automatically Populating a Panel
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Using Templates
Templates allow you to set up a default look and feel for your experiment. For
instance, if you like a certain paper size, or certain margins, or wish to include
your company logo on every layout, you can do so by creating a template.
A template is nothing more than an FCS Express layout that is set up the way
that you want, providing the user with the opportunity to use a previously
created layout as a starting point for a new analysis layout. Otherwise, it is just
like any other layout. FCS Express remembers the layout as a template when
you select it using the File Tab New Layout New From Existing command/
gallery. Clicking on New From Existing will bring up a Create New Layout
from Template dialog where you can choose any existing layout. If you have
previously created one or more templates, you can also choose one from the
Recent Documents or Places area of the gallery 92 .
When the new layout is opened, it will look identical to the template layout.
However it will "forget" that it came from the template, and when you save the
new layout for the first time, FCS Express will prompt you to select a new file
name.
You can also set a "default template" for use when any new layout is opened. If
a default template has been set, selecting the File Tab New Layout command
will bring up the default template instead of a blank layout. Setting the default
template is described in the section on Default Files/Directories 208 .
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Alerts
An Alert is used to notify the user when a condition has been met. It is
commonly used for quality control purposes. For example, Alert me if the
number of cells in my gate is less than 250.
You can define an essentially unlimited number of alerts. Once you have created
your alerts, you can run them (all at once) and any alerts which met your
condition(s) will be displayed.
Conceptually, Alerts are very similar to custom tokens 725 . An Alert uses a
formula, which can contain other tokens. Unlike custom tokens, however, an
alert formula must always return
TRUE or FALSE as its result value.
Click on the video below to watch a tutorial of how to use Alerts in FCS Express.

Learn how to use Alerts to build quality control checks into your data analysis.

Alerts are only available in FCS Express Flow IVD.

23.1

Creating Alerts
To create an Alert:
1. Click on the Quality Alerts Alerts command to bring up the dockable
Alerts window.
2. Make sure that the Alerts window is docked to the left or right of the
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screen so that all panels of the window are visible (Figure 23.1). The three
areas of the Alerts window are the: Alert List, Alert Formula Editor, and
Alert Message. The list and formula areas are separated by a splitter which
can be moved to resize the areas.

Figure 23.1 Docked Alert Window

3.
4.
5.
6.

Click on the
(Add) icon.
Give the New Alert a unique name.
Click on the Alert name in the list so that it is highlighted.
Enter or edit the formula:
Right-click the formula area and select Insert Token from the pop-up
menu.
Choose a token from the Insert a Token dialog.
Modify the formula so that it evaluates to a TRUE or FALSE statement.
You can use any of the operators and functions that are available for
custom tokens 766 . Examples of two formulas correct formulas are
shown in Figure 23.2. Example 1 is a formula that will evaluate whether
the number of events in the Upper Left Quadrant of Plot #3, Overlay #1
is greater than 2000. Example 2 is a formula what will evaluate whether
the percentage of gated cells on Plot #3, Overlay #1 is between 15%
AND 50%.

Figure 23.2 Examples of Alert Formulas
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7. Enter the text to be shown if the alert condition is met in the Alert
Message edit field at the bottom of the window.

The icon buttons in the Alerts window are explained in the table below.
Icon Button Explanation
Add a new Alert.
Create (and name) a new folder to manage Alerts. Drag & Drop Alerts into
the folder once it has been created.
Delete the selected item. Note: You can undo a delete by immediately
clicking Undo in the Quick Access Tool Bar 65 .
Rename the currently selected item.

23.2

Running Alerts
Once you have created at least one Alert, then you can run the Alerts. FCS
Express evaluates the Alert formulas in the order that they exist in the Alerts
window. Alerts can be run as many times as you choose.
To run the Alerts, use the View Tokens
Alerts command. If none of the
Alerts evaluated to TRUE, you will see the message shown in Figure 23.3.

Figure 23.3 All Alerts Passed Message

If any of the Alerts returns TRUE, the Alert Summary dialog will be displayed
(Figure 23.4).
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Alerts may also be run as part of a Batch Process 782 . Alerts run in a Batch
Process are control through the Batch Processing Options. 841

Figure 23.4 Alert Summary Dialog

In the example Alert Summary dialog, three Alerts that were evaluated. The
first Alert, Alert-Error, did not evaluate to TRUE or FALSE and generated an
error. The second, Alert - Pass, did not evaluate to TRUE and passed. The
third, Alert – Fail, evaluated to TRUE and therefore failed. The Alert Message
column displays the text that was entered in the Alert Message field for each
Alert.
You can sort any of the columns by clicking on the header for that column. Click
OK to close the Alert Summary dialog.
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Importing External Documents and File Types
FCS Express supports importing two external layout types:
BD FACSDiva™ experiments.
BD Accuri™ C6 experiments.
FCS Express also supports importing / loading of comma delimited files stored in
the format of (*.csv)

24.1

BD FACSDiva Files
The basic version of FCS Express can load FCS files from BD FACSDiva™
software, similar to loading data files from any other instrument. However, the
FACSDiva Importer add-on allows you to import your entire experiment
(FACSDiva version 4 and above) as well.
A FACSDiva experiment file, which has the extension .xml, is created when you
export your data using the FACSDiva software (see "Exporting Experiments" in
the FACSDiva Software Reference Manual for information). The FACSDiva
experiment file contains information on plots, gates, and compensation settings.
The following FACSDiva experiment information will be maintained when the file is
imported into FCS Express:
All acquisition templates and analysis worksheets.
The native, high resolution, floating point FCS data.
All gates with the proper gating hierarchy.
All compensation settings.
All markers and quadrants.
Because the FACSDiva experiment file does not contain information about the
pages its plots should appear on, FCS Express needs additional data to import
the file properly. In particular, FCS Express needs to know how you want the
plots distributed across your layout pages. For example, a given FACSDiva
experiment file has three plots laid out horizontally. This file could be imported
into FCS Express such that each plot exists on its own layout page, or all three
plots could be placed on a single layout page. If you leave the size of the FCS
layout page at the standard 8.5 x 11 inches, then importing the three plots may
cause the size of the plots to shrink, in order to fit them on a single page.
However, while importing, you can configure the size of the FCS Express layout
page to contain more plots of standard size.
Once you have set up the page size for the FACSDiva experiment file import,
along with the distribution of the plots on the layout page, you can save the
configuration for use again with other FACSDiva experiment files. The
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How to Import FACSDiva Experiment Files
To import a FACSDiva experiment file:
1. Use the File tab

Open From

Import BD FACSDiva File... command.

2. Browse your directories to select the FACSDiva experiment file (.xml) to
import. Click Open when you have located it.
3. The Import BD FACSDiva File Wizard appears, beginning with the
Import Options page (Figure 24.1). The worksheets available in the
FACSDiva experiment file are displayed, including their type (either Analysis
worksheet or Acquisition template). In the Import column, check the
box for the Worksheet(s) you want to load. You will need to select at least
one Worksheet to continue.

Figure 24.1 Import BD FACSDiva File Wizard - Import Options
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4. Towards the bottom of the window, choose whether you want to load the
FCS files corresponding to the experiment, and navigate to the folder
containing the files (if different from the .xml-containing folder). If you do
not want to load the FCS files, choose the Do not load the FCS files radio
button. Click Next to continue.
5. The FCS Express FACSDiva configuration file page appears (Figure
24.2). You can choose to load an existing configuration file, or create a new
one. If you choose to load an existing configuration file, select the Use an
existing configuration file radio button, select the file, click Next, and
proceed to Step 8. If you choose to create a new configuration file, select
the Create a new configuration radio button, and click Next.

Figure 24.2 Import BD FACSDiva File Wizard - Configuration File

6. If you decided to create a new configuration, the Setting up the page
size for the layout in FCS Express (Figure 24.3) will appear. Here, you
set up how the plots from the FACSDiva experiment will be imported into
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the FCS Express layout.

Figure 24.3 Import BD FACSDiva File Wizard - Setting Page Size

The window is divided into two sections:
Real Page Size (inches)
This section allows you to configure the page size of the layout. The
default is 8.5 x 11 inches. You can also set the margin widths.
Logical Page Size (pixels)
This section allows you to configure how the FACSDiva experiment file
will be divided when it is imported into FCS Express. It displays all the
dot plots and histograms from the FACSDiva experiment, using mock
diagrams to represent the appropriate plot. By clicking in the
representation of the FACSDiva experiment file page, you can divide
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the experiment into multiple pages. After the initial click, you will see a
dotted vertical line which represents the right side of each layout page,
and a horizontal dotted line, which represents the bottom of the layout
page. If one of these lines is not visible, zoom in or out using the
magnifying glass buttons. If a plot extends across more than one page
in the diagram, it will be placed on the layout page where its top-left
corner exists in the diagram. By default, the ratio of the page is locked,
which means that as the width of the page increases, so does the
height.

When you have completed setting up how the FACSDiva experiment’s plots
will be imported, click Next.
7. The next page of the wizard, Saving the configuration, allows you to
choose whether or not to save the settings from the previous screen to a
file. Saved configuration files can be used to import other FACSDiva
experiments (in Step 5). Click Next to continue.
8. If, in Step 3, you chose to load an Analysis worksheet, then FCS Express
will display the experiment. If you loaded an Acquisition template, along
with the FCS data files, then the Select the Specimen and Tube dialog will
appear (Figure 24.4). Expand the name headings, as appropriate, and
select one FCS file from the list. After highlighting an FCS file name, click
OK. If FCS Express cannot find the file, you will be prompted to locate it.
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Figure 24.4 Selecting FCS File Data for an Imported FACSDiva Experiment

9. For each worksheet with an acquisition template you selected in Step 3,
you will see the above dialog to load FCS data file.
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FCS Express will then display the imported FACSDiva experiment, which can be
treated like any other layout.

24.1.2

Tips for Importing FACSDiva Experiments
The following tips are valuable when considering importing FACSDiva experiment
files into FCS Express.
When importing FACSDiva experiments into FCS Express, all plots in the
experiment will be recreated on your layout. Although each plot can be
reformatted using standard FCS Express techniques 245 , it is useful to remember
that the default format (i.e., fonts, axes labels, plot resolution, overlay settings,
etc.) can be defined before a plot is created, in FCS Express User Options 179 . To
ensure that imported plots are displayed in the manner that you prefer, it is
recommended that you take advantage of the default options before you import
FACSDiva experiments. For convenience, you can create a user 50 (e.g.,
"FACSDiva Import"), under whom the specific default options may be defined
without affecting your default settings for working with other types of data files.
Among the plot settings that you will most likely want to configure are:
Legend visibility
Displaying the legend takes away viewable space from the plot. Therefore,
you should consider hiding the legend 189 if your FACSDiva experiment
displays many plots on a page.
Histogram resolution
Typically, the histogram resolution is set to be derived from the FCS File.
In high resolution data with lots of channels, there are likely to be very few
events in each channel. Lowering the resolution to 1024 channels may
improve the appearance of the histograms.
Scaling the Axes
When you import your experiment into FCS Express, your plots are
displayed with the axes scale settings that are stored in the experiment
file. You are not obligated to keep these axes scales, however. For
example, if an imported plot is displayed with five decades, you may
decide that it is better displayed with only four decades. You can also
change the scale between linear, logarithmic, and biexponential 393 .

24.2

BD Accuri CFlow and C6 Files
The BD Accuri™ C6 and C6 Plus are bench-top systems that deliver performance
and features similar to those of the market-leading flow cytometers, yet the
instruments and the C6 software that controls the C6 are easy to use and allow
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even a novice to quickly set up an experiment and acquire data.
FCS Express is pleased to provide the BD Accuri C6 importer, which allows you
to apply the sophisticated analysis features of FCS Express to the data acquired
using C6. FCS Express will import all of the experiment information from the C6
file, including:
All plots on the Collect and Analyze tab.
The native, high resolution, 24-bit FCS data.
All gates with the proper gating hierarchy.
All compensation settings.
All markers and quadrants.
All plot formatting settings.
Once your experiment is loaded into FCS Express, you can treat your plots just
like a plot created in FCS Express.
If you have purchased the Heat Map add-on
with FCS Express you may load
any .C6 file in FCS Express as a 96 well heat map regardless if it was collect from
a plate. Simply insert a heat map and choose BD Accuri C6 Plate files (*.c6,
*.ci) from the files of type dropdown list.
1048

24.2.1

How to Import CFlow Experiment Files
To import a CFlow experiment file:
1. Use the File tab

command.

2. Browse your directories to select the C6 experiment file (*.c6; *.ci)to
import. Click Open when you have located it.
3. The Import BD Accuri C6 File Wizard appears, beginning with the
Import Selections page (Figure 24.5). On this page, you can choose to
import plots from the C6 Collect and/or Analyze tabs.
4. If you choose to import plots from the Collect tab, select the data file to
use from the drop-down list.
5. Click Next to continue.
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Figure 24.5 Import BD Accuri CFlow File Wizard - Import Selections

The Page Layout Options page (Figure 24.6) will appear. Here, you
configure how the plots from the C6 experiment will be imported into FCS
Express.
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Figure 24.6 Import BD Accuri CFlow File Wizard - Page Layout Options

6. Under the Page Size section, you can select a standardized size from the
drop down menu, or you can manually enter a Width or Height. You are
also able to adjust the Margins, Page Orientation and whether or not
FCS Express is to Maintain the size of all objects on the layout.
Underneath the Plot Layout Options section, you can set the Plot width,
Plot height, Number of rows per page, and Number of columns per page. A
preview of your layout is shown on the right. Click Finish when you are
ready. FCS Express will now create an exact copy of the C6 workspace
displayed as an FCS Express layout. The plots will all be scaled and zoomed
the same way in FCS Express as in C6. All regions, markers, and gating are
retained. Parameter names and compensation settings are also applied.

24.2.2

Tips for Importing CFlow Experiments
The following tips and instructions will aid in importing and using Accuri CFlow
experiments:
Recommended settings in FCS Express to help improve performance when
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importing BD Accuri C6 experiments.
1. Open the Options dialog using the

179

command.

2. Select the
category. Make sure that
Allow Multiple Datasets is unchecked. Although this setting is not
necessary for loading a C6 data file, it will allow you to add files to the
data list, which is necessary for batch processing.

Loading BD Accuri C6 software data into FCS Express plots.
1. Insert a plot 171 from the Insert Tab. When the Select a Data File dialog
opens, change the file type to C6 files (*.c6; *.cfl; *.ci).
2. Navigate to the BD Accuri C6 software file that you want to open, and
double-click on it. The dialog will then display all of the fcs files contained
inside the C6 file. Select the one that you are looking for.
3. Press Open.

24.3

Comma Separated Value / Delimited (.csv) Files
FCS Express supports loading data stored as Comma Delimited files in the
format of (*.csv).
Data files stored in the .csv format must contain a header row for each
parameter that contains a parameter descriptor as well as a comma-separated
list of values for each parameter created as seen in Figure 24.7.
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Figure 24.7 - A comma-separated value (.csv) file created in the proper format for
import to FCS Express Version 5.

Comma Delimited files may be opened and used in FCS Express by choosing
Comma Delimited files (*.csv) from the Files of type dropdown list in any
Select a Data File dialog (Figure 24.8.).
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Figure 24.8 - Choosing the Comma Delimited files (*.csv) file type in the select a
data file dialog.

Once a file is selected it may be inserted as a plot in FCS Express for analysis
(Figure 24.9).
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Figure 24.9 A comma delimited value file opened in a histogram and dot plot.
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DNA Analysis
FCS Express provides a complete DNA analysis solution based upon the widely
used MultiCycle AV™ DNA analysis package written by Dr. Peter Rabinovitch at
the University of Washington, and distributed by Phoenix Flow Systems (http://
www.phoenixflow.com).
From the Multicycle manual:
"DNA content histograms require mathematical analysis in order to extract
the underlying G1, S, and G2 phase distributions...The most flexible and
accurate methods of cell cycle analysis are based upon building a
mathematical model of the DNA content distribution, and then fitting this
model to the data using curve-fitting methods." Multicycle contains "the most
well established models," like those "proposed by Dean and Jett, based upon
the prediction that the cell cycle histogram is a result of the Gaussian
broadening of the theoretically perfect distribution," and Fox, whose "model
provides a more flexible S phase shape, but still retains the smoothness of
the S phase that is characteristic of the Dean and Jett model." In addition,
"careful attention to fitting of the background aggregates and debris is also" a
feature of Multicycle "in order to maximize the reliability of cell cycle analysis
of complex histograms."
A free, limited version of Multicycle is included with FCS Express. This free version
only reports the data on a basic 1-cycle Autofit with no background correction.
When using the free version, there will be a warning message if more than one
cycle is detected in your .fcs data files, and/or if a background correction would
improve the fit. Both of these conditions require the full version of Multicycle for
accurate analysis.
The full version of Multicycle is available for purchase as an add-on. The complete
version allows 1-, 2-, and 3-cycle fits with the ability to change parameters
manually and perform background correction.

25.1

Multicycle
FCS Express comes with a free version of Multicycle capable of performing a 1cycle fit with no background correction. The full version of Multicycle may be
purchased as an add-on for FCS Express from De Novo Software, or as
standalone software from Phoenix Flow Systems (http://
www.phoenixflow.com).
The Multicycle model has been described extensively in the following publications:
Rabinovitch, P.S. DNA content histogram and cell-cycle analysis. Methods in
Cell Biology. 41:263-296, 1994.
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Rabinovitch, P.S. Practical considerations for DNA content and cell cycle
analysis. In: Clinical Flow Cytometry: Principles and Applications (Bauer,
K.D., Duque, R.E., and Shankey, T.V., eds.) Williams and Wilkins, Baltimore,
pp. 117-142, 1992.
Rabinovitch, P.S. DNA Histogram Analysis. In: Cell Growth and Division, 2nd
Edition. (G. Studinski, ed.). Oxford University Press, Oxford, 1996.
Kallioniemi, O-P., Visakorpi, T., Holli, K., Isola, J.J., and Rabinovitch, P.S.
Automated peak detection and cell cycle analysis of flow cytometric
histograms. Cytometry 16:250-255, 1994.

25.2

Inserting a DNA Histogram
DNA Histograms are inserted onto a layout page just like other histograms

171

.

Use the Insert tab 1D Plots Multicycle DNA command and either click on
the layout page to insert a standard size histogram, or click-drag to insert a plot
of the desired size. A file dialog will then appear allowing you to select your DNA
data file. A fitted Multicycle DNA histogram will appear. A legend 251 can be
displayed when the standard histogram features are formatted (Figure 25.1).

Figure 25.1 Multicycle DNA Histogram with Legend

FCS Express can fit DNA curves from files generated from any cytometer (both
standard FCS list mode data files as well as uncorrelated FCS histogram files).

25.3

Formatting a DNA Histogram
To format a Multicycle DNA histogram,
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Right-click on the histogram, select Format from the pop-up menu, expand
the DNA node, and choose one of the four DNA-specific categories: General
890 , Cycle 891 , Background 892 , or Position Markers 893
The other categories which can be formatted are described in formatting options
for standard histograms 266 . Note that overlays cannot be added to Multicycle
DNA histograms.

25.3.1

General Options
The General category of DNA formatting options contains properties that control
how the data on the DNA histogram is presented (Figure 25.2).

Figure 25.2 Formatting a DNA histogram - general options

The options are described in the table below.

Property
Fit Model to
show
Default

Explanation
Every time Multicycle performs a fit, it calculates six different variations
on that fit. You can choose which variation to display by changing this
option. The six variations are described in detail in the Multicycle manual.
Select which parameter to display when changing data files. "Prompt
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Property
Explanation
Parameter For when needed" will prompt you to select a parameter every time you
Plot
change a data file. "Use parameter below" allows you to always display
the parameter selected from the spin control.

You can find a summary of the Cycles and Models used in Multicycle here

25.3.2

902

.

Cycle Options
The Cycle category contains options describing different parameters of the DNA
fit. This category allows you to choose what kind of fit you wish to apply, as well
as set specific parameters for the fit.
FCS Express defaults to selecting the fit type automatically (the Detect fit type
automatically checkbox is checked). When detecting the fit type automatically,
all other options are disabled because Multicycle will calculate all the fit
parameters.
To set the fitting values yourself, uncheck the Detect fit type automatically
checkbox. The other options will then be enabled (Figure 25.3).
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Figure 25.3 Formatting a DNA histogram - Cycle options

FCS Express will show different fitting options depending on which fit type is
selected from the Fit Type drop-down list. The example shows a 2 Cycle fit.
Links to a complete listing of all the supported fit types and the various
parameters that apply for those fits can be found on the FCS Express - Multicycle
knowledgebase page.
After changing the parameters for a fit, you can apply those parameters by
pressing the OK or Preview buttons. Multicycle will use the input parameters as
the starting point for the fit, but may vary the parameters while calculating the
best fit. To see the final fit values that Multicycle calculated you can open a DNA
statistics window 899 or create Text Boxes with DNA-specific tokens 901 .

25.3.3

Background Options
The Background category (Figure 25.4) contains options which control how
Multicycle calculates the background (in order to remove debris from the sample
and calculate an accurate fit).
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Figure 25.4 Formatting a DNA histogram - background options

The Use Background Fit checkbox controls whether or not Multicycle will
attempt to calculate a background and remove it from the fit data. The other
options control the specific background fitting parameters and are explained in
detail in the Multicycle manual. Please see the FCS Express - Multicycle
knowledgebase page for additional resources.

25.3.4

DNA Position Markers
The position of cell cycle parameters (e.g., the G1 mean or the background
regions) can be displayed with the use of DNA Position Markers (Figure 25.5).
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Figure 25.5 DNA Histogram showing Diploid G2 Position Marker (Red)
and Aneuploid G1 Position Marker (Blue)

You can show or hide a position marker by either:
Right-clicking on the DNA Histogram, selecting DNA Position Markers from
the pop-up menu, and toggling the appropriate position marker on or off
from the submenu (Figure 25.6), or
Right-clicking on the histogram, selecting Format from the pop-up menu,
expanding the DNA category node, and choose the Position Markers
category
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Figure 25.6 Showing or Hiding DNA Position Markers

To adjust the visibility, style, color, and/or width of a marker, right-click on the
DNA Histogram, select Format from the pop-up menu, expand the DNA node,
and choose the Position Markers category (Figure 25.7). Select the marker
from the list on the left (use Ctrl+Click to select multiple markers). The Show
position marker on the plot checkbox controls the visibility of the selected
marker.
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Figure 25.7 Formatting a DNA histogram - Position Markers

25.4

Setting Default DNA Options
The default DNA options 193 including general options, overlay options, and
position marker preferences for performing DNA analysis using Multicycle 888 are
described in the appropriate section of the chapter on formatting objects 193 .

25.5

The Multicycle Tab
MultiCycle can automatically fit and analyze cell cycle histograms with multiple
models. You can control the number and type of populations to fit, the currently
displayed model, and the background options using the MultiCycle Tab (Figure
25.8). The Multicycle tab will only appear when a Multicycle DNA Analysis plot has
been selected in the layout.

Figure 25.8 The Multicycle Tab

© 2020 De Novo Software

DNA Analysis

897

To analyze a DNA histogram automatically:
1. Insert a DNA Histogram onto your layout using the Insert 1D
Plots MultiCycle DNA command.
2. Select the DNA Histogram and verify that the MultiCycle Fit
Parameters Autofit command is highlighted. With Autofit, MultiCycle will
choose the Cycle parameter for you.
3. Right-click on the DNA Histogram and select Statistics DNA Cycle
Statistics from the pop-up menu. Adjust the position of the statistics
window.
4. Right-click on the DNA Histogram and select Statistics DNA Model
Summary Statistics from the pop-up menu. Adjust the position of the
statistics window.

The current model being displayed in the DNA Cycle Statistics is highlighted in the
MultiCycle
group. To change the model, click on one of the
other five Model commands within the Model to Display group.
To change to a manual fit, click on MultiCycle Fit Parameters Autofit and
verify that the command/button is not highlighted. With a manual fit:
To change the number of populations for the fit, or the parameters for a 1
Cycle fit, use the MultiCycle
Cycle drop-down list.
To change the Fit Model Properties, use the MultiCycle Fit
Parameters
command to bring up the Formatting Fit
Model Options dialog (Figure 25.9). You can alter the means and CVs for
populations manually. The properties that can be adjusted will change
according to the Fit Type chosen in the drop-down list.
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Figure 25.9 Formatting Fit Model Options Dialog

To change background parameters, select the MultiCycle
Background command to bring up the Formatting
Background Options dialog (Figure 25.10). The parameters are described
in the MultiCycle manual.
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Figure 25.10 Formatting Background Options Dialog

25.6

DNA Statistics
To open a DNA statistics window, right-click on the DNA histogram, move the
cursor over Statistics in the pop-up menu, and select the desired type from the
submenu (Figure 25.11).
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Figure 25.11 Choosing DNA Statistics

The first choice, Standard Histogram Statistics, represents the statistics
available for non-DNA histograms 380 .
DNA Cycle Statistics describe each of the populations within your sample. The
three possible populations are Diploid, Aneuploid A (or Aneuploid 1), and
Aneuploid B (or Aneuploid 2). Each population will appear in a different row
depending on the currently applied fit. Figure 25.12 shows an example of DNA
cycle statistics for a two cycle fit. A detailed description of the different cycle
statistics can be found in the Multicycle manual.

Figure 25.12 DNA Cycle Statistics for a Two Cycle Fit

The DNA Model Summary Statistics pertain to the six different models that
Multicycle calculates each time a DNA analysis is performed. Each model will
appear in a different row. A detailed description of the different DNA model
statistics can be found in the Multicycle manual.
The DNA Experiment Statistics display several additional statistics as well as
an interpretation of the experiment as a whole. The interpretation, designed to
give you an estimate of the goodness of the fit, is described in more detail in the
Multicycle manual (Figure 25.13).
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Figure 25.13 DNA Interpretation and
Experiment Statistics

Please see the FCS Express - Multicycle knowledgebase page for additional
resources.

25.7

DNA-Specific Tokens
All of the DNA statistics can be used as tokens 688 . DNA tokens can be inserted
into text boxes 688 , used in Custom Token 725 or Alert 866 formulas, and exported
to reports during batch processing 833 .
To insert a DNA token into a text box:
1.
2.
3.
4.
5.
6.

Insert a text box using the Insert tab General Text Box command.
Right-click on the text box and select Insert Token.
Double-click Statistic to bring up the Create Statistic dialog.
Choose a DNA Histogram as a Data Source.
Open the Statistic category.
Choose a DNA statistic 899 from the Select a Statistic drop-down list. If
you choose DNA Cycle Statistics, the dialog will look like Figure 25.14. If
you choose a different DNA statistic (DNA Model Summary Statistics or
DNA Experiment Statistics), the options and the specific items in the list box
will change.
7. Click OK.
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Figure 25.14 Create Statistics Dialog - DNA Cycle Statistics

25.8

DNA Cycle and Model Summary Reference
MultiCycle AV for FCS Express is capable of autofitting the appropriate Cycle to
suit your data. However, users have the ability to override the autofit and
choose a Cycle to fit to their data.
Here is a summary of the various Cycles that are available in MultiCycle AV.

1 Cycle

Cycles
The most common and frequently used. Used when there is 1
full cell cycle present.
Similar to 1 Cycle. Ideal when using a standardization tool like
chicken erythrocytes.

1 Cycle
Standard
Overlay Peak
1 Cycle
This cycle is performed when it is assumed that there is one extra
Apoptotic
peak to the left of the G0/G1 peak.
Overlay Peak
1 Cycle
This cycle is performed when there is an Aneuploid peak present
Aneuploid
that does not contain a full cell cycle.
Overlay Peak
1 Cycle
This cycle is performed when there is a Diploid peak that does not
Diploid
contain a full cell cycle.
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Overlay Peak
2 Cycle
This cycle is used when there are 2 full cell cycles present.
3 Cycle
This cycle is used when there are 3 full cell cycles present.
Synchronous This cycle should be used when performing an experiment where
S Phase
S phase is arrested, leading to a peak in S peak, rather than a
smooth gradual curve.

MultiCycle AV for FCS Express applies six different models to your data at the
same time.
In FCS Express, you can create a DNA Model Statistics Summary box that shows
your statistics as it applies to each of the six different models (Figure 25.15).

Figure 25.15 - DNA Model Statistics

Here is a summary of the various Cycles that are available in MultiCycle AV.
Models
SL S0 Most common model used. Sliced nuclei background modeling with zero
order S phase, but without other options. Used when debris curve looks
like a ski slope.
SL CL Sliced nuclei background modeling with clumping compensation with zero
S0
order S phase. Used if debris curve is flat and cuts into G0/G1.
+G2/ Sliced nuclei background modeling, plus the constraint of the G2/G1 ratio.
G1
For 1 cycle fitting models, the G2/G1 ratio is the current default stored
Fixed within Multicycle AV.
Please note, for 2 Cycle models, the G2/G1 ratio of the diploid cycle is
constrained to be equal to the aneuploid G2/G1 ratio that resulted from
the user-chosen fitting model.
For 3 Cycle models, the G2/G1 ratio of all 3 cell cycles is constrained to
be equal to the average of the 2 aneuploid G2/G1 ratios that resulted
from the user-chosen fitting model.
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+Agg Sliced nuclei modeling plus aggregation modeling and addition of G2/G1
regat constraint, as detailed above. Basically, this is a software version of
es
doublet discrimination. This model looks at all possible combinations of
G1 and G2 stuck together and figures out the % of cells that are stuck
together.
+S
A 1st order S phase polynomial is used with sliced nuclei background
Order modeling. This model is to be used when the S phase is more in the
=1
shape of a broadened trapezoid.
S order = 0 (broadened rectangle)
S order = 1 (broadened trapezoid)
S order = 2 (higher on the sides, lower in the middle)
+CVs Sliced nuclei modeling with 1st order S phase, plus the CVs of all peaks
Fixed are constrained. This model can be used when the G2/M peak is buried in
the S phase.

References for this information can be found at our Multicycle Knowledgebase
Page.
In cases where the data is suboptimal or the cell cycle peaks are not well defined,
users can get Intra-model or Inter-model errors. You can find the definition for
these errors at http://www.denovosoftware.com/site/kbDNAMulticycleInfo.shtml.
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Proliferation Analysis
The introduction of fluorescent cell staining and division tracking dyes has made it
possible to monitor the number of cell divisions during proliferation, and to
examine the relationship between proliferation and differentiation.
Fluorescent tracking dyes can be categorized into two major groups:
General protein labeling
General protein labeling dyes such as carboxyfluorescein diacetate
succinimidyl ester (CFSE) act by forming random covalent bonds with
amino groups on cellular proteins resulting in a highly fluorescent
membrane impermeable marker. CFSE is highly fluorescent and when
excited with a 488 nm laser it emits in the "green" channel at 515 nm.
General membrane labeling dyes
General membrane labeling dyes such as PKH and Cellvue are lipophilic
compounds that stably but non-covalently insert into the plasma
membrane. General membrane labeling dyes vary in fluorescent intensity
and can be obtained in many colors, making them useful for multi-color
experiments.

With each cell division, the dye is divided roughly equally between the two
daughter cells. Therefore, the dye fluorescence intensity is a measure of the
number of divisions any given cell has undergone.
After staining, the cell population is analyzed at regular time intervals by flow
cytometry. A histogram of the number of cells as a function of dye fluorescence
intensity is generated. Typically, cell proliferation dyes can be used to track up to
8 rounds of division before fluorescence intensity is reduced to the
autofluorescence of unstained cells.
The FCS Express Proliferation Add-on provides curve fitting algorithms to
estimate the proliferation fraction.
For more information on proliferation analysis, please see http://
www.denovosoftware.com/site/ProliferationAnalysis.shtml.

26.1

Obtaining the Proliferation Add-on
The Proliferation add-on module in FCS Express performs sophisticated curve
fitting in order to quantify the proliferation characteristics of your population. This
allows for easy determination of the fraction of proliferating cells, as well as other
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derived statistics.
The Cell Proliferation Analysis add-on module is included with any Professional
license of FCS Express 6 Flow Cytometry.

26.2

Inserting a Proliferation Histogram
Proliferation histograms are a special subset of one dimensional plots that
automatically model proliferation statistics according to the fit parameters you
set.
Note: The axis scale

253

of Proliferation histograms should be set to Log.

Prior to inserting a Proliferation histogram for curve fitting analysis, you should
gate your cell population on the desired cells. See the proliferation tutorial
for
further information.
1798

To insert a Proliferation histogram, use the Insert 1D Plots Proliferation
command. If necessary, change the x-axis parameter 308 to reflect the
appropriate parameter for the proliferation dye used in the experiment, such as
CFSE or CellTrace Violet, for example.
An example of a Proliferation histogram is shown in Figure 26.1.

Figure 26.1 Proliferation Histogram

The default colors are explained in the table below.
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Color
Black

Explanation
Overall histogram contour. This includes all the data and does not represent an
output of the fitting algorithm.
Red
Overall contour of the fitted data. This excludes what the algorithm determines
to be noise.
Light Blue This is the data that the algorithm determines to be noise, and is not included
in the statistics.
Green
Modeled populations of proliferating cells. These are the actual curves fitted to
the data, representing the parent, undivided population, and all the
proliferating generations.

26.3

Formatting a Proliferation Histogram
In addition to the options common to all histograms 266 , Proliferation Histograms
have two additional property categories which can be formatted: Fit Parameters
908 and Proliferation Position Markers 910 .

26.3.1

The Fit Parameters Option
If the algorithm finds a significant population of events that it determines to be
noise (shown in Light Blue on the Proliferation histogram), you can try to modify
the Proliferation Fit Parameters in order to attempt to improve the model's
fit.
To format the fit parameters of a Proliferation histogram:
1. Right-click on the Proliferation histogram and choose Format from the
pop-up menu.
2. Click on the triangle next to Proliferation to expand the category.
3. To change the fit model, select the Fit Parameters category (Figure
26.2).
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Figure 26.2 Formatting Proliferation Fit Parameters

On the Fit Parameters page, you can modify a number of properties related to
the fit algorithm, including:
Maximum number of peaks to model.
Fixed CV. Decide whether or not to use a fixed CV (defined by the user) for
all peaks. Note that, the value defined in the Fixed CV field is actually
interpreted by the software as the Standard Deviation of the peaks,
calculated, on log-transformed values, after binning.
Same CV for All Peaks. When this option is selected, the CV, calculated on
linear-scaled data (i.e. raw data), is made the same between peaks. Note
that the CV reported in the Proliferation Statistics table, is calculated on the
log-scaled data instead.
Fixed Peak Ratio and/or Same Peak Ratio for All Peaks.
Fixed Starting Generation
Background Noise. The values defined in this field is subtracted from the
channel values prior to doing any fitting.

The following is a brief description of how the fitting algorithm works, which will
help you to set the properties:
The fitting process starts by determining where the population of cells that
have not divided is located. The fitting process attempts to find this peak
automatically, although you can specify it manually. In some cases, you
have to specify it manually since there are no cells in the population that
have not divided.
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Once the undivided population is found, the model attempts to find
populations that have decreased in fluorescence by 50% from each other.
Since not all experiments work according to theory, the model starts
looking at the 50% point but can move left or right to find the true peak.
You can control this by using the Same Peak Ratio for All Peaks option.
In order to find a peak, the model makes certain assumptions about the
width of each peak compared to the undivided control. You can also control
these settings using the Same CV for All Peaks option. When this options
is selected, the CV, calculated on linear-scaled data (i.e. row data), is made
the same between peaks.
The model can also subtract background fluorescence from all the
calculations, if you provide a value for the background fluorescence.
Since the algorithm uses the actual histogram contour to model the fit, the
histogram data should not be smoothed. Only in special cases, when the
original data is very noisy, should a little smoothing be applied to allow the
model to better fit the data.
These options exist in order to accommodate the wide range of data
sources and biological behaviors that the model has to encompass. Thus, in
order to obtain the best fit, it is important that the correct initial settings be
selected. In practice, this is usually performed by trial and error until the
settings providing the best fit are found.
The two ways to assess the goodness of the fit are visual inspection, which
gives a rough measure, and the proliferation fit statistics 911 .

26.3.2

Proliferation Position Markers
Position Markers can be displayed on Proliferation histograms to mark the
position of the undivided cells peak and/or the background region.
To format proliferation position markers:
1. Right-click on the Proliferation histogram.
2. Choose Format from the pop-up menu.
3. Click on the triangle next to Proliferation to expand the category.
4. Select the Position Markers category.
5. To make the position marker for a specific peak, select the peak and check
the box for Show position marker on the plot.
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Select the Undivided cells peak and/or Background properties from the list
box on the left (Figure 26.3) and choose line options for the selected markers on
the right.

Figure 26.3 Formatting Proliferation Position Markers

26.4

Proliferation Statistics
When performing a Proliferation Analysis, FCS Express automatically calculates
several proliferation fit 912 and proliferation population 914 statistics from your data.
To change user preferences for which of these statistics are displayed, refer to
the Proliferation Fit Statistics preferences 203 and Proliferation Population Statistics
preferences 204 sections of the Statistic Preferences 196 sub chapter of Formatting
Objects 178 .
To open a Proliferation statistics window, right-click on the Proliferation
histogram, move the cursor over Statistics in the pop-up menu, and select the
desired type from the submenu (Figure 26.4).
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Figure 26.4 Choosing Proliferation Statistics

The first choice, Standard Histogram Statistics, represents the statistics
available for non-Proliferation histograms 380 .
Proliferation Fit Statistics 203 describe the fitted data. Figure 26.5 shows an
example of proliferation fit statistics. The statistic equations that are calculated
are shown in the table below.

Figure 26.5 Proliferation Fit Statistics

The statistics shown in this window are explained in the table below
P is the total number of peaks found (where P0 is the undivided generation).
N is the number of cells in a generation.
µ is the mean of a population.
All statistics below assume that no cell death occurred.
Statistic
Proliferati
on Index

Equation

Description
The average number of cells that an
initial cell became.
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Division
Index

The average number of cells that a
dividing cell became.

# of
Original
Cells

The number of cells that existed prior to
any division.

%
Divided

The percentage of the original cells that
divided.

Peak
Ratio

The average ratio of all the peak
positions.

# of
Fitted
Cells

The total number of cells calculated by
the fitting.

Degrees
of
Freedom
R-Chi
Square
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The number of channels minus the
number of fit parameters minus 1.
An estimate of the “goodness of fit” of
the model. Values under 5 indicate a
good fit.
R is the range of the data.
O(i) is the data value at i.
F(i) is the fit value at i.
σ(i) is the measurement error at i.
Measurement error is estimated by
comparing a smoothed version
(7 point smoothing).
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RMS
Error

An estimate of the “goodness of fit” of
the model.
R is the range of the data.
O(i) is the data value at i.
F(i) is the fit value at i.

Proliferation Population Statistics 204 pertain to the multiple generations that
have proliferated during the experiment (Figure 26.6). The statistic equations
that are calculated are shown in the table below.

Figure 26.6 Proliferation Population Statistics

An explanation of the shown in this window is in the table below. Note that all
statistics are generation-specific.
Statistic
Peak
Channel
Peak Value
Log Std.
Dev.

Log CV

Description
The x-value of the peak.
The y-value of the peak.
The Standard Deviation (Std. Dev.) of the log-scaled data. The
Std. Dev. is a measure of the variation from the average for the
events, or the square root of the variance. Log values are used
due to histogram data being binned in log space.
The coefficient of variation (CV) of the log-scaled data. The CV is a
measure of the distribution of your data and is equal to the
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standard deviation divided by the mean. Log values are used due
to histogram data being binned in log space.
Peak Ratio The ratio of the fluorescence to the previous generation's
fluorescence. The ideal is 0.5.
# of Cells The number of cells calculated by the fitting.
# of Orig The number of original cells (i.e., cells prior to any cell division)
Cells
giving rise to the cells calculated by the fitting.
% of Orig The number of original cells expressed as a percent of the total
Cells
number of original cells.

26.5

Proliferation-Specific Tokens
All of the Proliferation statistics can be used as tokens 688 . Proliferation tokens can
be inserted into text boxes 688 , used in Custom Token 725 or Alert 866 formulas,
and exported to reports during batch processing 833 .
To insert a Proliferation token into a text box:
1. Insert a text box using the Insert General Text Box command.
2. Right-click on the text box and select Insert Token.
3. Choose Statistic and click on the Insert button to bring up the Create
Statistic dialog.
4. Choose a Proliferation Histogram as a Data Source.
5. Open the Statistic category.
6. Choose either Proliferation Population Statistics or Proliferation Fit
Statistics from the Select a Statistic drop-down list. If you choose
Proliferation Population Statistics, the dialog will look like Figure 26.7.
Choose a population from the Select Population drop-down list, and one
or multiple statistics from the list box, and click OK.

© 2020 De Novo Software

916

FCS Express 6 Manual

Figure 26.7 Choosing a Proliferation Population Statistic Token
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Kinetics Analysis
Kinetics experiments are particularly useful for examining changes in DNA
content, antibody binding, and calcium flux over time. For example, calcium ions
play an important role in cell signaling. The intracellular concentration of calcium
ions often show transient changes in response to external stimuli. Several
fluorescent dyes can be used to measure bound Ca++ by flow cytometry,
including Indo-1 (which requires a UV laser) and a combination such as Fluo-3
and Fura Red, which can be used in instruments limited to excitation at 488 nm.
Fluo-3 (with maximal fluorescence at 530 nm) increases its fluorescence with
increasing Ca++ concentration. Fura Red (maximal fluorescence at 650 nm)
decreases its fluorescence with increasing Ca++ concentration. The ratio of Fluo-3
to Fura Red fluorescence can be used to follow changes in Ca++ concentration
over time.

27.1

Inserting a Kinetics Plot
In Kinetics analysis, the X-axis value is Time. Cells are usually stimulated by
adding one or more drugs after a baseline is established at the beginning of the
experiment.
Kinetics plots are a special subset of one dimensional plot that automatically
average all of the Y-axis values per unit of Time and displays one dot (chosen
from Mean, Geometric Mean, Median or % Above Threshold) for each X-axis
value (along with the option of displaying the standard deviation of the Y-axis
value in color).
To insert a Kinetics plot, use the Insert 1D Plots Kinetics command. If
necessary, change the X-axis parameter to Time and format the X-axis range or
resolution to suit your experiment (right-click on the histogram, choose Format
from the pop-up menu, and select the Axis page to adjust the range or the
Kinetics Options Binned Plot Specific Options category to set the
resolution).
An example of a Kinetics plot is shown in Figure 27.1.
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Figure 27.1 Kinetics Histogram (Median
FL1-H vs Time). Standard Deviation
shown in red.

27.2

Formatting a Kinetics Plot
When formatting Kinetics plots, the Overlays category has important properties
which control their appearance. You can format these properties in one of two
ways:
Select the Kinetics plot and use the Format
command.

Plot Options

Overlays

Right-click on the Kinetics plot, select Format from the pop-up menu, and
choose the Overlays page (Figure 27.2).

© 2020 De Novo Software

920

FCS Express 6 Manual

Figure 27.2 Formatting Kinetics Overlays

Choose a Plotting Value, which represents either the method used to average
the Y-axis values (Mean, Geometric Mean, Median, Count) or the % Above
Threshold. Count represents events versus Time (i.e., event rate). If there are
no problems running the sample, Count should be relatively constant.
Using % Above Threshold as a plotting value (Figure 27.3) is useful to
determine what percent of the cells responded in the kinetics analysis. A
threshold value (set in the Threshold field) can either be set manually after
determining a cut-off value from the Y-axis or by inserting one or more statistic
token(s) into a formula 702 .
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Figure 27.3 Plotting the % Above
Threshold Value

The Show Standard Deviation check box controls whether or not one standard
deviation of the Y-axis value is shown (in red) around the plotted value.

27.3

Kinetics Statistics
To display kinetics statistics in a default statistics table(Figure 27.4), right-click on
the Kinetics plot and select Kinetics Statistics from the pop-up menu. Kinetics
statistics can also be inserted as tokens 922 anywhere on your layout.

Figure 27.4 Kinetics Statistics

The default kinetics statistics are explained in the table below. See Formatting
Statistics 387 to choose which statistics to display.
Statistic
Overlay Number

Overlay Legend
Gate
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Explanation
If there are multiple overlays visible on a plot, the statistics will be
calculated for every overlay on the plot. Overlay # displays the
overlay number for that row of statistics. The overlay number
corresponds to the position in the overlay list on the Overlays page
of the Format window.
The default legend is the file name. The legend can be changed in
the Legend Text field of the Overlays page of the Format window.
The gate for which the statistics apply. This region is the 1D gate
on the time parameter.
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Statistic
Start Time
End Time

Explanation
The time at the left marker boundary, or the left boundary of the
plot if there is no gate defined.
The time at the right marker boundary, or the right boundary of the
plot if there is no gate defined..
End Time minus Start Time.
The Y-axis value at the peak.
The X-axis value (Time) at the peak.
Peak Time minus Start Time.

Elapsed Time
Peak Value
Peak Time
Start to Peak
Elapsed time
Start to Peak Slope The slope from the left marker boundary to the peak, or from the
left boundary of the plot to the peak.
Start to End Slope The slope from the left marker boundary to the right marker
boundary.
Rising Phase
What the algorithm determined was the baseline prior to the rising
Baseline
phase starting.
Start Rising Phase The time at which the algorithm determined the rising phase started.
Rise to Peak
Peak time minus Start Rising Phase.
Elapsed Time
Rise to Peak Slope The slope from Start Rising Phase to Peak Time.
Area Under the
Area under the curve in units of the Y-axis.
Curve

Kinetics statistics can be calculated and displayed for the entire plot, or for gated
events. Drawing gates on kinetics plots is advisable when the left boundary of
the plot is not a reliable indicator of the baseline (e.g., when the signal is
unsteady at the beginning of acquisition, or when a drug is added and the return
to baseline is delayed). In such a case, the user may wish to define the baseline
by creating a 1D gate
on the Time parameter of the Kinetics plot. The left
boundary of the 1D gate will define the Start Time statistic and the baseline, and
the right boundary the End Time statistic.
1279

The algorithm is designed to automatically detect the beginning of the rising
phase and the peak.

27.4

Kinetics-Specific Tokens
All of the Kinetics statistics can be used as tokens 688 . Kinetics tokens can be
inserted into text boxes 688 , used in Custom Token 725 or Alert 866 formulas, and
exported to reports during batch processing 833 .
To insert a Kinetics statistics token into a text box:
1. Insert a text box using the Insert General Text Box command.
2. Right-click on the text box and select Insert Token.
3. Choose Statistic and click on the Insert button to bring up the Create
Statistic dialog.
4. Choose a Kinetics plot as a Data Source.
5. Choose the Statistic category.
6. Choose Kinetics Statistics from the Select a Statistic drop down.
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7. Select the Gate, if any, (Figure 27.5). Choose one or multiple statistics
from the list box, then click OK.

Figure 27.5 Creating a Kinetics Statistics Token
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Spectrum Analysis
Spectral flow cytometry is used to sample more parameters per single cell or
particle than traditional flow cytometry. In contrast to conventional flow
cytometers, spectral flow analyzers and sorters substitute mirrors, optical filters,
and photomultiplier tubes (PMTs) with a spectrograph and multichannel detector
to use fluorescence or Raman spectroscopy.
FCS Express has the capability to read and display raw spectral data from Cytek
and Sony instruments 27 through Spectrum Plots 926 . Spectral data plotted in
Spectrum plots links directly the standard flow cytometry single cell
measurements to allow seamless transitions between standard flow cytometry
analysis and spectral cytometry analysis.

Supported Data Formats:
Sony Instruments:
o Spectral data is stored with the .SRAW file format with both an .SRAW and
.FCS file being produced. To analyze data from Sony instruments in spectrum
plots the .sraw and .fcs files produced by the instrument must be placed in
the same source folder. The names of the .SRAW and .FCS files must match.

o Cytek Instruments: Spectral data is stored with the standard .FCS file
format however two files will be produced, an "unmixed" data file and a
"mixed" data file. The unmixed data file will have the same name as the
mixed data file except it will use a suffix of "Unmixed" in the data file name.
For instance:
sample1.fcs and sample1_Unmixed.fcs
The file containing the suffix of "Unmixed" contains the FCS file data that
was unmixed via the Cytek system while the file with the standard file name
remains unmixed.
To view spectrum plots for the unmixed data set both data files most be
placed in the same source folder with the names matching except for the
"Unmixed" suffix.
To view spectrum plots for the mixed data set, only the original file without
the "Unmixed" suffix must be present.

28.1

Inserting a Spectrum Plot
Spectrum Plots are a special subset of the one-dimensional plot type that
displays spectra for all events within a gating strategy as individual lines or an
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average of all events within a gating strategy as one line. Spectral lines for cells
or particles are displayed as Counts (Y-axis) vs. wavelength from 500 nm to
800 nm (X-axis) for the specified laser line. Compensations 622 and/or
transformations 934 may be applied to spectra displayed.
Data can be presented in the spectrum plot with one spectrum line per event
(Format
Overlays to show All Spectrums
command) or one line as an average of events (Format
Overlays to show Average command). The color of
each line will reflect the color of the gate in which the event falls if Overlay to
show is set to All Spectrums. If set to Average, the color will be derived from
Line options 277 color. See Formatting a Spectrum Plot 928 for more information
on these and other formatting options.
To insert a Spectrum plot, first ensure that the data files meet the requirements
for the data format 926 . Then, use the Insert 1D Plots Spectrum command
(Figure 28.1).

Figure 28.1 - Insert Spectrum Plot command

An example of a Spectrum Plot is shown below in Figure 28.2.

Figure 28.2 - Inserted Spectrum Plot

Spectrum Plots can be formatted
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averages, population density, and more.

28.2

Formatting a Spectrum Plot
Formatting options specific to Spectrum Plots are pictured below and include:
Plotting All spectrums or Average ( ), or Average Showing Standard
Deviation ( )
Setting Display Mode to Color on Gated/Overlays or Density ( )
Interpolating values with desired number of Interpolation points ( )
To access these formatting options, either
Select
the Spectrum plot(s) and use the Format tab Plot
Options Overlays or Specific Options command, or
1218

Right-click on the Spectrum plot, select Format from the pop-up menu, and
choose the Overlays or Spectrum Plot Specific Options category (Figure
28.3).

Figure 28.3 - Formatting options specific to Spectrum Plots.

These formatting options specific to Spectrum Plots are detailed in the table
below. Standard formatting options for Spectrum Plot overlays are listed here
.
Option
Overlay to
show

279

Explanation
All spectrums shows each event as an individual line or dot (left);
Average shows the average of all events as one line or dot (center);
Average with Show Std Dev
additionally plots the Standard Deviation
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Option

Explanation
as a red dot or line above and below the Average (right).

Display Mode

The colors in Color on Density mode (left) reflect population density of
events; the colors in Color on Gated/Overlays mode (center and
right) reflect the following, depending on the number of overlays 277 :
for plots with 1 overlay (center), the gate to which each event
belongs (only for gates selected in the Display Gates Option 281
) (e.g., pink for events in the "2D plot gate" below and the
base color of the overlay (e.g., blue, below) for cells not in one
of the selected gates).
for plots with >1 overlay (right), the overlay (e.g., red for
Overlay 1, and green for Overlay 2).

Interpolate
values

FCS Express can interpolate values to impart a smoother look to your
data, so that each event is depicted as a continuous line rather than an
array of discrete values. Below are examples of plots with no
interpolation (left), and 5 (center) and 50 (right) Interpolation Points
between each value.

Interpolate values is also applicable to Spectrum Plots with the Color
on Density Display Mode:

Please note that interpolation does impact the speed of displaying the
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Option

Explanation
plots. Thus, it is recommended to use the lowest interpolation value
that provides the desired plot appearance.

Resolution

Increase or decrease the display resolution, or number of bins, of the
Y-dimension of the plot.
Superimposes a grayscale shading pattern based on the density of
plotted data. When gates are displayed on a Spectrum Plot in the Color
on Gated/Overlay Display Mode, the shading pattern will be
pseudocolored to match the color of the gate displayed. A lighter shade
represents a higher density. Note that this option will not apply if
multiple overlays are displayed on the Spectrum Plot.

Shade Based
on Density

NOTE: In addition, the formatting options shared by all objects
exist for Spectrum Plots.

238

and plots

245

Below are some example of Spectrum plot customizations.
Figure 28.4 displays two Spectrum Plots with the Display Mode option set to
Color on Density (Option
in the table above) and a Spectrum plot showing
two Overlays as Average (Option
in the table above). Please note that a
legend 251 is also displayed in the latter.

28.4 Example of Spectrum plot customizations.

Figure 28.5 shows a Spectrum plot with three Overlays as an Average (Option
in the table above). Please note that a legend 251 is also displayed.
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28.5 Example of Spectrum plot customizations.

28.3

Gating and Backgating on Spectrum Plots
Gates may be created on 318 and applied to
other plot type in FCS Express.

350

Spectrum Plots, much like any

Gating and backgating each work bidirectionally between Spectrum Plots and
other plot types. In other words, gates can be:
created on Spectrum Plots and applied to 350 / backgated onto 302 other
plot types (Figure 28.6)
created on other plot types and applied to 350 / backgated onto 302
Spectrum Plots (Figure 28.7)

Figure 28.6 - Gate created on Spectrum Plot and applied or backgated onto a Color
Dot Plot.
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Figure 28.7 - Gate created on Color Dot Plot and applied or backgated onto a
Spectrum Plot.

28.4

Overlaying Spectrum Plots
Spectrum Plots can be overlaid upon one another 277 (e.g., Figure 28.8), in the
same way that overlays are added to histograms and other plots in FCS
Express. For details on creating and formatting these overlays, see the Overlays
subtopic of Formatting 1D Spectrum Plots 277 .

Figure 28.8 - Spectral plot with two overlays from different spectral datafiles,
each with a different gate applied.
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Transformations
The Transformations navigator is access via the Tools
tab
button. The transformations
navigator (Figure 29.1) will launch and new data transformations may be added
by clicking on the down arrow next to the blue plus button. The following
transformations are currently available in FCS Express:
Parameter Math 935
Principal Component Analysis (PCA) 948
K-Means cluster analysis 960
R Integration 975 for adding new parameters 984 and cluster transformations 992
tSNE transformation
SPADE
Please also note our sections on Merging / Concatenating files 656 which is often
used for tSNE and SPADE data sets.
1002

1024

Figure 29.1 - The transformations navigator in FCS Express. Clicking on the down
arrow next to the blue plus button allows access to a variety of transformations.
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Parameter Math
Parameter Math is a tool that allows you to create new parameters or change
current parameters, based on mathematical combinations, or formula
sequences, of existing parameters for a data file.
Continue to:
Defining Parameter Math 935
Applying Parameter Math 943

29.1.1

Defining Parameter Math
Formula sequences may be single calculations or a series of calculations. There
may be situations where you want to perform a series of parameter math
calculations. Although it is possible to perform many calculations in a single
formula 935 , sometimes it is necessary to store and plot the intermediate results
of a calculation, which makes parameter math sequences very useful.
To create new parameter math, complete the following commands:
1. Select the Tools Transformations Transformations command to open
the Transformations dialog.
2. In the Transformations dialog, click the down arrow to the right of the blue
plus
to open the drop down menu and select Parameter Math (Figure
29.2).
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Figure 29.2 - Transformation command on ribbon and Transformation Dialog with
Add New drop down menu displayed

If no plots are inserted into the layout when adding new parameter math, a
Template File will need to be selected by clicking the ... button (outlined in
red in Figure 29.3 below) to open the Select data file dialog. This button will
also need to be used if plots are inserted and a different file is preferred to be
used rather than the selected file. If preferred, a gate may also be selected in
this dialog by selecting the gate of interest from the Gate drop down list.
Parameter math will only be performed on cells that are accepted by the
gating formula listed. The calculation will be performed on all cells in the file if
No Gate is selected from the drop down list.
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Figure 29.3 - Select Template File from Transformations dialog

3. Once the Template File and Gate have been selected, click New to access
Create New Sequence Item dialog (Figure 29.4).
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Figure 29.4 - Transformations Dialog with Template File Selected

The Output Parameter field controls where the result of the calculation will
be stored. It can either be New, in which case a new parameter will be
created, or you can select a currently existing parameter, which will overwrite
that parameter (Figure 29.5 below). If you are creating a new parameter,
you can enter the name of the new parameter in the Output Parameter
Name field.
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Figure 29.5 - Output Parameter drop down list in Create New Sequence Item
dialog

There are two ways to set up a Parameter Math calculation: Single or
Formula. Click on the appropriate radio button to select either Simple or
Formula for parameter math entry.
For typical calculations, the Simple approach is usually easiest. Select the
First Input Parameter, followed by the mathematical operation [only
addition (+), subtraction (–), multiplication (*), and division (/) are
supported], and then the Second Input Parameter. The Second Input
Parameter can also be a constant, in which case an entry field will appear
below the Second Input Parameter allowing you to enter the constant
value.
A more complicated but flexible way to set up a Parameter Math calculation is
to enter a Formula directly. The formula has the advantage that you can
combine multiple parameters, including regular and custom tokens 688 , along
with different calculations, in a single formula. Formulas are entered as
mathematical equations. Each parameter is represented by Pn, where "n" is
the parameter number. Some valid formulas are:
P1+P2
(P1+P2)/(P4-100)
sin(P3)/cos(P4)
Functions can also be inserted in the Formula. To enter a token or a function
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into your equation, right-click on the Formula field and choose Insert Token
or Insert Function from the pop-up menu (Figure 29.6).

Figure 29.6 Inserting a Token into a Parameter Math Formula

In addition to inserting tokens, you can use the word Row as a special
keyword in Parameter Math formulas. Row refers to the cell number column
in a data grid 676 . For example, the formula P1+Row would add 1 to the P1
parameter for the first cell, 2 for the second cell, and so on. The Row
keyword is also useful for creating parameters with increasing values, such as
a time parameter.
The Evaluate tokens before adding to data checkbox controls whether or
not tokens added to the formula will remain as tokens in the resulting data
parameter. If that box is checked (the default), you will only see a single,
calculated result in the new parameter column in a data grid. If it is
unchecked, the value of the individual components of the formula (e.g.,
tokens or special keywords) will appear separately within the data grid cell, so
that you can see the contribution of each component.
A comprehensive set of all formula operators and functions
This available set is the same for Custom Tokens.

766

is available.
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If the parameter math calculation uses a simple calculation, or if the
calculation uses a formula and the checkbox Evaluate tokens before
adding to data is checked, then the results of the operation will be stored as
floating point numerical values. If the parameter math calculation uses a
formula, and the checkbox is unchecked, then the results will be stored as a
formula.
Any final results that are above the maximum channel value in the FCS file are
either truncated to the maximum value or stored without truncation,
depending on the setting of the Math Range Checking option on the General
page of the FCS Express User Options dialog 180 .
4. To create the new sequence item, click the OK (Figure 29.7).

Figure 29.7 - Finish calculation creation in Create New Sequence Item dialog

It will now appear in the Formula Sequence box (outlined in red in Figure
29.8 below) of the Transformations dialog.
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Figure 29.8 - Newly created calculation added to Formula Sequence box of
Transformations dialog.

You can delete a sequence: select it in the Formula Sequence box and click the
Delete button. To edit the sequence, select it and click the Edit button. These
commands may be accessed by right-clicking within the Formula Sequence box
as well. You may also save or load a sequence by right-clicking within the
Formula Sequence box. See right-click menu below in Figure 29.9.
After adding or selecting Parameter Math in the Transformations dialog, the
right-click in Formula Sequence box
command brings
up a standard dialog to save your Parameter Math Sequence (*.fcf).
After adding or selecting Parameter Math in the Transformations dialog, the
right-click in Formula Sequence box
command
brings up a standard dialog to load a saved sequence.
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Figure 29. 9 - Right-click menu for Formula Sequence box of Parameter Math in
Transformations dialog

29.1.2

Applying Parameter Math
The new parameters derived by Parameter Math can now be applied to any plot
or data grid in FCS Express, and they can be chosen from the list of available
parameters (Figure 29.10 below). Please note only one transformation may be
applied at a time for each plot or data grid selected.
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Figure 29.10 - Parameters created in Parameter Math can be accessed as standard
parameters

Once parameter math has been used to define new parameter(s), it may be
applied to any plot and data grid in FCS Express. Standard gating and statistics
may be used to study the result of the parameter math.
Note: When Parameter math has been applied, the text "Parameter Math
applied" will appear in the plot title.
Parameter math may be applied to 1D and 2D plots by either of the following
methods:
Drag and drop a parameter math from the Transformations navigator to the
intended plot (Figure 29.11).
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Figure 29.11 - Applying parameter math to a plot by dragging from the
Transformations navigator to the plot (red arrow).

Access the Formatting Overlays dialog 283 and choose the parameter math to
apply from the Transformation drop down list (Figure 29.12).

Figure 29.12 - Applying parameter math to 1D (left) or 2D (right) plots by
selecting the parameter math in the Transformation drop down from the
Formatting Overlays dialog.

Parameter math may be applied to data grids by any of the following methods:
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Drag and drop a parameter math from the Transformations navigator to the
intended data grid (Figure 29.13).

Figure 29.13 - Applying parameter math to a plot by dragging from the
Transformations navigator to the data grid (red arrow).

Access Formatting dialog for general options 309 .
parameter math to use from Transformation drop down list
29.14).

select
. (Figure
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Figure 29.14 - Applying parameter math to a data grid by selecting the parameter
math in the Transformation drop down from the Formatting Overlays dialog.

Right-click data grid Show Transformed Values
parameter math from menu.(Figure 29.15).

select appropriate

Figure 29.15 - Accessing parameter math by right-clicking data grid and navigating
to Show Transformed Values menu.
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Principal Component Analysis
Principal Component Analysis (PCA) is a statistical procedure that uses an
orthogonal transformation to convert a set of observations, in this case
cytometry based events, into new variables called principal components. The
transformation is defined in such a way that the first two principal components
generally define the maximum variance while each succeeding component
maximizes the variance at a 90 degree rotation. Principal components defined
and applied to a plot in FCS Express are accessible for analysis as new
parameters on plots.
To begin working with PCA analysis in FCS Express please see the topics on:
Defining a PCA Transformation 948
Applying a PCA Transformation 958

29.2.1

Defining a PCA Transformation
Principal Component Analysis is performed in FCS Express through the
Transformation window.
The steps below outline the process of creating a new PCA transformation on
your data:
1. Open the Transformation window by selecting the Tools tab
command. The Transformations
window will open (Figure 29.16, Step 1).
2. Click on the dropdown arrow adjacent to the blue plus
below, Step 2).
3. Click on PCA in the dropdown list (Figure below, Step 3).

button (Figure
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Figure 29.16 Initial steps to create a new PCA transformation.

The PCA dialog will now appear in the Transformation window as seen in Figure
29.17.
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Figure 29.17 The PCA dialog in the Transformations window

The new PCA transformation is named as New PCA by default but it can be
easily renamed by either of the following methods:
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Select

Rename.
Select the PCA transformation that need to be renamed via left click and press
F2 on your keyboard.
Select the PCA transformation that need to be renamed via left click and click
on the

button in the Transformations tool bar.

4.Choose a Template File for the PCA transformation by clicking on the ellipsis
to the right of the Template File text box (Figure 29.18).
The PCA dialog will be populated with a list of available parameters to perform
a PCA transformation based on available parameters from the template file
(Figure below).
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Figure 29.18 A template file has been chosen which subsequently populates the list
of possible parameters to perform a PCA transformation.

5.Choose the parameters to define the transformation by checking the boxes
next to the parameter names (Figure 29.19, Step 1).
6.Choose or change to the appropriate Parameter Scaling Options for each of
the selected parameters if required (Figure below, Step 2).
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Figure 29.19 Parameters for the PCA transformation are selected by checking the
boxes next to the parameter names.

The PCA transformation has now been defined and automatically calculated by
default. The PCA transformation can now be applied to any plot in FCS Express
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(see, Applying a PCA Transformation

958

).

Note the following options:
A gate may be selected to only evaluate the matrix for events falling within the
gate from Gate dropdown menu.
Sampling Options (optional). Although multiple Sampling Methods are
available (please refer to the Sampling Options

1038

chapter for more details), the

default Downsampling Method for PCA is None, thus all available events (i.e.
the ones defined with the Gate drop-down menu) will be used.
The Parameters to keep option allows you to define how many principal
components are defined for the data set (the figure below depicts an example
in which 3 parameters have been kept).
The Output Style choices are:
o Append to initial data adds the newly created principal component (PC)
parameters to the end of the parameter list in the data file when the PCA is
applied (Figure 29.20, left).
o PCA only only displays the PC parameters on a plot when the PCA is applied
(Figure below and right).

Figure 29.20 PCA transformation Output Styles

To defer calculating the PCA matrix, uncheck the box for Automatically
Calculate PCA Matrix. Doing so will present you with the button to Calculate
the PCA Matrix (Figure 29.21).
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Figure 29.21 Unchecking the Automatically Calculate PCA Matrix box will defer
calculating the PCA matrix.

After pressing the button to Calculate the PCA Matrix the matrix will be
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displayed in the bottom pane of the window (Figure 29.22).
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Figure 29.22 Once the Calculate PCA Matrix button is pressed the matrix will be
calculated and shown in the dialog.
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Applying a PCA Transformation
Once a PCA transformation has been defined 948 , it may be applied to any plot in
FCS Express. Once a PCA is defined and applied to a plot, standard gating and
statistics may be used to evaluate the new principal component parameters.
Note: When a PCA transformation has been applied, the text "PCA
transformed" will appear in the plot title.
PCA transformations may be applied to 1D and 2D plots by either of the
following methods:
Drag and drop a PCA transformation from the Transformation window to the
intended plot (Figure 29.23).

Figure 29.23 Applying a PCA transformation to a plot by dragging the PCA
transformation from the Transformations navigator to the plot (green arrow).

Access the Formatting Overlays dialog 283 and choose the PCA to apply from
the Transformation dropdown menu (Figure 29.24).
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Figure 29.24. Applying a PCA transformation to a plot by selecting the PCA
transformation from the Transformation dropdown in the Formatting Overlays
dialog.

The result of both method will be the following (Figure 29.25). Please note the
suffix "PCA transformed" in the plot title.

Figure 29.25. 1D and 2D plot with PCA transformation applied. Note the "PCA
Transofrmed" suffix in the plot title.

Principal Component will be accessible as additional or as unique plot parameters
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based on the selected output style (see the previous section
about this) (Figure 29.26).

948

for more info

Figure 29.26 - PCA Transformation output styles.

29.3

K means (Cluster Analysis)
FCS Express can perform cluster analysis using k-means methodology.
Cluster analysis aims to group a set of objects/events in such a way that
objects/events in the same group (i.e. a cluster) are more similar (in some
sense or another) to each other than to those in other groups (i.e. the other
clusters).
k-means is a partitioning-based clustering algorithm. k-means method for
clustering is an iterative process in which an initial partition of given k clusters is
then improved by applying a search algorithm to the data. Simplifying, given a
pre-defined number (k) of clusters, the algorithm:
-

begins with an initial set of k cluster centers (i.e. the centroids)
(re)assigns objects to the closest centroids
recalculates centroids according to new memberships of the data points.
repeats the last two steps until a consistent result is found or until the
maximum number of iterations is reached.

The basic k-means clustering is based on a non-deterministic algorithm. This
means that running the algorithm several times on the same data, could give
different results. However, to ensure consistent results, FCS Express performs kmeans clustering using a deterministic method.
To begin working with cluster analysis in FCS Express please see the topics on:
Defining a k-means Clustering Analysis 961
Applying a k-means Clustering Analysis 970
Working with k-means parameters 972
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Defining a k-means cluster analysis
k-means cluster analysis is performed in FCS Express through the
Transformation button within the Tools tab

The steps

below outline the process of creating a new k-means cluster analysis on your
data.

1. Open the Transformation window by selecting the Tools
tab

Transformations command (Figure below, Step 1).

2. Click on the drop down arrow adjacent to the blue plus

button (Figure

below, Step 2).
3. Click on Kmeans in the drop down list (Figure 29.27, Step 3).
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(Figure 29.27) - A Kmeans transformation can be created via the Transformations
navigator.

The Kmeans dialog will now appear in the Transformation window as seen in
Figure 29.28.
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Figure 29.28 - The Kmeans dialog opens when a new k-means transformation is
created.

The new Kmeans transformation is named as New Kmeans by default and it
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can be easily renamed by either of the following methods:
Right click on the Kmeans transformation that needs to be renamed

Select

Rename.
Select the Kmeans transformation that need to be renamed via left click and
press F2 on your keyboard.
Select the Kmeans transformation that need to be renamed via left click and
click on the

button in the Transformations tool bar.

4. Choose a Template File for the k-means clustering by clicking on the ellipsis
to the right of the Template File edit box.

Once the file of interest has been selected, the dialog will be populated with a
list of available parameters to perform a k-means clustering based on available
parameters from the template file (Figure 29.29).
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Figure 29.29 - A template file has been loaded into the New Kmeans dialog.

5.Choose the parameters to define the Kmeans clustering by checking the boxes
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next to the parameter names (Figure 29.30, Step 1).
6.Choose or change to the appropriate Parameter Scaling Options for each of
the selected parameters if required (Figure below, Step 2).
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Figure 29.30 - Choosing the parameters to perform k-means cluster analysis.
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A number of options can be set at this point:
6. (Optional) Select a gate from the Gate drop down if you are interested in
performing the clustering only for the events belonging to it.
7. Sampling Options (optional). Although multiple Sampling Methods are
available (please refer to the Sampling Options

1038

chapter for more details),

the default Downsampling Method for k-Means is None, thus all available
events (i.e. the ones defined with the Gate drop-down menu in Step 6) will be
used.
8. Set the Number of Clusters the events should be clustered by. It's
equivalent to the number of centroids.
9. Set the number of Maximum Iterations. This value indicate the maximum
number of iterations that FCS Express should perform before quitting the
clustering process.
10. Set the Minimum Percent of Cells Per Cluster. This value indicates the
minimum size, in term of percentage, of clusters.
10. Set Output Style for Kmeans clustering.

The available choices are Clustering Assignments and Clustering Statistics.
Please see the detailed list below explaining each option.
Clustering Assignments: By selecting this output style, the following
statistics can be assigned to each event the cluster has been performed
on:
o Cluster Assignment: An internal label indicating the cluster membership
is automatically assigned to each event. This label is internally used by
FCS Express for heatmap representation of clusters but it is also
accessible through a Data grid

676

.

o Distance to Cluster Centroid: The distance of a given event to the
centroid of its cluster. Values are plotted as unique histogram.
o Distance to centroid Histograms: The same as the Distance to
Cluster Centroid but in this case values are grouped, and thus plotted,
separately for each cluster. Clusters are numbered from 1 to Number
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of Clusters.
o Gaussian CV SSE Scaled: In this representation each event is plotted
based on its cluster membership, thus clusters appear as separated
histograms. Given that cluster membership is an integer value that goes
from 1 to Number of Clusters, an artificial noise is introduced to
spread out the data. Gaussian SSE scaled means that the standard
deviation of the Gaussian (normal distribution) used to represent each
cluster is proportional to the Sum of Squared Error of the cluster.
o Gaussian CV Unscaled: In this representation each event is plotted
based on its cluster membership, thus clusters appear as separated
histograms. Given that cluster membership is an integer value that goes
from 1 to Number of Clusters, an artificial noise is introduced to
spread out the data. Gaussian CV unscaled means that the standard
deviation of the Gaussian (normal distribution) used to represent each
cluster is the same among clusters.
o Gaussian Y Data: Events are plotted following a Gaussian (normal
distribution).

Clustering Statistic: By selecting this output style, the following statistics
will be accessible through plots and Data grid

676

:

o Kmeans Cluster ID: An integer value that goes from 0 to Number of
Clusters-1.
o Centroid coordinates: The coordinates of each centroid are given for
each of the parameters considered for the clustering.
o Sum Of Square (WCSS): The Within-Cluster Sum of Squares is
reported for each cluster.

The following table lists the objects suitable for displaying each output style:

Clustering
Assignment
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Assignment

Can be displayed as
Heatm 1D or 2D Data
ap
plots
grid
Y
Y
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s

Distance to
Cluster Centroid
Distance to
Centroid
Histograms
Gaussian CV
SSe Scaled
Gaussian CV
Unscaled
Gaussian Y Data

Clustering
Statistics

Y

Y

Y

Y

Y

Y

Y

Y

Y
Y

Y
Y

11. The k-means clustering has now been defined and automatically calculated.
k-means clustering can now be applied to plots for display and analysis. (see
Applying a k-means Cluster Analysis

29.3.2
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).

Applying a k-means cluster analysis
Once k-means clustering has been performed, results can be accessed as 1D
plots, 2D plots 171 , Heatmaps
and Data Grid 676 depending on the selected
output style (see the previous section 961 ). The Cluster Assignments chosen to be
calculated 968 may be accessed on plots on which the transformation has been
applied as new parameters 972 .
1048

Although clustering results are automatically displayed when inserting a Data grid,
to access clustering results as parameters in 1D plots, 2D plots and/or
Heatmaps, the k-means transformation must be applied to the plots.
k-means clustering may be applied to 1D plots, 2D plots and heatmaps by either
of the following methods:
Drag and Drop (Figure 29.31)
1. Left click and hold on k-means clustering from the Transformation window.
2. Drag the Kmeans to the intended plot.
3. Release the mouse button.
The Kmeans will be applied to the plot and the title of the plot will now include the
text "Kmeans clustered" 972 to indicate the transformation has been applied.
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Figure 29.31 Applying a k-means transformation to a plot by dragging the k-means
transformation from the Transformation navigator to the plot (green arrows).

Using the Formatting Dialog (Figure 29.32)
283 (for 1D plots, 2D plots and Heat
1. Access the
309
map) or the
(for Data Grids).
2. Choose the Kmeans to apply from the Transformation drop down.
3. Click OK.

Figure 29.32 Applying a k-means transformation to a plot by selecting the k-means
transformation from the Formatting Overlays dialog in the Transformation
dropdown.
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The result of both the previous methods is represented in Figure 29.33 below.
When a k-means clustering has been applied to a plot or to an heatmap, the
suffix "Kmeans clustered" will appear in the object title.

Figure 29.33 The plot title contains "Kmeans clustered" siffix when a Kmeans
transformation is applied.

In the next section we will see how to work with clustering parameters

29.3.3

972

.

Working with k-means parameters
Once a k-means transformation is applied to a plot, the newly created Cluster
Assignment parameters can be accessed by clicking on the axis label of the plot
Figure 29.34. Please note that heatmaps can only display Cluster
Assignments, which is automatically displayed when a k-means transformation
is applied.
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Figure 29.34 Newly created pareameters can be accessed by clicking on the axis
label of the plot of interest.

Gates 316 can now be created on the following Cluster Assignment parameters
to specifically select the events within one or more clusters.:
Cluster Assignments (heatmap only),
Distance to centroid Histograms(1D/2D plot only),
Gaussian CV SSE Scaled (1D/2D plot only),
Gaussian CV Unscaled (1D/2D plot only),
These gates can then be used to back gate
parameters.

302

clustered events on non-clustering

Here are some examples of cluster selection using the above-mentioned
parameters:
1D plots
Markers can be created on 1D plot displaying clustering parameters as one would
on non-clustering parameters. After converting the marker to be a gate 364 , that
marker can be used to back gate clustered events on non-clustering parameters
(Figure 29.35).
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Figure 29.35. Markers can be used to select cluster on 1D plot displaying a
clustering parameter. Gate 1 was defined on a density plot and events within it
have been clustered. Gate 1 has also been then applied to the k-means
transformed histogram. Markers from the histogram were converted to gates and
back gated onto the CD4 vs CD3 dot plot.

2D plots
Gates can be created on 2D plots displaying clustering parameters as one would
on 2D plots displaying non-clustering parameters. In the example below gates
have been created on a 2D plot displaying clustering parameters on both X and Y
axis but please consider that a clustering parameter can be displayed together
with a non-clustering parameter as well (Figure 29.36).

Figure 29.36. Gates can be used to select clusters on 2D plot displaying one or
more clustering parameters. Gate 1 was defined on a density plot and events
within it have been clustered. Gate 1 has also been then applied to the k-means
transformed plots. In this example 1D Gates (i.e. Markers) have been used to
select Cluster 2 and Cluster 3. Events in those gates have been back gated onto
the CD4 vs CD3 dot plot.

Heatmaps
Clustering Assignments are automatically displayed on heatmaps when a
transformation is applied to them. Well gates
can then be used to select one
or more clusters (i.e. wells) and then used for downstream analysis. In the
following example (Figure 29.37) two well gates have been created on cluster 2
and 3 (well gate 2 is red highlighted on the heatmap).
1059
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Figure 29.37. Well gates can be used to select clusters on heatmaps. Gate 1 was
defined on a density plot and events within it have been clustered. Gate 1 has also
been then applied to the k-means transformed plots. In this example Well Gates
have been used to select Cluster 2 and Cluster 3. Events in those gates have been
back gated onto the CD4 vs CD3 dot plot.

29.4

R Integration
FCS Express can integrate R scripts via the new R integration tools in the Tools
934 button which will launch the
Transformations navigator. Please refer to www.r-project.org to learn more
about R. The goal of R integration and implementation in FCS Express is to allow
users to run their own R scripts and work on the resulting output directly within
FCS Express as new parameters and cluster transformations. If you have any
questions about R integration with FCS Express after reading the topic
information below do not hesitate to contact support@denovosoftware.com.

Note: On the PC version of FCS Express, R and any R packages required to run R
scripts, need to be installed in order to take advantage of the R integration tools.
The MAC version of FCS Express does not require R to be installed on the
machine. However, any R package required to run the user's R script, needs to
be installed in order to take advantage of the R integration tools. Please refer
the Installing R packages on the MAC version of FCS Express 6 978 chapter
to learn more on how to install R packages on the MAC version of FCS Express.
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Enabling R integration in FCS Express
FCS Express integrates R via an External Application Bridge that can be
enabled in the Startup User Options 206 by going to File Options Startup and
checking the box for Start the De Novo Software External Application
Bridge on login (29.38).

Figure 29.38 Enabling the External Application Bridge at the FCS Express startup to
integrate R.

FCS Express must then be closed and reopened, including the startup screen.
The next time that FCS Express is launched, a Windows Security Alert
message by Windows Firewall may pop up under Windows environment. If this
happen, please check both options in order to allow DNSEABridge to
communicate on both Private and Public Network, and the click Allow access
(Figure 29.39).
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FIgure 29.39 The Windows Security Alert by Windows Firewall that may pop up
under Windows environment.

Once FCS Express will be launched, an icon referring to the External Application
Bridge will appear in your tray confirming that the External Application Bridge is
active (Figure 29.40 and Figure 29.41).
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29.40 The External Application Bridge icon
as it appears in the Windows tray.

29.41 The External Application Bridge icon as it appears in
the macOS tray.

29.4.2

Installing R packages on the MAC version of FCS Express
MAC users running FCS Express can install R packages by running one of the
following two scripts directly within FCS Express via either the R Add
Parameters or the R Cluster Transformation module. The scripts download
and install the packages of interest and create a text log report. The log report
can be used to check that the installation worked properly and that the packages
of interest can be loaded. The name of the log report file will be in the form
"FCSExpress installation report YYYY-MM-DD.txt", where YYYY-MM-DD is the
current date. The output directory can be defined by the user (see below).
Two scripts are available base on the repository (CRAN or Bioconductor) the
package is on. Please, chose the script suitable for you.

##Bioconductor Packages Installation for MAC users
Execute <- function(mat)
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{
FCSE6_log_file <- file(paste0("A/FCSExpress installation report
",Sys.Date(),".txt"), open="wt") ##creating the file and opening it
for writing
sink(FCSE6_log_file, type="message") ##diverting R messages to
the file
##Installing the required packages
source("https://bioconductor.org/biocLite.R")
biocLite("B",suppressUpdates=TRUE)
##Checking that the installed package can be properly loaded
library("B")
sink(type = "message") ## reset sink
close(FCSE6_log_file) ##close the file
}

##CRAN Packages Installation for MAC users
Execute <- function(mat)
{
FCSE6_log_file <- file(paste0("A/FCSExpress installation report
",Sys.Date(),".txt"), open="wt") ##creating the file and opening it
for writing
sink(FCSE6_log_file, type="message") ##diverting R messages to
the file
##Installing the required packages
install.packages("B")
##Checking that the installed package can be properly loaded
library("B")
sink(type = "message") ## reset sink
close(FCSE6_log_file) ##close the file
}

Where A and B are defined by the user as follow:
A: is the path where the text log report will be saved (e.g. /Users/YOURNAME/
Desktop).
B: is the name of the package that need to be installed.
Please do the following before proceeding with the installation:
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1. Open a text editor (e.g. TextEdit / NotePad).
2. Copy and past one of the scripts above into a blank page (either the
Bioconductor Packages Installation for MAC users or the CRAN
Packages Installation for MAC users).
3. Complete the script by inserting A and B.
4. Save the script using ".R" (without quotes) as the file extension.

Now that the R script is ready, you can run it in FCS Express via the R Integration
tools by following the next steps:
1. Be sure that the R Integration is enabled (if not, please see the Enabling R
integration in FCS Express

976

section of this chapter)

2. Open the Transformation window by selecting the Tools
tab

Transformations command from the ribbon bar.

3. Click on the drop down arrow adjacent to the blue plus

button.

4. Select either the R Add Parameters or the R Cluster Transformation.
5. Click on the ellipsis at the right of the Template File field to browse for a
template *.FCS file. The Transformation window will be populated with the
parameters contained in the selected *.FCS file.
6. Select any of the available parameters.
7. Click on the ellipsis at the right of the R Script File field to browse for the R
script created few steps ago.
8. Apply the transformation to any plot of your layout. This can be done via
either Drag and Drop

989

or via the Formatting dialog

990

.

9. A text log report will be generated in the A location.

In order to check that the installed packages can be properly loaded, you can
simply open the text log report and check the output messages (if any)
generated in response to the library("B") command.
Please, do not hesitate to contact us at support@denovosoftware.com for any
question you may have.

© 2020 De Novo Software

Transformations

29.4.3

981

Introduction to R integration in FCS Express
Although any R function can be run by FCS Express via the R integration tool, the
user should consider the following specifications for creating the R script
containing the function of interest:
1. The user's functions need to be included in a general function named Execut e
and defined as follow:
Execute <- function(mat) { }
2. The input of the Execut e function, mat , is a matrix of fluorescence values. FCS
Express allows the user to select which parameters and which events will be
included the matrix, as well as the matrix orientation, thus to keep events in
rows and parameter in columns (Figure 29.42, on the left) or vice-versa (Figure
below, on the right).
Please note that the name of the parameters included in the mat matrix will be
accessible in R by using the rownames() or the colnames() functions (when
parameter are in rows and in columns respectively).

Figure 29.42. The mat matrix used as input by the Execute function.

3. The aim of the above-mentioned Execut e function is to place the user defined
data and meta data together in an S4 object suitable to be used by FCS Express.
4. The output of the Execut e function is an S4 object containing the user defined
data and the metadata. The output represents the new input for FCS Express.
The workflow of how R integration works in FCS Express is given in the figure
below (Figure 29.43).
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Figure 29.43. Simplified schematic of R integration
with FCS Express.

FCS Express currently supports two types of S4 objects as input:
1.R Add Parameter 984 - The method is suitable for adding new columns to the
mat matrix. Columns must contain numeric values and can be named.
2.R Cluster Transformation 992 -The method is suitable for cluster based
analysis. A column containing the cluster membership of each event is added
and clusters may be labeled.

Both input methods can be accessed by selecting the Tools
tab
Transformations command to launch the
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Transformations navigator. Clicking on the drop down arrow adjacent to the
blue plus
button (Figure 29.44) will reveal the R Add parameters 984 and R
Cluster Transformation 992 modules described above and presented in further
detail in the next sections:
Jump to:
R Add parameters 984
R Cluster Transformation

992

Figure 29.44. Selecting the input method for R integration scripts.
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29.4.4

R Add Parameters
New parameters can be added to a file of interest using the R Add Parameters
input method.
To be compatible with the R Add Parameters method, the Execute function
defined in the R script should result in an S4 object containing the following slots:
1. numberOfNewParams : integer of the number of new parameters;
2. newParamData : numeric matrix with the data for the new parameters. It
has to be oriented with events in columns and parameters in rows, irrespective
of the orientation set for the mat matrix;
3. newParamNames : character vector containing the names of new
parameters.
A general example of an R script compatible with the R Add Parameters input
method follows:
Execute <- function(mat)
{
setClass("TransformationResult",
representation(
newParamData="matrix",
numberOfNewParams="integer",
newParamNames="character"
),
prototype(
newParamData=c(),
numberOfNewParams=as.integer(0),
newParamNames=""
)
)
result <- new("TransformationResult")
result@numberOfNewParams <- as.integer(A)
result@newParamData <- B
result@newParamNames <- C
return(result)
}
Where A, B and C values are defined by the user. As stated above:
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A can be any integer number. Note that the as.integer() function is required
since numbers are otherwise stored as object of class numeric.
B can be the result of any user-defined transformation. B must be an object of
class matrix with events in columns and parameters in rows. The number of
events (i.e. the number of columns) must match the number of events in the
mat matrix and the number of parameters (i.e. the number of rows) must
match the value defined in A.
C is a vector of class character containing the names of the new parameters.
Multiple names can be specified using the c() function (e.g.
c("name1","name2","name3") ). Please also note that the name of the
parameters included in the mat matrix are accessible in R by using the
rownames() or the colnames() functions (when parameter are in rows and in
columns respectively). Thus parameter names can be derived and used as part
of generating new parameter names.

An R script structured as above can be integrated into FCS Express using the R
Add Parameters tools via the following steps:
1. Open the Transformation window by selecting the Tools
tab
Transformations command.
2. Click on the drop down arrow adjacent to the blue plus
button.
3. Select R Add Parameters. The Transformation window will appear as in the
picture below (Figure 29.45).
4. Click on the ellipsis at the right of the Template File field to browse for a
template *.FCS file (Figure below - Step 1).

© 2020 De Novo Software

986

FCS Express 6 Manual

Figure 29.45. The transformation windows populated with a New R Add Parameter
transformation.
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The Transformation window will be populated with the parameters contained in
the selected *.FCS file (Figure 29.46).
5. Select the parameters that will be included in the mat matrix (Figure below Step 2).
6. Select or change to the appropriate Parameter Scaling Options for each of
the selected parameters if required (Figure below - Step 3).
7. (Optional) Select a gate from the Gate drop down menu to only include the
events within that gate in the mat matrix (Figure below - Step 4).
8. (Optional) Select a Sampling Option (Figure below - Step 5). Although
multiple Sampling Methods are available (please refer to the Sampling Options
chapter for more details), the default Downsampling Method for an R
Add Parameters transformation is None, thus all available events (i.e. the
ones defined with the Gate drop-down menu) will be used.
9. Click on the ellipsis at the right of the R Script File field to browse for an R
script file (Figure below - Step 6).
10.Select the Event Order. This option defines the orientation of the mat matrix.
If Events as Row is selected, the mat object will have events in rows and
parameters in columns. If Events as Columns is selected, the mat object will
have events as column and parameters as rows.(Figure below - Step 7).
1038

The result of the previous steps can be seen in the Figure below:
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Figure 29.46. The transformation window with a fully set New R Add Parameter
transformation.
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The custom R Add Parameters transformation is now ready to be applied to
plots and Data Grids.
The R Script will be automatically run as soon as it will be applied on a plot or a
data grid, or as soon as one of the option in the Transformation dialog are
modified. To defer running the R Script, uncheck the box for Automatically Run
R Script. Doing so will present you with the button to Execute R Script (Figure
29.47) which can be pressed to calculate on demand.

Figure 29.47 Unchecking the Automatically Run R Script box will allow the user to
run the R script manually only when required.

Once an R Add Parameters transformation has been created, results can be
accessed as 1D plots, 2D plots 171 and Data Grid 676 as new parameters. In order
to do so, the R transformation must be applied to the object of interest.
R Transformations may be applied to 1D plots, 2D plots and data grids by
either of the following methods:
Drag and Drop (Figure 29.48)
1. Left click and hold on New R Add Parameters from the Transformation
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window.
2. Drag the transformation to the intended object (1D plots, 2D plots or a data
grid).
3. Release the mouse button.
The R transformation will be applied to the object. For 1D and 2D plots the title
of the plot will now include text "R add parameters added" indicating the
transformation has been applied.

Figure 29.48 Applying an R Add Parameters transformation to a plot by dragging
the transformation from the Transformation navigator to the plot (green arrows).

Using the Formatting Dialog (Figure 29.49)
1. Access the

283 (for 1D and 2D plots) or the
(for Data Grids).
2. Choose the R Add Parameters to apply from the Transformation drop
down.
3. Click OK.
309
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Figure 29.49. Applying an R Add Parameters transformation to a plot by selecting
the R Add Parameters transformation from the Transformation dropdown of the
Formatting Overlays dialog.

The result of the previous methods for 1D and 2 Plots is represented in Figure
29.50 below. When an R Add Parameters has been applied to a plot, the suffix
"R Add Parameters Added" has appear in the object title.

Figure 29.50. The plot title contains the "R Add Parameters added" suffix when an R
Add parameters transformation is applied.
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Once the transformation is applied, transformation results can be accessed as
new parameters (Figure 29.51).

Figure 29.51 When an R Add Parameter transformation is applied to a plot,
transformation results can be accessed as new parameters.

Next Topic: R Cluster Transformations

29.4.5

992

R Cluster Transformation
Customized cluster analysis can be applied to a file of interest using the R
Cluster Transformation input method.
To be compatible with the method, the Execute function defined in the R script
should result in an S4 object containing the following slots:
1. clusterAssignments : integer vector of cluster assignments;
2. numberOfClusters : integer of the number of new clusters;
3. clusterNames : character vector containing the names of new clusters.
A general example of an R script compatible with the R Cluster Transformation
input method follows:
Execute <- function(mat)
{
setClass("ClusteringResult",
representation(
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clusterAssignments="integer",
numberOfClusters="integer",
clusterNames="character"
),
prototype(
clusterAssignments=c(),
numberOfClusters=integer(0),
clusterNames=""
)
)
result <- new("ClusteringResult")
result@numberOfClusters <- as.integer(A)
result@clusterAssignments <- as.integer(B)
result@clusterNames <- C
return(result)
}

Where A, B and C values are defined by the user. As stated above:
A can be any integer number. Note that the as.integer() function is required
since numbers are otherwise stored as object of class numeric;
B can be the membership resulting from any user-defined clustering. It must be
a vector of integer values of length equal to the number of events in the mat
matrix. The number of unique integer values must be equal to A. The
numbering of clusters must begin at 0.
C is a vector of class character containing the names of the clusters. Multiple
names can be specified using the c() function (e.g.
c("name1","name2","name3") ). The length has to be equal to A.
An R script as structured above can be integrated into FCS Express using the R
Cluster Transformation tools via the following steps:
1. Open the transformation window by selecting the Tools
tab
Transformations command.
2. Click on the drop down arrow adjacent to the blue plus
button.
3. Select R Cluster Transformation. The Transformation window will appear as
in the following Figure 29.52:
4.Click on the ellipsis at the right of the Template File field to browse for a
template *.FCS file (Figure below - Step 1).
© 2020 De Novo Software
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29.52. The transformation windows populated with a New R Cluster
© 2020 De NovoFigure
Software
Transformation.
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The Transformation window will be populated with the parameters contained in
the selected *.FCS file.
5. Select the parameters that will be included in the mat matrix (Figure below Step 2).
6. Select or change to the appropriate Parameter Scaling Options for each of
the selected parameters if required (Figure below - Step 3).
7. (Optional) Select a gate from the Gate drop down menu to only include the
events within that gate in the mat matrix (Figure below - Step 4).
8. (Optional) Select a Sampling Option (Figure below - Step 5). Although
multiple Sampling Methods are available (please refer to the Sampling Options
chapter for more details), the default Downsampling Method for an R
Cluster Transformation transformation is None, thus all available events (i.e.
the ones defined with the Gate drop-down menu) will be used.
9. Click on the ellipsis at the right of the R Script File field to browse for an R
script file (Figure below - Step 6).
10. Select the Event Order. This option define the orientation of the mat matrix.
If Events as Row is selected, the mat object will have events in rows and
parameters in columns. If Events as Columns is selected, the mat object will
have events as column and parameters as rows (Figure below - Step 7).
11. Set the output parameters for the clustering (Figure below - Step 8). Here
are reported the available cluster output format.
1038

o Cluster Assignment: An internal label indicating the cluster membership
assigned to each event. This label is internally used by FCS Express for
heatmap representation of clusters but it is also accessible through a
Data grid

676

.

o Distance to Cluster Centroid: The distance of a given event to the
centroid of its cluster. Values are plotted as unique histogram.
o Distance to centroid Histograms: The same as the Distance to
Cluster Centroid but in this case values are grouped, and thus plotted,
separately for each cluster. Clusters are numbered from 1 to Number
of Clusters.
o Gaussian CV SSE Scaled: In this representation each event is plotted
based on its cluster membership, thus clusters appear as separated
histograms. Given that cluster membership is an integer value that goes
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from 0 to Number of Clusters-1, an artificial noise is introduced to
spread out the data. Gaussian SSE scaled means that the standard
deviation of the Gaussian (normal distribution) used to represent each
cluster is proportional to the Sum of Squared Error of the cluster.
o Gaussian CV Unscaled: In this representation each event is plotted
based on its cluster membership, thus clusters appear as separated
histograms. Given that cluster membership is an integer value that goes
from 0 to Number of Clusters-1, an artificial noise is introduced to
spread out the data. Gaussian CV unscaled means that the standard
deviation of the Gaussian (normal distribution) used to represent each
cluster is the same among clusters.
o Gaussian Y Data: Events are plotted following a Gaussian (normal
distribution).
The result of the steps above will be the following (Figure 29.53):
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Figure 29.53. The transformation window with a fully set New R Cluster
© 2020 De Novo Software
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The custom R Cluster Transformation transformation is now ready to be
applied to plots.
The R Script will be automatically run when it is applied to a Heat Map or a data
grid, or when one of the option in the Transformation dialog are modified. To
defer running the R Script, uncheck the box for Automatically Run R Script.
Doing so will present you with the button to Execute R Script (Figure 29.54)
which can be pressed to calculate on demand.

Figure 29.54 Unchecking the Automatically Run R Script box will allow the user to
run the R script manually only when required.

Once an R Cluster Transformation transformation has been created, results
can be accessed through Heat Maps
and Data Grids 676 . The R transformation
must be applied to to the plots.
1048

R Transformation may be applied to Heat Maps and Data grids by either of the
following methods:
Drag and Drop (Figure 29.55)
1. Left click and hold on New R Cluster Transformation from the
Transformation window.
2. Drag the transformation to the intended object (Heat Map or Data Grid).
3. Release the mouse button.
© 2020 De Novo Software
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The R transformation will be applied to the object. If the object is an Heat Map
plot, the title of the plot will now include the text "R Cluster Transformation
clustered" to indicate the transformation has been applied.

Figure 29.55. Applying an R Cluster Transformation to a plot by dragging the
transformation from the Transformation navigator to the plot (green arrow).

Using the Formatting Dialog (Figure 29.56)
283 (for 1D plots, 2D plots and Heat
1. Access the
309 (for Data Grids).
map) or the
2. Choose the R Cluster Transformation to apply from the Transformation
drop down.
3. Click OK.
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Figure 29.56. Applying an R Cluster Transformation to a plot by selecting the R
Cluster transformation from the Transformation dropdown of the Formatting
Overlays dialog.

The result of the previous methods for 2D plot, Heat Map and 1D plot is
represented in Figure 29.57. When an R Cluster Transformation has been applied
to a 2D plot, Heat Map or 1D plot, the suffix "R Cluster Transformation
clustered" will appear in the plot title.

Figure 29.57. The heatmap title contains the "R Cluster Transformation clustered"
siffix when an R Cluster Transformation is applied.

2D plots, 1D plots and heatmap can now be used to create gates, markers and
well gates suitable for downstream analysis (please refer to the Heat Map
section of the Working with k-means parameter 972 chapter for more info on
how to create well gates) (Figure 29.58).

© 2020 De Novo Software

1002

FCS Express 6 Manual

Figure 29.58 Examples of 1D Gate ("Cluster 1" gate on the left), rectangle 2D Gate
("Cluster 2" gate on the left), Well Gate (blue well gate in the Heat map) and
Marker (M1 marker on the right).

29.5

tSNE (viSNE)
High-dimensional single-cell technologies, such as multicolor flow cytometry,
mass cytometry, and image cytometry, can measure dozens of parameters at
the single-cell level. FCS Express integrates t-Distributed Stochastic Neighbor
Embedding, otherwise known as t-SNE, which is a tool that allows you to map
high-dimensional cytometry data onto a two dimension plot while conserving the
original high-dimensional structure to help you visualize and analyze highdimensional data.
viSNE, which uses the Barnes-Hut implementation of the t-SNE algorithm,
was developed by El-ad David Amir and colleagues in 2013 and is based on the tDistributed Stochastic Neighbor Embedding (t-SNE) algorithm developed by
Laurens van der Maaten and Geoffrey Hinton in 2008.
Briefly, the optimization algorithm included in viSNE searches for the best lowdimensional (e.g. two or three dimensions) representation of the highdimensional events, so that the pairwise distances between events are best
conserved between the high- and the low-dimensional space.
The final result of the algorithms in FCS Express is a 2D plot in which the
positions of cells reflect their proximity in their original high-dimensional space.
Plots can further be colored with density or heat mapping
of each parameter
allowing for easy visualization of populations.
1020

Given that t-SNE is an highly demanding algorithm, in 2014 Laurens van der
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Maaten developed a faster version of the tSNE algorithm exploiting the BarnesHut algorithm. The Barnes-Hut method gives an approximate result of tSNE but it
is faster than the exact tSNE. FCS Express allows the user to use both the exact
tSNE algorithm and the Barnes-Hut approximation. Moreover, the developers
team at De Novo Software worked hard to make both the exact algorithm and
the Barnes-Hut approximation even faster. You can find a performance test in
the next chapter .
1003

Although t-SNE is extremely useful for visualizing high-dimensional data, t-SNE
plots can be mysterious and esoteric. For a more comprehensive understanding
of t-SNE, please click here.
More details on viSNE/tSNE can be found in the following publications:
Van der Maaten, L. Accelerating t-SNE using Tree-Based Algorithms. J. Mach.
Learn. Res. 15, 3221-3245 (2014).
Amir el-AD et al. viSNE enables visualization of high dimensional single-cell data
and reveals phenotypic heterogeneity of leukemia. Nat. Biotechnol. 31, 545–
552 (2013).
Van der Maaten, L. & Hinton, G. Visualizing data using t-SNE. J. Mach. Learn.
Res. 9, 2579–2605 (2008).
Additional resources:
Github by Laurens van der Maaten, co-author of original implementation:
https://lvdmaaten.github.io/tsne/
Distill article discussing the effective use of t-SNE: http://distill.pub/2016/
misread-tsne/

To begin working with viSNE in FCS Express please see the topics on:
t-SNE performance in FCS Express V6
Defining a tSNe transformation
Applying a tSNe transformation
Working with tSNE transformations
Saving a tSNE transformation
t-SNE FAQ

1003
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29.5.1

tSNE performance in FCS Express
Given that t-SNE is an highly demanding algorithm, the development team at De
Novo Software made a great effort to improve the speed of running the
algorithm with FCS Express.
To give you an idea of how t-SNE is performing within FCS Express, a
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performance test has been run comparing FCS Express and the independent R
package in running both the exact tSNE algorithm and the Barnes-Hut
approximation.
Here is a brief description of how the test was run:
File
Machine
FCS Express
R
FCS format
CPU: Intel Core i5- Version:
R version 3.3.1
version: 3.0
4200M CPU
6.00.0045 (64 bit) (2016-06-21)
R Studio Version
Total number of
2.5GHz
0.99.903
Memory:
8Gb
events: 500397
(different sample
System type:
sizes were used in Windows 8.1 64 bit
the performance
test)
Total number of
parameters: 40
(20 parameters
have been selected
in the performance
test)

The graph below (Figure 29.59) show the elapsed time (in minutes) for t-SNE
calculation (using both the exact t-SNE and the Burnes-Hut Approximation
(Amount of Approximation = 0.5)) in both FCS Express and R. A fixed
number of parameters (i.e. n=20) and different numbers of events have been
used. t-SNE was not estimated for unsampled events. Please refer to the
Defining a tSNE transformation
chapter for more information about all the
above mentioned options.
1005
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Figure 29.59 - Performance comparison between FCS Express and R in running
both the exact tSNE and the Barnes-Hut Approximation.

29.5.2

Defining a tSNE transformation
tSNE transformations are performed in FCS Express through the
Transformations navigator.
The steps below outline the process of creating a new tSNE transformation for
your data:
1. Open the Transformation window by selecting the Tools tab
command (Figure 29.60, Step 1).
The Transformations window will open as in the figure below.
2. Click on the dropdown arrow adjacent to the blue plus
below, Step 2).
3. Click on tSNE in the dropdown list (Figure below, Step 3).
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Figure 29.60 Initial steps to create a tSNE transformation.

The tSNE dialog will now appear in the Transformation window as seen in
Figure 29.61.

© 2020 De Novo Software

Transformations

1007

© 2020 De Novo Software

Figure 29.61 - The tSNE dialog opens when a new tSNE transformation is created.
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The new tSNE transformation is named as New TSNE by default but it can be
easily renamed by either of the following methods:
Right click on the tSNE transformation that needs to be renamed Select
Rename.
Select the tSNE transformation that need to be renamed via left click and
press F2 on your keyboard.
Select the tSNE transformation that need to be renamed via left click and click
on the

button in the Transformations tool bar.

4. Choose a Template File for the tSNE transformation by clicking on the ellipsis
to the right of the Template File text box.
Note: if you wish to define the tSNE transformation on your entire dataset
rather than an individual datafile, you can use a merged datafile with a File
Identifier Column 667 as the Template File. The transformation can then be
applied
to the merged datafile, and events therein can be related back
to the original datafiles with the File Identifier Column 667 .
1016

The tSNE dialog will be populated with a list of available parameters to perform a
tSNE transformation based on available parameters from the template file
(Figure 29.62).

© 2020 De Novo Software

Transformations

1009

© 2020 De Novo Software

Figure 29.62 When a template file is selected, the possible parameters to perform
a tSNE transformation are automatically listed in the tSNE dialog.
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5.Choose the parameters to be used in the tSNE transformation by checking the
boxes next to the parameter names (Figure 29.63 below, Point 1).
6. Select or change to the appropriate Parameter Scaling Options for each of
the selected parameters if required (Figure below, Point 2).
Options can now be set to customize the transformation.
Options
Gate
tSNE Method to Use

Amount of Approximation
(Applies Only to BarnesHut)

Description
Allows the user to run tSNE only on the events
within a specific gate.
Allows the user to set the method to use for
running tSNE. Possible choices are Exact tSNE
and Barnes-Hut Approximation. The Exact
tSNE is the original implementation of the
algorithm and is only practical for sample sizes
less than 5000 due to speed and memory
constraints of this approach. The Barnes-Hut
method gives an approximate result of tSNE and
is faster than the exact tSNE for larger data sets
but there will be little difference in calculation
times for smaller data sets. The amount of
approximation for the Barnes-Hut method can be
specified in the Amount of Approximation
(Applies only to Barnes-Hut) field (see next
option).
In FCS Express 6, the default Method for tSNE is
the Barnes-Hut Approximation.
Allow the user to set the Amount of
Approximation for the Barnes-Hut method. The
Amount of Approximation is a trade-off between
speed and accuracy of the approximation. The
value ranges from 0 to 1, where higher values
indicate a faster computation time but a less
accurate approximation and lower values results
in a slower computation time but a more
accurate approximation. If the approximation
value is less than 0.2, the exact tSNE method
may be used as well as the Barnes Hut
approximation may be slower than the exact
tSNE method.
In FCS Express 6, the default Amount of
Approximation is 0.50.
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Perplexity is a measure for information. In tSNE,
the perplexity is used to sets the number of
nearest neighbors considered.
In tSNE, typical values for the perplexity range
between 5 and 50.
In FCS Express 6, the default value for
Perplexity is 30.
tSNE in an iterative process. This option allows
you to set the number of iteration that will be
performed by the algorithm.
In FCS Express 6, the default Number of
Iterations is 500.
tSNE can be performed on a subsample of the
data with the rest of the data subsequently
mapped to the transformed subsampled data
after the initial run (see the Estimate tSNE for
Unsampled Events option).
Although multiple Sampling Methods are available
(please refer to the Sampling Options
chapter
for more details), the default setting for a tSNE
transformation are:
1038

Downsampling Method. Default setting is
Interval.

Estimate tSNE for
Unsampled Events

Change Random Seed

© 2020 De Novo Software

Sample Size. This parameter indicates how
many cells to subsample and perform tSNE on. If
the specified Sample Size is higher than the
number of available events, tSNE will be run on all
available events. Note that the number of
available events is dictated by the Gate option. In
FCS Express 6, the default Sample Size is 100.
This option determines whether events that did
not participate in the tSNE calculation (if you
chose less than the total number of events in the
Sample Size option) will be mapped to the
nearest point that did participate in the tSNE
mapping. If this option is unselected, events that
did not participate in the tSNE calculation will be
have undefined values in the resulting tSNE
parameters and will not be plotted, participate in
statistical calculations of the tSNE parameters or
able to be gated based on the tSNE parameters.
In FCS Express 6, tSNE is Estiamted by default for
Unsampled Events.
The Random Seed is a number which is used by
the random number generator to generate the N
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random values which are used as input data
points for the tSNE calculation. The random
number generator will use the Random Seed
value and perform a series of math operations on
it which result in N random values.

Automatically Calculate
tSNE

Since tSNE is a stochastic algorithm, a seed can
be set to make results reproducible over the time
when tSNE is applied to the same data.
Alternatively, the seed can be changed when a
different tSNE map is desired. The seed can be
changed by either clicking on the Change
Random Seed button or by manually inserting a
seed in the field.
In FCS Express 6, the default Random Seed is 6.
By default tSNE transformation is recalculated as
soon as an option in the tSNE dialog is changed.
Given that tSNE is an highly demanding algorithm
that can take several seconds to be calculate,
FCS Express allows the user to disable the
automatic calculation of tSNE and to manually
calculate tSNE only when required. To defer
calculating the tSNE algorithm, uncheck the box
for Automatically Calculate tSNE. Doing so will
present you with the button to Calculate tSNE
which can be pressed to calculate tSNE on
demand.
Please note that this option only regulates the
autoupdate upon changes made within the tSNE
dialog. If tSNE is calculated on a gate and that
gate is moved or resized, tSNE will be
automatically recalculated regardless this option.
If you want to avoid tSNE autoupdate upon gate
moving/resizing, please refer to the Live Updating
Gate 317 chapter of this manual.

7.(Optional) Select a gate from the Gate drop down menu to only run tSNE
transformation on the events within that gate (Figure below, Point 3).
8.(Optional) Select a Downsampling Method (Figure below, Point 4). Although
multiple Sampling Methods are available (please refer to the Sampling Options
chapter for more details), the default Downsampling Method for a tSNE
transformation is Interval.
1038
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9. Enter a value in the Sample Size field by typing the number of events on
which tSNE will be performed (Figure below, Point 5).
10. Select which method to use for tSNE transformation. Exact tSNE or the
Barnes-Hut Approximation (Figure below, Point 6).
11. If the Barnes-Hut approach is selected, set the Amount of Approximation
for the Barnes-Hut method in the Amount of Approximation (Applies only
to Barnes-Hut) field (Figure below, Point 7).
12.(Optional) Change the Perplexity by manually inserting a value in the field
(Figure below, Point 8).
13.(Optional) Change the Number of Iterations that will be performed by
manually inserting a value in the field (Figure below, Point 9).
14. (Optional) Select whether to Estimate tSNE for Unsampled events
(Figure below, Point 10).
15. (Optional) Change the the random seed used for tSNE calculation by either
clicking on the Change Random Seed button or by manually inserting a seed
in the field (Figure below, Point 11).
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The tSNE transformation has now been defined and will be automatically
calculated as soon as it will be applied to a plot . In addition, tSNE
transformation will be automatically recalculated as soon as an option in the
tSNE dialog will be modified.
1016

Given that tSNE is an highly demanding algorithm that can take several seconds
to be calculate, FCS Express allows the user to disable the automatic calculation
of tSNE upon options changing and to manually calculate tSNE only when
required. To defer calculating the tSNE algorithm, uncheck the box for
Automatically Calculate tSNE. Doing so will present you with the button to
Calculate tSNE (Figure 29.64) which can be pressed to calculate on demand.
Please note that this option only regulates the auto update of tSNE upon
changes made within the tSNE dialog. If tSNE is calculated on a gate and that
gate is moved or resized, tSNE will be automatically recalculated regardless this
option. If you want to avoid tSNE autoupdate upon gate moving/resizing, please
refer to the Live Updating Gate 317 chapter of this manual.

Figure 29.64 Unchecking the Automatically Calculate tSNE box will allow the user to
calculate tSNE manually only when required.

The tSNE transformation can now be applied to any plot in FCS Express and the
new tSNE X and tSNE Y parameters chosen from the list of available parameters
© 2020 De Novo Software
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(Figure 29.65 below). Please also see the Applying a tSNE Transformation
section for additional details on applying tSNE mapped transformations to plots.
1016

Figure 29.65 tSNE parameters can be accessed as standard parameters.

29.5.3

Applying a tSNE transformation
Once a tSNE transformation has been defined , it may be applied to any plot in
FCS Express. Once a tSNE transformation is applied to a plot, standard gating
and statistics may be used to study the result of the tSNE transformation.
1005

Note: When a tSNE transformation has been applied, the text "tSNE mapped"
will appear in the plot title.
tSNE transformations may be applied to 1D and 2D plots by either of the
following methods:
Drag and drop the tSNE from the Transformation window to the intended plot
or data grid (Figure 29.66).
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Figure 29.66 Applying a tSNE transformation to a plot by dragging the tSNE
transformation from the Trasnformations navigator to the plot (green arrow).

Access the Formatting Overlays dialog 283 and choose the tSNE transformation
to apply from the Transformation drop down menu (Figure 29.67).

Figure 29.67. Applying a tSNE transformation to a plot by selecting the tSNE
transformation from the Formatting Overlays dialog in the Transformation
dropdown.

The result of both methods will be plots that denote they are tSNE mapped in
the plot title (Figure 29.68). To access the tSNE parameters click and hold on the
axis of the plot and choose the appropriate tSNE X or Y parameters .
1018
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Figure 29.68. 2D and 1D plot with tSNE transformation applied. Note the "tSNE
mapped" suffix in the plot title.

In the next section, we will see how to work with tSNE parameters

29.5.4

1018

.

Working with tSNE transformations
Once a tSNE transformation is applied to a plot , tSNE parameters can be
accessed by clicking on the axis label of the plot Figure 29.69. Gates 316 may be
created on any combination of standard or tSNE parameters on any plot type to
specifically select the events within one or more tSNE clusters. Jump to Gating
tSNE transformed data.
1016
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Figure 29.69 tSNE parameters can be accesses as standard parameters.

While any plot type can display tSNE based parameters, Density plots and
Contour plots have a unique overlay option called Color Based on 287 (Figure
29.70) that is helpful for visualizing and understanding tSNE transformed data
sets.
The Color Based on option is access via either:
283 of Density and Contour plots. The Color
The
Based on dropdown menu will allow you to choose from Count or any
available parameter for the data set to display as the Density or Contour map
on the plot.
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Figure 29.70 - The Color based on option in the
formatting>overlays category of density and contour plots
allows you to choose a parameter that will be used to display a
density or contour map on tSNE X and tSNE Y transformed
parameters.

The Legend title 251 , when the plot legend is visible (see the red arrow in the
pictures below).
For tSNE transformed data sets it is useful to display tSNE X and tSNE Y
parameters on their respective X Parameter and Y Parameter axis and visualize
each additional target parameter as a Color Based on selection. In the examples
below the same tSNE transformation for an analysis is shown in three different
display types with each plot using the Color Based on parameter indicated in the
upper left of the plot. The top example shows Density plots with the Flame
Color Level, the middle example shows Contour plots with outliers enabled,
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while the bottom plot shows Density plots withe Green-Black-Red Color Level
with a Style of Mean +/- SD and Standard Deviations set to 2.00.
Note that there are a number of options in FCS Express that may be changed to
display tSNE transformed data in unique ways and seemingly unlimited
combinations. The following list of formatting options may be useful for reviewing
and preparing data visualizations:
Please note that reducing Smoothing 287 to 0 or 1 on plot overlays or reducing
the resolution 304 may significantly enhance your plot visualizations.
Overlays 286 - To choose the Color Based on 287 parameter and to show or hide
outliers and outlier coloring.
Color Levels 294 - To choose the overall color scheme and color level properties
for Density and Contour Plots.
Specific Options 304 - To choose the resolution to display plots at and the select
Shade Based on Density 307 if desired.

Color Based on parameter indicated in the upper left of the plot. Example above
shows Density plots with the Flame Color Level.
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Color Based on parameter indicated in the upper left of the plot. Example above
shows Contour plots with outliers enabled.

Color Based on parameter indicated in the upper left of the plot. Example above
shows Density plots with Green-Black-Red Color Level with a Style of Mean +/- SD
and Standard Deviations set to 2.00.

Gates 316 may be created on any combination of standard or tSNE parameters on
any plot type to specifically select the events within one or more tSNE clusters.
Gated populations may also be used to gate or back gate 302 events on any tSNE
transformed plot.

An example of gates drawn, backgated, and gated on tSNE parameters is shown
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in the Figure below (Figure 29.71).

Figure 29.71. Gates have been drawn on tSNE parameters (upper panel) and have
been displayed (lower left plot) or applied (lower central and lower right plots) to
other plots.

29.5.5

Saving tSNE results with an FCS File
Newly calculated tSNE X and tSNE Y parameters are not saved within the layout
or data file but are instead calculated automatically (or manually)
and applied
to plots/files
when the layout is reopened. When working with large data sets
or computationally intensive transformations the team at De Novo Software
recommends saving/exporting a new .FCS file that contains the newly calculated
tSNE X and tSNE Y parameters so you may more easily work with the data set
without having to recalculate the tSNE results.
1012
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Exporting/Saving the newly create tSNE X and Y Parameters as part of a new
.FCS file is easily accomplished by:
1. Apply the tSNE transformation
of interest to a given plot.
2. Click on the plot to select it.
3. Click on the Data tab Save/Load Export from the ribbon to launch the
Export Data dialog.
4. Select the additional tSNE X and tSNE Y parameters from the list of
Parameters to Export.
1016
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5. Perform the export normally according to the full instructions at Exporting
FCS File Data from a Single File 662 .
It is also recommend that the layout in which the transformation was create is
saved so you may review the settings used to create the tSNE transformation at
anytime in the future.

29.6

SPADE
FCS Express can perform the Spanning-tree Progression Analysis of Densitynormalized Events (SPADE) algorithm. The transformation allows for direct
analysis and visualization for highly multiparametric single-cell flow, image, and
mass cytometry data.
The final result of the algorithm in FCS Express is a heat map in which the
positions of cells in related nodes are positioned within a hierarchical minimum
spanning tree. Heat maps can be modified easily for improved visualization of
populations while Gates
may be created to identify node(s) of interest.
1059

SPADE was developed at Stanford University by members of the Plevritis and
Nolan laboratories.
More details on SPADE can be found in the following publications:
Qiu, P., et al. Extracting a cellular hierarchy from high-dimensional cytometry
data with SPADE. Nat. Biotech. 29, 886-891 (2011).
Qiu, P. Inferring phenotypic properties from single-cell characteristics. PLoS
One. 5, Web (2012).
To begin working with SPADE in FCS Express, please see the topics on:
Defining SPADE
Working with SPADE
1024
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29.6.1

Defining a SPADE transformation
SPADE is performed in FCS Express through the Transformations navigator.
The steps below outline the process of creating a new SPADE transformation for
your data:
1. Open the Transformation navigator by selecting the Tools tab
command (Figure 29.72, Step 1).
The Transformations navigator will open as in the figure below.
2. Click on the dropdown arrow adjacent to the blue plus
below, Step 2).

button (Figure
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3. Click on SPADE in the dropdown list (Figure below, Step 3).

Figure 29.72 Initial steps to create a SPADE transformation.

The SPADE dialog will now appear in the Transformation navigator as seen in
Figure 29.73.
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Figure 29.73 The SPADE dialog in the Transformations ©
navigator.

Transformations

1027

The new SPADE transformation is named as New SPADE by default, but it can
be easily renamed by any of the following methods:
Right click on the SPADE transformation that needs to be renamed select
Rename.
Select the SPADE transformation that need to be renamed via left click and
press F2 on your keyboard.
Select the SPADE transformation that need to be renamed via left click and
click on the

button in the Transformations tool bar.

1. Choose a Template File for the SPADE transformation by clicking on the
ellipsis to the right of the Template File text box (Figure 29.74).
The SPADE dialog will be populated with a list of available parameters to
perform SPADE based on available parameters from the template file (Figure
below).
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Figure 29.74 When a template file is selected, the possible parameters to perform
a SPADE transformation are automatically listed in the SPADE dialog.

2.Choose the parameters to be used in the SPADE transformation by checking
the boxes next to the parameter names (Figure 29.75, Point 1).
3.Select or change to the appropriate Parameter Scaling Options for each of
the selected parameters if required (Figure below, Point 2).
Options can now be set to customize the transformation.
Options
Gate

Description
Allows the user to run SPADE only on the events within a
specific gate.
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Number of
Indicates the number of nodes for the SPADE tree.
Clusters
Maximum
Sets the maximum number of iterations that FCS Express
Iterations
should perform before quitting the clustering process.
Min Percent of Defines the minimum size, by percentage, of clusters and
Cells Per Cluster should be a value between 0 and 100.
Sampling
Although multiple Sampling Methods are available (please refer
Options
to the Sampling Options
chapter for more details), the
default setting for a SPADE transformation are:
1038

Downsampling Method. Default setting is Target Density.
Specify Density Percentiles. By default the option is
checked, and the user can define how the density-dependent
downsampling is performed by eentering Min Density and
Target Density values. If the box is unchecked, Sample Size
may be defined instead of these two values.
Alpha. Default value is 5.
Min Density. Values range from 0 to 1. Default value is 0.01.
Target Density. Values range from 0 to 1. Default value is
0.20.
Local Density method. Default setting is Exact.
Sample Size. Since Specify Density Percentiles is checked
by default, the Sample Size field is not available by default.
This option becomes available when the Specify Density
Percentiles check-box is unchecked, . If using this option,
the Min Density and Target Density will be automatically
estimated to select cells. If the specified Sample Size is higher
than the number of available events, SPADE will be run on all
available events. Note that the number of available events is
dictated by the Gate option. The minimum value that can be
entered is 10.
Graph Layout
Defines the layout style used for the SPADE tree. Possible
Method
choices are Arch (default) or Radio. This option determines
the display style used to plot the tree, it does not affect
results.
Change Random The Random Seed is a number which is used by the random
Seed
number generator to generate the N random values which are
used as input data points for the SPADE calculation. The
random number generator will use the Random Seed value
and perform a series of math operations on it which result in N
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random values.
Since SPADE relies on k-Means clustering, which is a stochastic
algorithm, a seed can be set to make results reproducible over
the time when SPADE is applied to the same data. The seed
can be changed by either clicking on the Change Random
Seed button or by manually inserting a seed in the field.
In FCS Express 6, the default Random Seed is 6.
Output
The available choices are Clustering Assignments and
Clustering Statistics. Please refer to the Defining a k-Means
cluster analysis 968 chapter for more details on Clustering
Statistics.
Automatically
By default SPADE is recalculated as soon as an option in the
Calculate SPADE SPADE dialog is changed. FCS Express allows the user to
disable the automatic calculation of SPADE and to manually
calculate SPADE only when required. To defer calculating the
SPADE algorithm, uncheck the box for Automatically
Calculate SPADE. Doing so will present you with the button
to Calculate SPADE, which can be pressed to calculate
SPADE on demand.
Please note that this option only regulates the auto-update
upon changes made within the SPADE dialog. If SPADE is
calculated on a gate and that gate is moved or resized, SPADE
will be automatically recalculated regardless this option. If you
want to avoid SPADE auto-updating upon gate moving/
resizing, please refer to the Live Updating Gate 317 chapter of
this manual.

4.(Optional) Select a gate from the Gate drop down menu to only run SPADE on
the events within that gate (Figure below, Point 3).
5.(Optional) Select a Downsampling Method (Figure below, Point 4). Although
multiple Sampling Methods are available (please refer to the Sampling Options
chapter for more details), the default Downsampling Method for a
SPADE transformation is Target Density (see above for more details and
default settings).
1038

6. Enter value for Number of Clusters (Figure below, Point 5).
7. Enter value for Maximum Iterations (Figure below, Point 6).
8. (Optional) Change the value for Min Percent of Cells Per Cluster (Figure
below, Point 7).
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9. Select the Graph Layout Method to be used for the SPADE tree (Figure
below, Point 8). Possible choices are Arch (default) or Radio.
10. (Optional) Change the the Random Seed used for SPADE calculation by
either clicking on the Change Random Seed button or by manually inserting a
seed in the field (Figure below, Point 9).

Figure 29.75 Steps to complete the SPADE dialog.

The SPADE transformation has now been defined and will be automatically
calculated as soon as it will be applied to a heat map . In addition, SPADE will
be automatically recalculated as soon as an option in the SPADE dialog will be
modified.
1033

Given that SPADE is a demanding algorithm that can take several seconds to be
calculate, FCS Express allows the user to disable the automatic calculation of
SPADE upon options changing and to manually calculate SPADE only when
required. To defer calculating the SPADE algorithm, uncheck the box for
Automatically Calculate SPADE. Doing so will present you with the button to
Calculate SPADE (Figure 29.76) which can be pressed to calculate on demand.
Please note that this option only regulates the auto update of SPADE upon
changes made within the SPADE dialog. If SPADE is calculated on a gate and that
gate is moved or resized, SAPDE will be automatically recalculated regardless this
© 2020 De Novo Software
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option. If you want to avoid SPADE autoupdate upon gate moving/resizing,
please refer to the Live Updating Gate 317 chapter of this manual.

Figure 29.76 Unchecking the Automatically Calculate SPADE box will allow the user
to calculate SPADE manually only when required.

For visualization of the SPADE transformation, a Heat Map
may be inserted
and modified (Figure 29.77 below). Please also see the Working with SPADE
transformations
section for additional details on applying SPADE
transformations to plots.
1048
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Figure 29.77 Heat Map Displaying SPADE transformation.

29.6.2

Working with SPADE transformations
Once SPADE has been defined , it may be applied to empty Heat Maps
in
FCS Express. Please note when inserting a Heat Map
for non-multiwell plate
data, a warning message will appear (Figure29.78).
1024

1048

1048

© 2020 De Novo Software

1034

FCS Express 6 Manual

Figure 29.78 Warning message when inserting a heat map for data sets not derived
from a plate based data file.

Click Continue and proceed to apply the SPADE transformation by either of the
methods below:

Drag and drop SPADE from the Transformation navigator on to the intended
plot (Figure 29.79). Note that the SPADE tree can only be displayed on Heat
Map plots. However, applying the SPADE transformation on 1D and/or 2D plots
is required for downstream analysis of SPADE results (e.g. back-gating of
SPADE nodes on 1D and 2D plots).
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Figure 29.79 Drag and drop SPADE from Transformations navigator to an empty
heat map. When the transformation has been applied the heat map will populate
with SPADE nodes.

Access the Formatting Overlays dialog 283 and choose the SPADE
transformation to apply from the Transformation dropdown list (Figure
29.80).
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The result of both methods will be a plot that denotes SPADE tree in the title,
outlined in red below (Figure 29.81).
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Figure 29.80 Heat Map with title appended with SPADE tree, outlined in red.

Once SPADE is applied, the Heat Map may be formatted to:
Have well size dependent on a a statistic such as number of events in the
node
Set the Parameter and Statistic for display
Change the Color Level and Color Scheme
Create gate(s) to identify node(s) of interest, and edit other features
1055
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29.6.3

Saving SPADE results with a DNS file
Results from a SPADE transformation are not saved within the layout or data file
but are instead calculated automatically (or manually)
and applied to plots/files
when the layout is reopened. When working with large data sets or
computationally intensive transformations the team at De Novo Software
recommends saving/exporting SPADE results in a new file so you may more
easily work with the data set without having to recalculate the SPADE
transformation. SPADE result are not compatible with the Flow Cytometry
Standard (i.e. FCS) file format and need to be saved as De Novo Software data
Stream (i.e. DNS) file format.
1024
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Exporting/Saving SPADE results as part of a new .DNS file is easily accomplished
by:
1. Apply the SPADE transformation
of interest to a given plot.
2. Click on the plot to select it.
3. Click on the Data tab Save/Load Export from the ribbon to launch the
Export Data dialog.
4. Select the additional SPADE Cluster ID parameter from the list of
Parameters to Export.
5. Perform the export normally according to the full instructions at Exporting
FCS File Data from a Single File 662 , being sure to select DNS data Stream
file as file type for the output file.
1033

It is also recommend that the layout in which the transformation was create is
saved so you may review the settings used to create the SPADE transformation
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at anytime in the future.

29.7

Sampling Options
Sampling is a method used to reduce the sample size of a data set prior
calculating a statistics of interest. Different sampling methods are available in FCS
Express and can be used in conjunction with several Transformation tools 934 .
Available sampling methods are:

None. Sampling is not performed. All events selected in the Gate drop-down
menu of the Transformation dialog are used.

Interval. A defined number of cells (i.e. the Sample Size) is sampled from the
main population (i.e. the one selected in the Gate drop-down menu of the
Transformation dialog) according to a fixed periodic interval. This interval,
called the sampling interval, is calculated by dividing the population size by the
desired Sample Size. For example, if the main population counts 1000 events
and the Sample Size is 100, every 10th event will be selected (e.g. 1st, 11th,
21st, 31st...). If the specified Sample Size is higher than the number of
available events, all available events will be considered.

Target Density and Weighted Density are examples of Density Based
sampling. This means the probability that an event will be sampled (i.e. included
in the dataset for analysis) is based on the local density around that event. The
local density of an event x is defined as the number of other events within a
certain radius around event x. The radius used is arbitrary, and properties to
control it are defined below.
Density based sampling involves two stages. The first stage is to calculate the
local density around each cell. The second stage is to decide whether or not to
sample the cell based on the local density.

Local Density Calculation
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The local density is calculated identically for both the Target Density and
Weighted Density options. In order to calculate the local density, a radius must
be determined. In order to determine the radius, 2000 events are randomly
selected and the distance matrix of these events are calculated. The median
distance is then multiplied by the Alpha value that can be entered in the
properties to determine the radius for the local density.
Once the radius is determined as described above, the number of events within
the radius is calculated based on the Local Density Method whose options are:
Exact - the exact number of events within the radius is determined
Kernel - an approximation of the number of events within the radius is
determined. Generally, the kernel method is much faster than the exact
method and provides comparable results.

Sampling Calculation
After the local density has been calculated, the cells are sampled based on the
density using two different approaches which the user can select: Target Density
1039

29.7.1

and Weighted Density

1040

.

Target Density Downsampling
Target Density downsampling is a method to discard events based on their local
density. Please read our introduction to sampling
if you have not done so
already to learn about your options for calculating local density.
1038

Target density downsampling is implemented as originally described in Qui, P et.
al. "Extracting a Cellular Hierarchy from High-dimensional Cytometry Data with SPADE",
Nature Biotechnology, 29(10):886-891, 2011. The goal is to ensure that the final density of the
sampled population falls within a certain density range. Events with local densities below the
desired density range are discarded. Events with the local densities within the desired range
are kept. Events with local densities above the desired range with are discarded with a
probability that depends on how much the local density is greater than the desired range. The
higher the local density is compared to the desired range, the more likely it is to be discarded.
Target Density Downsampling has several options
Specify Density By default the option is checked, and the user can define
Percentiles
how the density-dependent downsampling is performed by
entering Min Density and Target Density values. If the
box is unchecked, Sample Size may be defined instead of
these two values.
© 2020 De Novo Software

1040

FCS Express 6 Manual

Min Density

If the local density of a cell is less than the Min Density
value, it will be excluded from sampling. Values range from
0 to 1. Default is 0.01.
Target Density If the local density of a cell is greater than the Min Density
percentile and less than the Target Density, it will be
sampled. When the Local density of a cell is greater than
the Target Density, it will be sampled randomly with a
probability equal to the ratio of Target Density/Local
density. Values range from 0 to 1. Default is 0.20.
Sample Size
Indicates how many cells to subsample when performing
the transformation. This option becomes available when
the Specify Density Percentiles check-box is
unchecked, . If using this option, the Min Density and
Target Density will be automatically estimated to select
cells. If the specified Sample Size is higher than the number
of available events, SPADE will be run on all available events.
Note that the number of available events is dictated by the
Gate option. The minimum value that can be entered is 10.

29.7.2

Weighted Density Sampling
Weighted Density sampling is a method to discard events based on their local
density. Please read our introduction to sampling
if you have not done so
already to learn about your options for calculating local density.
1038

Weighted density sampling is implemented as originally described in Kollios, G et.
al "Efficient Biased Sampling for Approximate Clustering and Outlier Detection in
Large Data Sets", IEEE Transactions on Knowledge and Data Engineering, 15(5):11701187, 2003.
There are several options for Weighted density sampling:
Sample Size
Weight

Indicates how many events to sample.
The Weight parameter controls the probability with which an events
is sampled based on the local density. Positive weights mean that
events from higher density regions will be preferentially sampled.
Negative weights mean that events from low density regions will be
preferentially sampled. A weight of 0 means random sampling will be
performed, with no bias for density. In general values from -3 to 3 are
appropriate. In order to mimic Target Density sampling, positive
values between 0 - 1 are generally appropriate.
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Working with Amnis .DAF files
FCS Express 6 Image Cytometry and Plus are directly compatible with the Amnis
*.daf file format to allow loading of native .daf files and the images associated
with them (in .cif format) in FCS Express.
Amnis .daf files behave just like any other data file in FCS Express for inserting
plots 171 , creating, gates, and deriving statistics 316 . Single cell images may be
accessed via a Data Grid which serves as an Image Gallery just as with any other
image cytometry data file formats in FCS Express.
Please note that .DAF files can be loaded with images or without image (numeric
data only) via the FCS Express User Options 236 depending on the needs of your
analysis. By default, if an Amnis .cif file with the same name as the corresponding
Amnis .daf file are located in the same folder, images will be loaded. If no Amnis
.cif file was created, or if the .daf files have been moved to a different folder
location than the .cif files, images will not be loaded.
Please see the following topics for working with data in FCS Express:
Analysis of Flow and Image Cytometry Data Files
Inserting plots 171
Using Data Grids as Image Galleries
Applying Gates to a Data Grid (Image Gallery) 677
Creating Gates on a Data Grid (Image Gallery) 679
Backgating on a Data Grid (Image Gallery) 677

316

To open an Amnis .DAF file in FCS Express:
1. Choose to insert a plot 171 or add a data file to the data list 786 .
2. Click on the Files of type drop down in the Select a Data File dialog (Figure
30.1)
3. Choose Amnis DAF File (*.daf) from the list.
4. Select the Amnis .daf file you wish to use.
5. Press OK.
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Figure 30.1 - Selecing the Amnis DAF File of type from the Select a Data File dialog.
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Picture Plots
Picture Plots are not available in FCS Express Flow IVD.
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Heat Maps
In high-throughput laboratories, flow cytometry and cell imaging are often done
in multiwell microtiter plates. The data from a 96-well microtiter plate, for
example, normally contains 96 separate data files. FCS Express can
automatically merge the files from any size plate into one dataset and associate
each "cell" with the particular well that it was located in. Even if samples were
acquired in tubes FCS Express can merge the individual files so they may be
represented in a heat map or "virtual plate".

A Heat Map is a graphical representation of your data in a plate-shaped grid with
each well of the plate color-coded based on the statistic being displayed. This
enables rapid visualization of wells and outliers by comparing the statistical data
in an individual well to the statistical data of the entire microtiter plate.
Heat Maps also provide a visualization when SPADE
is calculated with the
Transformations 934 navigator and applied. Please see the Working with SPADE
Transformations
section to learn how to use Heat Maps in conjunction with
SPADE transformations.
1024
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By choosing an appropriate color scheme and statistic to display, you can get an
overview of all of the wells in your experiment or node(s) within the SPADE tree
. You can also create Well Gates
to conveniently pool your data or identify
node(s) of interest within the SPADE tree .
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32.1

Working with Heat Maps
To display a Heat Map:
1. Select the Insert Other Plots Heat Map command.
2. Click (or click-drag) on your layout where you want the heat map to
appear.
3. Browse to the data file you wish to insert:
i. If you are loading a list of data files collected together in a microtiter
plate (e.g., data files derived from a BD HTS instrument), each file
will likely already contain a WellID keyword with the well position
for that sample. To open those files as a plate, choose FCS Plate
folder from the Files of type drop-down list in the Select a Data
File 76 dialog, open the folder that contains the files, choose any
individual well's file in that folder, and click Open File.
Note: The folder containing the files should also contain an extra
keywords file 654 to indicate the size of the plate, if this information is
not already present as keywords 704 in the data files. Ready-to-use
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extra keywords files indicating the size of the plate can be
downloaded from the De Novo Software web site.
ii. If you are loading a single file representing all the wells in a plate
(e.g., an Accuri .C6 or .CI file), choose the appropriate file type from
the Files of type drop-down list in the Select a Data File 76 dialog
(e.g., "BD Accuri .c6 Plate files"), and click Open File. No additional
extra keyword files will be required since both the WellID and plate
size are likely already contained in the data set.
iii. If you would like to display a heat map for a series of files that have
not been acquired in a microtiter plate (i.e. files that contain do not
contain a WellID keyword or the plate size), you may do so in the
following ways:
If you would like to control the well which the file will be
associated with, the folder containing the files should also contain
an extra keywords file 654 to indicate the size of the plate and
extrakeywordstable.csv file 648 indicating the WellID (or $WellID)
column with the well position for each file.
If you do not need to control which well the file will be associated
with, you can use the Merge FCS Files loader 658 which will load
samples into the plate map in the order they were selected
during the file merge. Setting the number of columns to display
will determine the plate format.
1058

iv. If you are visualizing SPADE tree please insert a Heat Map as
described in step 1 above and follow the instructions for Working
with SPADE transformations .
1033

v. If you are visualizing result of a k-Means clustering please insert a
Heat Map as described in step 1 above and follow the instructions
for Applying a k-Means cluster analysis 970 .

The data in a Heat Map is displayed as a two-dimensional grid of the wells on a
microtiter plate. For example, for a 96-well plate, the heat map contains eight
rows (labeled A through H) and 12 columns (labeled 01 through 12). The
parameter being displayed
is shown as the title of the y-axis. Each well
displays a color according to the chosen color scheme , and the well's radius
can be dependent upon a chosen parameter
(Figure 32.1).
1052
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You can now create Well Gates
to pool your data from multiple wells, and
display the parameters of each event on a per-well basis in a Data Grid .
1059
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Figure 32.1 Heat Map

When a Data Grid is displayed for the Heat Map, a Well column will be present
showing the well where each cell or event is located. The example below is from
an image cytometry experiment, where the Data Grid has been formatted as an
image gallery (Figure 32.2).
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Figure 32.2 Data Grid with Well Column

You can insert a table displaying the actual values from each well of your Heat
Map into a Text Box . For a 96-well microtiter plate, this will insert an 8 x 12
data grid. To do so, right-click on the Text Box, choose Insert Heat Map Stats
Grid, and select the Heat Map to use as a data source from the menu. (Figure
32.3). Tables can be displayed in Grid Layout Stats Grid, Column Order Stats
Grid, or Row Order Stats Grid .
1300
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Figure 32.3 - Insert Heat Map Stats Grid into a Text Box
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Grid Layout Stats Grid - displays the heat map well statistics in a table similar
to the heat map (Figure above).
Column Order Stats Grid - displays the heat map well statistics according to
the plate column order, ie, A01, B01, C01.... (Figure 32.4)
Row Order Stats Grid - displays the heat map well statistics according to the
plate row order, ie, A01, A02, A03.... (Figure below)

Figure 32.4 - Heat map stats grids displayed in Column and
Row order.

All stats grids may be copied and pasted into Excel or the table dragged into a
batch process export action 820 for easy reporting.

32.1.1

Choosing Parameters and Statistics
To select the parameter and statistic to display on the Heat Map, use one of the
following methods:
Select the Heat Map and use the Format tab Plot Options Overlays
command (Figure 32.5), and choose from the drop-down menus under
Heat Map Overlay Options.

Figure 32.5 - Heat Map Overlays Command from Ribbon
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Right-click on the Heat Map, select Format from the pop-up menu, choose
the Overlays category, and choose from the dropdown menus under Heat
Map Overlay Options (Figure 32.6).
Click and hold down the mouse button over the y-axis label and choose an
available parameter. Set the statistic to show using one of the above two
methods.

Figure 32.6 Heat Map - Setting the Statistic Parameter and Statistic to Show

The data that is displayed is a combination of the Statistic parameter and the
Statistic to show (e.g., Mean, Standard Deviation, CV, Median, # of events,
75%-ile) properties. FCS Express calculates the average of the statistic chosen
across all of the wells in the microtiter plate. Then, a color is displayed for each
well according to the color scheme property . The usual procedure is to assign
the color by comparing the value of the statistic in each well to either:
1055

The mean ± SD of the entire plate.
A predetermined threshold.
Choose the parameter from the Statistic parameter drop-down list. The list will
normally be populated by a wide range of parameters that were measured or
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calculated by your instrument. Select the Statistic to show from the predefined
statistics in the corresponding drop-down list.
Available Statistics to Show:
Min (or Max) value
The Min (or Max) value is calculated for each well
# of Event
The number of events is calculated for each well
% of parent
For a given overlay, the % of parent for a given well is
calculated as the number of events in that well (for that
overlay), divided by the number of events displayed on
the entire Heatmap (for that overlay), multiplied by 100.
E.g. If Gate 1 is applied to a given overlay of the
Heatmap plot, the % of parent for a given well of that
overlay is calculated as the number of events in that
well (for that overlay), divided by the number of events
of Gate 1 (i.e. the total number of events for that
overlay), multiplied by 100.
% of grandparent
not available
% of great grandparent not available
% of all cells
Same as % of parent but the total number of events in
the entire data file is used as reference.
Median (or Geometric The Median (or Geometric Mean, or Arithmetic Mean)
Mean, or Arithmetic
for the parameter selected in Parameter Statistics
Mean)
drop-dow menu is calculated for each well.
CV (or rCV)
The Coefficient of Variation (or the robust Coefficient of
Variation) for the parameter selected in Parameter
Statistics drop-dow menu is calculated for each well.
5%-ile (or, 25%-ile,
The selected 5th (or 25th, 75th, 95th) percentile for the
75%-ile, 95%-ile)
parameter selected in Parameter Statistics drop-dow
menu is calculated for each well.
Concentration
The concentration in each well is calculated based on
the Concentration 591 tool.
Standard Deviation
The Standard Deviation for the parameter selected in
Parameter Statistics drop-dow menu is calculated for
each well.
BD-rSD (or BD-rCV)
The BD robust Standard Deviation(or the BD robust
Coefficient of Variation) for the parameter selected in
Parameter Statistics drop-dow menu is calculated for
each well.
Please note: If a Statistic to Show for a well cannot be calculated, for
instance, the Geometric Mean of a negative value, the well will appear
"empty" with vertical and horizontal hatch marks
as in the screen shot to the right. Choosing a different Statistic to Show
may be appropriate.
A Heat Map can have a Gate set similar to any other plot in FCS Express. For
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example, you can draw a gate on a dot plot displaying the data and then drag
the gate onto the heat map. You can also set the gate using the drop-down list
in the Formatting window pictured above.
Radius Parameter and Statistic
FCS Express allows a statistic of a parameter be assigned to represent the well's
radius (Figure 32.7). The radius on the heat map can change based on the
statistic selected. Choose the parameter from the Radius Parameter dropdown list. Then, select from the Radius Stat drop-down list.

Figure 32.7 - A heat map using the number of events per well as the
radius statistic and the mean intensity as the heat statistic. Larger size
wells represent wells with more events present in the well.

32.1.2

Choosing a Color Scheme
To choose the color scheme on a heat map, select the Heat Map, and either:
Select the Format tab
32.8), or

2D Options

Color Levels command (Figure

Right-click on the Heat Map, select Format from the pop-up menu, then
choose Heat Map Color Levels.
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Figure 32.8 Formatting Color Level Options

The default settings are a Green-Red color scheme, a Style of Mean ± SD,
and 3.5 standard deviations on either side of the scale. This means that wells
close to the average for the statistic being displayed are colored black, wells that
are +3.5 SD from the average are pure red, and wells that are -3.5 SD are pure
green.
You can select another color scheme using the Selected Color Level drop-down
list.
Available color schemes are:
Rainbow
Threshold
Green-Red
Green-Blue
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Greyscale
Inverse Greyscale
The Threshold scheme has specific Color Level Properties related to the
threshold value (Figure 32.9).

Figure 32.9 Threshold Color Scheme

When the Selected Color Level or Style are set to Threshold, you can choose
a token (e.g., a statistic based on a control well) to represent the Threshold
Value by clicking on the
button, or simply type in an arbitrary freetext value.
Then, set the Below Threshold and Above Threshold colors using the dropdown lists. Wells whose value is below the threshold value will be displayed in the
first color, and wells with a value above the threshold value will be displayed in
the other color.
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Heat Map Specific Options
Heat Map Specific Options may be accessed by selecting the Heatmap, and
either:
Select the Format tab Plot Options
the ribbon bar (Figure 32.10), or

Specific Options command from

Right-click on the Heat Map, select Format from the pop-up menu, then
choose Heat Map Heat Map Specific Options.

Figure 32.10 The Heat Map Specific Options dialog when accessed via the ribbon
bar.

Heat Map Specific Options allow to modify two Heat Map properties:
Orientation. This option allow to display the Heat Map with Landscape or
Portrait orientation. For Heat Maps displaying SPADE, do not change this
setting.
Number of columns to display. This option applies to Heat Maps that
display Cluster Assignments from a k-Means transformation 960 and for heat
maps that are displaying merged files 658 . It allows you to specify how many
columns to display for Clustering Assignment rather than choosing a default
number of well columns to display. For merged data files it determines how
many columns wide the heat map should represent before "wrapping" to
the next row. For instance, if 96 samples are merged together that
represent a plate map, setting the value to 12 would result in a heat map
with 12 columns and 8 rows.
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Well Gates
You can set a gate on one or more wells in a heat map. The wells need not be
contiguous. To create a Well gate:
1. Select the Gating tab Create Gates Well command. (Alternatively,
right-click on the heat map and choose Create gate Well).
2. Click anywhere on the heat map. An Editing New Well Gate dialog (with
instructions) for the well gate will appear above the heat map (Figure
32.11).

Figure 32.11 Setting a Well Gate

To set the specific gate do one or more of the following:
Click on an individual well to select it as part of the gate.
While holding the Ctrl key, click on multiple wells.
Click and drag a rectangle across multiple wells to select all wells within the
rectangle as part of the gate.
The Create New Gate dialog will appear. Choose a name and color, and click
on OK.
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The well(s) in the gate will be outlined by a circle that is the same as the gate
color (e.g., the wells outlined in light blue in Figure 32.12).

Figure 32.12 - Well Gate. Three wells are outlined in blue (rows
E-G, column 03)

To change the gate you just created, click or click-drag on new well(s). The
original well(s) will no longer be part of the gate.
To extend the gate you just created to additional wells, hold down the Ctrl key
while clicking on individual wells (or while dragging a rectangle across a group of
cells). The new well(s) will be added to the original well(s) in the gate. Notice a
non-contiguous region was selected (Figure 32.13).
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Figure 32.13 Well Gates. Four new wells (rows E-F, columns
09-10) have been added to the previous gate by holding down the
Ctrl key when dragging across the new wells.

Click Close when you are finished editing.
To activate (and modify) an existing Well gate, right-click on the Heat Map,
select Edit gate, and choose the gate to activate from the submenu.

32.1.5

Heat Map Overlays
FCS Express allows users to view multiple statistics and parameters from a high
content experiment in a single heat map by adding each statistic as a new
overlay. Each well is represented by a circle with each overlay represented as a
slice similar to a pie chart. Different overlays may represent different parameters
and statistics from the same data set or multiple data sets. One Color Level
will be applied globally to all overlays of a Heat Map.
1055

To create a heat map overlay (Figure 32.14):
1.) Right-click on the Heat Map.
2.) Click Add overlay from pop-up menu.
3.) Select data files(s) to use for the overlay from Select a Data File dialog
(note that the existing data file may be chosen in the Data List tab or new files
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accessed in the File Dialog tab).
4.) Click Open.

Figure 32.14 - Adding Overlays to a Heat Map, Steps 1-4.

5.) Choose 2D Plot(s) under 2D Plot Selection.
6.) Select the parameter to use for the overlay from the Y-Axis Parameter
list.
7.) Click OK.
The new overlay will be added to the heat map as in Figure 32.15.
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Figure 32.15 - Adding Overlay to Heat Map, Steps 5-7.

The first overlay occupies the lower-right sector of the well, while new overlays
are added in a clockwise fashion (Figure 32.16).
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Figure 32.16 - New
overlay sectors added in
clockwise fashion to
Heat Map, starting from
lower-right sector.

Please note when visualizing SPADE, only one SPADE tree may be displayed on a
Heat Map.

32.1.6

Formatting Heat Map Overlays
Once overlays have been added to a Heat Map, they can be edited similarly to
other overlays much like Histogram Overlays 267 and 2D Plot Overlays 283 .
The Overlays option controls the parameter, statistics to display,
compensations, transformations, gates, and appearance of heat map overlays.
All heat maps have at least one overlay representing a file and well parameter to
display. You can add additional overlays by any of the following methods:
Right-click on the plot and select Add overlay from the pop-up menu, or
Drag-and-drop file(s) from the Data List
overlay, or

783

onto the plot you wish to

Drag-and-drop a plot from the layout onto the plot you wish to overlay.

You can edit overlays in one of two ways:
Select the heat map and use the Format
command.

Plot Options

Right-click on the map, select Format from the pop-up menu, and choose
the Overlays category (Figure 32.17).
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Figure 32.17 - Editing a Heat Map Overlay

In the dialog, a list of all the overlays on the heat map will appear in the list box
to the left . You can select one or more overlays using standard Microsoft
Windows techniques, including Shift-Click and Ctrl-Click. The properties on the
right
pertain to the currently selected overlay(s). If multiple overlays are
selected, the information will appear blank for those properties that are not
identical in all selected overlays. If the properties are not blank, then they are
identical for all selected overlays. Changing an option will change that property
for all selected overlays. For instance, if you select three overlays and change
the Gate, the Gate for all three overlays will be modified.
To remove an overlay from a plot, select the overlay (or multiple overlays) and
press the Remove button.
To change the order of selected overlay(s) in the legend 251 , use the blue up and
down arrows (

).

Heat Map Overlay Options are explained in the table below.

Option
Well
parameter
© 2020 De Novo Software
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Option
Statistic
parameter

Explanation
A drop-down menu to select the parameter from which a
statistic will be chosen to be displayed. Please refer to the
Setting the Parameter to Display
chapter for more details.
Statistic to
A drop-down menu to select the statistic 379 to show as an
show
overlay on the heat map. Please refer to the Setting the
Parameter to Display
chapter for more details.
Compensation If compensation definitions 622 are set, select the definition to use
when compensating the data in the overlay.
Transformatio If transformations 934 are applied to the data set, select the
n
transformation to use when transforming the data in the
overlay.
Gate
If gates are defined 316 , select the gate that will be used to limit
the data that is displayed on the histogram.
Radius
Optional: A drop-down menu to select the parameter from
Parameter
which a Radius statistic will be chosen. A Radius parameter
must be chosen to use a Radius statistic.
Radius
Optional: A drop-down menu to select the statistic to adjust the
Statistic
radius of each well.
Legend Text The text that will appear in the legend beside the symbol for the
overlay. If this field is blank the file name of the overlay will
appear. Insert keywords from the header of the data file by
pressing the ellipsis next to the legend text. You can also display
the current gate applied to the overlay by typing
"<$FCSE_GATEFORMULA>" into the legend text.
Change data If this option is checked, the data file for this overlay will change
file during
when doing batch processing 782 , or selecting Previous File or
Next/Prev/
Next File 72 . This option is usually only disabled for a control
Batch
histogram, where you have multiple overlays, and want the
control to stay the same all of the time.
Visible
You can hide overlays on a heat map without removing them.
Select the overlay file from the list and uncheck Visible. Check
Visible to show the overlay again.
1052
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32.2

Working with Index Sort Data in Heat Maps
Index sorting allows researchers to review the complete phenotype of every
single event sorted into a plate and associate that event with all sorted and non
sorted events. FCS Express allows for analysis and reporting of index sorting
data using Heat Maps along with the standard plot offerings 170 . For index sort
data, Heat maps will display the number of events (usually one) and parameter
based phenotypic data for all sorted events. Wells may be gated on individually,
or as groups, with the well gates backgated onto other plots to view the
individually sorted cells in context of the entire acquired/sorted samples. All heat
map functionality is available for use with index sorting data.
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FCS Express currently supports index sorting data files from the following
instruments:
Influx (BD Biosciences)
Summit Software (Beckman Coulter)
Diva (BD Biosciences)
Chorus (BD Biosciences)
1067

1070

1074

1080

32.2.1

Influx Index Sorting Data Files
Influx Index Sorting Data Files contain fluorescence information on both the
sorted and unsorted events. To isolate the sorted events:
1. Insert a heat map
for the index sort data file.
2. Select the parameter of interest on the y-axis (heat maps will contain
only Index Sorted Data) (Figure 32.18).
1048

Figure 32.18 Default Heat Map with GFP Arithmetic Mean Y
Parameter

3. Insert a Color Dot Plot 170 .
4. Change the axes on the color dot plot to the parameters of interest.
5. Create a Well Gate
on all wells.
Notes:
o In addition to creating a gate on all wells a gate may be
1059
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created on one, or any number of wells, to visualize the
individually sorted cells.
o Since Influx Index Sorting Data Files also contain data for the
unsorted events, we can use the Emphasize on Plots 321
feature of gates to differentiate the sorted from non sorted
events (Figure 32.19).

Figure 32.19 Heat map with Well Gate created on all wells. Standard gate is
shown above while a gate with the Emphasize on Plots check box checked
is shown below. Note that events highlighted in green fall within the well
gate and in this case represent all events that were sorted into the plate.

6. Optional: Apply the Well Gate created in step 3 to the color dot plot
to only view Index Sorted Events (Figure 32.20).
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Figure 32.20 Color Dot Plot gated on Well
Gate with events emphasized

It is possible to insert a heat map statistics grid
in a text box to display
statistics for each well in the heat map as done in Figure 32.21.
1052

Figure 32.21 Heat Map Statistics Grid displaying statistics for the Y parameter of
the Heat Map

Another useful feature for index sorting data is the Heat Map Overlay
function.
Heat Map Overlays allow a user to view multiple statistics and parameters on a
single heat map by adding each statistic as a new overlay. For instance, in Figure
32.22 left, the upper slice of the well represents PE-CY7 arithmetic mean while
the lower slice represents GFP arithmetic mean so single and double positive
events can be more easily visualized.
1061

Additionally, users may add a Radius Statistic , which changes the size of the
well to reflect the selected parameter. For instance, in Figure 32 below (right),
the heat/color for each well is dependent on the GFP arithmetic mean while the
size of the well radius is dependent on the PE-Cy7 arithmetic mean.
1061

Please see the Heat Map Overlay
section of the manual for full instructions on
how to create a heat map overlays of different parameters and types as well as
1061
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setting the radius parameter statistic.

Figure 32.22 Custom Heat Maps with Overlay (left) and Radius Parameter (right).
Standard Deviations of Color Levels was changed to 1.

32.2.2

Summit Index Sorting Data Files
Summit Index Sorting Data Files contain fluorescence information on both the
sorted and unsorted events. To isolate the sorted events:
1. Insert a heat map
for the index sort data file.
2. Select the parameter of interest on the y-axis (heat maps will contain
only Index Sorted Data) (Figure 32.23).
1048
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Figure 32.23 Default Heat Map with FL5 Arithmetic Mean Y
Parameter

3. Insert a Color Dot Plot 170 .
4. Change the axes on the color dot plot to the parameters of interest.
5. Create a Well Gate
on all wells.
Notes:
o In addition to creating a gate on all wells a gate may be
created on one, or any number of wells, to visualize the
individually sorted cells.
o Since Summit Index Sorting Data Files also contain data for
the unsorted events, we can use the Emphasize on Plots 321
feature of gates to differentiate the sorted from non sorted
events (Figure 32.24).
1059
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Figure 32.24 Heat map with Well Gate created on all wells. Standard gate is
shown above while a gate with the Emphasize on Plots check box checked
is shown below. Note that events highlighted in red fall within the well gate
and in this case represent all events that were sorted into the plate.

6. Optional: Apply the Well Gate created in step 3 to the color dot plot
to only view Index Sorted Events (Figure 32.25).
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Figure 32.25 Color Dot Plot gated on Well
Gate with events emphasized

It is possible to insert a heat map statistics grid
in a text box to display
statistics for each well in the heat map as done in Figure 32.26.
1052

Figure 32.26 Heat Map Statistics Grid displaying statistics for the Y parameter of
the Heat Map

Another useful feature for index sorting data is the Heat Map Overlay
function.
Heat Map Overlays allow a user to view multiple statistics and parameters on a
single heat map by adding each statistic as a new overlay. For instance, in Figure
32.27 left, the upper slice of the well represents FL13 arithmetic mean while the
lower slice represents FL5 arithmetic mean so single and double positive events
can be more easily visualized.
1061

Additionally, users may add a Radius Statistic , which changes the size of the
well to reflect the selected parameter. For instance, in Figure 32 below (right),
the heat/color for each well is dependent on the FL5 arithmetic mean while the
size of the well radius is dependent on the FL13 arithmetic mean.
1061

Please see the Heat Map Overlay
section of the manual for full instructions on
how to create a heat map overlays of different parameters and types as well as
setting the radius parameter statistic.
1061
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Figure 32.27 Custom Heat Maps with Overlay (left) and Radius Parameter (right).
Standard Deviations of Color Levels was changed to 1.

32.2.3

Diva Index Sorting Data Files
Diva Index Sorting Data Files contain fluorescence information only on the
indexed sort events. A larger "master" .fcs file contains information on all of the
events collected during a sort while a single, or number of, smaller .fcs files
contain only the sorted events. See Figure 32.28 below where the master file is
354 kB in size while the file containing only sorted events is 7 kB in size. These
two files may be used individually or in conjunction via plot overlays to help
visualize index sorting data acquired with Diva.

Figure 32.28 Diva Index Sorting Data Files. Note the larger sized "master" file that
contains all events collected and the smaller size file that only contains sorted
events.

To analyze Index Sort Data:
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1. Insert a heat map
for the index sort data file.
2. Select the parameter of interest on the y-axis (Figure 32.29).
1048

Figure 32.29 Default Heat Map with FITC Arithmetic Mean Y
Parameter

3. Insert a Color Dot Plot 170 .
4. Change the axes on the color dot plot to the parameters of interest.
5. Create a Well Gate
on all wells.
Notes:
o In addition to creating a gate on all wells a gate may be
created on one, or any number of wells, to visualize the
individually sorted cells.
o Since Diva Index Sorting Data Files only contain data for the
unsorted events, we can use the Emphasize on Plots 321
feature of gates to emphasize the events that fall within the
gate (Figure 32.30).
1059
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Figure 32.30 Heat map with Well Gate created on all wells. Standard gate is
shown above while a gate with the Emphasize on Plots check box checked
is shown below. Note that events highlighted in red fall within the well gate
and in this case represent all events that were sorted into the plate making
them easier to visualize.

6. Optional: Create additional Well Gates to isolate an individual well
(blue event) or a group of wells (purple events) (Figure 32.31).
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Figure 32.31 Color Dot Plot gated on Well Gate with Children Gates
Applied and Emphasized

In the event that you would like to compare the master file to the Index Sort
File, you can create a Color Dot Plot Overlay 285 with increased dot size for the
Index Sort Data. To do so:
1. Insert a Color Dot Plot for the larger "master" file.
2. Change axes to reflect parameters of interest (Figure 32.32).

© 2020 De Novo Software

1078

FCS Express 6 Manual

Figure 32.32Color dot plot of the
"master" file (largest file in the data
directory).

3. Drag and drop index sort data file (smaller data file in the data
directory) from the data list onto the Color Dot Plot.
4. Select add the files to the plot as new overlays radio button
(Figure 32.33).

Figure 32.33 Select Drag and Drop Action
Window to add Overlays to Color Dot Plot

5. Click OK.
6. Right click on the color dot plot.
7. Select Format.
8. Chose the Overlays category.
9. Select the second overlay.
10. Increase the Dot Size to 5.
11. Click OK (Figure 32.34).
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Figure 32.34 Adding an Overlay to Color Dot Plot with increased dot size for
the index sorted data file.

It is possible to insert a heat map statistics grid
in a text box to display
statistics for each well in the heat map as done in Figure 32.35.
1052

Figure 32.35 Heat Map Statistics Grid displaying statistics for the Y parameter of
the Heat Map

Another useful feature for index sorting data is the Heat Map Overlay
function.
Heat Map Overlays allow a user to view multiple statistics and parameters on a
single heat map by adding each statistic as a new overlay. For instance, in Figure
32.36 left, the upper slice of the well represents PE arithmetic mean while the
lower slice represents FITC arithmetic mean so single and double positive events
can be more easily visualized.
1061

Additionally, users may add a Radius Statistic , which changes the size of the
well to reflect the selected parameter. For instance, in Figure 32 below (right),
the heat/color for each well is dependent on the FITC arithmetic mean while the
1061
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size of the well radius is dependent on the PE arithmetic mean.
Please see the Heat Map Overlay
section of the manual for full instructions on
how to create a heat map overlays of different parameters and types as well as
setting the radius parameter statistic.
1061

Figure 32.36 Custom Heat Maps with Overlay (left) and Radius Parameter (right).
Standard Deviations of Color Levels was changed to 1.

32.2.4

Chorus Index Sorting Data Files
Chorus Index Sorting Data Files only allow for analysis on indexed sort events.
To analyze Index Sort Data:
1. Insert a heat map
for the index sort data file.
2. Select the parameter of interest on the y-axis (Figure 32.37).
1048
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Figure 32.37 Default Heat Map with PerCP Arithmetic Mean Y
Parameter

3. Insert a Color Dot Plot 170 .
4. Change the axes on the color dot plot to the parameters of interest.
5. Create a Well Gate
on all wells.
Note:
o In addition to creating a gate on all wells a gate may be
created on one, or any number of wells, to visualize the
individually sorted cells.
o Since Chorus Index Sorting Data Files only contain data for
the unsorted events, we can use the Emphasize on Plots 321
feature of gates to emphasize the events that fall within the
gate (Figure 32.38).
1059
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Figure 32.38 Heat map with Well Gate created on all wells. Standard gate is
shown above while a gate with the Emphasize on Plots check box checked
is shown below. Note that events highlighted in red fall within the well gate
and in this case represent all events that were sorted into the plate making
them easier to visualize.

6. Select the Insert tab General Gate View command to insert a
Gate View 343 .
7. Drag and Drop the Well Gate from the Gate View to the Color Dot Plot
to apply the Well Gate (Figure 32.39).
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Figure 32.39 Color Dot Plot gated on Well
Gate with events emphasized

8.Optional: Create additional Well Gates to isolate any number of
individual wells (blue events below) or a group of wells (purple events
below) (Figure 32.40).

Figure 32.40 Color Dot Plot gated on Well Gate with Children Gates
Applied and Emphasized
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It is possible to insert a heat map statistics grid
in a text box to display
statistics for each well in the heat map as done in Figure 32.41.
1052

Figure 32.41 Heat Map Statistics Grid displaying statistics for the Y parameter of
the Heat Map

Another useful feature for index sorting data is the Heat Map Overlay
function.
Heat Map Overlays allow a user to view multiple statistics and parameters on a
single heat map by adding each statistic as a new overlay. For instance, in Figure
32.42 left, the upper slice of the well represents FITC arithmetic mean while the
lower slice represents PerCP arithmetic mean so single and double positive
events can be more easily visualized.
1061

Additionally, users may add a Radius Statistic , which changes the size of the
well to reflect the selected parameter. For instance, in Figure 32 below (right),
the heat/color for each well is dependent on the PerCP arithmetic mean while the
size of the well radius is dependent on the FITC arithmetic mean.
1061

Please see the Heat Map Overlay
section of the manual for full instructions on
how to create a heat map overlays of different parameters and types as well as
setting the radius parameter statistic.
1061

Figure 32.42 Custom Heat Maps with Overlay (left) and Radius Parameter (right).
Standard Deviations of Color Levels was changed to 1.
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Electronic Signatures
FCS Express supports a comprehensive set of features to allow you to manage
and record electronic signatures.
Electronic signatures generally work in conjunction with the security features .
With the security features activated, a new Electronic Signatures gallery will be
present when you select File tab Info
(Figure 33.1).
1140

Figure 33.1 Electronic Signatures Gallery
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Click on the black triangle to Sign, Unsign or to view the Signature List .
The number and types of signatures can be completely defined by the user. If the
logging features are activated, FCS Express will keep a record of all signing and
unsigning events.
1096

33.1

Maintaining Signatures
Signatures can be maintained from the Signature List dialog (Figure 33.2) by
selecting the File tab Info Electronic Signatures
command.

Figure 33.2 Signature List Dialog

When you are finished adding , modifying , or deleting
OK to save your changes or Cancel to discard them.
1087

33.1.1

1088

1089

signatures, press

Adding Signatures
To add a new signature:
1. Use the File tab Info
Signature List
command to bring up the Signature List dialog.
2. Press the Add button. A new signature will appear in the list box on the left
(Figure 33.3).
3. Type a name for the signature into the Signature Name field.
4. Under the Allow signature for section, select the User Group
for which
the signature is to be enabled.
1172
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Figure 33.3 Adding a New Signature

The signature properties are described in the section on Modifying Signatures

33.1.2

1088

.

Modifying Signatures
To modify an existing signature:
1. Use the File tab Info
Signature List command to
bring up the Signature List dialog (if it isn't already visible).
2. Select the signature to modify in the list box on the left. The properties for
that signature will appear in the Signature Properties portion of the
window (Figure 33.4).
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Figure 33.4 Modifying a Signature

Signature properties are defined in the table below.

Property
Signature Name

Explanation
The name of the signature as it will appear in a token in the layout.
It usually corresponds to the specific state of the layout (e.g.,
under review, approved, etc.).
Allow signature for Only users who are members of the security groups 1171 that are
checked will be allowed to sign under this signature.
Description
A short description of the signature. This is used for reference
purposes only.
Notes
Notes associated with the signature

33.1.3

Deleting Signatures
To delete a signature:
1. Use the File tab Info
command to bring up the Signature List dialog.
2. Select the signature from the list on the left.
3. Press the Delete button.

33.2

Signature List

Signing Layouts
To sign a layout, use the File tab Info
command to bring up the Sign dialog (Figure 33.5).
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Figure 33.5 Signing a Layout

The list on the left will show signatures that are allowed, based upon the current
user’s security group.
Press the Sign button to sign the layout. An optional note or comment can be
entered in the Notes field. After pressing Sign, the user will be required to
confirm their password.

33.3

Unsigning Layouts
To unsign an already signed layout, use the File tab Info
ign command to bring up the Unsign dialog (Figure 33.6).
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Figure 33.6 Unsigning a Layout

The list on the left will contain the current user's signatures for the present
layout. Select the signature you wish to remove and press the Unsign button.
An optional note can be entered in the Notes field. After pressing the Unsign
button, the user will be required to confirm their password.

33.4

Displaying Signature Information
Once you have created and set up your signatures
in FCS Express, you may
want to display their details and signing status
on your layout pages.
1087

1096

By default, the signature
details and status do not appear on a layout page.
However, you can easily display the information about the signatures
using
signature tokens 688 .
1087

1087

A signature token can display the following kinds of information (Figure 33.7):
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1. Signature
Name
2. Signature
Description
3. Signature
Status
Never
Signed|
Signed|
Unsigned
4. Signature
Date
5. Signature
Time
6. Signature
Signer
Never
Signed or
Name
7. Signature
Stamping
Notes
1096

Figure 33.7 Signature tokens available in FCS Express.

To display the signature tokens, you need to first create a text box . Once you
have the text box , there are two ways to insert signature tokens into the text
box :
1300

1300

1300

1. Using the signature table
Right-click in the text box, and select Insert Signature Table. A table will
be created inside the text box, as shown below (Figure 33.8).
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Figure 33.8 Inserting a signature
table.

2. Using individual signature tokens
a. Right-click in the text box, and select Insert Token
Token 688 window will appear (Figure 33.9).

688

. The Insert a

Figure 33.9 The insert token window.

b. In the Insert a Token 688 window, expand the Signature
node then
select the type of signature
information you want to display, and press Insert
(in this example we will choose Signature Name) (Figure 33.10). The token
1087

1087
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editor will appear.

Figure 33.10 Inserting a token.

c. In the token editor click on the Signature information category to
confirm your choice (Figure 33.11).
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Figure 33.11 Signature information in the Create Signature Token window.

Note: You will notice in the Signature information category you have the
option to choose any defined signature from the Signature drop down. You can
choose which signature token you would like to insert from the Token Type
radio buttons. This is useful if you would like to edit or change the token in the
layout without deleting and inserting a new token.
d. Click OK to insert the token.

Figure 33.12 The signature token
inserted in a text box.

The new signature token will appear in the text box as in the image above
(Figure 33.12).
As with other tokens, you can change the formatting of individual signature
tokens, for instance to mimic a typical signature section on a printed report.
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Signature Status
Once you have created and set up your signatures
in FCS Express, you may
want to display their signing status on your layout pages.
1087

Signature Status can be designated as:
Never Signed - Indicates the signature has never been signed.
Signed - Indicates the signature is currently signed.
Unsigned - Indicates that the signature has been signed at least once and is
currently unsigned.
You may also create a custom signing status using custom tokens 725 to hide the
signature status if the layout has never been signed or has been unsigned. A
custom token 725 of this type will therefore only display the signature status when
the layout has been signed. Instructions for creating this type of custom token 725
can be found in the hiding signature tokens 732 section of the custom tokens 725
chapter.
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Layout History
FCS Express tracks every action performed by a user on a layout. To view the
history, use the File tab Info View Layout History command to bring up
the Layout History Viewer window (Figure 34.1).

Figure 34.1 Layout History Viewer

Every action performed contains the following information:
In the Action column, there is a description of the action performed.
If security is enabled, the User Name column lists the name of the user
who performed the action.
The Date column shows the date when the action was performed.
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The Time column contains the time the action was performed.
Some actions also cause other actions to be performed. For example, when
creating a gate, a text box is also automatically created. All of the associated
actions are grouped under a single entry. In the figure, the Open Dot entry at
the top of the list box contains two history sub-entries, Compensation Create
and Open 2D Plot. To view all history entries for an action, click on the + to the
left of the text of the action. The lower text region of the Layout History
Viewer contains more details about the currently selected action.
You can Print the layout history or Save it as a PDF.
The Layout History may also be cleared:
Select Clear Layout History at the bottom of the Layout History Viewer
dialog (Figure 34.2 Step 1).
Enter a Note and press OK (Figure Below, Step 2) in the Clear Layout
History dialog.
The Layout History will be cleared and a single action referring to the clearance
will be listed in it (Figure Below, Step 3).

Figure 34.2 Layout History can be cleared via the Clear Layout History button.
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Standard Operating Procedures
To help maximize efficiency and quality of routine analysis workflows, FCS
Express allows user to create Standard Operating Procedures (SOP's), which
are sets of step-by-step instructions and actions to perform in FCS Express.
These steps allow you to create a predetermined procedure in your FCS Express
layouts in which each step can be conditionally formatted with tokens so that a
requirement must be met before the next step is performed. For instance, a user
may not proceed to the next step unless the number of events in a gate is
above a certain threshold value or text has been entered in a field.
Jump to:
Accessing and Navigating SOP's
Creating SOP's
Reordering SOP Steps
Deleting SOP Steps
Using SOP Permission Rules
Running SOP's
Displaying SOP information and SOP tokens
1103

1104

1107

1107

1108

1108

1111

The Standard Operating Procedure feature in FCS Express
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Accessing and Docking SOP Navigator
To access the Standard Operating Procedures navigator, click on the Quality
tab
Standard Operating Procedures command (Figure 35.1).

Figure 35.1 Accessing SOP navigator

To dock the SOP navigator, click and drag the window's title bar to an edge of
the layout to activate docking zone sectors. Select the area by releasing mouse
on docking zone sector of choice (Figure 35.2). See docking a window 115 for
more details.

Figure 35.2 Docking SOP navigator
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Creating the SOP
Standard Operating Procedures are created in a step-wise manner. Steps
may simply be instructions to follow in the Instructions field or may include
conditions that must be met before the next step in the SOP may be accessed.
Conditions, can be specified in the Condition for moving to the next step field
of the SOP dialog.
For instance, in the example below, Figure 35.3, a formula was defined in the
Condition for moving to the next step field for the Beads Gate step (Step 1).
When the SOP is run, the step may not be advanced until the token value meets
the criteria of being above the reference value (0). In this case, the step is meant
to check to make sure events are present in the gate before proceeding to the
next step. Any tokens may be used to set a conditional custom value and may
be inserted 688 via right click in the Condition for moving to the next step field,
Insert Token.
Any manually entered value or token in FCS Express 688 may be used in the
Condition for moving to the next step. Tokens derived from the SOP itself
may also be used
and there are a number of specialized SOP functions
available within the custom token functions list 778 .
1111

Values must be evaluated to "true" to allow advancing to the next step. Please
see the examples below
showing how a condition may be evaluated to allow
moving to the next step.
1106

Providing detailed instructions in the Instructions field is highly recommended,
so users may easily follow the necessary steps to advance when Running the
SOP .
1108
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Figure 35.3 - An SOP has been defined where the first step is dependent on the
Condition for moving to the next step. In this example, the condition requires that
the number of events in the beads gate must be greater than 0.

To create a series of Standard Operating Procedure steps, add steps using
SOP navigator (Figure 35.4):
1.) Click

to add new step.

2.) Rename the New SOP Step by clicking the
icon. Alternatively, right-click
on the step and select Rename, or highlight the step and press F2.
3.) Enter information into Short Description field. The text in the Short
Description field will appear in the Description area when running the SOP .
4.) Populate Instructions field. The text in the Instructions field will appear in
the Instructions area when running the SOP .
Optional: Create a token expression to control advancing to next step in SOP
if by entering an "=" sign under Condition for moving to the next step.
5.) Right-click next to "=" sign in the field.
6.) Choose Insert Token.
7.) Choose a token to evaluate.
8.) Repeat steps 1-8 to add more steps until complete.
1108

1108
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Figure 35.4 Adding Steps to SOP

Use case examples of formulas to evaluate a result for
moving to the next step
Allow moving to the next
SOP step only if...
Token1 is higher then a given
value (i.e. 50)
Token1 is lower then Token2

Condition for moving to the
next step formula
=Token1>50

Equivalent
formula

=Token1<Token2
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Checkbox1 is checked

=CheckBox1=-1

Token1 and Token2 are both
higher than zero

=(Token1>0)and(Token2>0)

35.3

1107

=IsTrue(Check
Box1)

Changing Order of SOP Steps
The order of steps in an SOP may be rearranged easily by using drag and drop.
1.
2.
3.
4.

Click on SOP step to highlight it.
Hold the left mouse button.
Drag the step into the new position.
Release the mouse when blue line is positioned where desired (Figure 35.5).

Figure 35.5 Changing Order of Steps in SOP by clicking and dragging

The order of steps will update accordingly and may also be displayed in the
layout .
1111

35.4

Deleting SOP Step
Using the SOP navigator, steps may be deleted by:
1. Click on the step to highlight it.
2. Click on the
(Figure 35.6 left). Alternatively, right-click on the step and
choose Delete (Figure below - right).
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Figure 35.6 Deleting SOP steps.

The order of steps will update accordingly due to the deleted step and may also
be displayed in the layout .
1111

35.5

SOP Permission Rules and Authorizations
Permission Rules
and Authorizations
may be used in conjunction with
SOP's to allow or deny users of the layout to perform specific actions or to Edit/
Select objects.
1118

1134

Please see the Permissions Rules
section of the manual to learn more about
locking down specific actions that may be performed in the layout.
1118

Please see the Authorizations
section of the manual to learn more about
allowing or never allowing selection or editing of plots. Authorizations may also
be conditionally formatted
to allow or never allow editing or selecting of
objects.
1134

1136

35.6

Running SOP
The Run SOP command begins the step wise process of running through all of
the steps defined in the SOP creation process . When the Run SOP command
is selected from the Quality tab
the Standard Operating Procedure
dialog will appear (Figure 35.7) and will display the first step defined. The
Description area will display the information entered in the Short Description
field, the Instructions area will display the information entered in the
Instructions field . The current result of the condition (satisfied or not satisfied),
1104

1105

1105
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if any, is also reported in the SOP dialog.
The left and right arrows in the bottom right of the dialog (figure below) will allow
the user to advance or go back through the Standard Operating Procedure
steps. If an Condition for moving to the next step
conditional statement
was defined, the user will not be able to advance until the condition is met.
1105

To run an SOP (Figure below):
1.) Click on the Quality tab
command to launch the
Standard Operating Procedure dialog.
2.) Perform the instructions indicated in the Instructions area.
3.) Click on the right arrowheads in lower right of SOP dialog to advanced
through the SOP steps. Note that if an Condition for moving to the next step
was defined the condition must be met before you are allowed to advance.
4.) Optional: Click on the left arrowhead to go back to the previous SOP step.

1105

Note: The SOP Runner window is now dockable
other actions while the SOP runs.

115

, so that you may perform

Once all SOP steps have been completed the Standard Operating Procedures
dialog will close.
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Figure 35.7 Opening SOP Window from ribbon

If the Standard Operating Procedure was run to completion previously, a
message will appear and ask if you wish to restart the SOP (Figure 35.8).
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Figure 35.8 Run SOP Message

35.7

Displaying SOP Information and SOP tokens
Once you have created an SOP in FCS Express, you may want to display the
details on your layout pages.
SOP's details and status information can easily be displayed using the Insert
SOP table when right clicking in any text box 152 or by using tokens 688 .
An SOP token can display the following kinds of information:
SOP Token Type
Number of SOP
steps
Current SOP step
name
Current SOP step
internal ID
Current SOP step
order number
Current SOP step
description
Current SOP step
completion date
SOP step name

Explanation
The total number of steps in an SOP
The name of the currently active step when running SOP
as defined by the user
The internal ID of the currently active step when running
SOP
The step order number when running SOP
The step description when running SOP
The last date the current SOP step was completed on.

The name of the selected step from the Create SOP
Token dialog
SOP step internal ID The internal ID of the selected step from the Create
SOP Token dialog
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SOP step order
The step order number of the selected step from the
number
Create SOP Token dialog
SOP step description The step description of the selected step from the
Create SOP Token dialog
SOP step completion The last date the selected step from the Create SOP
date
Token dialog was completed on
To display the SOP tokens, you need to first create a text box
ways to insert SOP tokens into the text box :

1300

. There are two

1300

Using the SOP table
1. Right-click in the text box.
2. Select Insert SOP Table.
A table will be created inside the text box, as shown below (Figure 35.9).

Figure 35.9 Inserting the SOP Table

Using individual SOP tokens
1. Right-click in a text box.
2. Select Insert Token 688 . The Insert a Token
35.10).

688

window will appear (Figure
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Figure 35.10 Insert Individual SOP tokens

3. Click on the SOP node.
4. Select the type of SOP information you want to display.
5. Press Insert (in this example, we will choose SOP step name) (Figure
35.11). The Create SOP token dialog will appear. Note: if the SOP is not
running when any of the follow tokens are inserted, "SOP is not running" will
be the token value's display text in the text box: Current SOP step name,
Current SOP step internal ID, Current SOP step order number, Current
SOP step description, and Current SOP step completion date.
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Figure 35.11 SOP Tokens

6. Choose the SOP Information category in the Create SOP Token dialog.
7. Select the Linked SOP step name from Token to Display drop down list.
8. Choose the step of interest from the Sop Step drop down list under Linked
SOP Step (Figure 35.12).
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Figure 35.12 SOP Token Editor

9. Click OK. The token will appear in the text box (Figure 35.13).

Figure 35.13 Text box with
Inserted Token

As with other tokens, you can change the Common Token Properties 692 of
Display Text and Font of individual SOP tokens in the SOP Token Editor.
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Permission Rules
Permission Rules allow you to set available permissions
specific to a layout.
They may be activated or disabled manually or via formula statements
in the
Permission Rules navigator. Please note that layout based
and user based
security group permissions will always take precedence over permission rules.
1125

1122

1177

Permission Rules can be accessed via the Quality tab
Rules button.(Figure 36.1).

SOP

1171

Permission

Figure 36.1 - Accessing the Permission Rules navigator.

The Permission Rules navigator will appear (Figure 36.2) allowing you to create
and edit Permission Rules.
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36.2 - The Permission Rules navigator.

The top menu bar of the Permission Rules navigator allows you to (Figure
36.3) :
1. Create a new rule.
2. Create a new permission rule folder.
3. Delete one or more permission rules.
4. Rename the selected rule.
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5. Access the permission rule option.

Figure 36.3 - The Permission Rules navigator menu bar.

36.1

Creating a Permission Rule
To create a new Permission Rule first open the Permission Rules navigator
using the Quality tab

SOP

Permission Rules button. The Permission Rules

navigator will appear.

Click on the

button to create a new Permission Rule (Figure 36.4). A New

Rule will populate the Permission Rule window.
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36.4 - The Permission Rules navigator.

The new Permission Rule is named as New Rule by default but it can be easily
renamed by either of the following methods:
Right click on the Permission Rule that needs to be renamed and select
Rename from the right click menu.
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Select the Permission Rule that needs to be renamed via left click and press
F2 on your keyboard.
Select the Permission Rule that needs to be renamed via left click and click on
the

button in the Permission Rule window.

A free-text description of the Permission Rule can also be added in the Rule
Description field of the Permission Rule window.

The Actions secured by this rule section of the Permission Rule window
contains the list of action that can be locked down via the permission rule. A
complete list of actions that can be secured via a Permission Rule can be found in
the Available Permission Rules section

1125

.

The following buttons are available in the Actions secured by this rule section
of the Permission Rule window:
Select All: to select all the available actions.
Deselect All: to deselect all the available actions.
Save

Save Permissions to File: to export the list of secured actions as text

file (please see the Save and Load Permission Rules Action List
Load

1123

topic).

Save Permissions to File: to export the list of secured actions as text

file (please see the Save and Load Permission Rules Action List

1123

topic).

A permission rule can be turned on or off via a conditional formula. The
conditional formula a Permission Rule will be subjected to can be inserted in
the Rule Formula section of the Permission Rule window. The formula can
contain any of the operators and functions available for creating custom tokens
(please refer to the Custom Token Formula Reference

766

topic for the complete

list of available operators and functions). However, given that the formula has to
be conditional, one of the following operator need to be present:
Conditional/Comparison operators.
Logical Operators.
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Logic (True/False) functions.

NOTE: The results of Permission Rules are dependent on the Permission Rules
Options .
1125

36.2

Organizing Permission Rules in folders
Permission Rules can be organized in folders directly within the Permission Rules
window by either of the following methods:
Right click on any empty area of the upper section of the Permission Rules
window and select New Folder from the Right Click menu.
Right click on any Permission Rule and select New Folder from the Right Click
menu.
Click on the

button in the Permission Rule window.

A folder can be renamed by either of the following methods:
Right click on the folder that needs to be renamed and select Rename from
the Right Click menu.
Select the folder that needs to be renamed via left click and press F2 on your
keyboard.
Select the folder that needs to be renamed via left click and click on the
button in the Permission Rule window.

36.3

Save and Load Permission Rules Action List
The list of actions secured by a Permission Rule
order to be reloaded when needed.
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To export the list of actions secured by a Permission Rule:
1. Click on the Save button of the Permission Rules window and select Save
Permission to File.
2. A Select a file for saving permissions window opens.
3. Select the file destination and enter a file name in the Select a file for saving
permissions window and click Save.

To Load a previously exported list of action secured by a Permission Rule:
1. Click on the Load button of the Permission Rules window and select Load
Permission to File.
2. A Select a file for loading permissions window opens.
3. Select a previously exported lust of action in the Select a file for loading
permissions window and click Open.
4. The list of actions is now loaded and displayed in the Actions secure by this
rule section of the Permission Rules window.

36.4

Editing a Permission Rule
To edit a Permission Rule first open the Permission Rules dialog using the Quality
tab

SOP

Permission Rules command. The Permission Rules dialog will

appear and will list the available Permission Rules.
Select the Permission Rule that need to be edited. The Rule Description, the list
Actions secured by this rule and the Rule Formula can now be edited.

36.5

Deleting a Permission Rule
To edit a Permission Rule first open the Permission Rules dialog using the Quality
tab

SOP

Permission Rules command. The Permission Rules dialog will

appear and will list the available Permission Rules.
A Permission Rule can be deleted by either of the following methods:
Right click on the Permission Rule that need to be deleted and select Delete
from the Right Click menu.
Select the Permission Rule that need to be deleted via left click and press
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Delete on your keyboard.
Select the Permission Rule that need to be deleted via left click and click on the
button in the Permission Rule window.

36.6

Permission Rules Options
Permission Rules Options can be accessed by either of the following methods:
Click on the

button of the Permission Rules window.

Right click on any empty area of the upper section of the Permission Rules
window and select Options from the Right Click menu.

Permission rules options defines whether the Action that are not included in
any rule will be:
Allowed: all the actions not selected as permission rules will be allowed by
default (permissive approach).
Not Allowed: all the action not selected as permission rules will be denied
(restrictive approach).

36.7

Available Permission Rules
Permission Rules allow the user to lock down one or more of the following
actions:

Layout operations
Open layout
o Open
Navigators and Other Dockable Windows
o View Batch Actions
o View Data List
o View Alerts
o View Custom Tokens
o View Canned Comments
o View Compensations
o View Snapshots
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o View Standard Operating Procedures
o View Permission Rules
Save layout
Save layout as
Print layout
Change Page Setup
Save layout to PowerPoint
Save PDF
Publish Layout
Edit operations
Copy FCS data to the clipboard
View layout properties
Change layout properties
Insert new page
Rearrange pages
Delete page
View page options
Change page options
Align objects
Change Object Order
Adjusting and resizing objects
Move objects
Resize objects
Group objects
Ungroup objects
View operations
View the layout history
View the master page
Change the number of visible pages
View hidden pages
Data file operations
Open a Data file
Modify the contents of a data file
Add a column to a data file
Delete a column from a data file
Insert a row into a data file
Delete a row from a data file
Export a Data file
Load an Data file that is not already loaded
Create a custom data set
Add to data list
Search the data list
Remove from the data list
Format the Data List Options
Move a file Up in the data list
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Move a file Down in the data list
Increment/Decrement file on selected/all objects
Change file on selected/all objects
View file header information
Modify file header information
Change the increment value
Plots and other objects operations
Insert stats window
Insert plots and other objects
o Insert 2D Plots
o Insert Histogram
o Insert Kinetics
o Insert MultiCycle DNA
o Insert Proliferation
o Insert Text Box
o Insert Gate View
o Insert Picture
o Insert Data Grid
o Insert Scatter
o Insert Bar
o Insert Pie
o Insert Heat Map
o Insert AutoShapes
Remove 2D plots
Remove histograms
Remove DNA histograms
Remove Proliferation histograms
Remove text boxes
Remove picture
Remove data
Remove Gate View
Remove AutoShape
Remove stats window
Change parameters on a histogram
Change parameters on a 2D plot
Add overlay to a histogram
Add overlay to a 2D plot
Remove overlay from a histogram
Remove overlay from a 2D plot
Reorder overlay in a histogram
Reorder overlay in a 2D plot
Edit the text on a text box
View the format of a 2D plot
View the format of a 1D plot
View the format of an AutoShape
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View the format of a text box
View the format of a picture
View the format of a data object
View the format of a statistics window
Change the format of a 2D plot
Change the format of a 1D plot
Change the format of an AutoShape
Change the format of a text box
Change the format of a picture
Change the format of a data object
Change the format of a statistics window
Change the visibility of statistics
Autosize statistics window
Delete Table Cells
Insert Table
Insert Table Cells
Gate, marker and quadrant operations
Create a new gate
Modify a gate
Remove a gate
Modify gate information
Add a combination gate
Change Gate Properties
Create a new marker
Modify a marker
Remove a marker
Gate fellowship Link
Break Gate fellowship
Show quadrants
Hide quadrants
Modify quadrants
Parameter Math operations
Perform single calculation
View the current sequence
Modify the current sequence
Perform the current sequence on the top FCS file
Perform the current sequence on the all FCS files
Load a sequence
Save the current sequence
Parameter Labels operations
View parameter label sets
Modify parameter label sets
Load a set
Save the list of sets
Batch Processing and Alerts operations
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Alerts
o Run alerts
o Add a new alert
o Delete an alert
o Edit the text in an alert
o Add token to alert formula
o View token properties for the alert formula
o Edit alert formula token properties
Batch Processing
o Flag an iteration
o View batch processing options
o Change batch processing options
o Run batch processing
o Replay batch processing
o Add save batch actions
Add Save Layout batch action
Add Save PDF batch action
Add Save Picture batch action
Add Save PowerPoint batch action
Add Print batch action
Add Publish Layout batch action
o Add batch folders
Add Folder
o Add report batch actions
add Export To Excel (Column Mode)
add Export To Excel (Cell Mode)
add Word Report
add PDF Form
add Text Report
add Export To LabKey
o Add items to reports
add Regular Token
add Statistic Token
add Keyword Token
add Picture
add Text Box
add PDF
add Layout
add PowerPoint
add FCS File
o Rename batch actions
o Paste batch actions
o Delete batch actions
o View batch action details
o Change batch action details
Canned Comment operations
Add a new Canned Comment
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Delete a Canned Comment
Edit the text in a canned comment
Add a token to a canned comment
View canned comment token properties
Edit canned comment formula token properties
Channel Calibration operations
View Channel Calibration settings
Add a Channel Calibration
Delete a Channel Calibration
Load Channel Calibration settings
Save Channel Calibration settings
Modify settings
Calculate Channel Calibration
Edit a Channel Calibration
Compensation operations
Modify compensation
Import compensation
Export compensation
Create compensation
Delete compensation
Assign compensation
Run Automatic Compensation
Other tools
Modify Concentration calculator settings
Concentration calculator calculate
Histogram subtraction
Batch export
Diva Import
CFlow Import
Security Operations
Electronic Signature operations
o View signature list
o Change signature list
o Sign
o Unsign
Snapshot operations
Add snapshot
Edit snapshot
Delete snapshot
Apply snapshot
SOP operations
Add SOP Step
Delete SOP Step
Edit SOP Step
Run SOP
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Help operations
View help
View tutorials
View manual
View online forum
Go to the De Novo Software web site
Enter countercode
View About screen
Panel operations
View the panel information
Add a panel
Edit a panel
Remove a panel
Load panels from a file
Save panels to a file
Change the panel information
Change the name of a panel
Change the number of tubes in a panel
Token operations
Custom Tokens
o Add custom token
o Delete custom token
o Add token to custom token formula
o View custom formula token properties
o Edit custom formula token properties
o Edit the text in a custom formula
Change Font Classification
Add Font Classification
Edit Font Classification
Reorder Font Classification
Remove Font Classification
Token Bounds Change
Add Statistic Classification
Edit Statistic Classification
Reorder Statistic Classification
Remove Statistic Classification
Add Keyword
Remove Keyword
Add token to a text box
View text box token properties
Edit text box token properties
Formatting Operations
Bold
Bullets
Font
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Font Background
Font Color
Font Name
Font Size
Gate Formula Change
Indent Text
Italics
Justify Text
Format 3D Options
Format Axes Options
Format Color Levels
Format Fill Options
Format General Options
Format Legend Options
Format Line Options
Format Overlays Options
Format Size Options
Format Stats Options
Format Title Options
Underline
Keywords Anonymizer
Page Tab Operations
Change Page Tab Color Classification
Add Page Tab Color Classification
Edit Page Tab Color Classification
Reorder Page Tab Color Classification
Remove Page Tab Color Classification
Override Authorizations
Format Authorizations
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Formatting Authorizations
FCS Express allows user to control when objects are selected or edited based on
settings in Formatting Authorizations.
All objects in FCS Express may be assigned Authorizations , or rights, which
allows or prevents layout users from placing objects in Select mode or Edit
mode or both. Authorizations can be set to always allow, never allow, or
always allow/do not allow based on the value of a token. For instance, a token
value can be set to allow selection of a plot if the current FCS Express user
equals a specific person or a plot can remain non-editable unless a particular
statistic value is met, e.g., the number of events for a particular gate is higher
than an arbitrary value. See the Working with Authorizations
section in the
manual for additional details on setting up these conditions.
1134

1136

Authorizations allow for an additional layer of control at the layout level for any
object.

The Authorization feature.

37.1

Accessing and Docking Formatting Authorizations
Navigator
Users can access the Formatting Authorizations navigator by using the ribbon
after selecting object(s) or right-clicking selected object(s) and choosing
Format.
To access Authorizations using the ribbon:
1. Click on an object to select it.
2. Click Format tab
37.1).

command (Figure
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Figure 37.1 Accessing Formatting Authorizations for
selected object(s)

The Formatting Authorizations navigator will appear allowing actions to be
formatted when allowed as seen in Figure 37.2 below.

Figure 37.2 Formatting Authorizations navigator via ribbon

To access Formatting Authorizations via an object:
1. Right-click on a selected object(s).
2. Choose Format.
3. Select the Authorizations category (Figure 37.3).
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Figure 37.3 Formatting Authorizations navigator via right-clicking selected
object(s)

To dock the Formatting Authorizations navigator, click and drag the window's
title bar to an edge of the layout to activate docking zone sectors; select area
by releasing mouse on docking zone sector of choice. See docking a window 115
for more details.

37.2

Working with Authorizations
The Authorizations options may be accessed by formatting plots as described in
the previous section .
1134

Authorizations may be set for two Actions, Select and Edit. Either option may
be chosen individually in the Actions list or both Actions may be multiple
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selected to change them together. Setting an Authorization for either or both
Actions will control if an object may be placed into Select mode or Edit mode 131
thus limiting the specific actions that may be taken with a plot. For instance, if
Never Allowed is chosen for the Select action then a plot may not be placed
into selection mode and moved or resized on the page. If Never Allowed is
chosen for the Edit action then the plot cannot be formatted, gates cannot be
created, or nor can any actions available via the right click menu. If Never
Allowed is chosen for both the Select and Edit actions then the plot cannot be
formatted or moved.
The default status of Actions on all objects is Always Allowed. Selecting the
Never Allowed radio button will disallow access to the Select or Edit Action.
Choosing the Custom radio button will allow you to define a condition that must
be met to Allow or Never Allow the Action. For instance, in the example below,
Figure 37.4, a formula was defined in the Custom field. The chosen plot will not
be allowed to be in Select mode if the token value (highlighted in grey - 79.05))
is above the reference value (70). Any tokens may be used to set a conditional
Custom value and may be inserted 688 via right-click in the field, Insert Token or
by clicking on the T token icon.

Figure 37.4 - The Authorizations formatting dialog. In the example a Select action
was set to be Custom and is only allowed if the formula returns a true result. In this
case the plot will remain not selectable because the token value (highlighted in
grey) is higher than the reference value of 70.

Values must be returned as "true" to be allowed / "false" to never allow. Please
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note that if are evaluating a token whose result type is text, then the standard
value must exist in quotes (e.g. the "FACScan" in the figure below).

Figure 37.5Authorizations window showing proper syntax for text-type tokens to
return a true/false value.

Authorizations may also be overridden. Overriding Authorizations
is particularly
useful if the Edit Action is set to not be allowed but an edit or change to the plot
or Authorization is needed.
1138

37.3

Overriding Authorizations
To override authorization(s), click to select object(s) and click Format
tab
click Override Authorizations (Figure 37.5).

Figure 37. 6 Override Authorizations under Format tab

Please note, for users not using the security add-on , any user can override
authorizations. Users using the security add-on can allow or prohibit access to
Formatting Authorizations
or Override Authorizations at the User , Layout
, or Security Group
level.
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Security
FCS Express has a comprehensive security system that allows you to restrict
access to various functions to particular users. This can be important for ensuring
the integrity of your data analysis and to conform with certain government
regulations such as 21 CFR Part 11. FCS Express offers multiple layers of
security, described in the remaining sections of this chapter.

38.1

User-Based Security
The first level of security is based on restricting functionality based on a particular
user. When security is activated, each user must log in to FCS Express with a
user name and password (Figure 38.1).

Figure 38.1 Security Login

Users are created and managed from the File tab
Express (Figure 38.2).

Security gallery within FCS
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Figure 38.2 Security Gallery

Each user is also assigned to a User Security Group and can only perform
functions that are allowed by that group. Hence, if Group A does not allow its
members to print layouts, then any user who is a member of Group A will not be
allowed to print layouts.

38.2

Layout-Based Security
The second level of security is based on restricting functionality for particular
layouts. Every layout has a Layout Security Group
assigned to it. Only the
functions allowed by the Layout Security Group can be performed on that layout.
These functions are identical to the ones that can be assigned to a User Security
Group . For example, if the layout security was set to a Layout Security Group
that did not allow printing, then any user (regardless of their User Security Group
permissions) would not be able to print that layout.
1177

1179

In addition to having security permissions for each action on the layout, a
password can be specified for the layout. You will not be able to open the layout
without entering the password. The password is stored in an encrypted format. If
the password is lost, the only way to open the layout is to send it to De Novo
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Software.

38.3

Working with User-Based Security
FCS Express comes with one default user, the Administrator. The default Login
name for the Administrator is admin. The default Password for the Administrator
is password.
Note: This password should be changed immediately after using FCS Express the
first time.
Changing a user’s password is described in Editing a User . The Administrator is
part of the Administrator Security Group. For more information on Security
Groups, see Working with Security Groups . By definition, the Administrator
Security Group can perform every action and cannot be deleted.
1150
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Users may be sorted by Name or Last Name by clicking on the Up or Down
arrows in the column headers.
To manage users, use the File tab Security User Administration command.
This will bring up the User Administration dialog (Figure 38.3). Users are listed in
alphabetical order by last name.
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Figure 38.3 User Administration Dialog

Clicking on the Show Active Logins button will bring up the Active Logins
dialog (Figure 38.4) which will display all of the currently active users. To logout a
user, highlight the user and press the Logout button.
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Figure 38.4 Active Logins Dialog

Note: If a user is logged out while they are currently using the software, all
functionality will be disabled and they will only be able to Save or Exit.
Please see the Internet Dongle and Site License KnowledgeBase page for more
information on working with user-based security for these license types.

38.3.1

Creating a User
To create a new user:
1. Use the File tab Security User Administration command.
2. Click on the Add button in the User Administration dialog (Figure 38.5).
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Figure 38.5 The Add button in the User Administration dialog.

The Edit User Information dialog will appear (Figure 38.6).
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Figure 38.6 Edit User Information Dialog

All of the fields except for Employee ID and Lab Name are mandatory. The
Login Name field must be unique (no two users in FCS Express can have the
same Login Name). The Lab Name field allow to assign the user to a specific
lab. Previously inserted Lab Names will be available in the Lab Name dropdown
menu. The Lab Name is used to organize users in the Billing Report .
1197

The Allow Log In checkbox determines whether that user can log in. The Allow
self-logout checkbox determines if a user can log themselves out from a
remote location. The Require password change during next login checkbox
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will prompt the user to change his or her password during the next login.
At least one option must be selected in the Groups box for the user.
Customers who hold the Security add-on, can manage Security Groups via the
Security Group Definitions tools (see Working with Security Groups) .
Internet Dongle and Site License customers have the ability to assign the user to
one of the following pre-defined user groups:
o Administrator: User assigned to this group will be able to use the software
to analyze data, to add, edit and delete users, to view Security Reports
and to edit the Security Configuration .
o Standard user:User assigned to this group will only be able to analyze data.
o User Administrator: User assigned to this group will only be able to to add,
edit and delete users, to view Security Reports
and to edit the Security
Configuration .
1171
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Figure 38.7 Restrict User to Defined MAC Address(es) in User
Information Dialog

The user may be restricted to defined MAC address(es) as well. Clicking Include
this machine button will populate the Restrict to MAC Addresses (one per
line): box with the MAC address from the computer used to create the user
(Figure 38.7).
Multiple user can be automatically added to the database via the Add from CSV
button. The CSV file can be either a comma-delimited or a semicolon-delimited
file and has to contain the following columns:

Column Header
LoginName
Password

Specific requirements
None
None

Example
JohnSmith
password123
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FirstName
LastName
Email
EmployeeID
LabName
CanLogin

None
John
None
Smith
None
John.Smith@DNS.com
None
123456
None
Flow Lab
Enter: T or F or True or True
False
CanLogMyselfOut
Enter: T or F or True or F
False
ForcePasswordExpire Enter: T or F or True or T
d
False
SecurityGroups
For internet dongle user Standard User
types:
Administrator,
Standard User or User or
Administrator (see
above for additional
Comma delimited:
details ).
"Group 1, Group 2, Group 3"
User group names can be
or
inserted as comma"Group 1, ""Group,2"", Group
delimited list. For
3"
comma-delimited CSV
files, said list has to be
Semicolon-delimited CSV file:
surrounded by quotes.
Group 1, Group 2, Group 3
If a group name include
or
comma in it, that name Group 1, ""Group, 2"", Group 3
has to be included in
double quotes for both
comma-delimited and
semicolon-delimited CSV
files.
1147

Note: If MS Excel is used
to edit the CSV files, user
group names can be
simply listed as commadelimited list with a single
quote character around
any group names that
have commas in them.
RestrictToMACAddres N/A
N/A
ses
Example of .CSV import in Excel below. A template for the the .CSV file import
may also be downloaded for use.
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Editing a User
To edit an existing user:
1. Use the File tab
command.
2. Either double-click on the user, or select the user and click on the Edit
button in the User Administration dialog.
3. Edit the information and Click OK.
The currently logged in user can change their own password by selecting the File
tab System Edit Information for Current User command. The Edit User
Information dialog will appear, but only the password field will be enabled
(Figure 38.8).
Please note that for the User to be able to change their password, the User must
have the permission for Security Options Current User Operations enabled
for the User Group to which they belong.
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Figure 38.8 Change Current User Password

38.3.3

Deleting a User
To delete a user:
1. Use the File tab Security User Administration command.
2. Select one or multiple users, and click on the Remove button in the User
Administration dialog (Figure 38.9).
3. A message will ask for confirmation for the deletion. Click Yes to confirm
or No to avoid deleting the selected user(s).
FCS Express will not allow you to delete the last administrator who can log in.
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Note: You cannot undelete a user, so please use this feature with caution.

Figure 38.9 Removing a Security User

38.3.4

Editing Security Configurations
Under File tab
, users can find the Edit
Security Configuration dialog (Figure 38.10) which is used to manage
Password Policies , SMTP Servers , E-Mail Notifications , and Online
Registration (site license customers only) .
1153
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1157
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Figure 38.10 Navigating to the Edit Security Configuration dialog

38.3.4.1

Managing Password Configurations

Note: In previous releases FCS Express used an XML file to manage password
configurations. Upon updating and running the latest release of FCS Express for
the first time the values from your XML file will automatically be imported and the
original XML file will then be ignored.
To manage your Password Policies navigate to the File tab
Security Configuration.

Edit

The Edit Security Configuration dialog will appear as in Figure 38.11 below.
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Figure 38.11 The Password Policies Dialog

The options for password policies allow you to define:
Password Policy Option
Number of days before users
must change password
Number of failed login
attempts before user account
is locked
Prohibiting passwords from
being reused

Notes
A value of 0 (zero) means the user never has
to change their password.
A value of 0 (zero) indicates the account will
never lock upon any number of failed attempts

Checking this option will determine the number
of days before a password may be reused. A
value of 0 (zero) means that the user can
reuse their password at any time.
Idle time in seconds before
A value of 0 (zero) indicates the user will never
user is logged out
be logged out upon software idling
The time between pings to
Determines how often an FCS Express session
the database for keeping user communicates back to the server that it is still
session alive
active. When a new user logs in, the software
checks for any sessions that have not
communicated back within this period and
cancels that session. Smaller values indicate
that a session can be reused more quickly in
the event of an unexpected program halt (such
as a power failure or crash). The maximum
value is 300 seconds.

Once your Password Policies are defined click OK to apply them or continue to
setup the SMTP Server
or Mail Notifications .
1156
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Mail Notifications

The Mail Notification dialog (Figure 38.12) can be accessed through the File
tab
Edit Security Configuration
.
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Mail Notifications allow notifications to be sent to a specific email address when
certain events happen within FCS Express. A list of available notifications can be
found in the table below.

Figure 38.12 Mail Notifications Dialog

To setup a mail notification:
1.Configure your SMTP Server .
2.Check boxes for each notification trigger you would like to be notified about.
3.Enter the email address to receive the notification in the Email to Notify box.
4.Click on Send Test Mail to confirm your selection.
5.Click OK.
1156

When a notification is triggered you will receive an email at the specified email
address.

Available Notifications:
Mail Notification
FCSE session started
Invalid UserName
© 2020 De Novo Software
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entered
Notification when an invalid Password is
entered
Too many users
Notification when a user tries to log in and there
were too many other users already logged in
Too many users in the same Notification when a user tries to log in and there
account
are too many users are logged into the same
account
User account is disabled
Notification if a user account is disabled because
of too many invalid login attempts
Too many failed login
Notification if the number of failed login
attempts
attempts allowed is exceeded
Password expired
Notification if a password is determined to be
expired
Successful Login
Notification of a successful login
Unexpected Logout
Notification of an unexpected logout. This
occurs if the program shuts down unexpectedly
and the sessions times out.
Remote Logout
Notification if a user is logged out remotely by
another user
Logout
Notification of a regular logout
FCSE session ended
Notification if FCSE session is ended
FCSE session left open
Notification if FCSE session is left open
Event message notification
Confirmation notification of message sent
sent
Event message notification
Notification when a message fails to deliver
failed to deliver
User was logged out by idle Notification if user was automatically logged out
timeout
by idle timeout
Invalid Password

38.3.4.3

SMTP Server

The SMTP Server dialog (Figure 38.13) can be accessed through the File
tab
Edit Security Configuration
.
Enter the SMTP Server information for your preferred email provider in this
category to allow Mail Notifications
to be sent out.
1154
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Figure 38.13 The SMTP Server Dialog

Note that if you configure your SMTP server to use SSL, then you will need to
make sure that there are SSL libraries in your computer's system Path, or in the
same folder as FCS Express.exe. You can download and extract the OpenSSL
package for this purpose. Links to download it are available from https://
www.openssl.org/ . The only two libraries that are required from OpenSSL are
libeay32.dll and libeay32.dll.
38.3.4.4

Online Registration

The Online Registration dialog (Figure 38.14) can be accessed through the File
tab
Edit Security Configuration
.
The Online Registration dialog will only be available to you if you are an FCS
Express Internet Dongle or Site License customer and have Administrator
privileges assigned
to your user in FCS Express.
1147

Online registration will allow you to set up a unique webpage customized to your
institutions needs for allowing FCS Express end user registration. Registration can
be set up to allow users to register with or without approval. Multiple levels of
approval may be assigned and custom registration email messages may be
created directly within FCS Express.
To enable Online Registration for your users:
1. Click on the General category in the Edit Security Configuration dialog.
2. Enter the name of your institution. The name entered here will appear on your
custom registration web page as in the image below where "Your Institution
Name Here" was entered.
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3. Check the box for Allow new users to be registered through the De Novo
Software website.
4. Click on or copy the web address provided to access the web page (please
note it will not be active until you click OK in the next step).
5. Click OK to save your changes.
The web link provided is unique to your license. You can distribute the web link to
any prospective users of FCS Express to allow them to register as an end user of
your license. There are a number of customizations including access controls
and custom messages that are outlined in the table below.
All emails sent to users, approvers, and admins will originate from
denovosoftware@denovosoftware.com. Please ensure your institution and users
can receive messages from that email address. The inbox for
denovosoftware@denovosoftware.com is not monitored, please do not reply
directly to this email address but use support@denovosoftware.com.

Figure 38.14 - The Online Registration dialog in FCS Express is available to site
license adminstrators.
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Option
Allow new users to be registered
through the De Novo Software
website

Action when checked
Makes a website active that is unique to
and associated with your license so end
users can self-register. The link provided in
the dialog may be provided to end users to
self register.
Require Logging in to an existing
When attempting to register, a log in screen
account before creating new users will first be presented. A license user with
Administrator or User Administrator rights
must enter their credentials to access
the registration form. The option is useful if
you would like to have only an
administrator be able to create end users
on the license without having to access FCS
Express directly.
New users must verify their email
When new users register for a license user
address
they are first sent an email to the email
address they provided in the form with a
link to validate that the email address is
active. User must click on the verification
link before their user may be approved.
New users must be confirmed by an When new users register a field will be
approver
present on the registration form for
"Approval email address". The email
address associated with the approval email
address field will be sent an email message
to approve the user via a web link. If
Require administrator confirmation (below)
is not checked, the end user will be
approved immediately. If Require
administrator confirmation is checked, a
subsequent approval request will be send to
the license admin email.
Require administrator confirmation When checked the email address entered in
the Admin email field will be sent an email
message to approve the user via a web
link.
1147

Website Registration Form and Customizations
The website form for your institution (Figure 38.15 - left) will minimally contain
the following fields that when filled out will map to the Edit User Information
dialog
and create a license user on your license. Fields for Employee ID and
Lab name are optional.
1145
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Note that the Approval email address* field will be displayed only when choosing
the option (figure 38 below and right) for "New users must be confirmed by
an approver" in the Online Registration options. The Approval email address
should be the email address of the person who will be providing approval of the
user. If only "New users must be confirmed by an approver" is checked, they
will be the final line of approval for user creation. If "Require administrator
confirmation" is also checked then the Approval email address will first be
messaged for approval before sending a subsequent message to the Admin
email for final approval.
Login
Name
Email
Addre
ss
Passw
ord
Reenter
passw
ord

Figure 38.15 - The
website form in a
web browser. No
additional options
for confirmation
applied.

First
Name
Last
Name
Figure 38 - The website form in a web browser with
Approval email address displayed after checking
option for "New users must be confirmed by an
approver" in the Online Registration options.

Emplo
yee ID
Lab
Name
Appro
val
email
addre
ss*

If Require Logging in to an existing account before creating new users has
been checked in the Registration Options the web page will first display the log
in screen as seen in figure 38.16. A license user with Administrator or User
Administrator rights
must enter their credentials to access the registration
1147

© 2020 De Novo Software

Security

1161

form. The option is useful if you would like to have only an administrator be able
to create end users on the license without having to access FCS Express
directly.

Figure 38.16 - The log in screen presented on the web page if
"Require Logging in to an existing account before creating new
users" is checked.

Custom Registration Messages
Custom registration messages can be defined for the web form and emails sent
at various points in the registration process. Custom registration messages may
be set by clicking on the -- Custom registration messages -- drop down as
seen in figure 38.17 below.
The Open button will allow you to import a message as a text file.
The Save As button will allow you to save a message as a text file.
The Insert Field drop down will allow you to automatically populate the
message via a field from the User's information entered in the form (figure
below-right). For instance, if users have questions regarding their account you
might consider including the Administrator email address in the User registration
complete message. Or if an approver needs to easily access the Lab name or
requesting users email address it may be included in the Approver and
Administrator confirmation emails.
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38.17 - The custom registration message
dialog.

Custom
Registratio
n Message
Option
Initial
registration
instructions
User email
verification

Dialog box and text in FCS Express

Form on custom web
page or email
delivered to end user
/ approver / admin
approver

Email sent to user/
approver (yellow
indicates location of
custom text)
First Name Last Name,
Thank you for
registering for an FCS
Express account at
Your Institution Name
Here. Please verify
you email address.

Approver
confirmatio
n email

Please confirm your email
address by clicking this link:
Email sent to user/
approver (yellow
indicates location of
custom text)
First Name Last Name
wants to register a
new FCS Express
account, with you as
their reference.
© 2020 De Novo Software

Security

Custom
Registratio
n Message
Option

Dialog box and text in FCS Express

1163

Form on custom web
page or email
delivered to end user
/ approver / admin
approver
Account name: CellDye
Email address: email
address here Billing
code:
Enter text for your
Approver confirmation
email.

Administrat
or
confirmatio
n email

To approve this
registration, please
click this link:
Email sent to user/
approver (yellow
indicates location of
custom text)
First Name Last Name
wants to register a
new FCS Express
account.
Account name: CellDye
Email address: email
address here Billing
code:
Approved by: email
address here
Enter text for your
Administrator
confirmation email.

User
registration
complete

To approve this
registration, please
click this link:
Email sent to user/
approver (yellow
indicates location of
custom text)
First Name Last Name,
Your FCS Express
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Custom
Registratio
n Message
Option

Dialog box and text in FCS Express

Form on custom web
page or email
delivered to end user
/ approver / admin
approver
account "CellDye" is
now active. You can
log in at any time with
the password you
created during
registration.
Enter your text for
completion of the
registration process.

38.3.4.5

LDAP and Single Sign On

Lightweight Directory Access Protocol (LDAP) (also known as Active Directory or
Directory Server) with Single Sign On capability is currently available in FCS
Express. To request access and pricing for LDAP integration please contact
support@denovosoftware.com.
The LDAP dialog (Figure 38.18) can be accessed through the File
tab
Edit Security Configuration
tab.
If you are attempting to edit the security configuration for LDAP you must be
connected to the LDAP server.
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Figure 38.18 The LDAP Dialog

LDAP Authentication may be configured via the LDAP dialog via the
options listed in the dialog and as follows:
When the check box for Enable LDAP Authentication is checked FCS Express
will attempt to auto fill the LDAP Default Domain and Distinguished Name
Root. If a different LDAP Default Domain and Distinguished Name Root are
required you may enter them manually.
The LDAP Hostname must be entered by the end user setting up LDAP.
The Enable Single Sign On check box will control if Single Sign On should be
used by FCS Express when opening the software.
If Enable Single Sign On is unchecked, then the user will be prompted
via a log in dialog to enter their credentials.
o The user name may be entered as the domain user name or with the
domain plus user name. For instance, JQFlow or FlowCytometry
\JQFlow where JQFlow is the user name and the domain is
FlowCytometry.
If Enable Single Sign On is checked, and the end user of FCS Express is
assigned as a user of FCS Express, the end user will not be prompted to log
into FCS Express as long as they are already signed on to the system.
o If a user would like to force a sign in prompt, for instance, to switch to a
different domain user to access FCS Express, you may hold down the
Control, or Alt, or Shift key immediately after running FCS Express
until the log in dialog appears.
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o Users may also force a sign in prompt if they switch to another user by
logging out of FCS Express. To logout, click on the Logged in as: drop
down in the bottom bar of FCS Express (Figure 38.19) or from the File
tab System Current User Logout Current User.

Figure 38.19 Logging out via the logout current user drop
down in the bottom bar of FCS Express.

See the next chapter for Creating and Administering LDAP Users

1166

.

38.3.4.5.1 Creating and Administering LDAP Users

FCS Express users may be added from the LDAP server from the File
tab
User Administration
button (Figure 38.20).
Users added via LDAP may utilize all of the security group
signature
features available in FCS Express.

1171

and electronic

1086
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Figure 38.20The User Administration Dialog with Add from
LDAP highlighted.

Click on the Add from LDAP button to launch the Select Users dialog (Figure
38.21).
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Figure 38.21The Select Users dialog for LDAP user selection in FCS Express.

The Select Users dialog will all you to add users by entering the user names in
the Enter the object names to select (examples): field.
The field is searchable by clicking on the Check Names button after entering
text. For instance, if a user on the system existed as joeflow@cytometry.com
you could simply type Joe and click Check Names to find the user. If multiple
users appeared in the search a Multiple Names Found dialog will appear
allowing you to select one or multiple users.
If multiple users need to be added to the system at the same time you may
separate user names or search terms with a semi-colon. For instance, Joe;Jane
will search for any users in the system by those names. If users are found, the
full user name will appear separated by a semi colon in the dialog. If multiple
users are selected in the Multiple Names Found dialog they will appear in the
Enter the object names to select (examples): dialog separated by a semicolon.
An Advanced user selection dialog (Figure 38.22) may be launched by clicking on
the Advanced... button which will allow you to use additional tools to search for
and select users.
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Figure 38.22The advanced Select Users dialog.

Once a user is selected and added all fields except Employee ID and Lab Name
will be grayed out since they are being populated by LDAP (Figure 38.23). If a
change is made to the user via LDAP, for instance, the password has changed,
FCS Express will only update after the user logs out and logs back into FCS
Express.
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Please note that Permissions and Groups for each user added to FCS Express
via LDAP must be updated manually when adding a single user, or by selecting
the user from the User Administration User List and clicking on the Edit
button when adding multiple users.

Figure 38.23The Edit User Information dialog after a single user has been added via
LDAP.
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Working with Security Groups
Every action in FCS Express has a corresponding Permission. Security Groups
contain lists of Permissions that are allowed to be performed. The Permissions
are grouped in logical categories, as shown in Figure 38.24.

Figure 38.24 Security Group Definition Dialog

You can choose to include all checked permissions, or, if you only want to
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exclude a few permissions, include all permissions except those checked in the
list. Once a Security Group is created, it can be assigned to a user . The user
will then only be allowed to perform the actions for which they have permission.
1150

FCS Express comes with the Administrator group, which permits all actions, and
cannot be deleted.
The following example illustrates how permissions behave when a user logs in:
A user is assigned to a Group which can perform all actions, except for
viewing the security group list. The user logs in to FCS Express. They are able
to load a layout, and make changes to it. However, when the user attempts
to change the security group list, they will see the message shown in Figure
38.25. This notifies the user that they are unable to perform the action.

Figure 38.25 Operation Not Allowed

38.4.1

Creating a User Security Group
To create a new Security Group, use the File tab Security Security Group
Definitions command. The Security Group Definitions dialog will appear
(Figure 38.26).
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Figure 38.26 Security Group Definitions Dialog

The security groups are listed in alphabetical order. Click on the Add button to
create a new group and bring up the Security Group Definition dialog (Figure
38.27).
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Figure 38.27 Adding a New Security Group

Assign a Name and optional Description to the Group. To select all permissions
associated within a category, click on the checkbox next to the title. To view all
associated permissions within a category, click on the triangle next to the
checkbox. To select an individual permission, check the checkbox to the left of
the permission. Using the radio buttons, you can choose to either include all
checked permissions, or include all permissions except those that are checked.
When you are finished defining the group permissions, click OK.
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To view a list of Available Security Group Permissions in FCS Express 6, click here
.
1179

38.4.2

Editing a Security Group
To edit a Security Group, use the File tab Security Security Group
Definitions command, and either double-click on the group, or select the group
and click the Modify button. That will bring up the Security Group Definition dialog
, where you can then modify the groups permissions.
1171

Permissions are only applied when the user logs in. If a user’s permissions
change while they are logged in, the new permissions will only be effective after
the user logs out and in again.
Please note that the Administrator security group can not be modified.

38.4.3

Duplicating a Security Group
Duplicating a group allows you to easily create similar Security Groups. To
duplicate a group, use the File tab Security Security Group Definitions
command. Select the group to be copied, and click the Duplicate button. A new
group will be created which has the same name as the original group, but with
the "(copy)" added to it.
You can then select the new group, click the Modify button, rename it, describe
it, and set the exact permissions you need.

38.4.4

Deleting a Security Group
To delete a group, use the File tab Security Security Group Definitions
command. Select the group to be deleted and click the Remove button.
FCS Express will not delete a group which still has users assigned to it. Once all
users who are assigned to this Security Group are assigned to another group,
FCS Express will allow the group to be deleted.

38.4.5

Loading and Saving Security Group and Layout Status
Security Permissions, Groups, and Layout Status Definitions may be saved to a
.txt file for quick access and loading or saved as a convenient text report.
To save security Permissions, Groups, or Layout Status Definitions to a file or
report:
1. Choose the File tab Security.
2. Choose Security Group Definitions (Figure 38.28, left) or Layout Status
Definitions (Figure below, right).
3. Click on Add or Modify.
4. Click on the Save dropdown.
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5. Choose Save Permissions To File, Save Group To File, or Save Group as
Report from the dropdown.
6. Browse to a location to save the file.
7. Enter a file name for the .txt file.
8. Click Save.
The text file will then be saved in the location specified. Permissions or Group
Files may be loaded in the following steps listed below
or Group Reports may
be opened for review. Note that the permission files created in the steps below
may also be used when creating Permission Rules for the Standard Operating
Procedure features .
1176

1108

Figure 38.28 - Choosing to Save Security Group Permissions, Groups, and
Reports (left) and Choosing to Save Layout Status Definition Permissions,
Groups, and Reports (right).

To load security Permissions, Groups, or Layout Status Definitions files:
1. Choose the File tab Security.
2. Choose Security Group Definitions (Figure 38.29, left) or Layout Status
Definitions (Figure below, right).
3. Click on Add or Modify.
4. Click on the Load dropdown.
5. Choose Load Permissions From File or Load Group From File from the
dropdown.
6. Browse to the location of the saved file.
7. Enter a file name for the .txt file.
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8. Click Open.
9. Click OK.
The previously saved security permission or group will now be loaded.

Figure 38.29 - Choosing to Load Security Group Permissions or Groups (left)
and Choosing to Load Layout Status Definition Permissions or Groups (right).

38.5

Working with Layout Security Groups
A layout security group behaves in the same way as a user security group.
However, the permissions associated with the layout security group apply to a
particular layout file (as opposed to a user). Layout security groups are managed
in a manner identical to user security groups.
In order to manage a layout security group, use the File tab Security
Status Definitions command to bring up the Layout Status Definitions dialog
(Figure 38.30).
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Figure 38.30 Layout Status Definitions Dialog

Layout security groups are modified , added , and deleted
in the same
manner as user security groups. Layout security groups may also be saved and
loaded .
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In the event that the current layout belongs to a layout security group that
restricts a certain action, but the current user is part of a user security group that
has permission to perform that action, that action will not be allowed. Therefore,
both user permissions and layout permissions must be allowed for a particular
action to be performed.
To associate a layout with a particular security group, use the File
tab Info Layout Options
command
(Figure 38.31). The default group is Unrestricted. This means that all actions
can be performed on this layout. To change the group, select a different one
from the list box.
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Figure 38.31 Assigning a Layout to a Security Group

The Layout Options window shows other pertinent information related to the
layout. The file name, the name of the user who created the layout, and the date
it was created is shown. Password protection can be enabled on the layout here,
as well. If password protection is enabled, when the layout file is loaded, the user
will be prompted to enter the password. If the password is not correct, the file
will not open.

38.6

Managing the Databases
Regular maintenance of the database is not required. However, in the rare
occurrence that the database becomes corrupt, or is accidentally deleted, there
are tools to help maintain the databases. Please contact De Novo Software at
support@denovosoftware.com prior to performing maintenance to ensure that
this is required in your case.

38.7

Available Security Group Permissions
Application Level operations
Login
Edit preferences
Restore preferences to default values
Import user options from file
Export user options to file
Layout operations
Create New Layout
Open layout
o Open
Navigators and Other Dockable Windows
o Run Batch Processing
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o Rerun Batch Processing
o Review Batch Processing
o View Batch Actions
o View Data List
o View Alerts
o View Custom Tokens
o View Canned Comments
o View Compensations
o View Transformations
o View Run SOP
o View Snapshots
o View Standard Operating Procedures
o View Permission Rules
Save layout
Save layout as
Print layout
Clear Layout History
Change Page Setup
Save layout to PowerPoint
Save PDF
Publish Layout
Perform Publishing Maintenance
Edit operations
Copy FCS data to the clipboard
View layout options
Change layout options
Insert new page
Rearrange pages
Delete page
View page options
Change page options
Align objects
Change Object Order
Adjusting and resizing objects
Move objects
Resize objects
Group objects
Ungroup objects
View operations
View the layout history
View the master page
Change the number of visible pages
View hidden pages
Data file operations
Open a Data file
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Modify the contents of a data file
Add a column to a data file
Delete a column from a data file
Insert a row into a data file
Delete a row from a data file
Export a Data file
Load data that is not already loaded
Create a new spreadsheet
Add to data list
Search the data list
Remove from the data list
Format the Data List Options
Move a file Up in the data list
Move a file Down in the data list
Increment/decrement file on selected/all objects
Change file on selected/all objects
View file header information
Modify file header information
View files in memory
Change the increment value
Plots and other objects operations
Insert stats window
Insert plots and other objects
o Insert 2D Plots
o Insert Histogram
o Insert Kinetics
o Insert MultiCycle DNA
o Insert Proliferation
o Insert Text Box
o Insert Gate View
o Insert Picture
o Insert Spectrum
o Insert Data Grid
o Insert Scatter
o Insert Bar
o Insert Pie
o Insert Heat Map
o Insert AutoShapes
Remove 2D plots
Remove histograms
Remove DNA histograms
Remove Proliferation histograms
Remove text boxes
Remove picture
Remove data
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Remove Gate View
Remove AutoShape
Remove stats window
Change parameters on a histogram
Change parameters on a 2D plot
Add overlay to a histogram
Add overlay to a 2D plot
Remove overlay from a histogram
Remove overlay from a 2D plot
Reorder overlay in a histogram
Reorder overlay in a 2D plot
Edit the text on a text box
View the format of a 2D plot
View the format of a 1D plot
View the format of an AutoShape
View the format of a text box
View the format of a picture
View the format of a data object
View the format of a statistics window
Change the format of a 2D plot
Change the format of a 1D plot
Change the format of an AutoShape
Change the format of a text box
Change the format of a picture
Change the format of a data object
Change the format of a statistics window
Change the visibility of statistics
Autosize statistics window
Delete Table Cells
Insert Table
Insert Table Cells
Gate, marker and quadrant operations
Create a new gate
Modify a gate
Remove a gate
Modify gate information
Add a combination gate
Change Gate Properties
Create a new marker
Modify a marker
Remove a marker
Gate fellowship Link
Break Gate fellowship
Show quadrants
Hide quadrants
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Modify quadrants
Parameter Labels operations
View parameter label sets
Modify parameter label sets
Load a set
Save the list of sets
Batch Processing and Alerts operations
Alerts
o Run alerts
o Add a new alert
o Delete an alert
o Edit the text in an alert
o Add token to alert formula
o View token properties for the alert formula
o Edit alert formula token properties
Batch Processing
o Flag an iteration
o View batch processing options
o Change batch processing options
o Add save batch actions
Add Save Layout batch action
Add Save PDF batch action
Add Save Picture batch action
Add Save PowerPoint batch action
Add Print batch action
Add Publish Layout batch action
o Add batch folders
Add Folder
o Add report batch actions
add Export To Excel (Column Mode)
add Export To Excel (Cell Mode)
add Word Report
add PDF Form
add Text Report
add Export To LabKey
o Add items to reports
add Regular Token
add Statistic Token
add Keyword Token
add Picture
add Text Box
add PDF
add Layout
add PowerPoint
add FCS File
o Rename batch actions
o Paste batch actions
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o Delete batch actions
o View batch action details
o Change batch action details
Canned Comment operations
Add a new Canned Comment
Delete a Canned Comment
Edit the text in a canned comment
Add a token to a canned comment
View canned comment token properties
Edit canned comment formula token properties
Channel Calibration operations
View Channel Calibration settings
Add a Channel Calibration
Delete a Channel Calibration
Load Channel Calibration settings
Save Channel Calibration settings
Modify settings
Calculate Channel Calibration
Edit a Channel Calibration
Compensation operations
Modify compensation
Import compensation
Export compensation
Create compensation
Delete compensation
Assign compensation
Run Automatic Compensation
Apply to all plots
Apply to selected plots
Transformation operations
Create Parameter Math transformation
Create PCA transformation
Create Kmeans transformation
Create R Add Parameters transformation
Create R Add Clustering transformation
Create tSNE transformation
Create SPADE transformation
Modify transformation
Load Parameter Math Sequence from file
Save Parameter Math Sequence to file
Delete transformation
Other tools
Modify Concentration calculator settings
Concentration calculator calculate
Histogram subtraction
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Batch export
Diva Import
CFlow Import
Security Operations
Current user operations
o View information for the current user
o Change information for the current user
Security System operations
o View Security System configuration
o Change Security System configuration
o Security System configuration - SMTP
All user operations
o View information for all users
o Add a user
o Modify a user
o Duplicate a user
o Remove a user
o Can Log Any User Out
Reports
o Report All Events
o Report Failed Logins
o Report Full Sessions
o Report Remote Logouts
Layout Status Definitions
o View Layout Status List
o Add new Layout Status
o View and modify a Layout Status
o Duplicate a Layout Status
o Remove a Layout Status
Security Group Definitions
o View Security Group List
o Add new Security Group
o View and modify a Security Group
o Duplicate a Security Group
o Remove a Security Group
Electronic Signature operations
o View signature list
o Change signature list
o Sign
o Unsign
Snapshot operations
Add snapshot
Edit snapshot
Delete snapshot
Apply snapshot
SOP operations
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Add SOP Step
Delete SOP Step
Edit SOP Step
Reset SOP Run Status
Rerun SOP
Permission Rule operations
Add Permission Rule
Delete Permission Rule
Edit Permission Rule
Help operations
View help
View tutorials
View manual
View online forum
Go to the De Novo Software web site
Enter countercode
View About screen
Panel operations
View the panel information
Add a panel
Edit a panel
Remove a panel
Load panels from a file
Save panels to a file
Change the panel information
Change the name of a panel
Change the number of tubes in a panel
Token operations
Custom Tokens
o Add custom token
o Delete custom token
o Add token to custom token formula
o View custom formula token properties
o Edit custom formula token properties
o Edit the text in a custom formula
Change Font Classification
Add Font Classification
Edit Font Classification
Reorder Font Classification
Remove Font Classification
Token Bounds Change
Add Statistic Classification
Edit Statistic Classification
Reorder Statistic Classification
Remove Statistic Classification
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Add Keyword
Remove Keyword
Add token to a text box
View text box token properties
Edit text box token properties
Formatting Operations
Bold
Bullets
Font
Font Background
Font Color
Font Name
Font Size
Gate Formula Change
Indent Text
Italics
Justify Text
Format 3D Options
Format Axes Options
Format Color Levels
Format Fill Options
Format General Options
Format Legend Options
Format Line Options
Format Overlays Options
Format Size Options
Format Stats Options
Format Title Options
Underline
Keywords Anonymizer
Page Tab Operations
Change Page Tab Color Classification
Add Page Tab Color Classification
Edit Page Tab Color Classification
Reorder Page Tab Color Classification
Remove Page Tab Color Classification
Override Authorizations
Format Authorizations

38.8

Security Database Options
If you purchase FCS Express with the Security add-on, you have the choice of
two database options
Microsoft SQL Server
Elevate DB Local Server
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Click here for more information about compatibility requirements for Microsoft
SQL Server.
We strongly recommend Microsoft SQL Server for your production environment.
Please note that before or after you purchase the security add-on, you must
inform sales@denovosoftware which database option you would like. We can
then customize the configuration file for your license.
Microsoft SQL Server
Microsoft SQL Server is the most robust database option available for FCS
Express. This option is ideal if your organization already has an SQL Server
installation and has experience with it. It is also ideal if you will be running several
network installations of FCS Express, or many standalone licenses, or any
combination of network and standalone licenses. Each of those installations will
be able to use the same configuration , and share the same security system.
Note that to use FCS Express with SQL Server, you must purchase your own
license for SQL Server.
1188

Elevate DB local server
The Elevate DB local server is a database that does not require a database
server to be installed on any computer. The database files reside in a shared
folder, and each FCS Express client accesses the database files directly. Multiple
instances of FCS Express can access the database at the same time. This is the
simplest option as it requires no extra installation of an additional database
server. It does suffer from performance issues inherent to non-client server
architectures, however, the security databases are quite simple and this may not
have a practical impact in your organization. This option can be provided for free
with purchase of your security system.
Because Elevate DB is not a client-server database, it is critical that you perform
regular backup and restore tests in the event of data corruption. This is one of
the reasons we recommend SQL Server, since it is much less prone to data
corruption. Instructions regarding backing up your databases can be found here
.
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38.9

Configuring MS SQL Server to host Security
Databases
Microsoft SQL Server is one of several database options supported by FCS
Express for hosting your security system. This option is ideal if your organization
already has an SQL Server installation and has experience with it. To configure
FCS Express to use SQL Server, please follow the following instructions.
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1. Create a database in the SQL server instance. This will be the database that
FCS Express will use.
2. Set up a file containing the connection information to the database, in the
same folder as the FCS Express configuration file. This file can either be stored
in plain text, or encrypted.
a. If you want to store the database details and login credentials in a plain text
file, create a text file called FCSEDB.ini and start editing it in notepad.
i. In the first line, type [MSSQLConnection]
ii. In the second line, type ConnectionString=
iii. The connection string itself will be placed immediately at the end of the
second line (without any spaces following the = sign)
b. If you want to encrypt the database details and login credentials, run the
program FCSEDBIniFileEditor.exe. You will find this program in the same
folder as FCS Express.exe
i. A window will appear with fields for entering the connection string, and the
password.
3. Create a connection string, and enter it into the appropriate place in either the
text file or the field in FCSEDBIniFileEditor. The connection string includes
information about the type of connection to create, the server where the
database is located, the name of the database, and user id / password details.
Sample connection string if you will be using an ADO connection:
Provider=SQLOLEDB.1;Integrated Security=SSPI;Persist Security
Info=False;Initial Catalog=<database>;Data Source=<database host>
\<database instance>
Modify the text above so that it uses your database information. <Database>
should be replaced with the name of database you created in step #1 above.
<Database host> should be replaced with the IP address or path to your SQL
Server instance. <Database instance> will be the instance on the database host,
and may not be required, depending on your database installation. Note that this
connection string assumes integrated (ie Windows login) security. If you would
prefer to set it up with a named user, update the text above so that it includes
the user name and password, and removes the Integrated Security value. For
example, it might look like:
Provider=SQLOLEDB.1;Initial Catalog=<database>;Data Source=<Database
Host>\<Database Instance>;User ID=<user name>;Password=<password>

Sample connection string if you will be using an ODBC connection
Provider=MSDASQL.1;Persist Security Info=False;User ID=<user
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name>;Password=<password>;Data Source=<Data Source Name created with
ODBC Manager>;Initial Catalog=<database>
Modify the text above so that it uses your database information. <User name>
should be replaced with the username, <password> replaced with the
password. <Data Source Name created with ODBC Manager> should be replaced
with the ODBC connection name and <database> should be replaced with the
name of the database you created in step #1 above.
4. After you have entered the connection string, save the file.
a. Select the menu item File->Save in either notepad or the
FCSEDBIniFileEditor. Then navigate to the same folder where your
configuration file is stored, and enter a file name.
b. If you are using a plain text file, the file name must be FCSEDB.ini. If you are
using the FCSEDBIniFileEditor, the file name must be FCSEDB.cini .

Please note: when creating the connection string in the .INI file, the
"<>" are not needed and should not be included. They are being used in
this text to denote a placeholder for a custom value that needs to be
entered by the user or administrator.
When FCS Express starts, it will read the information in the file, connect to your
database, and automatically create all the required tables and indices. FCS
Express will not create a database. A database needs to be created ahead of
time for this process to occur.

38.10

Backing up the Databases

We recommend that you perform regular backups of your database, as well as
regular tests where you restore from backups.

SQL Server
There are several ways to back up and restore SQL Server databases, and we
do not recommend any particular ones. Please consult your SQL Server
administrator for the best choice for your environment.

Elevate DB Local Server
Elevate DB Local Server stores data in a set of files located in a subfolder of the
program folder. The subfolder is called ElevateDBData. In order to back it up,
please perform the following steps:
1. Make sure everyone is logged out of FCS Express, and that the program is
shut down on every computer.
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2. Copy the folder ElevateDBData to your backup storage location.
To restore, simply copy the backed up folder back to the original location.

38.11

Preparing for Database Updates

For certain releases, FCS Express will update the structure of the security
database. After the database is updated, previous releases of FCS Express will no
longer be able to use it. Because of this, we recommend the following:
1.Before installing a version of FCS Express which will update the database,
perform a backup of the existing database. Please see the topic Backing up the
Databases
for details. To determine whether a specific release will update
the database, please check the release notes on the download page.
1190

2. If you plan on testing the new FCS Express release before switching to using
it, then perform the following steps
a. Create a new database for testing, and initialize it with the contents of the
backup from step 1.
b. Install the new release to a new folder
c. Copy the file FCSEdb.ini from your previous installation to the new folder,
and edit it so that it refers to the database you created in step 1.
d. Run FCS Express, and perform your testing. The user names and
permissions will be the same as in your original databases. Note that since
you are now using a new database, any changes you make will not be
propagated back to the previous release.
3. Install the new release to the same folder as the previous release, and run.

38.12

Security Reports

FCS Express allows you to view and manage reports for user activity. Reports
can be accessed from the File tab
gallery (Figure 38.32).
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Figure 38.32 Navigating to the Security Reports Gallery

Four types of reports are available (click on each link for more details):

All Events Report

1193

Failed Logins Report
failure
Full Sessions Report

- Lists a history of all logging events
1194

- Reports a list of failed logins and the reason for

1195

- Reports a list of all full sessions in FCS Express

All Remote Logouts Report
location

1195

- Reports a list of all logouts from a remote

Billing Report
- Reports a list of Unique Users that accessed the software
and the corresponding Quarters Billed. Users are grouped based on the Lab
they belong to.
1197

All security reports contain a list of columns that can be arranged
or grouped
as well as the option to define Filter Criteria
and Refresh the Report for
the new filter (Figure 38.33). You also have the option to export the report
in
1198

1198

1198
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the following formats:
TXT
HTML
XML + XSL
XLS

Figure 38.33 - Example of Security Report dialog.

38.12.1

All Events Report

All Events Report can be accessed from the File tab
Events Report.
Choosing an All Events Report (Figure 38.34) will allow you to see the date
and time of all session actions and user logging event activity.
The report can be arranged, grouped, and filtered
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Figure 38.34 The All Events Report Dialog

38.12.2

Failed Logins Report

Failed Logins Report can be accessed from the File
tab
.
Being able to track failed logins in a requirement of the 21 CFR Part 11.

1204

Choosing a Failed Logins Report (Figure 38.35) will allow you to view:
Date and Time of failed login
Reason for failure
User Name when failure occurred
Login Name when failure occurred
Windows User Name when failure occurred
Computer name on which failure occurred
IP Address used to access server at time of failure
First Name of user associated with failure
Last Name of user associated with failure
The report can be arranged, grouped, and filtered

1198

according to your needs.
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Figure 38.35 The Failed Logins Report Dialog

38.12.3

Full Sessions Report

Full Sessions Report can be accessed from the File
tab
.

Choosing a Full Sessions Report (Figure 38.36) will allow you to view:
Date and Time of Connection
Windows User Name during sessions
Computer name on which session occurred
IP Address used to access server for session
Session Login time
Session Login Name
First Name of user associated with session
Last Name of user associated with session
Logout date and time
Logout Reason status
Time of disconnection
Disconnection reason status
Session Time (in hours) of each session
The report can be arranged, grouped, and filtered

1198

according to your needs.

Figure 38.36 The Full Session Report Dialog

38.12.4

All Remote Logouts Report

All Remote Logouts Report can be accessed from the File
tab
.
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Choosing a All Remote Logouts Report (Figure 38.37) will allow you to view:
For the User who was logged out
o Logout Time
o Login Time
o Login Name of the user
o First Name of user associated with session
o Last Name of user associated with session
o Windows User Name for the session
o Computer Name for the session
o IP Address used to access server for session

For the User who requested the logout
o Login Name of the user
o First Name of user associated with session
o Last Name of user associated with session
o Windows User Name for the logout
o Computer Name for the logout
o IP Address used to access server for the logout
The report can be arranged, grouped, and filtered

1198

according to your needs.

Figure 38.37 The Remote Logouts Report Dialog

38.12.5

Report Unique Users

The total number of Unique Users can be viewed in the footer of the Full
Sessions Report (Figure 38.38, red arrow), which is accessible from the File
tab
. Note that filter criteria
may be used to return the results for a specific date range.
1202

Figure 38.38 Number of Unique Users displayed in footer of Full Sessions report
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By dragging the Login Name column header to the shaded gray area at the top
of the report , the activity per user (by Login Name), can be reported. This
includes the sum of all hours logged in (SumHours), the number of logins (Qty),
and average length of session (AvgHours) (Figure 38.39).
1199

38.12.6

Billing Report

Billing Report can be accessed from the File tab
Report.
Choosing a Billing Report (Figure 38.40) will allow you to see the number of
Unique Users and the total of Quarters Billed for each Lab group.
The report can be arranged, grouped, and filtered

1198

according to your needs.

An example of Billing report is depicted in the figure below. Three unique users
have been created under the Joe Flow group, and another three under the Jane
Cytometry group. Only one unique user from the Joe Flow name group accessed
the software during the quarter, while all three users from the Jane Cytometry
group accessed the software during the quarter. In total four active accessed the
software during the quarter each, thus billing for four quarters would be
assessed.
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Figure 38.39 The Billing Report Dialog

38.12.7

Arranging, Grouping, and Filtering Reports

All security reports contain a list of columns that can be arranged
or grouped
as well as the option to define Filter Criteria
(for a date range) and
Refresh the Report for the new filter.
1198
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Please see the following topics for details:
Arranging Columns
Grouping Reports
Filtering on a Date Range
1198
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38.12.7.
1

Arranging Columns in Reports

Columns for any report can easily be rearranged.
To rearrange columns:
1.Click on the column header to select it.
2.Click and hold on the column header.
3.Drag the column header to a new location (green arrows will indicate where
the column will be placed) (Figure 38.41).
In the example below the column header for Windows User Name was
dragged between IP Address and Login.
4.Drop the column header by releasing the mouse button (Figure 38.42).
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Figure 38.40 Dragging a column to a new Figure 38.41 The report after the column
location.
has been moved.

Date range filtering may also be done on any column, group, or custom filter
using the Filter Criteria
button.
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38.12.7.
2

Grouping and Filtering Reports

Reports can be arranged into groups based on column headers.
To create a grouped report:
1.Click on a column header to select it.
2.Click and hold on the column header.
3.Drag the column header to the grey area just above the header (green arrows
and the text "Drag a column header here to group by that column" will
indicate where the column header will be placed) (Figure 38.43).
In the example below the column header for Connection was dragged to
the grouping area.
4.Drop the column header by releasing the mouse button (Figure 38.44).

Figure 38.42 Dragging a column header Figure 38.43 A report after being grouped
into the grouping area
by Connection

Subgrouping of the report is also possible.
To create subgroups:
1.Click on a column header to select it.
2.Click and hold on the column header.
3.Drag the column header to the grey area just above the header (green arrows
and the text "Drag a column header here to group by that column" will
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indicate where the column header will be placed) (Figure 38.45).
In the example below the column header for Computer Name and IP
Address were subsequently was dragged to the grouping area.
4.Drop the column header by releasing the mouse button.
The hierarchy of subgroups can also be changed by dragging and dropping a subgrouped item before or after another grouped or sub-grouped item.

Figure 38.44 Using the grouping feature to create sub-groups

Grouped items can also be further filtered by clicking on the group or subgrouped heading and checking the box for the sub-group classification (Figure
38.46).
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Figure 38.45 Using a check box to further classify a group or sub-group

If the (Custom...) category is chosen you will be prompted with the Custom
Filter dialog in which you can define a custom classification for your reports
grouping (Figure 38.47 and Figure 38.48 below).

Figure 38.46 Choosing a custom
classification for reports

Figure 38.47 Using a custom
classification for reports

Date range filtering may also be done on any column, group, or custom filter
using the Filter Criteria
button.
1202

Filters may also be saved by clicking on the Save As... button (Figure 38.49
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below). The Save the active filter to file dialog will appear where you may
save your Filters (*.flt) file to be used again at a later date by clicking Save.

Figure 38.48 Saving a customized filter.
38.12.7.
3

Filtering on a Date Range

All reports can be further classified by using Filter Criteria to choose a date and
time range.
To define the Filter Criteria:
1.Click on the Filter Criteria button.
2.Enter a date and time range in the Time Interval Filter dialog (Figure 38.50).
3.Click OK.
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Figure 38.49 Choosing the date and time Filter Criteria

4.Click on the Refresh Report button to apply the new Filter Criteria to the
report (Figure 38.51).

Figure 38.50 Choosing to refresh the report to the new Filter Criteria

38.12.8

Exporting Reports

You have the option to export any report in the following formats:
TXT
HTML
XML + XSL
© 2020 De Novo Software
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XLS
To export a report:
1.Click on the button for the export type you want (Export to HTML in this
examples) (Figure 38.52).

Figure 38.51 Choosing to export the report as an HTML file

2.Choose a location and name for the file on your drive (Figure 38.53).
3.Click Save.

Figure 38.52 The export to HTML file dialog

38.13

Layout and Data Security

To help you fulfill your requirements under 21 CFR Part 11, 11.10(c), FCS
Express provides Record Protection. This is implemented in two forms:
1. Your layouts are stored in an encrypted format, and require the correct
encryption key to open. This holds true whether or not any data has been
embedded in the layout. If the layout has been tampered with, or corrupted in
any way, FCS Express will not be able to decrypt it, and will inform you that the
layout cannot be opened.
Note that we encourage you to retain secure backups of your layouts if the
above situation were to ever occur, so that you would be able to retrieve your
analysis.
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2. When data is loaded in a layout, FCS Express makes a digital signature of the
data, and stores it in the layout. After the analysis is completed, if in the future
someone attempts to open the layout to look at your analysis, then the layout
will only display the data if the digital signature is still the same. In other words, if
the data has changed, the person will not be able to see that data in your
analysis, and all plots will appear blank. This holds true whether the data was
saved embedded in the layout, or is stored separately on disk.
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Canned Comments
Canned Comments, which can consist of freetext and tokens 688 (including
Custom Tokens 725 ) are a way of saving a library of text that can be used in text
boxes. The overall appearance and operation of the Canned Comments window
is similar to using Custom Tokens 726 .
To create a new Canned Comment:
1.Click on the View tab Tokens
command to bring
up the dockable Canned Comments window.
2.Dock 115 the Canned Comments window to the left or right of the screen
so that both panels of the window are visible. The two areas of the Canned
Comments window, the Canned Comments List (upper panel) and the
Canned Comments Text Editor (lower panel), are separated by a splitter
which can be moved to resize the areas.
3.Click the green plus
to create a new Canned Comment and type in a
name (e.g., "Comment1" below).
4.Enter the text for the Canned Comment in the Canned Comments Text
Editor (lower panel, below the splitter). You can insert any combination of
text, regular tokens 688 , and custom tokens 688 (Figure 39.1). In the
example, a Statistic Token was created which displays the percent of gated
Lymphocytes. Also, a Statistical Classifier Token 705 was created to assess
the level of the Statistic Token.
5.Select the Canned Comment from the Canned Comments List (upper
panel) and drag it to an empty spot on the layout, or to an existing Text
Box. The text will be displayed with the values of the tokens. The tokens
will be highlighted in gray when the text box is in edit mode (Figure 39.2).
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Figure 39.1 Entering Canned Comment Text with Tokens

Figure 39.2 Text Box with Canned Comment Containing Statistic and
Statistic Classifier Tokens

The icon buttons in the Canned Comments window are explained in the table
below.
Icon Button Explanation
Add a new Canned Comment.
Create (and name) a new folder to organize Canned Comments. Drag & Drop
Canned Comments into the folder once it has been created.
Delete the selected item. Note: You can undo a delete by immediately
clicking Undo in the Quick Access Tool Bar 65 .
Rename the currently selected item.
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Tutorials
This chapter contains detailed tutorials of the functions of FCS Express Version 6
to make learning commonly used features as easy as possible.
Sample data is provided so that you can follow along with the examples in the
tutorials. The sample data can be downloaded from the De Novo Software web
site, from the archive:
https://s3.amazonaws.com/fcsexpressdownloads/TutorialSampleDataV6.zip
After downloading the archive, you may extract the contents anywhere you like,
for example, in My Documents.
These tutorials are currently available:
Using Objects
Inserting Plots
Formatting Plots
Gating
Text Boxes and Tokens
Quadrants
Quadrant/Marker to Gate Linking
Compensation
Snap Shots
Batch Processing
Creating and Using Panels
Docking
Data Navigator
Gate Navigator
Layout Navigator
Spreadsheets Use Case 1 - Working with Custom Tokens, Formula
References, and Conditional Formatting
Spreadsheets Use Case 2 - Creating a regression analysis with an Antibody
Titration Series
Spreadsheets Use Case 3 - Performing Channel Calibration and Regression
Analysis
Spreadsheets Use Case 4 - Creating and working with Pie, Bar and Scatter
Plots
High Content Flow
DNA Analysis
Proliferation
Kinetics
Cell Concentration
Channel Calibration
1213

1226

1238

1268

1300

1364

1377

1391

1438

1460

1513

1552

1576

1597

1612

1635

1675

1701

1725

1761

1798

1821

1850

1871
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Changing Common Preferences
Cluster Analysis
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1885

1930

1936

40.1

Using Objects
Objects (e.g., plots, text boxes, statistic tables, and pictures) are items that are
placed onto an FCS Express document (called a layout). Objects in FCS Express
can be manipulated similarly to objects in Microsoft PowerPoint, which means
they can be moved, resized, deleted, grouped, aligned, cut, copied, and
duplicated. In order for an object to be manipulated, the object must first be
selected. A red border surrounding the object denotes a selected object. An
object can also be in Edit mode, which is denoted by a green border. Edit mode
will be described in detail later.
The first section of this tutorial will describe Inserting an Object

40.1.1

1213

.

Inserting an Object
To insert an object on a page, simply choose the object from the Insert tab on
the Ribbon. In the following example, we will insert a picture.
To insert a Picture:
1. Select

(Figure T1.1).

2. Click the mouse where you want the top-left corner of the picture to
appear on the page. A file selection dialog will appear to allow you to
choose the picture file you wish to insert.

Figure T1.1 Insert Picture

3. Select the file Logo.png as shown in Figure T1.2 (we will use the De Novo
Software Logo as an example for the rest of the tutorial). If Logo.png is not
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available, you can use any picture file.

Figure T1.2 De Novo Software Logo

The red border around the object signifies that the object is selected. For more
information on selected and edit modes, refer to the Layout Page Features
section in the FCS Express manual.
In the next section, we will practice selecting and deselecting objects

40.1.2
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.

Selecting and Deselecting Objects
Clicking anywhere outside the object on the layout background will deselect the
object. To select the object again:
1. Move the mouse until it is on the border of the object.
2. Click on the border. You will know the cursor is in the right place because
the cursor will change to a four-headed arrow.
Now, we will resize an object

40.1.3
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.

Resizing an Object
Once an object is selected, you can resize it by moving the cursor to one of the
resizing handles (red circles, Figure T1.3) along the border of the object.
The example below shows how to resize the object both horizontally and
vertically at the same time:
1. Move the cursor above the resized handle on the bottom right hand
corner of the object until the arrow cursor changes to a two-headed
diagonal arrow cursor.
2. Press and hold down the left mouse button while moving the cursor to an
appropriate position. A transparent preview image of the object will appear
showing the new size as you move the mouse. You can maintain the
aspect ratio of an object by holding down the Shift key while you resize
the object.
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3. Release the mouse button and the object will resize to the size of the
preview image.

Figure T1.3 Resizing an
Object

We will now learn to move an object

40.1.4
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.

Moving an Object
To move an object (Figure T1.4):
1. Move the cursor along the border until a four-headed arrow cursor
appears.
2. Press and hold down the left mouse button.
3. Move the mouse while holding down the button. A transparent preview
image showing the new position of the object will appear as you move the
mouse.
4. Continue moving the mouse until the preview image is in the desired
location.
5. Release the mouse button. The object will now move to the new location.
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Alternatively, you can move the object by selecting it and pressing the arrow
keys on the keyboard (up, down, left, right). To move the object in smaller
increments using the keyboard, hold down the Shift key while pressing the
arrow keys.
The next topic is deleting an object

40.1.5
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.

Deleting an Object
To delete an object:
1. Select the object as described above

1214

.

2. Press the Delete key on the keyboard
OR
3. Select the

command (Figure T1.5).
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If you decide that you didn't want to delete the object, you can undo or redo
your changes in the next section.

40.1.6
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Undoing and Redoing Changes
FCS Express 6 allows for any number of previous operations to be undone and
redone.
To undo or redo any changes:
1. Click the Undo button in the Quick Access Toolbar (Figure T1.6). The
text on the Undo menu item will change to inform you which operation
can be undone. For example, to undo the delete of the picture in the step
above , click the Undo button. You can also press Ctrl+Z to undo
changes.
1216

2. Click the Redo button in the Quick Access Toolbar. The text on the Redo
menu item will change to inform you which operation can be undone. You
can also press Ctrl+Y to redo changes.

The next topic is duplicating objects

40.1.7
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Duplicating Objects
To duplicate an object:
1. Select the object as described above

1214

.

2. Select the
command. The new object will
appear offset slightly lower and to the right of the original object (Figure
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T1.7).

In the next section, we will select multiple objects

40.1.8
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.

Selecting Multiple Objects
To select multiple objects using the mouse (Figure T1.8):
1. Place the cursor outside the border region near a corner of one of the
objects you would like to select.
2. Press and hold the left mouse button.
3. Move the cursor. A gray highlighted box will appear as you move the
cursor around the layout.
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4. Size the gray highlighted box until all the objects to be selected are
contained within the box.
5. Release the left mouse button.
All of the objects will now be selected as seen by the presence of a red border
around each one.

To select multiple objects using the keyboard:
1. Hold down the Shift key on the keyboard.
2. Click inside or on the border of an object that you want to select. When
the object is selected the border will change to red.
3. Continue holding down Shift and move the cursor to another object you
want to select.
4. Click inside or on the border of this object. You may also deselect during
this multiple selection process by shift-clicking an already selected object.
5. Continue following steps 3 & 4 until all the objects that you want to select
are selected.
6. Release the Shift key. All the objects you have selected will have a red
border.

The next section is copying objects

40.1.9
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Copying Objects
FCS Express allows you to copy one or more objects to the clipboard and paste
them onto the same or a different layout page.
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To Copy objects:
1. Select the object or objects to be copied as described above

1214

.

2. Select the Copy Picture command (Figure T1.9), from the Clipboard
Group on the Home tab. The text of the Copy menu item will inform you
which object will be copied. Alternatively, you can use the Ctrl+C shortcut.

We will now proceed to pasting objects

40.1.10

1220

.

Pasting Objects

To paste objects that are on the clipboard:
1. Select the Paste Bitmap command (Figure T1.10) from the Clipboard
group on the Home tab. The text of the Paste menu item will inform you
which object will be pasted. Alternatively, you can use the Ctrl+V
shortcut.

In the next step, we will learn to group objects

40.1.11
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Grouping Objects

Individual objects on a page can be grouped together. This means that as soon
as one object in the group is selected, all of the objects in the group will become
selected. This is useful, for example, if several objects are in a specific relative
location to each other and you want to make sure that you cannot move one
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without moving all of the others.

To group several objects together:
1. Select the objects that you want to group, as described above
2. Select Group from the
list (Figure T1.11).

1214

.

command drop-down

3. Click on a blank area of the layout to unselect all the objects.
4. Click on the border of one of the grouped objects. They should all become
selected.
To ungroup grouped objects:
1. Select the group of objects you want to ungroup, as described above.
2. Select Ungroup from the
down list.
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In the next section, we will learn to align objects

40.1.12
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.

Aligning Objects

FCS Express allows both horizontal and vertical alignment of objects by their
sides, tops, bottoms or centers. This alignment feature also allows you to resize
an object's height or width with respect to another object's size. Objects are
always aligned with respect to the first object selected.

To horizontally align multiple objects:
1. Select

1214

all of the objects you want to align.

2. Select Align from the
command drop-down
list (Figure T1.12). An Alignment drop-down list will appear.
3. Select Centers from the horizontal alignment list (Figure T1.12).
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The selected objects are now horizontally aligned (Figure T1.13).

To make several objects have the same height and width:
1. Select the object that is the size you wish all the other objects to be.
2. Select the objects you wish to resize.
3. Select Align from the
T1.14a).

drop-down list (Figure

4. An Alignment dialog box will appear in the center of the layout (Figure
T1.14b).
5. Select Widths from the horizontal alignment list.
6. Select Heights from the vertical alignment list.
7. Press the OK button.
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All of the selected objects are now the same size as the first object selected
(Figure T1.15). Alternatively, the height and width could have been aligned
separately.
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In the last section of this tutorial, we will set the order of different objects

40.1.13
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Ordering Objects

FCS Express allows for explicit placement of objects in front or behind other
objects.

To move an object in front of another one:
1. Select the object that you want to move in front, as described above
2. Select Bring to Front from the
drop-down list (Figure T1.16).
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The selected object will be brought to the front (Figure T1.17).

40.2

Inserting Plots
In the course of this example, we will:
Learn how to insert plots on a layout.
The basic way to insert a plot is to use commands from the
, or
groups.

,

Although any data files of your own can be used to follow along, you have the
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option of using the same sample data files used in this tutorial. The sample data
files are located in the Tutorial Sample Data archive . The files GFPcontrol.001
and GFPsample.002 are used here.
1212

We will start by inserting a 2D plot

40.2.1
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.

Inserting a 2D Plot
To insert a 2D plot:
1. Select the

command (Figure T2.1).

2. Move the mouse to a place on the layout where you would like the topleft corner of the plot to be located.
3. Click the mouse on the page where you want the top-left corner of the
plot to appear.
A Select a Data File dialog box will appear (Figure T2.2).
Notice that all the data files in the dialog box appear with an FCS file icon,
even though their extension is not ".fcs". This is because FCS Express knows
that many FCS files are not saved with a ".fcs" extension, and it performs
special checking (and appropriately sets the icon to make sure you can easily
recognize your FCS data files).
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4. Select the GFPcontrol.001 data file from the FCS Express Sample Data
directory (Figure T2.2).
5. Press the Open button.
The newly inserted 2D dot plot will now appear in the layout with a default
size (Figure T2.3). You can change the default size by placing the cursor over
any of the red handles on the selected plot and adjusting as necessary. Refer
to the tutorial on using objects for more information on resizing objects .
1214
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Next, we will insert a histogram
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Inserting a Histogram
To demonstrate inserting a 1D plot in a custom size, we will add one to the
layout made in the previous section.
1. Select

(Figure T2.4).

2. Move the mouse to a place on the layout where you would like the top left
corner of the plot to be located.
3. Press and hold the left mouse button down.
4. Move the cursor, while holding the mouse button down, until the sizing
rectangle is the size you want the histogram to be (Figure T2.5).
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Figure T2.5 Insert Histogram (Step 4)

5. Release the mouse button and the histogram (shown with the red border)
will be inserted in the place of the sized rectangle (Figure T2.6).
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Note that when inserting the histogram, you were not prompted to select a file.
This is because FCS Express uses the most recent data file when adding a new
plot. You are only prompted to select a data file if no data files have been
opened, or you select the When creating a new plot, always display the
selection dialog preference from the FCS Express User Options (described
below ).
1233

Plots can also be inserted

40.2.3
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Inserting from the Data Tab with the Open Command
To insert a plot:
1. Select the
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A Select a Data File dialog will open as previously shown in Figure T2.2

1227

.

2. Select the GFPcontrol.001 data file from the FCS Express Sample Data
directory.
3. Select Open.
A Select Plot Types... dialog will appear (Figure T2.8).

Figure T2.8 Select Plot Types... Dialog

© 2020 De Novo Software

Tutorials

1233

4. Select Dot as the Plot Type to open.
5. Select OK.

A 2D dot plot will now appear on the layout (with a red border to indicate it is in
selected mode) as previously shown in Figure T2.3 .
1227

You can force the display of the selection dialog
preference.

40.2.4
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using by setting a user

Always Display Selection Dialog
When the default preferences are used, inserting a plot will insert the same data
file as previously selected. To select alternate files, the When creating a new
plot, always display the selection dialog preference can be set in Options.

1. Select the File tab (circled in red in the upper left-hand corner of Figure
T2.9).
2. Select Options (shown in the lower left of Figure T2.9).
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The FCS Express User Options dialog will appear (Figure T2.10).
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3. Select the Files/Directories category from the left column.
4. Select the checkbox for When creating a new plot, always display the
selection dialog (Figure T2.10).
5. Click OK.
Now we will open a data file and insert a 2D plot.
6. Select the

command.

The Select a Data File dialog box will appear, as previously shown in Figure T2.2
.
1227

7. Select the file GFPsample.002 from the Select a Data File dialog box.
8. Select Open.
An Open 2D Plots dialog box for file GFPsample.002 appears (Figure T2.11).
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This is where you can select the desired X and Y parameters for the 2D plot.
9. Select OK to select the default parameters on the Open 2D Plots dialog
box.

Figure T2.11 Open 2D Plots Dialog

The 2D dot plot of GFPsample.002 will now appear on the layout as shown in
Figure T2.12.
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Finally, we will insert plots from Windows Explorer

40.2.5
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Inserting Plots from Windows Explorer
FCS Express provides a variety of ways to open and select data files for plots.
These options allow you to choose your preferred method of opening a plot
from a file. In addition to the methods described above, you can select files
directly from Windows Explorer and then plot them with FCS Express.

Opening a new plot with a file from Windows Explorer:
1. Open Windows Explorer.
2. Navigate to the FCS Express Sample Data directory using Windows
Explorer.
3. Select the file GFPSample.002 in Windows Explorer.
4. Press and hold down the left mouse button and drag the file
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GFPSample.002 onto the layout in FCS Express.
The Select Plot Types... dialog appears as previously shown in Figure T2.8

1231

.

5. Select Dot from the Choose Plot Type(s) to open window on the
Select Plot Types... dialog.
6. Click OK.
A 2D Dot Plot of GFPSample.002 will now appear on the layout using default
settings.

Dragging and dropping data from Windows Explorer onto the Layout

40.3

Formatting Plots
All plot types share basic formatting options that include altering the titles, axes,
background, legend, and 3D presentation. These options allow you to completely
customize the look of your plots.
Although any data files of your own can be used to follow along, you have the
option of using the same sample data files used in this tutorial. The sample data
files are located in the Tutorial Sample Data archive . The layout section4.fey
and the ApoMono.001, ApoMono.002 data files will be used here.
1212

We will start by using the pop-up menu to format plots
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.
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Formatting Plots Using the Pop-up Menu
In the course of this example, we will:
Open a Layout file.
Insert data into a plot.
Format a plot using the pop-up menu.

1. Select File tab

(Figure T3.1).

2. Select the section4.fey layout file located in the Tutorial Sample Data
archive
from the Load Layout dialog (Figure T3.2).
1212
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The Layout should have a single blank plot (Figure T3.3).
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Figure T3.3 Section 4 Layout

3. Select the
insert a data file into the plot (Figure T3.4).
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4. Select the ApoMono.001 FCS file located in the Tutorial Sample Data
archive .
1212

5. Click Open.
6. Right-click on the plot so the pop-up menu appears (Figure T3.5).
7. Select Format from the pop-up menu.

Even though we have shown this example using a 2D plot, all objects in FCS
Express have an associated pop-up menu and are formatted in a similar manner.
Simply right-click on the object and select Format from the pop-up menu.
The Formatting dialog for 2D plots is shown in Figure T3.6.
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Figure T3.6 Formatting Dialog for 2D Plots

All formatting dialogs in FCS Express share several common features. The
section on the left is called the Category List. This list organizes all of the different
options for a particular object. The specific categories in the list change
depending on which object is being formatted. When you click on a category in
the category list, the right hand side of the dialog will change to show the specific
options that pertain to that category.
The OK button of the format dialog will become enabled when you change the
value of an option. You can also Preview and Restore the options without
closing the formatting dialog. Remember, even if you press OK to change your
options, and then decide that you don’t like them, you can always undo your
changes by selecting the Undo command from the Quick Access Toolbar 65 .

In the next section, we will format multiple plots at the same time
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40.3.1.1

Formatting Multiple Plots

In the course of this example, we will:
Duplicate a plot using the pop-up menu.
Use the Format tab from the ribbon to format multiple plots
simultaneously.

1. Right-click on the plot to bring up the pop-up menu.
2. Select Duplicate from the pop-up menu (Figure T3.7).

Figure T3.7 Duplicating a Plot

A duplicate copy of the plot should appear on top of the original plot (Figure
T3.8).
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Figure T3.8 Duplicated Plot

3. Move the mouse over the top border of the duplicate plot, the cursor
should change to a four-headed arrow.
4. Hold down the left mouse button while moving the duplicate plot down the
page.
5. Release the mouse button when the duplicate plot is at a desired location.
There should now be two identical plots on the page as shown in Figure T3.9.
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Figure T3.9 Duplicated Plots on a Layout Page
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6. Select both plots on the layout (see the tutorial on selecting multiple
objects ).
1218

7. Select

(Figure T3.10).

We will format the border/line of both plots at the same time.

Figure T3.10 Format Border/Line Command

8. Select Line from the Formatting Border/Line dialog.
9. Select a solid line is the Style.
10. Select Blue as the Color (Figure T3.11).
11. Click OK.

Figure T3.11 Formatting Border/Line Dialog
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Both plots will now have a blue border, as shown in Figure T3.12.
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Figure T3.12 Plots with a Blue Border
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12. Select Undo from the Quick Access Toolbar
changes to the plots (Figure T3.13).

65

to undo the formatting

Figure T3.13 Undo

The plots will now be restored to their original formatting with no border.
There are many options available for formatting objects using the Format tab
(see Figure T3.14). If you hover your mouse over a command on the Format
tab, a brief description of the command’s actions appears, as shown for the Fill
command in Figure T3.14.

Figure T3.14 Format Tab

In the next section, we will format plot titles

40.3.2
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Formatting Plot Titles
In the course of this example, we will:
Acquire an overview of formatting plot titles.
Change the title text.
Change the title font.
Change the shadow size.
Change the alignment of the title.
Change the footer properties.
Insert keywords.

To change the plot title (numbers refer to Figure T3.15):
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1. Right-click on the top plot to open the pop-up menu.
2. Select Format from the pop-up menu (Figure T3.5

1239

).

3. Click on the Titles category from the Plot Formatting dialog (Figure T3.6
).
1239

The Formatting Titles category options shown in Figure 35.44 will appear.
4. Select Header from the Header/Footer list box
5. Press the Font button

.

and increase the font size to 12 pt.

6. Press OK on the Font dialog when you have changed the font size.
7. Replace the existing title with the text "Light Scatter"
text that will appear as the title of the plot.

. This is the actual

8. Change the Shadow Size to 0 to remove the shadow from the
background of the header.
9. Select Right from the Alignment list to right align the title.
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Figure T3.15 Formatting Titles Dialog

10. Press OK to apply the changes.
The plot should now look like the plot in Figure T3.16B.
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Figure T3.16 Changing the Header Properties

Now, we will change the footer properties (numbers refer to Figure T3.18):
1. Right-click on the plot and select Format from the pop-up menu.
2. Click on the Titles category.
3. Select Footer from the Header/Footer list box
4. Check the Visible checkbox

.

to enable the visibility of the footer.

5. Delete the $FIL keyword from the header text.
6. Press the Insert Token dropdown menu
and select Keyword from
Data from the dropdown list. The Keyword Dialog will appear (Figure
T3.17). This allows you to insert any keyword that is located in the header
of the FCS File as the footer for the plot. As the value of the keyword
changes, (i.e., because you change the data file) the plot will automatically
update with the correct value.
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Figure T3.17 Select FCS Keyword

7. Select the $Date keyword (red arrow). This will insert the acquisition
date.
8. Press OK.
9. Uncheck the Background visible checkbox

.

10. Select Right from Alignment to right-align the footer

.

The screen should look like Figure T3.18.
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Figure T3.18 Formatting Titles Category (Footer)

11. Press OK to apply the changes.
The plot should now look like Figure T3.19B.
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Figure T3.19 Changing the Footer Properties

Next, we will format the plot axes

40.3.3

1256

.

Formatting Plot Axes
FCS Express has many axis formatting options which allow you to customize the
appearance of your axes any way you like. You have full control over the axis
text, font, colors, and many other aspects of its appearance.
In order to demonstrate modifying the axis properties, we will continue with the
layout we were using above.
In the course of this example, we will:
Acquire an overview of formatting axes.
Modify the axis font properties.
Add grid lines to a plot.
Change the angle of the axis labels.

To format the axes (numbers refer to Figure T3.20):
1. Right-click on the plot and select Format from the pop-up menu.
2. Click on the Axis category

.
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3. Click on the Y Axis

to set the properties for the Y axis.

4. Click on the Font button

and change the font to Bold.

5. Press OK on the Font dialog to accept the font changes.
6. Click the Show grid lines checkbox
7. Click on the X Axis

to turn it on.

to set the properties for the X axis.

8. Click on the Font button

and change the font to Bold.

9. Press OK on the Font dialog to accept the font changes.
10. Change the Angle

to 10.

Press OK to accept the changes.

Figure T3.20 Axis Formatting
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The axes of the plot have now been modified (see Figure T3.21).

Figure T3.21 Formatting Axis Example

In addition to changing the parameters displayed on the axis or axes of a plot via
the Format window, you may use these keyboard or mouse commands 308 .
In the next section, we will format the plot background

40.3.4

1258

.

Formatting Plot Background
FCS Express also allows complete flexibility in formatting the background of your
plots. Almost any object in FCS Express has the same background options as
the ones we describe below. The background of any object can display any solid
color, a gradient of colors, or an image. Many objects can also be set to be
transparent. The plot background options are unique in that they also allow you
to adjust the plot margins.
In order to demonstrate modifying the background properties, we will continue
with the layout we were using above. In the course of this example, we will:
Acquire an overview of formatting the background.
Modify the background gradient.
Modify the plot margins.

To format the background (numbers refer to Figure T3.22):
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1. Right-click on the plot and select Format from the pop-up menu.
2. Click on the Background category
3. Click the Gradient radio button

.

.

4. Change the Right Margin
to 8%. This will move the right plot margin,
allowing you to see the last axis label that is cut off in Figure T3.21 .
1256

5. Press OK to accept the changes.

Figure T3.22 Background Formatting

The plot background has now been modified to display a gradient background as
shown in Figure T3.23.
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Next, we will format the legend

40.3.5
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.

Formatting the Legend
Legends are useful to describe the data presented in your plots and to help
distinguish between several data files that are overlaid onto a single plot.

In the course of this example, we will:
Learn how to add an overlay to a histogram.
Acquire an overview of legend formatting.
Change the legend font.
Change the legend position.

In order to format the legend, we will first create a histogram with an overlay.
1. Insert a histogram using the data file ApoMono.001. If you do not know
how to insert a histogram, see the Inserting Plots
chapter of this
tutorial.
1226

2. Right-click on the histogram.
3. Select Add Overlay from the pop-up menu.
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4. Choose the ApoMono.002 data file. Leave the rest of the properties on
the add overlay window alone.
5. Press OK to add the overlay.
The histogram should look like Figure T3.24. If the legend is already on your
plot, your preferences may be set to automatically add legends.

Figure T3.24 Histogram with Two Overlays

To format the legend:
1. Right-click on the histogram and select Format from the pop-up menu.
The Formatting window appears (Figure T3.25)
2. Select the Legend category on the left (
3. Check the Visible checkbox (
4. Press the Font button (
10 pt, Bold.

).

) (if it is not already checked).

) and change the font to Times New Roman,

5. Press OK on the font dialog to accept the changes.
6. Change the Position (

) to "Top".

7. Press OK to accept your changes.
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Figure T3.25 Formatting - Legend Category

The plot should now look like Figure T3.26.

Figure T3.26 Histogram with Formatted Legend

Overlays can be formatted either as stacked or overlaid

1263

.
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Changing Histogram Overlays
In the course of this example, we will learn how to change histogram overlays to
stacked:
For convenience, we are going to start with the same layout as before. The
images contained within this section will continue with the layout from the
previous section.
1.

Select the histogram (see selecting objects

2.

Select the
command (Figure
T3.27).
Alternatively you can Right-click on the histogram and select
.

1214

).

Figure T3.27 Format Specific Options Command

A Formatting Histogram Specific Options dialog will appear (Figure T3.28).
3.

Check Stacked from the Display multiple overlay data section (

4.

Click OK.
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Figure T3.28 Format Histogram (Stacked Overlays)

The histogram will change to stacked (Figure T3.29).
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Figure T3.29 Stacked Histograms

To change the histogram overlays back to overlaid press Ctrl+Z on your
keyboard.
Alternatively repeat steps 1-4 selecting Overlaid from the Display multiple
overlay data section ( ).
The histogram will change back to the overlaid style (Figure T3.26

Certain plots can be formatted in 3D
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).
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Formatting 3D Options
FCS Express also allows you to view your histogram overlays in 3D.

In the course of this example we will:
Acquire an overview of the 3D options.
Turn 3D on.
Change the 3D percent.

We will use the histogram shown in Figure T3.26

1260

.

1. Right-click on the histogram and select Format. The Formatting window
appears (Figure T3.31).
2. Click on the Plot 3D Options category under the Histogram sub-menu (
).
3. Check View in 3 Dimensions (
4. Change the 3D % to 100% (

).

).

5. Adjust the Zoom slider to 70% (

).

6. Adjust the Vertical offset slider to approximately 10% (

).

Press OK to accept the changes.
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Figure T3.31 Histogram 3D Options

The plot should now look similar to Figure T3.32.
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Figure T3.32 Histogram with 3D Overlays

40.4

Gating
In FCS Express 6, you can create six types of gates as tools for flow cytometry
analysis. These gates include rectangular, elliptical, polygonal, freeform, markers
(1D), and combination gates. This tutorial will demonstrate how to create,
manipulate, and apply gates. More information on gates can be found in the
Analysis of FCS Data chapter of the manual 316 .

The first section, will introduce creating gates

40.4.1

1268

.

Creating Gates
In the course of this example, we will:
Open a previously created layout.
Create rectangular, elliptical, polygonal, and freeform gates.
Change a data file.
Create a 1D gate on a 2D plot.
Create a 1D gate from a marker.
Convert a quadrant to a gate.
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Although any data files of your own can be used to follow along in this tutorial,
you have the option of using the same sample data files used in this tutorial. The
sample data files are located in the Tutorial Sample Data archive . The
section5.fey layout and the ApoMono.001 and ApoMono.002 data files will be
used here.
1212

To Open a Layout:

1. Select File tab

(Figure T3.1

1239

).

2. Select the section5.fey layout file located in the Tutorial Sample Data
archive
from the Load Layout dialog.
1212

3. Select the
insert a data file into the plot (Figure T3.4

command to
1239

).

4. Select the ApoMono.001 FCS file located in the Tutorial Sample Data
archive .
1212

5. Click Open.

The layout should now look like Figure T4.0.
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Figure T4.0 Section5 layout after file loading

We are going to insert four different kinds of gates on the different plots on the
layout.
Using the commands from the Create Gates groups on the Gating tab (Figure
T4.1) is the most convenient way to create gates, but all gates except markers
(1D) can also be created using Create Gate from the 2D plot pop-up menu
(right-clicking on a plot brings up the pop-up menu). The Gating commands are
shown in Figure T4.1 and described in the table below.
Note: Gating of data obtained from multiwell plates will be discussed in a
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subsequent tutorial (see Analyzing Data in Heat Maps section).

Figure T4.1 Gating Commands

Symbol

Description
Insert an elliptical gate
Insert a rectangular gate
Insert a polygonal gate
Insert a freeform gate
Insert a marker
Insert a quadrant

If you hover your mouse briefly over any of the commands in the Create Gates
group, a hint describing the command is shown.

To see the gating command hint (Figure T4.2):
5. Move the mouse over the Rectangle gate button.
6. Pause for half of a second.

Figure T4.2 Gating Command Hint

To create a Rectangular Gate:
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7. Select the Gating
).

command (Figure T4.1

You will know it is pressed because it will have a different color background

.

We will create the rectangular gate on the upper left density plot (referred to as
"Create the rectangular gate on this plot") (Figure T4.3) .

Figure T4.3 Density Plot for First Gating
Excercise

8. Move the cursor on the plot wherever you would like the gate to begin.
9. Press and hold the left mouse button.
10. Move the cursor on the plot wherever you would like the gate to stop.
(Figure T4.4).
11. Release the mouse button.
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Create the rectangular gate on this plot.

Figure T4.4 Creating a Rectangular Gate

The Create New Gate dialog will appear (Figure T4.5). We can now give the
gate a name.
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Figure T4.5 Create New Gate Dialog

12. Enter "Whole Cells" in the Create a new gate named edit field.
13. Click OK to accept the name.

The gate and a text box displaying the gate name and the % of gated cells will
appear in the plot (Figure T4.6).
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Figure T4.6 Newly Created Rectangular
Gate

Note: You can cancel the creation of gates anytime during step 7-12 by pressing
ESC on the keyboard. This technique applies to all types of gates.

To create an Elliptical Gate:
14.Select the Gating

command (Figure T4.1

).

You will know it is pressed because it will have a different color background

.

We will create the elliptical gate on the upper right density plot (referred to as
"Create the elliptical gate on this plot").

15.Follow steps 8-11 above to create the elliptical gate.
16. Enter "Cells in ellipse" in the Create a new gate named edit field.
17. Press OK to accept the name.
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The gate and a text box displaying the gate name and the % of gated cells will
appear in the plot (Figure T4.6b).

Figure T4.6b Newly Created Elliptical Gate

To create a Polygon Gate:
We will create the polygon gate on the lower left density plot (referred to as
"Create the polygon gate on this plot").
18. Select the

command (Figure T4.1

).

You will know it is pressed because it will have a different color background

.
19. Move the cursor on the plot wherever you would like the add the first
point of your polygon gate.
20. Press the left mouse button. The first point of your gate is created
21. Move the cursor on the plot wherever you would like the add the second
point of your polygon gate.
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22. Press the left mouse button. The second point of your gate is created
23. Repeat steps 19-22 until you want to close the polygon.
24. Close the polygon gate by clicking on the first point created in step 20.
Alternatively, you can press the space bar to close the polygon.

A Create New Gate dialog will appear, similar to Figure T4.5. We can now
give the gate a name:

25. Enter "Cells in a polygon" in the Create a new gate named edit field.
26. Click OK to accept the name.

The gate and a text box displaying the gate name and the % of gated cells will
appear in the plot (Figure T4.7).

Figure T4.7 Polygon Gate

To create a Freeform Gate:
We will create the freeform gate on the lower right density plot (referred to as
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"Create the freeform gate on this plot").
27. Select the
).

command (Figure T4.1

You will know it is pressed because it will have a different color background

.

28. Move the cursor to the place where you want to start the gate.
29. Press and hold down the left mouse button.
30. Move the cursor while holding the mouse button down to create the
shape of the gate. A line will follow the cursor showing where the gate will
appear.
31.Release the mouse to finish creating the gate (Figure T4.8).

A Create New Gate dialog will appear, again similar to Figure T4.5. We can now
give the gate a name:
32. Enter "Cells in freeform" in the Create a new gate named edit field.
33. Click OK to accept the name.

The gate and a text box displaying the gate name and the % of gated cells will
appear in the plot (Figure T4.6b).
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Figure T4.8 Freeform Gate

In the next section, we will create a 1D gate on a 2D plot

40.4.2
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.

Creating a 1D Gate on a 2D Plot
1D gates can be applied to 2D plots as well as single parameter histograms
(where they are called Markers). 1D gates are unique in the respect that they
only gate on data in a single dimension. We will continue using the same layout
we were using above in the previous section.
We will now create a 1D gate on the 2D plot underneath where it says "Create
the elliptical gate on this plot" (Figure T4.6b ).
1268

To create a 1D Gate on a 2D plot:
1. Select the Gating tab
right-click on the plot and select
menu.

command, or
from the pop-up

You will know the Create Marker command is selected because it will have a

different color background
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2. Place the cursor on the 2D plot at the location you want to start the gate.
3. Press and hold down the left mouse button.
4. While holding the mouse button down, move the cursor from the left to
the right to create a 1D gate in the horizontal direction.
Note: Moving the cursor from the right to left, or left to right, will create a 1D
gate along the x-axis. Moving the cursor in the vertical direction, either up or
down, will create a 1D gate along the y-axis. In this example, we will create a
gate along the x-axis.

5. Release the mouse button when at the desired location (Figure T4.9).
Create the elliptical gate on this plot.

Figure T4.9 Creating a 1D Gate on a 2D Plot

A Create a new gate dialog will appear, as previously shown.
6. Enter "Cells in marker" in the Create a new gate named edit field.
7. Press OK to accept the name.
8.
A 1D gate now appears on the 2D plot (Figure T4.10).
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Figure T4.10 1D Gate on a 2D Plot

Next, we will create a gate from a marker

40.4.3
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.

Creating a Gate from a Marker
We will continue using the same layout we were using above in the previous
section.
To create a Gate from a Marker on a 1D plot:
1. Press the Page 2 tab from the Layout Navigation Toolbar (lower left of
the window). You will see a blank histogram and dot plot on that page.
2. Select both the histogram and the 2D plot contained in this page by
pressing Ctrl+A on your keyboard
3. Select the
a data file into the plot (Figure T3.4

command to insert
1239

).

4. Select the ApoMono.002 FCS file located in the Tutorial Sample Data
archive .
1212

5. Click Open.

The histogram should look like Figure T4.11.
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Figure T4.11 Histogram with Marker

6. Right-click on the histogram to bring up the pop-up menu.
7. Select
from the pop-up menu (Figure T4.12).

Create the marker gate on this histogram.
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Figure T4.12 Convert Marker to Gate

A dialog will appear asking you to name the gate.
8. Enter "Marker Gate" in the Create a new gate named edit field.
9. Press OK to accept the name.

The gate is now linked to the marker because we selected Convert and link
above. This means that whenever we move the marker, the gate will also move
to reflect the new marker position.

Note you can track gate creation and hierarchy through the Gate View.:
To open a Gate View object:
10. Select the Gate View button in the Insert bar (Figure T4.12)

© 2020 De Novo Software

1284

FCS Express 6 Manual

Figure T4.12 Inserting a Gate View Object

11. Click the left mouse button on the layout wherever you want to insert the
Gate View object
10. The Gate View appear (Note the presence of the new "Marker gate"
gate)

Figure T4.13 Example of
Gate View

In the next section, we will create a gate from a quadrant

40.4.4
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.

Creating a Gate from a Quadrant
It is also possible to create a gate from a quadrant. It does not matter if the
quadrant is standard, floating, or percentile (for an in-depth description of the
different types of quadrants, see the section on Using Quadrants 366 ). Creating a
quadrant gate is very similar to creating a marker gate.
We will continue using the same layout we were using above in the previous
section.
On the bottom of Page 2 of the layout, you should see a dot plot with
quadrants.
1. Right-click on the dot plot to bring up the pop-up menu.
2. Select

from
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the pop-up menu (Figure T4.13).

Figure T4.13 Converting a Quadrant to a Gate

A dialog will appear asking you to name the gate.
3. Enter "Quadrant Gate" in the Create a new gate named edit field.
4. Press OK to accept the name.
The gate is now linked to the lower right quadrant because we selected Convert
and link above. This means that whenever we move the quadrants, the gate will
also move to reflect the new quadrant position.

It is also possible to create combination gates

40.4.5
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Creating Combination Gates
Combination gates consist of combinations of other gates. To combine gates,
you create a gating formula using Boolean combinations of pre-existing gates.
Gating formulas are defined by either a single gate, or gate numbers joined by
Boolean operators. The Operators describe how the gates should be combined
and follow the rules of Boolean algebra.
We will continue using the same layout as we were using above.
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As a first step we will insert a gate view object to keep track of the new gates
we are going to create.
To insert a Gate View:
1. Select the Gate View button in the Insert bar (Figure T4.12

1281

).

2. Click the left mouse button on the layout wherever you want to insert the
Gate View object
3. The Gate View (Figure T4.14) now appears on the layout.

Figure T4.14 Gate View on a Layout Page

To create a Combination Gate:
1. Right-click on the Gate View to bring up the pop-up menu.
2. Select Add Combination Gate from the menu (Figure T4.15).
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Create the polygon gate on this plot.

1287

Create

a freeform gate on this plot.

Figure T4.15 Add a Combination Gate

3. The Create Gate editor will appear (Figure T4.16).
4. Type "My Combination Gate" in the Name field (
5. Click in the formula field (

).

).

6. Type "m".
7. Notice that the text "marker Gate" is filled in for you. That is because FCS
Express knows that is the only gate that starts with the letter "m".
8. Type <SPACE> to accept the "marker gate" choice.
9. Type "o".
10. Type <SPACE> to accept the "or".
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11. Type "q".
12. Type <SPACE> to accept the "quadrant Gate" choice.
13. Change the color to "Plum" (

).

Figure T4.16 Create Combination Gate Dialog
14. Press the OK button to create the combination gate.

More information about creating combination gates and all the different possible
operators can be found in the section on Creating Gates 318 in the main part of
the manual.

Next, we will learn how to move a gate

1289

.
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Moving Gates
In the course of this example we will:
Activate a gate
Move a gate

We will continue using the same layout as we were using above.

1. Click anywhere inside the "Whole-Cells" gate. This will activate the gate.
You know the gate is activated when there are resizing handles (red
squares) on the corners (Figure T4.17).
Create the rectangular gate on this plot.
rectangular gate on this plot

Before

Create the

After

Figure T4.17 Gate activation by clicking on
it

2. Press and hold down the left mouse button anywhere inside the gate.
3. Move the mouse while holding down the mouse button. An outline of the
gate will move as you move the mouse.
4. Release the mouse button when the gate is in the new, desired position.

Note: You can press Esc on the keyboard while moving a gate (Steps 1-3) to
cancel the action.
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The next topic is resizing a gate

40.4.7
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Resizing Gates
In the course of this example we will:
Re-size a gate.
Re-size a gate with multiple vertices proportionally.
Re-size a vertex of a gate with multiple vertices independently.

We will continue using the same layout as we were using above.

1. Activate the "Whole-Cells" gate by clicking inside the gate (Figure T4.17
).

1289

2. Move the mouse to the top right resizing handle of the gate. You will know
you are in the correct place when the mouse cursor changes to a twoheaded arrow. Press and hold down the left mouse button.
3. Move the mouse while holding down the mouse button. An outline of the
gate will move as you move the mouse.
4. Release the mouse button when the gate is in the new, desired position.

Note: You can press Esc on the keyboard while resizing a gate (Steps 1-3) to
cancel the action.

Polygon and freeform gates can be resized proportionally by accessing the outer
set of resizing vertices.

Proportional Resizing of Polygon Gates
1. Activate the polygon gate by clicking inside the gate.
2. Move the mouse to the top right large outer resizing handle of the gate
(Figure T4.18). You will know you are in the correct place when the
mouse cursor changes to a two-headed arrow.
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Create the polygon gate on this plot.

Figure T4.18 Proportional Resizing of a Polygon Gate

3. Press and hold down the left mouse button.
4. Move the mouse while holding down the mouse button. An outline of the
gate will move as you move the mouse. The gate will change height as
you move the mouse up or down, width, as you move the mouse right or
left, and overall size as you move the mouse in a diagonal direction.
5. Release the mouse button when the gate is sized appropriately.

Resizing Polygon Gate Vertices Independently
1. Activate the Polygon Gate by clicking inside the gate.
2. Move the cursor over the upper left vertex of the polygon gate (Figure
T4.19). You will know you are in the correct place when the mouse cursor
changes to a two-headed arrow.
3. Press and hold down the left mouse button.
4. Move the mouse while holding down the left mouse button. As you move
the mouse, the one vertex will move and all the other vertices of the
polygon gate will remain fixed.
5. Release the mouse button when the vertex of the gate is in the
appropriate location (Figure T4.19).
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Create the polygon gate on this plot.
the polygon gate on this plot.

Create

Before
After
Figure T4.19 Re-size a Polygon Vertex Independently

In the next example, we will delete a gate

40.4.8
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Deleting Gates
In the course of this example we will:
Delete a gate

We will continue using the same layout as we were using above.

1. Activate the "Whole Cells" gate by clicking in the gate (Figure T4.17

1289

).

2. Press the Delete button on the keyboard.

A dialog will appear asking if you want to delete or hide the "Whole Cells" gate
(Figure T4.20).
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3. Press Delete to delete the "Whole Cells" gate.

Figure T4.20 Deleting a Gate

The "Whole Cells" gate has now been deleted from the layout and thus
disappears from the plot.

Once gates are created, they can be applied to a plot

40.4.9
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Applying Gates
In the examples above, we created several gates. We will now learn how to
apply them to a plot.

In the course of this example we will:
Apply a gate from the format screen.
Apply a gate from the Gating tab.
Apply a gate from the Gate Navigator.
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We will continue using the layout we have been using until now. Numbers refer to
Figure T4.21.

1. Right-click on the plot that used to have the "Whole Cells" gate on it.
2. Select Format from the pop-up menu.
3. Select the Overlays Category
4. Change the Gate

.

to "Cells in ellipse".

Figure T4.21 Formatting 2D Plots (Overlays Category)
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5. Press the OK button to accept the change.
The plot should now look similar to the right panel of Figure T4.22.
Note: The plot may not look exactly like Figure T4.22 because you may have
placed your ellipse gate in a slightly different position.

Figure T4.22 Plot Ungated (left) become gated on "Cells in Ellipse" (right)

6. Move the ellipse gate. You will see the plot that is gated on "Cells in ellipse"
update as the "Cells in ellipse" gate is moved.
7. Click on the plot that you have gated so that it is in edit mode. You will
know it is in edit mode because there will be a green border around the
plot.
The Current Gate field on the left side of the Create Gates group of the Gating
tab will display "Cells in ellipse" (see Figure T4.23), indicating that the current plot
is gated on "Cells in ellipse".
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Figure T4.23 Selecting the "Cells in a Polygon" Gate

8. Click on the arrow next to "Cells in ellipse" to drop down the list of
available gates.
9. Select the "Cells in a polygon" gate (Figure T4.23).

Your plot should only display cells that are in the "Cells in polygon" gate, as
shown in Figure T4.24.
Note: The plot may not look exactly like Figure T4.22 because you may have
placed your ellipse gate in a slightly different position.
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Figure T4.24 Plot Gated on "Cells in Ellipse" (left) become gated on "Cells in
Polygon" (right)

10. Select the

command.

11. The Gate Navigator will appear (Figure T4.25). The Gate Navigator
displays all the current gates and indicates which gates are being applied to
a plot.
12. Move the Gate Navigator to the side of the layout in order to have a
complete view of your plots.
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Figure T4.25 Opening the Gate Navigator Window

13. Drag and drop the "Cells in freeform" gate onto the 2D plot labeled
"Create the rectangular gate on this plot". As soon as the mouse will be
onto the plot, the latter will become blue highlighted (Figure T4.26)
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Figure T4.26 Drag&Drop a Gate from the Gate Navigator window onto a plot

14. Release the mouse button to apply the gate.

The "Cells in freeform" gate is now applied to the plot as indicated on the
updated Gate Navigator (Figure T4.27).
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Figure T4.27 Gate Navigator Updated

Note: you can also drag and drop a gate from the Gate View (Figure T4.13
) onto any plot, exactly in the same way we did here from the Gate
Navigator window.
1281

40.5

Text Boxes and Tokens
Text boxes allow you to enter any text you like in your layout. They support
many of the features found in modern word processing software, i.e., text
formatting, tables, bullets, numbering, and many other advanced features. In
addition to standard word processing features, FCS Express also supports adding
tokens to a text box. Tokens 688 are dynamic pieces of information that update
as you change your data. For instance, if you insert a statistics token in your
text box, the value of the token will constantly be changing as you change the
data.

In the first section, we will cover inserting text boxes

40.5.1

1300

.

Inserting Text Boxes
There are several ways to insert a text box, but the two most common
methods are: inserting a default-sized text box, or a custom-sized text box. You
can also add a text box directly into a 2D plot or histogram so that when you
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move the plot, the text box will also move.

In the course of this example, we will:
Insert a text box.
Insert a custom-sized text box.
Insert a text box into a plot.

To insert a default-sized text box:
1. Select File tab
2. Select the

to create a new layout.
command (Figure T5.1).

3. Click anywhere on the layout to place the text box.

Figure T5.1 Selecting the Insert Text Box Command

By default, a text box of 1 inch by 1 inch will appear where you place and click
your left mouse button on the layout. Note: To change this default size setting,
select File tab
.

The text box will appear in edit mode (green border) with a blinking mouse
cursor (Figure T5.2). This means that you can now enter text into the text box.
Entering text is similar to typing in a text box in Microsoft PowerPoint™.

Figure T5.2 Empty Text Box
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To insert a custom-sized text box:
1. Select the

command.

2. Place the mouse on the layout where you would like the top left corner of
the text box to begin.
3. Press and hold down the left mouse button.
4. Move the mouse while holding down the mouse button. A dashed outline
showing the dimensions of the object will appear as you move the mouse
(Figure T5.3).
5. Release the mouse button once you have enlarged the dashed outline to
the desired size. An empty text box will appear in edit mode (green
border) at that position.

Figure T5.3 Inserting a Custom-sized Text Box

To insert a text box into a 2D plot or histogram:
1. Select
2. Select

to close the layout we were just working on.
.

3. Open the layout TextBoxInsertion.fey found in the FCS Express Sample
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Data folder.
This layout contains a density plot of APC-A vs. PE-A.
4. Right-click on the plot. A green border will appear indicating that the plot is
selected and the pop-up menu will appear.
5. Select Add Text Box (Figure T5.4) from the pop-up menu.

Figure T5.4 Adding a Text Box to a Plot

A small text box will appear in the upper left-hand corner of the plot (Figure
T5.5). You can now begin entering text.
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Figure T5.5 Text Box Added to a Plot

The text box is now embedded within the plot. Moving the plot you will also
move the text box. You can also move the text box anywhere within the plot.
For help with moving objects, please see the tutorial on Using Objects .
1215

6. Select

to close the layout we were just working on.

In the next section, we will format the text in a text box

40.5.2
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.

Formatting Text in a Text Box
The text within a text box can be formatted similar to formatting text in
Microsoft Word™.

In the course of this example, we will:
Change the font.
Change the font size.
Change the paragraph alignment.

1. Select File tab

(Figure T3.1

1239

).

2. Open the layout TextBoxFormat.fey found in the Tutorial Sample Data
archive .
1212
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This layout contains a single text box in the center of the page with the text "This
is a text box" (Figure T5.6). The default settings for text are Arial, 10 pt., and left
alignment.

Figure T5.6 Text Box

You can change the text by selecting the Text tab on the ribbon (Figure T5.7).
The Text editing commands are very similar to those in Microsoft Word™.

Figure T5.7 Text Formatting Commands

3. Highlight the text in the text box.
4. Change the Font to Courier Bold.
5. Increase the Font Size to 16pt.
6. Change the Font Alignment to Right.

The text should now look like Figure T5.8 (right panel).
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Figure T5.8 Formatting a Text Box

Next, we will change the text box properties

40.5.3
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.

Formatting Text Box Properties
In addition to formatting the text within a text box, the properties of the text
box itself (e.g., size, background color, and border style) can also be formatted.

In the course of this example, we will:
Change the border.
Change the size.
Change the background.

We will continue using the same layout we were using above in the previous
section.

To format the Text Box properties:
1. Right-click in the text box from Figure T5.6

1304

.

2. Select Format from the pop-up menu (Figure T5.9).
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Figure T5.9 Selecting Format from the Pop-up Menu

The Formatting Text box dialog (Figure T5.10) will appear with five categories
on the left:
A. General – To change the name of a text box.
B. Border – To change or add a border to a text box.
C. Size – To change the size of a text box.
D. Background – To change the background of the text box.
E. Authorizations
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Figure T5.10 Formatting Text Box Dialog

To Modify the Border:
1. Click on the Border category in the Formatting Text box dialog (Figure
T5.11).
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Figure T5.11 Formatting Text Box Dialog--Border Category

From the category you can change the line style, color, and width. The default
setting is no line.
2. Select 1.00 points from the Width spin control (Figure T5.11
3. Select Solid Line from the Style drop-down list (Figure T5.11
4. Select Black from the Color drop-down list (Figure T5.11

).
).

).

5. Select OK.
6. Click on the layout to remove the selection highlighting from the text box.

The text box should now look like Figure T5.12 (Right panels).
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Figure T5.12 Text Box with Border

To Modify the Size:
1. Right-click in the text box..
2. Select Format from the pop-up menu..
3. Click on the Size category in the Formatting Text box dialog (Figure
T5.13).
From the category you can change you can change the dimensions of the
text box.

Figure T5.13 Formatting Text Box Dialog--Size Category

Click on Lock Aspect Ratio (Figure T5.13 ). This will maintain the ratio of the
text box size relative to the original text box.
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).

5. Select Preview. By changing the height to 2.00 inches, the width has
automatically change to 2.00 (because Lock Aspect Ratio is checked in
Figure T5.13).
6. Select OK.
7. Click on the layout to remove the selection highlighting from the text box.

The text box should now look like the 'After' image on the right of Figure T5.14.

Figure T5.14 Modified Text Box Size

To Modify the Background of a text box:
1. Click on the Background category of the Formatting Text box dialog
(Figure T5.15).
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Figure T5.15 Formatting Text Box Dialog--Background Category

The Background category page will appear (Figure T5.15). Here, you can
change the background of the text box. The default is a solid white background.
2. Select Gradient for the background.
3. Change the Start Color to Blue (Figure T5.15

).

4. Change the End Color to Pale Blue (Figure T5.15

).

5. Change the Direction to Right to Left (Figure T5.15

).

6. Select OK.

The resulting image should now look like the image on the right of Figure T5.16.
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Figure T5.16 Text Box with New Background

Select File tab

to close the layout we were just working on.

Next, we will insert and modify a table

40.5.4
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.

Inserting and Modifying a Table
Tables are another way to insert and organize data in a layout. FCS Express
supports a wide variety of formatting options for tables.

In the course of this example, we will:
Insert a table into a text box.
Modify table properties.

To insert a table:
1. Select File tab

to open a new layout.

2. Insert a text box and have it open in edit mode (green border). For help
with inserting a text box, see the previous section of this tutorial,
"Inserting Text Boxes" .
1300

3. Select the
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(You can also right-click within a text box and select
from the pop-up menu.)

Figure T5.17 Insert Table Command

An Insert Table dialog will now appear (Figure T5.18).

Figure T5.18 Insert Table Dialog

Here you can select the properties of the new table. The default settings are two
columns and two rows.
4. Press OK to accept the default properties.
A new table will appear in the text box (Figure T5.19).
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Figure T5.19 Table Inserting in a Text Box

To Modify a Table:
1. Click inside the table to select it.
2. Select the
right-click on the table and select
up menu.

command (Figure T5.20) or
from the pop-

Figure T5.20 Table Properties Command

A Table Properties dialog will appear (left side of Figure T5.21).
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Figure T5.21 Table Properties and Default Cells Border Dialogs

3. Select the color Sky Blue from the Fill Color drop-down list (Figure
T5.21 ).
4. Click on the Cell Borders… button (Figure T5.21 ). The Default Cells
Borders dialog will appear (Figure T5.21 right panel).
5. Change the cell border Color to Yellow (Figure T5.21
6. Change Width to 3 (Figure T5.21

).

).

7. Press the OK button on the Default Cells Borders dialog (Figure T5.21
).
8. Press the OK button on the Table Properties dialog to accept the
changes (Figure T5.21 ).

The resulting table should now look like the one on the right of Figure T5.22.
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Figure T5.22 Formatted Table

Select File tab

to close the layout we were just working on.

We will now proceed to inserting and modifying a token

40.5.5
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.

Inserting and Modifying a Token
Tokens can represent items of many types including: statistics, classifiers, file
information, or customized values. You can insert tokens in text boxes. For the
following three sections on tokens, the file we will be using is ApoMono.002
found in the Tutorial Sample Data archive .
1212

In the course of this example, we will:
Insert a token into a text box.
Modify the formatting of a token.

To insert a token:
1. Select File tab

(Figure T3.1

1239

).

2. Open the layout TokenInsertion.fey found in the Tutorial Sample Data
archive .
1212

3. Left-click after the word "contains" in the text box containing the
incomplete sentence "The Gate 'Whole Cells' contains". The text box
should change to have a green border, indicating it is in edit mode, and the
cursor should be flashing after the word contains.
We will be completing this sentence with the statistic # of Cells in Gate 'Whole
Cells'.
4. Right-click inside the selected text box.
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5. Select Insert Token from the pop-up menu (Figure T5.23).

Figure T5.23 Inserting a Token

You can also insert a token using the
command from the Ribbon Bar.
An Insert a Token dialog will appear (Figure T5.24).
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Figure T5.24 Insert a Token Dialog

6. Click on Statistic.
7. Click Insert at the bottom of the dialog.
A Create Statistic dialog will appear with the Data Source category open
(Figure T5.25). There is no need to change the data source, since it is already
showing the source as the FSC vs. SSC plot of ApoMono.002.
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Figure T5.25 Create Statistic Dialog--Data Source Category

8. Click on the Statistic Category of the Create Statistic dialog (Figure
T5.26).
The Statistic page of the Create Statistic dialog will now appear.
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Figure T5.26 Create Statistic Dialog--Statistic Category

We will select the statistic we want the token to display (Figure T5.26).
9. Select # of Events in the Statistic list box (Figure T5.26

).

10. Select Whole Cells from the Gate drop-down list (Figure T5.26

).

11. Select OK.
The Statistic (# of events) will now appear in the text box after the text 'The
Gate Whole Cells contains' and will be highlighted gray whenever the text box is
in edit mode (green border). The grey background is to show that the text is a
token, and cannot be directly edited.
12. Push the "space" bar key and type 'events.' in the text box after the
token to complete the sentence.
The text box should now look like Figure T5.27. The token will appear with the
same text settings as the text already in the box.
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Figure T5.27 Text Box with Token

Note: Tokens can also be inserted into tables.
You can format the font of a token identically to the way you format the font for
normal text, described above. Figure T5.28 shows the same text box as Figure
T5.27 except the font was changed to Courier New, 15pt, and Bold. For more
help on changing text in text boxes, see the section on Formatting Text in a Text
Box .
1304
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Figure T5.28 Formatted Token Font

Tokens can also be inserted by dragging and dropping the plot onto the text box.

To insert a Token by Drag and Drop:

First, we need to delete the token in the text box.
13. Highlight "7525" events in the text box.
14. Hit the Delete key to delete the token.
15. Left-click on the border of the SSC-H v FSC-H ApoMono.002 plot. The
border of the plot should turn green.
16. Left-click on the green border. The border of the plot should turn red to
indicate it is in selected mode.
17. While holding down the left mouse button, drag the cursor (Figure T5.29)
to the space after the word "contains" in the text box.
18. Release the mouse button to drop the plot into the text box.
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Figure T5.29 Dragging Token from Plot onto Text Box

The Paste Special dialog will appear (Figure T5.30).

19. Select Statistic Token from the Paste Special dialog (Figure T5.30).

Figure T5.30 Paste Special Dialog
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20. Click OK

The Create Statistic dialog will now appear with the Statistic category open as
previously seen in step 8 (Figure T5.26)
21. Select Whole Cells in the Gate field (Figure T5.26

).

22. Select # of Events from the Statistic box (Figure T5.26

).

23. Select OK.

The number of events will now be inserted as a token, highlighted in grey,
after the word "contains" in the text box (Figure T5.29).

24. Click after the number of events token (highlighted in grey) in the text
box.
25. Push the "space" bar key and type "events." to complete the sentence in
the text box.

The text box will now appear as in Figure T5.31.

Figure T5.31 The Layout as it will be appear at the end of this section
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Select File tab

to close the layout we were just working on.

In the next example, we will create a classifier token

40.5.6
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.

Creating a Classifier Token
A classifier token is one that takes a value from a statistic or custom token and
classifies it into different categories. For this example, we will use the % of FL1
and FL2 double positive events found in file ApoMono.002 and classify this value
as low, medium, or high.

In the course of this example, we will:
Create a classifier token.
Create three classifications.

To insert a classifier token:
1. Select File tab

.

2. Open the layout TokenClassifier.fey found in the Tutorial Sample Data
archive .
1212

The layout, shown in Figure T5.32, contains the completed plot and text box
from the section of this tutorial on Inserting and Modifying a Token . Below
them is a new plot of FL1 vs. FL2 with quadrants, the percentage positive, and
another text box with the text 'Apo Classification:'. We will be inserting the
classifier statistic at the end of the text box shown in Figure T5.32.
1317
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Figure T5.32 Token Classifier Layout (TokenClassifier.fey)

3. Click in the text box containing the incomplete sentence 'Apo
Classification:'.

We will be completing this statistic with the classifier of the statistic % of Cells in
Upper Right Quadrant, which in this case is 6.71%.

4. Right-click at the end of 'Apo Classification:' in the text box.
5. Select Insert Token from the pop-up menu (Figure T5.33).
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Figure T5.33 Selecting Insert Token from the Pop-up Menu

An Insert a Token dialog will appear (Figure T5.34).
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Figure T5.34 Selecting Statistic Classifier from the Insert a Token Dialog

6. Click on Statistic Classifier as the type of token to be inserted.
7. Click Insert.
A Create Statistic Classifier dialog will appear (Figure T5.35).
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Figure T5.35 Create Statistic Classifier Dialog

8. Click on the Classification Category (Figure T5.35).

Here we will enter the statistic to classify and the list of classifications for the
statistic value to be categorized against.

9. Click on the
classify.

(in Figure T5.35

) next to the field Enter a value to

Another Insert a Token dialog box will appear, similar to Figure T5.34.

10. Select Statistic as the type of Token to be classified.
11. Select Insert.
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A Create Statistic dialog will appear with the Data Source category selected
(Figure T5.36).

12. Select 2D plot - ApoMono.002 (FL1 vs. FL2) as the data source in
the Select a Plot section.

Figure T5.36 Create Statistic Dialog -- Data Source Category

13. Click now on the Statistic Category on the left (Figure T5.37).
Now we select the statistic we want to classify in the token from the Create
Statistic dialog. We will use the % of Gated Cells within the Upper Right
quadrant.
14. Select Upper Right in the Select a quadrant drop-down list (Figure
T5.37 ).
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15. Select Whole Cells in the Gate: drop-down list (Figure T5.37

).

16.Select % of Gated Cells from the Statistic: list box (Figure T5.37

).

17. Press OK.

Figure T5.37 Create Statistic Dialog --Statistic Category

The Create Statistic Classifier dialog will appear, but this time with the formula
that we entered in the Enter a value to classify field (Figure T5.38).
Now we need to fill in the List of classifications on the Create Statistic
Classifier dialog (Figure T5.38).
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18. Select Add (Figure T5.38 on the left).

A Create Classification dialog will now appear (Figure T5.39A).

19. Enter Low in the Classify the Token as field.
20. Enter the value 0 for the lower limit.
21. Enter the value 33.3 for the upper limit.
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Figure T5.39A Create classification Dialog -- "Low" Token

22. Click OK.

The Create Statistic Classifier dialog will reappear similar to Figure T5.38, but
this time with the Low classification listed (Figure T5.39B).
23. Select Add to add a new the "Medium" classification to the list (Figure
T5.39B).
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Figure T5.39B Create Statistic Classifier Dialog with "Low" Token Defined

A Create Classification dialog will again appear (Figure T5.40) to allow us to
define the "Medium" classifier token.
24. Enter Medium in the Classify the Token as field.
25. Enter the value 33.3 for the lower limit.
26. Enter the value 66.6 for the upper limit.
27.Click OK.
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Figure T5.40 Create Classification Dialog -- "Medium" Token

The Create Statistic Classifier dialog will again reappear, similar in appearance
to Figure T5.38, but this time with the Low and Medium classifications listed.
28. Select Add from the Create Statistics Classifier dialog to add the last
classifier, "High". A Create Classification dialog will appear.
29. Repeat steps 24-27 entering High in the Classify the Token as field,
66.6 as lower limit and 100 as upper limit.

The Create Statistic Classifier dialog will reappear, but this time with the Low,
Medium, and High classifications listed (Figure T5.41).
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Figure T5.41 Create Statistic Classifier Dialog with all Classifications Listed

33. Press OK to accept the new classifier
The text box should now appear with the Apo classification of Low shown in
Figure T5.42. If you move the quadrants, the classifier will update according to
the criteria you set above.
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Figure T5.42 Statsitic Classifier Token
in the Text Box

34. Move the quadrant by dragging&dropping its center in order to appreciate
the change in classification token

Figure T.43 Token classification changes base on quadrant position

35. Select File tab

to close the layout we were just working on.
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In the last example, we will create a custom token
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Creating a Custom Token
Tokens can also be customized to create any kind of statistic that you like. In
this example, we will calculate the Apo(+)/Apo(-) ratio in the positive sample file
ApoMono.002. This is calculated by taking the # of positive cells and dividing
them by the # of negative cells.
To insert a Custom Token:
1. Select File tab
2. Open the layout TokenCustom.fey found in the Tutorial Sample Data
archive .
1212

The layout, shown in Figure T5.43, contains two 2D plots a text box containing
the text 'Apo(+)/Apo(-) ratio:'.
We will be inserting a custom token statistic here (Figure T5.43).
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Figure T5.43 Custom Token Layout (TokenCustom.fey)

3. Click in the text box at the end of the incomplete text 'Apo(+)/Apo(-)
Ratio:'.
4. Select the

command (Figure T5.44).

Figure T5.44 Selecting the Custom Tokens Command

The Custom Tokens window should now appear (Figure T5.45).
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5. Right-click inside the upper half of the Custom Tokens window and select
New Custom Token from the pop-up menu (Figure T5.45).
Alternatively click on the

button within the Custom Tokens window.

Figure T5.45 Creating a New Custom Token

7. Type "Apo(+)/Apo(-) Ratio: " into the Name field of the New Custom
Token (Figure T5.46).
8. Press Enter to accept the new name.
9. The Custom Token "Apo(+)/Apo(-) Ratio:" should now be highlighted
(Figure T5.46).
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Figure T5.46 Custom Tokens Editor

To calculate the ratio for this example, we will take the number of events in the
positive population (upper right quadrant) and divide it by the number of events
in the negative population (lower quadrants).

9. Left-click in the lower half of the Custom Tokens window and enter an
equals sign "=" (Figure T5.47).
10. Right-click just after the "=" sign to bring up the associated pop-up
menu.
11. Select Insert Token from the pop-up menu (Figure T5.47).
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Figure T5.47 Entering a Custom Token Formula

An Insert a Token dialog will appear as in Figure T5.24

1317

.

12. Click on Statistic.
13. Click on Insert.

A Create Statistic dialog will appear with the Data Source Category open as in
Figure T5.36 .
1326

14. Select 2D plot - ApoMono.002 (FL1 vs. FL2) as the data source.
15. Click now on the Statistic Category (on the left).
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The Statistic Category of the Create Statistic Window will appear as in Figure
T5.37 . We will now select the statistic that will define the numerator of our
custom token.
1326

14. Select Upper Right in the Select a quadrant drop-down list (Figure
T5.37 ).
15. Select Whole Cells in the Gate: drop-down list (Figure T5.37

).

16.Select % of Gated Cells from the Statistic: list box (Figure T5.37

).

17. Press OK.

The Custom Tokens Editor (Figure T5.48), will show the statistic in the
formula field highlighted in light blue. This is the numerator for our custom token.
We will now define the operator and the denominator of our custom token.
20. Enter the division symbol "/" just after the statistic we created in the last
steps (Figure T5.48).
21. Right-click after the "/" symbol to bring up the pop-up menu.
22. Select Insert Token from the pop-up menu (Figure T5.48).
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Figure T5.48 Numerator Definition for Custom Token

An Insert a Token dialog box will appear (Figure T5.24

1317

).

23. Click Statistic
24. Click Insert

A Create Statistic window will appear with the Data Source Category open
(Figure T5.36 ). We will now define the denominator of our custom statistic
token.
1326

25. Select 2D plot - ApoMono.002 (FL1 vs. FL2) as the data source
(Figure T5.36) .
1326
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26. Click on the Statistic Category (Figure T5.37

).

The Statistic Category of the Create Statistic Window will appear as in Figure
T5.37 . We will now select the statistic that will define the denominator of our
custom token.
1326

27. Select Lower in the Select a quadrant drop-down list (Figure T5.37
28. Select % of Gated Cells from the Statistic: list box (Figure T5.37
29. Select Whole Cells in the Gate: drop-down list (Figure T5.37

).
).

).

30. Press OK.

Figure T5.49 Defining the Denominator for the Custom Token

30. Press OK.
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The Custom Tokens window (Figure T5.50) will show the upper right quadrant
statistic divided by the lower quadrants statistics in the formula field. The tokens
are highlighted in blue to indicate that they are being treated as numbers, as
opposed to text.

Figure T5.50 Final Custom Token Formula

Now that we have created the custom token, we must insert it into the text
box.
31. Position the cursor to the end of the text "Apo(+)/Apo(-) Ratio:" within
the text box (Figure T5.51).
32. Select
T5.51).

from the ribbon (Figure

Alternatively, right-click after the "Apo(+)/Apo(-) Ratio: " text to bring
up the pop-up menu and select insert token).
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Figure T5.51 Insert Token Command

The Insert a Token dialog will appear with the new custom token Apo(+)/
Apo(-) Ratio: listed (Figure T5.52).
33. Click

as the token to be inserted.

34. Click Insert to insert the token into the text box.
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3.Figure T5.52 Selecting the Custom Token

The Apo(+)/Apo(-) Ratio: value of '3.89' will appear highlighted in grey in the
text box (Figure T5.53).
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Figure T5.52 Displaying the Custom Token in the Text Box

We will now delete the Custom Token and then insert it by dragging it from the
Custom Tokens window.
35. Select the custom token we just insert after the "Apo(+)/Apo(-)
Ratio:" text (you can easily recognize it since it is grey highlighted) (Figure
T5.53).
36. Press the Delete on you keyboard to remove the custom token.
The Custom Tokens window should still be on the layout as shown in Figure
T5.54.
37. Press and hold the left mouse button down on the Apo(+)/Apo(-)
Ratio custom token
highlighted in blue in the Custom Tokens window
(Figure T5.54).
38. Drag the mouse, while holding the left mouse button down, to the spot
after the Apo(+)/Apo(-) Ratio: text
in the text box on the layout
page.
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Figure T5.54 Dragging Custom Token onto Text Box

39. Release the mouse button to drop the custom token into the text box.
The custom token is now reinserted in the text box as shown in Figure T5.53.

40.5.8

Using Custom Token Display Types
FCS Express has Custom Token display types 758 which allow you to insert an
interactive Edit box 759 , Check box 761 , or Dropdown list 764 directly in a layout.
These new display types provide increased flexibility for Custom Token
appearance and functionality.
In the course of this tutorial you will learn how to:
Create and use an Edit Box Custom Token.
Create an use a Check Box Custom Token.
Create and use a Dropdown List Custom Token.
1352

1356

© 2020 De Novo Software

1360

FCS Express 6 Manual

1352

40.5.8.1

Creating an Edit Box Custom Token

Edit Box 759 Custom Token display types are used to create an editable box
directly in the layout where you can change Custom Token values, which will
update the original custom token and subsequently any other instance of the
custom token. Values can be numeric or text. In the steps below we will describe
how to view a token as an Edit box, how to modify the token value, and how to
adjust the width of the Edit Box.
1. Navigate to the Tutorial Sample Data folder from the File tab

.

2. Open the layout EditBoxTutorial.fey.

The layout contains a table at the top that contains the # of Lymphs token from
the "Lymphs" gate, a user-defined division factor, and a Custom Token value for
the # of Lymphs divided by the division factor (Figure T5.44). The values are all
dependent on Custom Tokens 725 that were previously created for use in this
tutorial. In the following steps we will adjust the division factor token to be an
Edit Box that will dynamically update the token value in other tokens.

Figure T5.44 - The EditBoxTutorial.fey layout. The Division factor will be adjusted to
be an editable box within the layout in the tutorial.

3. Double click the token value "5.00" in the Division Factor column.
4. Choose Edit Box from the Display category
(Figure T5.45).

dropdown menu

5. Click OK.
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Figure T5.45 - Choosing the Edit box custom token display type.

6. Click on the text box in the layout to select it.
Notice that the Division Factor value is now surrounded by a blue box (Figure
T5.46). The blue box represents an editable field for the token value.

Figure T5.46- The token display type for the division factor is now an editable box
denoted by the blue box surrounding the token value.

7. Delete the value "5" from the edit box.
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8. Enter the value "10" in the edit box.
Notice that the token value in the "Lymphs / " column header has changed as
well as the token value in the cell underneath the header. Any tokens that are
dependent on the token in the Edit Box will update in real time as the value is
adjusted.
You may also notice that the division factor Edit Box is quite large for the table
size. We will now format the size of the edit box to more appropriately fit the
table (Figure T5.47).

Figure T5.47 - The value in the Edit box has been changed to 10 thus modifying the
original Custom Token value and updating any other token or displayed location in
the layout.

9. Right click on the edit box in the table.
10. Choose Format token.
11. Enter "10" in the Width dialog under the Display category (Figure T5.48).
12. Click OK.
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Figure T5.48 -Adjusting the width of the Edit box.

13. Click on the text box to select it.
Notice that the edit box size has decreased to a width of 10, thus fitting the table
cell correctly (Figure T5.49).

Figure T5.49 - The Edit box has been adjusted to a width of 10 to fit within the table
cell.

© 2020 De Novo Software

FCS Express 6 Manual

1356

In the next section we will create a Check Box Custom Token display type.

40.5.8.2

1356

Creating a Check Box Custom Token

Check box 761 Custom Token display types create a check box directly in the
layout that displays the name of the Custom Token. Checking the box returns a
"TrueValue", also equivalent to -1, entry for the Custom Token while unchecking
the box returns a "FalseValue", also equivalent to 0, entry for the Custom
Token. The True or False value of the token can then be used to control any
number of true or false dependent actions such as displaying pages. In the
course of this tutorial we will create a check box Custom Token and use it to
display

1. Navigate to the Tutorial Sample Data folder from the File tab

.

2. Open the layout CheckBoxCustomToken.fey.
The layout only contains a Custom Tokens window. We will use the predefined
Custom Tokens in the window to work with the Check box feature.

3. Drag and drop the Check Box Custom Token from the Custom Token
window onto the layout to insert it.
A text box containing the text "This will be our check box custom token" will
appear as in Figure T5.50 below:

Figure T5.50 - The Check box custom token inserted in the layout.

4. Double click on the token text of "This will be our check box custom token" to
open the Edit Token dialog.
5. Choose Check box from the Display type dropdown menu within the
Display category (Figure T5.51).
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Figure T5.51 - Choosing the Check box display type from the drop down list.

6. Click OK.

A Check box will appear within the text box in the layout where the token was
inserted that displays the name of the Custom Token (Figure T5.52).

Figure T5.52 - When the Custom Token display type is set to Check Box, a check
box will appear in the layout displaying the name of the Custom Token.

7. Check the check box in the text box.
Notice that the value of the token in the Custom Tokens window now changed
to "=TrueValue"
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8. Uncheck the check box in the text box.
Notice that the value of the token in the Custom Tokens window now changed
to "=FalseValue"
The True and False values returned through using the Custom Token display type
of check box can be used elsewhere in the layout. Before we continue using the
True and False values, we will rename the token which will in turn rename the
value in the check box.
9. Click on the Check Box Custom Token name within the Custom Tokens
window.
10. Press F2, which is the short-cut for the Rename command . Alternatively,
right-click on the token and choose Rename.
11. Enter the text "A New Check Box"
12. Press Enter.

Figure T5.53 - Renaming the Check box token to rename the
text in the Check box display.

Once renamed, the token name will appear in the Custom Tokens window with
the new name, and the check box text within the text box will also be renamed
(Figure T5.53).
We will now utilize the Check box token to display a message when checked /
unchecked.
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13. Drag and drop the Message to Display Custom Token from the Custom
Token window onto the layout to insert it.
14. Check the check box in the first text box containing the Check Box Custom
Token, which was inserted onto the Layout in Step 3.
Notice that the message updates as the Check box is changed. The action
occurs because the Message to Display Custom Token uses an IF Then Else
Custom Token format that evaluates the status of the Check Box Custom
Token (Figure T5.54). If the value equals "-1" (the numeric representation of
"TrueValue"), then "The Check Box Has Been Checked" is returned in the field. If
the value equals "0" (the numeric representation of "FalseValue"), then "The
Check Box Has NOT Been Checked" is returned in the field. The messages
between quotations can be any custom text or can be replaced with any token
or Custom Token values from your layout and analysis.

Figure T5.54 - The message to display custom token uses an IF THEN ELSE Custom
Token format to return values based on the status of the Check box Custom Token.

We will now utilize the Check box token to display a page when checked /
unchecked.
15. Right click on the Page 2 tab.
16. Choose Format.
17. Choose the Visibility category.
18. Click on the Custom radio button.
19. Enter an '=' sign in the text field.
20. Click on the "T" button to the right to insert a token.
21. Choose the A New Check Box Custom Token from the Insert a
Token Custom list.
22. Enter the text "=truevalue" after the token. The Visibility formatting category
should look like Figure T5.55.
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Figure T5.55 Entering a custom page visibility formula to view or hide a page based
on the status of a check box being checked or unchecked.

23. Click OK.
24. Check or Uncheck the check box in the text box containing the Check Box
Custom Token (on Page 1 of the Layout).
Notice in the page tabs that Page 2 appears and is hidden depending on the
status of the Check box. In this example we have used the "truevalue" text to
evaluate the token rather than the numeric "-1" and "0" values used in step 14.
Checking the box returns true value in turn displaying the page. In contrast, if the
text "=falsevalue" was entered the page would display when the Check box is
unchecked.

In the next section we will create a drop down list Custom Token display type.
40.5.8.3

1360

Creating a Dropdown list Custom Token

Dropdown list 764 Custom Token display types create a dropdown list of comma
separated choices entered in the Choices section of the Edit custom token
dialog Display category. The dropdown list is useful to choose and display a
value from a list of predefined entries. In the steps below we will describe how to
create a dropdown list for use in a layout.
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.

2. Open the layout Dropdownlist Custom Token.fey.
The layout only contains a Custom Tokens window. We will use the predefined
Custom Tokens in the window to work with the Dropdown feature.

3. Drag and drop the Drop Down List Custom Token from the Custom Token
window onto the layout to insert it.
A text box containing the text "This will be our Dropdown List Custom Token" will
appear as in Figure T5.56 below:

Figure T5.56 -The Dropdown list Custom Token inserted in the layout.

4. Double click on the token text of "This will be our Dropdown List Custom
Token" to open the Edit Token dialog.
5. Choose Dropdown list from the Display type dropdown menu within the
Display category (Figure T5.57).
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Figure T5.57 -Choosing the Dropdown list display type from the drop down list.

6. Type "Option 1, Option 2, Option 3" in the Choices (comma separated):
field (Figure T5.58).
The Edit Drop Down List Custom Token dialog should look like figure 3. Notice
that our choices for "Option 1 - Option 3" are separated by commas. Any text,
tokens, or Custom Tokens may be entered in the dialog as dropdown choices as
long as they are separated by commas.
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Figure T5.58 - The Edit Drop Down List Custom Token dialog after entering a comma
separated list of options to display in the Dropdown list.

7. Click OK.
8. Click on the dropdown arrow within the text box to reveal the Dropdown
choices.
We will now place the Custom Token elsewhere on the layout and observe how
making a choice from the Dropdown list updates the token value.
9. Drag and drop the Drop Down List Custom Token from the Custom Token
window onto the layout to insert it.
10. Click on the dropdown arrow within the text box containing the Dropdown
list to reveal the Dropdown choices.
11. Choose Option 2.
12. Choose Option 3.
Notice that the newly inserted text box containing the token from Step 9 now
reflects the value selected from the Dropdown list Custom Token display type
(Figure T5.59).
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Figure T5.59 - The text "Option 3" appear underneath the selected Dropdown list
Custom Token display type because "Option 3" is selected from the list.

40.6

Quadrants
FCS Express has powerful quadrant features. You can set "standard" rectangular
quadrants, as well as floating quadrants and percentile quadrants, among other
options. This allows you to analyze your data with the flexibility that you need.
In the first section, we will set up rectangular and floating quadrants

40.6.1

1364

.

Rectangular and Floating Quadrants
In the course of this example, we will:
Learn how to create rectangular quadrants and move them.
Learn how to create floating quadrants and move them.

To place a rectangular quadrant and move it:
1. Select File tab

.

2. Open the layout QuadTut.fey found in the Tutorial Sample Data archive
.

1212

Two density dot plots now appear on the layout.
3. Select the

command (Figure T6.1).

© 2020 De Novo Software

Tutorials

1365

Figure T6.1 Selecting the Quadrants Command on the Gating Tab

4. Click in the middle of the left density dot plot.
A rectangular or "standard" quadrant now appears on the plot with the center of
the quadrant located where you clicked in the plot. Note that the quadrant is
selected, as indicated by the rectangular symbol in the center of the quadrant
where the lines cross (the central node), indicated by the cursor in Figure T6.2.
Also note the quadrant’s percentages are automatically placed in the corners of
the plot (Figure T6.2).

Figure T6.2 Plot with Quadrants

If the quadrant is currently selected then skip to step 6.
5. Click in the middle of the quadrant at the central node to select the
quadrant (Figure T6.2).
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6. Hover the mouse over the central node of the quadrant; the cursor should
change to a four-headed arrow.
We will now move the position of the central node of the quadrant to redefine
the quadrant.
7. Press the left mouse button when the cursor is a four-headed arrow.
8. Continue to hold the left mouse button and move the central node to the
desired location.
9. Release the mouse when the quadrants properly define the three
populations in the plot.
Notice that when you move the central node, the percentages of each quadrant
change accordingly. The final plot should look similar to Figure T6.3.

Figure T6.3 Redefined Quadrants

We will now turn to the plot on the right side of the layout. In this case, if we try
to use a standard rectangular quadrant we will not be able to clearly separate the
three populations in the plot, as demonstrated in Figure T6.4.
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Figure T6.4 Improperly Defined Regions Using
Standard Quadrants

To surmount this problem we will create a floating quadrant on this plot.
1. Select the

command (Figure T6.1).

2. Click in the middle of the right plot.
A standard quadrant will appear similar to Figure T6.4. If the quadrant in right plot
is not already selected then select it.
3. Select the

command (Figure T6.5).

Figure T6.5 Selecting the Format Quadrants Command

The Formatting Quadrants dialog will now appear (Figure T6.6).
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Figure T6.6 Formatting Quadrants Dialog

4. Change the Type of the quadrant from Standard to Floating from the
drop-down list, shown by the cursor in Figure T6.6.
5. Click OK.
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Alternatively, you can format the quadrants using the plot associated pop-up
menu.
Right-click on the right plot to bring up the associated pop-up menu.
Select Format from the pop-up menu.
The Format dialog appears, similar to Figure T6.7.
Select the Quads category on the left side of the Format dialog
(Figure T6.7).
Change the Type of the quadrant from Standard to Floating from the
drop-down list, shown by the cursor in Figure T6.7.
Click OK.
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Figure T6.7 Quads Category of the Formatting Dialog

6. Click on the right plot in the middle of the quadrant, on the central node, to
activate the quadrant.
Notice that not only does the central node show a small square, but also the
ends of the quadrant lines have small squares as well, indicated by the red circles
on Figure T6.8. The ends of the quadrant lines are now movable nodes, along
with the central node.
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Figure T6.8 Floating Quadrant Selected for
Editing

7. Place the cursor over the small square on the central node; the cursor
should change to a four-headed arrow.
8. Hold down the left mouse button and move the central node into the
middle of the three populations on the plot.
9. Release the mouse button when the central node is in the desired
location.
10. Place the cursor over the small square at the end of one of the quadrant
lines; again, the cursor should change to a four-headed arrow.
11. Hold down the left mouse button and move the square node at the end
of the quadrant line along the axes to separate the three populations.
12. Release the mouse button when the quadrant line node is in the desired
location.
Repeat steps 10 through 12 until all of the nodes on the quadrant lines have
been moved. The final result should look similar to Figure T6.9.
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Figure T6.9 Floating Quadrants

Next, we will set up percentile quadrants

40.6.2

1372

.

Percentile Quadrants
FCS Express allows you to set quadrants according to percentages instead of
manual positioning.
In the course of this example, we will:
Learn how to set rectangular quadrants using percentiles.

For convenience, we are going to start with the same layout as before. If you
have the previous layout still open, please jump to Step 3.
1. Select File tab

.

2. Open the layout QuadTut.fey found in the Tutorial Sample Data archive
.
3. Select the

1212

command (Figure T6.1).

4. Click in the middle of the left density dot plot.

Two density dot plots now appear on the layout with quadrants appearing on the
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left plot.

To set a quadrant with percentages:
3. Click once on the left plot to select it.
4. Select the

command (Figure T6.5

The Formatting Quadrants dialog will appear, similar to Figure T6.10.
5. Change the Type of the quadrants listed in the drop-down menu
from Standard to Both Percentile, indicated by the cursor in Figure
T6.10.
Notice that the X Percentile and Y Percentile options on the Formatting
Quadrants dialog are now enabled (Figure T6.10).
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Figure T6.10 Formatting Quadrants Dialog -- Setting Type to Both Percentile

6. Enter "80" in X Percentile field (Figure T6.10).
7. Enter "20" in the Y Percentile field (Figure T6.10).
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8. Click OK.

The quadrants have adjusted automatically and appear similar to Figure T6.11.
The sum of the Upper Left and Lower Left quadrants is approximately 80% (±
rounding errors), and the sum of the Upper Right and Lower Right quadrants is
approximately 20% (± rounding errors).

Figure T6.11 Percentile Quadrants of
80% and 20%

We will now use the plot pop-up menu to format the quadrant and change the X
and Y percentile values.
9. Right-click on the left plot to bring up the associated pop-up menu.
10.Select Format from the pop-up menu.
11.Select the Quads category from the left of the Formatting dialog (Figure
T6.12).
12.Change the X and Y Percentiles to 82 and 8 respectively (Figure
T6.12).
13.Click Preview, indicated by the cursor in Figure T6.12.
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Using Preview allows you to quickly manipulate the percentiles until you reach
your desired result.

Figure T6.12 Using Preview while Setting Percentile Quadrant Values

Percentile quadrants are very useful when you have a plot that has a control
population. You can have the quadrants automatically adjust to ensure that a
specific fraction of the cells are in the lower left quadrant. You can then link the
quadrants on the control plot to the quadrants on the sample plots, and all of the
quadrants will update appropriately.
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Quadrant/Marker to Gate Linking
One of the many time saving features that FCS Express offers is the ability to
use a quadrant to define a gate. This is useful if you want to use your quadrants
to define a negative (or positive) population and then have your plots show only
cells in the gated population. Markers can also be used to define a gate.

In the first exercise, we will link a quadrant to a gate

40.7.1
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.

Quadrant to Gate Linking
In the course of this example, we will:
Link a quadrant to a gate.
Move a quadrant with a linked gate and watch the gate automatically
update.

To link a region to a quadrant:
1. Select File tab

.

2. Open the layout Quad2RegionLink.fey found in the Tutorial Sample Data
archive .
1212

This layout contains three 2D Color Dots of the file TCellSample1.fcs (Figure
T7.1). The left plot is of SSC-A vs. PerCP-Cy5.5-A with a gate on Lymphs,
which are colored Red. The upper right plot is of FITC-A vs. APC-A gated on
Lymphs with quadrants. The lower plot is a 2D Color Dot Plot looking at PE-Cy7
vs APC and gated on Lymphs.
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Figure T7.1 Quad2RegionLink.fey Layout

3. Right-click on the upper right 2D plot of FITC-A vs. APC-A with quadrants,
shown with the green border in Figure T7.1.
This will bring up the associated pop-up menu (Figure T7.2).
4. Select
from the pop-up menu (Figure T7.2).
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Figure T7.2 Converting and Linking the Lower Right Quadrant to a Gate

A Create New Gate dialog will appear (Figure T7.3). Here, we will name the new
gate that will be linked to the lower right quadrant.

© 2020 De Novo Software

1380

FCS Express 6 Manual

Figure T7.3 Create New Gate Dialog

5. Enter FITC+ in the Create a new gate named field.
6. Change the Gate Color to Green.
7. Click OK.
We will now apply the newly created FITC+ gate, that is linked to the lower right
quadrant, to the lower right 2D plot.
7. Click inside the 2D plot of PE-Cy7-A vs APC-Cy7-A on the lower right
without the quadrants. The border will appear green (Figure T7.4).
8. Select the Gating tab (Figure T7.4).
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9. Select FITC+ from the Current Gate drop-down list (Figure T7.4).

Figure T7.4 Selecting the FITC+ Gate for the Lower Right 2D Plot

The 2D plot on the lower right will now appear with only the events found in the
lower right quadrant (Figure T7.5).
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Figure T7.5 Lower Right Plot Gated on GFP(+)

Because the quadrants are linked to the gate, changing the quadrant position will
also change the gate GFP(+). We will now move a quadrant to demonstrate
how the GFP(+) gate linked to the quadrant will also change.
To move a quadrant:
10. Click inside the 2D plot of FL1 vs. FL2 with the quadrants on the upper
right of the layout. The border will appear green (Figure T7.6).
11. Click on the vertex of the quadrant. You will know you have selected the
quadrant for editing because the mouse will change to a four-headed
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arrow.
12. Press and hold the down the left mouse button on the vertex.
13. Move the mouse to the right while continuing to hold down the mouse
button.
14. Release the mouse button when the lower right quadrant definition is
smaller (Figure T7.6).
The Lower 2D plot of FL1 vs. FL2 will update to reflect the changes made to
the lower right quadrant (Figure T7.6).

Figure T7.6 GFP(+) Gate Updated after Quadrant Move
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15. Select File tab

.

In the next section, we will link a marker to a gate

40.7.2
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.

Marker to Gate Linking
In the course of this example, we will:
Link a marker to a gate.
Move a marker with a linked gate and watch the gate automatically
adjust.
A marker can also be created directly on a 2D plot by selecting the
command. For more information on
creating a 1D gate on a 2D plot, please refer to the appropriate section in the
tutorial on Using Gates .
1279

1. Select File tab

.

2. Open the layout Marker2RegionLink.fey found in the Tutorial Sample
Data archive .
1212

This layout contains one 2D plot and two histograms of the file GFPsample.002
(Figure T7.7). The upper left plot is of FSC vs. SSC with a gate on Whole Cells.
The upper histogram is of FL1 gated on Whole Cells with a marker M1. The
lower histogram is also a histogram of FL1 but without a marker.
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Figure T7.7 Marker2RegionLink.fey Layout

3. Right-click on the upper right histogram of FL1 with the M1 marker.
This will bring up the associated pop-up menu.
4. Select
from the pop-up menu (Figure T7.8).
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Figure T7.8 Converting the Marker M1 to a Gate

A Create New Gate dialog will appear as shown in Figure T7.3
name the new gate that is linked to the marker.

1377

. Here, we will

5. Enter "GFP(+)" in the Create a new gate named field.
6. Click OK (Figure T7.3

1377

).

7. Click inside the histogram of FL1 on the lower right, without the marker.
The border will appear green (Figure T7.9).
8. Select the Gating tab as previously shown in Figure T7.4

1377

.

Alternatively, select the Home tab (Figure T7.9).
9. Select GFP(+) from the Current Gate drop-down list (Figure T7.9).
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Figure T7.9 Applying the GFP(+) Gate to the Lower Right Histogram

The histogram on the lower right will now appear with only the events found in
the marker M1 (Figure T7.10).
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Figure T7.10 Lower Right Histogram Gated on GFP(+)

Because the marker M1 is linked to the gate, changing the marker position will
also change the gate GFP(+).
10. Click inside the histogram of FL1 with the marker M1, located in the
upper right of the layout. The border will appear green.
11. Click the left mouse button anywhere on the marker M1 to select it. The
marker will have three resizing rectangles when it has been selected for
editing (Figure T7.11).
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Figure T7.11 Active Marker M1 with Resizing Rectangles

12. Move the mouse over the central resizing rectangle. You will know you
are in the correct place because the cursor will change to a four-headed
arrow.
We will now move the entire marker M1 to a new location on the histogram.
Alternatively we could also resize the marker by selecting one end of the marker
with the cursor and then moving it.
13. Press and hold down the left mouse button.
14. Move the mouse to the right while holding down the mouse button
(Figure T7.12).
Arrows pointing down will appear indicating the location of the ends of the
marker on the x-axis. On top of the marker will be the channel numbers
indicating the end boundaries of the marker (Figure T7.12).
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Figure T7.12 Moving Marker M1

15. Release the mouse button when the marker is in the desired position
(Figure T7.12).
The histogram of FL1 located on the lower right will update to reflect the changes
made to the marker M1 (Figure T7.13).
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Figure T7.13 Histogram Gated on GFP(+) Updated to Reflect Changes made to
Marker M1 Position

40.8

Compensation
Normally, FCS Express imports the compensation matrix that was used when
acquiring the sample. But sometimes you want to make your own compensation
matrix.
There are two ways to create your own compensation definition in FCS Express:
The Manual
method allows you to adjust the compensation levels using
sliders that allow you to adjust the amount of compensation.
The Automatic
method allows you to take single stained controls and
automatically calculate the appropriate compensation values.
1392

1396

FCS Express allows you to quickly and easily set up either compensation
method. Sometimes compensation may also introduce digitization errors which
will be discussed in the Compensation Digitization Error
tutorial. In the
following examples, we will be opening two layouts in FCS Express which already
have a gate defined on the compensation population of interest.
1436
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The first example will show Manual Compensation

40.8.1

1392

.

Manual Compensation
To adjust the compensation manually:
1. Select File tab

.

2. Open the layout ManualComp.fey found in the Tutorial Sample Data
archive .
1212

This layout contains two plots. The dot plot of FSC-H vs. SSC-H is showing a
gate based on size (gate 1). The right plot of CD95 PC5 (PE CY5) vs. CD8a PC7
(PE CY7) is gated on gate 1 (Figure T8.1).

Figure T8.1 Uncompensated Plots

3. Right-click on the right density plot of CD95 PC5-A vs. CD8a-PC7-A to
bring up the associated pop-up menu.
4. Select
T8.2).

from the pop-up menu (Figure
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Figure T8.2 Selecting Create New Compensation

A Create a new Compensation dialog will appear (Figure T8.3).
5. Type "ManualComp" in the Enter a name for the new Compensation
field.
6. Deselect the checkbox for Use this compensation as default on new
plots.
7. Click OK.

© 2020 De Novo Software

1394

FCS Express 6 Manual

Figure T8.3 Create a new Compensation Dialog

An Edit Compensation dialog will now appear (Figure T8.4).

Figure T8.4 Edit Compensation Dialog

8. Adjust the sliders shown in Figure T8.4 until the 2D plot looks like Figure
T8.5. Note that moving the slider to the right causes the population to
move in the direction of the arrow in the image to the left of the slider.
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Be careful not to overcompensate! Proper compensation will require
around 6.0% of CD95 PC5-A - % of CD8a PC7-A and 18.0% of CD8a
PC7-A - % of CD95 PC5-A.
9. Click OK to select the manual compensation settings.

Figure T8.5 Manual Compensation using Edit
Compensation Sliders

Manual compensation of the file is now complete.
Note: Sometimes when working with your own data digitization errors
may occur as in Figure T8.21 below. If you wish to correct for the
digitization errors please see the brief Compensation Digitization Errors
tutorial.
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Figure T8.21 - Digitization errors after compensation can
be seen in the red box. Please refer to the Compensation
Digitization Errors tutorial to correct this type of error.

Note: Existing compensations may also be adjusted on a 2D plot. Please
see the Adjusting Compensation Definitions 642 section of the manual for
more details.
In the next section, we will use Automatic Compensation

40.8.2

1396

.

Automatic Compensation
To create a Compensation Definition automatically from single stained controls:
1. Select File

Open (Figure T3.1

1239

).

2. Open the layout AutoComp.fey found in the Tutorial Sample Data archive
.
1212

This is the layout that we are going to use to illustrate how to set up automatic
compensation (Figure T8.6). Typically you would start with a blank layout but we
have inserted plots so you can more easily see your data for the purposes of
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this tutorial. The top-left most plot is of FSC vs. SSC data with a gate based on a
bead population. In order to use the automatic compensation, you need a singlestained control for every parameter that you wish to compensate as well as an
unstained sample.
(Note: The unstained control can be a universal negative, a negative population
defined by a gate, or the negative population with the tube of the positive
control. In this case we will use an unstained sample)
The following data set contains an Unstained Control, All Color Control, and five
single stain controls for the following parameters: FITC, PE, PC5 (PE Cy5), PC7
(PE Cy7), and APC. All of the histograms are gated on the Beads gate and
display the data file and parameter for each control. For example, the top-right
most histogram is the Compensation Controls_FITC Stained Control.fcs file and
the FITC-A parameter is being displayed on the X-axis.

© 2020 De Novo Software

1398

FCS Express 6 Manual

Figure T8.6 Autocomp.fey Layout

In this example, we are setting compensation for all five single stained controls/
colors. However, you can set compensation for as many channels as you like,
provided you have a single-stained control for each particular channel.
3. Click on the Tools tab
Compensations command
to open the Compensations navigator (Figure T8.7).
The Compensations navigator can be moved anywhere on the screen and it
is dockable and pinnable 113 . Please feel free to move it around the screen
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as needed while working on this tutorial.
4. Click on the blue plus button,
(Figure T8.7).

, to Create a new compensation

A text box highlighted in blue will appear with the text New Compensation
(Figure T8.7).

Figure T8.7 - The Compensations navigator. Use the
navigator to add new compensations, edit definitions, and to
create new Automatic Compensation Setups.

5. Click on the Add data for compensation button,
, in the Automatic
Compensation Setup Step 1 - Select single-stained controls
window (Figure T8.7).
6. The Standard Open Data Dialog will appear (Figure T8.8).
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Note: based on your User Options 212 , the Advanced Open Data Dialog 216 may
appear. If the Advanced Open Data dialog appears, please select the
button to access the Standard Open Data Dialog.

.

Select FCS Files (*.*; *.fcs; *.lmd) from the files of type dropdown menu (Step 1, Figure T8.8).

.

Select multiple files from your computer (Step 2, Figure T8.8).

Figure T8.8 - Use the Select Data File window to select all of the files for use in
the Automatic Compensation Setup.

7. Click Open file.
Notice that all of the single-stain control files and the unstained control file
have been brought into the Select single-stain control window (Figure
T8.9). We will now assign the correct parameter for each individual file by
matching the single-stain control name in the file name to the Parameter in
the -select parameter- drop down list.
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Figure T8.9 - Files have been added to Step 1 in the
Automatic Compensation Setup. The Parameter column drop
downs will be used to match the single stained sample data
control files to the respective parameter for compensation.

8. Click on -select parameter- for the first file (Compensation
Controls_Unstained Control.fcs) (Figure T8.10).
9. Select Universal Negative from the bottom of the -select parameterdrop down list (Figure T8.10).
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Figure T8.10 - Selecting the Universal negative parameter to
match the Unstained Control.fcs file.

This will assign the Compensation Controls_Unstained Control.fcs file as the
universal negative control for the rest of the single stained controls.
10. Click on -select parameter- for the second file (Compensation
Controls_FITC Stained Control.fcs) (Figure T8.11).
11. Select 7- FITC-A from the -select parameter- drop down list (Figure
T8.11).
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Figure T8.11 - Selecting the FITC-A parameter to match the
FITC Stained Control.fcs file.

12. Repeat steps 11 and 12 for each of the single stained controls and
parameters. For example, PE Stained Control.fcs should be matched with
11 -PE-A. The Step 1 - Select single-stained controls window should
look like figure Figure T8.12 when you are done.
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Figure T8.12 - All Parameters have been matched to their
respective single stain control.fcs file.

13. Click on Step 2 - Build histograms to expand the build histograms
window (T8.13).
14. Click on the Build Histograms button (T8.13).
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Figure T8.13 - The Build Histograms button will create a new
page for scatter parameters and a new page containing a
postive control and negative control histogram for each
individual stain.

Six new pages will be created (Figure T8.14):
Scatter Plot
FITC-A control
PE-A control, PC5-A control
PC7-A control
APC-A control
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The Scatter Gate page contains a plot based on the first two parameters of
the data while the rest of the pages (single stain control pages) contain two
histograms for each parameter compensated. The top histogram shows the
positive population from the single stain control for the parameter while the
bottom histogram shows the negative population from the universal negative
control. A histogram marker has automatically been created for each positive
and negative population and each histogram marker has also been
automatically converted and linked to a gate. All of the histogram markers/
gates are children of the Scatter Gate which means adjusting the Scatter
Gate will cause the histogram markers/gates to update in real time.
We will now make some adjustments to the Scatter Gate to refine the
automatically marked/gated single stain and negative populations.

To better appreciate plot adjustments, turn on the Multiple Page view by:
15. Click on the View tab

.

16. Select the Scatter Plot page for the left page.
17. Select the FITC-A control page for the right page.

your screen should now look as in Figure T18.14
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Figure T8.14 - Clicking on the build histograms button results in a Scatter Plot
page and a new page with every single stained control.

In this instance FSC-H vs FSC-A are not the correct parameters for defining
scatter so we will replace the Scatter Gate with a more appropriate one.

18. Change the X-Axis parameter on the Unstained Control dot plot (left
page) to SSC-H (Figure T8.15)
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Figure T8.15 - Changing the X-Axsi parameter to
SSC-H.

19. Choose the Gating tab

.

20. Draw a gate around the beads population like the one in Figure T8.16 (left
panel).
21. A Create New Gate dialog appears.
22. Chose the Replace an existing gate radio button (Figure T8.16).
23. Choose Scatter Gate from the bottom of the drop down list (Figure
T8.16).
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Figure T8.16 - Creating a gate around the bead population on the plot and
choosing to replace the Scatter Gate with the newly created gate.

24. Click OK.
Notice that the original scatter gate has been replace with the new one you
defined. It is convenient to replace the original scatter gate because all the
single stained control histograms in the layout are already using that gate. If
we had created a new gate, we would have had to apply that new gate to all
the single stained control histograms. Notice that the subsequent single stain
control histogram pages have updated to use this new gate.
User may also decide to refine markers position in the following pages of the
layout (the ones containing single staining control histograms).
We will now complete the Automatic Compensation Setup in Step 5.
Steps 3 and 4 of the Automatic Compensation Setup are optional and we
will come back to them at the end of this tutorial .
1414

25.Click on Step 5- Calculate matrices in the Compensations navigator.
26. Click on the Calculate matrices button (Figure T8.17).
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Figure T8.17 - Click the Calculate Matrices button to
complete your automatic compensation setup.

All of the compensation and spillover matrix's will be automatically calculated
and displayed in the Compensation Matrix and Spillover Matrix tabs of the
Compensations navigator. The Editor view (highlighted in red) can be
changed from Matrix Editor to List Editor to view the compensation
definitions in matrix or list form (this may also be done in the Spillover
Matrix tab). (Figure T8.18 below)
Note: Your values may differ slightly from figure T8.18 due to differences in
how the scatter gate was manually setup in steps 20-25 of this tutorial.
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Figure T8.18 - The Spillover Matrix created from the Automatic
Compensation Setup. The red box indicates you can change
from Matrix Editor to List Editor view. The Spillover Matrix tab
will display the spillover matrix for your compensation
definition.

We will now switch back to a one page view and apply our new automatic
compensation to a multicolor control.
27. Click on the View tab
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28. Click on the Compensation Samples page tab to move on the first page
of the layout (Figure T8.6).
29. Click on the New Compensation compensation in the Compensations
navigator to select it (Figure T8.19).
30. Drag and drop (by click and holding the left mouse button) the New
Compensation on top of the Compensation Controls_All Colors.fcs plot in
the upper right of the layout (see red arrow in Figure 8.19).

Figure T8.19 - Dragging the New Compensation definition from the
Compensations navigator and dropping it on a plot will apply that compensation
definition to the plot.

The plot will update and show the data properly compensated as in figure
T8.20 below.
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Figure T8.20 - The All Colors
control plot with the
compensation defined in the
Automatic Compensation Setup
feature applied.

Compensation and Spillover matrices may also be added anywhere in your
layout or Microsoft Excel in a text box.

31. Click Compensation Matrix within the New Compensation definition to
select it (FigureT8.21).
32. Drag the Compensation Matrix to an empty space in the layout and
drop it (FigureT8.21).

Figure T8.21 - Drag and drop the Compensation Matrix to a blank space in the
layout (red arrow) to insert a text displaying all of the matrix values.
© 2020 De Novo Software

1414

FCS Express 6 Manual

The compensation matrix will now be displayed in a text box (FigureT8.21).
Steps 32 and 33 can be repeated with a drag and drop to Microsoft Excel if you
would like the matrices displayed there.

At this point the Automatic Compensation Setup is complete although Step 3
- Adjust parameters (optional) 634 and Step 4 - Add extra spillover
targets (optional) 636 may also be used to refine your single stain
populations (Adjust parameters 634 ) or to have other targets defined
without defining a source (Add extra spillover targets 636 ). If you would like
to learn more about these advanced features please see the Automatic
Compensation- Optional Steps 3 and 4
tutorial.
1415

Please see the Manual Compensation
tutorial or the Compensation
of the manual for more details on compensation in FCS Express.
1392

622

section

Note: Sometimes when working with your own data digitization errors may
occur as in Figure T8.22 below. This happens primarily if you are using log
converted FCS 2.0 data. If you wish to correct for the digitization errors
please see the brief Compensation Digitization Errors
tutorial.
1436
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Figure T8.22 - Digitization errors after compensation can
be seen in the red box. Please refer to the Compensation
Digitization Errors tutorial to correct this type of error.

40.8.2.1

Automatic Compensation - Optional Steps 3 and 4

To adjust parameters and extra spillover targets:
Once you have completed Step 2 of the Automatic Compensation Setup
you may proceed directly to Step 5 to calculate the matrices or you can go
through Step3 and/or Step 4. This tutorial will walk you through a sample
compensation setup that uses also Step 3 and Step 4. If you are not yet
familiar with automatic compensation in FCS Express please complete the
Automatic Compensation
tutorial before starting this section.
1396

Step 3 - Adjust parameters (optional) 634 allows you to base your single
stained controls on gates other than the default marker gates that were
created during the automatic compensation setup.
o Adjust parameters 634 is useful when you would like to refine the
populations that are used for calculating compensation. For instance, if
the Automatic Compensation Setup does not make a good estimate
© 2020 De Novo Software

1416

FCS Express 6 Manual

of the population or if you would like to use a population from another
file, gate, gating hierarchy, or plot Step 3 would prove very useful.
Parameters may be adjusted or changed all together by dragging and
dropping a plot or gate onto the parameter for the Stained and
Unstained columns. If a gate is dropped the compensation definition
will be based on that gate and plot it originated from (keep in mind any
gating hierarchy you have defined with a gate will be used) . If a plot is
dropped, the compensation definition will be based on the plot that you
just dropped, with the gating being unchanged. Dragging and dropping
new plots, files, or gates in this section will allow you to override the
automatic setup and use gates and plots of your choice.
Step 4 - Add extra spillover targets (optional) 636 will allow you to have
other fluorescence targets defined without defining a source fluorescence.
o Adding extra spillover targets 636 is useful if you would like to have an
idea of what spillover would look like if an extra parameter was added in
future experiments. To add an extra spillover target simply check the
box for the extra target you would like to add. Note. Extra spillover
targets will only appear for parameters that were acquired with the
data.

The layout that will be used for this section of the tutorial is
AutoCompAdditionalSteps.fey and it can be found in the Tutorial Sample
Data archive . In this layout an automatic compensation setup definition
(named New Automatic Compensation) has already been created using
the standard default setup described in the previous section . The layout
contains 4 pages as follows:
1212

1396

Gating Strategy and Sample page: The Gate View on this page shows
the gating strategy that was created automatically by the compensation
setup (purple gates) and the one that we would like to use (red and blue
gates). The plots are arranged starting from the top left to show how the
gating hierarchy has been applied. Follow the green arrows next to each
plot to see how the gates have been applied and defined. The plot labeled
SAMPLE COMPENSATION has the New Automatic Compensation
definition applied to it. The plot off the page to the right is labeled Data for
New Compensation Gates and has no compensation applied to it. The
Data for New Compensation Gates plot has gates drawn on the PE
positive, PerCPCy5-5 positive, and negative populations. These gates will be
used later in the tutorial for the adjust parameters steps.
Scatter Plot page: This page was created by the Automatic Compensation
Setup tool and displays the stained and unstained populations used to
calculate the compensation matrix.
CD 62L YG PE-A control page: This page was created by the Automatic
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Compensation Setup tool and displays the current gate used to calculate
the compensation matrix for the PE parameter.
CD 4 PerCP-Cy5-5-A control page: This page was created by the
Automatic Compensation Setup tool and displays the stained and unstained
populations used to calculate the compensation matrix for the PerCPCy5-5
parameter.

In the following steps we will:
Adjust the parameters to define new gates for the single stained and
unstained controls.
Change the gating hierarchy to make the Scatter Gate (defined by the
Automatic Compensation Setup) a child of manually defined gates.
Add an extra spillover target to view the potential spillover of another
target.

1. Select File

Open (Figure T3.1

1239

).

2. Open the layout AutoCompAdditionalSteps.fey found in the Tutorial Sample
Data archive
(see above for a description of the layout ).
1212
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3. Click on the Created manually folder
in the Compensations
navigator (figure T8.22 red box).
4. Click on the Add data for compensation button,
Compensation Setup

, in the Automatic

Step 1 - Select single-stained controls window

(Figure T8.7).
5. Click on the Data List tab (Figure T8.8).
6. Multiple-select the following files in the Data List (Figure T8.8):
Specimen_001_PE_CD62L.fcs
Specimen_001_PerCP Cy5-5 CD4.fcs
Specimen_001_PE_unstained.fcs
7. Chose the parameter for each data file based on the table below:
Data File
Specimen_001_PE_CD62L.fcs

Parameter
9 - YG PE-A

Specimen_001_PerCP Cy5-5 CD4.fcs 10 - PerCP-Cy5-5-A
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Specimen_001_PE_unstained.fcs

Universal Negative

8. Click on Step 2 - Build histograms to expand the build histograms window
(T8.13).
9. Click on the Build Histograms button (T8.13).
10. A window asking for deleting the layout pages and gates previously created
opens. Click Yes.

As in the previous tutorial section we will now make some adjustments to the
Scatter Gate to refine the automatically marked/gated single stain and negative
populations.
In this instance FSC-H vs FSC-A are not the correct parameters for defining
scatter so we will replace the Scatter Gate with a more appropriate one.

11. Select the Scatter Plot page and change the X-Axis parameter of the
displayed dot plot to SSC-H.
12. Choose the Gating tab

.

13. Draw a gate around the cell population like the one in the Figure below
(Figure T8.22a, left panel).
14. In the Create New Gate dialog that appears chose the Replace an
existing gate radio button and select Scatter Gate from the bottom of the
drop down list (Figure T8.22a, right panel).

© 2020 De Novo Software

Tutorials

1419

Figure 8.22a - A new Scatter Gate is drawn and used as replacement for the
original one.

15. Click OK.
Notice that the original scatter gate has been replace with the new one you
defined. It is convenient to replace the original scatter gate because all the single
stained control histograms in the layout are already using that gate. If we had
created a new gate, we would have had to apply that new gate to all the single
stained control histograms. Notice that the subsequent single stain control
histogram pages have updated to use this new gate.
User may also decide to refine markers position in the following pages of the
layout (the ones containing single staining control histograms).
16. Click on Step 3- Adjust parameters (optional) (figure T8.22b).
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Figure T8.22b - Selecting the Automatic Compensation setup and Step 3 for the
New Automatic Compensation definition.

We will now replace the gates that were defined in the Automatic Compensation
Setup with gates we have defined manually. These manually defined gates
represent the following:
A gating hierarchy has been defined with all of the FSC and SSC parameters
and a Dapi Negative gate. This hierarchy is used to exclude debris and other
unwanted events.
Negative Control Gate: This gate is a child of the Dapi Negative Gate
hierarchy. It defines a negative or unstained control population.
PE Positive Control gate: This gate is a child of the Dapi Negative Gate
hierarchy. It defines a PE single color control only population.
PerCP CY5-5 Positive Control gate: This gate is a child of the Dapi Negative
Gate hierarchy. It defines a PerCP CY5-5 single color only population.
17. Click and hold on the Negative Control gate in the gate view (Figure
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T8.23).
18. Drag the Negative Control gate onto the Unstained column in the CD62L
YG PE-A row and drop it here.
19. Click and hold on the Negative Control gate in the gate view.
20. Drag the Negative Control gate onto the Unstained column in the CD4
PerCP-Cy5-5-A row and drop it here.

Figure T8.23 - Dragging the Negative Control gate from the gate view to the
Unstained column for both parameters.

Now the Step3 - Adjust Parameters (Optional) section should look as in
Figure T823b.
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Figure T8.23b The Step3 section after the drag&drop

We previously dragged and dropped the Negative Control gate from the Gate
View. We will now use a plot a source for the drag and drop (Figure T8.24).
21. Click and hold on the PE Positive Control gate in the Data for New
Compensation Gates plot (off the right hand side of page).
22. Drag and drop it onto the Stained column in the CD62L YG PE-A row and
drop it here.
23. Click and hold on the PerCPCY5-5 Positive Control gate in the Data for
New Compensation Gates plot (off the right hand side of page) (Figure
T8.24).
24. Drag and drop it onto the Stained column in the CD4 PerCP-Cy5-5-A row
and drop it here.
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Figure T8.24 - Dragging and dropping gates from a plot to the Stained column in
step 3 for each parameter.

Step 3 - Adjust parameters (optional) will look like figure T8.25 below when
you are done.
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Figure T8.25 - Step 3 - Adjust parameters (optional) after dragging and dropping
gates from the gate view and plots onto the stained and unstained population
columns.

25. Click now on Step 5 - Calculate matrices.
26. Click the Calculate Matrices button.

Notice that the spillover matrix for the New Automatic Compensation definition
has changed (see Figure T8.26 below) to reflect the new gating changes. You
can drag and drop any gate or an entire plot to the Stained and Unstained
columns in this fashion to customize your Automatic Compensation Setup.
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Figure T8.26 - The original Automatic Compensation Setup definition (left)
compared to the Automatic Compensation Setup definition (right) that is based on
a gating hierarchy and manually defined positive and negative controls.

Another useful trick is to make the Scatter Gate and its children (defined by the
Automatic Compensation Setup) children of another gate that you have defined.
In the following steps we will make the Scatter Gate a child of the Dapi Negative
gate. When the matrix is recalculated the manually entered gating hierarchy for
debris exclusion will be taken into account with the Automatic Compensation
Setup. We will first close the layout and open it again to reset the changes we
have made to the compensations.

27. Select File tab

. (Do not save any changes).

28. Select File tab

.

29. Open the layout AutoCompAdditionalSteps.fey found in the Tutorial
Sample Data archive .
1212

30. Click on the Created manually folder
in the Compensations
navigator (figure T8.22 red box).
31. Click on the Add data for compensation button,
, in the Automatic
Compensation Setup Step 1 - Select single-stained controls window
(Figure T8.7).
32. Click on the Data List tab (Figure T8.8).
33. Multiple-select the following files in the Data List (Figure T8.8):
Specimen_001_PE_CD62L.fcs
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Specimen_001_PerCP Cy5-5 CD4.fcs
Specimen_001_PE_unstained.fcs Click and hold on the Scatter Gate in
the Gate View
33. Chose the parameter for each data file based on the table below:
Data File
Specimen_001_PE_CD62L.fcs

Parameter
9 - YG PE-A

Specimen_001_PerCP Cy5-5 CD4.fcs 10 - PerCP-Cy5-5-A
Specimen_001_PE_unstained.fcs

Universal Negative

34. Drag the Scatter Gate on top of the Dapi Negative Gate and drop it here
(Figure T8.27).

Figure T8.27 - Dragging and dropping the Scatter Gate onto the Dapi Negative Gate
to create a new gating hierarchy

Click on Step 5 - Calculate matrices.
35. Click on Step 2 - Build histograms to expand the build histograms window
(T8.13).
36. Click on the Build Histograms button (T8.13).
37. A window asking for deleting the layout pages and gates previously created
opens. Click Yes.
38. Click the Calculate Matrices button.

Notice that the spillover matrix for the New Automatic Compensation definition
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has changed (see Figure T8.28 below) to reflect the new gating changes. This is
because the plots that were created by the Automatic Compensation Setup were
gated on the Scatter Gate so by moving the Scatter Gate in the gating
hierarchy the statistics based on these plots were automatically updated.

Figure T8.28 - The original Automatic Compensation Setup definition (left)
compared to the Automatic Compensation Setup definition (right) that is based on
the new gating hierarchy of the Scatter Gate.

We will now use Step 4 - Add extra spillover targets (optional) to determine
the theoretical spillover for the FITC parameter.

39. Click on Step 4 - Add extra spillover targets (optional) to expand the
window.
40. Check the FITC-A check box (Figure T8.28).
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Figure T8.28 - Adding an extra spillover target in Step 4.

41. Click the Calculate Matrices button in Step 5 - Calculate matrices.
The Spillover Matrix tab will now display all of your original parameters along
with the FITC-A parameter that you selected in Step 4- Add extra spillover
targets (optional) (Figure T8.29). The column for FITC-A in the matrix is
displaying the theoretical compensation needed against all other targets.
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Figure T8.29 - The compensation matrix displaying the extra
spillover target that was added. The compensation values for CD
44 FITC-A vs other sources/targets is the theoretical value.

This brings us to the end of the Automatic Compensation Optional Steps 3 and 4
tutorial. Please see the Manual Compensation
tutorial or the Compensation 622
section of the manual for more details on compensation in FCS Express.
1392

40.8.2.2

Automatic Compensation and Batch Processing

In FCS Express, you may define a post-acquisition compensation matrix using
single-stained controls, apply it to your experimental samples, and batch process
your results to Microsoft PowerPoint, PDF, and Word, all within a single layout.
There is no need to export and import compensation into separate layouts.
In this section, we will:
Change our default Options to use a post-acquisition compensation matrix
as default
Set an automatic compensation as default for the entire layout
Insert plots of experimental files in the same layout
© 2020 De Novo Software
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Batch process the results to Microsoft Office PowerPoint
We'll begin with a layout in which an automatic compensation was already
defined, using single-stain controls.
1. Select File

Open.

2. Open the layout AutoCompWithBatchProcess.fey from the Tutorial
Sample Data archive .
1212

An automatic compensation has already been defined in this layout, according to
Steps 1-27 of this section
of this tutorial. We will now set this compensation
as default for the entire layout.
1396

3. Select File

Options.

4. Select Compensation Default, then FCS File from the Default
Compensation to Use dropdown menu (Fig. 1, ). Learn more about
Compensation default Options 641 .
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Figure 1. Changing the default Compensation Option.

5. Click OK (Fig. 1,

).

6. Click to expand the Created manually node within the Compensations
window (Fig. 2, ).
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Figure 2. Setting a compensation matrix as default for the layout.

7. Right-click on the "New Compensation" matrix to Set As Default (Fig. 2,
). This matrix will now be marked as default (Fig. 2, right).
We will now insert plots of experimental files in the same layout, and watch as
the Compensation Default matrix is automatically applied.
8. Drag the first file from the Data List to an empty spot on the layout (Fig.
3, ).
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Figure 3. Inserting a plot on the layout.

9. Click OK (Fig. 3,

).

10. Click and hold the X- and Y-axis labels to change the parameters of the
newly inserted plot to "CD95 PC5-A" (Fig. 4, ) and "CD8a PC7-A" (Fig.
4, ), respectively.

© 2020 De Novo Software

1434

FCS Express 6 Manual

Figure 4. Changing axis parameters.

The Compensation Default matrix has been applied automatically to the plot.
You may verify this by manually changing the values in the Compensation Matrix
from the Compensations window (Fig. 5, mouse arrow) and watching the
population in the plot update.
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Figure 5. Editing a compensation matrix manually.

We will now perform a Batch Process to export the results from all the files in
our Data List to PowerPoint. The Batch Process Action has already been set up
for convenience. To learn more about this functionality, see the Batch
Processing tutorial
or the short Batch Processing video on YouTube.
1460

11. Click Batch

Run (Fig. 6).

Figure 6. Running a Batch Process.
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A PowerPoint file with the results from all the files in your Data List has now
been saved on your Desktop. If the PPT file does not open automatically, please
change the Export to PowerPoint's Output file options save path to a valid one
for your computer. See the PowerPoint section of the Batch Processing tutorial
808 for details.

40.8.3

Compensation Digitization Error
Sometimes compensation will introduce a digitization error as seen in the red
box in the figure below. The digitization error of the FL1-H (+) population in the
lower right-hand quadrant after compensation (figure T8.30) can easily be
corrected by adding a range of random values. Digitization errors and adding a
range of random values is further discussed in Editing a Compensation Definition
627 topic. Please follow the steps below to learn how to correct for digitization
errors.

Figure T8.30 - Digitization errors can be seen highlighted in
the red box.

1. Select File tab

.

2. Open the layout ManualComp.fey found in the Tutorial Sample Data archive
.
1212
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3. Click on the Digitization Errors page tab.
Notice the digitization error of the FL1-H (+) population in the lower right-hand
quadrant after compensation. To correct for the digitization error:
4. Select the
5. Select the Create Manually folder
definition (figure T8.31)

command
compensation

Figure T8.31 - Selecting the DigitizationError compensation definition for editing.

6. Select the Create Manually folder
compensation
definition (figure T8.31).
7. Type 2.0 in the Range of random value to add when converting log data
field (indicated by red box in Figure T8.32).
The plot will update in real time to reflect the change and the FITC(+) population
in the lower right quadrant will now appear without the digitization error. The
random value entered above was added to visually correct the data displayed in
the 2D plot.
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Figure T8.32 - Changing the Range of random value to add when converting log
data to 2.0.

40.9

Snapshots
Snapshots 370 provide a convenient way to easily save multiple gate, quadrant, or
marker positions and to apply these positions for quick access across samples in
your analysis.
Snapshots can be applied during Batch Processing
independently through the Snapshots window .

850

, Iteration Navigation

374

, and

1438

These tutorials will highlight these tools and how they can be utilized during
analysis.
Snapshot Window Tutorial
Iteration Snapshots Tutorial
Batch Processing Snapshots Tutorial
1438

1444

1451

We will start by focusing on the Snapshot Window

40.9.1

1438

.

Snapshots Window
In this tutorial:
We will learn how to take Snapshots through the use of the Snapshots
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window.
We will learn how to apply Snapshots to the data in the layout.
Although any data files of your own can be used to follow along in this
tutorial, you have the option of using the same sample data files used in this
tutorial. The sample data files are located in the Tutorial Sample Data
archive .
1212

1. Navigate to the Tutorial Sample Data folder from the File tab
2. Open the layout SnapshotWindow.fey.
This layout contains 2 color dot plots, 2 density plots and a 1D histogram. There
are also 3 data files loaded into the Data List, which is docked 115 to the right side
of the layout. We will navigate and analyze through these 3 files and make
adjustments to the various gates, quadrants and markers that are to be used to
analyze the data. Once we adjust the coordinates of our gates, we will take a
snapshot.
3. Open the Snapshots navigator from
1).

(Figure

Figure 1 - The Snapshots Tool

We will begin by taking a snapshot of the current state of the layout.
4. Click on the Create a new Snapshot button (
navigator.

) in the Snapshots

5. Replace the text "New Snapshot" with "Baseline" in the Snapshot name text
area.
Once the snapshot is taken, FCS Express will show a time stamp for that
snapshot (Figure 2).
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Figure 2 - Baseline Snapshot with a
Timestamp

6. Navigate to the next iteration by clicking on iteration #2 in the Data List, as
seen in Figure 3.

Figure 3 - Navigate to the Next Iteration
By Clicking on the Iteration Number

The steps below are highlighted in Figure 4.
7. Adjust the Red gate to include the majority of the cells in the cluster. (Figure
4 )
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8. Right click on the BV605 vs BV421 plot. (Figure 4

1441

)

9. Select Show Quadrants.
10. Move the quadrant in the APC-H7 vs APC plot to a new position. (Figure 4
)
11. Adjust the Marker in the 1D histogram of APC. (Figure 4

)

Figure 4 - Making Adjustments Before Taking A Snapshot

After adjustments, the layout should look similar to Figure 5.
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Figure 5 - After Making Gating Adjustments

12. Repeat Step 4 to record a new Snapshot.
13. Replace the text "New Snapshot" with "Adjusted" in the Snapshot name text
area.
14. Navigate to the next iteration by clicking on iteration #3 in the Data List.

We will now apply the Baseline snapshot from step 5 to Iteration 3.
15. Click on the text "Baseline" in the Snapshots navigator to select the snap
shot.
16. Drag the "Baseline" Snapshot from the Snapshots window to the layout, as
seen in Figure 6a.
Alternatively, you may apply the snapshot by selecting the snapshot as in
step 15 and clicking on the Apply Snapshot button
navigator.

in the Snapshots
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Once the snapshot has been applied, all gates and coordinates that applied to
that snapshot will be applied to the data, as seen in Figure 6b. Repeating steps
15 and 16 with the "Adjusted" snapshot will apply that snapshot to the layout.

Figure 6a - Dragging and Dropping the Baseline Snapshot
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Figure 6b - The layout as it appear after the drag and drop of the Baseline
snapshot.

In the next section, we discuss on how to automatically apply snapshots will
navigating thru each iteration .
1444

40.9.2

Iteration Snapshots
In this tutorial:
We will learn how to take Snapshots through the use of the Apply
Iteration Snapshot tool.
We will learn how to navigate through our data by using the Previous/
Next buttons or thru the Iteration drop down menu on the Data tab.
We will learn how to Flag an iteration for review later on during analysis.
Although any data files of your own can be used to follow along in this
tutorial, you have the option of using the same sample data files used in this
tutorial. The sample data files are located in the Tutorial Sample Data
archive .
1212

© 2020 De Novo Software

Tutorials

1445

1. Navigate to the Tutorial Sample Data folder from the File tab
2. Open the layout IterationSnapshots.fey.

This layout contains 4 density plots and a 1D histogram and is currently
displaying the 1st iteration from 3 iterations that are contained in the Data List.

3. Select the Tools tab
(Figure 8).

button

Figure 8 - Apply Iteration Snapshot Tool

4. Click the Next button (double right hand arrow) in the Data tab
Data on All Objects category to advance to the next iteration.
Alternatively, you can advance to the next iteration by selecting 2 from
the Data tab
drop down
menu or by selecting 2 from the Iteration column in the Data List.

The content of the layout should now be similar to Figure 9a.

We will now make the adjustments for the 2nd iteration according to the steps
below and as seen in Figure 9a:
5. Adjust the red gate around the cluster on the SSC/V500 plot (Figure 9a
6. Adjust the purple gate around the cluster in the right of the BV421/BV605
plot (Figure 9a ).
7. Right click on the FITC/BV605 plot (Figure 9a
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8. Choose Show Quadrants.
9. Adjust the M1 marker to fully accommodate the peak on the APC 1D
histogram (Figure 9a ).

Figure 9a - Steps for the 2nd Iteration

After these adjustments the layout should be similar to Figure 9b.
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Figure 9b - The layout as it should appear after the adjustments reported in Steps
5-9.

We will now Flag the iteration for use later in the tutorial.

10. Click on the Flag this Iteration button in the Data tab
All Objects section(Figure 10).
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Figure 10 - Flag the 2nd Iteration

Once the 2nd iteration is flagged, you will see a new icon within the Data List,
next to the 2nd iteration:
.
We will come back to the Flagged iteration in the next tutorial section, Batch
Processing Snapshots .
1451

11. Click the Next button (double right hand arrow) in the Data tab
Data on All category to advance to the third iteration.

We will now make the adjustments for the third iteration according to the steps
below and as seen in Figure 11a:
12. Adjust the red gate around the cluster on the SSC/V500 plot (Figure 11a

)

13. Adjust the purple gate around the cluster in the lower right of the BV421/
BV605 plot (Figure 11a )
14. Move the floating quadrant on the PE/PerCPCy5.5 plot to a new position
(Figure 11a )
15. Move the quadrant on the FITC/BV605 plot to a new position (Figure 11a
)

16. Move the M1 marker on the APC 1D histogram (Figure 11a

).

17. Create a new marker 351 to accommodate the second peak on the APC 1D
histogram (Figure 11a ).
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Figure 11a - Steps for 3rd Iteration

The layout should now appear similar to Figure 11b:
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Figure 11b - The layout as it should appear after the adjustments reported in Steps
12-17.

We will now navigate back through our data to observe the Iteration Snapshot
feature in effect.

18. Click the Previous button (double left hand arrow) in the Data
tab
category to move back to the second
iteration.
19. Click the Previous button (double left hand arrow) in the Data
tab
category to move back to the first
iteration.

Notice that FCS Express has automatically saved and applied a snapshot for
each iteration.
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to save your work.

21. Navigate to your desktop.
22. Name the layout file a name of your choice.
23. Choose Linked as the Data Link Style.
24. Click Save.
You can now double click on the layout file you saved in steps 20-24 to open
and pick up your analysis where you left off. After opening the saved layout you
will notice that clicking the Previous/Next buttons will automatically apply the
iteration snapshots saved with the layout.
In the next section, we will further investigate how Snapshots are integrated with
Batch Processing .
1451

40.9.3

Batch Processing Snapshots
In this tutorial:
We will learn how to analyze data and take Snapshots
Processing.

1513

through Batch

We will learn how to Run, Rerun and Review the analysis during batch
processing.
o Run
- will run batch processing and perform all batch actions
that are selected for each iteration. Snapshots for each iteration
will automatically be taken.
1452

o Rerun
- will rerun the previous batch process and perform all
batch actions that are selected, for each iteration. Any Snapshots
that were previously saved by FCS Express will automatically be
re-applied during Rerun. This will also be the opportunity where the
user can regate and have FCS Express overwrite the previously
saved Snapshot with the new gating.
1456

o Review
- will rerun the previous batch process, without
performing any batch actions that were created and selected for
each iteration.
1457

We will learn about the new Batch Processing Options 841 that are available
and how they are used to play back the snapshots taken during analysis.
We will learn how to Flag 847 an iteration for further review after batch
processing has been completed.
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The layout used in this tutorial contains a batch action to Save to
Powerpoint 808 . This course assumes that the user knows how to create
Batch Processing Actions 801 to be performed each iteration of data.

To Run Batch Processing and Automatically Save Snapshots
1. Navigate to the Tutorial Sample Data folder from the File tab
2. Open the layout BPSnapshots.fey.
The layout contains 3 iterations of data already in the Data List. The layout also
contains a Save to PowerPoint 808 batch action that is designated to save to the
Desktop of the Current Windows User 715 . For this tutorial, we will focus on how
to set up the Batch Processing Options to provide the you with an opportunity to
optimize gates during the batch process.
3. Click on the Batch tab

(Figure 12).

Figure 12 - Batch Processing Options Button

Towards the middle of the Batch Processing Options window there are several
pause options that will determine whether or not FCS Express will pause
between each iteration during analysis and when FCS Express will pause during
analysis.
4. Select Unconditionally pause between iterations (Figure 13).
5. Click OK.
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Figure 13 - Batch Processing Options - Unconditionally Pause
Between Iterations

6. From Batch

Batch Processing, click the Run button.

Microsoft PowerPoint will automatically open. You can minimize PowerPoint
while the batch process completes. The Batch Processing window will also
appear showing the status of the current action, current iteration progress, and
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overall progress.
At the 1st pause, for Iteration #2, make the following adjustments (Figure 14):
7. Aadjust the Red gate
(Figure 14 ).

316

around the cluster of cells in the SSC/V500 plot.

8. Adjust the Purple gate around the cluster of cells on the right side of the
BV421 vs BV605 plot. (Figure 14 ).
9. Add a Quadrant

290

to the FITC vs BV605 plot (Figure 14

10. Adjust the Marker
).
11. Click on the Flag
).

270

847

).

around the peak in the APC 1D histogram (Figure 14

icon in the Batch Processing progress window (Figure 14

Figure 14 - Steps for 2nd Iteration Analysis

12. In the Batch Processing progress window, click Continue (Figure 15).
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Figure 15 - Continuing with Batch Processing

At the 2nd pause, make the following adjustments (Figure 16):
13. Aadjust the Red gate around the cluster of cells in the SSC/V500 plot
(Figure 16 ).
14. Adjust the Blue gate around the cluster of cells in the upper left portion, and
the Purple gate around the cluster of cells in the lower right portion of the
BV421 vs BV605 plot (Figure 16 ).
15. Adjust the floating quadrant as seen in figure 5 in the PE vs PerCP Cy5.5 plot
(Figure 16 ).
16. Adjust the quadrant as seen in the image in the FITC vs BV605 plot (Figure
16 ).
17. Adjust marker M1 around one peak and create a new marker, M2, around
the 2nd peak in the APC 1D histogram (Figure 16 ).
18. Click Continue within the Batch Processing progress window. At the
conclusion of the batch process, the PowerPoint export will open (Figure 16
).
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Figure 16 - Steps for 3rd Iteration Analysis

FCS Express has automatically taken Snapshots of each iteration analysis.
a. To view the Snapshots that were taken, you must either Rerun
batch process or Review
the data.

1456

the

1457

b. Using the Previous/Next buttons will remove whatever Snapshots
were taken during batch processing.
c. The following steps will detail how to view the Snapshots that were taken
during batch processing.

Rerunning Batch Processing
1. From

, click the Rerun button (Figure 17).
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Figure 17 - Rerunning Batch Processing

The same process as before will occur. Since we still have the Batch
Processing Pause Option set to Unconditionally pause between iterations,
FCS Express will continue to pause after each iteration. However, if you
would like to experiment with different options, you can find a summary of
the Batch Processing Options here 841 . Please note that FCS Express will still
process all iterations. FCS Express will only pause for the iterations that are
determined in Options.
2. Click Continue with the progress window to continue with the Rerun process.
Make any changes to gates, markers and quadrants that you deem
necessary. If you do not wish to make any changes, click Run to end.
If any changes were made to gating, marker and/or quadrant placement,
FCS Express will record a new Snapshot for that iteration and will overwrite
any previously existing Snapshot for that iteration.
During the Rerun process, FCS Express will also perform any batch actions
that were set up as part of any process.

Reviewing Data
Review will give the user the opportunity to look at their data and make any
necessary changes to gate, marker or quadrant positions for each iteration.
However, FCS Express will not perform any batch processing actions that were
set up when in review mode.
As before, the user can control when FCS Express pauses during batch
processing. For the earlier exercise, we chose the option to have FCS Express
unconditionally pause between each iteration. This time, we will tell FCS Express
that we only want to review any iterations that were flagged during analysis. In
this exercise, we flagged the 2nd iteration, so, FCS Express will pause only for
that iteration.
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1. From Batch

Batch Processing click the Options button.

2. Deselect Unconditionally pause between iterations (if selected).
3. Select the option to Pause on flagged iterations (the list is below) (Figure
18).
FCS Express will automatically add any iterations that were flagged by the
user during batch processing. In our example, you should the number 2 listed for
that pause option.
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Figure 18 - Pause on Flagged Iterations

We will now review the data and the snapshots that were taken at the time of
analysis without completing any of the batch actions through the Review
command., go to Batch Batch Processing.
4. From
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Figure 19 - Review

5. Once the Review process begins, another Batch Processing progress window
will appear.
6. Make any changes that you would like to make. Click Continue or Run to
end to complete the process.

40.10

Batch Processing

Batch processing allows you to analyze many data files consecutively, without
having to set up the plots for each file. Batch processing also gives you the ability
to export your layout and statistics in many different formats, including: printing,
saving, and exporting to PowerPoint, PDF, Excel, a text file, Microsoft Word, or
LabKey Server .
1498

In the first example, we will export plots to a PowerPoint file

40.10.1
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.

Exporting Plots to PowerPoint

In the course of this example, we will:
Create a Data List of files to be batch processed.
Export plots to a PowerPoint file.

To Run a Batch Processing Action:
1. Select the File tab and click on Open.
2. Open the layout BatchProcess.fey found in the Tutorial Sample Data
archive .
1212

This layout contains two 2D density plots and a histogram of the file
TCellSample1.fcs (Figure T9.1). The left plot is of SSC-A vs. PerCP-Cy5.5-A
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with a gate on Lymphs. The right plot is of PE-A vs. APC-A gated on Lymphs
with quadrants. The histogram of FITC-A is also gated on Lymphs.

Figure T9.1 Batch Layout (BatchProcess.fey)

In order to run a batch process, you need to put files in the Data List.
3. Select the
T9.2).
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Figure T9.2 Selecting the Data List Command

A Data List window will appear (Figure T9.3).

Figure T9.3 Data List Window

4. Click the green plus to add files

.

A Select a Data File dialog will appear (Figure T9.4).
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Figure T9.4 Select a Data File Dialog

5. Navigate to the location where the tutorial sample is saved and select the
file TCellSample2.fcs.
6. Click Open.
The Data List window will show the two files (Figure T9.5).
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Figure T9.5 Data List with Two Files

Note: Files are processed during a batch process in the order they appear in the
Data List.
So far we have told FCS Express that we want to take the BatchProcess.fey
layout and use it to analyze the two files: TCellSample1.fcs and
TCellSample2.fcs. The next step is to tell FCS Express what we want to do every
time we analyze a different file.
7. Select the
T9.6).

command (Figure

Figure T9.6 Selecting the Batch Actions Command

A Batch Actions window will appear (Figure T9.7). This is where you tell FCS
Express what actions you want to perform during the batch process. We will now
tell FCS Express that we want to save a PowerPoint file during each iteration of
the batch process.
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Figure T9.7 Batch Actions Window

8. Select Save To PowerPoint
T9.7).

from the Add Action category (Figure

A Create Export To Powerpoint Action dialog will appear (Figure T9.8).
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Figure T9.8 Create Export to PowerPoint Action Dialog

9. Select the option to Open presentation after saving

.

10.Select Combine the output from all iterations into the same
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presentation from the Iteration options section
11.Select Save to a new file
click on the folder icon

.

from the Output file options section and

to choose where the file will be saved, such as

your Desktop, and give your file a name.
12.Click OK

.

The Batch Actions window will now be updated to reflect the export to
PowerPoint (Figure T9.9) from the Add Action category (Figure T9.7).
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Figure T9.9 Batch Actions Window Updated with Export to
PowerPoint Action

13. Select the
T9.10).

command (Figure
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Figure T9.10 Selecting the Run Batch Process Command

FCS Express will now run the batch process. After a series of automated steps,
PowerPoint will launch and open the file TCellAnalysis.pptx. The file will consist
of two pages: the first will be a slide showing the layout with the data file
TcellSample1.fcs (Figure T9.11) and the second the layout with the data file
TcellSample2.fcs (Figure T9.12).
Note about ungrouping objects in PowerPoint for PC versus PowerPoint
for Mac
Once exported to PowerPoint, layout objects can be further ungrouped into
single components in the PC version of Microsoft PowerPoint. Ungrouping
objects saved by FCS Express in PowerPoint for Mac is not supported. However,
presentations saved on a Mac may be opened on a PC and ungrouped.

Figure T9.11 Slide 1 in PowerPoint

© 2020 De Novo Software

FCS Express 6 Manual

1470

Figure T9.12 Slide 2 in PowerPoint

The next section will continue using this layout, so you can keep it open.
Otherwise, please feel free to save it so that you can start the next section
where you left off.

In the next section, we will export to an Excel report (Cell Mode

40.10.2
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).

Excel Report (Cell Mode)

In the course of this example we will:
Create an Excel – Cell Mode Report.
Export the $FIL keyword.
Export the $DATE keyword.
Export a Statistic.
Export a Picture.
Run a batch process.
For convenience, we are going to start with the same layout as before. The
images contained within this section will continue with the layout from the
previous section. However, you can add reports to layouts that already have
actions defined. If you have the previous layout still open, please jump to Step
5.
1. Select the File tab and click on Open.
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2. Open the layout BatchProcess.fey found in the Tutorial Sample Data
archive .
1212

To Perform an Excel Report Batch Process:
3. Create a Data List with files TCellSample1.fcs and TCellSample2.fcs
(see the previous section ).
1460

4. Select the
T9.6 ).

command (Figure

1460

A Batch Actions window will appear (Figure T9.7).
5. Select Export to Excel (Cell Mode) (
Report category.

Figure T9.7

1460

) from the Add

An Excel (Cell Mode) Options dialog will appear (Figure T9.13). We will use this
dialog to set up the batch export of files in the Data List to Excel.
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Figure T9.13 Excel (Cell Mode) Options Dialog

6. Click on the Open File Icon in the Template Document: field
refer to Figure T9.13).

(Numbers

7. Select T Cell Analysis Template.xlsx from FCS Express Tutorial Sample
Data folder.
T Cell Analysis Template.xlsx is an Excel file that contains the background for
your report. The Excel template we are using is shown in Figure T9.14.
8. Click on Combine all iterations in the same document in the Iteration
options section .
9. Click on Save to a new file from the Output file options section

.

10. In the Save to a new file field, click on the Folder icon to specify the
output location of your Excel Report , such as your desktop.
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11. Click OK
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.

Figure T9.14 T Cell Analysis Excel Template

The Batch Actions window will show the export to Excel (Cell Mode) action
listed (Figure T9.15). This image also shows the Save To Powerpoint Batch
Action from the last section.
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Figure T9.15 Batch Actions Window with the Export To Excel Action

12. Select Keyword Token from the Add Item to Report category (cursor
in Figure T9.15).
An Excel (Cell Mode) field "Keyword" options dialog will appear showing the
Data Source category (Figure T9.16). This is where we will define the
"keywords" to export to Excel.
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Figure T9.16 Excel (Cell Mode) field "Keyword" options Dialog

13. Under the Data Source category, select 4 - Histogram TCellSample1.fcs compensated (FITC-A).
14. Click on the Keyword category. (Figure T9.16).
The Keyword category page will appear (Figure T9.17).
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Figure T9.17 Excel (Cell Mode) field "Keyword" options Dialog -- Keyword Category

15. Click on the ellipsis (…) button to the right of the field Select a keyword
(Figure T9.17).
The Please select a keyword dialog will appear (Figure T9.18). This dialog
displays the keywords found in the FCS file.
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Figure T9.18 Dialog Displaying Keywords Found in the FCS File

16. Select the keyword $FIL (Figure T9.18), which is the filename keyword
stored in the FCS File.
17. Click OK.
18. Click on the Field category of the Excel (Cell Mode) field "Keyword"
options dialog (Figure T9.19).
The Field page of the Excel (Cell Mode) field "Keyword" options dialog will
appear. This is where we select the Excel cell address that the $FIL keyword
data will be batch exported to.
19. Type B27 in the Cell Address field (Figure T9.19). This tells FCS Express
that we want to put the FCS file name in cell B27 of the Excel template
(Figure T9.14).
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Figure T9.19 Setting the Excel Report Cell Address

20. Click OK.
The Batch Actions window will show the action Keyword: $FIL added (Figure
9.20A).
You can also select a token associated with a plot to batch export to Excel by
dragging and dropping the plot or gate of interest from the layout page onto the
Batch Process Actions section of the Batch Actions dialog.
21. Select the bottom histogram plot by clicking on the edge of the plot. You
will know it is selected because it will be outlined in red.
22. Hold down the left mouse button and drag the histogram plot over to
the Batch Process Actions section of the Batch Actions dialog (Figure
T9.20A).
23. Release the mouse button when the plot is on top of the Excel (Cell
Mode) text inside the Batch Process Actions section (Figure T9.20A).
A Paste Special dialog box will appear (Figure T9.20B).
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Figure T9.20A Dragging and Dropping a Histogram onto the Batch Actions Window

Figure T9.20B Paste Special Dialog
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24. Select the Keyword token item and click OK (Figure T9.20B).
25. The Keyword category page will appear (Figure T9.17)
26. Click on the Keyword category.
27. Click on the ellipsis (…) button to the right of the field Select a keyword
(Figure T9.17).
A Please select a keyword dialog will again appear (Figure T9.21).

Figure T9.21 Inserting the $DATE Keyword

28. Select the keyword $DATE (Figure T9.21).
29. Click OK (Figure T9.21).
30. Click on the Field category from the Excel (Cell Mode) field
"Keyword" options dialog (Figure T9.22).
The Field page of the Excel (Cell Mode) field "Keyword" options dialog will
appear again.
31. Type D27 in the Cell Address field (Figure T9.22).
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Figure T9.22 Cell Address Field Defined for Batch Export of $DATE Keyword to Excel

32. Click OK (Figure T9.22).
The Batch Actions window will show the action Keyword: $DATE added
(Figure T9.23).
This means that if the batch analysis were run now, using the files in the Data
List, the file name, saved in the FCS keyword $FIL, and the date, saved in the
FCS keyword $DATE, would be exported to cells B27 and D27, respectively, of
the Excel file previously specified in Figure T9.13.
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Figure T9.23 Batch Actions Window with $DATE Keyword Exported

We are now going to select a Statistic to batch export to the Excel file.
33. Select Statistic Token from the Add Item to Report category of the
Batch Actions window (Figure T9.23).
An options dialog will appear, as previously shown in Figure T9.16.
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34. Click on the Data Source category (Figure T9.16).
35. Select 4 - Histogram - TCellSample1.fcs compensated (FITC-A)
from the Select a plot field (Figure T9.16).
36. Click on the Statistic Category (on the left). The Statistic page of the
Excel (Cell Mode) field "Statistics" options dialog will appear (Figure
T9.24). This is where we will select a Statistic for the histogram plot that
we want to batch export to Excel.

Figure T9.24 Selecting a Statistic to Export

37. Select the marker M1 from the Plot Information drop-down list
38. Select the Gate Lymphs from the Gate drop-down list

.

.

39. Select the Statistic % of gated cells from the Statistic list box

.

40. Click on the Field category (on the left). The Field category of the Excel
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(Cell Mode) field "Statistics" options dialog will appear (Figure T9.25).
This is where we select the Excel cell address that the statistic data will be
batch exported to.
Type F27 in the Cell Address field (Figure T9.25). This is telling FCS Express
that we want to put the statistic in cell F27 of the Excel template (Figure T9.14).

Figure T9.25 Setting the Excel Cell Address

41. Click OK to accept the changes.
The Batch Actions window will show the action Statistic: % of Gated Cells
added (Figure T9.26).
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Figure T9.26 Batch Actions with Statistic % of Gated Cells to be Exported to Excel

We will now select a picture to batch export to the Excel file.
42. Select Picture from the Add Item to Report section (Figure T9.26).
An Excel (Cell Mode) field "Picture" options dialog will appear (Figure T9.27).
This is where we will define the details of the picture that will be batch exported
to Excel.
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Figure T9.27 Excel (Cell Mode) field "Picture" options Dialog

43. Select 4 - Histogram – TCellSample1.fcs compensated (FITC-A) in
the Select a Plot field (Figure T9.27).
44. Click on the Field category (Figure T9.28).
The Field category of the Excel (Cell Mode) field "Picture" options dialog will
appear (Figure T9.28). This is where we select the Excel cell address that the
picture will be batch exported to.
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Figure T9.28 Setting the Excel Cell Address for the Picture Field

45. Type A8 in the Cell Address field (Figure 28).
46. Click OK.
We have now told FCS Express to export a picture of 4 - Histogram –
TCellSample1.fcs compensated (FITC-A) to cell A8 of the Excel report
template shown in Figure T9.14.
The Batch Actions window will show the action Picture added (Figure T9.29).
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Figure T9.29 Batch Actions with Picture to be Exported to Excel

47. Click the Close button (red x) in the upper right corner of the window to
close the Batch Actions window (Figure T9.29).
We will now return to the layout page and run the Batch Processing.
48. Select the
(Figure T9.10

command
1460

).

FCS Express will now execute the Batch Process. When the Batch Process is
complete, an Excel file will be created (Figure T9.30) at the location you
specified, with two worksheets, one for each of the two files TCellSample1.fcs
and TCellSample2.fcs.
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Figure T9.30 First Sheet of the Final Excel Report from the Batch Processing
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We will continue to use this same layout in the next exercise.
Next, we will batch process an Excel report in column mode

40.10.3

1490

.

Excel Report (Column Mode)

A Column Mode batch analysis report can be created in a similar fashion as the
Cell Mode.
In this exercise we will:
Create an Excel Column Mode batch analysis report.
Add a statistic token to the report.
Add a keyword token to the report.
Add a picture to the resulting Excel spreadsheet.

For convenience, we are going to start with the same layout as before. The
images contained within this section will continue with the layout from the
previous section. However, you can add reports to layouts that already have
actions defined. If you have the previous layout still open, please jump to Step
5.
1. Select the File tab and click on Open.
2. Open the layout BatchProcess.fey found in the Tutorial Sample Data
archive .
1212

To Perform an Excel Report Batch Process:
3. Create a Data List with files TCellSample1.fcs and TCellSample2.fcs
(see Steps 4-6 of the previous section ).
1462

4. Select the Batch tab
(Figure T9.6 ).

command

1460

A Batch Actions window will appear (Figure T9.7 ). Please note that if you
have the previous layout still open the Batch Actions window will also shows the
Batch Actions from the (Figure T9.29 )
1460

1470

1460

We will now dock the Batch Actions window to the left side of the layout.
Docking the Batch Actions dialog makes it easier to drag and drop plots and
tokens while the rest of the layout remains in view, allowing you to set up the
batch process actions very quickly. Please refer to the Docking Tutorial
for
more details on using the docking feature in FCS Express.
1552

5. Move the Batch Actions window so that you see a four-headed icon in
the center of the FCS Express window (Fig. T. 9.31)
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6. Release the mouse on the left side of the icon so that both it and the left
side of the FCS Express window become highlighted (Fig. T. 9.31). The
Batch Actions window is now docked to the left side of the FCS Express
window (Fig. T. 9.31, right).

Figure T9.31 Docking the Batch Actions window.

7. Select Export to Excel (Column Mode) from the Add Report category
(Figure T9.32, ).
An Excel (Column Mode) Options dialog appears (Figure T9.32, right).

Figure T9.32 Excel (Column Mode) Options Dialog

8. In the Save to a new file field, click on the Folder icon (Figure T9.32, )
to navigate and specify where you would like to save your file and give it a
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name (e.g., "TCellStats" saved on the Desktop in Figure T9.31).
9. Click OK (Figure T9.32,

).

An Excel (Column Mode) process will now appear in the Batch Process
Actions section of the window (Figure T9.33, mouse pointer). We will now add
three items to the report (a keyword token, a statistic token, and a picture of a
plot from our layout).
10. Drag and drop the border of the upper-left plot on the layout onto the
Excel (Column Mode) action (Figure T9.33).

Figure T9.33 Dragging and dropping a plot to serve as data source for a token to be
added to the report

11. Double-click Keyword token from the Paste Special dialog (Figure
T9.34, ).
12. Click on the ellipsis in the Excel (Column Mode) field "Keyword..."
options dialog (Figure T9.34, ).
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Figure T9.34 Adding a keyword token to the report

13. Scroll to and select $FIL in the Please select a keyword dialog (Figure
T9.34, ).
14. Click OK in the Please select a keyword dialog (Figure T9.34,

).

15. Click OK in the Excel (Column Mode) field "Keyword..." options dialog
(Figure T9.33). The Keyword token has now been added as an item to
the Excel (Column Mode) report (Figure T9.34, bottom).
16. Drag and drop the border of the histogram on the layout onto the Excel
(Column Mode) action (similar to Figure T9.33, but we are dragging a
different plot).
17. Double-click Statistic token from the Paste Special dialog (Figure
T9.35, ).
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Figure T9.35 Adding a statistic token to the report

18. Select "M1" from the Select a marker dropdown menu of the Excel
(Column Mode) field "Statistic..." options dialog (Figure T9.35, ).
19. Select % of gated cells from the Statistic list box (Figure T9.35,

).

20. Click OK in the Excel (Column Mode) field "Statistic..." options dialog
(Figure T9.35, ). The Statistic token has now been added as an item to
the Excel (Column Mode) report (Figure T9.34, bottom).
Note: you can also drag and drop gates directly from plots onto the Excel
Batch Action.
21. Deselect the check boxes next to the Export to Powerpoint and Excel
(Cell Mode) batch actions, if these exist on your layout (Figure T9.36).
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Figure T9.36 Deselect Excel (Cell Mode) to Batch Process Only Excel (Column
Mode)

Now we are ready to run the Batch Processing to export to Excel (Column
Mode).
22. Select the Batch tab
T9.10 ).

command (Figure

1460

An Excel (Column Mode) report will appear with the results of the batch
process (Figure T9.37).
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Figure T9.37 Excel (Column Mode) Report

We will now insert the image of a plot from FCS Express onto the Excel
spreadsheet using drag and drop.
23. Drag and drop the border of the histogram on the layout onto an empty
part of the Excel spreadsheet (Figure T9.38).
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Figure T9.38 Dragging and Dropping a Plot Image from FCS Express to an Excel
Spreadsheet

An image of the histogram plot will now appear in the Excel spreadsheet (Figure
T9.39). You can drag and drop items from FCS Express to Word and PowerPoint
in a similar manner.
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Figure T9.39 Excel (Column Mode) Report with a Plot Image Added

40.10.4

Exporting to LabKey

LabKey Software and De Novo Software have worked together to provide direct
export capabilities from FCS Express 6 Flow Cytometry to LabKey Server. The
collaboration will allow high volume flow cytometry users a unique combination
of report generation and analysis with FCS Express and an online data
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environment, extra quality controls, and workflow tools from LabKey Server.
Various items including tokens, pictures, files, and even your entire FCS Express
analysis can be exported to LabKey Server, simply by adding a LabKey Report
as a Batch Process Action.
In this exercise we will:
Download the free LabKey Server to your local computer.
Create a LabKey Server Report with FCS Express Batch Actions 801 .
Add the following items to the LabKey Server Report Batch Actions
o Keyword Tokens 704
o Statistic Tokens 699
o FCS Express Layout (.FEY) file
o .FCS files
o Picture 837 of a 2D plot (JPEG format)

801

:

To export to LabKey Server:
The first step in exporting to LabKey Server is to register and install
LabKey Server to your local machine. If you have already completed this
step, please proceed to step 2.
1. Download LabKey Server to your local computer and register with LabKey
Server by following the directions at https://www.labkey.org/wiki/home/
Documentation/page.view?name=installServerDemo. Alternatively, write
to us at support@denovosoftware.com if you would like to try out this
tutorial using De Novo Software's own LabKey server for public use.
2. Set up an Assay Design in LabKey Server to which you will export FCS
Express data, by following the directions in the LabKey Setup: Folder
and Assay Design/Protocol section of the accompanying LabKey
tutorial.
Now that the LabKey Server is ready to receive your data from FCS
Express, you may proceed to step 3 below to complete the rest of the
tutorial in FCS Express.
3. Select the File tab and click on Open.
4. Open the layout LabKeyServerExportTutorial.fey found in the "LabKey
Server Export" folder within the Tutorial Sample Data archive .
1212

The layout is currently displaying 2D density and dot plots and a histogram
of the file Sample 1.fcs (Figure T9.40). The layout contains a data list
with a total of 7 .fcs files which are also located in the "LabKey Server
Export" folder to be used in the batch export process. The table in the
upper right displays Participant ID and Date Keyword Tokens from the
© 2020 De Novo Software
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sample .fcs in the plots, the number of events in Gate 1 from the 2D
density plot, and the percent of gated events in M1 from the histogram.

Figure T9.40 Example of the LabKeyServerExportTutorial.fey layout

5. Select the Batch
T9.41).

Actions command (Figure
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Figure T9.41 Selecting the Batch Actions command

6. Click on Export to LabKey under the Add Report category of the Batch
Actions window (Figure T9.42).
The Export to LabKey Options dialog box opens (Figure T9.43).
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Figure T9.42 Adding a LabKey Report

7. Type (or copy and paste) the URL generated by LabKey Server into the
LabKey Server URL field (Figure T9.43 ) of the Export to LabKey
Options dialog box. This URL is generated automatically by LabKey Server
and can be found by following the directions in the FCS Express Set Up:
Prepare the FCS Express Report section of the accompanying LabKey
tutorial.
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Figure T9.43 Export to LabKey Options dialog box

8. Type the Protocol ID number into the Protocol ID field of the Export to
LabKey Options dialog box (Figure T9.43 ). The Protocol ID is an
integer generated automatically by LabKey Server and can be found by
following the directions in the FCS Express Set Up: Prepare the FCS
Express Report section of the accompanying LabKey tutorial.
9. Type your name into the Name field of the Export to LabKey Options
dialog box (Figure T9.43 ). This entry will be shown as the "Assay Id" in
the table of Experimental Runs in LabKey Server.
10. Type the email address you used to register with LabKey Server in step 1
into the Username field (Figure T9.43 ).
11. Type the password you used to register with LabKey Server in step 1 into
the Password field (Figure T9.43 ).
12. Click OK to close the dialog window (Figure T9.43
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13. Highlight the Participant ID Token in the second column of the Table in
the Layout (Figure T9.44 ) so that the Token text ("110349") appears
white.
14. Drag and drop the highlighted Token on top of the Export to LabKey
action which has just appeared in the Batch Actions window (Figure
T9.44, red arrow).

Figure T9.44 Dragging and dropping Tokens from the Table into the Batch Actions
Window

15. Repeat steps 13 and 14 for the next three Tokens in the Table (i.e., Date
, Gate 1 events , and Marker 1 % ) (Figure T9.44 , , ).
Note that you can also drag drop the whole table directly on top of the
Export to LabKey action. In this case the file name "Sample 1.fcs" will also be
included in the
list of Export to LabKey items.
16. Double-click on the item Keyword: $PARTICIPANTID for Plot #3,
overlay #1 in the list of Export to LabKey items (Figure T9.45 ).
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Figure T9.45 Export to LabKey Batch Action with Tokens added to Report

The Export To LabKey options window will appear.
17. Click on the Field category on the left (Figure T9.46
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Figure T9.46 Entering text into the XML node field

18. Type the text "PARTICIPANTID" in the XML Node field (Figure T9.46).
The XML Node field ensures that this data is exported to the correct Data
Field in LabKey Server.
19. Click OK.
20. Repeat steps 16-19 for the next three items in the Export list (see bullets
below) but in the XML Node field (step 18) type "DATE", "Events", and
"Percent", respectively. (Figure T9.45 , , ):
Keyword: $DATE for Plot #3, overlay #1
Statistic: # of Events for Plot #3, overlay #1 Additional Gate:
Gate 1
Statistic: % of gated cells for Plot #4, overlay #1, in marker1

21. Click on the Export to LabKey action in the Batch Actions window
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) to highlight it.

Figure T9.47 Adding items to the LabKey Report

22. Click on the Layout icon under the Add Item to Report category of the
Batch Actions window (Figure T9.47 ). Leave the default option in the
Layout category so that the Layout is exported linked to your data files 93 .
23. Click on the Field category on the left of the dialog window which opens
(Figure T9.48).
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Figure T9.48 Entering text into the XML Node field

24. Type "FEY" in the XML Node field and click OK (Figure T9.48).
25. Click on the FCS File icon under the Add Item to Report category of
the Batch Actions window (Figure T9.47 ).
26. Highlight plot 3, "3-Density-Sample1.fcs(SS Lin vs. FS Lin)", under
Select a Plot to specify it as the Data Source for the FCS file to be
exported (Figure T9.49 ).
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27. Click on the Field category on the left of the dialog window (Figure
T9.49 ).
28. Type "FCS" in the XML Node field (Figure T9.50
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Figure T9.50 Entering text into the XML Node field

29. Click OK to close the dialog window (Figure T9.50

).

30. Click on the Picture icon under the Add Item to Report category of the
Batch Actions window (Figure T9.47 ).
31. Select JPEG from the Format drop-down menu at right, in the window
that opens (Figure T9.51 ).
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Figure T9.51 Format and data source options for exported pictures

32. Select plot 4, "4-Histogram - Sample1.fcs(FL8 Log)" under Select a
plot to specify it as the plot to be exported (Figure T9.52 ).
33. Click on the Field category on the left of the dialog window (Figure
T9.51 ).
34. Type "JPEG" in the XML Node field (Figure T9.52
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Figure T9.52 Entering text into the XML Node field

35. Click OK to close the dialog window (Figure T9.52

).

36. Select the
command
(Figure T9.53). FCS Express will now export the items to the LabKey
Server.

Figure T9.53 Running the Batch Process

37. Follow the directions in the View the Exported Data section of the
accompanying LabKey Server tutorial to view the data you have just
exported from FCS Express to LabKey Server.
You have now set up a LabKey Report in the Batch Actions window from
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within FCS Express. You have added Keyword and Statistic Tokens, and files
including an FCS Express Layout, FCS files, and pictures to the LabKey Report.
Please see the accompanying LabKey Server tutorial for more information on
sharing your flow cytometry analysis with your colleagues via LabKey Server.

40.10.5

Snapshots

FCS Express will automatically take Snapshots during Batch Processing.
The tutorial for Batch Processing Snapshots is located in the Snapshots
section and can be found the Batch Processing Snapshots section .

1438
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40.11

Creating and Using Panels

It is very common in the day-to-day work with flow cytometry to use the same
analysis layout to analyze many different data files (for example, CD3-CD4-CD8
determinations in a clinical setting, where this panel of stains is repeated for
different patients, or to test for the expression of the same surface markers
after different treatments). In order to facilitate this type of analysis, FCS
Express has the Panels option. Panels allow you to rapidly change all of the data
on a particular layout to a new set of data.
In order to use the panels feature in FCS Express, you will first set up the number
of tubes that you are working with, and then create the plots and other elements
on the layout. Once that is done, you will be able to load another set of data with
just a few mouse clicks.
You can also set up a panel

858

after the layout has already been created.

In the first section, we will set up the panel

40.11.1
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.

Setting Up the Panel

In the course of this example, we will:
Learn how to set up a panel.
Learn how to set up a file list with the experimental files to be analyzed.

In this tutorial we will be analyzing 2 samples, each comprised of a set of 2
tubes. The panel will consist of the tubes that comprise the "set", which will
repeat itself.
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We will begin by defining the panel and then setting up the data list.
1. Open a new, blank layout.
2. Select the
T10.1). Alternatively, select the
command.

command (Figure

Figure T10.1 Selecting the
Panels Command

The Panel Information dialog appears as shown in Figure T10.2.

Figure T10.2 Panel Information Dialog

3. Click the Add button (Figure T10.2).
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The Add Panel dialog will appear as shown in Figure T10.3A.
4. Enter "My Panel" in the Panel Name field.
5. Click on the upward triangle in the Number of Tubes spin control until it
reaches 2. The dialog should now look like Figure T10.3B.
6. In the Name column, name Tube #1 "T Cell markers" and Tube #2 "B Cell
markers" The dialog should now look like Figure T10.3C.
7. Click OK to close the Add Panel dialog.

Figure T10.3 Setting up a Panel using the
Add Panel Dialog

The Panel Information dialog will now appear updated with the newly added
panel information, as shown in Figure T10.4.
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Figure T10.4 Updated Panel Information
Dialog

8. Click OK to close the Panel Information dialog (Figure T10.4).
The next step consists of using the Data List to set up a list of the files we want
to analyze using the panel.
9. Select the
T10.5). Alternatively, select the
command.

command (Figure

Figure T10.5 Selecting the Data
List Command

A Data List window opens as shown in Figure T10.6.
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Figure T10.6 Data List Window

10. Click the Add

button on top of the Data List window to add files.

The Select a Data File dialog opens (Figure T10.7).
11. Navigate to where the Tutorial Sample Data folder is located.
12. Select the 4 files named Normal2_Tube1, Normal2_Tube2,
Normal3_Tube1 and Normal3_Tube2 as shown in Figure T10.7. (To
select multiple files at once, Ctrl + click each file or click on the first file,
Normal2_Tube1, press and hold the Shift key on the keyboard, and then
click on the last file, Normal3_Tube2.)
13. Click Open (Figure T10.7).
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Figure T10.7 Selecting Data Files to insert into the Data List.

The Data List window now lists the data files selected, each with its Iteration
number, Tube from the panel, and File Name displayed. The Data List should
appear as shown in Figure T10.8.
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Figure T10.8 Updated Data List with
Corresponding Tubes for the Panel

As shown in Figure T10.8, the Data List window shows the tubes from the panel
you created in the left column, and the files you added in the right column. This
greatly helps to organize your files into the corresponding tubes for further
analysis. To further aid organizing the data files, FCS Express allows you to add
keywords from the FCS file to the information displayed in the Data List.
Keywords that are descriptive indicators of sample identification can be added to
the Data List to easily identify which data files corresponds to each entry in the
Data List. There are many keywords that can be used to help identify the data
files within the Data List. In this tutorial, we will add the keyword $SRC to the
Data List.
14. Click on a sample in the Data List to highlight it.
15. Click on the Format button shown at the top of the Data List in Figure
T10.8.
The Format File List dialog appears, as shown in Figure T10.9.
16. Select Add from the Format Data List dialog.
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Figure T10.9 Format File List Dialog

The Please select one or more keywords dialog appears, as shown in Figure
T10.10. This is where we will select the keyword $SRC to display in the Data
List.
17. Click on the down arrow to scroll down to the bottom of the list.
18. Click on $SRC, highlighted in Figure T10.10. If you want to display more
than one keyword, you can select multiple adjacent keywords by holding
down the Shift key on the keyboard or by selecting multiple non-adjacent
keywords by holding down the Ctrl key while clicking on each keyword.
For this example, we will only select $SRC.
19. Click OK (Figure T10.10).
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Figure T10.10 Selecting an FCS Keyword to use in the Data List

The Format File List dialog will be updated with $SRC in the Selected
Keywords field, as shown in Figure T10.12. The Data List can also be formatted
to display your data in Groups.
20. Select OK on the Format File List dialog.
The Data List dialog will now appear updated showing the grouping of the data
files, the file name without the full path and with the column $SRC, as shown in
Figure T10.13.
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Figure T10.13 Data List Window Updated with Groups,
File Names and $SRC Column.

You can use the icons at the top of the Data List dialog, (Figure T10.13) to
manipulate the data files in the list.
As previously demonstrated, you can add more files to the Data list by selecting
the Add button

and you can format the list to include FCS keywords by

selecting the Format button

. To move a file up or down in the Data List

select the data file and then select the Up

or Down

arrows. To change a

file, select the Change File button
, and to search for a file select the Search
button
. To delete a file from the list, select the file, and then select the Delete
button

.

In a previous version, FCS Express 4, any changes made to the order of the
tubes in the Data List would automatically change in which plots those data files
were being viewed as they are being moved. If your files are large, it could take
some time for your layout to refresh as each tube is moved up or down the
Data List.
However, in FCS Express 6, the user can now defer those changes until the files
have been moved and placed in the required order. By clicking the Defer Layout
Changes icon
, the user can makes changes to the order of tubes, then,
deselect the icon and the data would automatically refresh in the analysis layout.
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We will now proceed to creating the layout
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Creating the Layout

In the course of this example, we will:
Create a layout to use for our panel.
We will now proceed to create a layout for the analysis of our experiment using
the panel we created. We will be using plots and gates. Please refer to previous
tutorials for more information on inserting plots , formatting plots , and using
gates .
1226
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Using the layout we started in the previous section, Setting Up the Panel
will create four plots for our first set of samples.

1513

, we

1. Open the Data List window, if it is not already open.
2. Select the first two files from the list (click on the first file, hold down the
Shift key and click on the second file).
3. Drag the selected files outside of the Data List dialog.
4. Release the mouse button to drop the files onto a blank place on the
layout.
The Select Plot Types… dialog will now appear, as shown in Figure T10.14.
5. Check the Color Dot option and uncheck all other plot types.
6. Check the Use this selection for all files option.
7. Click OK (Figure T10.14).
8. Note that now in Version 5, FCS Express can remember your selection
and use this selection as the default plot type for this layout when creating
new plots by dragging and dropping from the Data List.
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Figure T10.14 Select Plot Types... Dialog

Two color dot plots, using the first two data files selected in the Data List, are
now created on the layout. We now need to arrange them in a column on the
left side of the layout.
8. Select the plots by holding down the Ctrl button on the keyboard and
clicking on each one. It maybe necessary to move the density plot to be
able to individually select each plot. Alternatively, click and hold the mouse
button down and drag a box that encompasses all four plots, or select
the
command.
9. From
, select the Align command (Figure
T10.15). This tool will help align and distribute your object by arranging
them according to the first object that was selected while holding the Ctrl
key.
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Figure T10.15 Aligning Plots

The Alignment window similar to Figure T10.16 will appear.
10. Under the Horizontal column, select Left Sides. Under the Vertical
Column, select No Change.
11. Click OK.
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Figure T10.16 Aligning Plots on the Left Side

12. Select the plots. Right click on them and select Duplicate. (Figure
T10.17).
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Figure T10.17 Duplicating Plots

The duplicated plots will appear. (Figure T10.18).
13. Rearrange the duplicated plots by placing them to the right of the original
plots.
14. Use the Align tool, if needed.
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Figure T10.18 Duplicated Plots

The page of the layout should now appear similar to Figure T10.19. For more
information on manipulating objects in FCS Express please refer to the tutorial
on Using Objects .
1215
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Figure T10.19 Plots Arranged on Page

We will now adjust the X and Y axis parameters 283 , create gates 318 , create
statistics 379 and create a 1D histogram
to which we will add an overlay 267 .
1229

16. On the 1st plot in the upper left corner, click on the X axis and choose V500-A. Click on the Y axis and choose SSC-A.
17. On the 2nd plot in the upper right corner, click on the X axis and choose
V450-A. Click on the Y axis and choose PerCP-Cy5-5-A.
18. For the 3rd plot, in the lower left, set the X axis to APC-H7-A and the Y
axis to V450-A.
19. For the 4th plot in the lower right, set the X axis to APC-A and the Y axis
to PE-A.
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20. The layout should similar to Figure T10.20.

Figure T10.20 Plots with X and Y axis set to Parameters

21. We will also format the titles of the plot to include the Current Gate for
that plot.
22. Select all plots by selecting Select All from the Home tab or by clicking
Ctrl+A.
23. From the Format tab, select Titles. If you are using Default preferences,
most likely the keyword <$FCSE_FILENAMENOPATH> will already be
entered as a Title. Position your cursor after <$FCSE_FILENAMENOPATH>
and click on Insert Keyword. Select Current Gate from the dropdown
menu, as seen in Figure T10.21. Click OK.
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Figure T10.21 - Before and After Adding Current Gate to the Plot Title

24.We will now create gates 318 . On the SSC/V500-A plot, we will create a
polygon gate around the lymphs. From the Gating tab, select Polygon and
create a gate around the lymphs. Name the gate Lymphs, as seen in
Figure T10.21.

Figure T10.21 - Creating a Lymphs gate

25. We will apply the Lymphs gate to the 2nd plot in the upper right by
dragging and dropping the Lymphs gate on top of the 2nd plot. The
Before and After can be see in Figure T10.22.

© 2020 De Novo Software

1532

FCS Express 6 Manual

Figure T10.22 - Before and After Dragging and Dropping the Lymphs Gate

26. Select the 2 plots at the bottom of the page. From the Gating tab,
select Lymphs from the Current Gate drop down menu, as seen in
Figure T10.23.
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Figure T10.23 - Selecting Lymphs from the Current Gate Drop Down Menu

27. In the 3rd plot in the lower left, create a Rectangle gate around the
cluster of cells that are APC-H7/V450 dual positive. Name the gate Cells
of Interest.
28. Apply the Cells of Interest gate to the 4th plot in the lower right by
dragging and dropping the gate on top of it.
29. Edit the Gates to Display in the top 2 plots by selecting them, then
selecting from the Format tab, Gates to Display.
30. Under Gate Options, choose Only the gates checked below. Choose
Lymphs.
31. For the question When a new gate is created on the layout, should
the gate color be displayed?, select the option Only if the gate was
create on a plot showing the same data file as this plot, as seen in
Figure T10.24. Click OK.
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Figure T10.24 - Editing the Gates to Display

32. Your layout should look similar to Figure T10.25.
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Figure T10.25

33. We will now add Quadrants to the upper right and lower right plots. From
the Gating tab, click on Quadrants, then click on the V450 vs
PerCPCy5.5 plot. Quadrants can be moved by clicking on the center point
of the quadrant and then moving the quadrant to the desired position.
34. Repeat step 33 for the APC vs PE plot.
35. Your layout should appear as in Figure T10.26.
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Figure T10.26

36. Now we will add quadrant statistics for the 2 plots that contain quadrants.
37. On the V450 vs PerCPCy5.5 plot, right click and select
Statistics>Quadrant Statistics. Right click on the statistics grid and deselect everything but the columns Gate, # of Events, % of Gated Cells
and % of All Cells, as seen in Figure T10.27.
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Figure T10.27 - Formatting Statistics

38. From the right click menu, you can also choose Format>Stats
the columns to be viewed.

387

39. Repeat steps 36&37 for the APC vs PE plot.
40. You can also edit
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to edit
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changes, so each element does not need to edited manually.
41. We will now add another page and add a 1D histogram to this page.
42. From the Insert tab, select New Page. We can also add a new page by
selecting the "+" sign next to the Page 1 tab at the bottom of the layout.
43. On Page 2, drag and drop the 2nd tube from the Data List.
44. Select Histogram. Click OK.
45. Change the X axis to PE-A and change the Current Gate to Lymphs.
46. Right click on the histogram and select Add Overlay using Advanced
Open Data Dialog, as seen in Figure T10.28.

Figure T10.28 - Adding an Overlay

47. In the Advanced Open Data File window, select the Data List tab and
choose the 2nd tube. Click Open, as seen in Figure T10.29.
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Figure T10.29 - Selecting a Data File for Overlay

48. In the Add Overlay window, in the Parameter section, select APC-A. If
not already chosen, select the Lymphs gate, as seen in Figure T10.30.
Click OK.

Figure T10.30 - Adding the Overlay
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49. Your histogram should look similar to Figure T10.31.

Figure T10.31 - Histogram with Overlay

50. At this point, we will save the layout. From the File tab, select Save As.
Once you have chosen a location where you can save your layout,
choose Unlinked from the Data Link Style section, as seen in Figure
T10.32. This will save your layout as empty template. Click Save.
51. Close the layout.

In the next section, we will use the panel

40.11.3
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Using the Panel

In the course of this example, we will:
Load new data into the layout we just created.
Use the panel to analyze the other similar samples.
Extend the layout easily using the panel set up in the previous steps.

1. Open the layout that you created in the previous lesson, Creating the
Layout .
1523

2. Open the Data List

209

window, if it is not already open.

3. Click on the blue "+" sign in the Data List toolbar to add data files to be
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analyzed.
4. Navigate to the tutorial sample folder and select file Normal2_Tube1.
Make sure the Files of type is set to FCS files. Select Open.

Figure T10.32 Selecting Panel Data for the Data List

5. Since the Panel that was created for this layout was defined as a 2-tube
panel, FCS Express will prompt you to whether or not you would also like
to add the next tube to the Data List to complete the 2-tube panel, as
seen in Figure T10.33.
6. Click Yes.
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Figure T10.33 - Automatically Add Data File to Data List

7. FCS Express will load the 2 tubes, Normal2_Tube1 and Normal2_Tube2
into the Data List. FCS Express will also automatically populate all the
plots in the layout with the appropriate data files that were assigned to
each plot during the creation of the layout, including the histogram that
contains the overlay on Page 2.
8. To analyze another sample that fits the Panel criteria, click on the green
"+" sign in the Data List toolbar.
9. Navigate to the tutorial sample folder and, while holding the Ctrl key,
select files Normal3_Tube1 and Normal3_Tube2.
10.Because you have selected 2 tubes, FCS Express will not prompt whether
you would like to automatically add the next data files to the Data List.
Also, the same would hold true if all 4 data files were selected for addition
to the Data List.
11.After adding the 4 data files, the Data List should look like Figure T10.34.

© 2020 De Novo Software

Tutorials

1543

Figure T10.34 - Data List Containing More Than One Panel
Iteration

12.Keep the Data List open. Feel free to dock
and pin the Data List. Later
on, we will discuss how we can rearrange data files within the Data List.
1552

Advancing Through Panel Iterations in the Data List
13.To advance from one iteration to another iteration to be analyzed, use
the Next button, which can be found under Data>Change Data On All
Objects, as seen in Figure T10.35.

Figure T10.35 - Change Data on All

14.Also, to navigate through your data, select the Iteration number from
the drop down menu, as seen in Figure T10.36.

Figure T10.36 - Navigating by Using the
Iteration Dropdown Menu

15.The number of iterations available will match the number of iterations seen
in the Data List, as seen in Figure T10.34.
16.Also, to navigate between iterations within the Data List, you can select
the Iteration within the Data List, as seen in Figure T10.37.
17.The iteration that is currently displayed within the plots of the layout will be
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highlighted within the Data List.
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Rearranging Data Files within the Data List
18.For the tubes that comprise the Panel to be correctly displayed in their
properly assigned plots, the order of the tubes within the Data List is
critical.
19.If tubes are in the incorrect order, the tubes can be moved up or down the
Data List by select the tube, then clicking the Up or Down arrow within the
Data List toolbar until the tube is in its proper order.
20.In Figure T10.38, the tubes of the 1st iteration are in the wrong order. As
a result, incorrect data is being displayed in the incorrect plots.

© 2020 De Novo Software

Tutorials

1547

Figure T10.38 - Incorrect Order Of Tubes Within the Data List. Notice How Tube
2 is Ahead of Tube 1.

21.By selecting a tube of the 1st iteration, we can correct this by moving the
tube using the Up and Down arrows, as seen in Figure T10.38.
22.As the tubes are moved, the data will refresh and recalculate within the
layout in real time, as seen in Figure T10.39.
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Figure T10.39 - Corrected Tube Order in Data List

23.However, if the files are large, there may be a noticeable delay in the
refresh time as the tubes are moved within the Data List.
24.Users can defer the layout changes by selecting the Defer Layout Changes
button

in the Data List toolbar.

25.As seen in Figure T10.40, users can:
a. Select Defer Layout Changes

.
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b. Select the file to be moved
c. Click the Up or Down arrow
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.
.

d. After all the changes have been made, click the green check mark

.

Figure T10.40 - Deferring Layout Changes - Before and After

26.After clicking the green check mark, the changes will take effect.
Adding plots to the layout
27.After a Panel has been added to a layout, the layout can be easily edited.
28.On Page 1, select the following plots while holding the Ctrl key:
a. V450 vs PerCP Cy5.5
b. APC-H7 vs V450
c. APC vs PE
29.Right click on the selected plots and choose Copy. Also, the keyboard
shortcut Ctrl+C will work.
30.Go to Page 2. Right click on the Page and select Paste. Also, the
keyboard shortcut Ctrl+V will work.
31.Rearrange the plots around the 1D histogram with the overlay.
32.Change the parameters for these pasted plots to any pairing desired.
33.Add a Quadrant to the plot that was previously the APC-H7 vs V450 plot.
34.Save your layout by choosing File tab>Save, or by clicking the Save
button
in the layout toolbar at the top of your computer screen.

Finally, we will see examples of saving and loading panels
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40.11.4

Saving and Loading Panels

In the course of this example, we will:
Work with the layout that was created in Creating the Layout

1523

.

Learn how to save and load panels for future use.

We will now proceed to save and load the panel we created for future use.
1. Select the
select the

command. Alternatively,
command.

The Panel Information dialog appears with My Panel listed and marked as
active, as shown in Figure T10.41.
2. Click the Save button on the Panel Information dialog.

Figure T10.41 - Saving a Panel

The Save As dialog appears.
3. Navigate to the Tutorial Sample Data folder and enter "My Panel" in the
File Name field.
4. Click Save on the Save As dialog.
We have now saved My Panel. We will now save the current layout, and then
load the saved panel into a new layout.
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5. Click on Cancel to close the Panel Information dialog.
6. Select the File tab
, to save the current layout. Alternatively, select
the Save icon located in the Quick Access Toolbar 65 .
If you have not previously saved the layout then the Save Layout dialog
appears.
7. Navigate to the Sample Data folder and enter "Panel Demo Layout" in
the File Name field.
8. Click Save on the Save Layout dialog.
9. Select the File tab

, to open a new blank layout.

A new blank layout will now appear.
10. Select the
select the

command. Alternatively,
command.

The Panel Information dialog will now appear and it will be empty.
11. Click the Load button on the Panel Information dialog, as seen in Figure
T10.42.

Figure T10.42 - Loading a Panel

The Open dialog will now appear.
12. Navigate to the Sample Data folder and select the
"MyPanel.PanelInfo" file.
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13. Click Open.
The Panel Information dialog will now show My Panel. Saving a panel allows
you to avoid having to redefine a panel over and again for every new layout you
create.
14. Click on OK to activate My Panel and close the dialog.
My Panel is now active on this layout and you could choose to create a new
layout of plots to analyze with this panel.

40.12

Docking

Many of the functional windows within FCS Express are dockable. This means
that they can be embedded within the layout and becoming a more permanent
fixture within the layout. Docked windows can also be Pinned, which enables an
Auto Hide feature for that docked window.
The docking feature allows you to place any of the Navigator windows (Layout,
Data and Gate), the Token windows (Custom Token, Canned Comments, and
Alerts), and the Data List window, onto the layout and then "dock" the window,
or windows, to a specific fixed location on the outside of the layout page.
Docking has many powerful features which we will explore in this tutorial.
Note: We are going to open a lot of interesting Navigators in this tutorial, but will
only focus on the docking functionality. For more information on how these
Navigators work, please see the tutorials on the Layout Navigator , Data
Navigator , and Gate Navigator .
1612
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In the course of this example, we will:
Learn how to dock a window.
Learn how to use the many docking features.
Learn how to use docking features with multiple windows.
Learn how to undock a window.

To Dock a window:
1. Select File tab

.

2. Open the layout Docking.fey found in the FCS Express Sample Data
folder.
The following layout will appear, shown in Figure T11.1. This layout may look
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familiar as a similar layout was used in the Tokens tutorial.

Figure T11.1 Docking Layout

3. Select the
T11.2).

command (Figure

Figure T11.2 Selecting the Gate Navigator Command
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The Gate Navigator window will appear on the layout. When dockable windows
are first opened, they always appear in the "floating" state. This means that they
can be moved anywhere you like, even outside the layout itself. We will now
dock the Gate Navigator window to the left side of the layout.
4. Place the mouse on the top border of the Gate Navigator window.
5. Press and hold the left mouse button.
Continue to hold the left mouse button and move the Gate Navigator window.
As soon as you start moving the Gate Navigator window, an icon with four
outward facing arrows will appear in the center of the layout, as shown in Figure
T11.3; this is a docking icon. The docking icon, allows you to choose the docking
location for the Gate Navigator (or any other dockable window). As you drag
the window and the cursor moves over each of the four arrows of the docking
icon, a blue rectangular area will appear to indicate the proposed position on the
layout where the window will be docked. However, you cannot dock a window
directly on the layout page itself, but rather to the sides of the layout page.
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Figure T11.3 Docking Icon in the Center of the Layout

Continue to hold down the mouse button and drag the Gate Navigator towards
the central docking icon.
6. Move the Gate Navigator towards the right arrow of the docking arrow.
7. Continue to hold down the mouse button and place the cursor over the
right arrow, indicated by the red circle in Figure T11.4A.
When the cursor is over the right arrow of the docking icon, a blue rectangular
window appears on the right side of the layout indicating the proposed docking
location for the window, as shown in Figure T11.4A.
8. Continue to hold down the mouse button and Repeat steps 7 and 8, but
place the cursor over the bottom docking arrow, indicated by the red
arrow in Figure T11.4B.
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Again, a blue rectangle appears at the proposed docking location at the bottom
under the page (Figure T11.4B).
9. Continue to hold down the mouse button but place the cursor over the
left docking arrow, indicated by the red arrow in Figure T11.4C.
10. Release the mouse button when the cursor is over the left arrow of the
docking icon, as indicated by the red circle in Figure T11.4C.
Again, a blue rectangle appears at the proposed docking location to the left of
the page (Figure T11.4C).

Figure T11.4A Gate Navigator -- Cursor on the Right Arrow of the Docking Icon
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Figure T11.4B Gate Navigator -- Cursor on the Bottom Arrow of the Docking Icon

© 2020 De Novo Software

1558

FCS Express 6 Manual

Figure T11.4C Gate Navigator -- Cursor on the Left Arrow of the Docking Icon

The Gate Navigator is now docked on the left side of the layout as shown in
Figure T11.5.

Figure T11.5 Gate Navigator Docked on the Left Side of the Layout

© 2020 De Novo Software

Tutorials

In the next section, we will learn the features of a docked window
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Features of a Docked Window

Once a window is docked it can be resized, undocked, redocked to a new
location, and you can Auto Hide it. Note that when a layout is saved, the
corresponding docking configuration is also saved with the layout, so that it will
be reloaded when you load the layout. We will now explore the various features
of a docked window.
1. Place the cursor on the top border of the docked Gate Navigator.
2. Press the left mouse button and continue to hold it while dragging the
Gate Navigator to a new location on the layout.
As you move the Gate Navigator on the layout docking icon arrows appear on
the four outer sides of the layout, indicated by the red circles in Figure T11.6. If
you continue to move the Gate Navigator towards the middle of the layout the
central docking icon will re-appear, as previously shown in Figure T11.3 .
1552

Figure T11.6 Four Outer Docking Icon Arrows Circled in Red

3. Continue to hold down the mouse button and move the Gate Navigator
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towards the bottom docking arrow.
4. Release the mouse button when the cursor is on top of the bottom
docking arrow, as indicated by the red circle in Figure T11.7.
Notice that a blue rectangle appears at the bottom of the layout, again to
indicate the proposed docking location for the window.

Figure T11.7 Bottom Docking Icon Arrow

The Gate Navigator is now docked at the bottom of the layout, as shown in
Figure T11.8. However, the current size of the docked Navigator is too large and
covers part of the plots on the layout. We will now resize the docked window to
a more appropriate size.
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Figure T11.8 Gate Navigator Docked at the Bottom of the Layout

5. Place the cursor over the top border of the docked Gate Navigator.
6. Move the cursor slightly until it changes to a resizing icon (two horizontal
lines with an arrow on either side of the lines facing outward), indicated by
the red circle in Figure T11.8.
7. Press the left mouse button and continue to hold it while dragging the
border of the Gate Navigator down.
8. Release the mouse button when the docked Gate Navigator is no longer
covering the plots on the layout.
Rather than resize the docked Navigator, we could use the Auto Hide feature.
Auto Hide allows the window to remain docked, but hidden, except for a visible
tab with the name of the docked window on it. When the cursor is placed on the
tab the docked window re-appears and remains visible as long as the cursor
remains on the docked window. If the cursor is moved off the docked window
then the window is again hidden.
9. Click on the Auto Hide icon from the upper right corner of the docked
Gate Navigator, indicated by the cursor in Figure T11.9.

Figure T11.9 Auto
Hide Icon

© 2020 De Novo Software

1562

FCS Express 6 Manual

10. Move the cursor off the docked Gate Navigator.
The docked Gate Navigator is now hidden on the layout, except for a tab on
the bottom of the layout, indicated by a red circle in Figure T11.10.

Figure T11.10 Gate Navigator Hidden using the Auto Hide Feature

11. Move the cursor over the Gate Navigator tab, indicated by the red circle
in Figure T11.10.
The docked Gate Navigator will now reappear. We will now remove the Auto
Hide feature so that the Gate Navigator will remain visible.
12. Click on the Auto Hide icon located in the upper right corner of the
docked Gate Navigator, indicated by the cursor in Figure T11.11, to
remove the Auto Hide feature from the docked window.
Note that the Auto Hide icon has changed from its original design, shown in
Figure T11.9, to the design shown in Figure T11.11. The Auto Hide design,
shown is Figure T11.11, indicates that the Auto Hide feature is on. However
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after clicking on the Auto Hide icon it will go back to the original design, shown in
Figure T11.9, which indicates that the Auto Hide feature is off. The Gate
Navigator is now visible, docked at the bottom of the layout.

Figure T11.11
Removing
Auto Hide

In the next section, we will continue using the Docking.fey layout and cover
docking features with multiple windows docked .
1563

40.12.2

Docking Features (Multiple Windows)

We will now open more Navigators and the Custom Tokens window, and dock
them to demonstrate the features of docking with multiple windows. Please refer
to the beginning of this tutorial for details on docking.
1. Select the

command.

The Data Navigator window will appear on the layout.
2. Dock the Data Navigator window to the left of the layout.
The layout now has two windows docked, Gate Navigator on the bottom and
Data Navigator on the left, as shown in Figure T11.12.
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Figure T11.12 Layout with Gate Navigator and Data Navigator Docked

3. Select the

command.

The Layout Navigator appears on the layout. We will now dock the Layout
Navigator to the left side of the layout.
4. Drag the Layout Navigator toward the left side of the layout.
When you first start to drag the Layout Navigator, the four-headed arrow and
the single arrow docking icons, appear at all the possible docking locations
(Figure T11.13). The four-headed arrows are indicated by red circles, and the
single arrows by blue circles in Figure T11.13. Once you begin moving the
Layout Navigator, the docking icons fade away and the only docking icons
visible are those that indicate the current docking site. The four-headed arrow
docking icon will only appear within a specific docking site and indicates the
possible docking locations at that site. The single docking arrows, indicated by
the blue circles in Figure T11.13, always appear to the left, bottom, right, and
top of the layout page and indicate that these docking sites are always available.
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Figure T11.13 Initial Docking Icons

As you move the Layout Navigator towards the left side of the layout, the
four-headed arrow docking icon appears at the left docking site, indicated by the
red circle in Figure T11.14. The four-headed arrow docking icon indicates the
possible docking locations for the Layout Navigator. The single docking arrow
on the far left indicates that the window can be docked all the way to the left of
the currently docked Data Navigator.
5. Continue to hold down the left mouse button and drag the Layout
Navigator towards the docking icon with the four arrows on the left side
of the layout, circled in red in Figure T11.14.
6. Release the mouse button when the Layout Navigator is over the right
arrow, indicated by the blue circle in Figure T11.14.
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Figure T11.14 Docking Layout Navigator

The Layout Navigator is now docked to the right of the Data Navigator, on
the left side of the layout, as shown by Figure T11.15. Note that it was docked
inside the previous Data Navigator, i.e., both new docked windows take up the
same amount of space as the Data Navigator did.
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Figure T11.15 Layout Navigator Docked to Right of the Data Navigator

Note that the windows docked on the layout are highlighted on the ribbon
(Figure 15). We will now dock the Custom Tokens window on the layout.
However, this time we will dock it on top of the Layout Navigator.
7. Select the

command.

The Custom Tokens window appears on the layout.
8. Drag the Custom Tokens towards the left side of the layout.
9. Continue to hold down the left mouse button and drag the Custom
Tokens window towards the middle of the docked Layout Navigator.
When the Custom Tokens is on top of the Layout Navigator the four-headed
arrows docking icon appears (Figure T11.16).
10. Release the mouse button when the cursor is on top of the central area
of the docking icon on top of Layout Navigator, indicated by the cursor in
Figure T11.16.
You will know you are in the correct place because the blue rectangle indicates
the proposed docking location.
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Figure T11.16 Docking Custom Tokens on top of the Layout Navigator

The Custom Tokens window is now docked on the left side of the layout, on
top of the Layout Navigator, as shown in Figure T11.17. Notice that at the
bottom of the docked Custom Tokens window there is a tab labeled Custom
Tokens. However, we want to see the tabs for both docked windows so we will
now resize the docked windows to make them larger.
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Figure T11.17 Custom Tokens Docked
on top of the Layout Navigator
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11. Place the mouse over the outer right border of the docked Custom
Tokens.
12. Move the mouse slightly over the border until the resizing icon appears,
indicated by the red square in Figure T11.17.
13. Press and hold down the left mouse button and continue to hold it while
dragging the border to the right.
14. Release the mouse button when the docked window is large enough to
show the tabs for both Custom Tokens and Layout Navigator at the
bottom (Figure T11.18).
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Figure T11.18 Custom Tokens and Layout Navigator Tabs

We will now explore the benefits of using Auto Hide when multiple windows are
docked in one location.
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15. Select the docked Data Navigator.
16. Drag the Data Navigator and dock it on top of Custom Tokens.
The Data Navigator is now docked on top of both Custom Tokens and
Layout Navigator, as shown in Figure T11.19. If you can’t see all three tabs,
then resize the docked windows to make them wider.
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Figure T11.19 Data Navigator Docked
on top of Custom Tokens and Layout
Navigator

17. Click on the Auto Hide icon in the upper right corner of Data Navigator,
previously shown in Figure T11.9 .
1559
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18. Move the cursor off the docked Data Navigator.
The Auto Hide feature is now applied to all three docked windows, and only the
tabs for the docked windows are visible, as shown in Figure T11.20. To see a
docked window, move the cursor over the respective tab of the window you
wish to see.

Figure T11.20
Docked Windows
using Auto Hide
Feature

In the last section, we will undock a window

40.12.3
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.

Undocking a Window

To undock a window:

1. Place the cursor on the top border of the docked Gate Navigator, which
is docked on the bottom of the layout.
2. Press and hold the left mouse button while dragging the Gate Navigator
up and away from its current docked location.
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3. Release the mouse button when the Gate Navigator is at the desired
location. Be sure the cursor is not on any of the docking icons.
To undock the docked windows that are using Auto Hide, we need to first turn
off the Auto Hide feature; there are two ways of doing this.
4. Move the cursor over the Data Navigator tab to make the docked Data
Navigator visible.
5. Click on the Auto Hide icon in the upper right corner of the docked Data
Navigator, as previously shown in Figure T11.11 , to turn off the Auto
Hide feature. Alternatively,
1559

Place the cursor on the top border of the docked Data Navigator.
Right-click to bring up the associated pop-up menu.
Deselect Auto Hide from the pop-up menu, indicated by the cursor in
Figure T11.21.

Figure T11.21 Removing Auto Hide using
the Pop-up Menu

The Auto Hide feature has now been turned off for all three docked windows,
and they can now be undocked.
6. Right-click on the top border of the docked Data Navigator to bring up
the associated pop-up menu.
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7. Select Undock from the pop-up menu.
Alternatively, the docked windows can be undocked by dragging and dropping
them back onto the layout as previously shown.

40.13

Data Navigator

The Data Navigator is designed to give you a useful overview of all the data
files used in the entire layout. It shows you a hierarchical view of all the data, as
all the plots using that data. The Data Navigator also allows you to manipulate
the data and plots on the layout. For example, by simply dragging and dropping
the data icon on the Data Navigator you can replace or overlay the data on a
plot.
In the course of this example, we will:
Open and dock the Data Navigator.
Learn about the Data Navigator features and how to use them.
Specifically we will use the Data Navigator to:
o

Explore the use of the thumbnail image of a plot associated with a
data file.

o

Insert new data onto a plot.

o

Add an overlay to a histogram.

o

Insert a new plot onto the layout.

In the first exercise, we will open and dock the Data Navigator

40.13.1
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.

Opening and Docking

To begin, we will open a saved layout that already has plots and gates on two
pages.
1. Select File tab

.

2. Open the layout DataNavigator.fey found in the Tutorial Sample Data
archive .
1212

The first page of the layout appears, as shown in Figure T12.1.
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Figure T12.1 Page 1 of the Data Navigator Layout (DataNavigator.fey)

We will now open the Data Navigator.
3. Select the
T12.2).

command (Figure

Figure T12.2 Selecting the Data Navigator Command

The Data Navigator appears, as shown in Figure T12.3. Right click within the
Data Navigator and select Expand All or click on the "+" sign next to each file to
expand the view. Under each file, you will see a list of plots that are currently
showing data from that file.
We will now dock it to the left side of the layout. For more information on
docking, please refer to the Docking tutorial .
1552
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Figure T12.3 Data Navigator

4. Place the mouse on the top border of the Data Navigator window.
5. Press and hold the left mouse button and move the Data Navigator
window.
As soon as you start moving the Data Navigator window the four-headed
arrows of the docking icon appears in the center of the layout, as shown in
Figure T12.4.
6. Continue to hold the mouse button and move the Data Navigator toward
the left arrow of the docking icon.
7. Release the mouse button when the cursor is over the left arrow of the
docking icon, indicated by the cursor in Figure T12.4. You will know you
are in the correct place because the blue rectangle, indicating the proposed
docking location, will appear on the left side of the layout.
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Figure T12.4 Docking the Data Navigator to the Left Side

The Data Navigator is now docked on the left side of the layout. However, all
the text might not be visible so we will now resize the docked window it to
make it wider.
8. Place the mouse over the outer right border of the docked Data
Navigator.
9. Move the mouse slightly over the border until the resizing icon appears,
indicated by the red square in Figure T12.5.
10. Press and hold down the left mouse button and continue to hold it while
dragging the border to the right.
11. Release the mouse button when the docked window is large enough to
show all the text of the Data Navigator, as shown in Figure T12.6.
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Figure T12.5 Resizing the Data Navigator

The docked Data Navigator should appear similar to Figure T12.6.
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Figure T12.6 Docked Data Navigator

In the next section, we will explore the features of the Data Navigator

40.13.2

1581

.

Data Navigator Features

As shown in Figure T12.6 , the Data Navigator is organized by the data files in
the layout. Under each data filename, is the list of the plots which are using that
data file. We will now explore the many features of the Data Navigator.
1576

1. Hover the mouse over the 9 - Density – TCellSample3.fcs
compensated (APC-Cy7-A vs PE-Cy7-A), under the data file listing for
TCellSample3.fcs, within the Data Navigator, as indicated by the cursor
in Figure T12.7.
A thumbnail image of the actual 2D plot will appear, as shown in Figure T12.7.
This is a helpful quick reminder of which plot is associated with a data file,
particularly if that plot is not currently visible. This feature applies to any of the
plots listed in the Data Navigator.
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Figure T12.7 Thumbnail Image of a 2D Plot on the
Data Navigator

We will now use the Data Navigator to change the data displayed in a 2D plot.
We will replace the TCellSample1.fcs data in the 1D plot in the lower right of the
layout with the TCellSample2.fcs data using just the Data Navigator.
2. Place the cursor over data file TCellSample2.fcs in the Data Navigator,
highlighted in blue in Figure T12.8.
3. Press and hold the left mouse button.
4. Drag the TCellSample2.fcs data file up to the plot listing 7 – Histogram
– TCellSample1.fcs compensated (FITC-A), indicated by the cursor
and highlighted in blue in Figure T12.8.
5. Release the mouse button when the TCellSample2.fcs data file is on top
of the listing 7 – Histogram – TCellSample1.fcs compensated (FITCA).
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Figure T12.8 Dragging TCellSample2.fcs data file onto a
1D plot in the Data Navigator

The Select Drag and Drop Action dialog appears, as shown in Figure T12.9.
6. Select replace the existing overlays in the plot (Figure T12.9).
7. Click OK.

Figure T12.9 Select Drag and Drop Action Dialog

The 1D histogram in the lower right of the layout is now selected and updates to
reflect the TCellSample2.fcs data, outlined in green in Figure T12.10.
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Figure T12.10 Selected and Updated 1D Histogram with TCellSample2.fcs Data

The Data Navigator is also updated to reflect the changes, as shown in Figure
T12.11. The plot 7 – Histogram – TCellSample2.fcs compensated (FITC-A)
appears under the TCellSample2.fcs data file listing, as indicated by the cursor
and the thumbnail image in Figure T12.11.
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Figure T12.11 Data Navigator Updated to Reflect
TCellSample2 Plot Changes

We will now use drag and drop in the Data Navigator to overlay data on a
histogram.
8. Place the cursor over data file TCellSample2.fcs in the Data Navigator,
highlighted in blue in Figure T12.12.
9. Press and hold the left mouse button.
10. Drag the TCellSample2.fcs data file up to the histogram plot listing 4 –
Histogram – TCellSample1.fcs compensated (FITC-A), indicated by
the cursor and highlighted in blue in Figure T12.12.
11. Release the mouse button when the TCellSample2.fcs data file is on top
of the histogram listing.
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Figure T12.12 Dragging TCellSample2 onto a Histogram
Plot in the Data Navigator

The Select Drag and Drop Action dialog appears, as previously shown in Figure
T12.9. However, this time we will change the selection on the dialog to allow the
data to be overlaid on the histogram.
12. Select "add the files to the plot as new overlays".
13. Click OK.
The histogram in the upper right of the layout is now updated to reflect the
overlay of the TCellSample2.fcs data. The histogram plot is shown outlined in
green and the new overlay data is shown in red in Figure T12.13.

© 2020 De Novo Software

Tutorials

1587

Figure T12.13 Histogram Updated to Show the Overlay of TCellSample2 Data

Again, the Data Navigator also updates to reflect the changes as shown in
Figure T12.14. Under the data file listing for TCellSample2.fcs, a listing now
appears for 4 – Histogram – TCellSample1.fcs compensated (FITC-A), as
indicated by the cursor and the thumbnail image in Figure T12.14. The sub-listing
Overlay 2 also appears under the histogram listing to indicate that the data file
TCellSample2.fcs is the second overlay on the TCellSample1.fcs histogram.
Note that under the TCellSample1.fcs data file listing, the histogram 4 –
Histogram – TCellSample1.fcs compensated (FITC-A) listing has also been
updated with the sub-listing Overlay 1 to indicate that the data ApoMono.001 is
the base data.
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Figure T12.14 Updated Data Navigator with Overlay of
TCellSample2 Data

All the previous actions of dragging and dropping data in the Data Navigator
could also have been done using the Data Navigator pop-up menu. We will now
use the Data Navigator pop-up menu to add data as another overlay to the
histogram in the upper right of the layout.
14. Place the cursor over the TCellSample3.fcs data file listing on the Data
Navigator, shown highlighted in blue in Figure T12.15.
15. Right-click to bring up the associated pop-up menu.
16. Select Copy from the pop-up menu, indicated by the cursor in Figure
T12.15.
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Figure T12.15 Copy Using Data Navigator Pop-up Menu

17. Place the cursor over the listing 4 – Histogram – TCellSample1.fcs
compensated (FITC-A) listed under TCellSample1.fcs data on the
Data Navigator, shown highlighted in blue in Figure T12.16.
18. Right-click to bring up the associated pop-up menu.
19. Select Paste from the pop-up menu, indicated by the cursor in Figure
T12.16.
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Figure T12.16 Paste Using Data Navigator Pop-up Menu

The Select Drag and Drop Action dialog appears, as previously shown in Figure
T12.9. However, we will change the selection on the dialog to allow the data to
be overlaid on the histogram.
20. Select "add the files to the plot as new overlays".
21. Click OK.
The histogram in the upper right of the layout is now updated to reflect the
overlay of the ApoMono.003 data. The histogram is shown outlined in green and
the new overlay data is shown in blue in Figure T12.17.
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Figure T12.17 Histogram Updated to Show the Overlay of TCellSample3 Data

Again, the Data Navigator updates to reflect the changes as shown in Figure
T12.18. Under the data file listing for TCellSample3.fcs, a listing now appears
for 4 – Histogram – TCellSample1.fcs compensated (FITC-A), as indicated
by the cursor and the thumbnail image in Figure T12.18. The sub-listing Overlay
3 also appears under the histogram listing to indicate that the data file
TCellSample3.fcs is the third overlay on the TCellSample1.fcs histogram.
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Figure T12.18 Updated Data Navigator with Overlay of
TCellSample3 Data

We can also drag and drop data from the Data Navigator to either replace or
overlay data within the plots on the pages of our layout.
We will drag a data file from the Data Navigator onto a plot on the layout. On
the layout, the dot plot of SSC-A vs. PerCP Cy5.5-A, in the lower left corner of
Page 1, is using the data TCellSample2.fcs. We will overlay that with
TCellSample1.fcs data.
22. Place the cursor over data file TCellSample1.fcs in the Data Navigator,
highlighted in blue in Figure T12.19.
23. Press and hold the left mouse button.
24. Drag the data file TCellSample1.fcs onto the layout.
25. Release the mouse button when TCellSample1.fcs is on top of the dot
plot of SSC-A vs. PerCP Cy5.5-A, in the lower left corner of Page 1,
indicated by the cursor and outlined in blue in Figure T12.19.
26. In the Select Drag and Drop Action window, select add the files to the
plot as new overlays.
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Figure T12.19 Dragging and Dropping TCellSample1 from the Data Navigator onto
the Dot Plot on the Layout

Both the dot plot on the layout, in the lower left, and the Data Navigator have
updated to reflect the data change, as shown in Figure T12.20. The cursor and
thumbnail image, shown in Figure T12.20 indicate the changes in the Data
Navigator.

Figure T12.20 Updated Layout and Data Navigator with TCellSample1 Overlay

In addition to dragging the data file from the Data Navigator and dropping it
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onto the dot plot on the layout, we could have used the Data Navigator pop-up
menu to copy the data object, and then used the pop-up menu on the layout to
paste the data onto the dot plot. Just like all the other pop-up menus, the Data
Navigator pop-up menus are accessed by right-clicking when the cursor is
located over an item in the Data Navigator. We will now use the Data
Navigator pop-up menu to insert a new data plot onto the layout.

26. Place the cursor over TCellSample3.fcs in the Data Navigator.
27. Right-click to bring up the associated pop-up menu.
28. Select Copy from the pop-up menu, as previously shown in Figure
T12.15.
29. Click on Page 2 at the bottom of the layout, as shown in Figure T12.21.

Figure T12.21 Selecting Page 2

Page 2 of the layout will now appear as shown in Figure T12.22.
30. Place the cursor on an empty part of the layout.
31. Right-click to bring up the associated pop-up menu, shown in Figure
T12.22.
32. Select Paste from the pop-up menu.
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Figure T12.22 Page 2 of the Layout with the Pop-up Menu

The Select Plot Types… dialog appears, as shown in Figure T12.23.
33. Select Density as the types of plots to open (Figure T12.23).
34. Click OK.
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Figure T12.23 Select Plot Types... Dialog

A density plot of TCellSample3.fcs appear, using the default parameters of
Time vs. FSC-H, as shown in Figure T12.24. Feel free to format this plot any
way you wish.
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Figure T12.24 Contour Plot of TCellSample3.fcs Data

40.14

Gate Navigator

The Gate Navigator is designed to give you a useful overview of all the gates
used in the layout. It shows a hierarchical view of the gates and the plots
associated with those gates. The Gate Navigator also allows you to manipulate
the gates and plots on the layout. For example, by simply dragging and dropping
the gate icon on the Gate Navigator you can change the gate a plot is gated
on.
In the course of this example, we will:
Open and dock the Gate Navigator.
Learn about the Gate Navigator features and how to use them.
Specifically, we will use the Gate Navigator to:
o Apply gates to plots on the layout.
o Insert a plot onto the layout.
In the first exercise, we will open and dock the Gate Navigator

40.14.1
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.

Opening and Docking

To begin, we will open a saved layout that already has plots and gates on two
pages.
1. Select File tab

.

2. Open the layout GateNavigator.fey found in the FCS Express Sample
Data folder.
The layout appears, as shown in Figure T13.1.
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Figure T13.1 Gate Navigator Layout (GateNavigator.fey)

We will now open the Gate Navigator.
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3. Select the
T13.2).
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command (Figure

Figure T13.2 Selecting the Gate Navigator Command

The Gate Navigator appears, as shown in Figure T13.3. We will now expand the
menu to view all the plots using these gates.

Figure T13.3 Gate Navigator Window

4. Click on the "+" icon to the left the Lymphs gate, indicated by the cursor
in Figure T13.3, to expand the menu.
5. Continue to click on the "+" icons until all gate listings are expanded.
Alternatively, you can use the pop-up menu to expand the Gate Navigator
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menu.
Place the cursor on the Gate Navigator.
Right-click to bring up the pop-up menu (Figure T13.4).
Select Expand All, indicated by the cursor in Figure T13.4.

Figure T13.4 Gate Navigator Pop-up Menu

The Gate Navigator should now appear similar to Figure T13.5.
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Figure T13.5 Gate Navigator with Listings Expanded

We will now dock the Gate Navigator to the left side of the layout. For more
information on docking, please refer to the Docking tutorial .
1552

6. Place the mouse on the top border of the Gate Navigator window.
7. Press and hold the left mouse button and move the Gate Navigator
window.
As soon as you start moving the Gate Navigator window the four-headed
arrows of the docking icon appears in the center of the layout, as shown in
Figure T13.6.
8. Continue to hold the left mouse button and move the Gate Navigator
toward the left arrow of the docking icon.
9. Release the mouse button when the cursor is over the left arrow of the
docking icon, indicated by the cursor in Figure T13.6. You will know you
are in the correct place because the blue rectangle, indicating the proposed
docking location, will appear on the left side of the layout.
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Figure T13.6 Docking the Gate Navigator to the Left Side of the Layout

The Gate Navigator is now docked on the left side of the layout. However, not
all the text is visible, so we will now resize the docked window it to make it
wider.
10. Place the mouse over the outer right border of the docked Gate
Navigator.
11. Move the mouse slightly over the border until the resizing icon appears,
indicated by the red circle in Figure T13.7.
12. Press and hold down the left mouse button and continue to hold it while
dragging the border to the right.
13. Release the mouse button when the docked window is large enough to
show all the text of the Gate Navigator, as shown in Figure T13.7.
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Figure T13.7 Resizing the Gate Navigator

In the next section, we will explore the features of the Gate Navigator

40.14.2
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.

Gate Navigator Features

As shown in Figure T13.7 , the Gate Navigator is organized by the gates used
in the layout. Under each gate, is the list of the plots gated on this gate. As you
move the cursor over the plots listed in the Gate Navigator, thumbprint images
of the plots appear. This is a helpful quick reminder of which plot is gated on a
gate, and is particularly useful if that plot is not currently visible.
1597

We will now explore the features of the Gate Navigator, beginning with applying
a gate to a plot on the layout using the Gate Navigator. Specifically, we will
apply the CD3 gate and then the FL2+ gate to 2D plots on the layout.
1. Place the cursor over the CD3 gate in the Gate Navigator, highlighted in
blue in Figure T13.8.
2. Press and hold the left mouse button.
3. Drag the CD3 gate onto the layout.
4. Release the mouse button when the CD3 gate is on top of the 2D density
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plot of CD3-FITC (FITC fluorescence vs. SSC-H) in the second row of the
left column of the layout, outlined in blue and indicated by the cursor in
Figure T13.8.

Figure T13.8 Dragging and Dropping the CD3 Gate from the Gate Navigator onto a
Density Plot on the Layout

The 2D density plot of CD3-FITC (FITC vs. SSC-H) will now update to reflect that
is gated on the CD3 gate, as shown in Figure T13.9. The Gate Navigator also
updates, and under the CD3 gate is a new listing for the 2D density plot CD3FITC (FL1-H vs. SSC-H), indicated by the cursor and the thumbnail image in
Figure T13.9.
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Figure T13.9 Application of the CD3 Gate to the 2D Density Plot of CD3-FITC (FL1-H
vs. SSC-H)

We will now use drag and drop to apply the CD3 gate from the Gate Navigator
to the other FITC Fluorescence vs. SSC-H 2D plots on the layout.
5. Repeat steps 1 through 3.
6. Release the left mouse button when the CD3 gate is on top of the 2D
density plot of CD4-PE (FITC fluorescence vs. SSC-H), located in the
second row of the middle column of the layout.
Both the 2D plot and the Gate Navigator update to reflect the application of
the CD3 gate to the CD4-PE (FITC fluorescence vs. SSC-H) plot, as shown in
Figure T13.10.
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Figure T13.10 Application of the CD3 Gate to the 2D Density Plot of CD4-PE (FL1-H
vs. SSC-H)

7. Repeat steps 1 through 3.
8. Release the left mouse button when the CD3 gate is on top of the 2D
density plot of CD3-FITC+CD4-PE (FITC fluorescence vs. SSC-H), located
in the second row of the last column of the layout.
Both the 2D plot and the Gate Navigator update to reflect the application of
the CD3 gate to the CD3-FITC+CD4-PE (FITC fluorescence vs. SSC-H) plot, as
shown in Figure T13.11.
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Figure T13.11 Application of the CD3 Gate to the 2D Density Plot of
CD3-FITC+CD4-PE (FL1-H vs. SSC-H)

We will now apply the FL2+ gate to the 2D plots of PE Fluorescence vs. SSC-H
in the third row of the layout.
9. Place the cursor over the FL2+ gate in the Gate Navigator.
10. Press and hold the left mouse button.
11. Drag the FL2+ gate onto the layout.
12. Release the mouse button when the FL2+ gate is on top of the 2D
density plot of CD3-FITC (PE fluorescence vs. SSC-H), located in the third
row of the first column of the layout.
Both the 2D plot and the Gate Navigator update to reflect the application of
the FL2+ gate to the CD3-FITC (PE Fluorescence vs. SSC-H) plot. We will now
apply the FL2+ gate to the other 2D plots of PE Fluorescence vs. SSC-H).
13. Repeat steps 9 through 11.
14. Release the mouse button when the FL2+ gate is on top of the 2D
density plot of CD4-PE (PE fluorescence vs. SSC-H), located in the third
row of the middle column of the layout.
15. Repeat steps 9 through 11.
16. Release the mouse button when the FL2+ gate is on top of the 2D
density plot of CD3-FITC+CD4-PE (PE fluorescence vs. SSC-H), located in
the third row of the right column of the layout.
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The 2D plots on the layout and Gate Navigator should now look similar to
Figure T13.12.

Figure T13.12 2D Plots and Gate Navigator Updated to Reflect the Application of
Gates

Now that we have lots of 2D plots using gates, we can drag and drop gates on
the Gate Navigator itself to change how plots are gated. We will now apply the
Lymphs gate to a 2D plot that is currently being gated on the CD3 gate using
only the Gate Navigator.
17. Place the cursor on the Lymphs gate, shown highlighted in blue in Figure
T13.13.
18. Press and hold the left mouse button.
19. Drag the Lymphs gate down the Gate Navigator.
20. Release the mouse button when the Lymphs gate is on top of the listing
for 2 - Density – CD3 FITC.002 compensated (FL1-H vs. SSC-H),
indicated by the cursor and highlighted in yellow in Figure T13.13.
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Figure T13.13 Dragging and Dropping the Lymphs Gate on the Gate
Navigator

The Lymphs gate has now been applied to the 2D plot of the CD3-FITC.002
(FL1-H vs. SSC-H) by simply dragging and dropping the gate on the Gate
Navigator. The updated 2D plot is shown highlighted in green, and the updated
Gate Navigator listing of the plot is indicated by the cursor in Figure T13.14.
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Figure T13.14 Updated Gate Navigator and Layout Reflect the Application of the
Lymphs Gate

Instead of dragging and dropping the Lymphs gate onto the plot, we could have
used the associated pop-up menu.
We will now use the Gate Navigator to move a plot onto a new page in the
layout. First, we will insert a new page on the layout.
21. Click on the insert new Page icon, located on the bottom border of the
layout, indicated by the cursor in Figure T13.15.

Figure T13.15 Insert New Page

Alternatively, you can insert a new Page using the Insert command.
Select the
in Figure T13.16.

command, indicated by the cursor
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Figure T13.16 Selecting the Insert New
Page Command

A new blank page appears on the layout.
22. Place the cursor over the listing for 2D density plot CD3FITC.002 (FL1H vs. FL2-H) listed under the Lymphs gate on the Data Navigator,
shown highlighted in blue in Figure T13.17.
23. Press and hold the left mouse button.
24. Continue to hold down the mouse button and drag the plot listing from
the Gate Navigator onto page 2 of the layout.
25. Release the mouse button when the plot listing is on page 2, indicated by
the cursor in Figure T13.17.

Figure T13.17 Dragging and Dropping a 2D Density Plot Listing onto Page 2 of the
Layout

A new density plot, 19 - CD3FITC.002 compensated (FL1-H vs. FL2-H),
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appears under the Lymphs gate and on the new page of the layout, similar to
Figure T13.18.

Figure T13.18 2D Plot on Page 2 of the Layout

40.15

Layout Navigator

The Layout Navigator is designed to give you a useful overview of your entire
layout. It shows you a hierarchical view of all the pages in your layout, along with
which plots and data files are being displayed on each page. The Layout
Navigator also allows you to manipulate the plots and their associated gates
and data files within the layout. For example, plots can be moved from one page
to another by simply dragging and dropping the plot icons on the Layout
Navigator.

In the course of this example, we will:
Open and dock the Layout Navigator.
Learn about the Layout Navigator features and how to use them.
Specifically, we will use the Layout Navigator to:
o Apply a gate to a plot.
o Add an overlay to a histogram.
o Insert a new plot.
o Move a plot from one page to another.
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Opening and Docking

To begin, we will open a saved layout that already has plots and gates on
multiple pages.
1. Select File tab

.

2. Open the layout LayoutNavigator.fey found in the Tutorial Sample Data
archive .
1212

The layout appears. However, part of the layout is not visible, so we will now use
zoom to view the whole layout page on the screen.
3. Click on the Zoom icon located in the Zoom Toolbar at the lower left
corner of the screen (indicated by the cursor in Figure T14.1).

Figure T14.1 Zoom Icon

The Zoom dialog appears, as shown in Figure T14.2. Please note that the
Percent number in the field at the bottom of the dialog window will be
dependent on your screen and screen resolution.
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Figure T14.2 Zoom Dialog

4. Select Full Page.
5. Click OK.
The layout page will update to display the full page of the layout as shown in
Figure T14.3. Notice the tabs at the bottom of the screen (Figure T14.1)
indicating there are two pages in the layout.
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Figure T14.3 Layout Navigator - Page 1 Plots

We will now open the Layout Navigator.
6. Select the
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T14.4).

Figure T14.4 Selecting the Layout Navigator Command

The Layout Navigator appears; we will now dock it to the right side of the
layout. For more information on docking please refer to the Docking tutorial

1552

.

7. Place the mouse on the top border of the Layout Navigator window.
8. Press and hold the left mouse button and move the Layout Navigator
window.
As soon as you start moving the Layout Navigator window the four-headed
arrows of the docking icon appears in the center of the layout, as shown in
Figure T14.5.
9. Continue to hold the mouse button and move the Layout Navigator
toward the right arrow of the docking icon.
10. Release the mouse button when the cursor is over the right arrow of the
docking icon, indicated by the cursor in Figure T14.5. You will know you
are in the right place because the blue rectangle, indicating the proposed
docking location, will appear on the right side of the layout.
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Figure T14.5 Docking the Layout Navigator

The Layout Navigator is now docked on the right side of the layout. However,
not all the text is visible so we will now resize the docked window it to make it
wider.
11. Right click within the Layout Navigator and select Expand All.
12. Place the mouse over the outer left border of the docked Layout
Navigator.
13. Move the mouse slightly over the border until the resizing icon appears.
14. Press and hold down the left mouse button and continue to hold it while
dragging the border to the left.
15. Release the mouse button when the docked window is large enough to
show all the text of the Layout Navigator, as shown in Figure T14.6.
16. If necessary, use the scroll bar on the right side of the docked window to
scroll up and down the Layout Navigator.
The docked Layout Navigator should appear similar to Figure T14.6.
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Figure T14.6 Docked Layout Navigator

In the next section, we will learn the features of the Layout Navigator

40.15.2
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.

Layout Navigator Features

The Layout Navigator is organized by the Pages of the layout. Notice that the
current page, Page 1, is highlighted, as shown in Figure T14.7. Under the Page all
the plots on that page are listed. Under each plot the filename, gating, and other
information is listed. We will now explore the many features of the Layout
Navigator.
1. Hover the mouse over the Page 2 listing on the Layout Navigator, as
indicated by the cursor in Figure T14.7.

© 2020 De Novo Software

Tutorials

1619

A thumbnail image of the actual layout page will appear, as shown in Figure
T14.7. This is a helpful, quick reminder of the layout of plots on a page that may
not be currently visible. This feature also applies to the plot listings in the Layout
Navigator. If you hover the mouse over any of the plot listings in the Layout
Navigator, a thumbnail of the plot will appear.

Figure T14.7 Image of Page 2 on the Layout Navigator

2. Click on Page 2 in the Layout Navigator.
Page 2 of the layout now appears with five plots, as shown in Figure T14.8. This
demonstrates another way of changing pages within the layout. This page looks
just like the thumbnail that was previously displayed on the Layout Navigator,
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shown in Figure T14.7. Also notice that Page 2 is now highlighted on the Layout
Navigator indicating that this is the currently displayed page.

Figure T14.8 Page 2 of the Layout

3. Select the TCellSample2.fcs APC-A vs PE-A color dot plot, located in the
lower left of the layout (Figure T14.9).
Notice that the listing for the 13 - Color Dot - TCellSample2.fcs compensated
(APC-A vs PE-A) is now highlighted in the Layout Navigator, as shown in
Figure T14.9.
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Figure T14.9 TCellSample2.fcs Color Dot plot Selected

This plot is currently gated using the Lymphs gate. We will now use the Layout
Navigator to apply the FITC- gate to 13 - Color Dot - TCellSample2.fcs
compensated (APC-A vs PE-A).
4. Place the cursor over the FITC- gate, listed under 7 - Color Dot TCellSample1.fcs compensated (APC-A vs PE-A) on Page 1 of the
Layout Navigator, highlighted in blue in Figure T14.10.
5. Press and hold the left mouse button.
6. Continue to hold the left mouse button and drag the FITC- gate down
towards the listing for 13 - Color Dot - TCellSample2.fcs compensated
(APC-A vs PE-A), on Page 2 of the Layout Navigator.
7. Release the mouse button when the FITC- gate is over the 13 - Color
Dot - TCellSample2.fcs compensated (APC-A vs PE-A) listing,
highlighted and indicated by the cursor in Figure T14.10.
8. Press Undo to remove the gate from the histogram.

Alternatively, you can directly drag the gate from the Layout Navigator onto
the plot on the layout.
A. Click on Page 2 in the Layout Navigator to display that layout page.
B. Place the cursor over the FITC- gate, listed under 7 - Color Dot TCellSample1.fcs compensated (APC-A vs PE-A) on Page 1 of the
Layout Navigator, highlighted in blue in Figure T14.10.
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C. Press and hold the left mouse button.
D. Continue to hold the mouse button and drag the FITC- gate onto the
histogram plot of 13 - Color Dot - TCellSample2.fcs compensated
(APC-A vs PE-A) that is visible on Page 2.
E. Release the mouse button when the FL+ gate is on the histogram plot of
13 - Color Dot - TCellSample2.fcs compensated (APC-A vs PE-A).

Figure T14.10 Dragging and Dropping the FITC- Gate onto
TCellSample1.fcs Color Dot plot with the Layout Navigator

13 - Color Dot - TCellSample2.fcs compensated (APC-A vs PE-A) updates
to reflect the application of the FITC- gate, as shown in Figure T14.11. The
Layout Navigator also updates to reflect the FITC- gate on the 13 - Color Dot
- TCellSample2.fcs compensated (APC-A vs PE-A).

© 2020 De Novo Software

Tutorials

1623

Figure T14.11 TCellSample2.fcs Color Dot plot Histogram with FITC- Gate

A very powerful feature of the Layout Navigator is the ability to drag and drop
plots, gates, or data within the Layout Navigator or directly onto the layout.
We have just showed two ways you can apply a gate to a plot using the Layout
Navigator. Now we will use the Layout Navigator to add an overlay to a
histogram.
9. Click on Page 2 in the Layout Navigator to display that layout page.
10. Place the cursor over the listing for the TCellSample1.fcs data from
Page 1 in the Layout Navigator (it doesn't matter which plot it's listed
under) indicated by the cursor in Figure T14.12.
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Figure T14.12 TCellSample1 Data Listing in the Layout Navigator

11. Press and hold the left mouse button.
12. Continue to hold down the mouse button and drag the TCellSample1.fcs
data onto the layout.
13. Release the mouse button when the cursor is over the histogram of
TCellSample2.fcs compensated (FITC-A) on Page 2.

Alternatively, you can drag and drop the data within the Layout Navigator.
A. Place the cursor over one of the listings for the TCellSample1.fcs data in
the Layout Navigator, indicated by the cursor in Figure T14.12.
B. Press and hold the left mouse button.
C. Continue to hold down the left mouse button and drag the
TCellSample1.fcs data down the Navigator Layout towards 8 Histogram - TCellSample2.fcs compensated (FITC-A).
D. Release the mouse button when the cursor is over 8 - Histogram TCellSample2.fcs compensated (FITC-A), highlighted and indicated by
the cursor in Figure T14.13.
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Figure T14.13 Dragging and Dropping TCellSample1.fcs Data
within the Layout Navigator

The Select Drag and Drop Action dialog appears, as shown in Figure T14.14.
14. Select add the files to the plot as new overlays.
15. Click OK.
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Figure T14.14 Select Drag and Drop Action Dialog

The 8 - Histogram - TCellSample2.fcs compensated (FITC-A) plot now
updates to reflect the overlay of the TCellSample1.fcs data as shown in Figure
T14.15. The Layout Navigator also updates to show that there is now overlay
data on 8 - Histogram - TCellSample2.fcs compensated (FITC-A),
highlighted in Figure T14.15.

Figure T14.15 Overlay of TCellSample1.fcs and TCellSample2.fcs
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We will now undo the overlay on the histogram.
16. Click on the Undo icon on the Quick Access Toolbar (Figure T14.16).

Figure
T14.16
Undo Drag
and Drop

The 8 - Histogram - TCellSample2.fcs compensated (FITC-A) now updates
to reflect the removal of the overlay.

We will now use the Layout Navigator to insert a new plot onto page 2 of the
layout.
17. Click on Page 2 in the Layout Navigator, if page 2 is not already being
displayed.
18. Place the cursor over one of the listings for the TCellSample2.fcs data in
the Layout Navigator (it doesn't matter which plot it's listed under)
shown highlighted in blue in Figure T14.17.
19. Press and hold the left mouse button.
20. Continue to hold down the mouse button and drag the TCellSample2.fcs
data onto page 2 of the layout.
21. Release the mouse button when the cursor is on a blank area of the
layout, indicated by the cursor in Figure T14.17.
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Figure T14.17 Dragging and Dropping TCellSample2.fcs Data onto the Layout

The Select Plot Types… dialog appears, as shown in Figure T14.18.
22. Select Density as the type of plot to open for the TCellSample2.fcs
data (Figure T14.18).
23. Click OK.
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Figure T14.18 Select Plot Types... Dialog

A density plot of the TCellSample2.fcs data now appears on the layout, with
Time vs. FSC-H as the default parameters. The Layout Navigator also updates
to reflect the insertion of a 2D plot onto page 2 of the layout, indicated by the
cursor in Figure T14.19.
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Figure T14.19 Density plot of TCellSample2.fcs with Updated Layout Navigator

We will now undo the insertion of the 2D plot.
24. Click the Undo icon in the Quick Access Toolbar, as previously shown in
Figure T14.16.

We will now use the Layout Navigator to move a plot from one page to
another.
25. Place the cursor over the listing for 7 - Color Dot - TCellSample1.fcs
compensated (APC-A vs PE-A), shown highlighted in blue in Figure
T14.20.
26. Press and hold the left mouse button.
27. Continue to hold down the mouse button and drag the 2D plot down the
Layout Navigator.
28. Release the mouse button when the cursor is over Page 2 on the
Layout Navigator, highlighted and indicated by the cursor in Figure
T14.20.
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Figure T14.20 Moving a Plot to Page 2 in the Layout Navigator

Both the layout and the Layout Navigator update to reflect the new location of
the density plot.
29. Click on Page 1 in the Layout Navigator, highlighted in yellow in Figure
T14.21.
Page 1 of the layout appears, as shown in Figure T14.21. Notice that 7 - Color
Dot - TCellSample1.fcs compensated (APC-A vs PE-A) is now missing, as it
was moved to its same location on page 2 of the layout and renamed 18 Color Dot - TCellSample1.fcs compensated (APC-A vs PE-A).
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Figure T14.21 Page 1 of the Layout without the TCellSample1 2D Plot

30. Click on Page 2 in the Layout Navigator, highlighted in yellow in Figure
T14.22.
Page 2 of the layout appears, as shown in Figure T14.22. Notice that 18 - Color
Dot - TCellSample1.fcs compensated (APC-A vs PE-A) is now added to the
bottom left corner of the layout, and the Layout Navigator now reflects the
addition of this plot to Page 2. You can move the new plot to an open part of
the layout.
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Figure T14.22 Page 2 of the Layout with the Addition of the new 2D Color Dot Plot

Alternatively, the 2D plot could have been moved by dragging and dropping the
plot listing in the Layout Navigator directly onto page 2 of the layout.
All of the previous manipulations of data, gates, and plots with the Layout
Navigator involved dragging and dropping the items. However, another way to
accomplish these actions would have been to use the pop-up menu associated
with the different items in the Layout Navigator. Just like all the other pop-up
menus, the Layout Navigator pop-up menus are accessed by right-clicking
when the cursor is located over an item in the Layout Navigator. We will now
use the Layout Navigator to move the 2D plot from page 2 back to page 1 of
the layout.
31. Select 18 - Color Dot - TCellSample1.fcs compensated (APC-A vs
PE-A) listed on Page 2 of the Layout Navigator.
32. Right-click on the color plot on Page 2 of the layout to bring up the menu,
shown in Figure T14.23.
33. Select Cut from the menu (Figure T14.23).
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Figure T14.23 Layout Navigator 2D Plot Pop-up Menu

The density plot is now cut from page 2 of the layout.
34. Select Page 1 on the Layout Navigator.
35. Right-click to bring up the Layout Navigator pop-up menu (Figure
T14.24).
36. Select Paste from the menu (Figure T14.24).
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Figure T14.24 Paste 2D Plot Menu Item

Alternatively, after following steps 31 through 33 to cut the color dot plot, you
can place the cursor directly onto page 1 of the layout, right-click to bring up the
pop-up menu and select Paste to paste the color dot plot.
The color dot plot is now pasted back onto page 1 of the layout and the Layout
Navigator updates to reflect this change.

40.16

HLA Cross Matching - Spreadsheets Use Case 1

FCS Express provides a number of tools that allow you to create and use
spreadsheets to graph your data. Your spreadsheets can contain data from
many sources including, but not limited to, tokens such as keyword, statistics,
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custom tokens, and token classifiers. In previous versions of FCS Express,
custom data grids were used to create and graph data sets. However, in FCS
Express version 6, the custom data grid is replaced with the new spreadsheet
function 308 . The advantage of creating a spreadsheet containing tokens is that
when your layout changes (e.g., by making a gate or displaying a new set of
data) your data within that spreadsheet will change as well. The use of a
spreadsheet allows you to easily demonstrate the important results from your
experiments using a spreadsheet very similar to excel, by graphing the results
using a bar chart or scatter plot. In this tutorial, we will focus on creating and
using spreadsheets.

Note: Spreadsheets replace Custom Data grids 308 from previous versions of
FCS Express but have the same and more advanced capabilities. If you have
Custom Data tables saved from previous versions of FCS Express in your
layout, then FCS Express 6 will allow you to open them for use and formatting 308
. New custom data may not be created as Spreadsheets will replace all functions
of the previous Custom Data grid functionality.
We will create a custom spreadsheet to aid in the analysis of an HLA crossmatch experiment. Flow cytometry is frequently used to predict how much
soluble IgG, from a potential recipient's serum, will bind to the cells of an
engrafted organ. The assumption is that most of the IgG binding is directed
against the HLA molecules on the donor cells. A negative cross-match means
that the soluble IgG in the potential recipient's serum did not bind to a significant
number of lymphocytes from the donor cells. This negative cross-match
correlates with an improved graft survival. Specifically, we will examine the Tand B-cells from the donor to determine the amount of IgG binding from the
potential recipient using an anti-human FITC labeled IgG.
In the course of this example, we will:
Load and examine a layout with all the plots needed to perform an HLA
cross-match.
Create and insert various kinds of tokens and data into a new
Spreadsheet.
Explore various ways of entering information into a Spreadsheet.
Create Conditional Formatting in Spreadsheet cells.

First, we will load a layout in preparation for creation of a custom dataset

1637

.
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Loading a layout for analysis

In this section, we will:
1. Load and examine a layout with all the plots needed to perform an HLA
cross-match.
We will begin by loading a two page layout of HLA cross-match data. The layout
contains data plots from two different negative controls, a positive control, and
serum from a possible recipient patient.
2. Select File tab

.

3. Open the layout HLA Custom Data.fey found in the FCS Express Sample
Data folder.
The two pages of the layout should appear as shown in Figure T15.1, with both
pages being displayed next to each other.

Figure T15.1 HLA Custom Data.fey

Let's begin by examining the first four plots on the top of Page 1, all labeled 'PBS
NEGATIVE CONTROL', shown in Figure T15.2. The plot in the upper left corner is
of the cells from the donor; a gate has been drawn around the lymphocyte
population and labeled 'Lymphs'. The density plot in the upper right is gated on
only the lymphocyte population and displays the CD3 positive T-cells, in the
lower right quadrant (blue) and the CD19 positive B-cells, in the upper left
quadrant (red). The two quadrants for the T- and B-cells have been converted to
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gates and are sub-gates, or children, of the Lymphs gate, as shown by the Gate
View window. The two histograms on the bottom, from left to right, are gated
on the B-cell population (red) and T-cell population (blue), respectively. The
numbers inside the histograms are the median MESF values of the IgG FITC
parameter of the T- and B-cells.
The other plots on the layout are duplicates of these four plots displaying the
data from three other data files.

Figure T15.2 Layout of PBS NEGATVE CONTROL Plots and Gate View

Rather than using arbitrary channel values, the layout uses a Channel Calibration
regression that was previously created from FITC MESF beads. This means the
IgG FITC histograms use a calibrated FITC MESF scale. For more information on
using beads in this way, please refer to the tutorial on Calibrating Fluorescence
Using Beads . As shown in Figure T15.2, the median value from the PBS NEG
CONTROL histogram of the B-cells is 2619.03. This means that the median
1871
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intensity of the IgG FITC signal, from the soluble IgG bound to the B-cells of the
donor cells, is approximately 2,619 MESF (Molecules of Equivalent Soluble
Fluorochrome) of fluorescein.

Next, we will create a spreadsheet

40.16.2
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.

Creating a Spreadsheet for analysis

In this section, we will:
Create a Spreadsheet.
Create and insert tokens and data into the Spreadsheet.
Because the IgG histogram scales are calibrated, we can use the MESF median
values from the B- and T-cell histograms to construct a custom data set.
Ultimately, we want the custom data set to tell us if serum from a patient
sample is considered a "positive", "negative" or "weak" positive cross-match
against the donor cells. To be able to do this, we have to define what is
considered 'positive' or 'negative'. To aid in these definitions, multiple negative
control serum samples are analyzed against the donor cells to determine the
average FITC MESF value. The standard deviation is used to determine a
significant "cut-off" value to use. We will assume that the FITC MESF values that
define 'positive', 'negative' and 'weak' positive have already been determined.
We will begin by inserting a new blank page in the HLA Custom Data.fey layout
from the previous "loading a layout for analysis" tutorial section, and then
inserting a spreadsheet.
1. Select the

command.

Alternatively, click on the New Page Icon at the bottom of Page 2 of the layout,
as indicated by the cursor in Figure T15.3.
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Figure T15.3 New Page Tab/Icon

A new blank page appears.
2. Select the Insert tab

command (Figure T15.4).

Figure T15.4 New Spreadsheet Command

The Create new spreadsheet dialog appears. Please refer to Figure T15.5 for
the following steps.
3. Type 'HLA Cross-match' in the Name field.
4. Click OK.
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Figure T15.5 Create New Spreadsheet Dialog

An empty spreadsheet will appear on Page 3 of the layout, as shown in Figure
T15.6. If the spreadsheet appears on another page, you can cut and paste it
onto Page 3 of the layout.

Figure T15.6 Empty Spreadsheet

In the next exercise, we will Populate the spreadsheet for analysis
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40.16.3

Populating a Spreadsheet with data

In this section, we will:
Insert keyword and statistic tokens into the Spreadsheet.
Explore various ways of entering information into the Spreadsheet.
We will insert a keyword token in the cells of 'A' column of the HLA Custom
Data.fey can be found in the FCS Express Sample Data folder. The keyword
$SRC will be used because it has a good description of the sample. In fact, the
plot titles are all using the keyword $SRC rather than the filename.
1. Click inside the top cell in the 'A' column, shown highlighted in blue in Figure
T15.10.
We are now going to insert the keyword token into the cell. Find the
Spreadsheet Tab in the Top Center of the screen, then Click on
2. Click on the Spreadsheet tab
tab
Insert Token
command, indicated by the red arrow in Figure T15.10.
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Figure T15.10 Spreadsheet with Insert Token

The Insert a Token dialog appears, as shown in Figure T15.11.
3. Select Keyword.
4. Click Insert.
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Figure T15.11 Insert a Token Dialog

The Create Keyword dialog appears, with the Data Source category displayed,
similar to Figure T15.12.
5. Select any of the plots associated with the data file XM110210-201.001
(PBS NEGATIVE CONTROL), shown highlighted in blue in Figure T15.12.
6. Select the Keyword category on the left.
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Figure T15.12 Create Keyword Dialog

The Keyword category of the Create Keyword dialog appears, similar to Figure
T15.13.
7. Type '$SRC' in the Select a keyword text field.
8. Click OK.

© 2020 De Novo Software

1646

FCS Express 6 Manual

Figure T15.13 Create Keyword Dialog -- Keyword Category

Alternatively, click on the ellipsis icon, indicated by the cursor in Figure T15.13.
The Please select a keyword dialog appears, as shown in Figure T15.14.
Scroll down and select $SRC, shown highlighted in blue in Figure T15.14.
Click OK.
Click OK in the Create Keyword dialog.

Figure T15.14 Please Select a Keyword Dialog

© 2020 De Novo Software

Tutorials

1647

The Spreadsheet updates to reflect the insertion of the keyword in the 'A1' cell.
We will now fill in the rest of the 'A' Column. However, rather than repeating all
the previous steps, we will simply drag and drop the appropriate plot onto the
correct cell in the data grid.
10. Place the cursor over one of the 'AB HUMAN NEGATIVE SERUM ' 2D plots
from page 1, shown highlighted in red in Figure T15.16.
11. Press and hold the left mouse button and drag the plot towards the
Spreadsheet, as shown in Figure T15.16.
12. Release the left button when the plot is over the second cell of the A
column, indicated by the cursor in Figure T15.16.

Figre T15.16 Dragging and Dropping the AB NEGATIVE HUMAN SERUM Plot onto
the Spreadsheet

The Paste Special dialog appears, similar to Figure T15.17.
13. Select Keyword token, shown highlighted in blue in Figure T15.17.
14. Click OK.
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Figure T15.17 Paste Special Dialog

The Edit Keyword dialog appears, similar to the Keyword category of the
Create Keyword dialog previously shown in Figure T15.13.
15. Type '$SRC' in the Select a keyword text field.
16. Click OK.
Note: Dragging a plot onto a place in your layout that can accept a token is a
very convenient way of creating that token, since you do not have to manually
select the data source for the token like you did in step 5 above.
The second cell of the A column updates to reflect the addition of the keyword
for the AB NEGATIVE HUMAN SERUM plot. We will now fill the rest of the cells in
the A column.
17. Repeat steps 10 through 16 for the third cell in the A column using a
POSITIVE SERUM plot from page 2.
For the 4th cell in the A column, we will manually type in the sample
information.
18. Type 'PATIENT SERUM'.
Alternatively, you can click anywhere outside the Spreadsheet to accept the
entry into that particular cell. If you do not wish to save the data typed in the
editor, you can select the Delete icon, or hit Esc on the keyboard and the
changes will be canceled.
The Sample column of the Spreadsheet is now filled in and should appear similar
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to Figure T15.20.

Figure T15.20 Sample Column
Completed

We will now insert the 'B' column as the results of the 'Bcell Median', and the 'C'
Column as the results of 'Tcell Median' column values as token statistics.
Because these median values are already being displayed as tokens in the
histograms, we will simply copy and paste these tokens into the appropriate cells
of the 'B' and 'C' columns.

19. Place the cursor at the beginning of the B-Cell token value in the PBS
NEGATIVE CONTROL histogram (page 1), shown in red on the layout.
20. Select the B-Cell token text. You will know it is selected because the text
will be white, indicated by the cursor in Figure T15.21.

Figure T15.21 Token Value Selected
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23. Copy the text using Ctrl+C on the keyboard.
Alternatively, after Step 21, the B-cell token text can be copied using the pop-up
menu.
Right click to bring up the pop-up menu.
Select Copy from the pop-up menu, shown highlighted and indicated by the
cursor in Figure T15.22.

Figure T15.22 Copying a Token Using the Pop-up Menu

We will now paste the B-cell token into the appropriate cell of the 'B' column of
the Spreadsheet.
24. Click inside the first cell of the 'B' column to select it.
25. Paste the text using Ctrl+V on the keyboard.
26. Click anywhere outside the Spreadsheet to accept the entry.
Alternatively, after Step 24, the token text can be pasted using the pop-up
menu.
Right-click inside the first cell of the 'B' column to bring up the pop-up menu.
Select Paste Text from the pop-up menu.
Click anywhere outside the Spreadsheet to accept the entry.
The rest of the 'B' column can now be filled using copying and pasting by
repeating Steps 20 through 26 using the B-cell histograms of the AB NEGATIVE
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HUMAN SERUM, POSITIVE SERUM, and PATIENT SERUM. The 'C' column of the
Data Grid can be filled in by copying the token median text displayed in the T-cell
histograms, shown in blue on the layout. Again, repeat Steps 20 through 26,
substituting the T-cell tokens for the B-cell tokens. All the cells of the 'B' and 'C'
columns of the Spreadsheet should be filled in and appear similar to Figure
T15.23.

Figure T15.23 Spreadsheet with B- and T-Cell Median Values, in
Column B and Column C, Respectively

In the next section, we will create and use custom tokens in a spreadsheet

40.16.4
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.

Working with Custom Tokens and Formula References in
spreadsheets

In this section, we will:
Creating a custom token and insert it in a spreadsheet.
Learn how to use spreadsheet formulas to replace custom token formulas.
(Jump to this section )
1657

We will begin by using the HLA Spreadsheet.fey layout found in the FCS
Express Sample Data folder.
The layout contains plots and statistics related to an HLA cross matching data
set. In this tutorial we will first learn how to create a custom token formula and
insert the result in a spreadsheet. We will then learn how to use spreadsheets to
create the formula in spreadsheet cells to contrast the two different methods for
calculating custom statistics in FCS Express. Using spreadsheets for custom
calculations (rather than custom tokens) allows for quick access to additional
chart types for the data sets of interest and may also be more efficient for
calculating certain formulas. For instance, with the particular data set we are
using it would take an additional amount of effort to create the necessary
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custom token formula(s) whereas using a spreadsheet allows you to quickly
copy and paste cells to derive statistics and use the copy down feature to
calculate formulas for multiple cells.

To begin, we will first complete a series of custom tokens that normalize a
'samples' median fluorescence values based on a 'negative' value. We will use
the median MESF FITC values from the B cells of the PBS NEGATIVE CONTROL as
the 'negative' value and subtract this value from the median MESF FITC value of
the corresponding samples. We will begin by inserting the Custom Tokens
window.
1. Select File

.

2. Load the HLA Spreadsheet.fey layout from the FCS Express Sample
Data folder.
1212

The layout will appear with the Custom Tokens window docked on the right side
of the layout. For more information on docking, please see the Docking tutorial
.
1552

Three custom tokens that calculate the shift in median fluorescent values
between a negative control and a corresponding sample are already created in
the Custom Token Dialog as seen in Figure T15.24. We will create a final
custom token that represent the MESF channel shift of a "patient" sample
relative to the PBS NEGATIVE CONTROL sample and place the value into a
spreadsheet table. The following steps serve as an example of how to create and
use a custom token formula in a spreadsheet. Later in the tutorial we will
examine how to define the formula solely in a spreadsheet.
Note: For more information on creating custom tokens, refer to the Custom
Token Tutorial .
1339

3. Click on the
symbol on the top border of the Custom Tokens window,
indicated by the red box in Figure T15.24.
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Figure T15.24 Creating a new Custom Token.

4. Type 'BShift Patient' for the Custom Token name.
5. Click in the bottom of the Custom Token window under Enter the
Custom Token formula below.
6. Type '=' in the Custom Token definition area.
7. Right click to the right of the '=' sign.
8. Choose Insert Token.
9. Double click on the Statistic category.
10. Click Insert.
11. Choose 20-Histogram XM110210-210.001 in the Select a Plot
dialog, as in Figure 15.25a.
12. Click on the Statistic category on the left as seen in Figure 15.25b.
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13. Choose the B Cells gate from the Select Gate drop down.
14. Click on Median under Statistic.
The Create Statistic dialog should appear as in Figure 15.25b below.
15. Click OK.
The median token value will appear in the custom token definition.

Figure 15.25a - Create Statistic Dialog, Selecting a Token from the appropriate
histogram.
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Figure 15.25b Choosing a Statistic for the Custom Token.

We will now complete the complete the BShift Patient custom token, as it looks
in Figure T15.26.
16. Type '-' after the token defined in the previous steps (red arrow in
Figure T15.26 below).
17. Repeat steps 7-15 after the minus sign choosing '4-Histogram
XM110210-210.001' instead of '20-Histogram XM110210210.001'.
The Custom Token formula will appear as in Figure 15.26 below. Notice the
custom token defines the median for plot 20 minus the median for plot 4.
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Figure T15.26 Creating the B-cell Median Shift Custom Token Definition

We will now complete the column of B Cell Shift custom tokens in the
spreadsheet on Page 3 by dragging and dropping the BShift Patient Custom
Token into the spreadsheet.
Please refer to FigureT15.27 for the steps below.
18. Click on the Page 3 page tab
19. Place the cursor over the 'BShift Patient' Custom Token, shown
highlighted in blue.
20. Left-click and hold the mouse button.
21. Drag the 'BShift Patient' Custom Token toward cell B4 in the Spreadsheet.
22. Release the mouse button when the 'BShift Patient' Custom Token is
over cell B4 in the Spreadsheet, (indicated by the cursor and the red arrow
in Figure T15.27.)
© 2020 De Novo Software

Tutorials

1657

Figure T15.27 Dragging and Dropping the 'BShift PBS' Custom Token into the
Spreadsheet.

The spreadsheet should now appear as in Figure T15.28.

Figure T15.28 Spreadsheet with BShift Custom Tokens in 'B', and Cells to be filled in
Columns 'C', 'D' and 'E'

We will now complete a series of custom tokens for corresponding T cell median
fluorescent shift values by using tokens and formulas in the spreadsheet. The
method described below will contrast the method of using custom tokens. The
TShift Negative Control Tokens that we will bring into Column 'D', will be
subtracted from the TShift Median Tokens in Column 'C'. The result will be
returned from a formula Column 'E' which can serve to replace a series of
custom token values such as the previous way we defined the BShift custom
token series in the steps above.

Let's start with Dragging and Dropping the Histogram from the Data Navigator to
Column 'C'. First Open up the Data Navigator. We have more information about
the Data Navigator in our Tutorials and Manuals.

23. Click on the View tab

Navigator.

24. Expand the XM110210-201.001 node.
25. Click on 5-Histogram-XM110210-201.001 (IgG FITC). (It will be
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highlighted in blue as in Figure T15.29).
26. Drag and Drop 5-Histogram-XM110210-201.001 (IgG FITC) to cell C1.

Figure T15.29 Drag and Drop a Histogram to retrieve a statistical token and
populate a cell.

A Paste Special Dialog will appear.
27. Click on Statistic Token in the Paste Special as in Figure T15.30 below.

Figure T15.30 The Paste Special dialog.

28. Select the T Cells gate from the Select Gate dropdown menu.
29. Select Median from the Statistic list.
30. Click OK.
We will now repeat the steps above to insert the rest of the TShift Median values
by dragging and dropping the histograms from the Data Navigator to cells C2,
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C3, and C4, respectively.
31. Expand the XM110210-202.001 node in the Data Navigator.
32. Drag and Drop 6-Histogram-XM110210-201.001 (IgG FITC) to cell C2
and repeat steps 24-30.
33. Expand the XM110210-203.001 node in the Data Navigator.
34. Drag and Drop 14-Histogram-XM110210-201.001 (IgG FITC) to cell C3
and repeat steps 24-30.
35. Expand the XM110210-204.001 node in the Data Navigator.
36. Drag and Drop 21-Histogram-XM110210-201.001 (IgG FITC) to cell C4
and repeat steps 24-30.

We will now use copy and paste to copy the baseline TShift Negative Control
value to the corresponding cells in Column D. The value will be subtracted from
the Column C median values in a subsequent formula resulting in the TShift series
of values within Column E of the Spreadsheet.
37. Select Cell C1.
38. Press Ctrl+C to Copy cell C1. Alternatively, Right-Click and choose Copy as
in Figure T15.31.

Figure T15.31 Using the copy command to copy cells in a spreadsheet.

39. Multiple select Cells D1 through D4 by left clicking in cell D1 and mousing
down as you would multiple select cells in Excel.
40. Press Ctrl+V to Paste to cells D1-D4.
The spreadsheet should now appear as in Figure T15.32 below.
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Figure T15.32 Using the multiple select and paste command in a spreadsheet.

We will now complete the spreadsheet by defining the formula of the TShift
series in column in E using a spreadsheet formula reference and using the copy
down feature to quickly complete the formula for all rows.
41. Click on cell E1.
42. Enter an '=' sign.
43. Click on cell C1.
44. Enter a '-' sign.
45. Click on cell D1.
The formula should appear as in Figure T15.33
46. Press Enter.
The formula for C1 minus D1 will result in the value of 0 in cell E1.

Figure T15.33 Defining a formula in a spreadsheet

We will now use the copy down feature to quickly copy the formula down to
through the remaining cells and complete the spreadsheet.
47. Select cell E1.
48. Press Ctrl+C to Copy.
49. Multiple select Cells E1 through E4 by left clicking in cell E1 and mousing
down as you would multiple select cells in Excel.
50. Press Ctrl+V to Paste.
The formula will be copied down the range of cells selected in Step 49 and the
spreadsheet will be completed as in Figure T15.34.
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Figure T15.34 Spreadsheet with formulas.

Next, we will create and use token classifiers in the spreadsheet

40.16.5
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for IVD use.

Create Token Classifiers

Classifier Tokens are only available in the Clinical Edition (IVD version) of FCS
Express. Please contact support@denovosoftware.com if you would like more
information on FCS Express Clinical Edition and access to the Creating Token
Classifiers tutorial.
In this section, we will:
Create token classifiers using custom tokens.
Insert token classifiers into the new Spreadsheet.

Note: Token Classifiers are only included with clinical licenses of FCS Express.
Using the 'BShift' and 'TShift' Custom Token data created in the last section, we
will now define token classifiers ('NEG', 'POS', and 'WEAK') in the Spreadsheet.
We will use the token classifiers to classify our samples and ultimately determine
the status of the patient serum cross-match. To begin, we will insert a new
Spreadsheet.

1. Open the HLA_Custom_Tokens_Completed.fey layout found in the
FCS Express Sample Data folder.
We will now begin defining Token Classifiers to classify the results for each
sample in the bottom spreadsheet of Page 3 of the layout. For more information
on creating Token Classifiers, see the Using Text boxes and Tokens Tutorial .
1326

2. Click on the Page 3 tab.
3. Right click inside the B1 cell.
4. Choose Insert Token.
Note: The Insert a Token dialog appears as in Figure T15.33a
© 2020 De Novo Software

1662

FCS Express 6 Manual

Figure T15.33a Insert a Token-Statistical Classifier

5. Select Statistic Classifier from the Insert a Token dialog.
6. Click Insert.
The Classification category of the Create Statistic Classifier dialog appears,
as shown in Figure T15.33b. We will begin to define the Statistic Classifier to
classify our results as either 'NEG', 'WEAK', or 'POS'. However, first we need to
tell the Classifier what we want it to classify.

7. Click on the
T/Token icon (shown by the cursor in FigureT15.33b)
under the 'Enter a value to classify:' field.
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Figure T15.33b Create Statistic Classifier Dialog -- Classification Category

Note: The Insert a Token dialog reappears, as shown in Figure T15.34. We
will choose the Custom Token for our Token Classifier to classify.
8. Select BShift PBS from the Custom category of the Insert a Token
dialog, shown highlighted in blue in Figure T15.34.
9. Click Insert.
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Figure T15.34 Insert a Token Dialog with Custom Tokens to
Classify

Note: The Classification category of the Create Statistic Classifier dialog
reappears. The 'Enter a value to classify:' field has the Custom Token 'BShift
PBS' entry, as shown in Figure T15.35. We will now enter the specific list of
classifiers to use.
10. Click the Add button, indicated by the cursor in Figure T15.35.
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Figure T15.35 Adding the List of Classifiers in the Create Statistic Classifier Dialog

The Create Classification dialog appears. Please refer to Figure T15.36 for the
following steps;
11.Type 'NEG' in the Classify the token as text field.
12. Type '0' in the if its value is between text field.
13. Type '19999' in the and text field.
14. Click OK.
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Figure T15.36 Edit Classification Dialog

Note: The Classification category of the Edit Statistic Classifier dialog
appears. However, now the List of classifications: field has the 'NEG' definition
listed. We have just defined the 'NEG' classification for the 'BShift' Custom Token
to be between 0 and 19,999. This means that if the sample's MESF FITC median
fluorescence value of the B-cells, adjusted by the PBS NEGATIVE CONTROL, is
less than 20,000 it is classified as negative or 'NEG'.
We will now continue to define the two other classification categories of 'WEAK'
and 'POS'.
15. Click the Add button.
16. Type 'WEAK' in the Classify the token as text field of the Create
Classification dialog.
17. Type '20000' in the if its value is between text field.
18. Type '49999' in the and text field.
19. Click OK.
20. Click the Add button.
21. Type 'POS' in the Classify the token as text field.
22. Type '50000' in the if its value is between text field.
23. Type '1200000' in the and text field.
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24. Click OK.
The Edit Statistic Classifier dialog should now appear similar to Figure T15.37
with the complete classifier definition for the 'BShift' Custom Tokens.

Figure T15.37 The 'B Result' Token Classifier Definition

25. Click OK on the Edit Statistic Classifier dialog to accept the definition.
The 'HLA' Spreadsheet now updates to reflect the addition of the Token Classifier
to the first cell of the 'B' column, as shown in Figure T15.38.
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Figure T15.38 Token Classifier for the 'B' Column

Note: We have created the Token Classifier to use for the 'B1' cell. However, we
will need to edit the Token Classifier to use the appropriate sample data for the
remaining 3 classifications for AB Negative Human Serum, Positive Human
Serum, and Patient Serum (B2, B3 and B4, respectively).
To define the statistical classifier for the remaining cells:
26. Right click in cell 'B2'.
27. Repeat Steps 4-25 to define to a statistical classifier for BShift NegSerum.
Note, In step 8, Type 'BShift NegSerum' instead of 'BShift PBS' and use the
same classifier values and names as listed in the above steps.
28. Right click in cell 'B3'.
29. Repeat Steps 4-25 to define to a statistical classifier for BShift Pos Serum.
Note, In step 8, Type 'BShift Pos Serum' instead of 'BShift PBS' and use the
same classifier values and names as listed in the above steps.
30. Right click in cell 'B4'.
31. Repeat Steps 4-25 to define to a statistical classifier for BShift Patient.
Note, In step 8, Type 'BShift Patient' instead of 'BShift PBS' and use the same
classifier values and names as listed in the above steps.

The spreadsheet should now look like Figure T15.39 below. As the Lymphs
gate is adjusted in the layout you will notice the statistic classifiers updating in
real time as the statistics change.
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Figure T15.39

40.16.6

Using Conditional Formatting to Classify Data
Create Conditional Formatting using custom tokens.
Insert Conditional Formatting into the new Spreadsheet.

Using the 'BShift' and Custom Token data created in the last section, we will now
define conditional formatting ('NEG', 'POS', and 'WEAK') in the Spreadsheet. We
will use conditional formatting to classify our samples and ultimately determine
the status of the patient serum cross-match. To begin, we will insert a new
Spreadsheet.

1. Open the HLA Conditional Formatting.fey found in the FCS Express
Sample Data folder.
We will now begin defining Conditional Formatting to classify the results for each
sample in the spreadsheet.
2. Click on the Page 3 tab.
3.Click on the header of the 'B' column on the spreadsheet.
4. Click on the Spreadsheet Tab

Tab

5. Mouse over Icon Sets.
6. Mouse to the right to reveal the available icon set.
7. Left Click the first set of arrows icons in the first row, shown by the red
box as in Figure T15.40 below.
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Figure T15.40 Icon Set with veritcal and
horizontal arrows to define conditional
formatting

You will notice that the data set has now been conditionally formatted based
to use the icon set based on the default rules. We will now adjust the rules to
perform a custom classification using the icon sets.
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Tab

7. Click on the drop down menu to Managing Rules (as seen enclosed in the
red box in Figure T15.41).
Note: Here we will define the rules for the conditional formatting seen in
Figure T15.41. Before using the Manage Rules feature make sure the
column containing the data set to classify in the spreadsheet is selected. For
example; in this tutorial, it will be column 'B'.

Figure T15.41 Managing Conditional
Formatting Rules

8. Click on the words Icon Set underneath the Rule column in Figure
T15.42
9. Click on the Edit Rule... button (shown with the cursor on it in Figure
T15.42).
Note: During conditional formatting, we can also add additional rules. In this
particular case, we will edit the rule as it is already started in this particular
layout (shown by the cursor). This rule will apply to cells B1-B4 as is shown
in Figure T15.42.
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Figure T15.42 Conditional Formatting Rules Manager Dialog

10. Click on Format all cells based on their values via icon set as in
Figure T15.43 (shown highlighted in blue).
Note: Here you will add values according to each rule displayed by the icon
set. Make sure you choose the rule type. In this tutorial, we are using
Format all cells based on their values via icon set.
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Figure T15.43 Conditional Formatting Rule Range Definitions

11. Click on the percent drop down in the Up Arrow category Figure
T15.45.
12. Choose value as in Figure T15.45.
13. Click on the "0" in order to enter a new value.
14. Enter the value of 40000 to replace "0".
Note: In this case, we entered 40000 which defines greater than or ">"
40000 for the green arrow.

In order to define the second line for the right facing yellow arrow in the
Display each icon according to these rules: window;
15. Click on percent in the second row.
16. Choose value from the drop down.
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17. Click on the "0" from the second line in the Display each icon according
to these rules: window.
18. Enter 8000 as the numerical value for the yellow arrow.
Note: The yellow rule is defined by less than or "<" 40000 but greater than of
">" 8000.
Also Note: The red arrow is then automatically defined as less than or
"<" 8000.
19. Click OK. The formatting rules dialog will appear as in Figure T15.45.
20. Click Apply.
21. Click OK.

Figure T15.45 Conditional Formatting Rules Dialog

Note: you will see the conditional formatting defined in the spreadsheet
shown in Figure T15.46. To see the changes in real-time you may type in a
different value in column B or update the Lymphs gate on Page 1 or Page 2.
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The conditional formatting will change due to the values in the cells updating.

Figure T15.46 Spreadsheet with conditional formatting

40.17

Antibody Titration - Spreadsheets Use Case 2

FCS Express 6 allows you to easily create summary data and plots that show
your entire experimental results using Spreadsheets 412 . Your spreadsheet(s)
can contain information from data files, plots, or gates. When your gates change,
so will the data in spreadsheets and any plot derived from them. Formulas 438 can
be used also to calculate custom data as well.
In this tutorial, we will use spreadsheets and plots to aid in the visualization of
data from antibody titration experiments. This tutorial will demonstrate, by
selecting the ideal antibody concentration the best separation between positive
and negative cells will be achieved.
We will examine data from a titration experiment where seven different amounts
of CD64 were used to stain peripheral blood mononuclear cells. Because CD64 is
constitutively expressed on only macrophages and monocytes, we will examine
the ratio of the intensity of fluorescence staining on the monocyte versus
lymphocyte population. The negative population will be defined by the
lymphocytes and the positive population by the monocytes.
In the course of this example, we will:
Create a new spreadsheet and populate it by manually entering
information as well and dragging and dropping statistics from gates and
data files and calculate a CD64 signal to noise ratio.
Insert a scatter plot displaying the data calculated within the spreadsheet.
In the first exercise, we will create a spreadsheet

40.17.1
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.

Creating an analysis Spreadsheet

For this tutorial, we will be using a layout file that has 2D density plots with
defined gates from seven data files, each having a different amount of CD64
antibody. Please note you may skip ahead to the next section to insert a scatter
with regression plot
using a completed spreadsheet.
1689
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1. Select the File tab

dialog.

2. Open the layout Titration.fey found within the FCS Express Sample Data
in a subfolder called Spreadsheet and Titration.
The following layout should appear as shown in Figure T17.1.
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In the upper left corner of the layout is a dot plot of Side Scatter versus Forward
Scatter with a scatter gate, drawn in red. The Scatter gate has been defined to
exclude very low and very high scatter signals. All the other plots on the layout
are gated using this Scatter gate. Seven different volumes of CD64 were added
to peripheral blood mononuclear cells and are shown in the seven color dot plots.
To define the negative population for this titration experiment, a gate has been
drawn on the lymphocyte population, shown in blue as the Lymphs gate, in the
2D plot of Side Scatter (SS Lin) versus CD64 (FL 8 Log). The positive population
is the monocyte population which is defined in purple as the Monos gate. In the
lower left corner of the layout is the Gate View window showing that the
Lymphs and Mono gates are children of the Scatter gate, meaning the data is
first gated using the Scatter gate and then the Lymphs and Mono gates are
applied.
We will use a spreadsheet to calculate the values of CD64 signal to noise ratio
for each of the seven volumes of CD64 used. The values will be defined as the
ratio of the median CD64 fluorescent intensity of the monocyte population (the
positive population) divided by the median CD64 fluorescent intensity of the
lymphocyte population (the negative population).
3. Select the

command (Figure T17.2).

Figure T17.2 - Opening new spreadsheet from ribbon

The Create new spreadsheet window now appears on the layout.
4. Enter "Titration" in Name field.
5. Click OK to close window.
The new spreadsheet appears on the layout.
6. Click and drag spreadsheet border to reposition.
7. Release the button when spreadsheet is positioned where desired.
For this exercise, we will populate the spreadsheet with the following
information:
Column A - amount of antibody added,
Column B - median CD64 fluorescent intensity of the monocyte population, and
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Column C - median CD64 fluorescent intensity of the lymphocyte population.
8. Left-click on cell A1 of spreadsheet.
9. Type "Ab Added".
10. Press Enter. Cell A2 will be outlined in blue (Figure T17.3).

Figure T17.3 - Populating cell A1 of spreadsheet

11. Type "0.156".
12. Press Enter. Cell A3 will be outlined in blue.
13. Type "0.313".
14. Press Enter. Cell A4 will be outlined in blue.
15. Type "0.625".
16. Press Enter. Cell A5 will be outlined in blue.
17. Type "1.25".
18. Press Enter. Cell A6 will be outlined in blue.
19. Type "2.5".
20. Press Enter. Cell A7 will be outlined in blue.
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21. Type "5".
22. Press Enter. Cell A8 will be outlined in blue.
23. Type "10".
24. Press Enter. Cell A9 will be outlined in blue.
Cells A2-8 should be populated with antibody amounts (Figure T17.4).

Figure T17.4 - Column A populated properly

To populate cells from columns B, we will drag and drop the SS Lin vs FL8 Log
Color Dot plots for each respective antibody amount.
25. Type "Monos Median".
26. Press Enter. Cell B2 will be outlined in blue.
27. Click plot for 0.156 ul CD64
28. Click border of plot to cell B2 of spreadsheet (Figure T17.5).
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Figure T17.5 - Drag and Drop Plot to cell B2 of spreadsheet

29. Release mouse button.
30. Select Statistic token from Paste Special window (Figure T17.6).

Figure T17.6 - Paste Special window to insert Statistic token

The Statistic page of the Edit Statistic dialog now appears (Figure T17.7).
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Figure T17.7 - Edit Statistic information for Monos

31. Click OK.
32. Select Monos from the Select Gate: drop down list.
33. Select Y Median from the Statistics list box.
34. Select OK.
35. Repeat Steps 27 - 34 for the following color dot plots and spreadsheet
cells:
0.313 ul CD64 to B3, 0.625 ul CD64 to B4, 1.25 ul CD64 to B5, 2.5 ul
CD64 to B6, 5 ul CD64 to B7, and
10 ul CD64 to B8.
The spreadsheet should now appear as in Figure T17.8.
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Figure T17.8 - Columns A and B populated properly

Column C will be populated by dragging and dropping data files from the data list
onto the spreadsheet.
36. Click Data tab

command.

37. Press Ctrl+A to select all data files.
38. Click and hold mouse button on any data file in data list.
39. Drag data files to cell C1 in spreadsheet (Figure T17.9).
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Figure T17.9 - Drag and Drop Files from Data List to
spreadsheet

40. Release mouse button.
The Statistic category of the Edit Statistic dialog now appears.
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41. Select FL 8 Log from Parameter drop down list under Data File
Information.
42. Select Lymphs from Select Gate: drop down list.
43. Select Median from Statistic list box.
44. Click OK (Figure T17.10).

Figure T17.10 - Edit Statistic window for Lymphs

45. Click cell C1.
46. Type "Lymphs Median".
47. Press Enter.
The spreadsheet should appear similar to Figure T17.11 below.
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Figure T17.11 - Columns A, B, and C populated properly

Alternatively, gates may be dragged and dropped from each dot plot to the
spreadsheet.
Click gate of interest from plot and drop onto appropriate cell.
o For example, click and drag purple Monos gate from color dot plot 0.156 ul CD64 SS Lin vs FL 8 Log to cell B2 of spreadsheet.
Release mouse.
Select Y Median from Statistic list box.
Click OK.
Values in the spreadsheet will update in real-time as gating is changed.
Click and hold red Scatter gate in upper left plot on layout - 10 ul CD64
SS Lin vs FS Lin.
Move mouse and observe values changing in spreadsheet as Scatter gate
is moved.
Release mouse.
Press Ctrl+Z to undo gate move.
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To resize column width(s), follow one of the two commands below:
Hover mouse cursor over right border of column header until resizing
cursor appears (

)

double click (left in Figure T17.13 below).

Spreadsheet tab group Layout tab Format drop down list
Column Width (right in Figure T17.12 below).

AutoFit

Figure T17.12 - Resizing single column width (left) or autofitting widths for entire
spreadsheet (right)

We will now calculate the ratios of the CD64 staining for the Monocyte and
Lymphocyte populations within the spreadsheet.
48. Add page to layout by using
49. Use View
Navigator.

command.
command to open Layout

50. Drag and drop spreadsheet "Titration" from Page 1 to Page 2 within
Layout Navigator (Figure T17.13).
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Figure T17.13 - Moving
Spreadsheet to Page 2

51. Select the

command.

52. Go to Page 2 of layout.
53. Select the spreadsheet.
54. Click cell D1.
55. Type "M/L Ratio".
56. Press Enter. Type "=" into cell D2.
57. Click cell B2.
58. Type "/".
59. Click cell C2.
60. Press Enter.
61. Click cell D2.
62. Hold Shift and click cell D8.
63. Release mouse button.
64. Ctrl+C.
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65. Ctrl+D.
The spreadsheet should now appear similar to Figure T17.14.

Figure T17.14 - Columns A, B, C, and D properly
populated

In the next section, we will create a regression curve from a spreadsheet

40.17.2

1689

.

Creating a regression curve from a Spreadsheet

The remainder of this tutorial will focus on creating a regression analysis of the
data by using a scatter plot with regression plot with Spreadsheet based data.
You can use the layout you created in the previous section or open Titration
with Complete Spreadsheet.fey in FCS Express Sample Data within the sub
folder called Spreadsheet and Titration.
1. Click on spreadsheet.
2.
3. Click on blank space on page 2 of layout.
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Plot should now appear where clicked similar to Figure T17.15 below.

Figure T17.15 - Scatter Plot with Regression
Unedited

The 2D scatter with regression plot using the titration data in the spreadsheet
appears. Notice that the plot contains points in black that represent the points
from Columns A (X-axis) and B (Y-axis) of the spreadsheet. The red line overlay
is a regression overlay. The default regression fit for all scatter with regression
plots is a linear fit. In the following steps we will adjust the plot to display the
correct data from the spreadsheet and a more appropriate Michaelis-Menten
regression fit. We will also start by adjusting the axis range to more appropriately
fit the points within the plotted region.
4. Double-click plot to open Formatting dialog.
5. In Overlays, change Y Parameter to D for 2D Unbinned Overlay
Options. This will change the data used from Column A "Monos Median"
to Column D "M/L Ratio"(Figure T17.16).
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Figure 17.16 - Changing Y Parameter

6. Select the Axis category.
7. Select Y axis, shown highlighted in blue in Figure T17.17A.
8. Enter "150" in the Minimum Range and "750" in the Maximum Range
fields, shown highlighted in blue (Figure T17.17A).
9. Select X axis, shown highlighted in blue in Figure T17.17B.
10. Enter "12" in the Maximum Range window, shown highlighted in blue
(Figure T17.17B).
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Figure T17.17A - Changing Y-Axis Scale (left); B - Changing X-Axis Scale

11. Select Regression fit category.
12. Choose MichMenten from Regression Type drop down list.
13. Confirm Number of regression dots is set to 30 (Figure T17.18).

Figure T17.18 - Regression Fit Settings

14. Click OK.
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The scatter plot should now appear similar to Figure T17.19

Figure T17.19 - Modified Scatter with
Regression Plot

15.Click cell E1.
16. In Data List, Ctrl+A.
17. Drag and drop data files to E1 (Figure T17.20).
18.Choose Statistic Token from the Paste Special dialog.

Figure T17.20 - Drag and Drop Data Files to E1

The Statistic page of the Edit Statistic dialog now appears.
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19. Select FL 8 Log from Parameter drop down list under Data File
Information.
20. Select Monos from Select Gate: drop down list.
21. Select CV from Statistic list box.
22. Click OK (Figure T17.21).

Figure T17.21 - Edit Statistics for Monos CV

23. Click cell E1.
24. Type "Monos CV".
25. Press Enter.
The spreadsheet should now appear as Figure T17.22 below.
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Figure T17.22 - Columns A, B, C, D, and E populated properly

28. Double-click plot.
29. Select the Overlays category.
30. Select E from the Error Bar Param drop-down list. This will change the
data used from Column A "Monos Median" to Column E "Monos CV".
(Figure T17.23).
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Figure T17.23 - Adding Error Bar from Overlays

31. Click OK.
The titration Scatter with Regression plot updates to reflect the addition of black
error bars using the Monos CV data, as shown in Figure T17.24. Note that as
you adjust any of the gates in the layout the raw data points, regression line,
and error bars will all update accordingly and in real-time.
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Figure T17.24 - Scatter with Regression
Plot, error bars added

We will now add a Regression Parameter Statistics default window to the layout,
to obtain the Vmax (Vm in Fig. T17.24b, below) and summarize the fit.
32.Right-click on the Scatter with Regression plot.
33.Select Statistics> Regression Parameter Statistics from the pop-up
menu.
A Regression Parameter Statistics window has now been inserted on the layout
(Figure T17.24b).

Figure T17.24b - Regression Parameter Stats Window
inserted from Scatter with Regression Plot

40.17.3

Interpolating values from the regression

We will now interpolate the X-value for the Vmax calculated from the Scatter
with Regression Plot in the previous section, using the "RegressionPlotYToX"
Custom Token function.
Please ensure that the previous section of the tutorial has been completed
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before proceeding.
1. Select the View tab

command.

2. Click on the blue plus in the Custom Tokens window to Create a new
Custom Token (Fig. T17.25, ).
3. Type "X from Vmax" to descriptively title the new Custom Token (Fig.
T17.25, ).
4. Type an equals sign ("=") in the Custom Token formula pane of the
Custom Tokens window (Fig. T17.25, ).
5. Right-click and select Insert Function> Regression >
RegressionPlotYtoX from the pop-up menu (Fig. T17.25,

).

Figure T17.25. Inserting a Custom Token function to interpolate X from Y from the
regression

The Custom Token formula pane now appears as in Fig. T17.26.
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Figure T17.26. "RegressionPlotYtoX" Interpolation Custom Token formula

We will now replace the components of this Custom Token with specific
information from our layout.
6. Highlight the "Plot ID" text of the Custom Token (Fig. T17.27,
7. Right-click on Plot ID and select Insert Token (Fig. T17.27,

).
).

8. Select Plot Information from the Plot node of the Insert a Token dialog
(Fig. T17.27, ).
9. Click Insert (Fig. T17.27,

).

Figure T17.27. Filling components of the Custom Token

10.Scroll to and select the Regression plot under the Select a Plot box of
the Edit Plot Information Token dialog window (Fig. T17.28, ). A
thumbnail image at right aids in selection of the correct plot.
11.Select the Plot Elements category at left (Fig. T17.28,

).

12.Select Plot Number from the Select a Plot Token Element box (Fig.
T17.28, ).
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13.Click OK (Fig. T17.28,

).

Figure T17.28. Filling components of the Custom Token, continued

14.Highlight the "Overlay Number" text of the Custom Token (Fig. T17.27,
above).
15.Type "2", as the Regression line is the second overlay in the Scatter with
Regression Plot.
16.Highlight the "Y value" text of the Custom Token (Fig. T17.27, above).
17.Type a value close to the Vmax, e.g., "500".
Note: typing in a value too close or equal to the Vmax will result in a non-useful,
very high X-value, as the Michaelis-Menten equation asymptotically
approaches the Vmax. As an alternative to typing in an arbitrary freetext
value, you could create a Custom Token 726 that is equal to a percentage
(e.g., 90%) of the Vmax regression token 581 , and enter this Custom Token in
place of the "Y value" text.

The "X from Vmax" Custom Token formula now appears as below (Fig. T17.29,
left). We will now insert the result as a Custom Token onto our layout.
18.Drag and drop the "X from Vmax" Custom Token from the upper pane of
the Custom Tokens window to an empty spot on your layout, or to the
Scatter with Regression plot.
The Custom Token's mathematically calculated value is now displayed in a Text
Box (Fig. T17.29, center). We will now add descriptive freetext to the Text
Box.
19.Click inside the Text Box so that it enters edit mode
green as in Fig. T17.29, right).

131

(its border appears
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20.Type "The amount of antibody to use is" before the Custom Token, and
"uL" or "microliters" for units after the Custom Token.

The interpolated X-value for the close-to-Vmax Y-value chosen in Step 17 is now
displayed on the layout (Fig. T17.29, right).

Figure T17.29. Inserting the completed Custom Token for interpolated X value
onto the layout

40.18

Calibration via Regression Analysis - Spreadsheets
Use Case 3

FCS Express provides the user with many mathematical functions to create
custom tokens and custom data sets that can be plotted in Scatter with
Regression and Scatter Plots to provide live updating regression curves and fit
statistics as gates or data files change.
In this tutorial, we will complete a Spreadsheet 412 , insert a scatter with
regression plot, and derive model fit statistics from the data. You will also learn
how to create a regression overlay on a scatter plot, how to apply a regression
fit to an FCS file, as well as how to save a regression fit for later use.
As an example, we will be performing our analysis on a FITC MESF bead data set
in order to obtain an equation that returns the FITC MESF value for a data
channel value. Because FCS Express also provides the user with an easy to use
Channel Calibration Tool 610 that uses MESF data from a set of beads to calibrate
the axes to MESF values, this tutorial is most useful in demonstrating the ways in
which custom tokens and custom data sets can be created and plotted and how
you can use regression analysis to fit your data in real time right within FCS
Express.
In the course of this example, we will:
Load a layout of MESF beads with histogram markers to complete a
Spreadsheet for regression fitting.
1702

Insert a Scatter with Regression Plot of the Spreadsheet values and
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automatically generated best-fit regression curve.

1702

Add a regression fit token to the Scatter with Regression Plot.

1711

Apply the linear regression to an .fcs data file to obtain MESF data.

1717

Save the linear regression formula in a text file usable by other .fcs data
files and layouts.
1721

First, we will complete the Spreadsheet
plot.

40.18.1
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and insert a scatter with regression

Complete a Spreadsheet and Insert a Scatter with Regression
Plot

For this tutorial we will be using a layout file that has plots of FITC MESF beads
and a custom data set, with custom tokens.
1. Open the layout FITC MESF Beads.fey found in the Calculating MESF
From Regression folder of the Tutorial Sample Data archive .
1212

The following layout should appear as shown in Figure T27.1.
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Figure T27.1 The FITC MESF Beads.fey Layout

In the upper left corner of the layout, is a Color Dot plot of the FITC beads with a
gate around the single bead events. To the right of this plot, is the FITC
histogram plot, gated with the 'FITC Beads' gate, with markers defining each of
the five FITC bead populations.
Under both plots, is a spreadsheet, named 'FITC MESF'. For more details on how
to create a spreadsheet, please see our creating a spreadsheet for analysis
tutorial .
1639

Please take a moment and double click on an entry in each column of the
spreadsheet and examine the data entry. The first column is the marker name
and is a manually entered data value. The second column is the median value for
each of the defined markers on the histogram, and is defined using a statistics
token (see the Inserting a Token or Custom Token in a cell 418 chapter of the
manual to learn more about this topic).
The third column is the MESF FITC value assigned to each of the bead
populations, and is a manually entered data value. The fourth and fifth columns
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are the Log values of the median and MESF bead populations, and are defined by
formula inserted directly in the spreadsheet. In this case, the formula for
calculating the Log, using log base 10, is =LOG(num), where num can be both
a manually inserted number, a numeric token or, as in this case, a cell reference.
Notice that the bottom right cell of the spreadsheet (Cell E6), under the
'LogMESF' column, is empty. We will now fill this cell with the required value by
copy-pasting the content of one of the other cells in that column.

2. Select Cell E3, as shown in Figure T27.2, . Please note that any cells
among E2 and E5 can actually be copied in this step.

Figure T27.2 Copying and pasting the E3 cell content into the E6 cell to complete
the spreadsheet.

3. Press Ctrl+C to copy the cell content.
4. Select Cell E6 as show Figure T27.2,

.

© 2020 De Novo Software

Tutorials

1705

5. Press Ctrl+V to paste the cell content .
We have now completed the spreadsheet as shown in Figure T27.3.

Figure T27.3 The spreadsheet successfully complete.

Now, we will insert a Scatter with Regression plot using the FITC bead data in the
spreadsheet.
4. Select the spreadsheet; it should now have a green border.
5. Select the Insert tab

with Regression command.

6. Click on a blank area of the layout below the spreadsheet to insert the
Scatter with Regression plot.
An empty plot using the data from the first two columns, 'A' and 'B', of the
custom spreadsheet appears.
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We will now format the Scatter with Regression plot to display the Median and
MESF data from the spreadsheet (i.e. columns 'B' and 'C' respectively).
7. Place the cursor over the Y-axis 'B' label.
8. Press and hold the left mouse button and the list of columns from the
spreadsheet appears, as shown in Figure T27.4.
9. Release the button when the cursor is over 'C', shown highlighted in blue in
Figure T27.4.
10. Repeat 7 to 9 for X-axis selecting 'B' as column to display.

Figure T27.4 Selecting 'LogMESF' Data for the Y-axis

The empty plot is now populated with the data from column B and C of the
spreadsheet in black, along with a best-fit regression curve in red, as shown in
Figure T27.5.

Note: The regression curve type has defaulted to the first option (Linear), which
is appropriate for this dataset. When working with other datasets, the
Regression Type can be chosen from the Formatting options of the Scatter with
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Regression plot. The smoothness of the curve can also be adjusted. See this
section of the manual 576 for details.

Figure T27.5 Scatter with Regression Plot of
Median and MESF Data from the Data Grid

We will now format the Scatter with Regression plot to display the 'Log
MESF' (i.e. column 'E') data of the spreadsheet on the Y-axis.
11. Place the cursor over the Y-axis 'C' label.
12. Press and hold the left mouse button and the list of columns from the
Spreadsheet appears.
13. Release the button when the cursor is over 'E'.

The Scatter with Regression plot now updates to reflect the selection of the 'Log
MESF' (i.e. column 'E') data for the Y-axis.

We will now change the X-axis parameter to the 'LogMedian' (i.e. column 'D')
data of the spreadsheet on the X-axis.
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10. Place the cursor over the X-axis 'B' label.
11. Press and hold the left mouse button and the list of columns from the
Spreadsheet appears.
12. Release the button when the cursor is over 'D'.
The Scatter with Regression plot now updates to reflect the selection of the
'LogMedian' (i.e. column 'D') data for the X-axis and appears as in Figure T27.6.

Figure T27.6 Scatter with Regression Plot with
Log Median and Log MESF Values from the
Spreadsheet.

We will now format the Scatter with Regression plot to better visualize the five
data points.
13. Right-click on the Scatter with Regression Plot.
14. Choose Format from the pop-up menu.
15. Choose the Axis category (Figure T27.7a,

).

16. Change the Y Axis Range Minimum to 3 and Maximum to 7 (Figure
T27.7a, ).
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17. Click on X Axis under Select Axis (Figure T27.7a,

1709

).

18. Change the X Axis Range Minimum to 1 and Maximum to 4.

Figure T27.7a Formatting axis for Scatter with Regeression plot.

19. Click on the Overlays category (Figure T27.7b,

).

20. Click on the second overlay ("2-Linear") from the 2D Unbinned
Overlays list (Figure T27.7b, ).
21. Choose Connecting Lines from the Line Options for dropdown menu
(Figure T27.7b, ).
22. Set the line with to 1.5 (Figure T27.7b,
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23.Click OK (Figure T27.7b,

).

Figure T27.7b Formatting fitting line in Scatter Plot with Regression.

The Scatter with Regression plot will now look like Figure T27.7c. It has been
formatted to bring all of the data points into range and to increase the width of
the red regression curve.
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Figure T27.7C Scatter Plot with Regression
reformatted.

Next, we will insert and view a linear regression token

40.18.2

1711

for the data set.

Working with Regression Tokens and Fit Equations

To learn working with regression we will pick up from where we left off in the
previous section of this tutorial.
If you didn't go along the previous section, you can directly start with the FITC
MESF Beads - Part2.fey layout stored in the Calculating MESF From
Regression folder of the Tutorial Sample Data archive .
1212

As a first step we will display a regression token on the Scatter with Regression
Plot.
1. Right-click on the Scatter with Regression plot and select Add text box
from the pop-up menu (Fig. T27.8, ).
2. Right-click in the text box on the plot and select Insert Token from the
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pop-up menu (Fig. T27.8,

).

3. Double-click Statistic in the Insert a Token dialog (Fig. T27.8,

).

Figure 27.8 Adding a regression token to the plot

4. Click the Statistic category in the Create Statistic dialog (Fig. T27.9,

).

5. Select Regression Parameter Statistics from the Select a Statistic
dropdown menu (Fig. T27.9, ).
6. Select m (slope) from the Statistic list (Fig. T27.9,
7. Increase the Number of decimals to "4" (Fig. T27.9,
8. Click OK (Fig. T27.9,
displayed on the plot.

).
).

). The slope (m) of the regression curve is now
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Figure 27.9. Adding a regression token to the plot, continued

9. Click inside the text box to put it into edit mode. The border will be green.
10. Use the arrow keys on the keyboard or click within the text box to move
the cursor to the left of the token.
11. Type "m = " (Fig. T27.9, ). The token has now been annotated with
this descriptive freetext within the text box. Note: if necessary, the text
box can be enlarged by dragging its border, so that all the text fits on one
line as in the figure.
We will now create a Custom Token for the linear regression equation, so that
we can apply the regression to other .fcs files (including those in other
layouts). Each token in the Regression Parameter Statistics list (Fig. 27.9
above) will be used as a component of this Custom Token.
12. Open the Custom Token window by clicking on
Tokens in the Ribbon bar.
13. Click the blue plus (
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).

1714

FCS Express 6 Manual

Figure T27.10 Creating the Linear Regression Fit Custom Token

14. Highlight the "New Custom Token" text in the Custom Tokens window
(Fig. 27.10, ).
15. Type 'LinFitLogMedMESF' (Fig. 27.10,

).

16. Type "m=,b=,r2=" in the formula (lower) pane of the Custom Tokens
window (Fig. 27.10, ).
17. Click on the Scatter with Regression plot so its border becomes
highlighted.
18. Drag and drop the border of the Scatter with Regression plot to the
position after the "m=" and before the "," (comma) in the formula pane of
the Custom Tokens window (Fig. 27.10, ).
19. Double-click Statistic token from the Paste Special dialog (Fig. 27.11,
).
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Figure 27.11 Inserting a regression parameter token as a component of the
linear regression fit custom token

20. Choose Regression Parameter Statistics from the Select a Statistic
dropdown menu (Fig. 27.11, ).
21. Choose m from the Statistic list (Fig. 27.11,
22. Click OK (Fig. 27.11,

).

).

23. Repeat Steps 17-21, with the following modifications:
Step 17: Drop the plot after the "b=" in the formula pane of the
Custom Tokens window
Step 20: Choose b from the Statistic list
24. Repeat Steps 17-21, with the following modifications:
Step 17: Drop the plot after the "r2=" in the formula pane of the
Custom Tokens window
Step 20: Choose r2 from the Statistic list
25. Drag the LinFitLogMedMESF Custom Token from the Custom Token
window onto a blank area of the layout. A new text box containing the
linear regression fit token will be automatically created.
Note: an r2 value of exactly 1 denotes a perfect fit, which is rarely attained with
experimental data. The Custom Token initially displays a value of 1.00 for r2
because its value here is greater than 0.995, and statistics in FCS Express
are rounded to two decimal places by default.
We will now edit the r2 component of the Custom Token to display five digits
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after the decimal point.
26. Double-click the component r2 token in formula pane of the Custom
Tokens window (Fig. 27.12, ).
27. Click the Statistic category in the Edit Statistic dialog (Fig. 27.12,

).

Figure 27.12 Increasing the number of digits after the decimal displayed for the
r-squared component of the Custom Token

28.Increase the Number of decimals to 5 (Fig. 27.12,

).

29.Click OK.
The linear fit token will be displayed as in Figure T27.13.

Figure T27.13 The LinFitLogMedMESF Custom
Token displayed in a Text Box, after editing the
number of digits displayed for r-squared

Once a linear regression is calculated it can be used as model for fitting unknown
samples. This can be done directly within the same layout in which the
regression has been calculated (see the Apply Regression to an FCS File
section of this tutorial) or in any new layout. To use the regression in a new
1717
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40.18.3
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topic of this tutorial.

Apply Regression to an FCS File

We will now use the linear regression formula calculated in the previous section
to calculate MESF data for four unknown samples (i.e. four FCS files). The
goal of this analysis is to assess the amount of IgG that is present in the
patient's serum that is binding to the B- and T-cells of the potential donor.
1711

The layout we will be using contains five pages. The first page displays the linear
regression calculated in the previous section using beads. Page 2 and 3 define
the negative and positive controls along with the patient sample. The MESF
Calculations page is where we will be working to complete the linear regression
and MESF data. The Bar Plots page will be used to easily visualize the data once
it is complete.

1. Open the HLA CrossMatch.fey layout from the Calculating MESF From
Regression folder in the Tutorial Sample Data archive .
1212

2. Click on the MESF Calculations page tab of the layout.

This page contains two spreadsheets (Table 1 and Table 2), one for calculating
MESF for B cells and one for calculating MESF for T cells. Each spreadsheet
contain the "m" and "b" regression parameters calculated on Page 1 (Figure
T27.14). This way, both parameter will be available in each spreadsheet using
cell reference. Moreover, since they have been inserted as statistic tokens, they
will automatically update if the linear regression change.
Note: as we will see in the Save a Regression
section of this tutorial, linear
regression parameters can also be added to the data files as a keyword. This
allows to use the regression parameter even in a brand new layout.
1721

Figure T27.14 - "b" and "m" parameter have been
inserted into the spreadsheet.
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Spreadsheets on MESF Calculations page also contain the Name, the Median
fluorescence intensity and the log10-transformed Median fluorescence intensity
of each of the four sample.

To calculate the MESF for the said unknown samples using the linear regression
model previously calculated we will need to:
Use the log10-transformed Median intensity (i.e. the X variable of the linear
regression) to calculate the log10MESF value (i.e. the Y variable of the linear
regression) following the linear regression formula Y=mX+b;
Elevate the log10MESF value to the tenth in order to calculate the actual MESF
value.
3. Select the G2 cell of Table 1 (i.e. the first available cell of the B Cell Log
MESF column).
4. Type "=$B$2*F2+$B$3" (without quotes), where $B$2 is an absolute
cell reference for the "m" parameter, F2 is a relative cell reference for the
"X" parameter and $B$3 is an absolute reference for the "b" parameter.
Note: A cell reference can also be inserted in the formula by mouse selection of
the cell of interest. Please see the referencing cells in a spreadsheet section of
the manual. 418

5. Press Return on your keyboard. The formula is calculated in real time and
the spreadsheet looks like the one of Figure T27.22.

Figure T27.22

Note: if you double click on cell G2, cell references will highlight as displayed in
figure T27.23.

Figure T27.23
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6. Select the H2 cell of Table 1 (i.e. the first available cell of the B Cell MESF
column).
7. Type "=10^G2" (without quotes), where G2 is the relative reference to
the B Cell Log MESF of the PBS NEGATIVE CONTROL SAMPLE.
8. Press Return on your keyboard. The formula is calculated in real time.

We will now fill the remaining cells of column G and H by copy-pasting the
content of cells G2 and H2.

9. Multiple select both cell G2 and cell H2.
10.Press Ctrl+C on your keyboard or, alternatively, right click and select
Copy from the right-click menu.
11.Multiple select cells from G3 to H5 as shown in Figure T27.24.

Figure T27.24 - Multiple cell selections.

12. Press Ctrl+V on your keyboard or, alternatively, right click and select
Paste from the right-click menu. The cell are filled with the corresponding
value and the spreadsheet looks like the one displayed in figure T27.25.

Figure T27.25 - The B Cell table completed.

We will now fill the T Cell Log MESF and the T Cell MESF columns of Table 2 by
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copy/pasting the content of the content of the B Cell Log MESF and the B Cell
MESF columns respectively from Table 1.

13. Multiple select cells from G2 to H5 as shown in Table 1 (i.e. the B cell
Table) as shown in Figure T27.26.
14. Select the G2 cell in Table 2 (i.e. the T Cell table).
15. Press Ctrl+V on your keyboard or, alternatively, right click and select
Paste from the right-click menu.

Table 2 is now completed and looks like Figure T27.27.

Figure T27.27 - The T Cell table completed.

To see the results of the table expressed in a bar plot (Figure T27.28), please
click on the Bar Plots page tab (for instructions on creating bar plots, please visit
the Bar and Scatter Plots tutorial ). You will see that the B-Cell MESF values for
the Patient Serum are slightly elevated over negative controls yet well below the
positive control. The T-Cell MESF values for the Patient Serum fall within the
negative control range and are also well below the positive control value.
1725
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Figure T27.28 Bar Plots Displaying the FITC MESF HLA Cross Match Data from Band T-cells

Next, we will save a previously created regression for use in another layout

40.18.4

1721

.

Save a Regression

Once a formula for a linear regression has been defined, we can display it in our
layout, use it to overlay a line fit on the scatter plot, and even save the formula
as a keyword for use in future experiments and analysis. Since it is typical to
have one layout for calibration and another for analysis, it is useful to save a
regression for use in any layout. In this section, you will learn how to save a
regression formula as a keyword for use in any layout.
1. Load the FITC MESF Beads Completed.fey layout located in the
Regression Analysis folder within the Tutorial Sample Data archive

1212

.

2. Drag the LinFitLogMedMESF custom token from the Custom Tokens
window onto a blank area of the layout.
A new text box will be automatically created and the linear fit token will be
inserted in it. The linear fit token will be displayed as in Figure T27.28.
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Figure T27.28 LinFitLogMedMESF Custom Token Formula
Output Displayed in a Text Box

3. Right-click on the text box.
4. Choose Copy from the pop-up menu.
5. Open a text editor application such as Notepad for Microsoft Windows.
6. Paste the text box in the text editing software.
7. Enter a '$' symbol followed by the name you would like the keyword
displayed as before the formula followed by an equals sign (Figure
T27.29). In this case, use: '$FITCMESFCalib='

Figure T27.29 Creating an Extra Keyword for the Regression Formula in Notepad

8. Save the text document as FITCMESFCalib.AllExtraKeywords.txt (Figure
T27.30) in a location that will be easy to access such as your Desktop.

Figure T27.30 Saving the Keyword Text Document

FCS Express has the capability to load keywords from external files as part of
loading a data file 648 . These keywords are treated within FCS Express as if they
were originally part of the data file itself. This is a convenient way to introduce
externally derived data into your analysis template. We will make the regression
keyword available for use in another layout in the following steps.
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9. Copy the FITCMESFCalib.AllExtraKeywords.txt file you just created and
paste it into the Regression Analysis folder within the FCS Express
Sample Data directory (Figure T27.31).

Figure T27.31 Paste the
FITCMESFCalib.AllExtraKeywords.txt File
into the Linear Regression Analysis Folder

10. Load the HLA CrossMatch Keyword Regression.fey layout located in
the Regression Analysis folder within the FCS Express Sample Data
Directory.
This layout contains sample files and a page for MESF Calculations. We will now
use the regression formula saved as a keyword to complete the table.
11. Click the Tcell LogMESF Patient Custom Token to select it.
12. Right-click in Enter the Custom Token formula below area of the
Custom Tokens window.
13. Choose
[modelParameters]) from the pop-up menu.
14. Highlight the text 'x' in the formula brackets.
15. Right-click on the highlighted text.
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16. Chose Insert Token from the pop-up menu.
17. Double-click the Tcell LogPatient token from the Custom category.
18. Highlight the text [modelParameters] in the formula (Note: the
brackets must be selected in this instance).
19. Right-click on the highlighted text.
20. Choose Insert Token from the pop-up menu.
21. Double-click on Keyword. The Create Keyword dialog opens.
22. Choose the Keyword category in the Create Keyword dialog (Figure
T27.32, ).

Figure T27.32 Choosing the $FITCMESFCALIB Keyword Token

23. Click on the ellipsis (Figure T27.32,

).

24. Scroll to and click on the $FITCMESFCALIB keyword (Figure T27.32,
).
26. Click OK in the Please select a keyword dialog (Figure T27.32,
27. Click OK in the Create keyword dialog (Figure T27.32,

).

).

28. Enter an "=" sign before the formula.
The formula will now look like Figure T27.33.
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Figure T27.33 Completed Custom Token Formula for Tcell
LogMESF Patient

Tables or spreadsheets for your analysis may now be populated using the
custom tokens you have defined. The formulas use the regression stored as a
keyword in the data.
In summary, when trying to create any kind of calibration regression to apply to
your sample data, the best practice is to have a layout that is used for creating
the regression. This will contain all of your controls. You then save the final
regression as an "allextrakeywords.txt" file. Create another analysis layout that
is used to analyze the actual data and apply the regression you created. The
analysis layout will get the regression from the keyword that you defined in the
"allextrakeywords.txt" file. By placing the "allextrakeywords.txt" file into the
folder with the appropriate data files, you ensure that all the data files actually
contain the regression that you wish to use.

40.19

Working with Pie, Bar, and Scatter Plots Spreadsheets Use Case 4

Introduction:
In FCS Express 6, data can be displayed in Bar Plots, Scatter Plots, or Pie Charts
that update in real-time as you advance through your dataset or adjust your
gates. This eliminates intermediate steps in your workflow such as creating
tables, exporting and reassembling data in a spreadsheet program, and manually
generating new graphs to evaluate additional data or a change in your gating
positions or hierarchy. Bar Plots, Scatter Plots, and Pie Charts can be formatted
and exported to PowerPoint and PDF, just like any other plot in FCS Express-so you can summarize your results and generate publication-quality graphics in
record time.
In the course of this tutorial you will learn how to:
Plot your data in a Bar Plot, Scatter Plot, or Pie Chart

1726

Create tokens for use in Bar Plots, Scatter Plots, or Pie Charts
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Manually enter values for Bar Plots, Scatter Plots, or Pie Charts
Use tokens for creating error bars on your plots

1726

1746

Create conditional formulas to emphasize interesting data sets

1752

Display additional datasets (as Overlays on Bar and Scatter Plots, or a Ring
on Pie Charts)
1756

Format the appearance of Bar and Scatter Plots and Pie Charts

1746

Please see the table below for an overview of the options for working with each
plot type.

Add Data to Plots
by
Drag
and
Drop
Bar Plots
Scatter
Plots
Pie Charts

Formatting Feature

Data Emphasis
Spreadshee Error
(according to usert
Bars
defined criteria)
(Highlight)

(as
Overlay)

(Highlight)

(as
Overlay)

(Explode)

(as Ring)

In the first exercise, we will create bar and scatter plots

40.19.1

Display
Additional
Datasets

1726

.

Creating Bar and Scatter Plots and Pie Charts

Bar Plots, Scatter Plots, and Pie Charts graph data from Spreadsheets. The cells
of the spreadsheet can contain statistical tokens based on your plotted data, or
freetext. You may want to familiarize yourself with Spreadsheets prior to
beginning this tutorial by visiting the Spreadsheet tutorial .
1635
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Note that Bar Plots and Pie Charts can be populated by drag-and-drop directly,
but the Spreadsheet must be accessed to add formatting elements such as Error
Bars and Data Emphasis features (i.e., Highlighting and Exploding).
In this section of the tutorial, we will learn to:
Insert a Spreadsheet onto the layout and populate it with freetext and
statistical tokens.
Create a Bar Plot

1727

Create a Pie Chart

.

1733

.

Create a Scatter Plot
(also see the Regression Analysis tutorial
more details on creating live updating regression analysis).
1740

40.19.1.
1

1701

for

Creating Bar Plots

In this section we will learn to populate a Bar Plot with data from a Spreadsheet.
Please also see our Bar Plots webpage for additional videos and tips on
creating Bar Plots.
1. Select File

Open.

2. Open the layout titled "Bar Pie Scatter begin.fey" within the Tutorial Sample
Data archive.
The layout contains Color Dot Plots and a Spreadsheet from which the Bar
Plot will be derived (Fig. 1). See this section of the manual to see how the
Spreadsheet was added to the layout 413 .
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Figure 1. Spreadsheet on the layout

We will now fill the Spreadsheet with both freetext and live-updating tokens.
First, we will manually enter freetext values that will be used for our bar plot
axis labels.
3. Click on Cell A1 in the Spreadsheet to highlight it.
4. Type "live" (Fig. 2,

).

5. Press Enter on the keyboard.
6. Repeat steps 3-5 for Cells A2 and A3 in the Spreadsheet, typing in "apo" and
"necro", respectively. The Spreadsheet will now appear as below (Fig. 2).
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Figure 2. Entering freetext into a Spreadsheet

We will now select statistic tokens to plot in the Bar Plot or Pie Chart and
place them in the Spreadsheet. Using tokens will allow live-updating of plots
as you adjust your gates or advance through your dataset.

7. Drag and drop the "live" gate from the 6 hr treatment plot at upper left into
Cell # B1 of the Spreadsheet. While dragging, the gate outline will move (Fig.
3, ).
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Figure 3. Dragging and dropping a statistic token into the Spreadsheet.

8. Select % of gated cells from the Statistic list box in the Edit Statistic
dialog (Fig. 3, ).
9. Click OK (Fig. 3,

).

The B1 cell of the Spreadsheet will now contain the %-gated statistic for the
"live" gate, as shown in Fig. 3, bottom.

10. Repeat steps 7-9 for the "apo" and "necro" gates of the 6 hr treatment plot
respectively into Cell #s B2 and B3. The Spreadsheet will now appear as in
Fig. 4.
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Figure 4. Spreadsheet with B column filled with %-gated
statistic tokens

Note: Steps 1-10 can also be accomplished via drag-and-drop of statistics,
gates, or plots directly to the Bar Plot 546 , without using a Spreadsheet. Please
see this section of the manual for a pictorial guide 546 .
11. Select the Insert tab

command (Fig. 5).

Figure 5. Inserting a Bar Plot

12. Click on an empty space on the layout (e.g., to the right of the Spreadsheet)
to insert a Bar Plot (Fig. 6).
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Figure 6. Bar Plot inserted on the layout

We will now rename the Bar Plot axes.
13. Double-click the Bar Plot to open the Formatting dialog.
14. Click on the Axis category (Fig. 7,

).

15. Click the The specified text below radio button (Fig. 7,
16. Type "%-gated" into the Text box under Title (Fig. 7,
17. Click X Axis under Select Axis (Fig. 7,

).
).

).

18. Type "subset" into the Text box under Title.
19. Click OK (Fig. 7,

).

The Bar Plot will now appear as in Fig. 7, right.
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Figure 7. Bar Plot with Renamed Axes.

Note: Bar color, style, and other attributes of a Bar Plot can be customized.
See the Formatting Bar Plots 553 section of the manual for details.
20. Optional:
Click the Data tab
Next/Previous buttons to
advance through the set of files in the Data List and watch as the Bar Plot
updates with the new data.
Adjust the gates on the plots and watch the Bar Plot update in real-time.
Go on to the next section to create a Pie Chart
jump to the section on Formatting Bar Plots
40.19.1.
2

from the same raw data. Or,

1733
1746

.

Creating Pie Charts

Creating Pie Charts in FCS Express is much like creating Bar Plots, in that they
can be populated via a Spreadsheet or by drag-and drop.
1. Select File

Open.

2. Open the layout titled "Pie begin.fey" within the Tutorial Sample Data archive.
This layout contains Color Dot Plots and a Spreadsheet that has already been
© 2020 De Novo Software
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filled with one row of tokens and freetext.
3. Select the Insert tab

command (Fig. 8).

Figure 8. Inserting a Pie Chart

4. Click on an empty space on the layout (e.g., to the right of the Spreadsheet)
to insert a Pie Chart (Fig. 9).

Figure 9. A Pie Chart inserted on the layout

We will now use the drag-and-drop functionality of FCS Express 6 to add new
sectors (slices) and replace old ones.
5. Drag and drop the "apo" gate from the 6 hr treatment plot at left to an empty
spot on the Pie Chart (not on the pie sector itself) (Fig. 10).
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Figure 10. Dragging a gate to a Pie Chart to create a new sector (slice)

6. Select "% of gated cells" from the Statistic box in the Edit Statistic dialog
(Fig. 11).
7. Click OK. A new sector (slice) displaying this statistic now appears as in Fig.
11, right.
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Figure 11. Choosing a statistic to plot on the Pie Chart after dragging a gate

8. Repeat Steps 5-7 for the "necro" gate of the 6 hr treatment plot at left, so
that the Pie Chart will have a total of three sectors (slices).

We will now Format the Pie Chart.
9. Right-click on the Pie Chart.
10. Choose Format from the pop-up menu (Fig. 12).
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Figure 12. Accessing Formatting options of the Pie Chart

11. Choose the Legend category (Fig. 13,
12. Check the Visible box (Fig. 13,
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Figure 13. Adding a Legend to the Pie Chart

13. Click Preview (Fig. 13, ). The Pie Chart will now display the name of each
subset (listed in the first column of the Custom Data Grid) in the Legend (Fig.
13, right).
14. Choose the Overlays category (Fig. 14,

).

The Name Parameter is derived by default from the first column of the Custom
Data Grid on your layout. It appears as "subset" or as "A", depending on the
appearance of your Custom Data Grid.
The Value parameter is derived by default from the second column of the
Custom Data Grid. It appears as "%-gated" or as "B", depending on the
appearance of your Custom Data Grid. It is displayed by default as a Caption
for each slice of the Pie Chart (Fig 18, upper right). The Caption can be
formatted to display any combination of Name, Value, or Percentage for each
sector (slice) of the Pie.
15. Check any combination of Value, Percentage, and Name from the Caption
Style section of the Overlays category to customize the Caption with the
desired information (Fig. 14, ).
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Figure 14. Editing the Caption Style of the Pie Chart

16. Click Preview to view the Caption Style change (Fig. 14, mouse arrow).
Note: Clicking on the Caption in the Pie Chart allows for direct editing of the
Captions with freetext or tokens of your choice 544 . Pie shadow, donut vs.
pie appearance, color scheme, and other attributes can also be
customized. See the Formatting Pie Charts 541 section of the manual for
details.
17. Optional:
Click the Data tab
Next/Previous buttons to
advance through the set of files in the Data List and watch as the Pie Chart
updates with the new data.
Adjust the gates on the plots and watch the Pie Chart update in real-time.
Optional: Explore Pie Chart color formatting options in Steps 18-28. Or, go to
the Formatting section of this tutorial
to learn how to Explode slices for
emphasis and display an additional dataset as a Ring at the periphery of the
Pie.
1746

© 2020 De Novo Software

FCS Express 6 Manual

1740

18.Select Modern from the Color Schemes dropdown list (Fig. 15, ). Note:
there are many predefined color schemes that may be chosen for display.

Figure 15. Changing the Color Scheme

19.Click Preview (Fig. 15, mouse arrow).
The Pie Chart colors have now been reformatted with the Modern color scheme.
(Fig. 15, right)
Go on to the next section to create a Scatter Plot
from the same Color Dot
Plots on this layout. Or, jump to the Formatting section of this tutorial
to
learn how to Explode Pie slices for emphasis and display an additional dataset
as a Ring at the periphery of the Pie.
1740
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40.19.1.
3

Creating Scatter Plots

1. Select File

Open.

2. Open the layout titled "Bar Pie Scatter begin.fey" within the Tutorial Sample
Data archive.
The layout contains Color Dot Plots and a Spreadsheet from which the
Scatter Plot will be derived (Fig. 22). See this section of the manual to see
how the Spreadsheet was added to the layout 413 .
We will now fill the Spreadsheet with both freetext and live-updating tokens.
First, we will enter the independent parameters for the Scatter Plot. Note
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that in contrast to Bar Plots and Pie Charts, the x-axis values in a Scatter
Plot must be numeric. We will enter the hours of treatment indicated in the
title for each Color Dot Plot as this parameter.
3. Click on Cell A1 in the Spreadsheet (Fig. 1,

) to highlight it.

4. Type "0" in the Custom Data Grid formula editor (Fig. 1,

).

5. Press Enter on the keyboard.
6. Repeat steps 3-5 for Cells A2 and A3 in the Spreadsheet, typing in "6" and
"12", respectively. The Spreadsheet will now appear as in Fig. 1, right.

Figure 1. Typing freetext into a Spreadsheet

We will now insert tokens into the Spreadsheet to display on the Scatter Plot.
7. Drag the "live" gate from the 6 hr treatment plot onto cell B2 of the
Spreadsheet. While dragging, the gate outline will move (Fig. 2, ).
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Figure 2. Dragging and dropping a statistic token into a Spreadsheet

8. Select % of gated cells from the Statistic list box in the Edit Statistic
dialog (Fig. 2, ).
9. Click OK (Fig. 2, ). The B2 cell of the Spreadsheet will now contain the %gated statistic for the "live" gate of the 6 hr treatment Color Dot Plot (Fig.
2, bottom).
10. Repeat steps 7-9 for the 12 hr treatment and Control (no treatment) Color
Dot Plots, dragging the "live" gate from each plot into cell #s B1 and B3,
respectively. The Spreadsheet will now appear as in Fig. 3.

Figure 3. Completed Spreadsheet

11. Select the Insert tab

command (Fig. 4).
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Figure 4. Inserting a Scatter Plot

12. Click on an empty space on the layout (e.g., to the right of the Spreadsheet)
to insert a Scatter Plot (Fig. 5).

Figure 5. Inserted Scatter Plot

We will now rename the Scatter Plot axes.
13. Double-click the Scatter Plot to open the Formatting dialog.
14. Click on the Axis category (Fig. 6,

).

15. Click the The specified text below radio button (Fig. 6,
16. Type "%-gated" into the Text box under Title (Fig. 6,
17. Click X Axis under Select Axis (Fig. 6,

).
).

).

18. Type "treatment time (hr)" into the Text box under Title.
19. Click OK (Fig. 6,

).

The Scatter Plot will now appear as in Fig. 6, right.
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Figure 6. Scatter Plot with Renamed Axes

We will now adjust the range of the Scatter Plot so that the points are more
readily visible.
20. Double-click the Scatter Plot to open the Formatting dialog from the pop-up
menu.
21. Select the Axis category (Fig. 7,

).

Figure 7. Adjusting range of the Scatter Plot from the Formatting dialog

22. Enter "100" as the Maximum (Fig. 7,

).
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23. Click on X-axis of the Select Axis section (Fig. 7,
24. Enter "-4" as the Minimum (Fig. 7,

).

25. Enter "16" as the Minimum (Fig. 7,

).

26. Increase the # Ticks to 5 (Fig. 7,

1745

).

).

27. Click OK.
The Scatter Plot will now appear as in Fig. 8.

Figure 8. Completed Scatter Plot with
adjusted range

Note: Point color, shape, connecting lines, and other attributes of a Scatter Plot
can be customized. See the Formatting Scatter Plots 560 section of the
manual for details.
28.Optional:
Click the Data tab
Next/Previous buttons to
advance through the set of files in the Data List and watch as the Scatter
Plot updates with the new data.
Adjust the gates on the Color Dot Plots and watch the Scatter Plot update
in real-time.
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40.19.2

Formatting Bar and Scatter Plots and Pie Charts

Like any other plot in FCS Express, Bar Plots, Scatter Plots, and Pie Chart axes,
titles, legends, backgrounds, and more are fully formattable 245 . In this tutorial
section we will focus on learning how to apply the special formatting features
listed below. Please click on the links below or in the table to jump to a tutorial
topic.
Adding Error Bars to Bar and Scatter Plots
Formatting Highlighting and Explode data emphasis features
Adding an additional dataset to a Spreadsheet
Creating Overlays on Bar and Scatter Plots
Creating a Ring on a Pie Chart
1746

1752

1756

1758

1760

Add Data to Plots
by
Drag
and
Drop

Formatting Feature

Display
Data Emphasis
Spreadshee Error
Additional
Bars (according to usert
Datasets
defined criteria)
1752

1746

1756

Bar Plots
Scatter
Plots
Pie Charts

40.19.2.
1

(Highlight

(Highlight

(Explode

1752

1752

1752

)

)

)

(as
Overlay
(as
Overlay
(as Ring
)

1758

)

1758

)

1760

Adding Error Bars

Error Bars and Highlighting can be added to Bar Plots and to Scatter Plots. In this
example, we will add these features to a Bar Plot.
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Open.

2. Open the layout titled "Error Bars.fey" within the Tutorial Sample Data archive.
A Spreadsheet and its associated Bar Plot without Error Bars or Highlighting
already exist on the layout. The Bar Plot is graphing the means of the "apo"
and "necro" %-gated statistic for each of the three Color Dot Plots. This is
accomplished through the use of array formulae 745 within the Spreadsheet,
which can be seen when clicking on Cell E1 (Fig. 1).

Figure 1. Array formula for calculating the mean of three tokens in a Spreadsheet

We will also employ an array formula 745 to calculate the error bars in this
example; however, error bars may also derive from default Statistic Tokens
or from freetext.
3. Click on Cell F1 of the Spreadsheet (Fig. 2,

) to select it.

4. Click the Formulas tab, which has now been revealed in the formerly hidden
Spreadsheet tab family (Fig. 2, ).
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Figure 2. Inserting a function into the Spreadsheet cell

5. Click the Statistical command (Fig. 2,

).

6. Scroll down through the menu of Statistical formulas (Fig. 2,
"STDEVA" is visible.
7. Select "STDEVA" from the menu (Fig. 3,

) until

).
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We will now enter Cells B1-D1 as components of the StdDev array formula.

8. Click Cell B1 of the Spreadsheet (Fig. 3, ), while the cursor is within the
parentheses of the "STDEVA" formula, as shown by the green arrow.
9. Type a comma (") (Fig. 3,

).

10. Repeat Steps 8-9 for Cells C1-D1 of the Spreadsheet. When complete, the
filled-in formula will appear as in Figure 3, bottom.

Figure 3. Entering components of the Standard Deviation formula

The Custom Data Grid "apo" row now contains a complete StdDev array formula
for the error bar, which has been evaluated with the result shown in Cell F1
(Fig. 4).

Figure 4. Numerical result of completed array formula within the Spreadsheet

We will now enter the corresponding mean and error bar formulas for the
"necro" row of the Custom Data Grid, by dragging the appropriate Cells within
the Spreadsheet to fill the series.
11. Click on Cell E1 in the Spreadsheet, which contains the complete AVERAGE
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formula that was created for you in the layout, prior to beginning the tutorial.
12. Hover the mouse pointer over the lower-right corner of Cell E1 in the
Spreadsheet, until the cursor forms a crosshair (Fig. 5, ).

Figure 5. Filling a series in the Spreadsheet.

13. Drag the mouse to the lower-right corner of Cell E2 in the Spreadsheet, while
keeping the mouse button pressed (Fig. 5, ).
14. Release the mouse button (Fig. 5,
as a result of filling the series.

). A numerical value appears in Cell E2

15. Double-click Cell E2 to view the formula and its components (Fig. 5, ).
Note that the formula was extended faithfully, but refers to the "necro" %gated values from Row 2 in the Spreadsheet.
16. Repeat Steps 11-15 for Cell F1, to fill the formula for the Standard Deviation
of the "necro" %-gated values. The Spreadsheet will then appear as in Figure
6 below.
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Figure 6. The Standard Deviation for the "necro" row values has been calculated
by filling the appropriate cell in the Spreadsheet.

We will now format the Bar Plot to derive the error bars from the appropriate
column in the Spreadsheet.
17. Double-click the Bar Plot to open the Formatting dialog.
18. Click on the Overlays category (Fig. 7,

).

Figure 7. Adding error bars to a Bar Plot in the Formatting dialog

19. Choose "F", which refers to the column F of the Spreadsheet, from 2D Bar
dropdown list (Fig. 7, ).
20. Select red from the Color dropdown menu of the Error Bar Properties
section (Fig. 7, ).
21. Click OK (Fig. 7,

).

The Bar Plot will now appear as in Fig. 7, right.
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22. Optional:
Click the Data tab
Next/Previous buttons to
advance through the set of files in the Data List and watch as the Bar Plot
and Scatter Plot update with the new data.
Adjust the gates on the plots and watch the Bar Plot and Scatter Plot
update in real-time.
In the next section we will add highlighting and exploding parameters to Bar,
Scatter, and Pie Plots.
1752

40.19.2.
2

Adding Highlighting or Exploding

We will now add a Highlight or Explode parameter to a Bar Plot and Pie Chart.
The Highlight/Explode parameter must be a formula in the Spreadsheet
evaluating to "TRUE" or "FALSE"; if "TRUE," the bar will be highlighted in a
selected color or the pie sector (slice) will explode away from the Pie for
emphasis. The Layout used in this section contains a Spreadsheet and an
associated Bar Plot and Pie Chart, to which we will now add a Highlight or
Explode rule, respectively.
Note: Highlighting may be added to Scatter Plots in an identical manner to
Bar Plots, but for simplicity, we have omitted the Scatter Plot from this
section.
1. Select File

Open.

2. Open the layout titled "Highlighting and Exploding.fey" within the Tutorial
Sample Data archive. The Bar Plot and Pie Chart are graphing the mean of
the three subsets ("live", "apo", and "necro") for the three replicates in the
Dot Plots.
3. Click on Cell D3 of the Spreadsheet (Fig. 1,

).

4. Click the Formulas tab, which has now been revealed in the formerly hidden
Spreadsheet tab family (Fig. 1, ).
5. Click the Logical command (Fig. 1,
6. Select "IF" from the menu (Fig. 1,
below (Fig. 1, bottom).

).
). The Spreadsheet will now appear as
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Figure 1. Entering a Highlighting rule containing the Logical operator "IF" into the
Spreadsheet.

We will now enter Cell B3 as a component of the highlighting formula.

7. Click Cell B3 of the Spreadsheet (Fig. 2, ), while the cursor is within the
parentheses of the "IF" formula, as shown by the green arrow.
8. Type ">5.5" (Fig. 2,
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Figure 2. Entering a Spreadsheet cell as a component of the
Highlighting rule.

9. Click on the Layout outside of the Spreadsheet. The result of the Logical
formula will appear as "TRUE" (Figure 3).
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Figure 3. Result of the Logical "IF" fourmula.

If desired, an analogous procedure to Steps 3-8 could be followed to create a
Highlight or Explode rule for the "live" and "apo" rows of the Spreadsheet.

We will now format the Bar Plot or the Pie Chart to derive the Highlight or
Explode rule from the appropriate column of the Spreadsheet.

10. Double-click the Bar Plot or the Pie Chart to open the Formatting Bar or Pie
dialog (Fig. 4, upper or lower pane, respectively).
11. Click the Overlays category (Fig. 4,

).

Figure 4. Designating the Custom Data Grid column from which the Highlighting or
Explode rule will be derived

12. Choose "D" from the Highlight Param or Explode Parameter dropdown
list (Fig. 4, ) of the Formatting Bar or Formatting Pie dialog, respectively.
13. Click OK in the Formatting Bar or Pie dialog (Fig. 5).
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Figure 5. Clicking OK in the Formatting dialog.

The Bar Plot or Pie Chart will now appear as in Fig. 4, right. Note the following
change:
in the Bar Plot, the "necro" bar is highlighted. The Highlight Color and
other visual formatting elements of the Bar Plot may be customized from
the Overlays category. See this section of the manual 554 for details.
the Pie Chart, the "necro" sector (slice) has exploded away from the rest
of the Pie for emphasis. Sector (slice) Color and other visual formatting
elements of the Pie Chart may be customized from the Overlays category.
See this section of the manual 542 for details.
14. Optional:
Click the Data tab
Next/Previous buttons to
advance through the set of files in the Data List and watch as the Bar Plot
and Pie Chart update with the new data.
Adjust the gates on the plots and watch the Bar Plot and Pie Chart update
in real-time.
Go on to the next section to learn how to display additional datasets
Overlays on Bar and Scatter Plots, and as a Ring on a Pie Chart.
40.19.2.
3

1756

as

Displaying Additional Datasets

Additional datasets and parameters can be displayed on Bar and Scatter Plots as
well as on Pie Charts. Bar and Scatter Plots can display multiple additional
datasets as Overlays, while Pie Charts can display one additional dataset as a
Ring.
In this section of the tutorial, we will enter an additional dataset into a
Spreadsheet which can be subsequently displayed on a Bar Plot, Scatter Plot, or
Pie Chart.
1. Select File

Open.

2. Open the layout titled "Displaying Additional Datasets.fey" within the
Tutorial Sample Data archive.
The layout a contains a Spreadsheet and its associated Bar Plot, Scatter Plot,
and Pie Chart. The %-gated statistic for the "apo" gate is being plotted.
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We will now add a %-gated statistic for the "necro" gate to the
Spreadsheet.
3. Drag and drop the "necro" gate from the 6 hr treatment Color Dot Plot to cell
C1 of the Spreadsheet. While dragging, a ghost of the gate outline will move
(Fig. 1, ).

Figure 1. Entering the first member of an additional dataset into an empty column
in the Spreadsheet.

4. Select % of gated cells from the Statistic list box in the Edit Statistic
dialog (Fig. 1, ).
5. Click OK (Fig. 1, ). The C1 cell of the Spreadsheet will now contain the %gated statistic for the "necro" gate, as shown in Fig. 2, left.
6. Repeat steps 3-5 for the "necro" gate of the 12 hr treatment plot. The
Spreadsheet will now appear with the %-gated statistic in Cell C2 (Fig. 2,
right).

Figure 2. Populating the Spreadsheet with statistics from the 12-hr treatment plot.

The "necro" dataset is now complete within Column C of the Spreadsheet
(Fig. 2, right). We will now format the Bar Plot, Scatter Plot , and/or Pie
Chart
to display this additional dataset from the appropriate column of
the Spreadsheet.
1758
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40.19.2.3.1 Overlays on Bar and Scatter Plots

In this section of the tutorial, we will display an additional dataset as an Overlay
on a Bar Plot and/or Scatter Plot. Please complete the preceding section of
the tutorial (Displaying Additional Datasets ) before proceeding.
1756

1. Click on the border of the Spreadsheet so it is highlighted in red.
2. Drag and drop the Spreadsheet onto the Bar Plot or Scatter Plot (Fig. 1,

).

Figure 1. Dragging and dropping a Spreadsheet onto a Bar or Scatter Plot to create
an overlay

3. Click the add the files to the new plot as new overlays radio button (Fig.
1, ).
4. Click OK (Fig. 1, mouse pointer).
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The Bar Plot or Scatter Plot will now appear as in Fig. 1, bottom.
The new Overlay has defaulted to the second ("apo") column of the
Spreadsheet for its values. We will now reformat the plot to derive the
values from the third ("C") column, in order to plot the "necro" gatederived values.
5. Double-click the Bar or Scatter Plot to open the Formatting Bar or
Formatting Scatter dialog (Fig. 2, upper or lower pane, respectively).
6. Click the Overlays category (Fig. 2,

).

Figure 2. Designating the Spreadsheet column from which the new overlay will be
derived

7. Click 2- New spreadsheet from the 2D Bar Overlays or 2D Unbinned
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Overlays list (Fig. 2,

)

8. Choose "C" from the Bar Values or Y Parameter dropdown list of the
Formatting Bar or Formatting Scatter dialog, respectively (Fig. 2, ).
9. Click OK (Fig. 2, mouse pointer). The Bar Plot or Scatter Plot now appears as
in Fig. 2, right.
Note: Color, style, size, and other attributes of bars on a Bar Plot and points
on a Scatter Plot can be customized independently for each overlay. See
the following sections of the manual for details:
Formatting Bar Plots 553
Formatting Scatter Plots 560
10. Optional:
Click the Data tab
Next/Previous buttons to
advance through the set of files in the Data List and watch as the Bar Plot,
Scatter Plot, and Pie Chart update with the new data.
Adjust the gates on the plots and watch the Bar Plot, Scatter Plot, and Pie
Chart update in real-time.
40.19.2.3.2 Ring on Pie Chart

In this section of the tutorial, we will display an additional dataset as a Ring on a
Pie Chart. Please complete the Displaying Additional Datasets
section of
the tutorial before proceeding.
1756

1. Double-click the Pie Chart to open the Formatting dialog.
2. Click the Overlays category (Fig. 1,

).

© 2020 De Novo Software

Tutorials

1761

Figure 1. Displaying an additional dataset as a Ring on a Pie Chart

3. Choose "C" from the Ring Parameter dropdown list of the Formatting Pie
dialog (Fig. 1, ).
4. Click OK (Fig. 1, ). The Pie Chart now appears with the "necro" dataset as
a ring at the periphery of the pie (Fig. 1, right).
5. Optional:
Click the Data tab
Next/Previous buttons to
advance through the set of files in the Data List and watch as the Bar Plot,
Scatter Plot, and Pie Chart update with the new data.
Adjust the gates on the plots and watch the Bar Plot, Scatter Plot, and Pie
Chart update in real-time.

40.20

DNA Analysis

In this tutorial, you will learn how to use MultiCycle to analyze different types of
cell cycle histograms. There are ten different histogram files named ASCII1.fcs
through ASCII10.fcs, located in the FCS Express Sample Data folder, that show
different DNA cell cycles to explore MultiCycle.
The true strength of MultiCycle is its ability to analyze cell cycle histograms with
multiple models coupled with the batch processing ability of FCS Express.
FCS Express includes a basic version of MultiCycle. The basic version will fit a
single cycle model to your data without background or aggregate/debris
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correction. A single cycle analysis means only one population of cells will be
modeled. The advanced version can fit up to two aneuploid populations
(considered a 3-cycle model) as well as apply sophisticated background and
aggregate/debris correction. The advanced version must be purchased
separately.
In the course of this example, we will:
Use gating to exclude doublets.
Use Autofit in MultiCycle to analyze a DNA histogram.
Format MultiCycle histograms.
Use MultiCycle without Autofit to analyze a DNA histogram.

In the first exercise, we will use autofit selection for a single cycle analysis

40.20.1
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.

Autofit Selection (1 Cycle Analysis)

Setting gates to exclude doublets:
In order to exclude doublets, we will examine a 2D dot plot of the DNA
fluorescence height versus the DNA fluorescence area signal and draw a gate on
the single cell events. Many times, users will also use the plot of the DNA
fluorescence width signal versus the DNA fluorescence area signal. The Height
signal corresponds to the peak intensity of fluorescence pulse from the DNA dye.
The Area signal is the calculated area under the fluorescence pulse emitted by the
DNA dye. The Width signal represents the length of time of the fluorescence pulse
emitted by the DNA dye. The specific geometry of the laser beam and other
instrument factors determine which parameters are best suited to discriminate
single cell events from doublets. In our example, DNA fluorescence area signal is
the FL2-A parameter, DNA fluorescence width is the FL2-W parameter, and DNA
fluorescence height is the FL2-H parameter.
If a new blank layout is already open then proceed to step 2.
1. Select the File tab

.

2. Select the Insert tab

command.

3. Click anywhere inside the blank layout.
The Select a Data File dialog appears (Figure T19.1).
4. Navigate to the Tutorial Sample Data folder.
5. Make sure that FCS files (*.*, *.fcs, *.lmd) is chosen as the Files of
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type.
6. Select the file BD.LMD.FCS (Figure T19.1).
7. Click Open.

Figure T19.1 Select a Data File Dialog

A dot plot appears on the layout
7. Left-click on the x-axis and select FL2-H from the pop-up menu.
8. Left-click on the y-axis and select FL2-A from the pop-up parameter
menu. The dot plot should appear similar to Figure T19.2.
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Figure T19.2 Dot Plot of FL2-H vs
FL2-A

We will now create a gate on the 2D plot to exclude the doublets as well as to
exclude what appear to be tetraploid amounts of DNA. We are excluding these
cells with higher amounts of DNA because we want to perform a single cycle DNA
analysis. Please refer to Figure T19.3 during the following steps. For more
information on creating gates, please refer to the Gating tutorial .
1268

9. Select the Gating tab

command.

10. Create a polygon gate similar to the gate shown in Figure T19.3.
The Create a New Gate dialog appears.
12. Name the gate 'singlets HA'.
The gate should look similar to Figure T19.3.
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Figure T19.3 Gate to Exclude Doublets
and Cells iwth High DNA Content

We are now ready to use the Autofit function in MultiCycle to perform a DNA cell
cycle analysis.
Inserting a MultiCycle histogram:
13. Select the Insert tab
T19.4).

command (Figure

14. Click on a blank area of the layout.

Figure T19.4 Selecting the Insert Muticycle DNA Command

The Select DNA parameter dialog appears, as shown in Figure T19.5. Please
refer to Figure T19.5 for the following steps.
18. Select FL2-A as the Parameter, shown highlighted in blue.
19. Click OK.
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Figure T19.5 Select DNA
Parameter Dialog

The histogram of FL2-A, gated on singlets HA, is analyzed by MultiCycle using
the Autofit function and appears on the layout (Figure T19.6). Note that your
plot may differ from the figure depending on your singlets gate shape.
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Figure T19.6 MultiCycle Analysis of FL2-A Using Singlets
HA Gate

We will now zoom into the region of interest on the Multicycle plot to improve
the fit.
20. Right-click on the Multicycle plot and select Magnify (Resolution) from
the pop-up menu.
21. Drag the cursor, which is now a crosshair, around the region of interest
as shown (Fig. T 19.7, left).

Figure T19.7 Magnifying resolution on a MultiCycle plot to improve the
fit of the model

22. Release the cursor. The Multicycle plot's fit has updated, and only one
cycling population is now detected, depicted in red (Fig. T 19.7, rright).
We will now display the legend information associated with the MultiCycle DNA
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analysis.
21. Right-click on the histogram to bring up the associated pop-up menu.
22. Select Format from the pop-up menu.
23. Select Legend from the categories section of the Formatting dialog
(Figure T19.8).
24. Click on the Visible checkbox.
25. Click OK (Figure T19.8).

Figure T19.8 Formatting the DNA histogram to Display the Legend Associated with
MultiCycle Analysis

Alternatively, the histogram legend information can be displayed using the
Format Legend command, as follows:
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Left-click to select the histogram; it should be outlined in green.
Select the

command (Figure T19.9).

Figure T19.9 Selecting the Format Legend Command

The Formatting Legend dialog appears (Figure T19.10).
Click on the Visible checkbox in the Formatting Legend dialog.
Click OK.

Figure T19.10 Formatting Legend Dialog
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The legend associated with the MultiCycle DNA analysis will appear to the right of
the histogram (Figure T19.11).

Figure T19.11 MultiCycle DNA Histogram Cell Cycle Analysis with Associated
Legend

As you can see from the legend, this histogram contains only diploid cells and
therefore a single cycle analysis was performed by the Autofit function of
MultiCycle. We can confirm this by examining the MultiCycle information on the
ribbon.
26. Left-click to select the histogram, it should be outlined in green (Figure
T19.11).
27. Select the MultiCycle tab (Figure T19.12).
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Figure T19.12 The Multicycle Tab

Notice that Autofit and Model 1 are highlighted in grey (Figure T19.12). This
indicates that the MultiCycle Autofit function and that Model 1 are being used to
analyze this DNA histogram. Also notice that 1 Cycle, indicated by the cursor in
Figure T19.11, was used in the analysis.
Note: For an explanation of the differences between all the models, please see
the De Novo Software DNA/Multicycle AV knowledgebase page.
We will now view all the different statistics for the DNA analysis of this histogram.
28. Right-click on the DNA histogram to bring up the associated pop-up
menu.
29. Select
T19.13).
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Figure T19.13 DNA Cycle Statistics Pop-up Menu Item

The DNA Cycle Statistics window of the current model (Model 1) will now
appear (Figure T19.14). Note that you will have slightly different values for the
statistics depending on how your singlet gate was drawn.
30. Move the DNA Cycle Statistics window beneath the plot (Figure
T19.14).
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Figure T19.14 DNA Cell Cycle Statistics from the MultiCycle Model 1 Analysis of
the Histogram

31. Right-click on the DNA Histogram to bring up the associated pop-up menu.
32. Select
menu, previously shown in Figure T19.13.

from the pop-up

The DNA Model Summary Statistics window, showing all of the six defined
MultiCycle models applied to the current histogram, appears. The six models
shown in the DNA Model Summary Statistics window correlate respectively
with the six models shown in the
group (Figure
T19.12). The DNA Model Summary Statistics displays the default statistics set
in FCS Express preferences which we will change later in the tutorial.
33. Move the DNA Model Summary Statistics window under the DNA Cell
Cycle Statistics window (Figure T19.15).
34. Right-click on the DNA Histogram to bring up the associated pop-up menu.
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35. Select
previously shown in Figure T19.13.

from the pop-up menu,

The DNA Experiment Statistics window with the interpretation of the DNA
model and the experiment statistics will appear.
36. Move the DNA Experiment Statistics window next to the DNA Model
Summary Statistics window (Figure T19.15).

Figure T19.15 DNA Histogram with All of the MultiCycle
Statistics Windows

In the next section, we will perform an expanded analysis with Autofit

1775

.
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Expanded Analysis with Autofit

We will now adjust the 'singlet HA' gate to include the cells with higher DNA
content. Autofit in the basic version of MultiCycle will continue to perform a one
cycle analysis. However, Autofit in the advanced version of MultiCycle, will
mathematically decide whether to apply a one, two, or three cycle fit to the
histogram data.
Please refer to Figure T19.16 for the final location of the gate.
1. Activate the 'singlet HA' gate for editing by clicking inside the gate.
2. Move the cursor to the top upper right resizing handle of the gate; you will
know you are in the correct place when the cursor changes to a twoheaded arrow.
3. Press and hold down the left mouse button while dragging the corner of
the gate upwards.
4. Release the button when the corner of the gate is in the desired location
(Figure T19.16).
5. Repeat steps 2 through 4 for the top upper left corner of the gate.
The gate should now appear similar to Figure T19.16, modified to include cells
with higher content DNA, but still excluding most of the doublets.

Figure T19.16 Gate Modified to Include
Cells with Higher DNA Content
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The Autofit function of MultiCycle updates the cell cycle analysis, as shown in
Figure T19.17. Note: Figure T19.17 shows the MultiCycle analysis using the
advanced version of Multicycle. The basic version of MultiCycle will continue to
apply a one cycle model to the histogram.
For the rest of this tutorial we will use the advanced version of MultiCycle for the
DNA analysis. However, all the formatting features of the DNA histogram and
related statistics are also available in, and operate in the same way, in the basic
version of MultiCycle.
Note that the DNA analysis now shows an aneuploid population, shown in blue in
Figure T19.17. In fact, the MultiCycle Interpretation suggests that this is most
likely a tetraploid population. Also of note is that a 2-cycle model was used. This
information is shown in the Experiment Statistics window and can also be found
by selecting the DNA histogram and then selecting the Multicycle tab.

Figure T19.17 Autofit MultiCycle Analysis with Modified gate
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We will now select the specific statistics we want to display in the DNA Model
Summary Statistics table. There multiple ways of selecting the statistics shown
in the table and these same methods can be used to select which statistics are
shown for any of the DNA-associated statistics shown in the pop-up menu on
Figure T19.13 . For more information on formatting, please see the tutorial on
Formatting Plots . First, we will close the DNA Experiment Statistics window
so that we have room to expand the DNA Model Summary Statistics
window.
1772

1238

6. Hover the mouse over the border of the DNA Experiment Statistics
window.
7. Left-click when the cursor changes to a four-headed arrow; you will know
it is selected for editing because it will have a red border.
8. Press Del on the keyboard or select delete from

.

9. Left-click inside the DNA Model Summary Statistics window to select it.
10. Select the

command.

The Formatting Stats Options dialog appears (Figure T19.18).

© 2020 De Novo Software

1778

FCS Express 6 Manual

Figure T19.18 Formatting Stats Options Dialog for DNA Model Summary
Statistics

11. Select the down arrow, shown by the cursor on Figure T19.18.
12. Continue to hold down the left mouse button to scroll down to the
bottom of the list.
13. Click on the box next to Clump and Debris as shown in Figure T19.19.
14. Click OK.
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Figure T19.19 Selecting Clump and Debris from the Formatting Stats Options
Dialog

The DNA Model Summary Statistics table will now update to show the
selected statistics as shown in Figure T19.20.
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Figure T19.20 DNA Model Summary Statistics
Table Updated to Show to Clump and Debris

Alternatively, you can use the DNA Model Summary Statistics associated popup menu to select, or De-select, the specific statistics to display.
Right-click on the DNA Model Summary Statistics window to bring the
associated pop-up menu.
The DNA Model Summary Statistics pop-up menu appears (Figure T19.21).
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Figure T19.21 DNA Model Summary
Statistics Pop-up Menu
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Select the arrow in the lower left corner of the menu to scroll down,
indicated by the cursor in Figure T19.21.
Continue to hold down the left mouse button until the menu scrolls all the
way down (Figure T19.22).
Left-click next to Clump, as indicated by the cursor on Figure T19.22, to
de-select the item.
The pop-up menu will now close and the DNA Model Summary Statistics table
will update to reflect the removal of the item Clump.
Repeat the above steps to de-select Debris, located under Clump in Figure
T19.22.
The pop-up menu will now close and the DNA Model Summary Statistics table
will update to reflect the removal of the item Debris.
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Figure T19.22 Deselecting Clump from
the DNA Model Summary Statistics
Pop-up Menu
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You can select different DNA cell cycle models in the Multicycle Model to
Display group, and the DNA cell cycle statistics window will update to reflect the
model selected. Try selecting different models from the Multicycle tab using
Autofit and observe how the results change in the DNA cell cycle statistics
window. When using the full version of MultiCycle, the histogram display will also
update to reflect the fit to the model selected. The different models vary by the
complexity of the model (applying constraints, or not, on the CV or G2/G1 mean
ratio) and the inclusion of software aggregate compensation. For more
information on the different models refer to the MultiCycle documentation.
A quick visual examination of the DNA Model is often useful. However, the model
with the lowest Chis (Chi-square) value is usually the best fit, shown circled in
red in Figure T19.23. In this case Model 2 (SL CL S0) has the lowest Chis;
however, two other models have very similar low Chis values.

Figure T19.23 DNA Cell Cycle Model
with the Lowest Chis (Chi-square)
Value

In the next section, we will format a DNA histogram

40.20.3
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.

Formatting a DNA Histogram

There are many formatting features in FCS Express that aid the user in the visual
assessment of a MultiCycle analysis of a DNA histogram. The different cell cycle
populations can be shaded in different ways and markers can be displayed
indicating the location of the mean of a specific population. In addition, the user
can zoom in on a specific area on the histogram for a more detailed view of the
analysis.
We will begin by changing the pattern of the diploid population on the MultiCycle
histogram to a solid color.
1. Click inside the MultiCycle histogram to select it.

© 2020 De Novo Software

Tutorials

2. Select the

1785

command.

The Formatting Overlays dialog window appears, shown in Figure T19.24.
Please refer to Figure T19.24 for the following steps.
3. Select Diploid G1 from the category on the left, shown highlighted in blue.
4. Select the solid fill pattern from the Fill Style drop down menu, indicated by
the cursor.
5. Click OK.

Figure T19.24 Formatting Overlays Dialog for a MultiCycle DNA Histogram

The MultiCycle histogram will now update to reflect the changes as shown in
Figure T19.25. Alternatively, we could have accessed the histogram Overlay
menu by right-clicking on the DNA histogram to bring up the pop-up menu and
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selecting Format and then Overlays.

Figure T19.25 MultiCycle DNA Histogram Updated with Solid Fill on the Diploid Peak

We will now add a marker on the histogram to indicate the location of the
aneuploid G2 peak.
6. Right-click inside the DNA histogram to bring up the pop-up menu.
7. Select
the cursor in Figure T19.26.

from the menu, indicated by
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Figure T19.26 Selecting DNA Position Markers on the Pop-up Menu

Alternatively, the DNA Position Markers can be accessed from the Format item
on the pop-up menu.
Right-click inside the histogram to bring up the pop-up menu.
Select Format from the menu.
The histogram formatting window appears, please refer to Figure T19.27 for the
following steps.
Select
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outlined in blue.
Select the box Show position marker on the plot, indicated by the
cursor.
Select A2 Mean, shown highlighted in blue.
Click OK.

Figure T19.27 Formatting DNA Histogram Position Markers

A vertical line marking the location of the mean of the aneuploid G2 peak
appears on the Multicycle DNA histogram (Figure T19.28).
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Figure T19.28 MultiCycle Histogram Updated with a DNA Position Marker on the
Aneuploid G2 Mean

We will now zoom in to the DNA histogram to more closely examine the
aneuploid population.
8. Right-click inside the DNA histogram to bring up the pop-up menu.
9. Select Magnify (Axis) from the pop-up menu (Figure T19.26).
Please refer to Figure T19.29 for the following steps.
10. Place the cursor to the left of the aneuploid G1 peak on the DNA
histogram, shown by left arrow.
11. Press and hold the left mouse button and move the mouse to the right.
12. Release the left button when the right arrow is to the right of DNA
Position Marker, indicated by the cursor.
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Figure T19.29 Selecting an Area on the X-axis to Zoom

The histogram now updates to zoom in on the area of the x-axis that was
selected in the previous steps, as shown in Figure T19.30.
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Figure T19.30 Histogram Zoomed

We will now change the y-axis scale on the histogram.
13. Click inside the histogram to select it.
14. Select the

command.

The Formatting Axes dialog appears. Please refer to Figure T19.31 for the
following steps.
15. Select Y-Axis, highlighted in blue.
16. Deselect the box next to Automatic, indicated by the cursor.
17. Enter '300' as the maximum value for the Y-axis, shown highlighted in
blue.
18. Click OK.
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Figure T19.31 Formatting Axes Dialog

The MultiCycle histogram updates, scaling the y-axis from 0 to 300 as shown in
Figure T19.32.
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Figure T19.32 MultiCycle Histogram with Rescaled Y-axis

Next, we will perform MultiCycle analysis of 3 cycle data

40.20.4
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.

Analysis of 3 Cycle Data

Analysis of DNA histogram data that contains multiple cycling populations
requires the advanced MultiCycle version which must be purchased separately.
We will begin by opening a new blank Layout page and inserting a DNA histogram
that has multiple aneuploid populations.
1. Select File tab

.

2. Select the Insert tab

command.

3. Click on a blank area of the layout.
The Select a Data File dialog appears, as previously shown in Figure T19.1

1762

.

4. Navigate to the FCS Express Sample Data folder.
5. Select the file ASCII4.fcs.
6. Click Open.
The MultiCycle DNA histogram now appears as shown in Figure T19.33. Note the
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two aneuploid populations, shown in blue and green, that make up a majority of
this histogram.

Figure T19.33 MultiCycle DNA Histogram with Two Aneuploid Populations

You could insert the DNA Cycle, DNA Model Summary, and DNA Experiment
Statistics windows as previously shown in the tutorial to further study this
histogram. However, it is apparent that this DNA histogram has multiple cycling
populations, which MultiCycle appears to have correctly identified.
We will now look at a histogram that is more difficult to analyze because the
aneuploid populations overlap, and in fact the Autofit function of MultiCycle does
not correctly identify the two aneuploid populations, requiring us to use manual
settings. We will begin by inserting just the histogram.
7. Select the Insert tab

command.

8. Click on a blank area of the layout.
A histogram of the current data file appears
change the data in the plot.

172

on the layout. We will now

9. Right-click on the histogram and select Change file from the pop-up
menu.
10. Select the file ASCII8.fcs from the Select a Data File dialog which
appears.
11. Click Open.
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The histogram changes to display the ASCII8.fcs data file, as shown in Figure
T19.34. Note that there is an aneuploid peak, shown circled in red. However,
upon closer examination it appears that there may actually be two aneuploid
peaks with very similar amounts of DNA. We will now use the Autofit function of
MultiCycle to analyze this DNA histogram, and show that it does not yield correct
results in this case.

Figure T19.34 ASCII8.fcs Histogram

12. Select the Insert tab
T19.4 ).

command (Figure

1763

13. Click on a blank area of the layout.
The Select a Data File dialog appears, as previously shown in Figure T19.1

1762

The MultiCycle DNA histogram now appears as shown in Figure T19.35. The
Autofit function of MultiCycle has analyzed this histogram using a two cycle
model, thereby assuming there is one aneuploid population, shown in blue. We
will now use MultiCycle to analyze the DNA histogram without using Autofit.
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Figure T19.35 Autofit MultiCycle Analysis of ASCII8.fcs

17. Click inside the MultiCycle histogram of ASCII8.fcs to select it.
18. Select the

command.

The Formatting Fit Model Options dialog appears. Please refer to Figure
T19.36 for the following steps.
19. Deselect the box
Autofit.

next to Detect fit type automatically, this turns off

20. Select 3 Cycle

from the Fit Type drop-down menu.

21. Select the box

next to Diploid CV = Aneuploid CV.

22. Click OK.
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Figure T19.36 Formatting Fit Model Options Dialog

We have now turned off Autofit and told MultiCycle to apply a 3 Cycle model. We
have also specified the additional constraint on the model that the CV of the
diploid peak should equal the CV of the aneuploid peaks. The MultiCycle analysis
of the histogram using the manual fit options appears, as shown in Figure
T19.37.
Alternatively, you can turn off Autofit by deselecting it on the MultiCycle tab and
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specifying a 3 Cycle model.
Select the
Autofit.

command, to turn off

Select
list.

from the Cycle drop-down

Right-click on the ASCII8 MultiCycle histogram to bring up the pop-up
menu.
Select Format from the pop-up menu.
The Formatting Cell Cycle window appears.
Select the

category from the left side of the window.

The DNA Cell Cycle category of the Formatting Cell Cycle dialog appears,
similar in appearance to the Formatting Fit Model Options shown in Figure
T19.36.
Select the box

next to Diploid CV = Aneuploid CV (Figure T19.36).

Click OK.

Figure T19.37 Manual MultiCycle Fit

40.21

Proliferation

One of the most common methods used to study cell proliferation 906 induced by
different treatments is the dye dilution technique. In this technique, the cells of
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interest (usually T-cells) are labeled uniformly with tracking dyes such as CFSE or
the CellTrace and PKH series of dyes. With each generation, the dye content of
the cells decreases by half as the dye is equally divided among the daughter cells.
Thus, as time progresses, cell populations that have divided can be identified by
their characteristic distribution of peaks with diminished fluorescence as
compared to the undivided control. The proliferation module 906 in FCS Express
performs sophisticated curve fitting in order to quantify the proliferation
characteristics of your population. This allows for the easy determination of the
proportion of cells that proliferated, as well as other derived statistics.
In this tutorial we will learn how to apply such algorithms, create proliferation
statistics, format the plotted data, and generate publication quality reports in a
batch process.
Layout Design and Gating Strategy Notes:
The layouts for use in this tutorial are listed below can be found in the
Proliferation Tutorial folder within the Tutorial Sample Data folder.
Proliferation Tutorial Fitting Proliferating Cells Section.fey
Proliferation Tutorial Formatting Section.fey
Proliferation Tutorial for Batch Processing.fey
The layouts have been optimized for ease of use while assuming that you are
familiar with the basics of data analysis in FCS Express. The samples for the data
set are listed below and were stained with SYTOX AADvanced (live/dead
marker), CD4 Alexa 488, and CellTrace Violet (proliferation dye).
Unstained Control.fcs
10 uM CellTrace Violet Control.fcs
10 uM CellTrace Violet Stimulated Control.fcs
10 uM CellTrace Violet Stimulated Sample.fcs
In the Gating page of the layouts, the top two plots define the live cells in the
assay using a hierarchy of gates from the SSC-H, FSC-H, and SYTOX
AADvanced-H parameters. The plots in the middle row of the Gating page are an
inverse greyscale density plot (left) and a color dot plot (right). These plots are
used to help visualize generational data and are useful for further downstream
analysis of the proliferation data. The final plots for the analysis are two
histograms of the CellTrace Violet-H parameter: one which contains a marker
that is linked to the Non Proliferating Control gate (M1) and is labeled
Proliferation Histogram in the title; the other, "Background Noise Histogram,"
contains a marker for Background Noise. (Note: The Background Noise
histogram is only visible in the Proliferation Tutorial Fitting Proliferating Cell.fey
while in the other layouts it can be found on a hidden page 98 ). The Proliferation
Data page contains a pre-inserted proliferation plot of the data. The Proliferation
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Tutorial for Batch Processing.fey layout has completed all of the steps from the
first three sections of the proliferation tutorial so you may proceed directly to
batch processing the data.
We will begin by learning how to insert a proliferation plot and how to convert a
histogram to a proliferation plot .
1800

40.21.1

Inserting Proliferation Plots

A proliferation plot can be created just like any other plot in FCS Express, and
regular histograms
can easily be changed to a proliferation plot.
1229

In the course of this section we will:
Insert a new proliferation plot
Change a histogram to a proliferation plot

1. Open the "Proliferation Tutorial Fitting Proliferation Cells Section.fey" layout in
the Proliferation Tutorial folder within the Tutorial Sample Data folder.
2. Click on the Proliferation Data page tab.
3. Click on the Insert

button (Fig. T20.1).

Figure T20.1 Inserting a Proliferation Plot

4.Click below the current proliferation plot to insert a new proliferation plot. The
plot will look like figure T20.2a and we must change the X Axis parameter and
gate to display the data correctly.
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Figure T20.2a Proliferation plot
before formatting the X Axis
parameter and applying the Sytox
gate.

Figure T20.2b Proliferation plot after
formatting the X Axis parameter and
applying the Sytox gate.

5.Choose the Format tab from the ribbon
T20.3, ).
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Figure T20.3 Formatting overlay options on a proliferation plot.

6. Change the X Parameter to CellTrace Violet-H (Fig. T20.3,
7.Change the Gate to Sytox Live Cells Gate (Fig. T20.3,

).

).

8. Click OK (Fig. T20.3, mouse pointer).
The proliferation plot for the sample is now present on the page and has been
formatted to display the correct parameters and gates (Figure T20.2b).
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We will now change the histogram on the Gating page to a proliferation plot.
9. Click on the Gating page tab at the bottom of the program to make the
Gating page visible.
10. Click on the histogram labeled Proliferation Histogram in the title, located
towards the bottom of the Gating page, to select it.
11. Click on the Format tab

button.

12. Select Proliferation from the drop down menu (Figure T20.4).

Figure T20.4 Changing
plot type from a
histogram to a
proliferation plot.

You will now notice that the histogram has been changed to a proliferation plot
that is ready for analysis.
The Inserting Proliferation Plots section is now complete. Please close the layout
and do not save the changes before proceeding to the next section.
In the next section
with the data.

40.21.2

1809

we will learn how to further modify the default fit for use

Formatting a Proliferation Histogram

In the course of this section we will :
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Learn how to adjust the proliferation overlays to better visualize the
populations of interest.
Learn how to produce the curve fitting statistics.
Learn how to smooth the proliferation histogram.
Learn how to use a batch process for analyzing multiple proliferation
samples.

1. Open the "Proliferation Tutorial Formatting Section.fey" layout in the
"Proliferation Tutorial" folder within the Tutorial Sample Data folder.
2. Click on the "Proliferation Data" page.
3. Click once on the proliferation histogram to select it.
4. Select the Format tab

Plot

Overlays command.

The Formatting Overlays dialog will appear (Fig. T20.11).
5. Select the Noise overlay from the left (Fig. T20.11a,
6. Uncheck the Visible box (Fig. T20.11a,

).

).

7. Select the Generation 6 overlay from the left (Fig. T20.11b,
8. Change the Color to Blue (Fig. T20.11b,

).

).

9. In the Fill Style drop down select the 1 st option for a completely filled
rectangle (Fig. T20.11b, ).
10.Select the Generation 8 overlay from the left (Fig. T20.11c,

).

11. In the Fill Style drop down Select the 1 st option for a completely filled
rectangle (Fig. T20.11c, ).
12. Click OK (Fig. T20.11c,

).
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Figure T20.11c
Coloring
generation 8 in
the proliferation
plot green.

Figure T20.11a Removing the
noise overlay from the
proliferation plot.
Figure T20.11b Coloring
generation 6 in the
proliferation plot blue.

The proliferation histogram now appears without displaying the noise, with the
peak corresponding to generation 6 filled in blue, and the peak corresponding to
generation 8 filled in green (Fig. T20.12). This allows for easier confirmation and
visualization of each generation and fitted peak. You can change the formatting
of any and all of the different fitted elements and overlays in this way.

Figure T20.12 The formatted proliferation plot
displaying different generations in different colors
with the noise overlay removed.

Both the RMS error and R-Chi Square are measures of the goodness of the fit.
When setting the proliferation model fit parameters, it is important to check how
changing these parameters affect these two statistics. The combination of
settings that provides the least RMS error and R-Chi Square is mathematically
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the best fit. We will now show the associated statistics for this proliferation
model.
12. Right-click on the proliferation histogram to bring up the associated popup menu.
13. Select

from the pop-up menu.

The Proliferation Fit Statistics window will now appear.
14. Right-click on the proliferation histogram to bring up the associated popup menu.
15. Select

.

The Proliferation Population Statistics window will now appear.
16. Move both statistic tables so that the proliferation histogram and tables
are all visible as in Fig. T20.13.
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Figure T20.13 Proliferation Histogram with the Proliferation Fit
Statistics and Proliferation Population Statistics

We will now smooth the proliferation histogram.
17. Click on the proliferation histogram to select it.
18. Select the

command.

The Formatting Overlays dialog will appear, similar to Figure T20.11.
Note that, by default, the first overlay is selected in the left hand side. This is the
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overlay we will smooth since the rest of the overlays are calculated from the
fitting algorithm.
19. Increase the Smoothing to 6.
20. Click OK.
The Proliferation histogram and the statistics are now updated to reflect the
smoothing (Figure T20.14). The black contour of the raw data is much
smoother, but the fit changes significantly (note that the proliferation fit and
proliferation population statistics have changed). Although this provides for a
nicer visual presentation, this option should be used with caution since it affects
the statistics obtained when using the raw data, and can thus affect the
interpretation of the data. Note that the R-Chi Square 912 value has increased
from 4.82 to 17.76 as a result of smoothing the raw data, indicating an inferior
fit. Thus it is advisable to cull statistics from an unsmoothed (raw) proliferation
plot, while applying smoothing to a duplicate Proliferation plot or regular
histogram for visual presentation only, if desired.
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Figure T20.14 Proliferation Histogram and Associated Statistics with
Smoothing

Now that we have formatted our plots for the experiment and inserted
proliferation statistics we will create a batch process 782 in the next section
summarize the three sample experiment.
40.21.2.
1

Fitting Proliferating Cells

In the course of this section we will:
Learn how the curve fitting algorithm and parameters are fitted to a
histogram.
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Use tokens to define a Fixed Starting Generation and Background.
Insert proliferation position markers.

We will begin by navigating through the data to get an idea of what the
experiment looks like and what the color coded overlays represent.
1. Open the "Proliferation Tutorial Fitting Proliferating Cells Section.fey" layout in
the "Proliferation Tutorial" folder within the Tutorial Sample Data folder.
2. Navigate to the Proliferation Data page tab.

You will notice a proliferation plot on the Proliferation Data page tab for the 10
uM CellTrace Violet Stimulated Control.fcs sample (Figure T20.5a). This is the
curve fitting result on the positive control, proliferating cells. There are four
samples in the data list.

We will now switch to our control sample in which cells are not proliferating.
3. Select the Data tab

Change Data on

Previous command to load the

previous file in the Data List, i.e., 10 uM CellTrace Violet Control.fcs (Figure
T20.5b).
Notice that the 10 uM CellTrace Violet Control.fcs file represents the stained
yet undivided control sample and can serve as our starting generation peak.
We will now switch to our Stimulated Sample.
4. Select the Data tab

Change Data on

Next command to advance

two files to 10 uM CellTrace Violet Stimulated Sample.fcs (Figure T20.5c).
Notice that the 10 uM CellTrace Violet Stimulated Sample.fcs file represents
our stimulated (dividing) sample in which we would like to measure the degree of
proliferation.
We will now switch to our final Unstained Control sample.
5. Select the Data tab

command to the end of
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the Data List to Unstained Control.fcs (Figure T20.5d).
Notice that the Unstained Control.fcs file represents the sample as it appears
without any proliferation staining and can serve as our background noise peak.
Please note that FCS Express is fitting the background peak as it was a
population of proliferating cells. We will modify the fitting parameters later on to
tell FCS Express to treat these as the background.

Figure T20.5a Proliferation positive
control

Figure T20.5c Proliferation
stimulated sample

Figure T20.5b Proliferation negative
control

Figure T20.5d Proliferation unstained
control

You will notice many different color overlays on the different proliferation
samples. The default colors for the proliferation curve fitting are as follows:
Black – Raw histogram contour. This includes all the data and does not
represent an output of the fitting algorithm and would be the same histogram
you would see if you plotted the data on a regular histogram.
Red – Overall contour of the fitted data. This excludes what the algorithm
determines to be noise.
Light blue – Noise. This is the data that the algorithm determines to be noise,
and is not included in the statistics.
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Green – Modeled populations of proliferating cells. These are the actual curves
fitted to the data, representing the parent, undivided population, and all of the
proliferating generations.
Note that there are cells in the proliferation stimulated sample (Figure T20.5c) in
the 10 6 to 10 7 range, shown in light blue, that have been determined by the
model to be noise. We will now modify the Proliferation Fit Parameters to see
if we can improve the model's fit by specifying where the starting generation is
located. Notice on the Gating page there is a histogram with the marker M1
visible. M1 defines the starting generation based on the negative control and we
will use a token representing the geometric mean of the data under the marker
to define our starting generation more accurately.
6. Change the data using the Data tab
Change Data on
Next/
Previous buttons until you reach the 10 uM CellTrace Violet Stimulated
Control.fcs sample.
7. Right-click on the proliferation plot on the Proliferation Data page.
8. Select Format from the pop-up menu.
The Formatting dialog now appears (Figure T20.6).

Figure T20.6 Adjusting proliferation fit parameters in the formatting dialog.
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Parameters category (Figure T20.6,

10. Check the Use Fixed Starting Generation check box (Figure T20.6,

).

11. Delete the numbers in the white text box next to the Use Fixed Starting
Generation option (Figure T20.6).
12. Click on the

token symbol next to the text box (Figure T20.6,

).

The Insert a Token dialog will appear.
13. Double click on Statistic from the Insert a Token dialog.
14. Choose Plot 4 - Histogram - as the Data Source as shown highlighted
in blue below (Figure T20.7, ).

Figure T20.7 Adjusting proliferation fit parameters, continued.

15. Click on the Statistic category on the left (Figure T20.7,
16. Set the marker to M1 (Figure T20.7,

).

).

17. Select Geometric Mean from the Statistic list (Figure T20.7,

).

18. Click OK (Figure T20.7, mouse pointer).
19. Click on the
).

Markers category (Figure T20.8,

20. Check the box for Show position marker on the plot with Undivided
cells peak highlighted in blue (Figure T20.8, ).
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Figure T20.8 Checking the Show position marker on the plot box for the
Undivided cells peak.

21. Click OK (Figure T20.8,

).

The proliferation histogram should now look like Figure T20.9.
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Figure T20.9 The proliferation plot after adjusting
the starting generation and choosing to display
the Undivided cells peak marker.

Notice on the Gating page there is a histogram labeled "Background Noise" with
a marker of the same name. The area under this marker has been defined as the
background noise based on the Unstained Control.fcs sample which is being
displayed in the histogram. We will now use steps similar to those above for
defining a starting generation to define the background noise.
22. Right-click on the proliferation plot on the Proliferation Data page.
23. Select Format from the pop-up menu.
The Formatting dialog will appear as in Figure T20.6.
24. Navigate to the

category.

25. Check the Use Background Noise check box.
26. Delete the numbers in the white text box next to the Use Background
Noise option.
27. Click on the

token symbol next to the text box.

The Insert a Token dialog will appear.
28. Double click on Statistic from the Insert a Token dialog.
29. Choose Plot 30 - Histogram - as the Data Source.
30. Click on the Statistic category on the left.
31. Set the marker to Background Noise.
32. Select Geometric Mean from the Statistic list.
33. Click OK.
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34. Click on the

Markers category.

35. Check the box for Show position marker on the plot with Background
highlighted in blue.
36. Click OK.

The proliferation histogram should now look like Figure T20.10a with the Starting
Generation and Background noise based on the markers from the histogram in
Figure T20.10b.

Figure T20.10a Proliferation plot with
Figure T20.10b Histogram with markers
Background Noise Position and Starting that define the starting generation and
Generation Markers defined.
background noise for proliferation analysis.

Now the fit is better since the starting generation and background noise (now
indicated by the green vertical lines on the right and left respectively) are based
on cells that fall within the Sytox Live Cells gate in M1 or the Background Noise
marker. Notice how the red, fitted contour, more closely follows the black, raw
data contour towards the high end of the data; the R-Chi Square value 912 is also
lower. Although the fit is better for the high end of the data you can see for most
of the curve it has changed very little. That is because the curve fitting algorithm
correctly found a good approximation of the starting generation before adding
the more correct token value for the starting generation. Nevertheless, in some
cases, it is important to manually set the starting generation and background
from control samples. On the other hand, sometimes in proliferation
experiments, the control sample can have a slightly different peak fluorescence
value than the undivided cells from the experimental samples. These differences
can be enough to preclude the use of control histograms to set the position of
the undivided cells.
You will also notice that if you adjust the markers to make them broader or
narrower the proliferation plot fit will update in real time since the starting
generation and background noise are now based on the statistics for the
geometric mean under the M1 and Background noise markers. For a description
of how the fit is being calculated please see the technical note below.
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Technical Note: This is a brief technical note to describe how the fitting
process works. This information is to help you have an understanding of how
adjusting the parameters affects your data. If you wish to skip this, you may
do so.
The fitting process starts by determining where the population of cells
that have not divided is located. The fitting process attempts to find this
peak automatically, although you can specify it manually, as described
above. In some cases, you have to specify it manually because your cell
population may no longer include cells that have not divided.
Once the undivided population is found, the model attempts to find
populations that have decreased in fluorescence by 50% from each
other. Since not all experiments work according to theory, the model
starts looking at the 50% point but can move left or right to find the
true peak. You can control this by selecting the Same Peak Ratio for
All Peaks option (Figure T20.6).
In order to find a peak, the model makes certain assumptions about the
width of each peak compared to the undivided control. You can also
control these settings, selecting or deselecting the Same CV for All
Peaks option, as shown above (Figure T20.6).
The model can also subtract background fluorescence from all the
calculations, if you provide a value for the background fluorescence.
Since the algorithm uses the actual histogram contour to model the fit,
the histogram data should not be smoothed. Only in special cases,
when the original data is very noisy, should a little smoothing be applied
to allow the model to better fit the data.
These options exist in order to accommodate the wide range of data
sources and biological behaviors that the model has to encompass.
Thus, in order to obtain the best fit, it is important that the correct initial
settings be selected. In practice, this is usually performed by trial and
error until the settings providing the best fit are found.
There are two ways to asses the goodness of the fit; the first is visual
inspection, which gives a rough measure, and the second is fit statistics,
which are discussed below.

Next, we will format the proliferation histogram and show statistics

40.21.3

1803

.

Batch Processing Proliferation Data

In the previous sections we have inserted proliferation plots , optimized the
proliferation fit , formatted the proliferation plot , and inserted proliferation fit
1800
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and population statistics . We will now combine these efforts to create a final
presentation and excel export.
1803

We will be using the Proliferation Tutorial for Batch Processing.fey layout which
incorporates all of the steps from the previous three sections so we can focus on
the batch process.
1. Open the "Proliferation Tutorial for Batch Process.fey" layout.
2. Click on the Batch tab

Batch Processing

Batch Actions command.

The Batch Actions window will open.
3. Click on Save to Powerpoint in the Add Action category.
The Create Export To Powerpoint Action window will open (Fig. T20.15).
4. Check the Open presentation after saving box

(Fig. T20.15).

5. Check the Combine the output from all iterations in to the same
presentation radio button

(Fig. T20.15).

6. Click on the folder icon under the Output file options category
new file

Save to a

(Fig. T20.15).
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Figure T20.15 Editing the Create Export To Powerpoint Action options.

7. Choose a location and a file name for the Powerpoint file that will be created.
8. Click Save.
9. Click OK.
10. Click on the Export to Excel (Column Mode) in the Add Report category.
The Excel (Column Mode) Options window will open.
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11. Click on the folder icon under the Output file options category

Save to a

new file.
12. Choose a location and a file name for the Excel file that will be created.
13. Click Save.
14. Click OK.
15. Drag the text box containing the Sample ID from the top of the Gating page
on top of the Excel (Column Mode) icon in the Batch Process Actions
window (Fig. T20.16).

Figure T20.16 Dragging and dropping the sample ID text box to the Excel (Column
Mode) batch action.

16. Select all the statistics in the Proliferation Fit Statistics Table so they appear
highlighted in blue (Fig. T20.17).
17. Drag the selection on top of the Excel (Column Mode) icon in the Batch
Process Actions window (Fig. T20.17).
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Figure T20.17 Dragging and dropping the Proliferation Fit Statistics table to the
Excel (Column Mode) batch action.

Dragging and dropping the sample ID text box and table data to the Batch
Process Actions window

Excel (Column Mode) icon has added the sample

ID and all of the statistics from the table to the excel report.
18. Click the Batch tab
process.

Batch Processing

Run button to begin the batch

The batch process will proceed through the 4 samples in the data list and
generate an 8-slide Powerpoint file which will include 2 slides per sample and an
Excel document that will have four rows of data for each of the three samples in
the data list.

40.22

Kinetics

Many flow cytometers are capable of recording a time parameter in the .fcs file,
allowing for kinetics experiments to be performed. Kinetics experiments are
particularly useful for examining changes in DNA content, antibody binding, and
calcium flux over time. By adding a compound (usually a drug) to a sample and
monitoring influx, efflux, or binding of your probe over time, unique information
can be gathered. FCS Express offers the capability to display and analyze kinetics
data in an easy and user friendly manner while updating your plots as your
analysis changes.
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In the course of this tutorial we will show how to:
Create parameter math formulas to view ratios between two parameters.
Create gates and display statistics for Kinetics Plots.
Plot Mean, Geometric Mean, Median, % Above Threshold, and Count.
Overlay multiple Kinetics Plots.
Format a Kinetics Plot to view the data at the correct resolution.

In the first exercise, we will create parameter math formulas for use in kinetics
plots .
1822

40.22.1

Using Parameter Math

It is often useful to define a ratio when examining kinetics data. This can be a
ratio of two different dyes, or the ratio of the same dye in two different emission
wavelengths. The parameter math feature of FCS Express allows the user to
define mathematical operations from simple ratios to complex formulas for use
in your analysis. FCS Express will also calculate and display the actual ratio
values rather than an arbitrarily scaled multiplied integer as some other software
packages do.
In this section you will learn how to create parameter math formulas for use in
Kinetics Plots.
Although any kinetics data files of your own can be used to follow along in this
tutorial, you have the option of using the same sample data files used in this
tutorial. The sample data files are located in the Tutorial Sample Data archive .
The KineticsTutorial.fey, kinetics10.010, and kinetics25.025 data files have
been embedded and will be used here.
1212

1. Select File tab

.

2. Select the KineticsTutorial.fey layout file located in the FCS Express
Sample Data directory from the Load Layout dialog.
In the KineticsTutorial. fey layout the two samples (kinetics10.010, and
kinetics25.025) are already displayed as kinetics plot 918 .

The following steps open the transformation window and create a new
Parameter Math transformation:
3. Open the Transformation window by selecting the Tools
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Transformations command

4. Click on the drop down arrow adjacent to the blue plus
the transformations dialog(Figure T21.1).
5. Click on Parameter Math in the drop down list

1823

(Figure T21.1).
button

in

(Figure T21.1).

Figure T21.1 Selecting the Parameter Math transformation.

A New Parameter Math transformation is created and listed in the upper part
of the Transformation Window. The Parameter Math dialog now appears in
the lower part of the Transformation window as seen in Figure T21.2. Note
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that the kinetics10.010 sample has been automatically selected as template file
in this example but this can be changed by clicking on the ellipsis

at the right

of the Template File field.
6. Choose New in the Parameter Math dialog (Figure T21.2) to define a
new formula.

T21.2 The New Parameter Math dialog as it appear in the
Transformation window after Step 5.

A Create New Sequence Item window similar to the one represented in Figure
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T 21.3 will open.
The following instructions refer to Figure T21.3.
5. Enter Ca++ Ratio in the Output Parameter Name box
6. Change the First Input Parameter to Fluo 3

.

7. Change the mathematics operator to "/" for division

.

8. Change the Second Input Parameter to Fura Red

.

9. Click OK

.

.

Figure T21.3 Defining a Parameter Math Sequence Item Formula

The Parameter Math dialog in the Transformation window now displays the
formula sequence we defined (Figure T21.4). Please note that, although in this
example the New Parameter Math transformation contain only the Ca++
Ratio formula, a Parameter Math transformation can contain more than one
formula.
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Figure T21.4 Parameter Math Sequence Dialog with
Formula Displayed

The Parameter Math transformation has now been defined and can now be
applied to plots for display and analysis.
We will now apply the New Parameter Math transformation (containing the Ca
++ Ratio formula) to the histograms displayed in the layout.
Please note that the New Parameter Math transformation has been created
using the kinetics25.025 sample as Template File. Though, since the
kinetics10.010 sample has the exact same parameter in the same exact order,
we can apply the New Parameter Math transformation to this sample as well.
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10. Left click and hold on the New Parameter Math transformation from
the Transformation window.
11. Drag the New Parameter Math transformation out of the
Transformation window and release it on top of each of the 1D plot
(Figure T21.5).

Figure T21.5. Use Darg&Drop to apply the Parameter Math transformation to the
plots of the layout.

The two 1D plots should now look as the ones displayed in figure T21.5b.
Note the suffix Parameter Math applied automatically added to the plot
title.
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Figure T21.5b The two kinetics plot as they appear when the New Parameter
Math transformation has been applied to them.

The newly calculated Ca++ Ratio parameter can now be accessed as a
standard parameter from the axis labels.
We will now display the Ca++ Ratio parameter on the Y axis of both 1D plot
simultaneously via the formatting windows.

12.Hit Ctrl+A to select all plots.
13. Choose the Format
Ribbon.

Overlay command from the

14. Change the Y Parameter to Ca++ Ratio (i.e. the formula defined in the
New Parameter Math transformation) from the drop-down list (Figure
T21.6)
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Figure T21.6 Changing the Y Axis to the Ratio Defined by the Parameter Math

The plots on the layout should now look like Figure 21.7. Since the first
parameter of the parameter math calculation was a logarithmic parameter, FCS
Express assumed the newly created parameter should be a log parameter as
well. This is typically the case, but in this situation it is not correct. Since the plots
display the real ratio value, we will have to adjust the axis settings to display the
data on a linear scale.
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Figure T21.7 Ca++ Ratio vs Time

15. Hit Ctrl+A to select all plots.
16. Choose the

command from the Ribbon.

Refer to Figure T21.8 for the following steps.
17. Under the Select Axis section, select Y-Axis
18. Under the Scale section, un-check Automatic
19. Change the Scale to Linear

22. For Maximum, enter 1
23. Click OK

.

.

20. Under the Range section, un-check Automatic
21. For Minimum, enter 0

.

.

.
.

.
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Figure T21.8 Formatting Axes Dialog

The plots in the layout should now look like Figure T21.9.
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Figure T21.9 Plots Scaled Correctly to Display the Ca++ Ratio

In the next section, we will apply gating and statistics to kinetics plots

40.22.2

1832

.

Applying Gating and Statistics

In this section, you will learn how to apply a gate to a kinetics plot and view
kinetics statistics for the gate.
Although any kinetics data files of your own can be used to follow along, you
have the option of using the same sample data files used in this tutorial. The
sample data files are located in the Tutorial Sample Data archive . The
KineticsTutorial.fey, kinetics10.010, and kinetics25.025 data files will be
used here. Please complete the steps in the Using Parameter Math
section
before beginning.
1212

1822

1. Choose the

(Figure T21.10).
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Figure T21.10 Creating a Marker

2. Create a 1D (marker) gate on sample kinetics25.025 similar to the one
in Figure T21.11, so that its left boundary defines the baseline and its right
boundary is after the peak has subsided.
3. Name the gate "Marker Gate 1".
4. Click OK.
5. Choose the

command.

6. Create a 1D (marker) gate on sample kinetics10.010 similar to the one
in Figure T21.11, so that its left boundary defines the baseline and its right
boundary is after the peak has subsided.
7. Name the gate "Marker Gate 2".
8. Click OK.

Figure T21.11 Kinetics Plots with 1D Gates Applied
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7. Right-click on the kinetics25.025 plot.
8. Choose Kinetics Statistics from the pop-up menu. A Kinetics Statistics
window will appear on the layout.
9. Move the Kinetics Statistics window to a convenient position on the
layout.
10. Right-click on the kinetics10.010 plot.
11. Choose Kinetics Statistics from the pop-up menu. A Kinetics
Statistics window will appear on the layout.
12. Move the Kinetics Statistics window to a convenient position on the
layout.
The layout should now look like Figure T21.12. By right-clicking on the Kinetics
Statistics window, you may choose to view up to 14 different kinetics statistics
(Figure T21.13). These values will change dynamically with adjustments to the
gates.

Figure T21.12 Plots with Kinetics Statistics Windows
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Figure T21.13 Kinetics
Statistics Right Click Pop-up
Menu

Next, we will explore different plotting values

40.22.3

1835

.

Plotting Values

The default parameter for plotting kinetics data is Median, but often times it is
useful to look at other values such as Mean, Geometric Mean, Count, and
percentage of events above a threshold. In this section, you will learn how to
change these plotting values and define a threshold based on gates/tokens.
The sample data files for this section are located in the Tutorial Sample Data
archive . The KineticsTutorialParameterSection.fey layout will be used here.
The layout is embedded with the kinetics10.010, and kinetics25.025 sample
data, and has a Ca++ Ratio parameter math formula applied.
1212
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1. Click on the kinetics10.010 plot to select it.
2. Right-click on the plot and choose Format from the pop-up menu.
3. Select the Overlays category.
4. Change the Plotting Value from Median to Mean (Figure T21.14).

Figure T21.14 Changing the Plotting Value

5. Move the Format dialog window so that you can see the kinetics10.010
plot.
6. Click Preview.
The plot will change to display the Mean Ca++ Ratio on the Y-Axis. Steps 1-6
may be repeated to view any of the plotting values.
7. Change the Plotting value to Count.
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8. Click Preview.
Selecting Count will plot the number of events acquired per unit time. This is very
useful for quality control, to ensure that the event rate over time is consistent.
Notice how the data has many peaks and valleys due to low cell numbers. We
will now change the resolution to view the #Events/Time at the appropriate
resolution.
9. Choose the
(in the Formatting dialog).

category

10. Change the Y-Axis Resolution to 32x32 from the Resolution drop-down
list (make sure that Y-axis is selected in the list box).
11. Click OK.
The plot should now look like Figure T21.15. Count vs. Time is a useful way to
view the flow rate of your sample (it can reveal when a sample was removed or
placed on the instrument, or if the flow rate decreased or increased for any
reason). Note the large valley during the beginning of acquisition in this example
when the sample was removed to add a drug.

Figure T21.15 Kinetics Plot Displaying
Count vs. Time

We will now assign a threshold to view % Above Threshold as a plotting value
on a new page and plot.
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12. Choose % Above Threshold from the page tabs.
You will see a Kinetics Plot and a Density Plot for kinetics10.010 with gates
applied to the Density Plot (Figure T21.16). The gates are applied such that the
Baseline Gate encompasses events before addition of a drug. Statistics derived
from the gate will serve as baseline values for plotting % Above Threshold. The
Post Treatment Gate includes events after the addition of a drug. We will plot
the percentage of cells within this gate that responded with a fluorescence signal
above the baseline.

Figure T21.16 Kinetics and Density Plots with Thresholding Gates Applied

13. Select the Kinetics Plot on the left.
14. Right-click on the Kinetics Plot.
15. Choose Format from the pop-up menu.
16. Choose the Overlays category.
17. Select "Post Treatment Gate" from the Gate drop-down list.
18. Choose % Above Threshold from the Plotting Values drop-down list.
19. Click on the Token Symbol

after the Threshold field.

20. Choose "Y Median + 2 * SD" from Custom in the Insert a Token
dialog (Figure T21.17). (The Y Median + 2* SD custom token represents
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the Y median of the baseline gate plus two standard deviations of the Y
median in the baseline gate.)

Figure T21.17 Choosing a Custom Token as a Threshold
Value

21. Click OK.
The plots in the layout should now look like Figure T21.18. The kinetics plot on
the left is now displaying the percentage of events in the Post Treatment Gate
that are above the Y-Median plus two standard deviations of the baseline gate
for the Ca++ Ratio parameter.
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Figure T21.18 Kinetics Plot Displayed as % Above Threshold

In the next exercise, we will overlay and format kinetics plots

40.22.4

1840

.

Overlay and Format Kinetics Plots

It is often useful to look at many samples on the same plot to see sample
variation and to compare experimental samples against a control. In this section,
you will learn how to overlay multiple kinetics samples, apply parameter math to
the overlays, and format the overlays to make the data easier to view.
Although any kinetics data files of your own can be used to follow along, you
have the option of using the same sample data files used in this tutorial. The
sample data files are located in the Tutorial Sample Data archive . The
KineticsTutorialFormatting.fey, kinetics8.008, kinetics9.009,
kinetics10.010, and kinetics25.025 data files will be used here.
1212

1. Select File tab

.

2. Select the KineticsTutorialFormatting.fey layout file located in the FCS
Express Sample Data directory from the Load Layout dialog.

The layout contains one kinetics plot displaying Time vs Fluo 3 for sample
kinetics25.025. We will now add the other three samples to the kinetics plot as
overlays.
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3. Ctrl+Click on samples kinetics8.008, kinetics9.009, and
kinetics10.010 to select them in the data list.
4. Drag the files from the data list onto the Kinetics Overlay plot.
5. Release the mouse button to drop them on the plot.
6. Choose add the files to the plot as new overlays.
7. Click OK.

The four sample are now displayed simultaneously in the kinetics plot. Though,
the Parameter Math transformation is not yet applied to the plot. We will now
apply the Parameter Math transformation to the plot via drag and drop.
8. Left click and hold on the New Parameter Math transformation from the
Transformation window.
9. Drag the New Parameter Math transformation out of the
Transformation window and release it on top of the kinetics plot (Figure
T21.5). The Parameter Math applied suffix will be added to the plot title as
a confirmation of this action.
10. Change he Y-Axis parameter on the Kinetics Overlay plot to Ca++
Ratio.
11. Select the Live Cells gate from
section of the Ribbon bar.
The plot now contains overlays for each sample and should look like Figure
T21.19.
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Figure T21.19 Multiple Kinetics Overlays

We will now format the plot to make it more visually appealing.
18. Right-click on the plot.
19. Choose Format from the pop-up menu.
20. Choose the Overlays category.
21. Ctrl+Click on all of the plots in the list box to select them.
22. Change

to 1.50.

23. Choose the Legend category.
24. Click on the Visible check box to select it.
25. Change the Position from Right to Bottom.
26. Click OK.
The plot should now look like the Figure T21.20.
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Figure T21.20 Kinetics Plots Formatted

Finally, we will change the resolution of a kinetics plot

40.22.5

1843

.

Format to Change Resolution

From time to time your kinetics data files may not be displayed suitably with
your default settings from the preferences. In this section, you will learn how to
adjust resolution to view your data correctly, and how to show the standard
deviation of your kinetics curves.
Although any kinetics data files of your own can be used to follow along, you
have the option of using the same sample data files used in this tutorial. The
sample data files are located in the Tutorial Sample Data archive . The
KineticsTutorialScaling.fey, kinetics10.010, and kinetics25.025 data files
will be used here.
1212

1. Select File tab

.

2. Select the KineticsTutorialScaling.fey layout file located in the FCS
Express Sample Data directory from the Load Layout dialog.
The layout should look like Figure T21.21 below. The red highlighting is showing
the standard deviation of the sample while the black line is displaying the Median
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of Fluo 3. Sample kinetics10.010 is scaled correctly and is not showing
standard deviation. Notice how sample kinetics25.025 has a very jagged black
line and is displaying standard deviation. The jagged black line is occurring
because the resolution on the plot is set too high. We will now format the
kinetics25.025 plot to remove the standard deviation highlighting and adjust
resolution to display the plot correctly.

Figure T21.21 Kinetics Tutorial Layout After Adding Sample Data

3. Click on the kinetics25.025 plot to select it.
4. From the Ribbon Bar choose the
command.
5. Uncheck the Show Standard Deviation check box (Figure T21.22).
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Figure T21.22 Unchecking Show Standard Deviation

6. Click OK.
The red standard deviation highlighting will now be removed as in Figure T21.23.
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Figure T21.23 Sample Plots with Standard
Deviation Highlighting Removed

We will now change the resolution of sample kinetics25.025 to display the plot
properly.
7. Right-click on the kinetics25.025 plot.
8. Choose Format from the pop-up menu.
9. Choose the

category.

10. Click on the Resolution drop-down list under Resolution Options
(Figure T21.24).
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Figure T21.24 Changing the Resolution on a Plot

11. Select the 64x64 resolution option.
12. Click OK.
The plot will now change and be scaled properly as seen in Figure T21.25.
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Figure T21.25 Changing the Resolution: 256x256 (Left) to 64x64 (Right)

After following the instruction above, the layout should look like Figure T21.26.

Figure T21.26 Kinetics Plots Scaled Properly

We will now apply a gate and the standard deviation highlighting to both of the
plots.
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13. Hit Ctrl+A to select all plots.
14. Choose the

command.

15. Change the Gate to Gate 1.
16. Check the Show Standard Deviation check box.
17. Click OK.
The layout should now look like Figure T21.27.

Figure T21.27 Kinetics Plots with Standard Deviation Highlighting Applied

40.23

Cell Concentration

FCS Express can calculate the absolute concentration of the cells in a sample.
FCS Express does so by automatically calculating the volume of the sample that
was used during acquisition. The volume can be calculated by a) using beads that
were present in the sample tube at a known concentration, b) using the sample
flow rate and acquisition time, or c) using the volume keyword from FCS 3.1
files, or the equivalent in Amnis DAF files, if available. FCS Express can display the
concentration as a one time calculation, in a statistics table, or as a token.

To begin, we will set up the bead gates
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40.23.1

Setting up the Bead Gates

In the course of this example, we will:
Learn how to gate beads using hierarchical gating.
For more information about inserting a plot

1226

, see the tutorial on that subject.

1. Open a new, blank layout.
2. Insert a forward (FSC-H) vs side scatter (SSC-H) dot plot 171 of the file
Monocytes.002 found in the FCS Express Sample Tutorial Data folder.
3. Create a polygonal gate around the monocytes, calling it Monocytes
(Figure T22.1).
4. Create a rectangular gate around the beads, calling it Beads1 (Figure
T22.1).
The gates should look similar to the ones shown in the plot on the left side of
Figure T22.1. For more information on creating gates, please refer to the Gating
tutorial .
1268

5. Create a second dot plot, this time showing FL1-H vs SSC-H (Figure
T22.1).
6. Apply the Beads1 gate to the new plot. For more information about
applying gates, please refer to the Gating tutorial .
1268

7. Draw a new rectangular gate around the beads, calling it Beads2, as
shown on the plot on the right side of Figure T22.1.

Figure T22.1 Gates for Monocytes and Beads
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The Beads2 gate allows for added discrimination between the cells and the
beads. Depending on how well separated the beads are from your sample, you
can use an approach consisting of only one gate, but applying two gates
generally allows for cleaner isolation of the bead events to exclude doublets and
higher order aggregates.

In the next section, we will use the Concentration Calculator

40.23.2

1851

tool.

Concentration Calculator (Beads)

In the course of this example, we will:
Identify the variables needed for the concentration calculation.
Set up the concentration calculator using beads.
Obtain a one time result.

In order to calculate the concentration, we need the following four parameters:
A. The file to be analyzed.
B. The cells of interest.
C. The gate containing the beads that were added to the sample tube.
D. The concentration of the beads in the sample tube.
Now that the gating strategy for the cells and beads is ready, we will proceed to
do the actual calculations. (Note that the following sections build upon steps 1
through 7 in the Setting up the Beads Gates chapter )
1850

1. Select the
(Figure T22.2).

command

Figure T22.2 Concentration Calculator Command
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The Concentration Calculator dialog now appears as shown in Figure T22.3.
The following steps all refer to Figure T22.3.
2. Select the File to analyze, in this case Monocytes.002, from the dropdown list .
3. Select Monocytes as the Gate to analyze, from the drop-down list
4. Select the Reference Beads radio button
Calculation type.
5. Select Beads2 for the Bead Gate

.

to specify the Volume

.

6. Input the concentration of the beads in the sample tube. In this case we
will use a value of 100,000 beads/ml .
7. Click the Calculate button.
In the Results section of the Concentration Calculator, the volume of the
sample analyzed appears in the Volume Analyzed
field and the concentration
of the cells in the Monocytes gate appears in the Sample Concentration
field (Figure T22.3).
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Figure T22.3 Concentration Calculator Dialog Using
Beads

8. Click Cancel to close the Concentration Calculator dialog.

In the next example, we will calculate the concentration using time and flow rate
.
1854
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40.23.3

Concentration Calculator (Time/Flow Rate)

In the course of this example, we will:
Set up the concentration calculator using the time of acquisition and the
flow rate.
Obtain a one time result.
(Note that the following sections build upon steps 1 through 7 in the Setting
up the Beads Gates chapter )
1850

1. Select the
(Figure T22.2

command
1851

).

The Concentration Calculator dialog appears again as shown in Figure T22.2.
The following steps all refer to Figure T22.4.
2. Select the File to analyze, in this case Monocytes.002, from the dropdown list .
3. Select Monocytes as the Gate to analyze, from the drop-down list
4. Select the Time radio button

.

to specify the Volume Calculation type.

The start and end times embedded in the FCS data file appear by default, and
the Total Time is calculated automatically. You can change the start or end time
manually, or enter a specific Total Time directly.
5. Input the Flow Rate used when acquiring the sample. In this case, since
the data was collected on a cytometer that used a flow rate of 60 µl/min,
we will use a value of 0.06 mL/min .
6. Click the Calculate button.
The Results section now displays the volume of the sample analyzed and the
concentration of cells in the Monocytes gate (Figure T22.4).
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Figure T22.4 Concentration Calculator Dialog Using Time
and Flow Rate

7. Click Cancel to close the Concentration Calculator dialog.

In the next example, we will calculate the concentration using volume ($VOL)
keyword .
1856
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40.23.4

Concentration Calculator ($VOL keyword)

In the course of this example, we will:
Set up the concentration calculator using the volume ($VOL) keyword in
the data.
Obtain a one time result.
(Note that the following sections build upon steps 1 through 7 in the Setting up
the Beads Gates chapter )
1850

1. Select the
(Figure T22.2

command
1851

).

The Concentration Calculator dialog appears again as shown in Figure T22.2.
The following steps all refer to Figure T22.5.
2. Select the File to analyze, in this case Monocytes.002, from the dropdown list .
3. Select Monocytes as the Gate to analyze, from the drop-down list
4. Select the Volume keyword in the data radio button
Volume Calculation type.

.

to specify the

5. Click the Calculate button.
In the Results section of the Concentration Calculator, the volume of the
sample analyzed appears in the Volume Analyzed
field and the concentration
of the cells in the Monocytes gate appears in the Sample Concentration
field (Figure T22.5).
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Figure T22.5 Concentration Calculator Dialog Using the
$VOL keyword

8. Click Cancel to close the Concentration Calculator dialog.

Next, we will show the calculated concentration in a statistics window
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40.23.5

Showing the Concentration in a Statistics Window

In the course of this example, we will:
Set up the concentration calculator for displaying the results in the layout
using beads or time and flow rate.
Show the concentration calculated as a statistic in a statistics window.

We have learned how to obtain one-time calculations of the cell concentration in
a sample. We will now learn how to present these results in the layout using the
statistics window.
1. Right-click in the forward vs. side scatter plot containing the Beads1 and
Monocytes gates to bring up the associated pop-up menu.
2. Select

from the pop-up menu.

A Gate Statistics window should appear (Figure T22.6). Move it to a
convenient place in the layout.

Figure T22.6 Statistics Window

3. Click once on the statistics window to select it; it should have a green
border (Figure T22.6).
4. Select the
T22.7).

command (Figure

Figure T22.7 Selecting Format Statistics Command
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The Formatting Statistics dialog now appears (Figure T22.8). We are now
going to select which statistics to display in the statistics window on the
layout.
5. Select only the following items on the Formatting Statistics dialog
(Figure T22.8):
Gate
Number of Events
% of Gated Cells
% of All Cells
Concentration
6. Click OK to close the Formatting Statistics dialog.
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Figure T22.8 Formatting Statistics Dialog

The statistics window will now appear as shown in Figure T22.9 displaying only
the items selected in the Formatting Statistics dialog.

Figure T22.9 Statistics Window after
Formatting
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There are two other ways to format the statistics window to show only the
statistics you want:
Choosing the statistics to be displayed using the statistics window popup menu:
A. Right-click on the statistics window to bring up the associated pop-up
menu (Figure T22.9).
B. Left-click on the individual statistics you want displayed.
C. Left-click on the items you want removed (Figure T22.10).
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Figure T22.10 Statistics
Window Pop-up Menu

Choosing the statistics to be displayed using the statistics window
Format dialog:
A. Right-click on the statistics window to bring up the associated pop-up
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menu (Figure T22.10).
B. Select Format from the pop-up menu.
C. Select the Stats category from the left panel of the Format dialog
(Figure T22.11).
D. Set the statistics you want displayed and then click OK (Figure
T22.11).

Figure T22.11 Stats Category of the Statistics Window Format Dialog

As you can see in Figure T22.9, the statistics window has a Concentration
column, but it is undefined and shows only n/a. We will now setup FCS Express
to calculate these concentrations.
7. Select the
T22.2 ).

command (Figure

1851

The Concentration Calculator dialog appears as previously shown in Figure
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T22.4

1854

.

8. Click on the second tab titled Stats Window Setup (Figure T22.12).
As before, there are two ways to do this: a) specifying a beads gate and giving
the concentration of the beads in the sample, or b) using time together with the
sample's flow rate when acquired. We are going to specify the Reference Beads
as shown in Figure T22.12.
9. Select the Reference Beads radio button.
10. Select Beads2 in the Bead Gate drop-down list.
11. Enter 100000 in the Bead Concentration field.
12. Click OK (Figure T22.12).
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Figure T22.12 Concentration Calculator Dialog -- Stats
Window Setup

Now, the statistics window will show the results in the Concentration column
for every gate in the plot using the parameters you specified in the previous step
(Figure T22.13). This setup will apply to the whole layout and will be used for the
concentration statistics of every plot in the layout.
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Figure T22.13 Statistics Window with
Concentration Results by Gate

Now, we will show the concentration as a token

40.23.6

1866

.

Showing the Concentration as a Token

In the course of this example, we will:
Show the concentration as a token.

You can use FCS Express tokens to insert statistics in a text box to present your
results. For more information, see the tutorial on using text boxes and tokens
. In case you haven’t setup the concentration calculation, please do so now in
the previous section of this tutorial .
1300

1858

1. Create a blank text box on the layout.
2. Enter the following text: "Beads were added to this sample at a final
concentration of 50,000 beads per mL. The final concentration of
Monocytes in the sample is <blank space>." in the text box.
3. Right-click on the blank space you left in the text box to bring up the
associated pop-up menu (Figure T22.14).
4. Select Insert Token from the pop-up menu (Figure T22.14).
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Figure T22.14 Inserting a Token in a Text Box

The Insert a Token dialog now appears (Figure T22.15).
5. Select Statistic from the Insert a Token dialog.
6. Click Insert (Figure T22.15).
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Figure T22.15 Insert a Token Dialog

The Create Statistic dialog now appears with the Data Source category
displayed (Figure T22.16). This is where you choose which plot the token will
refer to; that is, which plot’s data will be used for the concentration calculation. If
the plot contains multiple overlays, you can also pick the specific overlay you
want to use for the calculation. Since we have created a very simple layout
during this tutorial, there is nothing to change on this dialog.
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Figure T22.16 Create Statistic Dialog -- Data Source

7. Click on the Statistic category in the left panel (Figure T22.17).
8. Select Monocytes from the Gate drop-down list.
9. Select Concentration from the Statistic list.
10. Click OK (Figure T22.17).
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Figure T22.17 Selecting Concentration as the Statistic Token

The text box is now updated with the concentration of the monocytes using the
token we just defined, shown highlighted in grey in Figure T22.18.

Figure T22.18 Text Box with the Concentration Token Value

You can now appreciate that the number in the token is the same as the number
that appears in the statistic window for the "Monocytes" gate. What you have
done is specify the four parameters needed for calculating the cell concentration
, in two separate places: the volume was determined in the Stats Window
Setup of the Concentration Calculator, and the number of cells was
determined in the token setup itself.
1851
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Channel Calibration

FCS Express can ease the task of determining the absolute fluorescence values
of your samples using calibration particles. Using the integrated Channel
Calibration tool, you can setup FCS Express, using calibration particles, to have
your plots and statistics display corresponding MESF fluorescence values.

We will start by setting up the bead gates and markers

40.24.1

1871

.

Setting Bead Gates and Markers

In the course of this example, we will:
Learn how to gate the beads.
Learn how to apply markers to the fluorescence peaks of the beads.
Set up channel calibration defaults for FCS Express.

1. Open a new, blank layout.
2. Insert a Forward vs Side scatter dot plot of the file
ChannelCalibration.001 located in the Tutorial Sample Data archive .
For information on how to do this, please see the tutorial on Inserting
Plots .
1212

1226

3. Create a polygonal gate around the beads.
The gate should look similar to the one shown in Figure T23.1. For more
information on creating gates, please refer to the Gating tutorial .
1268
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Figure T23.1 Polygonal Gate

4. Insert a new histogram of the same file.
5. Set it to show channel FL3-H.
6. Apply the Beads gate to the new histogram.
The histogram should appear similar to Figure T23.2.

Figure T23.2 Histogram of FL3-H with Beads Gate
Applied

The histogram shows the five fluorescent peaks, plus a "blank", of the calibration
particles. We will now proceed to delineate the peaks by setting individual
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markers on each peak.
7. Select the

command.

8. Place the cursor inside the histogram and to the left of the brightest peak.
9. Press and hold the left mouse button down and drag the mouse to the
right side of the peak.
10. Release the mouse button when you are on the right side of the brightest
peak. Take care to avoid the "tail" which represents the doublets, indicated
by the red circle in Figure T23.3.
You can move and resize the marker freely once it has been created by selecting
the marker and moving either the ends of the marker or the whole marker. For
more information on resizing markers please refer to the tutorial section
explaining Marker to Gate Linking .
1384

Repeat steps 7 through 9 for each of the other four peaks, moving from the
brightest to the dimmest peak, excluding the lowest peak associated with the
"blank" beads. You should now have five markers, one for each fluorescent
peak, as shown in Figure T23.3.

Figure T23.3 Markers M1 through M5 for the five
Fluorescent Peaks (red circles indicate doublets)

Note: The default setting for FCS Express is to use channel calibration on the
axes. Therefore, before we set up the channel calibration, it is important to set
the histogram, showing the beads, to not use channel calibration, since that is
our original reference.
11. Right-click on the histogram showing the calibration beads in the FL3
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channel to bring up the associated pop-up menu.
12. Select Format from the pop-up menu.
The Formatting dialog for the histogram appears.
13. Select
listed on the left of the Formatting dialog.

from the categories

The Histogram Specific Options category of the Formatting dialog will appear
(Figure T23.4).
14. Unselect the Use channel calibration on axis option, indicated by the
cursor (Figure T23.4).
15. Click OK.

Figure T23.4 Formatting Dialog -- Unselecting Use channel calibration on axis
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In the next section, we will set up the channel calibration tool

40.24.2
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.

Channel Calibration Tool Setup

In the course of this example, we will:
Identify the variables needed for calibrating the channels.
Set up the Channel Calibration tool using the beads and markers prepared
in the previous section.
Obtain the calibration information.

Before we can begin our setup, it is important to clarify a detail on how flow
cytometry FCS data files are formatted. Typically, in an FCS file, the first
parameter described is Forward scatter, followed by Side scatter, and then the
fluorescent channels in order – FL1, FL2, FL3, etc. Some instruments embed the
name of the parameter directly in the FCS file and you can see it in the Channel
Calibration tool (see instructions below). In the file we will be using for this
tutorial, that is not the case. Nevertheless, we know that "Parameter 5"
corresponds to FL3, which is the channel we want to calibrate. In case you do
not know which parameter corresponds to a fluorescent channel, you can view
the FCS text header information by selecting the
Header command. A dialog displaying the FCS data file header information will
appear displaying all the parameter information in a grid.

We will now proceed to set up the Channel Calibration tool.
1. Select the
T23.5).

command (Figure

Figure T23.5 Selecting the Channel Calibration Tool Command

The Channel Calibration dialog appears (Figure T23.6).
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Figure T23.6 Channel Calibration Dialog

2. Click the Add button on the Channel Calibration dialog (Figure T23.6).
A New Calibration dialog now appears, similar to Figure T23.7.
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Figure T23.7 New Calibration Dialog

3. Select FL3-H from the Create calibration for
T23.7).

drop-down list (Figure

4. Select the Histogram - ChannelCalibation.001 (FL3)
with the
calibration beads from the Calculate regression from drop-down list.
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Note: If there are multiple overlays in your histogram, you can select which one
to use in the Overlay option. In this case it is a simple histogram. Therefore,
there are no other overlays and nothing has to be changed.
5. Enter "5"

in the Number of peaks to use for regression field.

Usually, it is best to use all available peaks (except the blank one); but if for
some reason you want to omit one of the peaks, you can do so. You must use
a minimum of three peaks to calculate a regression.
6. Enter the following fluorescence values, shown in Figure T23.7, for each
peak, in the Molecules/Bead column beginning with Marker 1; 77100,
22100, 6900, 2100, 750.
These values are provided by the manufacturer of the beads, usually quoted as
MESF – Mean Equivalent of Soluble Fluorochrome. In this case, the reported
MESF are for PE-Cy5 molecules.
If you specified fewer peaks than the number of markers in the histogram, for
example, four peaks out of five markers, make sure you select the correct
markers in the left column.
7. Click the Calculate button

(Figure 7).

The New Calibration dialog and results, i.e., Slope , Y intercept , and
Correlation coefficient , should look similar to Figure T23.7. FCS Express
calculates the regression using the logarithmic values. The minimal detection
threshold is the fluorescence obtained by setting the channel to "1" in the
regression equation. The number of decades (the dynamic range of the machine)
is calculated as the inverse of the slope.
8. Click OK to close the New Calibration dialog.
The Channel Calibration dialog will now appear similar to Figure T23.8. The
channel calibration is now ready for use.
As you define calibrations for more than one parameter, they will all appear here.
If the Active option is set, then that calibration set will be used in the layout (in
those plots that have the Use channel calibration on axis checked. You can
only have one active calibration defined for a particular parameter.
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Figure T23.8 Updated Channel Calibration Dialog

Note: Although we won’t show it in the tutorial, you can also edit existing
calibrations for a particular parameter by selecting the parameter in the Channel
Calibration list and pressing the Edit button.
9. Click OK to close the Channel Calibration dialog and return to the layout.

Next, we will demonstrate channel calibration

40.24.3

1879

.

Channel Calibration Demonstration

In the course of this example, we will:
Demonstrate the effect of channel calibration on the data display.

We will now proceed to open a new histogram to show how the calibration
affects how the data is displayed.
1. Insert a new histogram using the file Monocytes.002 in the Tutorial
Sample Data archive .
1212

2. Set the new histogram to display channel FL3-H.
3. Make sure the histogram is ungated.
The histogram should look similar to Figure T23.9. Note that the x-axis extends
from less than 10 2 to more than 10 5. The axis is shown as calibrated, expressing
© 2020 De Novo Software

1880

FCS Express 6 Manual

the mean equivalent number of soluble PE-Cy5 molecules. This is because the
default setting for all plots is to use calibrated axes.

Figure T23.9 Histogram with Calibrated Axis

4. Right-click on the histogram to bring up the associated pop-up menu.
5. Select Histogram Statistics from the pop-up menu.
The Statistics window associated with the histogram will appear.
6. Move the Statistics window under the histogram.
7. Click inside the Statistics window so that it is selected; it should have a
green border.
8. Select the
T23.10).

command (Figure

Figure T23.10 Selecting the Format
Statistics Command

The Formatting Statistics dialog now appears.
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9. Select the following items on the Formatting Statistics dialog: Median,
Geometric Mean, Arithmetic Mean, CV.
10. Deselect all other items from the Formatting Statistics dialog.
11. Click OK.
The Statistics window should appear similar to Figure T23.11.

Figure T23.11 Statistics Window
for Histogram with Calibrated
Axis

12. Right-click on the histogram to bring up the associated pop-up menu.
13. Select Format from the pop-up menu.
The Formatting dialog now appears.
14. Move the Formatting dialog so that both the histogram and the statistics
window are visible.
15. Select
from the categories
listed on the left of the Formatting dialog, as previously shown in Figure
T23.4 .
1871

Notice that the Use channel calibration on axis is checked.
16. Deselect the Use channel calibration on axis option (Figure T23.4

1871

).

17. Click the Preview button.
Note that the histogram curve itself does not change, but the axis reverts to the
usual 10 0 to 10 4 uncalibrated scale. Notice that the values in the statistics
window change when the axis changes from calibrated to uncalibrated. When
calibration is active, the units represent the MESF of PE-Cy5. When calibration is
not used the units are the arbitrary values obtained from the raw data in the FCS
file.
18. Click Cancel to close the Formatting dialog.
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In the next section, we will cover saving and loading channel calibrations

40.24.4

1882

.

Saving/Loading Channel Calibrations

In the course of this example, we will:
Learn how to save and load channel calibration sets.

Now that you have set up this calibration (or in the future, multiple calibration
sets), you can save them in order to use them for other layouts. For example, if
you acquired multiple samples which you are analyzing in separate layouts, you
can set up the calibration in one layout, save it, and then load it in all the other
layouts. That way you avoid the need to repeat the calibration process in every
layout. Bear in mind that the calibration is applicable only to the samples acquired
during the same experimental run using the exact same cytometer setup.

We will now proceed to save the calibration setup.
1. Select the
T23.5 ).

command (Figure

1875

The Channel Calibration dialog will appear as previously shown in Figure T23.8
.
1875

2. Select the calibration you created. There should only be one.
3. Click the Save button.
The Save As dialog appears.
4. Navigate to the FCS Express Sample Data folder and enter "CalibDemo".
5. Click Save.
We will now proceed to load the calibration setup into a new layout.
6. Click on Cancel to close the Channel Calibration dialog.
7. Select Save Layout from the application button to save your current
layout.
8. Press Ctrl+N on the keyboard, to open a new blank layout.
9. Select the

command.

The Channel Calibration dialog appears empty, with no calibrations defined, as
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previously shown in Figure T23.6

1875

1883

.

10. Click the Load button.
The Open dialog appears where we can select the calibration file to load.
11. Navigate to the FCS Express Sample Data folder and select the
"CalibDemo" file that you just saved.
12. Click Open.
The Channel Calibration dialog will now look like Figure T23.8
calibration information that you saved.

1875

, with the same

13. Click on Cancel to close the Channel Calibration dialog.
14. Close the current blank layout to return to the original layout we were
working on before.

Finally, we will set up channel calibration defaults

40.24.5
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.

Channel Calibration Defaults

In the course of this example, we will:
Learn how to change channel calibration default settings for FCS Express
plots.

As previously mentioned, the default setting is for FCS Express to use channel
calibration on all plots. However, you have the option of turning the channel
calibration option off, or on, for a specific plot type. We will now show how you
can turn the channel calibration option off for all 2D dot plots.
1. Select

.

The FCS Express User Options dialog now appears (Figure T23.12).
2. Select the
subcategory on the left side of the FCS Express User Options dialog,
shown highlighted in grey in Figure T23.12.
3. Uncheck the Use channel calibration on axes box, indicated by the
cursor in Figure T23.12.
4. Click OK to close the FCS Express User Options dialog.
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Figure T23.12 FCS Express User Options Dialog -- Unselecting Use channel
calibration on axes for 2D Dot Plots

This setting will now ensure that all new 2D dot plots created will not use channel
calibration. If we would like to remove the channel calibration for other types of
2D plots, we would need to go to the specific subcategory for that type of 2D
plot under the Plots category on the FCS Express User Options dialog.
Note that you always have the option of setting or removing the channel
calibration for a specific plot, rather than for all plots, using either the
command, or using the Format
dialog from the plot pop-up menu as shown in the previous steps. When the
Formatting dialog associated with the plot appears, remember to select Dot
for 2D dot plots or
for histograms. Then, select or
unselect the Use channel calibration on axes option.
Remember, it is important to uncheck the Use channel calibration on axes
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option on any histograms you are going to use to set up a new bead channel
calibration.

40.25

Immunophenotyping

FCS Express makes it easy for you to analyze your flow cytometry data and
generate reports. In this Immunophenotyping Tutorial, rather than going into
depth on any particular procedure, we'll touch on a variety of software features
in the context of a natural work flow for analyzing flow cytometry data.
In the course of completing this tutorial, you will insert
and format plots ;
create gates 316 , markers 351 , and quadrants 366 ; add default
and custom
statistics
to your layout; and, batch export 782 your results to PowerPoint™
and Excel™. After completing the tutorial, you will have become familiar with
many of the basic yet powerful features of FCS Express.
1226

1238

1317

1339

This tutorial is organized into the three sections, listed below, which together
comprise one complete work flow. Each section stands as an independent
exercise, so you may complete each section of the tutorial separately if you
wish.
Section 1: Begin building your layout
with plots and other analysis
elements (e.g., gates, markers, quadrants), on the next page.
Section 2: Add default and custom statistics
to your layout, or to
the provided layout.
Section 3: Batch process your results to PowerPoint and Excel ,
using your own layout or the provided layout.
1885

1908

1918

You may also view the Immunophenotyping Analysis recorded webinar
which accompanies this tutorial.

40.25.1

Building your layout

In this section, we will:
Load an .fcs file
Insert

1226

Create

173

into the plots on the layout.

and format plots

1238

.

and apply gates

1293

, markers

318

Change our axis labels
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Note: There are three Save Points in this section of the tutorial, so that you
may save your progress and return to these Save Points in the tutorial later:
Save Point #1 (Step 21)
Save Point #2 (Step 39)
Save Point #3 (Step 69, end of this section)
1896

1901

1. Select File

1908

Open.

2. Open the layout Immunophenotyping Tutorial.fey found in the
"Immunophenotyping Tutorial" folder within the Tutorial Sample Data
archive.
The layout has been saved unlinked 93 to any .fcs files, so the plots will
appear empty (Fig. T29.1). Unlinked .fey files (layouts) are convenient to
use as templates for similar experiments in the future. Learn more about
the three options for saving layouts 93 .
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Figure T29.1 Immunophenotyping Tutorial.fey. Note that plots appear
empty because the layout is saved as "unlinked".
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We will first change our Default Options 179 so that our .fcs file-derived Stain
and Name keywords 704 appear on our plot axes 253 .
3. Follow the directions in the Changing Axis Labels section
Common Default Options tutorial .

1932

of the Changing

1930

Now, your plots' axes 253 for .fcs files subsequently loaded into this layout
will be labeled with these descriptive keywords 704 that were saved with
your .fcs files at the time of acquisition.

We will now load an .fcs file into the plots
4. Select the Data tab
Ribbon (Fig. T29.2,

173

.
from the

).

5. Navigate to the "Immunophenotyping Tutorial" folder within the Tutorial
Sample Data archive , in the Select a Data File dialog box which
appears (Fig. T29.2, ).
1212
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Figure T29.2 Loading .fcs files into the plots

6. Select "Sample 1.fcs" in the Select a Data File dialog (Fig. T29.2, )
(Note that the advanced open dialog 212 is used in the above screen shot.
The standard open dialog may be used much in the same way).
7. Click Open (Fig. T29.2,

).

The plots now display the data from the Sample 1.fcs file with a predefined
"scatter" gate 318 and quadrants 366 (Fig. T29.3).
Note that the Experiment keyword 704 derived from the .fcs file is now
displaying in the text box 152 at the top of the Layout, as are the Current
Windows User and Current Date. All of these were inserted into a text box
152 as live-updating tokens
.
1300
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Figure T29.3 2D plots after changing file© 2020 De Novo Software
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8. Press and hold anywhere inside the boundaries of the red "scatter" gate
(Fig. T 29.4).
9. Drag the "scatter" gate out of the plot to the empty space at right (Fig.
T29.4, ), while continuing to hold the mouse button down.

Figure T29.4 Dragging and dropping the "scatter" gate out of a plot to make a
new plot gated on "scatter"

10. Release the mouse button when your cursor is on an empty part of the
layout to the right of the original plot.
A new plot gated on this gate will appear at the conclusion of the drag and
drop action commenced in Step 8 (Fig. T29.4, ).

11. Click the X-axis of the new plot.
12. Click "CD45 V800-A" to select it as the parameter 308 from the pop-up
list. You may also type CD45 V800-A in the empty field at the top of the
list (Fig. T29.5).
The X-parameter of the plot has now been changed to "CD45 V800". Note
that Step 3 of this tutorial permitted both the Stain (CD45) and Name
(V800-A) keywords 704 to appear on the axis. This change in your
Preferences will affect all future layouts made under the current FCS
Express User Profile 50 .
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Figure T29.5 Changing the
X-parameter of a plot

13. Repeat steps 11 and 12 for the Y-axis of the new plot, selecting "CD19
V655-A" as the new parameter. The plot will now appear as in Fig. T29.6.
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Figure T29.6 Plot with X- and
Y-parameters changed to CD45
V800-A vs CD19 V655-A

14. Select the Gating tab
T29.7).

from the Ribbon (Fig.

Figure T29.7 Selecting a gate shape from the
Gating tab of the ribbon

15. Click once on each vertex to create a gate around the periphery of the
CD45+CD19+ population (as in the figure below) in the plot at right (Fig.
T29.8).
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Figure T29.8 Drawing a polygon gate

16. Close the gate by clicking on the first vertex you defined (Fig. T29.9,

).

A dialog box 318 appears in which the gate name, color, and inclusion/
exclusion property may be defined.
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Figure T29.9 Closing and naming a polygonal gate

17. Type "B cells" in the Create a new gate name field (Fig. T29.9,

)

18. Select bright green from the Gate color drop down menu. (Fig. T29.9,
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).
19. Click OK (Fig. T29.9,

).

20. Select File
Save As and save the layout linked 93 (first option from
drop down menu shown in Fig. 4.2) 93 . You may then return to this Step
in the tutorial at a later time by clicking on Save Point #1 at the top of this
page.

Save Point #1 (Step 21)

We will now examine the phenotype of the B-cell population in more detail by
gating the plot
in the lower-left corner on the "B cells" gate.
1293

21. Press and hold anywhere inside the boundary of the green "B cells" gate
(Fig. T29.10).
22. Drag the gate toward the plot in the lower-left corner. You will start to
see a "ghost" of the gate outline move along the dragging path (Fig.
T29.10, ).
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Figure T29.10 Gating a plot by dragging and dropping a gate from another plot

23. Release the mouse button when the recipient plot outline turns blue (Fig.
T29.10, ).
The recipient plot is now gated on "B cells" and appears similar to Fig.
T29.10, .
Note: Dragging and dropping the "B cells" gate from the Gate View
the recipient plot would achieve the same action.
24. Select Format tab
T29.11) while the lower-left plot is still selected.
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Fig. T29.16 Changing plot type

25. Click on Contour (Fig. T29.11).
This plot now appears similar to the highlighted plot in Fig. T29.12.
Optional: Add outlier dots 283 to the Contour Plot, in Steps 27 to 32.
Otherwise, proceed to Step 33 .
1900

26. Right-click on the Contour Plot.
27. Select Format from the associated pop-up menu (Fig. T29.12, mouse
pointer).
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Figure T29.17 Right-clicking on a plot to reformat its appearance

28. Click on the Overlays category at the left (Fig. T29.13,

).

Figure T29.18 Adding outlier dots to a contour plot

29. Check the Show Outliers box (Figure T29.13,

).

30. Change the Outlier Dot Color to red (Figure T29.13,
31. Click OK (Figure T29.13,
T29.13, right.

© 2020 De Novo Software

).
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We will now examine the phenotype of the IgD/IgM-double-negative and double-positive populations of B-cells in more detail.
32. Press and drag the central Quadrant vertex (e.g., as shown in Fig.
T29.14) to adjust its position so that the double-positive and doublenegative populations are better divided.
Note: Outer vertices of these Floating Quadrants
adjusted, if desired.

1364

may also be

Figure T29.14 Adjusting the central
quadrant vertex

33. Right-click on the contour plot (Fig. T29.15).
34. Select Convert Quads to Gates
(Fig. T29.15, mouse pointer).

Upper Right

Convert and Link
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Fig. T29.15 Converting and linking the upper right quadrant to a gate

A dialog box similar to that in Fig. T29.9

1895

appears.

35. Repeat steps 18-20
but name the gate "Double Positive" and assign it
a turquoise color to match the pre-formatted text table in the lower right
corner of the layout.
1895

36. Repeat steps 34-36 in order to Convert and Link the Lower Left
Quadrant to a Gate.
37. Repeat steps 18-20
but name the gate "Double Negative" and assign it
a pink color to match the pre-formatted text table in the lower right corner
of the layout.
1895

38. Select File
Save As and save the layout linked 93 (second radio
button as shown in Fig. 4.2) 93 , or simply press Ctrl+S on your keyboard
if you already saved this layout linked 93 as in Save Point #1. You may
then return to this Step in the tutorial at a later time by clicking on Save
Point #2 at the top of this page.

Save Point #2 (Step 39)

39. Select Insert tab
outlined in red).
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Figure T29.22 Selecting histogram
from the Insert tab of the Ribbon

40. Press and hold on the blank space of the layout above the pre-formatted
table (Fig. T29.17).
41. Drag the cursor until the histogram is of the desired size, while continuing
to hold the mouse button (Fig. T29.17, ).
Note: Any plot, text box, or other object
at any time.

238

on your layout may be resized

1214

Fig. T29.17 Inserting a histogram onto the layout

42. Release the mouse button. A new histogram
T29.17, .

266

appears, similar to Fig.

We will now overlay 267 the "double-positive" and "double-negative"
populations onto the histogram to compare their CD20-expression.
43. Right-click on the histogram

266

(Fig. T29.18).

44. Select Add overlay in the associated pop-up menu (Fig. T29.18).
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Figure T29.18 Adding an overlay to the histogram by right clicking on the
plot and choosing "Add Overlay"

45. Repeat Steps 5-7
as in Fig. T29.2
to add "Sample 1.fcs" from the
Data List tab as a second overlay 267 to the histogram 266 .
1888

1888

46. Click OK on the additional dialog box that appears (Fig. T29.19).

Fig. T29.19 Additional dialog box for adding overlays

47. Right-click on the histogram again (Fig. T29.20).
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48. Select Format on the associated pop-up menu (Fig. T29.26).

Figure T29.20 Right-clicking on the 1D-plot to access Format options

49. Select the Overlays category at the left (Fig. 29.27,

).

Figure T29.21 Formatting histogram overlays

50. Select both overlays by clicking on each while holding down Ctrl (Control)
on the keyboard (Fig. 29.21, ).
51. Select "CD20 G710-A" from the X Parameter drop-down menu (Fig.
29.21, ).
52. Increase Smoothing

267

to "5" (Fig. 29.21,

).

53. Click on the first overlay ("1-Sample 1.fcs compensate...") so it alone
is selected (Fig. 29.22, ).
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Figure T29.22 Formatting histogram overlays, continued

54. Select "double positive" from the Gate drop-down menu (Fig. 29.22,
).
55. Select turquoise as the Color under Line Options (Fig. 29.22,

).

56. Repeat Steps 54-56, but this time click instead on the second overlay
("2-Sample 1.fcs compensate..."), and choose "double negative" as the
Gate and pink as the Color, respectively.
57. Click Preview (Fig. 29.22, ). (Note: Move the formatting window to
the side to preview the formatting changes)
The histogram now appears similar to Fig. T29.23.
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Figure T29.23 Preview of gates, colors,
and smoothing applied to both histogram
overlays

Optional: Normalize the histogram, in Steps 59-62. Otherwise,
proceed to Step 63 .
1906

58. Expand the Histogram, on the category at left (Fig. T29.24,

).

Figure T29.24 Normalizing a histogram

59. Click on Histogram Specific Options (Fig. T29.24,

).

60. Select Peak Value from the Normalize to drop-down menu (Fig.
T29.24, ).
61. Select the Based on Value radio button (Fig. T29.24,

).

62. Click OK to close the Formatting pop-up window (Fig. T29.25). Postnormalization, the histogram will appear similar to Fig. T29.30, right; if
you chose not to normalize, it will appear similar to Figure T29.29.
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Figure T29.25 Clicking OK to accept the formatting changes.

We will now look at the differences in CD20-expression between the IgD/IgMdouble-positive and -double-negative populations by creating a marker on
the CD20-positive population.
63. Right-click on the histogram (Fig. T29.26).
64. Select Create marker on the associated pop-up menu (Fig. T29.26).

Figure T29.26 Right-clicking on the histogram to add a marker

65. Press and hold on the histogram to the left of the positive population
peak (Fig. T29.27).
66. Drag the mouse pointer to the right until the marker spans the peak (Fig.
T29.27, ).
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Figure T29.27 Creating a marker

67. Release the mouse. The marker
plot (Fig. T29.27, ).

351

("M1") has now been added to the

68. Select File
Save As and save the layout linked 93 (second radio
button as shown in Fig. 4.2) 93 , or simply press Ctrl+Son your keyboard if
you already saved this layout linked 93 as in Save Point #1 or #2. You
may then return to this Step in the tutorial at a later time by clicking on
Save Point #3 at the top of this page.

Save Point #3 (Step 69,
end of this section)

We have now created a Layout with 2D-plots, histograms, gates, quadrants,
and markers. Next, we will add summary statistics to our layout .
1908

40.25.2

Adding statistics to your layout

In this section, we will:
Add a default statistics table to our layout.
Fill a custom text-table

1313

with selected statistics

Define a custom ratio using a Custom Token

1339

379

.

.

It is easy to add default statistics tables as well as custom-made tables and
statistics to your FCS Express Layout. We will now add one example of each
to this Immunophenotyping Tutorial Layout.
© 2020 De Novo Software
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1. Select File

1909

Open.

2. Open the layout Immunophenotyping Tutorial Ready for Summary
Statistics.fey found in the "Immunophenotyping Tutorial" folder within
the Tutorial Sample Data archive.
The Layout has been saved linked 93 to the .fcs files in the same folder,
and should resemble your Layout after completing the previous section of
the tutorial . You may use this Layout or your own Layout to proceed
to Step 3.
1885

3. Right-click on the contour plot in the lower-left corner of the Layout (Fig.
T29.28; note: the plot pictured is from the provided layout for this
section and shows red outlier dots added as in optional Steps 27-32 from
Section 1 . If you are using your own layout from the previous section
and skipped those steps, your plot will look slightly different.)
1898

4. Select Quadrant statistics from Statistics on the associated pop-up
menu (Fig. T29.28).
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Figure T29.28 Adding a default quadrant statistics window to the layout

A quadrant statistics window appears, similar to Fig. T29.28. Note: you may
move
this statistics window to a convenient part of your layout, such as
below the contour plot.
1215

Note: Default statistics windows may also be similarly added for gates,
markers, and histograms. You may right-click on the quadrant statistics
window to add or remove various statistics.

A Default statistics window is a convenient way to quickly display summary
statistics 379 for a given plot. Summarizing the results of your entire
experiment, however, often requires data from multiple plots on the
layout. This is easily accomplished in FCS Express by adding statistical and
keyword tokens 688 to custom-made tables in a text box. We will now add
statistical tokens to the text table
in the lower-right corner of the
layout, which was custom designed within a text box . The chief
1313

1300
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advantages of these custom tables are: statistics 379 from disparate plots
may be displayed; an endless variety of statistics 379 including user-defined
statistics
may be defined; and, the appearance of the table itself is fully
formattable .
1339

1313

5. Click on the border of the histogram to select it (Fig. T29.29)
Note: the histogram pictured is from the provided layout for this section
and shows a normalized histogram as formatted in optional Steps 59-62
from the previous section . If you are using your own layout from the
previous section and skipped those steps, your histogram will instead
resemble Fig. T29.23 .)
1906

1906

6. Drag the plot toward the upper-right cell in the table (Fig. T29.29,

Figure T29.29 Dragging and dropping a
marker-derived statistical token into a text
table

7. Release the mouse when the cursor is visible within the upper-right,
© 2020 De Novo Software
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turquoise cell in the table (Fig. T29.29, ). Go on to Step 8 or to Step 11
if you were referred here from a more advanced point in this tutorial.
1912

8. Double-click Statistic token in the Paste Special dialog (T29.30,

).

9. Select "M1" in the Select a marker drop-down menu of the Edit
Statistic dialog box that appears (Fig. T29.30, ).

Figure T29.30 Selecting a marker-derived statistical token

10.Select % of gated cells in the Statistic list (Fig. T29.30,
11. Click OK (Fig. T29.30,

).

).

12. Repeat Steps 5-9 , but drag the marker into the pink cell reserved for
the double-negative, CD20-positive population (immediately below the cell
indicated in Fig. T29.30).
1911

13. Click on Data Source in the category at left (Fig. T29.31,

).
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Figure T29.31 Defining the second overlay in the histogram as the data source
for a statistical token

14. Click on the second overlay to select it as the Data Source for this
statistic (Fig. T29.31, ).
15. Click Statistic and select % of gated cells.
16. Click OK (Fig. T29.31, ). The two tokens now appear in the text table
as shown in Fig. T29.32. Note: exact values may vary in your layout
due to your placement of gates, markers, and quadrants. You may adjust
any of these and watch the tokens update accordingly.
1313

17. Press and hold the mouse button inside the boundaries of the red
"scatter" gate in the upper-left color dot plot (Fig. T29.32).
18. Drag it toward the table (Fig. T29.32,
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Figure T29.32 Dragging and dropping a gate-derived statistical token into a
text table

19. Release the mouse when the cursor is visible inside the turquoise cell
pictured in Fig. T29.32, .
20. Select "double positive" from the Gate drop-down menu of the Edit
Statistic dialog box that appears (Fig. T29.33, ).
21. Select X Arithmetic Mean in the Statistic category (Fig. T29.33,

).
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Figure T29.33 Selecting a gate-derived statistical token

22. Reduce the Number of decimals to "0" (Fig. T29.33,
23. Click OK (Fig. T29.33,

).

).

24. Repeat Steps 16-22 , but drag the "scatter" gate into the pink cell
reserved for the double-negative population (immediately below the cell
indicated in Fig T29.32), and select "double negative" in the Gate dropdown menu.
1913

We will now define a ratio between the CD20-positive populations of the IgD/
IgM-double-positive and -double-negative B cells using Custom Tokens ,
which we will subsequently enter into the lower-right blue cell in the table
reserved for "ratio +/+ : / ".
1339

25. Select the View tab

Tokens

Custom Tokens (Fig. T29.34).

Figure T29.34 Opening the Custom Tokens window
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26. Move the floating Custom Tokens window to the side of the page so the
plots are visible.
27. Click the blue Plus button (
T29.35, ).

) for (Create a new Custom Token) (Fig.

Figure T29.35 Defining a new custom token as a ratio between two regular
statistical tokens

28. Type "CD20 ratio" as a descriptive name for the Custom Token (Fig.
T29.35, ).

We will now define a Formula for a simple ratio, using a procedure similar to
that used in Microsoft Excel . However, instead of typing static numbers into
the Formula, we will enter the Tokens we defined in the text table
on the
layout. Thus, as the values of the tokens
change among different samples
in our experiment, the value of the "CD20 ratio" Custom Token 726 will update
accordingly.
1313

1317

29. Type an equals sign ("=") in the Enter the Custom Token formula
below pane of the Custom Tokens window (Fig. T29.35, ).
30. Highlight the Token in the upper right, turquoise cell of the Layout (Fig.
T29.35, ).
31. Drag it toward the Enter the Custom Token formula below pane, while
keeping the mouse button pressed.
32. Release the mouse when the cursor appears after the equals sign ("=")
(Fig. T29.35, ). The Token Description will appear there, highlighted in
blue.
33. Type a division sign ("/") in the Enter the Custom Token formula
below pane of the Custom Tokens window (Fig. T29.35, ).
34. Repeat Steps 29-31 for the Token in the pink cell corresponding to the
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CD20-positive, IgD/IgM double-negative population. The complete "CD20
ratio" Custom Token Formula is pictured in Fig. T29.35, extreme right.
We will now drag and drop this "CD20 ratio" Custom Token into the
appropriate cell, to complete the "CD20+" column of the text table on our
Layout.
35. Press and hold on the "CD20 ratio" Custom Token in the Custom
Tokens Window (Fig. T29.36, ).

Figure T29.36 Dragging and dropping a custom token from
the custom tokens window into the summary text table on
the layout
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36. Drag it toward the lower-right cell in the text table.
37. Release the mouse when the cursor is visible in the appropriate cell (Fig.
T29.42, dashed arrowhead). The value of the "CD20 ratio" Custom Token
will appear as in (Fig. T29.36, ). Note: the value may differ slightly
from that shown, depending on your placement of gates, markers, and
quadrants. You may adjust these to watch the value of the "CD20 ratio"
Custom Token update in real-time.

You have now added a default statistics table to your layout, and have filled a
custom text table
with selected statistics 379 , including a custom ratio
between two statistics .
1313

1339

Learn even more about using text boxes and tokens to take
advantage of the powerful statistical features in FCS Express by
viewing a recorded webinar and completing a separate tutorial
dedicated to this topic.

1300

In the final section of this tutorial, we will batch process our data
generate Microsoft PowerPoint™ and Excel ™ reports.

40.25.3

1918

to

Batch processing your analysis

In this final section of the tutorial, we will create Microsoft PowerPoint and
Excel exports using the powerful Batch Processing 782 function of FCS Express.
1. Select File

Open.

2. Open the layout Immunophenotyping Tutorial Ready for Batch
Processing.fey found in the "Immunophenotyping Tutorial" folder within
the Tutorial Sample Data archive .
1212

The layout has been saved linked 93 to the .fcs files in the same folder,
and should resemble your own layout after completing the previous
section of the tutorial . You may use this provided layout or your own
layout to proceed to Step 3.
1908

3. Select the Batch tab

Actions (Figure 29.82).
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Figure 29.<%C++%> - Opening Batch Actions

4. Move the Batch Actions window to the side of the page so that your
plots are visible.
5. Click Save to Powerpoint in the Add Action category of the Batch
Actions window (Fig. T29.38, ).

Figure T29.38 Batch actions window

6. Check the Open presentation after saving box in the Create Export to
Powerpoint Action dialog box which opens automatically (Fig. T29.39,
left, ).
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Figure T29.39 Adding a PowerPoint action to Batch Process Actions

7. Click the Combine the output from all iterations into the same
presentation radio button in the Iteration options section (Fig. T29.39,
left, ). Note: the first radio button, if selected, would result in each
sample being saved to its own .PPT file.
8. Click on the Folder icon under Save to a new file in the Output file
options section (Fig. T29.39, left, ).
9. Navigate to the directory folder to which the exported file will be saved
(e.g., Desktop), in the Save As dialog window (Fig. T29.39, right, ).
10. Type "immunophenotyping study" in the File name field (Fig. T29.39,
right, ).
11. Click Save (Fig. T29.39, right,

).

12. Click OK in the Create Export to Powerpoint Action dialog box (Fig
T29.39, left, mouse pointer).
13. Click on Export to Excel (Column Mode) in the Add Report category
of the Batch Actions window (Fig T29.38, ).
14. Click on the Folder icon under Save to a new file in the Output file
options section of the Excel (Column Mode) Options dialog box (Fig.
T29.40, ).
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Figure T29.40 Adding an Excel (Column Mode) report to Batch Process Actions

15. Navigate to the directory folder to which the exported file will be saved,
such as the Desktop, in the Save As dialog window (Fig. T29.40, ).
16. Type "immunophenotyping study" in the File name field (Fig. T29.40,
).
17. Click Save (Fig. T29.40,

).

18. Click OK in the Excel (Column Mode) Options dialog box (Fig T29.40,
).

We will now choose which tokens to include in our Excel export.
19. Click on the text table in the lower-right corner of the layout so that its
border is highlighted (Fig. T29.41, ).

Figure T29.41 Dragging and dropping the tokens within a text table into the
Excel export in the Batch Process Actions window.
(Note: the layout pictured has had the optional steps completed for adding red
outlier dots to the contour plot, and for normalizing the histogram. If you are
using your own layout from the previous section and skipped those steps, those
two plots will look slightly different.)

20. Drag the text table toward the Batch Actions window, while keeping the
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mouse button pressed.
21. Release the mouse when the cursor is on the Excel (Column Mode) icon
in the list of Batch Process Actions (Fig. T29.41, ). You may notice a
ghost of the table appearing in the Batch Process Actions before you
release the mouse. All of the statistical tokens in the text table have now
been added to the Excel (Column Mode) export (Fig. T29.41, ).

Note: You may also add tokens to your Excel exports
by dragging and
dropping plot elements, including gates, gate/marker/quadrant text boxes,
and entire plots; individual tokens from default Statistics Windows and text
tables may be added in the same manner as well. We will now add a Token
to the report by dragging and dropping a plot.
1470

22. Click on the upper-left plot on the layout so that its border becomes
highlighted, indicating that it is selected (Fig. T29.42, ).

Figure T29.42 Dragging and dropping a plot-derived element into the Excel
export of the Batch Process Actions window

23. Drag the plot toward the Batch Actions window, while keeping the
mouse button pressed.
24. Release the mouse when the cursor is on the Excel (Column Mode) icon
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in the list of Batch Process Actions (Fig. T29.42, ). You may notice a
ghost of the plot appearing in the Batch Process Actions before you
release the mouse.
25. Click on Keyword Token in the Paste Special dialog box (Fig. T29.43,
).

Figure T29.43 Selecting a keyword token

26. Click OK (Fig. T29.43,

).

27. Click on the ellipsis in the Select a keyword dialog box (Fig. T29.44,
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Figure T29.44 Selecting a specific keyword token

28. Scroll to and select $FIL in the Please select a keyword dialog box
(Fig. T29.44, ).
29. Click OK in the Please select a keyword dialog box (Fig. T29.44,

).

30. Click OK in the Excel (Column Mode) field "Keyword..." dialog box
(Fig. T29.44, ).

Several statistical 688 and keyword tokens 688 are now ready to export to
Excel. We will now reorder the list so the keyword token is exported to
the first column in your Excel worksheet.

31. Press and hold on the "Keyword: $FIL for Plot#..." token (Fig. T29.45,
).
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Figure T29.45 Reordering the tokens in the list to be exported to Excel

32. Drag this token to be directly below the Excel (Column Mode) icon (Fig.
T29.45, ).
33. Release the mouse when the blue bar spanning the window width is at the
position shown in Fig. T29.45, . The tokens have now been re-ordered
as in Fig. T29.45, right. Note: if the token does not move to the new
position in the list, expand the width of the Batch Process Actions
window (simply by dragging its border to be wider, so there is white space
beyond the end of each token descriptor) and try again.

Although we are now ready to Batch Process 782 our analysis, let's first take a
look at all of our samples within the layout itself. This is easily accomplished
in FCS Express; there is no need to make replicate plots and tables for each
of our samples. And, since in FCS Express "What you see is what you get,"
you could even print the layout 102 now or add a Print action 801 to the list of
Batch Process Actions, and the printout would appear exactly as the layout
does on the screen.
34. Select the Data tab
(Fig T29.46, left).
The Data List 783 appears (Fig. T29.46, right), which contains the four .fcs
files in the directory folder from which "Sample 1.fcs" was loaded. When
we run the Batch Process, there will be four iterations, and we will have
four slides in our PowerPoint file and four rows of data in our Excel export.
Note: If you generally prefer to define a list of .fcs files to work with at the
start of your analysis, you may add 786 your files to the Data List before
beginning to build your layout. In this tutorial, we simply loaded "Sample
1.fcs" into our plots and allowed the other three files in the directory folder
to be added to the Data List automatically.
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Figure T29.46 Opening the Data List

35. Select the Data
Change Data on All Objects Next (Fig.
T29.47). Watch as each of the plots and statistics tables on your layout
update to the next file every time Next is clicked. When "Sample 4.fcs" is
displaying on the plots, it will no longer be possible to click Next, as it is
the last file in the Data List.

Figure T29.47 Changing data on all objects to the next iteration in the Data
List

36. Click on the Data tab
(Fig.
T29.47, to the left of Next) until "Sample 1.fcs" is displaying on the layout
again.
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As you click Next to advance through your Data List 783 , you may notice that
the populations shift in position, and you may wish to adjust gates,
markers, or quadrants accordingly. We will now add a pause between
iterations to our Batch Options 841 so that the software will pause before
exporting the data for each sample. During this pause, we can adjust the
"B cells" gate for "Sample 2.fcs" (for example), before the PowerPoint and
Excel exports are generated for that sample and prior to the layout
advancing to the "Sample 3.fcs" iteration 841 . Note: you need not access
Batch Options (as described in Steps 41-44 and 46-48) for batch
processing 782 FCS Express layouts in which no adjustment between
iterations 841 is required.
37. Select the Batch tab

(Fig. T29.48).

Figure T29.48 Accessing Batch Processing
Options

38. Check the Unconditionally pause between iterations box in the Batch
Processing Options dialog (Fig. T29.49, ).
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Figure T29.49 Adding a pause between iterations to our batch
process

39. Click the Restore the state of the layout radio button (Fig. T29.49,
).
40. Click OK (Fig. T29.49,
41. Select the Batch tab

).
(Fig. T29.50).
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Figure T29.50 Running the batch process

The Batch Processing status window appears (Fig. T29.51), indicating that 2
of 2 actions 801 (i.e., one PowerPoint slide + one Excel row of statistics)
have been completed for 1 of 4 iterations 841 in the Data List 783 .

Figure T29.51 Status of the batch process (currently in
progress)

42. Adjust the "B cells" gate, quadrants on the contour plot, and/or the
marker "M1", if desired. You may also make other changes to your layout
during this pause, such as rescaling plot axes, or reformatting, adding, or
deleting plots, text boxes, or any other object.
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43. Click Continue (at the bottom of the window pictured in Fig. T29.51).
44. Repeat Steps 42-43 until the end of the Batch Process; alternatively,
click Run to End (at the bottom of the window pictured in Fig. T29.51) if
no more changes need be made.
45. Examine your PowerPoint export, noting that each of the four slides looks
exactly like your layout in FCS Express in which you performed your
analysis, and that the adjustments made to gates, markers, and quadrants
are recorded in the slides. Each plot and statistics window on the slide is
exported as a high-resolution object which can be moved and resized as
you wish.
Note about ungrouping objects in PowerPoint for PC versus PowerPoint
for Mac
Once exported to PowerPoint, layout objects can be further ungrouped into
single components in the PC version of Microsoft PowerPoint. Ungrouping
objects saved by FCS Express in PowerPoint for Mac is not supported. However,
presentations saved on a Mac may be opened on a PC and ungrouped.
Note: an example PowerPoint export of this layout is saved in the
"Immunophenotyping Tutorial" folder within the Tutorial Sample Data
archive.
46. Examine your Excel export and note that the exported statistics for each
of the four samples reflect the adjustments made to gates, markers, and
quadrants which were recorded in the Powerpoint export. Note: an
example Excel export of this layout is saved in the "Immunophenotyping
Tutorial" folder within the Tutorial Sample Data archive.

View the Immunophenotyping Analysis recorded webinar
accompanying this tutorial.

40.26

Changing Common Preferences

FCS Express provides many options that allow you to completely customize
your working environment. The settings for these preferences are called User
Options 179 . You can save time by creating a new user name 50 to save your
common options rather than changing the default settings each time you start
the program.
This tutorial explains step-by-step how to change the following commonly edited
preferences:
Displaying filenames without path in the Data List
Changing axis labels to stain and name
Creating gates hierarchically and adding a %-gated statistic to
1931

1932
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40.26.1

1931

1935

Displaying Filenames Without Path in Data List
Here we will change our FCS Express User Options
filenames will appear by default in our Data List 783 .
1. Select File

179

so that only the .fcs

Options (Fig. T30.1, outlined in red).

Figure T30.1 Accessing Preferences from the Application
Button

2. Click on Data List in the category at left (Fig. T30.2,
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Figure T30.2 Data List preferences

3. Uncheck Show Full Path (Fig. T30.2,
4. Click OK (Fig. T30.2,

).

).

Note: the current Option for showing or hiding file paths may be overridden
on a per-layout basis at any time. In addition, keywords may be added to
the Data List and the files may be sorted on these keywords by Formatting
the Data List 789 .

40.26.2

Changing Axis Labels
Here we will change our User Options 179 so that data file-derived Stain and
Name keywords appear on our plot axes .
1256

1. Select File

Options (Fig. T30.3, outlined in red).
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Figure T30.3 Accessing Preferences from the Application
Button

2. Click on the Data Loading
T30.4, ).
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Figure T30.4 Selecting Stain and Name as the Parameter Name for plot axes

3. Select Stain and Name from the Keyword to Use as Parameter Name
drop-down menu (Fig. T30.4, ).
4. Click OK (Fig. T30.4,

).

Now, as you load in new data files, your plot axes 253 in FCS Express will be
labeled with the values for the keywords that you have selected. These
keywords values were saved with your data at the time of acquisition,
however, you can edit keywords 646 in FCS Express.
Please note that different manufacturers will use different bits of
information for each keyword value.
For example:
on a BD analog instrument (FACScan, FACSCalibur)
o Stain keyword = CD3 FITC, Name Keyword = FL-H
on a BD digital instrument (anything which uses BD FACSDiva)
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o Stain keyword = CD3, Name keyword = FITC-A
Go back to Immunophenotyping Tutorial.

40.26.3

1888

Creating Gates Hierarchically and Adding Statistics to Gate Text
Boxes
Here we can change our User Options 179 to determine whether or not gates
318 are created hierarchically. In FCS Express 6, Gates are automatically
created hierarchically by default. From this preference, you can also choose
whether or not to include a statistic and the type of statistic within the gate
text box. With this option selected, a statistic 688 is automatically added to
gate text boxes 180 upon creation of that gate.
1. Select File

Options (Fig. T30.5, outlined in red).

Figure T30.5 Accessing Preferences from the Application
Button

2. Click on the Gate category at the left (Fig. T30.6,
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Figure T30.6 Adjusting gate preferences

3. To de-select the option for hierarchical gating, uncheck the "When a new
gate is created, create it hierarchically" box (Fig. T30.6, ).
4. Check the "Insert a gate stat in text box" box (Fig. T30.6, ). Note:
You may choose a different statistic from the drop-down menu to be
added by default to gate text boxes; see gate 206 preferences 206 for
more details.
5. Click OK (Fig. T30.6,

).

Go back to Immunophenotyping Tutorial.

40.27

1885

Cluster Analysis

FCS Express provides users with many different cluster analysis tools which are
referred to as Transformations

934

to help you in analyzing high dimensional data.
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Example of these tools are k-means Clustering
948

and the R integration

975

960
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, Principal Component Analysis

tool.

In this tutorial we will:
create a k-means clustering
apply a k-means clustering
work with a k-means clustering
As an example we will be performing our analysis on a sample of Peripheral Blood
stained for different surface markers. However, please note that transformations
can be performed and applied on any type of sample.

40.27.1

Defining a k-means clustering

For this tutorial, we will be using a layout file that has 2D density plots with a
defined gate. The layout contain a single FCS data file obtained from Peripheral
Blood stained for different surface markers. The sample has two physical
parameters (FSC-H and SSC-A) and six fluorescence parameters.
To open the layout
1. Select the File tab

.

2. Navigate to the Tutorial Sample Data folder and open the Defining kmeans.fey layout stored in the k-means tutorial subfolder.
The layout should appear as shown in Figure T33.1.

© 2020 De Novo Software

1938

FCS Express 6 Manual

The aim of this tutorial is to create k-means clustering on Gate 1, events are
based on 3 out of the 6 fluorescence parameters (i.e. CD3, CD4 and CD8).

The following steps open the transformation window and create a new k-means
transformation:
1.Open the Transformation window by selecting the Tools
tab

Transformations command

2. Click on the drop down arrow adjacent to the blue plus
3. Click on Kmeans in the drop down list

.
button

.

(Figure T33.2).
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Figure T33.2. k-means transformations are created via the Transformation
navigator.

The Kmeans dialog will now appear in the Transformation window as seen in
Figure T33.3.
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Figure T33.3. The Trasnformation window as it appears after creating a new
K-means transformation.

Note: the Template File field already contains the TCellSample1.fcs file, thus
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the file already loaded into the layout. When a transformation is created before
any file is loaded into the layout, a template file will need to be selected by the
user via the ellipsis button (

) at the right of the Template File field.

We will now rename the new k-means transformation as My first k-means
clustering:
4. Select the New Kmeans in the Transformation window.
5. Select the

button from the Transformation window.

6.Type My first k-means clustering as the new name.

Please Note: other ways of renaming a k-means transformation are listed in the
Defining a k-means cluster analysis

961

topic of the manual.

We will now have to define the k-means clustering arguments. We will start by
selecting the parameters the cluster will be based on, and the gate containing the
events we want to cluster. Then we will specify additional required arguments
such as the number of clusters, the maximum number of iterations, and the
cluster minimum size. For a detailed description of each argument, please refer
to the Defining a k-means cluster analysis

961

topic of the manual.

7. Select Gate 1 from the gate drop down menu of the Transformation dialog.
8. Flag CD3, CD4 and CD8 parameters in the parameter list of the
Transformation dialog.
Please note that a scale can be specified for each parameter via the
Parameter Scaling Options section of the Transformation Dialog.

As for all Transformations in FCS Express, a Downsampling Method

1038

can be

selected. We will use all events in this tutorial (i.e. Downsampling Method set
to None).

9. Type 3 in the Number of Clusters field. This is the number of centroids and
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thus the number of clusters that will be created.
10. Type 100 in the Maximum Iterations field. This is the maximum number of
iterations FCS Express will perform upon quitting the clustering algorithm.
11. Type 10 in the Min Percent Cells Per Cluster field. Iterations ending up
with clusters containing less then 1% of events will be discharged and
recalculated. This applies to all iterations except the last one.

At this point, the Transformation dialogue should appear as in the following Figure
T33.4:
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Figure T33.4. The Transforamtion dialogue partially filled for a new k-means
clustering transformation.
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Now that the input parameters are selected we need to define the output style
we want to use for the clustering result. FCS Express provides two output
styles: Cluster Assignment and Clustering Statistics.
In this tutorial we will select the Cluster Assignment output style, which allows
several graphical representations of the clustering results. For more details about
the two different output styles, please refer to the Defining a k-means cluster
analysis

961

topic of the manual.

13. Select Cluster Assignment.
14. Flag Cluster Assignments, Gaussian CV SSE Scaled, Gaussian Y Data
from the list located below the output styles. These will be the new clustering
parameters that will be directly available in a 1D/2D plot and in Heat Maps.

The Transformation dialogue should now appear as in the following Figure T33.5:
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Figure T33.5. The Transformation dialogue filled for a new k-means trasnformation.

The k-means clustering has now been defined and automatically calculated. k-
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means clustering can now be applied to plots for display and analysis. Please
proceed to the next part of this tutorial to see how to apply the k-means
transformation to plots and heat maps

40.27.2

1946

.

Applying a k-means clustering

Once k-means clustering has been performed, results can be accessed as 1D
plots, 2D plots 171 , Heatmaps
and Data Grids 676 depending on the selected
output style (see the Defining a k-means cluster analysis 961 topic of the manual
for details). In the previous part of this tutorial, we selected Cluster
Assignment as the output style that allowed us to create three clustering
parameters; Cluster Assignments, Gaussian CV SSE Scaled, and Gaussian
Y Data. These new parameters 972 may be accessed on plots on which the
transformation has been applied.
In this tutorial we will apply the k-means transformation to 1D plots, 2D plots
and Heatmaps.
1048

Please Note: although different methods can be exploited in applying a
transformation to plots, (please refer to the Applying a k-means Cluster Analysis
970 topic of the manual for further info on this subject), in this tutorial, we will use
the drag&drop method.
To open the layout required for this tutorial:
1. Select the File tab

.

2. Navigate to the Tutorial Sample Data folder and open the Applying kmeans.fey layout stored in the k-means tutorial subfolder.
The layout should appear as shown in Figure T33.6. A Transformation window
with the My first k-means clustering should also been opened.
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Figure T33.6. The Applying k-means.fey layout as it appear after opening it.

Since we selected Cluster Assignments among the new clustering parameters,
we will be able to display clusters using Heat Maps. Thus, let's open a new
heatmap in the layout.
3. From the ribbon bar select

.

4. Click in the place on the layout where you wish to insert the Heat Map.
5. A message saying, there is no parameter compatible with Heat Maps
available..., will open (Figure T33.7). Click Continue.
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Figure T33.7. The message saying that not heat map compatible parameter is
currently available.

6. Select the Heat Map and then select Gate 1 from the
drop down menu. The Heat Map where the cluster
is displayed, will be gated on Gate 1, thus the same gate used for the kMeans clustering.
We will now apply the k-means transformation to all the plots present in the
layout by drag & drop (Figure T33.8):
7. Left click and hold on k-means clustering from the Transformation
window.
8. Drag the k-means transformation out of the Transformation window and
release it on top of each of the 2D plot.
9. Repeat step 7 and release the transformation on top of the newly created
Heat Map.
10. Repeat step 7 and release the transformation on top of the histogram.
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Figure T33.8. Use Darg&Drop to apply the k-means transformation to the
objects of the layout.

The k-means is now applied to all the objects in the layout and the title of the
plot will now include the text "Kmeans clustered" 972 to indicate the
transformation has been applied (Figure T33.9).
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Figure T33.9. When a k-means transformation is applied to plots, the suffix
"Kmeans clustered" is automatically added to the title.

Please Note: When a k-means transformation with Cluster Assignments
parameter is applied to a Heat Map, the latter automatically displays the Cluster
Assignments parameter by plotting each cluster as a well. When a k-means
transformation with parameters other than Cluster Assignments is applied to
1D or 2D plots, the clustering parameters can be accessed as standard flow
cytometry parameters.
In the next section we will see how to work with clustering parameters

1956

.
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Working with k-means using 1D-2D plots

When a k-means transformation includes parameters other than Cluster
Assignments, and these are applied to 1D or 2D plot, the clustering parameters
can be accessed as standard flow cytometry parameters.
In this tutorial we will access clustering parameters on 1D and 2D plots, and we
will use gates and markers to select clustered events. These gates and markers
will then be available for downstream analysis.

For this tutorial we will use the k-means on plots.fey layout stored in the kmeans tutorial subfolder of the Tutorial Sample Data folder.
To open the layout required for this tutorial:
1. Select the File tab

.

2. Navigate to the Tutorial Sample Data folder and open the k-means on
plots.fey layout stored in the k-means tutorial subfolder.
The layout should appear as shown in Figure T33.10:
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Figure T33.10. The k-means on plots.fey layout as it appear after opening it.

In this layout a k-means transformation has been created

1937

and applied

1946

to a

histogram and to 2 color dot plots, (please note the Kmeans clustered suffix in
the plot title). In order to simplify gate visualization, and to create a cluster gate
with the correct hierarchy, Gate 1 (thus the gate on which the clustering has
been performed), has already been applied to all this objects.

In this example, the following clustering parameters have been selected, and thus
automatically created as output results for the k-means clustering: Cluster
Assignments (which is suitable for Heat Maps, see the next section of this
tutorial

1956

), Gaussian CV SSE Scaled and Gaussian Y Data (which can be both

accessed on 1D and 2D plots). To learn more about the available clustering
parameters, please refer to the Defining a k-means cluster analysis

961

topic of

the manual.

We will now select clustered events using markers on 1D plots.
3. Change the parameter displayed on the 1D plot to be Kmeans 3 Gaussian
CV SSE Scaled. Three peaks will appear in the 1D plot, one for each clusters
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(Figure T33.11).
4. Select the peak on the left (i.e. cluster 1) by creating a marker

351

.

5. Convert the marker to a gate, by right clicking on it and selecting Convert
Marker to gate

Marker #1 (M1)

Convert and Link. A Create a new

gate dialogue opens.
6. Replace Gate 2 with Marker on Cluster as gate name and click OK.

Figure T33.12. A 1D plot displaying a clusering
parameter.

The content of the layout should now be similar to Figure T33.12. Please note
that the new gate is now listed in the gate view, and that the events belonging
to Marker on Cluster are now shown in green in both of the color dot plots.
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Figure T33.12. A marker has been created to select cluster 1. The marker has then
been converted and linked to be a gate. The gate view and the color dot plots
reflect this change.

7. Move marker M1 to select a different peak in the histogram, thus a different
cluster. Please take note that the color dot plot is updated based on these
changes.
Also, please note: Since the M1 marker has been converted to a gate, now it
can also be applied to a plot

350

and to other objects in the layout. The M1 gate

will have the same functionality as any other gate.

We will now select clustered events using gates on 2D plots.
8. Change the parameter displayed on the 2D color dot plot in the upper part of
the layout to be Kmeans 3 Gaussian CV SSE Scaled on the X axis, and
Kmeans 3 Gaussian Y Data on the Y axis (Please also note that clustering
parameters can be used together with any other non-clustering parameter as
well on 2D plots).
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The content of the plot will be similar to the one displayed in Figure T33.13.
Please note that the coloring may be different depending on the position of
marker M1 (see step 7).

Figure T 33.13. A 2D plot displaying two
clustering parameters.

9. Select one of the blue clusters by creating a 1D Gate
Gating

Create Gates

318

(select

Markers from the ribbon bar) around it. A Create

New Gate dialogue opens.
Note: although any type of gate can be used to select clustered events on 2D
plots, 1D Gates are particularly useful in this cases as they automatically extend
from the bottom to the top of the 2D plot.

10. Replace Gate 2 with Gate on Cluster as gate name, change color to be red
and click OK.

The layout should now appear similar to the one displayed in Figure T33.14.
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Please note that the new gate (i.e Gate on Cluster) is now listed in the gate
view, and that the events belonging to it are now red, in both of the color dot
plots.

Figure T33.14. A gate has been created to select cluster 2. The gate view and the
color dot plots reflect this change.

11. Move the Gate on Cluster gate to select a different cluster. Note that the
color dot plots update their content based on these changes. Note: the Gate
on Cluster gate can also be applied to a plot

350

and to other objects in the

layout. The Gate on Cluster gate will have the same functionality as any other
gate.

40.27.4

Working with k-means parameters

When a k-means transformation with a Cluster Assignments parameter is
applied to a Heat Map, it automatically displays the Cluster Assignments
parameter by plotting each cluster as a well. The k-means transformation
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available in this layout is defined by three clusters, thus 3 wells are displayed in
the Heat Map.
In this tutorial we will access the clustering parameter on the Heat Map, and we
will use the well gates to select clustered events. These well gates will then be
available for downstream analysis.

For this tutorial we will use the k-means on heatmap.fey layout stored in the
k-means tutorial subfolder of the Tutorial Sample Data folder.
To open the layout required for this tutorial:
1. Select the File tab

.

2. Navigate to the Tutorial Sample Data folder and open the k-means on
heatmap.fey layout stored in the k-means tutorial subfolder.
The layout should appear as shown in Figure T33.15:

Figure T33.15. The k-means on heatmap.fey layout as it appear after opening it.

In this layout a k-means transformation has been created
© 2020 De Novo Software
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to a
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Heat Map and to a color dot plot. In order to simplify the gate visualization, and
to create a cluster gate with the correct hierarchy, Gate 1 (thus the gate on
which the clustering has been performed) has already been applied to the color
dot plot.
In this example, the following clustering parameters have been selected and thus
automatically created as output results for the k-means clustering; Cluster
Assignments (which is suitable for Heat Maps), Gaussian CV SSE Scaled and
Gaussian Y Data (which can be both accessed on 1D and 2D plots, see the
previous section of this tutorial

1951

). To read more about the clustering

parameters, please refer to the Defining a k-means cluster analysis

961

topic of

the manual.

We will now select clustered events using well gates on Heat Map.
3. Right click on the Heat Map and select Create gate

Well from the right click

menu.
4. Select cluster 1 by left clicking on it. A Create New Gate dialog opens.
5. Create Gate 2 and name it as Cluster 1 on Heat Map as gate name, and
have Gate 1 as the Parent Gate and click OK.
6. Click Close in the Edit new gate dialogue. The new gate named Cluster 1 on
Heat Map is now listed in the gate view.
7. Right click on the Heat Map and select Show Gates

Cluster 1 on Heat Map

from the right click menu. The gate is now visible on the Heat Map as a border
around cluster 1.

The content of the layout should now be similar to the one displayed in Figure
T33.16. Please note that the new gate is now listed in the gate view, and that
the events belonging to cluster 1 are now green in the color dot plot.
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Figure T33.16. A well gate has been created to select cluster 1. The gate view and
the color dot plot reflect this change.

Note: The Cluster 1 on Heat Map gate can also be applied to a plot
other objects in the layout just as any other gate.
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